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Chapter 1: About This Guide

This guide covers features that you use to manufacture goods. The chapters are:

Shop Resource Maintenance – This chapter describes how to set up the shop resources you use in 
the manufacturing process.

Manufacturing Window – This chapter describes the features of the Manufacturing Window. The 
Manufacturing Window provides master process definition, work order creation, and the seamless 
integration of scheduling, material planning, purchasing, and order management you need to 
manufacture products. Comprehensive tracking tools provide complete as-planned and as-built data 
from the highest level of summarization to the lowest level of detail for each individual transaction.

Coproducts – This chapter describes how to set up the coproducts you manufacture in conjunction 
with other products.

Rate-based Parts – This chapter describes how to set up and use rate-based parts. A rate-based 
part is a fabricated part that you produce in predictable daily quantities. 

Concurrent Scheduler and the Scheduling Window– This chapter describes how to schedule all of 
your manufacturing activities.

Labor Ticket Entry – This chapter describes how to record labor on work orders.

Work Order Travellers – This chapter describes how to print paperwork about work orders and 
material requirements. You can use this paperwork throughout the manufacturing process to ensure 
that individuals have the information they need to successfully manufacture a part. 

Barcode Labor Transactions – This chapter describes the Wedge Barcode and Barcode 
Transaction System functions. 

Engineering Change Notices – This chapter describes how to manage engineering changes to your 
documents, parts, and bills of manufacture.

Throughput Window – This chapter describes how to analyze your enterprise’s profitability.

Scheduling Reports – This chapter describes the reports you can use to track your scheduling 
activities.

Engineering Reports – This chapter describes the reports you can use to keep track of the 
production activities of your enterprise. 

Equipment Maintenance – This chapter describes how to add pieces of equipment to your database.

Planned Maintenance Manager – This chapter describes how to create planned maintenance 
details for equipment you previously set up using Equipment Maintenance.
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Unplanned Maintenance – This chapter describes how to track the maintenance of internal and 
external equipment outside of regularly-scheduled tasks.

Data Import Utility – This chapter describes how to use the Data Import Utility. You can use the Data 
Import Utility to integrate technical estimating, industry-specific configurators, and other CAD 
products with VISUAL.

Prerequisite Knowledge
You should be familiar with the information in the Infor VISUAL Concepts and Common Features 
guide.

Related Information
The following guides contain information related to this guide:

• Infor VISUAL System-wide Guide
• Infor VISUAL Purchasing User’s Guide
• Infor VISUAL Sales User’s Guide
• Infor VISUAL Inventory User’s Guide
• Infor VISUAL Multi-entity and Multi-site User’s Guide
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Chapter 2: Shop Resource Maintenance

This chapter includes:

Topic Page

What is Shop Resource Maintenance? .......................................................................................... 2–2
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Setting Resource Schedules .........................................................................................................2–11
Changing the Presentation Sequence .......................................................................................... 2–14
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Resetting Operation Costs............................................................................................................ 2–16
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What is Shop Resource Maintenance?
Shop Resource Maintenance refers to the input and tracking of the resources necessary to the 
manufacturing process. A shop resource can be a work center or assembly station, an individual or 
group of individuals, or a subcontractor employed by your company to perform a manufacturing 
process. A resource can also be a group of other, non-group resources. This is useful for scheduling 
purposes.

The Shop Resource Maintenance function provides the means necessary to maintain correct and 
accurate definitions of your shop resources. This information is vital for proper scheduling and work 
order costing. The information you enter here is used in many other parts of VISUAL.

Accessing Shop Resource Maintenance
Select Eng/Mfg, Shop Resource Maintenance.

Use Shop Resource Maintenance to:

• Add shop resources
• Set resource schedules
• Set resource calendar exceptions
• Change the presentation sequence
• Create shop views
• Set up shop groups
• Reset operation costs
• Define operation types
• Set up discontinous operations
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Adding Shop Resources
If you are licensed to use multiple sites, you can select a site and define all resource information when 
you are creating the resource. Some of the information you define is stored at the tenant level. If you 
click Save before you complete the resource record, you must select the **Tenant** option in the Site 
ID field to continue specifying information for certain fields. 

If you are licensed to use a single site, the Site ID field is not available. You can edit all other fields 
without restriction.

To add a shop resource:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to which you are 
adding the resource. If you are licensed to use a single site, this field is unavailable.

2 In the Resource ID field, specify the ID for the resource.

3 In the Description field, specify a brief description for the resource.

4 Click the Costs tab.

5 In the Costs section, specify the labor costs for this resource. If you use standard costing, these 
costs are used for labor costs. For other costing methods, these costs are used to estimate labor 
costs. Specify this information:

Setup per hour – Specify the labor cost per hour to set up this resource. This field is unavailable 
if for resources of type Contractor. 

Run per hour – Specify the labor cost per hour to run this resource. This field is unavailable if for 
resources of type Contractor. 

Run per unit – Specify the labor cost to produce one unit with this resource. This field is 
unavailable if for resources of type Contractor. 

Labor G/L Acct ID – To specify an override account for labor costs associated with this 
resources, click the browse button and select the General Ledger account. To use the default 
account specified in the G/L Interface, leave this field blank. The labor override account specified 
here is used only if you use standard costing.

Cost Category ID – If you are licensed to use Project/A&D features, specify the cost category for 
this resource. If you are not licensed to use Project/A&D features, this field is not available.

Department ID – Specify the department ID associated with this resource.

Bid Rate Category – Specify the bid rate category for this resource. Use bid rate categories to 
analyze budgets and quotes for this resource. Set up bid rate categories in Application Global 
Maintenance. 

6 In the Burden Costs section, specify the burden costs for this resource. The costs you specify 
here are used with all costing methods. If you are creating a resource of type Contractor, only the 
Burden G/L Acct ID field is available. Specify this information:

Burden/hour (setup) – Specify the burden cost per hour of setup time. Use the Percent field to 
the right of this field to specify set up burden as a percentage of the Setup per hour cost. This 
percentage amount is added to the total dollar amount in the Burden/hour (setup) to give a total 
burden cost.
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Burden/hour (run) - Specify the burden cost per run of the resource. Use the Percent field to the 
right of this field to set a percentage of the Setup per hour cost. This percentage amount is added 
to the total dollar amount in the Burden/hour (run) to give a total burden cost.

Burden/unit (run) - Specify the burden cost per unit produced.

Fixed Burden - Specify the one-time burden cost charged when this resource is used.

Burden G/L Acct ID – To specify an override account for burden costs associated with this 
resources, click the browse button and select the General Ledger account. To use the default 
account specified in the G/L Interface, leave this field blank.

7 Click the Other tab.

8 In the Type section, select the type of resource. Depending on your selection, fields on the tab 
become available or unavailable. Specify this information:

Work Center – Click this option if this resource is a physical machine or work station.

Individual/Team – Click this option if this resource is a person, skill level, or team.

Contractor – Click this option if this resource is an outside service. When you click this option, 
the Cost and Burden Cost fields on the Costs tab are not available.

Group – Click this option to define a resource group. You can add resources to the group by 
selecting Edit, Shop Groups.

9 In the Capacity section, specify the maximum number of complete processes this resource can 
perform in each shift. The maximum number you can specify is 254. 

10 In the Group exclusivity section, specify how group resources are considered for scheduling. 
These options are available only if the resource type is Group. Click one of these options:

Schedule All – Click this option if all members of the group must be scheduled simultaneously for 
an operation.

Schedule One - Click this option if only one member of the group must be scheduled for an 
operation. When you select this option, the Schedule Members by Shift check box in the 
Scheduling section becomes available.

11 In the Schedule section, specify how this resource is scheduled:

Schedule Normally – Select this check box to use the capacities established for this resource in 
the Capacities section. Clear this check box if the resource has unlimited capacity. his option is 
available to all resource types.

Schedule Members by Shift – This check box is available only if you selected Group in the Type 
section and Schedule One in the Group exclusivity section. If you select this check box, the 
resources in the group are checked each time a new shift starts. One of the members of the group 
is assigned to the operation. The member assigned to the operation in the first shift scheduled 
may not be the same member assigned to the operation in subsequent shifts. If you clear this 
check box, the member assigned to the operation in the first shift scheduled is assigned for the 
entire operation, even if the operation spans more than one shift. 

Schedule Discontinuous – The check box is not available if you select Group in the type section. 
Click this check box to schedule operations that require this resource discontinuously. Then, enter 
the minimum number of hours of run you want scheduled in one segment.
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12 In the Drum-Buffer-Rope section, click the Monitor Planned Load check box to monitor the 
planned load for this resource. In the Service Buffer field, specify the number of hours to use 
when planning this resource.

13 Specify this information:

Automatic Reporting – If this resource reports to a higher level resource, select the Automatic 
Reporting check box. 

This is also known as "back flushing."

For example, if you are reporting pieces complete at a higher level and you have defined lower 
levels as "Automatic Reporting," quantities complete are reported at the lower level operations. 
This feature has limited use. Labor tickets for lower level operations are not created. 

Project Resource - If you are a projects/A&D user, select this check box if this resource is used in 
your projects. This option is not available if you are not licensed to use projects/A&D.

Obsolete – If you select this check box, users cannot use the resource in Work Orders, 
Engineering Masters, and Quotes. 

If the resource is used in an active operation on a work order, you cannot mark the resource 
obsolete. If the resource is used on any active Work Order, Engineering Master, or Quote, you are 
warned when you attempt to designate the resource obsolete. You can choose to mark the part 
obsolete, or choose to keep the resource active.

14 If you use user-defined fields, click the User Defined tab to specify user-defined information. To 
define user defined field labels, select Edit, User-defined Field Labels. See "Setting Up User-
defined Field Labels" on page 4–20 in the Concepts and Common Features guide.

15 Click Save.

Editing Shop Resources
When you edit a resource, no changes you make to capacity or calendar information are applied until 
you run the Concurrent Scheduler again. No changes you make to cost information are applied until 
you use Reset Operation Costs.

If you are licensed to use a single site, click the browse button and select the resource to edit. Edit 
any information as necessary. You cannot edit the Resource ID. If you change the resource ID, a new 
resource is created.

If you are licensed to use multiple sites, you must edit certain information at the tenant level and 
certain information at the site level. 

To edit a resource, you must make the appropriate selection in the Site ID field. To edit tenant-level 
information, select **Tenant** in the Site ID field. The fields that contain tenant-level information 
become available. To edit site-level information, select the site ID where the resource exists. If the 
resource exists in multiple sites, you must edit site-level information on a site-by-site basis. 

You must edit this information at the tenant level:

• Description
• Resource type
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• Group Exclusivity information
• Project resource check box
• Obsolete check box
• User-defined fields

You must edit this information at the site level:

• Setup Per Hour
• Run Per Hour
• Run Per Unit
• Burden/Hour (setup)
• Burden/Hour (setup) Percent
• Burden/Hour (run)
• Burden/Hour (run) Percent
• Burden/unit (run)
• Fixed Burden

You can define all other information at either the tenant or the site level. If you do not specify 
information at the site level, the tenant level information is used. When the site-level information is 
different from the tenant-level information, the text in the field is displayed in blue. For options and 
check boxes, the label is displayed in blue.
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Adding Shop Resources to Sites
This procedure applies to multi-site licenses only.

If you use multiple sites, you can assign the same resource to different sites. After you assign a 
resource to a site, you can edit any site-specific information to make the information unique to the 
site. For more information, refer to “Editing Shop Resources” on page 2-5 in this guide.

You can add a resource to a site directly in the Shop Resource Maintenance window. To add a 
resource to a site, click the Site ID arrow and select the site, then click the Resource ID browse button 
and select the resource. If the resource does not exist in the site, you are asked to add the resource 
to the site.

You can add multiple resources to a site at one time by using the Site Resources dialog box.

Adding Multiple Resources to a Site
To assign multiple shop resources to a site:

1 Click the Site ID arrow and select a site. You can select any site; it does not have to be the site to 
which you are assigning resources.

2 Select Edit, Site Resources.

3 Click the Site ID arrow and select the site to which you are assigning resources.

4 To add a resource to the site, click the Add to Site check box. If the resource has already been 
added to the site, the Exists in Site check box is selected.

5 Click Save.

Adding a Shop Resource to Multiple Sites
To add a shop resource to multiple sites: 

1 In the Shop Resource Maintenance window, click the Resource ID browse button and select the 
resource to add to multiple sites.

2 Select View, Resource Sites.

3 Select the Show All Sites check box. The Exists in Site and Add to Site columns and the Save 
and Close buttons are displayed.

4 To add the resource to a site, select the Add to Site check box. 

5 Click Save. 
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Discontinuing Use of a Resource
To discontinue use of a resource in your work orders, engineering masters, and quotes, you can mark 
the resource obsolete. To mark a resource as obsolete, any work order, engineering master, or quote 
that references the resource must have a status of Closed or Cancelled. If the resource is used on a 
work order, engineering master, or quote with any other status, then you cannot mark the resource as 
obsolete. 

To mark a resource as obsolete:

1 If you are licensed to use multiple sites, click the Site ID arrow and select *Tenant*. If you are 
licensed to use a single site, this field is unavailable. 

2 Click the Resource ID browse button and select the resource.

3 Click the Other tab.

4 Select the Obsolete check box.

5 Click Save.

If you are licensed to use multiple sites, you can delete a resource from the site. You can only delete 
a resource from a site if it is not used on any record in that site. This procedure deletes the resource 
from the selected site only. It is not deleted from the tenant or from any other site.

To delete a resource from a site:

1 Click the Site ID arrow and select the site from which you are deleting this resource. 

2 Click the Resource ID browse button and select the resource.

3 Click the Delete button.

You are prompted to confirm the deletion.

4 Click Yes to continue, or No to cancel the deletion.

The Shop Resource Maintenance window still contains the resource information, but the resource 
has been removed from the site.

5 Click the New button or select Clear All Fields from the Edit menu.

The Shop Resource Maintenance window is cleared.

You can also permanently remove resources from the database. You can only delete a resource if the 
resource is not used on any record in VISUAL. If the resource is used on a record – even if the record 
is closed or cancelled – you cannot delete it. If you delete a resource from the database, the 
information is not recoverable.

If you are licensed to use multiple sites, you must first delete the resource from all of your sites before 
you can delete it from the tenant.

To delete a resource: 

1 If you are licensed to use multiple sites, click the Site ID arrow and select **Tenant**. If you are 
licensed to use a single site, this field is unavailable.

2 Click the Resource ID browse button and select the resource.

3 Click the Delete button.
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You are prompted to confirm the deletion.

4 Click Yes to continue, or No to cancel the deletion.

The Shop Resource Maintenance window still contains the resource information, but the resource 
has been removed from the database.

5 Click the New button or select Clear All Fields from the Edit menu.

The Shop Resource Maintenance window is cleared.
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Setting Up Shop Groups
If you created group shop resources, use the Shop Groups dialog box to assign shop resources to the 
group. 

If you are licensed to use multiple sites, the site ID of the resources you add to the group must match 
the site ID of the group. If the site ID does not match, you are prompted to add the resource group 
member to the site. For example, say you created a group shop resource in site MMC called MMC 
GROUP. All resources that you add to MMC GROUP must also exist in site MMC. If you assigned 
MMC GROUP to MMC and MMC-2, then all shop resources you assign to MMC GROUP must exist 
in both MMC and MMC-2.

If your shop resource group is assigned to multiple sites, you are prompted to add member resources 
to all sites to which the shop resource group is assigned.

If you are licensed to use a single site, you can add any shop resource to a shop group without 
limitation.

To add a shop resource to a shop group:

1 Select Edit, Shop Groups.

2 Click the Resource ID arrow and select the group Resource ID to which you are assigning 
resources. The drop-down list shows only Resource IDs with the type Group.

3 Click Insert.

4 Specify this information: 

Seq # – A sequence number is inserted. If you selected the Schedule One option in the Schedule 
exclusivity section for this resource group, the individual resources in the group are scheduled in 
the sequence specified in this dialog box. You can change the sequence number.

Resource ID – Double-click the Resource ID button and select the resource to add to this group. 
If you select a resource ID that does not belong to the same site as the Site Group, you are 
prompted to add the resource ID to the site.

Description – The description for the ID is inserted.

5 Click Save.
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Setting Resource Schedules
Use the Resource Calendar to define the shifts and hours that a resource is available. In addition to 
setting up shift hours, you can set up exceptions to the available hours. Establishing exceptions to the 
standard work shift allows automatic adjustments to be made for schedule exceptions. The 
Concurrent Scheduler uses this information. 

If you are licensed to use multiple sites, entries in the Resource Calendar override the settings on the 
Schedule tab in Site Maintenance.

If you are licensed to use a single site, entries in the Resource Calendar override the settings on the 
Schedule tab in Application Global Maintenance.

1 With the appropriate resource in the Shop Resource Maintenance window, select Edit, Resource 
Weekly Calendar. 

2 In the header, specify this information:

Site ID – If you are licensed to use multiple sites, click the arrow and select the site to which this 
resource schedule applies. If you select **All** in the Site ID field, the default schedule defined in 
Application Global Maintenance is displayed. You cannot change the default schedule in this 
dialog. If you are licensed to use a single site, this field is unavailable.

Schedule ID – Click the arrow and select the schedule to override with the resource schedule. To 
override all schedules, select **All**.

Resource ID – Click the arrow and select the resource whose schedule you are defining. To 
override the schedule for all resources, click the arrow and select **All**. 

3 In the table, define the schedule override. Specify the start time for each day the resource can be 
used and the duration of each shift. If you cannot use a resource on a particular date or shift, 
leave the field blank or specify 0.

4 Click Save.

Setting Resource Calendar Exceptions
In some instances a resource may not be available as defined by the weekly calendar. In these 
cases, you can define an exception for the resource. For example, if a resource is not available for 
use during a plant shut down or on holidays, use the exception table to define these dates. Resource 
calendar exceptions allow specification of alternate availability and capacity by date.

Define resource calendar exceptions in the Calendar Exceptions dialog box. You can define these 
calendar exceptions:

• Specific to a particular resource and a particular schedule
• Specific to a particular resource but applies to all schedules. If you are licensed to use multiple

sites, you can apply a calendar exception to all schedules within a particular site only.
• Specific to all resources in a particular schedule. 
• Specific to all resources in all schedules. If you are licensed to use multiple sites, you can apply a

calendar exception for all resources in all schedules within a particular site only.
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When the system identifies an exception to a schedule, it checks for exceptions in this order: 

1 Exception for Specific Schedule, Specific Resource

2 Exception for Specific Schedule, **All** Resources

3 Exception for **All** Schedules, Specific Resource

4 Exception for **All** Schedules, **All** Resource

5 Calendar for Specific Schedule, Specific Resource

6 Calendar for Specific Schedule, **All** Resources

7 Calendar for **All** Schedules, Specific Resource

8 Calendar for **All** Schedules, **All** Resource

To set resource calendar exceptions:

1 Choose the resource to set the exception for and select Edit, Resource Calendar Exceptions.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site that contains 
the schedule to which to apply exceptions. If you select **All** the default calendar exceptions 
defined in Application Global Maintenance are displayed. You cannot change the default calendar 
exceptions in this dialog box.

If you are licensed to use a single site, this field is not available.

3 In the Schedule ID field, click the arrow and select the schedule to which to apply the resource 
calendar exception. If this exception applies to all schedules in the site, select **All**.

4 In the Resource ID field, click the arrow and select the resource for the calendar exception. If the 
exception applies to all resources, select **All**. 

If you select **All** in both the Schedule ID field and the Resource ID field, the default calendar 
exceptions defined for the site in Site Maintenance are displayed in the table. You can edit the 
defaults in this dialog box. 

5 Click Insert.

6 Specify this information:

Start Date – Specify the start date of the exception.

End Date – Specify the end date of the exception.

1st Shift Start Time – Specify the time the first shift begins.

Shift fields – Specify the duration of the exception for each shift.

Capacity – Specify the number of simultaneous operations for each shift. If you select **All** in 
the Resource ID field, these fields are not available.

7 Click Save.

Deleting Resource Calendar Exceptions
You can delete existing resource calendar exceptions.
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To delete an exception:

1 Highlight the exception line and click Delete.

The row is marked for deletion.

2 Click Save to complete the deletion. Click Close to close the dialog box without deleting the 
resource.
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Changing the Presentation Sequence
Use the Presentation Sequence feature to change the order in which the shop resources are 
displayed in the Scheduling Window. 

1 Select Edit, Presentation Sequence.

2 In the Seq# field, specify where in the list the resource is displayed. 

3 Click Ok.

The next time you open the presentation sequence dialog box, the resources are listed in order by 
sequence number.
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Creating Shop Views
You can create different views to be available when you use the Scheduling Window. These different 
views contain a set of resources you define under a particular View ID. Use Shop Views to define a 
set of resources you want to view at one time in the Scheduling Window. A resource can belong to 
many views.

1 Select Edit, Shop Views.

2 In the View ID field, specify an ID.

3 Click Insert. 

4 Double-click the Resource ID button and select a resource to add to this view.

5 In the Seq # field, specify where in the view to display the resource. Change the sequence 
numbers to determine the top-to-bottom sequence.

6 Click Save.
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Resetting Operation Costs
If you have made changes to shop resource costs, you can use the Reset Operation Costs function to 
reset the estimated operation costs used in quote masters, work orders, and engineering masters. 
You can choose to update work orders with certain statuses. You can also choose to update masters 
or work orders created before or after a certain date.

Note: Because resetting operation costs has the potential to affect many work orders, use caution in 
making the decision to reset operation costs.

If you are licensed to use multiple sites, operation costs can be reset on a site-by-site basis only. You 
must select a Site ID before resetting operation costs. The operation costs are reset for only for that 
site’s masters and work orders.

To reset operation costs:

1 Select Eng/Mfg, Shop Resource Maintenance. 

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site where you are 
resetting costs. If you are licensed to use a single site, this field is not available.

3 Optionally, to reset costs for a particular shop resource, specify the resource in the Resource ID 
field. If you are resetting costs for all resources or for selected resources in the site, you can leave 
the Resouce ID field blank. 

4 Select Edit, Reset Operation Costs.

5 Complete one of these tasks: 

• To reset the costs for the resource selected in the Shop Resource Maintenance window only,
click Current resource only. If you did not select a resource before opening the Reset
Operation Costs dialog, this option is not available.

• To reset costs for all resources in the site that you selected in step 2, click All resources.
• To select the resources whose costs you are resetting, click Selected resources. Click the

Insert Row button, then click the Resource ID browse button to select the resources. 

6 Specify the types of masters to update. Select one or more of these options:

• Engineering Master operations
• Work Order operations
• Quote Master operations

7 To reset costs based on the status of each operation, select the According to Operation Status 
check box and select the statuses to use:

• Unreleased
• Firmed
• Released
• Closed
• Cancelled
• All

This selection applies to work orders only.
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8 To reset costs based on Work Order or Master creation date, select the According to W/O or 
Master Creation Date check box. Use the calendar buttons to select the After or Before dates to 
use.

9 To reset costs based on operation type, click the Type drop-down arrow and select an operation 
type. 

10 Click OK. As your operation costs are updated, the Reset Operation Cost dialog box shows the 
current resource being updated. When processing is finished, a dialog box is displayed listing the 
number of operations that were updated.

11 Click OK. 
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Defining Operation Types
Use the Operation Types feature to pre-define all of the attributes of an operation so that you can 
easily copy information about the operation during operation add or edit in the Manufacturing 
Window. When you change the Type of an operation in the Manufacturing Window, you are asked 
whether or not you want it to copy the attributes. Most fields available to you for entry for an operation 
in the Manufacturing Window are available here for entry too.

1 Select Edit, Operation Types.

Creating Operation Types that reference multiple group type resources is permitted.

2 Click Insert.

3 Enter a Type ID, up to 15 characters, and a Description.

4 Click Save.

5 Highlight the Type you want to define and click the Edit Row toolbar button.

The Edit Operation Type window looks just like the Operation window in the Manufacturing 
Window. Any fields you enter are copied to the corresponding fields when you use the operation 
type.

6 Enter all data fields you want to pre-define for operations of that type.

7 Click Ok when you are done.

You return to the Operation Types Table dialog box.

8 Click Save to save the operation type.
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Specifying User Dimensions
If you use dimensional reporting, you can attach user dimensions for shop resources to these 
transactions:

• Work Order Issues
• Work Order Labor
• Work Order Service
• Indirect Labor

You can set up different user dimensions for each shop resource. Use the User Dimensions for Shop 
Resource ID dialog box to specify which user dimensions to associate with a particular shop 
resource. Use the User Dimensions Priorities dialog box available in the Accounting Window to 
determine when the shop resource user dimension IDs should be used. See "Cost Centers" on page 
2-1 in the General Ledger guide.

If you are licensed to use multiple sites, you can assign user dimensions at the tenant level only. You 
cannot specify different user dimensions for different sites.

To associate user dimensions with shop resources:

1 Select the resource to which you are assigning user dimensions.

2 Select Edit, User Dimensions....

3 In the left pane, each user dimension group is listed. Expand the list under the user dimension 
group to view the transactions in which warehouse user dimensions can be used. 

To assign the same dimensions to all transaction types, click the name of the dimension group in 
the left pane. All Subledgers is inserted in the Subledger field.

To assign dimensions to a particular transaction type, select the appropriate transaction type. The 
transaction type is inserted in the Subledger field.

4 Click Insert.

5 Specify this information:

Valid From – Specify the date the dimension assignment becomes effective. 

Debit Dimension – Double-click the browse button and select the dimension to use for account 
debits.

Credit Dimension – Double-click the browse button and select the dimension to use for account 
credits.

6 Click Save.
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Viewing Audit History
If you are auditing information in database tables related to shop resources, you can view a history of 
the changes made to a shop resource in the Audit History dialog. 

A system administrator must grant you permission to view this dialog. 

Use Audit Maintenance to set up the audit. See "Audit Maintenance" on page 5–1 in the System 
Administration guide.

Information is written to this dialog if you are auditing these database tables:

• SHOP_GROUP
• SHOP_RESOURCE
• SHOP_RESOURCE_SITE
• SHOP_VIEW

To view audit history information:

1 Select Eng/Mfg, Shop Resource Maintenance.

2 Open a shop resource.

3 Select Info, Audit History.

4 This information is displayed:

ID – The primary key of the database record that was changed.

User ID – The ID of the user who made the change.

Date – The date that the change was made.

Field – The database table and column that was changed.

Old Value – The original value.

New Value – The new value.

Action – The action that occurred to update the date. These actions are used:

Insert – A new value was created.

Update – An existing value was changed.

Delete – A value was deleted. 

Exporting Audit Information
You can export Audit Information to Microsoft Excel or to an XML file. 
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Exporting Audit Information to Microsoft Excel
To export the information to Microsoft Excel:

1 Select Eng/Mfg, Shop Resource Maintenance.

2 Open a shop resource.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to Microsoft Excel. Microsoft Excel is opened, and the rows 
you selected are inserted in the spreadsheet.

Exporting Audit Information to XML
To export audit information to XML:

1 Select Eng/Mfg, Shop Resource Maintenance.

2 Open a shop resource.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to XML.

6 Specify this information:

File Name – Specify the name to use for the XML file.

XML to Write – Specify the content to include in the file. Click one of these options:

Schema – Click this option to export the schema only. The XML structure is exported, but no 
information from the table is exported.

Document – Click this option to export the rows that you selected in the Audit History table in 
XML format. 

Both – Click this option to export both a schema file and a document file.

Tags – Specify the information to use for the XML tags. Click one of these options:

Use column name – Click this option to use the database column names for the tags.

Use item name – Click this option to use the column names as displayed in the Audit History 
table for the tags.

7 Click Export. 
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What is the Manufacturing Window?
The Manufacturing Window is the master engineering and production management application. The 
Manufacturing Window provides master process definition, work order creation, and the seamless 
integration of scheduling, material planning, purchasing, and order management you need to 
manufacture products. Comprehensive tracking tools provide complete as-planned and as-built data 
from the highest level of summarization to the lowest level of detail for each individual transaction.

This chapter begins with a Concepts section that covers the various Manufacturing Window concepts 
with minimal focus on features and functions. The remaining sections rely on these explanations to 
further describe all of the features and functions of each application. If you are interested in other 
areas, such as scheduling, material planning, or purchasing, you will benefit from reading the 
Concepts section first.
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Manufacturing Window Concepts
Use the Manufacturing Window and the objects it maintains to achieve the following goals:

• Manufacture standard parts and custom products using the same flexible tool set. The
Manufacturing Window provides a number of options for specifying fabrication masters for
different levels that you can combine to meet your unique needs.

• Allow free modification of all aspects of a work order routing and bill of material as needed, even
when it is for a standard part. You can modify work orders locally without affecting the master, if
one exists. Full security control is provided for this feature.

• Allow the use of purchased parts that are special to an order without maintenance of a part
master or assignment to a warehouse. You can specify one time material requirements for
engineering masters or work orders, and purchase directly to the job.

• Support concurrent engineering and manufacturing. Work order release and status is by
individual operation and material requirement to maximize your ability to begin manufacturing
some components before engineering is complete for others.

• Allow “Just In Time” material planning, as well as other planning policies. Material requirements
are specified at the operation where they are needed, rather than on a common bill of materials.

To meet these goals, the Manufacturing Window maintains three types of objects, all very similar to 
one another: Engineering Masters, Quote Masters, and Work Orders.

Engineering Masters
Engineering Masters define a process for use in the production of a manufactured product. This 
includes the individual operations, materials, effort required, and the estimated cost of production.

Engineering masters are a combined bill of material and routing. You develop engineering masters as 
the basis for work orders that are released to build the parts in question. Each fabricated part has a 
current engineering master, which you specify in Part Maintenance, and a series of alternate 
engineering masters that are used when needed.

Quote Masters
Quote Masters are identical to Engineering Masters, but are specifically attached to quotation line 
items. They are used primarily to generate estimated costs for quotations.

Work Orders
Work orders define a manufacturing process that produces a given quantity of a product. Work orders 
have all the features of masters, but also have additional attributes to control and track the actual 
execution of a process. You can produce work orders by copying an engineering master for a 
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standard part, by copying a quote master, or by creating a custom work order from the ground up. 
The method you use depends on whether you are making to stock, making to order, or engineering to 
order.

Work orders cause demand for shop resources that the Global Scheduler plans. Work orders and 
customer orders cause demand for materials that the Material Planning Window plans.

The remainder of this section describes the structure of engineering masters, quote masters, and 
work orders, and how you use them. It also covers the structure of masters from the top down, 
moving from header information, to subassemblies, to individual operations and material 
requirements.
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The Master/Work Order
The term “master/work order” refers to any of the three objects that you can use in the Manufacturing 
Window. The term “header,” for example, “work order header,” sometimes refers to the part of the 
master/work order that contains general data for the entire structure. This is to distinguish from the 
legs, operations, and material requirements that make up a large part of the substructure of a master/
work order.

Master/Work Order Identification
Masters and work orders are identified by a number of key fields that form a logical structure:

Base ID – This is the top-level identification for a master or work order.

For an engineering master, the Base ID must be the same as the Part ID that it represents.

For a quote master, the Base ID always matches the Quote ID of the quotation to which it belongs.

For a work order, the Base ID is sometimes called the Job ID and uniquely identifies the order.

Lot ID/Eng ID – For an engineering master, this field is the Engineering ID. You can use the 
engineering ID to maintain multiple variations of the same part. If you are licensed to use multiple 
sites, use the engineering ID to create unique engineering masters for a part that is used in multiple 
sties.

For a quote master, this field uniquely identifies the quote master from others attached to the same 
quote.

For a work order, the Lot ID identifies a specific lot within a larger work order specified by Base ID. 
This allows all of the lots to have the same Base ID.

Split ID – Split ID uniquely identifies the child lots of a split work order. This way, all splits can have 
the same Base ID/Lot ID as the parent lot. This field allows a manual split. For engineering masters, 
this field should always be zero.

Sub ID – Masters and work orders can have a number of subassembly legs, each of which 
represents the independent production of a subassembly required by the parent operation. The Sub 
ID uniquely identifies a leg within the work order. The primary leg is always Sub ID zero.

The first three fields uniquely identify a master or work order. When taken together, they are usually 
shown in the following format: Base ID/Lot ID.Split ID. If Split ID is 0, it is usually not shown. When 
used for a work order, the combination is sometimes called a Work Order ID.

All four fields uniquely identify a leg of a master or work order. When taken together, they usually 
appear in the following format: Base ID-Sub ID/Lot ID.Split ID. When Sub ID is zero, it is usually not 
shown.
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Master/Work Order Quantity
The Quantity associated with an engineering or quote master represents a standard lot size for any 
work orders you produce.

The Quantity associated with a work order is sometimes called the Desired Quantity. It is the quantity 
that you receive into finished goods when the work order is complete.

Master/Work Order Costs
Master/work order manufacturing costs are broken out into four categories:

• Material
• Labor
• Burden
• Service

In short, the total cost for a master/work order in each category is the sum of those costs for all 
operations on all legs of the master/work order.

Work Order Scheduling
The Global Scheduler schedules work orders, of which you can view the output in the Scheduling 
Window. The following data drives the schedule:

Release Date – The earliest date the work order can start production.

Want Date – The date the finished goods from the work order should be available.

Desired Quantity – The quantity that should be received into finished goods. This ultimately drives 
the actual run time of each operation, and thus the entire schedule.

Forward Schedule – If you set the Forward Scheduled from Release Date option, then the 
Scheduler works forward from the release date, trying to schedule the work order for completion as 
soon as possible. Otherwise, the Scheduler attempts to schedule the work for completion by its want 
date and the want dates of all other work orders.

Treat Release Date as Hard – If you select this option, the Concurrent Scheduler does not attempt 
any scheduling of the work order until the release date. You can set this per work order, per schedule, 
or by site. For more information, refer to the “Specifying Site Scheduling Information” chapter in the 
System-wide guide.

Priority – You can set work order priorities in the Concurrent Scheduler. Priorities affect which work 
orders take precedence over others. By default, all work orders have the same priority.

Operations & Requirements – Operations dictate the actual scheduling of individual resources. 
Material requirements are important if the Scheduler is using the Check Material Availability option.



The Master/Work Order

Infor VISUAL Inventory User’s Guide | 3 – 7

Work Order Actuals
A work order contains additional data beyond that for a master. Because it represents an actual 
instance of production, a work order must have the ability to track status and scheduling. The 
following information is associated with a work order:

Status – This is the master status for the work order, although subcomponents have their own status.

Unreleased work orders are considered to be in the engineering process and/or unauthorized for 
release.

Firm work orders are considered to be firm in terms of quantity, release, and want date, but not 
authorized to begin. 

Released work orders can begin production on the scheduled start date.

Closed work orders are finished productions.

Canceled work orders are not produced.

Scheduled Start Date – Date on which the Concurrent Scheduler schedules the work order to start 
by.

Scheduled Finish Date – Date on which the Concurrent Scheduler schedules the work order to finish 
by.

Determinant Path – The “determinant path” for a work order is the string of operations (a path) that 
controls the total duration of the work order. Whereas “critical path” is the controlling path in an ideally 
scheduled work order, the determinant path also takes into account schedule delays caused by 
unavailability of resources.

Identifying the determinant path shows the operations, and therefore resources, that you can focus 
on to reduce the duration of the work order. Modifying other operations cannot shorten the duration.

Quantity Received – Total quantity so far that you have received into finished goods.

Linked Demand – You can directly link customer orders, customer order delivery schedules, 
interbranch transfers, inventory and other work order’s material requirements to a work order. You 
can do this from the Manufacturing window—assigning supply to demand—or from each of the 
respective applications—assigning to current demand from supply.

Master/Work Order Variables
You can set up any number of variables for a master/work order. These are named items with 
changeable values. Variables primarily define material requirements in terms of variable dimensions. 
For example, an engineering master to produce a door might specify variables of length and width. In 
a material requirement for a piece of sheet metal, you can specify the area needed in terms of the 
length and width. When a work order is created for an actual door, you can set the length and width 
as appropriate, and the material requirement quantity is calculated automatically.
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Operations
Using a single shop resource, operations represent one step in the manufacturing process. In terms 
of scheduling, material planning, and costing, operations are the most basic components of the 
manufacturing process.

An Operation Sequence Number is assigned to each operation on a leg. Each leg has its own 
sequence of numbers. These are the essential parts of an Operation:

Base ID – Identifies the master or work order

Lot/Eng ID – Identifies the work order lot, or revision of the master

Split ID – Identifies sub-lot produced by a lot split

Sub ID – Identifies the leg on which the operation exists

Operation Seq. No. – Identifies the operation among the others on the same leg

Two classes of operations are supported:

In-house Operation – This is an operation performed using the equipment, labor, and other 
resources of your plant.

Sub-contracted Operation – This is an operation where an outside contracted service vendor 
performs one or more operations on in-process material that you sent from your facility.

Operation Resources
Each operation uses only one primary resource. Define shop resources in Shop Resource 
Maintenance.

Resources are divided into three classes:

Work Center – A piece of equipment, grouping of equipment, work area, production line, or any other 
facility that is scheduled, managed, and costed as a single unit.

Individual/Team – A person or team of persons with a particular skill set or role that is scheduled, 
managed, and costed as a single unit.

Contractor – Specifies a particular kind of subcontract resource that an external vendor supplies. 
Unlike the other two resource types, you do not maintain schedule and capacity. When specifying a 
Sub-Contractor resource, you also specify a Service ID that indicates the actual service you want to 
use to fulfill this resource requirement.

Group – A set of resources. Depending on how the group is defined in Shop Resource Maintenance, 
the scheduler either schedules all members of the group or a single member of the group.  
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Operation Quantities
Work orders always specify a number of pieces or amount of material for the order to complete. This 
is the desired quantity. The production of the desired work order quantity is managed at the 
operation level by tracking two basic quantities:

Start Quantity – The number of pieces or amount of material entering the operation, from the 
previous one.

End Quantity – The number of pieces or amount of material leaving the operation. These pieces 
either flow to the next operation, or to finished goods. If this is the last operation, the End Quantity 
equals the work order Desired Quantity.

The Manufacturing Window manages these quantities without your intervention, based on the 
following information:

Next Start Qty – The Start Quantity required for the next operation determines the End Quantity 
needed from this one. If this is the last operation, then the Desired Quantity for the work order 
determines the End Quantity needed.

Scrap/Yield % – You can specify how many pieces or how much quantity you lose due to scrap, or 
how much remains as the final yield. You specify both as a percentage of the total incoming material.

Fixed Scrap – A fixed number of pieces or amount of material that you must scrap, often due to setup 
loss or testing.

The resulting equation is straightforward: Start Quantity for an operation equals the Start Quantity 
needed for the next operation, plus additional quantity to make up any loss due to fixed or variable 
scrap in the current operation.

This includes the implied scrap specified by a yield percentage less than 100%. When no scrap is 
specified for an operation, the Start Quantity equals the Start Quantity needed for the next operation. 
The Manufacturing Window works backward from the Desired Quantity for the work order to calculate 
the Start and End Quantity of each preceding operation.

When necessary, you are allowed to explicitly override these quantities.

It is important for you to understand Start and End Quantity in terms of the final yield, and to 
understand how material requirement quantities are calculated.

Minimum Move Quantity
When a product is produced in discrete pieces or quantities that can be individually processed, you 
can specify a minimum move quantity for an operation. This is the minimum number of pieces that 
can move from one operation to the next when finished. This allows the schedules of sequential 
operations to overlap, because the output of one can immediately begin to feed the next. When you 
do not specify Minimum Move Quantity, all pieces must be completed before the next operation can 
start.

If you specify a minimum move quantity on an operation that uses a rate-based part as a material 
requirement, the minimum move quantity determines when the current operation can begin and when 
the subsequent operation can begin. See "Rate-based Parts" on page 5–1 in this guide.
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For example, presume that you have a work order with two operations: operation 10 and operation 
20. Operation 10 uses a rate based part as a material requirement. If you specify a minimum move 
quantity of 3 on operation 10, operation 10 is scheduled to begin when 3 units of the rate-based 
material requirement are available. In addition, operation 20 is scheduled to begin when operation 10 
produces 3 units. 

Operation Labor Hours
A key component of an operation’s specification are the setup and run time required to perform the 
operation. This data is central to the estimation of time and cost necessary to perform the operation.

Setup time is always specified in hours. It represents the onetime labor required regardless of the 
number of pieces running for the operation.

You can specify run time in a number of ways. In each case, you can use the one best suited to the 
operation. Supported units are hours per piece, pieces per hour, minutes per piece, pieces per 
minute, loads per hour, and hours per load. The last two options allow the specification to be 
constrained by any standard load size that is required for the resource. When you use this, you must 
also specify a load size in pieces. For example, a heat treating facility might be capable of processing 
one load of 100 parts at a time, a load taking 4 hours. You can specify the time as 4 hours per load, 
with a load size of 100. If 150 pieces are needed, the estimated time is 8 hours, since two loads are 
required.

Setup and run time specified in an operation is used for estimation and projection only. Actual hours 
are always obtained from labor tickets recorded against the operation.

Standard Operation Rates
Costs for an operation are estimated by multiplying labor hours applied by the standard rate for the 
operation. Run costs can also be determined based on quantity completed, rather than hours worked. 
These costs include both direct Labor, and Burden. The different options for each rate can be used 
simultaneously, and all add together.

Rate Specified As

Setup Labor Setup Cost per Hour

Run Labor Run Cost per Hour and/or Run Cost per Unit Completed

Setup Burden Burden per Hour, and/or as a Burden % of the Run Labor 
cost

Run Burden Burden per Hour, and/or Burden per Unit Completed, and/
or Burden % of the Run Labor cost

Fixed Burden
Onetime dollar value associated with the operation Sub-
contract rates are specified strictly in terms of Run Cost per 
Unit.
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When you specify the resource for an operation, the standard rates are copied into the operation. 
Although you can override them at this point, the standard rated only provide cost estimations for the 
operation. If you use standard costing, the costs for labor specified on the shop resource record are 
used. If you use actual or average costing, the employee’s pay rate is used. For all types of costing, 
the burden costs specified on the shop resource record are used.

Operation Costs
Operations contribute to work order costs in the following way:

In-house Operations – Labor and Burden costs are incurred based on the number of hours worked 
on the setup and run phases of the operation. Run costs can also be calculated based on the number 
of pieces produced, rather than the hours worked. You can use these methods in combination, even 
within the same operation.

Cost calculation depends upon the method of costing in use. If you use standard costing, the costs for 
labor specified on the shop resource record are used. If you use actual or average costing, the 
employee’s pay rate is used. For all types of costing, the burden costs specified on the shop resource 
record are used.

Costs generated by material requirements for an operation are also considered to be part of the 
operation’s overall cost. 

Sub-contracted Operations – Subcontracted operations have their own cost category—Service 
cost. All costs incurred for subcontracted operations are accumulated in this category.

Operation Scheduling
The Global Scheduler determines a shop schedule for each resource. The Scheduler schedules 
operations using the following information that you specify with the operation:

Setup Time – Applied one time for the operation.

Run Time – Applied based on the remaining quantity of the operation.

Setup Overlaps Previous Operation – If you select this check box, then the set up of the operation 
is scheduled to begin before the previous operation is completed. 

Move Hours – You can also specify a number of move hours for an operation. This is the actual clock 
time necessary between this operation and the next, because of transportation time or other factors 
that do not allow immediate start of the next operation. Move hours drives the scheduling process 
only and do not contribute to the cost of the work order.

Setup time, run time, and move time for all previous operations define an implied lead time for this 
operation: the production hours between the start of the first operation and the time when this 
operation can begin.

Minimum and Maximum Capacity – Shop Resource Maintenance allows the specification of one or 
more units of capacity for a work center or individual/group resource. When the Scheduler schedules 
for that resource, it has a number of concurrent units with which to work.
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When you specify Minimum Capacity Use for an operation, the Scheduler does not schedule the 
operation unless it has at least the minimum number of units to use. The default is one—any available 
unit is used to run the operation.

When you specify Maximum Capacity Use for an operation, the Scheduler does not schedule the 
operation to use more units at once than the maximum—even if more units are available. The default 
is the minimum capacity use. This parameter can prevent a specific operation from using all of a 
resource. It is also useful if there is an actual physical maximum.

Concurrent Resources – These are required in parallel with the setup and/or run of the primary 
resource.

Material Requirements – During scheduling, if material availability checks are enabled, the Schedule 
does not schedule an operation to start unless material is planned to be available. If no actual 
material supply is planned, the lead time for material acquisition is included in the scheduling process.

Maximum Percent Complete – A value can be specified in this field only if the Quantity Complete by 
Hours check box is selected. If a value is specified in the Max Percent Complete field, then a 
percentage of the hours for the operation remains on the schedule until the operation is manually 
closed. 

For example, presume an operation takes 10 hours to complete and 80% is specified in the Maximum 
Percent Complete field. For the first 8 hours of labor reporting, percentage of completion is updated 
and the amount of time remaining on the operation is reduced. After 8 labor hours have been 
reported, updates to the percentage of completion stop and 2 hours remain on the schedule until the 
operation is manually closed. An operation can be manually closed by indicating that the run is 
complete on the labor ticket or by changing the operation’s status in the Manufacturing Window.

All hours that are reported for an operation, including hours logged after the maximum percent 
complete threshold has been reached, are recorded for costing purposes. 

Operation Actuals
This section covers information associated with an actual operation on a work order. The following 
additional information is associated with such an operation:

Status – Operations can be released or unreleased independently. An operation is automatically 
closed when the reported Quantity Complete meets the End Quantity required. The close date of an 
operation is maintained. For operations, an additional status indicates whether the setup portion of 
the operation has been completed.

Scheduled Start Date – The date on which the operation is scheduled to start.

Scheduled Finish Date – The date on which the operation is scheduled to finish.

Labor Hours – The setup and run hours actually performed against the operation, as reported 
through labor ticket entry.

Quantity Completed – Total quantity of goods so far reported completed from the operation, through 
labor ticket entry.

Quantity Deviated – Total quantity of rejected goods reported for the operation, through labor ticket 
entry.
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Labor Tickets – Labor tickets report completion quantities and labor hours against a work order 
operation. These are permanently linked and can be viewed if necessary.

Material Requirements
Material Requirements define a need for a specified amount of material at a certain work order 
operation.

Material requirements are associated with individual operations of a master/work order. This allows 
“just-in-time” material planning of required materials. The setup and run times for all preceding 
operations define a lead time for the material requirement. The material needs to be available at a 
time specified by the work order release date plus this implied lead time.

Because one operation can have any number of material requirements, a piece number is assigned 
to each requirement on the same operation. Here is a list of the essential parts of a Material 
requirement:

Base ID – Identifies the master or work order.

Lot/Eng ID – Identifies the work order lot, or revision of the master.

Split ID – Identifies sub-lot produced by a lot split.

Sub ID – Identifies the leg on which the operation is.

Operation Seq. No. – Identifies the operation on which the material is required.

Piece No. – Identifies the requirement among the others for the same operation

Four separate types of material requirements are supported:

Purchased Inventory Material – These are parts that have standard part masters, which you specify 
in Part Maintenance, and are obtained though Purchase Order Entry and received through Purchase 
Receipt Entry. Specify this type of requirement by Part ID.

Purchased Non-Inventory Material – You can specify requirements for materials that do not have 
part masters. This is particularly important in a job-shop environment, where there are likely to be 
many onetime material purchases, and is useful anytime you need to use a special material on a job. 
This capability is also useful in the quotation process, when there may be new materials involved that 
do not yet have part masters.

For inventory part requirements, much of the information needed is obtained from the part master 
maintained in Part Maintenance. When a non-inventory material is required, special provision is made 
to obtain the necessary information. For example, standard costs are normally obtained from the part 
master. Because no part master exists for a non-inventory part, you can specify the costs directly in 
the Manufacturing Window material requirement.

Fabricated Inventory Material – These parts are also maintained in Part Maintenance, but they also 
have an associated engineering master of their own. Material requirements for purchased and 
fabricated parts are treated in exactly the same way. After they are received into inventory, through a 
purchase receipt or finished goods receipt, they are both available for work orders. Specify this type 
of requirement by Part ID.
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Fabricated Sub-Assembly – From a material requirement standpoint, these act like other 
requirements—they are associated with an operation, and a specified quantity is required for that 
operation. However, rather than maintain a separate engineering master and work order for the 
assembly, the operations and material requirements for the subassembly are included in the same 
structure as the primary operations. This allows these items to be engineered, scheduled, and 
managed as one unit, while maintaining the definition of independent subassemblies.

The strings of subassembly operations are often called “legs.” In the graphical viewing mode of the 
Manufacturing Window, they appear as offshoots of the operation where they are required. In text 
mode, they appear indented beneath their parent operations. These legs have their own header, 
referred to as a “leg/detail.” Its function is very similar to that of a standard material requirement.

The operations on a subassembly leg are identical to those on the primary assembly, and can have 
material requirements of their own, including other subassemblies. This means an indented structure 
can be built to any level.

Using Fabricated Parts vs. Legs
It is up to you to decide when to use a separate part for a fabricated material requirement, and when 
to use a leg. To help you make this decision, we provide some information on the benefits and 
drawbacks of each.

Advantages of Using Legs
When subassemblies are built in a one-to-one relationship with a main assembly, using legs greatly 
simplifies the inventory management, material planning, and scheduling process. You do not have to 
schedule independent work orders, nor are you required to manage the allocation and issuing of the 
subassembly to the main one. All material requirements at all levels appear as material requirements 
of the entire product.

Additionally, the Global Scheduler automatically schedules all levels of subassemblies independently, 
but in such a way that a required assembly is always ready for a parent operation.

Neither of these facts prevent you from managing production of the subassembly independently of 
the main one. Indeed, the key benefit to legs is the ability to unify inventory management and 
scheduling while maximizing your ability to manufacture concurrently.

Disadvantages of Using Legs
The parts produced by a leg are wholly owned by the parent work order. There are no explicit 
inventory transactions performed for the receipt of these parts as finished, and their subsequent issue 
to the parent operation. Although they can be released, started, and completed independently of the 
main work order, the material cannot be managed independently.

This may present an issue in situations where you want to swap subassemblies between work orders, 
or “steal” the assembly from one work order to finish another, later work order. When using legs, you 
would have to perform significant manual adjustments to perform the transfer.
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You can use the Part ID of a fabricated part to refer to the leg. This means you can indicate the 
construction of a leg that is also a separate fabricated part in its own right. This allows you to have 
stockable subassemblies that can be placed as separate work orders. To do this, you have to 
maintain the leg and the separate engineering master independently.

Material Requirement Quantities
Determining the quantity of material that actually has to be issued to fulfill a material requirement is 
not always as simple as considering the quantity required and the desired quantity from the work 
order. You must also consider multiple levels of fixed and variable scrap and unit of measure 
changes. Enter the following information to specify and determine the quantity of a material 
requirement:

Quantity Per – This is the number of pieces or amount of material required for each unit of incoming 
material on the operation. You can specify this in terms of the Start Quantity for the operation, or the 
End Quantity. This choice depends upon whether the scrap/yield events for the operation occur 
before or after the new material is used.

Fixed Quantity – This is a one time quantity of the required material that is used regardless of the 
work order quantity. As with operation scrap, this could account for material needed for setup or 
testing.

Scrap % – This is the variable scrap factor for the required material, which you specify as a 
percentage of the Quantity Per.

Usage UOM – You can specify a unit of measure for use in the operation that is different from the 
material’s stocking unit of measure. In this case, you must specify a conversion factor in the units of 
measure tables.

Dimensions – You can also specify a formula to compute a quantity. This is useful where the actual 
quantity is the result of multiple dimensions that produce a result. For example, the area of sheet 
metal required might depend upon length and width of a part. This is most useful when used in 
conjunction with work order variables, which allow you to specify variable quantities that are used 
throughout the work order in calculating required quantities.

It may be somewhat confusing that scrap factors are defined for the operation and the material 
requirement. Keep in mind that the material requirement scrap represents a loss of the “pure” raw 
material as it is used in the operation, while operation scrap represents a loss of the intermediate 
material in process. A specified material scrap increases the amount of the material required for the 
operation, while a specified operation scrap decreases the amount of the material that flows to the 
next operation.

If you specify the Quantity Per in terms of the Start Quantity, then the required quantity is calculated 
as follows:

Required Qty=Main Quantity 
+(Main Quantity x Scrap) 
+Fixed Quantity

or
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Required Qty=[Operation Start/End Quantity x Quantity Per x Dimensions)]
+[(Operation Start/End Quantity x Quantity Per x Dimensions)) x Scrap %/100]
+Fixed Quantity of Scrap

If the Quantity Per is specified in terms of End Quantity, the equation is identical—just replace Start 
Quantity with End Quantity.

Note that if you specify dimensions, they are simply multiplied by the base Quantity Per. Often, when 
you use dimensions, you specify a Quantity Per of one, and let the dimensions specify the actual 
quantity. As an example, consider the fabrication of a solid door, that has work order variables of 
LENGTH and WIDTH. A material requirement might be for a certain square footage of sheet metal. 
You specify a Quantity Per of 1, and dimensions of [LENGTH]*[WIDTH] (length times width). If you 
needed two such sheets, the Quantity Per would be 2. Or you could keep Quantity Per as 1, and 
place the 2 (the actual Quantity needed) within the dimensions field z [LENGTH]*[WIDTH].

If the usage unit of measure is different from the stock unit of measure, it is then applied to this 
quantity to get the amount that must be issued to the work order.

This final quantity required is sometimes referred to as the “calculated quantity” or “calc qty.” This is 
the amount that shows up as demand in the Material Planning Window, and the amount that must 
actually be issued to the work order to meet the requirement. The calculated quantity is always in 
terms of the stock unit of measure.

As an alternative, consider the following step-by-step description of arriving at the calculated quantity:

1 Figure out the Start Quantity for this operation, based on required quantity of next operation.

2 If the Quantity Per is based on End Quantity, apply operation scrap factors.

3 Multiply Quantity Per by the resulting quantity to get a base amount required.

4 Multiply that result by any dimensions specified.

5 Add quantity to make up for fixed and variable material scrap.

6 Apply unit of measure conversion to get to the stock unit of measure.

In summary, the actual quantity of material required to fulfill a work order material requirement 
depends upon the fixed and variable scrap of the current operation, and all subsequent operations as 
well. It is important that you understand how each factor affects the determination of calculated 
quantity.

Calculated Quantity Values for Piece Tracked Parts
If you use piece tracked parts as material requirements, you can choose how to determine the 
quantity in the Calculated Value field on the Material card. The Calculated Value field is used to 
determine the actual quantity of the material requirement and the cost of the material in the work 
order. Specify your choice in Preferences Maintenance. Your choice is particularly important if you 
specify a scrap percentage or fixed quantity for materials.

To make your decision, it is important to understand how material quantities are calculated for piece 
tracked parts. These calculations are made:
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1 The size of the material requirement piece is calculated. To calculate the size of each piece, the 
dimension specified on the Material Requirements card are multiplied. If the usage unit of 
measure is different from the stock unit of measure, the dimensions are multiplied by the 
conversion factor:

Length * Width * Height * Conversion Factor

2 After the size of the piece is determined, the total quantity required for the work order is 
calculated: 

Work Order or Leg Header Quantity * ((1 + Scrap %) * Qty Per) + Fixed Quantity) * Dimensions * 
the conversion factor between the usage unit of measure and the stock unit of measure

This is the quantity of material actually used for the work order. 

3 To determine the number of pieces needed to meet the requirement, the total amount required for 
the work order is divided by the size of the material requirement and then rounded up to the next 
whole number:

Total amount required/piece size, rounded the next whole number 

The result of these calculations is inserted in the Calculated # of Pcs field on the Planning tab. To 
determine the value in the Calculated Piece Qty field, the Calculated # of Pcs is multiplied by the 
piece size. 

The value used for the Calculated Qty field is determined by the CalcQtyByPieces preference setting 
in Preferences Maintenance: 

CalcQtyByPieces=Y – If you choose this option, then the Calculated Value field is equal to the 
Calculated Piece Quantity. If you choose this option, then the whole number of pieces is the total 
requirement. This is the default option.

CalcQtyByPieces=N – If you choose this option, then the Calculated Value field is equal to the actual 
amount used for the work order. 

Example
Presume you have a work order with these parameters:

Work Order Header Qty: 5

Material Card Qty Per: 1

Scrap Percentage: 25%

Dimensions: 100 length * 45 width

Usage U/M: Square Inches

Stock U/M: Square Feet

1 Calculate the size of the material requirement piece by multiplying the dimensions and the 
conversion factor between the usage u/m and stock u/m:

100 *45 * 0.006944 = 31.25

The size of the material requirement piece is 31.25 square feet. When you purchase quantities for 
this work order, the piece is purchased in multiples of 31.25.
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2 Calculate the total required for the work order by multiplying the quantity on the work order header 
by the total amount required on the material requirement card. The value is converted to the stock 
unit of measure:

5 * ((1 + 0.25) * 1) + 0) * (100 * 45) * .006944 = 5 * 1.25 *4500 * .006944 = 195.30

This is the quantity you actually use in the work order.

3 Calculate the number of pieces required by dividing the total required for the work order by the 
size of the piece and rounding up to the next whole number:

195.30/31.25 = 6.25, rounded up to 7

On the Planning tab of the material requirement card, these values are used:

Calculated # of Pieces – 7

Calculated Piece Qty – This value is equal to the Calculated # of Pieces multiplied by the piece size: 

7 * 31.25 = 218.75

Calculated Qty – The value used in this field is determined by the CalcQtyByPieces preference in 
Preference Maintenance. If the preference is set to Y, then this value in equal to the Calculated Piece 
Qty. In this example, the value is 218.75. If the preference is set to N, then this value is equal to the 
total required for the work order. In this example, the value is 195.30. 

Specifying the CalcQtyByPieces Preference Setting
To specify the CalcQtyByPieces preference setting:

1 Select Admin, Preferences Maintenance.

2 Click the Insert button.

3 Specify this information:

Section – Specify Visual Mfg.

Entry – Specify CalcQtyByPieces.

Value – To use the calculated piece quantity as the calculated quantity, specify Y. To use the total 
quantity actually used in the work order, specify N. 

4 Click Save. 

Note:  If you change your CalcQtyByPieces preferences settings, you must recalculate quantities on 
work orders, engineering masters, and quote masters that use piece-tracked parts. Posting When 
you recalculate quantities, posting candidate flags are set to Yes. When you run costing, the work 
orders will be processed. 

Purchasing Piece Tracked Parts for Material Requirements
When you purchase a piece tracked part, the number of pieces you order must be a whole number.  
When you use the Purchase this Material/Service function to purchase a piece tracked part in the 
Manufacturing Window, the number of pieces on the purchase order line is equal to the Calculated # 
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of Pcs field on the Planning tab of the Material card. The quantity is equal to the Calculated Piece Qty 
on the Planning tab of the Material card. If you use the CalcQtyByPieces = N setting in Preferences 
Maintenance, the amount you purchase might exceed the amount needed to fulfill the material 
requirement. You can return any unused pieces to your inventory. 

Standard Material Unit Costs
Costs for materials are estimated by multiplying calculated quantity by the standard unit cost for the 
material. The following unit costs apply:

Unit CostDescription

Material Unit CostPurchased material unit cost, or material component of fabricated material cost.

Fixed CostOnetime charge for material acquisition, such as a vendor setup charge.

Labor Unit CostLabor component of fabricated material requirement cost.

Burden Unit CostBurden component of fabricated material requirement cost.

Service Unit CostService component of fabricated material requirement cost.

Burden per UnitBurden associated with material handling, per unit.

Burden PercentBurden associated with material handling, as percent of total material cost.

For Standard Costing – When you specify the Part ID for a material requirement, the standard rates 
are copied into the requirement from the part master. Although you can override the rates at this 
point, they are only used to provide cost estimations for the material requirement. Standard costs are 
always taken from part records.

For Actual Costing – The material requirement card issue burden values override the part card issue 
burden values when setting the "actual burden” for the work order issue transactions. Actual costs are 
always taken from PO/Invoice prices.

Material Requirement Costs
Material requirements contribute to work order costs in the following way:

Purchased Parts (Inventory or Non-Inventory) – Purchased material contributes to work order cost 
in two categories only: Material and Burden. You incur material costs for the fixed and variable 
purchase price of the material. You incur burden cost for the issue burden, if any, associated with the 
material. Do not confuse this burden with the Burden cost of a fabricated material requirement.

Fabricated Parts – The Costing Between Levels option in Accounting Entity Maintenance determines 
how fabricated requirements contribute to the parent work order cost. If you specify “Keep Separate 
Costs”, the four cost categories of the required fabricated part contribute to the four categories in the 
requiring work order. If you specify “Fold to Material Cost”, all four cost categories of the required 
fabricated part are rolled into the Material cost of the requiring work order.
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Material Planning
Use the Material Planning Window to plan material supply to meet expected demands. The following 
information you can specify for a material requirement affects the material plan:

Operation Start Date – The Concurrent Scheduler determines the start date for the operation that 
requires the material. The operation’s Start Date defines the date that the material must be available 
to the operation.

Material Lead Time – Both fabricated and purchased parts have a Lead Time specified in their part 
master, maintained in Part Maintenance. This is used in planning work orders and purchase orders 
for required material. You must place work orders and purchase orders this far in advance of the 
operation start date in order to be available in time.

Note that the lead time for a fabricated part is displayed in its part master, not by accumulating its 
setup and run times.

Calculated Quantity Required – As mentioned above, this quantity specifies that actual amount of 
material that needs to be acquired to meet the material requirement demand.

Material Actuals
This section covers information associated with an actual material requirement on a work order. The 
following additional information is associated with such a requirement:

Status – Material requirements have their own private status; they can be released or unreleased 
independently. A requirement is automatically closed when all required material is issued. The close 
date of a requirement is maintained.

Required Date – The Required Date of the material requirement is always equal to the scheduled 
start date for the operation, as assigned by the Global Scheduler.

Issued Quantity – The current quantity of material that you have issued to meet the requirement. 
This also implies a Quantity Due, or the outstanding required quantity that you have not yet issued.

Inventory Issue Transactions – Inventory Issue Transactions that issue and/or return material to the 
requirement are permanently linked. You can view these if you need to.

Linked Purchases – It is possible to link a material purchase directly to the material requirement it 
meets. This simplifies the management of this type of order.
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Starting the Manufacturing Window
The Manufacturing Window is available from the Main window.

To open an existing master:

1 From the Eng/Mfg menu, select Manufacturing Window.

2 In the Type section, select the type of master you would like to open. You can select Engineering 
Master, Work Order, or Quote Master. If you are opening an existing master, the selection you 
make in the Type box determines the records available to you when you click the Base ID browse 
button. 

3 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. Masters 
are created by site. 

If you are licensed to use a single site, this field is unavailable. 

4 Click the Base ID browse button and select a record from the table. The Lot ID/Eng ID and Split 
fields are populated based on your Base ID selection.

5 Select the appropriate predefined Size Preference radio button.

6 Select the appropriate viewing mode radio button. Select from the following: Graphical (1), 
Graphical (2), Text (1), Text (2), and Grid.

7 Click Ok.

To create a new master, select the type of master to create in the Type section, then click New. 

Specifying the Default Document Type in the Open Dialog
When you launch the Open dialog, the Work Order type is selected by default. To change this default 
selection, specify your preference in Preferences Maintenance. 

To set up your preference:

1 Select Admin, Preferences Maintenance.

2 Click the Insert button.

3 Specify this information:

Section – Specify ManufacturingWindow.

Entry – Specify Default Type.

Value – To set Engineering Master as the default, specify M. To set Quote Mater as the default, 
specify Q. To set Work Order as the default, leave the value column blank, or remove the Default 
Type entry line from the preferences table.

4 Click Save.

You may need to close and reopen the Manufacturing Window to apply the new setting.
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Choosing a Manufacturing Window Interface
The Manufacturing Window offers a number of different viewing modes and options. In all cases, the 
same internal database information is displayed. The viewing modes present you with a variety of 
tools for viewing and editing the information. 

You can choose among three views: Graphical, Text, and Grid. If you choose Graphical or Text, you 
can choose a one-window or two-window option. If you use the Graphical view, you can also choose 
to view information from the bottom of the window up or from the top of the window down.

You can also specify the colors of the various objects in the window and define up to 6 text size 
options.

You can choose an interface when you open an existing master or create a new master. You can 
change the view using the View menu.

Graphical View

In the graphical view, each object (header, operation, material, leg) is represented by a rectangular 
“index card.” The card shows some basic information about the object and its relation to the other 
objects, and is used to select and edit all of the object’s contents. Each header card and leg is 
grouped with the operations and material requirements associated with the header or leg. The cards 
sit on a scrollable viewing area, which is always large enough to hold all the cards. Depending upon 
your size preference settings and the size of the master/work order, you may need to use the scroll 
bars to access all of the cards. Different colors highlight the different types of objects. 

Setting Graphical View Options
You can specify how to display the various objects in the Graphical view. To specify settings:

1 Select Options, Graphical Display Options.

2 Select from the following options:
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Top Down – Select this option to position the header card of the master at the top left of the 
window. All other legs flow beneath the header card. Clear this option to position the header card 
at the bottom left of the window. All other legs flow above the header card.

Header Cards behind Other Cards – Select this option if you would like the header or leg card to 
be under the operation and material requirements information. If you select this option, most of 
the information that is displayed on the header or leg card is hidden behind the operations and 
material requirements. Clear this option if you would like the header or leg card to be on top of the 
operation and material requirements information. If you select this option, the information 
displayed on the header or leg index card is visible.

3 Click Ok.

Text View

The text viewing mode provides a more traditional view of the work order/master. Each object is 
shown as a single line of text, displaying some basic information about the object.

To select the one-window text mode, from the View menu, select Text Display Mode (1 Window).

The header is always the first line of the display. Operations appear indented beneath the header. 
Material requirements appear indented beneath their operations.

Legs are also shown indented beneath their operations. Legs are indented one more character 
positions than material requirements. The operations for legs are directly beneath the legs, and their 
materials are indented beneath them. This presents a traditional indented bill of materials.
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Two Window Display

If you have a large number of material requirements associated with a single operation, you may find 
it easier to use the two window display option. This option is available with the Graphical View and the 
Text View.

When you use the two window display, the system displays header cards, legs, and operations in the 
bottom window. When you select an operation, the system displays the material requirements in the 
top window. 
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Grid Display

In the grid display, the master is displayed in a table. The header is displayed in the first row. 
Operations, legs, and materials are displayed in subsequent rows. Like the Text display, information 
in the table is indented to show the relationship among operations, legs, and materials. Operations 
are indented under their associated legs, and materials are indented under their associated 
operations. 

The grid display shows more of the information entered in the master, leg, operation, and material 
dialog boxes than the text and graphical displays show. 

Note: Because the grid displays more information, it will take longer to load than the text and 
graphical displays.

Not all columns in the Grid display table apply to all of the objects in the table. For example, 
Operations do not use Part IDs, so the Part ID column does not apply to Operations. You can choose 
how you want the system to indicate that a column does not apply to a particular object using the Grid 
View Display Options dialog box.

If you use the Grid display, you can export the information from the grid into Microsoft Excel. You can 
also import information from Excel into the grid display provided that your Excel spreadsheet is 
formatted properly and you have security permission to do so. For more information, refer to the “User 
Management” chapter in the System Administrator guide.
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You can also edit information directly in the Grid display. Because the system does not display all 
information related to the master in the Grid display, you should still access the Header, Leg, 
Operation, and Material Requirements dialog boxes to ensure you have completed all pertinent 
information. If you want to create a new card, you must use the Add Leg, Add Operation, or Add 
Material buttons, or select the functions from the Edit menu.

Specifying Grid View Display Options
You can specify which color you would like to use for a non-applicable column in the Grid View 
Display Options dialog box. You can also choose how you would like the system to display the Detail 
column.

To specify grid view display options:

1 Select Options, Grid View Display Options.

2 Specify the following:

Non-applicable Column Color – Some columns in the Grid Display table do not apply to every 
row in the table. Specify the color to use to indicate that a column does not apply to a row. Select 
one option:

Use Specified Color – Select this option to use the same color for all non-applicable 
columns. If you select this option, click the Color button and select the color you would like to 
use. This color will be used for all non-applicable columns regardless if the row is a header, 
leg, operation, or material.

Use Faded Object Color – Select this option to use a lighter shade of the color you specified 
for the header, leg, operation, or material in Setting Color Preferences. For example, if you 
specified that operations are blue, then cells that do not apply to operations are a lighter 
shade of blue. If you select the Use Faded Object Color option, specify a Fade Factor. The 
Fade Factor indicates how much lighter the non-applicable column color will be than the 
object color. The higher the number, the lighter the shade. Enter a value from 0.1 to 0.9. Avoid 
using 0. If you use 0, the non-applicable color will be the same as the object color.

Tree View Detail – Select this check box if you would like the Detail column to use a tree view. In 
the tree view, the system draws lines between associated objects. The system displays the Plus 
and Minus buttons used to expand and collapse the master structure directly in the Detail column. 
Clear this check box if you do not want to view lines connecting the master objects. The system 
displays the Plus and Minus buttons used to expand and collapse the master structure in the first 
column.

Configuring the Grid View
You can add columns related to the master to the grid view. For example, you can add user-defined 
field information from the Part record to the view.

1 Select Options, Grid Display Table Configuration. A list of available columns is displayed.
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2 To include a column in the Grid View, select the Include check box. To remove a column from the 
Grid View, clear the Include check box.

3 Click Save. 

If you add information from the Part record to the grid, note these caveats:

• Users can view user-defined and specification information in the Manufacturing Window even if
they do not have permission to view the information in Part Maintenance. 

• If a protocol, such as http://, has been defined in a URL customizable user-defined field, and at
least one part in the master contains a URL, the protocol is displayed in all rows that contain
parts. The protocol is displayed even if a URL has not been defined for a particular part. See
"Customizable User Defined Fields" on page 5–8 in the System Administrator guide.

Using the Grid View
The Grid View table displays most of the information found on the header, leg, operation, and material 
cards. If the information is editable in a card, you can also edit it in the Grid view. For example, you 
can change the part ID associated with a material card directly in the grid view without accessing the 
material card. Place the cursor in the part ID field, double-click the part ID browse button, and select a 
part from the table. 

Refer to the Building Masters section for more information on editing objects in a master.

After you make changes in a grid line, click anywhere outside the grid line. The system prompts you 
to save your changes. The system also prompts you to save your changes if you tab out of a row.

Exporting the Grid View to Excel
You can export the master or portions of the master to Microsoft Excel.

1 To export the entire master, do not select any lines, or select all lines. You can also send selected 
lines. Hold down the CTRL button and click the lines to export. 

2 Select File, Send to Microsoft Excel.

The system launches Microsoft Excel and inserts the information from the Manufacturing Window.

3 You can edit the spreadsheet and import the information back into the Manufacturing Window.

Importing from Excel into an Existing Master in the Grid View
You can import information from a Microsoft Excel spreadsheet into the Manufacturing Window. You 
can import information to an existing master, or you can use Excel to create a new master. You can 
import information from Excel, provided that the following conditions are met:

• You are using the grid view
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• The columns in the Microsoft Excel spreadsheet are named correctly. For example, if you rename
the You may find it helpful to export a master from the Manufacturing Window first before
importing information to be sure that the columns are named correctly.

• The information in the system is valid. For example, if you specified “G” in the Status column, the
system would not import the information since a status of “G” does not exist in ERP Express
(VISUAL).

• For existing masters, the card has no material issues or labor tickets applied against it.

To import from Excel:

1 From the Manufacturing Window Grid View, select File, Import from Excel.

2 Select the Excel file and click Open.

3 The system imports the information from the Excel file into the database. The system updates any 
existing header, leg, operation, or material cards you edited in the spreadsheet and creates any 
new cards you added to the spreadsheet, provided that you formatted the information correctly. 
The system adds any new headers, legs, operations, or material cards you created in the 
spreadsheet.

Scrolling in the Manufacturing Window
You can use the scroll bars at the bottom and at the left of the Manufacturing Window to scroll to view 
information. 

In the Graphical and Text displays, you can also click and drag the window to scroll. Place your cursor 
in a blank area of the window (an area that does not contain any object cards). Click the mouse 
button. The cursor changes to a hand. With your mouse button depressed, drag the mouse to scroll 
the information in the window.

If you are using the two-window option, you can drag the bottom window only. You cannot drag the 
window where the material requirements are displayed. 

Using High Contrast Mode
High Contrast color schemes can increase legibility for some users by heightening screen contrast 
with alternative color combinations.

To turn High Contrast Mode on in Windows, select Control Panel, Accessibility Options from the Start 
menu. Select the Display tab, then select the Use High Contrast check box.

For users employing the High Contrast mode, the following changes are made to your view settings:

Text Display Mode 1 – Text and background colors are affected by the high contrast setting. You can 
change the font using the Manufacturing Window's Size Preferences option located on the Option 
menu.

Note: Changing the font size also affects the cards in the graphical modes.
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Text Display Mode 2 – The outline text panel do not respond to the high contrast settings. The 
material panel responds to the high contrast setting but is not affected by the Size Preference 
settings—only the background and text colors are affected.

Graphic Display 1 – Graphic Mode 1 does not support high contrast mode.

Graphic Display 2 – Graphic Mode 2 only supports high contrast mode in the material panel and is 
not affected by the Size Preference settings—only the background and text colors are affected.

Grid Display – The Grid Display does not support high contrast mode.

Selecting Two-Window Views
Both graphical and text modes provide an alternate two-window display. Header, operations, and legs 
are shown in one window in their normal graphical or text display. A separate window is provided for 
materials. This is convenient for working with a large number of material requirements on a single 
operation. The separate display lets you better manage the materials. More operations can be viewed 
in a single window, because material requirements only take up screen space for one operation at a 
time.

Selecting Two Window Graphical View
In two-window graphical mode, the screen is split into a top and bottom portion. The graphical display 
shows in the lower section, and materials for the selected operation in the upper section. Only the 
material requirements for a single operation display at any one time. You must select the operation to 
view the materials.

To select the two-window graphical mode:

1 From the View menu, select Graphic Display (2 Window).

A dialog box appears, telling you that you need to refresh the display before you can switch to this 
mode.

2 Click Yes to continue.

The two window graphical mode is switched to.

Selecting Two Window Text View
In two-window text mode, the screen is split into a left and right portion. The normal text display of 
header, legs, and operations shows in the left portion. Materials for the selected operation show in the 
right section. Again, you must select the operation to view the materials.

To select the two-window text mode:

From the View menu, select Text Display Mode (2 Window).
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To select a material in two-window mode, click the material line. The selected line becomes 
highlighted. An arrow does not show the selected material.

The materials appear in the right screen if existing for that operation.

Selecting Objects

Selecting Objects in Graphical Viewing Mode
To select any object, click the box. A left-pointing arrow is shown to the right of the selected box, 
indicating that it is the current object.

You can also use all four cursor keys to navigate the structure. Use up and down keys to move back 
and forth between operations and material requirements in a leg. Use left and right keys to move 
between legs.

Selecting Objects in Text Viewing Mode
To select any object, click its line. A right-pointing arrow is shown to the left of the selected line, 
indicating that it is the current object. You can also use the up and down, left and right cursor keys to 
move around the structure.

Opening Multiple Windows
The Manufacturing window allows you to open work orders, engineering masters, and quote masters 
separately or in combination. Use tile and cascade options to position work orders and masters so 
you can drag and drop information between open windows and compare operation and material 
requirement details. You may want to, for example, open an engineering master and then open 
another window in which you can build a new work order for the engineering master part. Tile the two 
windows and drag and drop the engineering master header card to create a new work order with the 
same attributes of the engineering master. After dragging and dropping work order/master header 
cards, watch the new structure built, and information copied and pasted from one to the other.

Even with multiple windows open, you still have total control over each windows display and size. A 
window must have the default, however, before you can change its settings. You cannot make 
universal changes to open windows. See the previous sections for more information on changing the 
window display and selecting sizes.

Open work orders/masters one at a time using the Open dialog box.

See elsewhere in this chapter for information on searching for existing work orders/masters and 
creating new work orders/masters.
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Arranging Open Windows
With more than one window open, you may want to position the windows for ease of viewing and 
performing drag and drop operations.

Three positioning options are available from the Windows menu.

Tile Vertical – Select this option to vertically tile all open windows. If four or more windows are 
currently open, no distinction is made between a vertical tile and a horizontal tile. Select either menu 
option to position the windows.

Tile Horizontal – Select this option to horizontally tile all open windows. If four or more windows are 
currently open, no distinction is made between a vertical tile and a horizontal tile. Select either menu 
option to position the windows.

Cascade – Select this option to cascade all open windows.

Selecting Open Windows
With multiple windows open and arranged, or with multiple windows open but hidden except for the 
current displayed window, from the Window menu select the Base ID/Lot ID of the work order/master 
you want to have the default position.

With arranged windows, you can click anywhere in a window to make it the default.

Upon selection, the title bar of the default window becomes blue.

Selecting Windows if more than Nine Windows are Open
A maximum of nine windows can be listed in the Window menu. If you have more than nine windows 
open, select More Windows from the Window menu to view a complete list of all open windows.

1 The Selected Windows dialog box appears.

2 Select a window and click Ok.

The work order/master is called up and is assigned to the default window position.

3 Click Cancel to exit the dialog box and return to the main display.

Minimizing & Restoring Windows
You can minimize all open windows at once. To do this, select Minimize All from the Window menu.

All windows are minimized.

To restore windows to their former arrangement, select Restore All from the Window menu.

The former window arrangement is restored.
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You can also minimize windows one at a time. To do this, click the minimize button, found in the top 
right of each window.

To quickly restore a window to its former position, select Restore All from the Window menu.

Closing Windows
Instead of closing open windows one by one, you can close them all at once. To do this, select Close 
All from the Window menu.

All open windows are closed. The Manufacturing window, however, remains open.

Setting Size Preferences
Size preferences allow you to choose font, font size, attributes, and graphical card display 
characteristics for the Manufacturing Window. You can define six separate size preferences that you 
can change at will. You might, for example, set one preference that is useful for viewing details of 
objects, and another that displays a maximum number of objects in the viewing space. You will find 
that the combination of preferences allows you to setup an amazingly large number of different 
display styles.

To set size preferences:

1 From the Options menu, select Size Preference.

2 Select the radio button for the preference you want to modify.

3 Set any of the following font and size parameters:

Font – You can display all text in the Manufacturing Window in any font that is installed on your 
PC. Select the font you want to use from the list.

Font Size – You can select the size of the font. For True Type fonts, you can select any size 
desired. For non-true type fonts, you must select from the list of sizes offered for the font.

Enhancement – You can display the selected font in normal or bold style.

Lines of Text – Choose the number of lines you want to be visible in graphical mode, or the 
number of columns of information to display in text mode. This controls how much the cards 
overlap vertically.

Width – Specify the width of a card in graphical mode, in terms of the number of characters 
shown in the selected font and size.

Height – Specify the height of a card in graphical mode, in terms of the number of characters 
shown in the selected font and size.

Offset – Specify the horizontal distance between edges of successive cards, in terms of the 
number of characters shown in the selected font and size.

4 Optionally, click the Save as Default Sizes check box to indicate that you want to save these 
settings as the permanent defaults for this workstation.
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5 Click Ok to complete the operation, or Cancel to abort the changes.

The display automatically shifts to the last size preference you selected. If you selected Save as 
Defaults, your changes are saved in Preference Maintenance for your workstation. Otherwise, 
any changes you made are only in effect for this use of the Manufacturing Window.

Using Size Preferences
To select from the current size preferences:

Select from Size Preference 1 through Size Preference 6 options in the View menu.

You can also press the SHIFT and function key corresponding to the size. For example, press 
SHIFT+F2 to use size preference 2.

Setting Color Preferences
You can set individual colors for each of the six classes of objects shown on the manufacturing 
window. Unlike Size preferences, there is only one current set of colors.

1 From the Options menu, select Color Preference.

You can set the colors for any of the following classes of objects:

Engineering Master/Work Order – This sets the color for the header line or card. The default 
color for the header is white.

Engineering Leg – This sets the color for the leg/detail line or card. The default color for legs is 
gray.

Internal Operation – Operations for which the Resource ID is for a workcenter or individual/group 
resource. The default color for internal operations is light blue.

Sub-Contracted Operation – Operations for which the Resource ID is for a subcontractor 
resource. The default color for subcontracted operations is light blue.

Material – Material requirements with no part ID. 

Fabricated Material – Material requirements where the required part is a fabricated part. 

Purchased Material – Material requirements where the required part is a purchased part.

Fab and Purc Material – Material requirements where the required part is both fabricated and 
purchased. 

Tool/Fixture/Consumable – Part Maintenance allows you to specify a Part ID as a Tool/Fixture/
Consumable. You can create requirements for these materials in the same way that you make 
normal inventory requirements. This option allows you to display the requirement for the Tool/
Fixture/Consumable in a different color. The default color for these requirements is light green.

Alternate Part – All alternate parts. You can use alternate parts when the required material is 
unavailable.
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Borders/Lines – The color of the border lines of the cards appearing in the window.

In-process Borders – The color of the border lines used on operations that have currently active 
labor tickets. If the operation is the determinant operation, then a thick border line is used. If the 
operation is not the determinant operation, then a thin border line is used. This border is used in 
the graphical display only. 

Exception Fade Factor – If you set up and show exceptions, only cards with exceptions are 
displayed in the colors you specify. Cards without exceptions are displayed in a faded color. The 
faded color is made by combining the color you specify for the object with the primary background 
color you specify. Specify a value to indicate how much of the primary background to use in the 
faded color. The default value is 3. The larger the number you specify, the more of the 
background color is used to fade the color. 

2 Click the Change button next to the object.

The Color dialog box appears. This dialog box allows you to select any Windows RGB color.

3 Click one of the Basic or Custom color boxes.

You can also choose a custom color by dragging the cross-hair around the large box until you find 
the color you want. You can also use the slider at the left to control the luminosity (brightness) of 
the color. The top of the range corresponds to white, and the bottom to black. These automatically 
set Hue/Saturation/Luminosity or Red/Green/Blue values. You can also enter these directly. The 
best thing to do is move the crosshair and the slider around until you find a color you like.

To add the color to the permanent list of custom colors, select the box for the color you want to 
replace, and press Add to Custom Colors. To use this color without adding it to the custom colors, 
just click Ok.

4 Click Ok to change the color. You can also double-click the color box.

Click Cancel to close the Color dialog box without making color changes for this object.

5 In the Background section, select how you want the window background to appear. You can 
select what you want the Primary color to be and if you want the background to fade to another 
color, you can select what you want that to be by selecting the Fade To color. If you selected to 
use a Fade color scheme, you can also select how you want the fade to appear:

Fade Edge – You can select horizontal or Vertical.

Fade Diagonal – You can select up or down.

6 If you want to save the color changes you made as the permanent ones, select the Save as 
Default Colors check box. If you do not select this box, the colors remain in effect for the current 
session only.

7 Click Ok to complete the operation, or Cancel to abort the changes.

Using the Show/Hide Options
There are various Show/Hide options, all located in the View menu, which control which objects are 
displayed and which are hidden in the Manufacturing Window.
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Showing/Hiding Multi-Levels
The Show/Hide Multi-Level option controls how the other Show/Hide functions operate. If you want 
to control the display of all legs on the master/work order, select Show/Hide Multi-Level from the 
View menu. A check mark to the left of the option indicates that it is active.

If you want to set display for individual legs, select Show/Hide Multi-Level from the View menu 
again. The check mark disappears.

The remaining options operate on the entire master/work order if you select Show/Hide Multi-Level. 
Otherwise, the Show/Hide commands only apply to the selected leg.

Showing/Hiding Operations
If you want to focus on material requirements only, select Show/Hide Operations from the View 
menu or press the SHIFT+F10 keys together. This suppresses the display all of the operations. Only 
the header, legs, and material requirements appear. In text mode, this produces an indented bill of 
materials.

To redisplay operations, select Show/Hide Operations again, or select Show All.

Showing/Hiding Materials
If you want to focus on operations only, click the appropriate header card then select Show/Hide 
Materials from the View menu or press SHIFT+F11. This suppresses the display of all material 
requirements. Only the header, legs, and operations appear. This option does not apply to two-
window modes, because the materials always appear in the second window.

To redisplay materials, select Show/Hide Materials again, or select Show All.

Hiding All
If you want to focus only on the subassembly structure of the master/work order, select Hide All from 
the View menu or press the minus (-) key on the number keypad of your keyboard. This suppresses 
the display of all operations and material requirements, leaving only the header and leg details.

Showing All
Select Show All, or press the plus (+) key on the number keypad of your keyboard to quickly 
redisplay all operations, material requirements, and legs.
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Using the Jump Options
These functions control which portion of the master/work order appears on the available screen 
space. They help you navigate around a large structure that you cannot view on a single screen. All 
three Jump options place an object in the “home position.” For graphic display, home position is the 
lower left corner of the screen. For text display, home position is the top line of the screen. These 
functions are all located in the View menu.

Using Jump Home
Select Jump Home from the View menu to place the master/work order header in the home position.

Using Jump
Select Jump from the View menu to place the currently selected object in the home position. This 
allows you to pick a starting point from which to work. You can also use SHIFT+F8 to activate this 
function.

Using Jump Up
Select Jump Up from the View menu to place the parent leg header or master/work order header of 
the selected object in the home position. For example, if you select the fifth operation on a leg, and 
select Jump Up, the leg header for the leg is placed into home position. This lets you focus on a 
particular leg to work on. You can also use SHIFT+F9 to activate this function.

Understanding the Manufacturing Window Display
The Manufacturing Window provides you with detailed information for each object. The following data 
appears on the faces of cards in graphical modes, and on the lines in text mode. In one-window 
graphical mode, information appears on subsequent lines of the index card. The cards appear front to 
back in the following order: header information, material requirements for an operation, then 
operations.

For one-window text mode, all information appears on one line. For two-window text mode, limited 
information appears for headers and operations, and material information appears in a separate 
window.
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Popup Cards
In all display modes, you can get a full summary of information for an object by placing the pointer on 
the object and pressing the right mouse button. An informational index card appears with one to four 
lines of information concerning the object.

You can display the popup card for multiple objects without releasing the right mouse button—simply 
drag the pointer around to each object, and the card automatically changes.

Customizing Cards
You can customize the information on cards. Cards are used in the graphical display. They are also 
used in the text display as pop up cards. For materials, you can customize the information that is 
displayed on the third line and add a fourth line of information. For the leg, operation, and service 
cards, you can add a fourth line of information.

To customize pop up cards:

1 Select Options, Card Line Preferences.

2 To select the card type and line to set up, specify these options:

Object Type – Specify the card type to set up. You can select Leg, Material, Operation, or 
Service.

Line # – Specify the line number to set up. For Materials, you can select 3 or 4. If you select 3, the 
current information displayed on the line is inserted in the table. For all other object types, 4 is the 
only available selection.

3 To specify the information to include on the line, click Insert. 

4 Specify this information:

Data Column – Click the arrow and select the data to include.

Hide If – Specify the conditions under which this information is hidden. Select Zero to hide this 
information if the value is zero. Select Null to hide this information if the value is blank. Leave this 
field blank to always show the information.

Operation 70 Card

Operation 60 Card
Material for Operation 60

Operation 50 Card
Operation 40 Card

Materials for Operation 40

Operation 30 Card
Operation 20 Card

Operation 10 Card
Materials for Operation 10

Header Card

Currently 
Selected Card
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Prefix – Specify text to include before the data.

Suffix – Specify text to include after the data.

As you specify information, the text that will be displayed on the card line is inserted below the 
table. Tokens (for example, %1) are used to indicate where the information you selected will be 
displayed. The token is replaced by the value from the database when you access the pop up 
card.

While there is no limit to the number of pieces of information you can add to a line, the size of the 
pop up card is limited. If you specify too many pieces of information, some of the information may 
be truncated.

5 Click Ok. 

Header Information
The Header Information is on the front card. The header information differs slightly for work orders, 
engineering masters, and quote masters.

Header Card
Line 1 of the header card in graphical mode and column 1 in Text Mode contains the following 
information.

Type

For an engineering master, the letter M is used.

For a quote master, the letter Q is used.

For a work order, the current status of the work order is shown in parentheses. U for unreleased, F for 
firm, R for released, C for closed, and X for cancelled.

Base ID
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For an engineering master, this is Base ID/Engineering ID. Engineering ID is omitted if it is zero. 
Remember that the Base ID is always the Part ID.

For a quote master, this is the Base ID/Engineering ID. Remember that the Base ID is always the 
Quote ID, and the Engineering ID refers to the line within the quote.

For a work order, this is the Base ID/Lot ID.Split ID.

Part ID

Identifies the part associated with the master/work order. For a work order, this may be blank if it’s a 
custom job.

Part Description

The description of the part from Part Maintenance.

Card Line 2/Text Column 2 Information
Quantity

For an engineering master, this is the standard lot size.

For a work order, this is the desired quantity.

Specifications

The first line of the specifications from the master/work order header.

Card Line 3/Text Column 3 Information
The information in the third line applies only to work orders.

Days Early/Late

The difference between the scheduled finish date and the current date. A negative value indicates a 
late order, a positive value an early one.

Desired Want Date

The date by which you want the work order completed.

Scheduled Finish Date

The scheduled Finish Date of the work order as determined by the Global Scheduler. This appears in 
parentheses

Desired Start Date

The date on which you want to start the work order.

Scheduled Start Date

The scheduled start date of the work order as determined by the Global Scheduler.
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Card Line 4/Text Column 4 Information
Elapsed Days

The elapsed days between release date and the current date.

True Prod. Hours

The total setup and run time for all operations on all legs, irrespective of calendar time taken to 
perform them.

Viewing Header Information in the Engineering/Work Order Dialog Box
You can also view the header information by double clicking on the header card in graphical mode, 
the first row in grid mode, or the first line in the first column in text mode.

Material Requirement Information
If an operation requires certain materials, Material Requirement information precedes the operation 
information after the Header card.

If the Popup menu is not enabled, you can view the entire contents of the material requirement card 
by right-clicking the card and holding the mouse button down. 

To verify that the Popup menu is not enabled, select the Options menu. If a check mark is displayed 
next to Popup Menu, select Popup Menu to clear the check mark. 

You can color-code the cards to indicate the type of material that is required. See "Setting Color 
Preferences" on page 3–33 in this guide.

Card Line 1/Text Column 1 Information
Piece No.

The piece number for the material requirement within the operation.

Part ID

For an inventory part, the Part ID. Otherwise, this is blank.

Description

For an inventory part, description of the Part ID from Part Maintenance. Otherwise, the specifications 
for the material are displayed here.



Choosing a Manufacturing Window Interface

Infor VISUAL Inventory User’s Guide | 3 – 41

Card Line 2/Text Column 1
Status

For work orders only, the status of the material requirement is shown.

Date

For work orders only, the required date of the material is shown. This is usually equal to the start date 
of the operation. If the material has been issued, then the last issue date is shown instead. Not shown 
in two-window mode.

Qty Required

The calculated quantity required, in terms of the stock unit of measure. Not shown in two-window 
mode.

Card Line 3/Text Column 3 Information
This information is provided by default. You can customize the information that is displayed on the 
third line. See "Customizing Cards" on page 3–37 in this guide.

Quantity Per

The Quantity Per from the material requirement.

Scrap Percent

The Scrap percent from the material requirement.

Fixed Quantity

The Fixed quantity from the material requirement.

Viewing Material Information in the Material Information Window
You can also view the material information by double clicking on the material card in graphical mode 
or the first line in the first column in text mode.
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Operation Information
Operation information cards follow any material requirement cards for that operation.

If the Popup menu is not enabled, you can view the entire contents of the operation card by right-
clicking the card and holding the mouse button down.

To verify that the Popup menu is not enabled, select the Options menu. If a check mark is displayed 
next to Popup Menu, select Popup Menu to clear the check mark. 

You can color-code the cards to indicate whether the operation is an internal operation or sub-
contracted. You can also add a border to identify the operations with active, in-process labor tickets. If 
the operation is determinant, then a thick border is drawn. Otherwise, a thin border is drawn. See 
"Setting Color Preferences" on page 3–33 in this guide.

Card Line 1/Text Column 1 Information
Seq. No.

The sequence number for the operation.

Resource ID

The primary Resource ID for the operation.

Specifications

The description or other specifications for the operation.

Card Line 2/Text Column 2 Information
These items appear only for work orders.

Status

The status of the individual operation. An additional status of S/U indicates that the operation is 
released and the setup portion has been completed.

Start and Finish Date

The scheduled Start Date and scheduled Finish Date, if the work order has been scheduled.

Delay

The days delay for the operation appears in parentheses. This indicates the difference between the 
time the operation could finish with an ideal schedule, and the time it is actually scheduled to finish.
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Card Line 3/Text Column 3 Information
For In-House Operations:

Setup Time – The setup hours for the operation.

Run Time – The calculated run hours for the operation.

For Subcontracted Operations:

Service ID – Service ID specified in operation.

Transit Days – Number of transit days for service, specified in operation.

Quantity In – The Start Quantity as discussed previously.

Quantity Out – The End Quantity as discussed previously.

Viewing Operation Information in the Operation Information Window
You can view the operation information by double clicking on the operation card in graphical mode or 
the first line in the first column in text mode. Also, you can point to an operation card and select Edit 
from the Edit menu.

Leg Information
The leg information card displays similar information to the header card.

Card Line 1/Text Column 1 Information
Type

For an engineering master, the letter M is used.

For a quote master, the letter Q is used.

For a work order, the current status of the work order is shown in parentheses: U for unreleased, F for 
firm, R for released, C for closed, and X for cancelled.

Base ID

For an engineering master, this is Base ID/Engineering ID. Engineering ID is omitted if it is zero. 
Remember that the Base ID is always the Part ID.

For a quote master, this is the Base ID/Engineering ID. Remember that the Base ID is always the 
Quote ID, and the Engineering ID refers to the line within the quote.
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For a work order, this is the Base ID/Lot ID.Split ID.

Part ID

Identifies the part associated with the master/work order. For a work order, this may be blank if it’s a 
custom job.

Part Description

The description of the part from Part Maintenance.

Card Line 2/Text Column 2
Quantity Per – As specified for the leg.

Specifications – The first line of the specifications from the leg header.

Card Line 3/Text Column 3
This information appears for work orders only.

Days Early/Late – This is the difference between the scheduled finish date and the current date. A 
negative value indicates a late order, a positive value an early one.

Scheduled Start – The scheduled Start Date of the leg as determined by the Concurrent Scheduler.

Scheduled Finish – The scheduled Finish Date of the leg as determined by the Concurrent 
Scheduler.

Completion Meters
For work orders, a horizontal bar appears at the top of each card in graphical mode, and to the left of 
each line in text mode. This bar indicates the percentage of the total completion for the object. It 
begins empty, and fills in black as work progresses. If you over receive the item, the completion meter 
extends past the right of the card.

For the header, the bar indicates the percentage of goods received into finished goods versus the 
total desired quantity. For operations, the bar shows the percentage of Quantity Completed reported 
through labor ticket entry or service entry versus the End Quantity required of the operation. For 
material requirements, the bar shows the percentage of material issued though inventory transaction 
entry versus the total calculated quantity required.
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Determinant Path
The “determinant path” for a work order is the string of operations (a path) that controls the total 
duration of the work order. Whereas “critical path” is the controlling path in an ideally scheduled work 
order, the determinant path also takes into account schedule delays caused by unavailability of 
resources.

Determinant path for a work order is shown in the graphical mode of the Manufacturing Window by a 
darker outline around each operation on the path. The work order must be scheduled into the 
production schedule to show a determinate path.

Operations 10, 20, and 40 are part of the determinant path.

In the example above, notice the dark outline around operations 10, 20, and 40. These operations are 
part of the determinant path.
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Creating Engineering Masters
Engineering masters are basic templates for your fabricated parts. 

Engineering masters, quote masters, and work orders function similarly. Most of the procedures 
described in this section apply to both quote masters and work orders. Functions specific to quote 
masters and work orders are described in subsequent sections. 

Be sure you have read the “Manufacturing Windows Concepts” and “Choosing a Manufacturing 
Window Interface” sections of this chapter before attempting to work with masters and work orders.

To create an engineering master:

1 Select New from the File menu or click the New button on the main toolbar.

If another master/work order is currently loaded in the Manufacturing Window, it is automatically 
closed when you finish creating the new master.

2 Click the Engineering Master option.

3 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you are 
creating this engineering master. If you are licensed to use a single site, this field is unavailable.

4 To create an engineering master for an existing part, click the Part ID browse and select the part. 

To create an engineering master for a new part, specify the Part ID in the Part ID field. Specify a 
description for the part and whether the part is Purchased, Fabricated or Detail Only.

After you complete the engineering master, open the new part in Part Maintenance to complete 
the part record. 

5 Click the Warehouse ID button to select from a list of warehouses that carry that part.

If the part is new, no warehouses exist for it.

Enter a valid warehouse in the Warehouse ID field. When the dialog box appears asking you if 
you want to add this as a warehouse for the part, click Yes.

6 Enter an Engineering ID (Eng ID).

The Engineering ID allows multiple versions of the master for a fabricated part. In Part 
Maintenance, you specify the Engineering ID of the default master to use in creating work orders 
for the part. Other masters can exist, but you must explicitly provide the engineering ID to use.

If you are licensed to use multiple sites, the engineering ID is used to differentiate masters for the 
same part in different sites.

7 Specify the Quantity for a standard lot size for this part.

8 Enter or view the following Engineering Information on the General tab:

Specifications – This is a multi-line text field that lets you enter specification text to describe the 
engineering master. Use the Copy and Paste buttons to copy the entire contents of the 
Specifications window, or to replace the entire contents of the window with the clipboard.

Engineered By – Specifies the person responsible for the master.

Engineered Date – Date associated with this revision of the master. Selection of Engineering 
Date can also be done from the Calendar object provided.
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Drawing Number – Drawing number of the engineering drawing for this master.

Drawing Rev – Revision of the drawing number for this master.

Drawing File – The path to drawing file.

Entered By – The method used to create the master. This field is populated by the system. See 
"Working with Information in the Entered By Field" on page 3–80 in this guide.

Product Code – The Code associated with a product of this master. Each product code can have 
a unique G/L account for inventory, WIP, and cost of goods sold. Select a product code from the 
drop down menu.

Commodity Code – The Code associated with a Commodity of this master. Select a commodity 
from the drop down menu. You can also enter the Commodity Code and save the information by 
clicking Save. See the Material Planning Window for more information.

Traveller Printed – The date and time the work order traveller report was printed.

Current Stage/Rev – If an engineering change notice has been applied to this master, the system 
inserts the current ECN stage and revision level. 

Original Stage/Rev – If an engineering change has been applied to this master, the system 
inserts the original ECN stage and revision level. 

Stock U/M – The system inserts the stock unit of measure as defined in Part Maintenance. 

Customer Priority – This field is used in conjunction with VISUAL Shop Floor. Optionally, specify 
a priority level for this work order. You can specify a value between 0 and 3. For example, if this 
work order is for a particularly important customer, you could specify a priority of 1. In the VISUAL 
Shop Floor app, the priority level is indicated with a 1, 2, and 3 icon. If you specify 0 for the 
customer priority, no priority icon is displayed in VISUAL Shop Floor. 

A system administrator can control access to this field. 

9 Select the Forward Schedule from Release Date check box to force the forward scheduling of 
work orders with this engineering master.

If left clear, work orders are scheduled backwards from their want date. You can change this 
option for each individual work order created from this master.

Select the Treat Release Date as Hard check box to ensure hard release dates for work orders 
with this engineering master. When scheduling work orders with a hard release date, a work 
order’s Release Date is strictly obeyed as being the earliest point work may begin on the order.

10 Specify how to report labor for all operations in this master. The settings that you specify are 
copied to work orders that you generate from the master. If the fields listed below are unavailable, 
then the information has been specified in Site Maintenance and cannot be customized for this 
master:

Percent Complete – To record labor by percentage complete instead of quantity complete, select 
this check box. When a user selects an operation that uses percentage complete reporting, labels 
in the labor ticket entry programs are updated to indicate that quantities are reported as 
percentages. If you use BTS, a Percent Completed prompt is displayed. 

Quantity Complete by Hours – To automatically calculate quantity complete or percentage of 
completion based on the hours reported on the labor ticket, select this check box.
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If you report labor based on quantity complete, then this calculation is made to determine the 
quantity completed during the labor ticket:

(hours reported on ticket/total estimated hours for operation) * operation quantity

If you report labor based on percentage complete, then this calculation is made to determine the 
percentage:

(hours reported on ticket/estimated hours for operation) * 100

The operation is automatically closed when the quantity or percentage complete equals or 
exceeds the operation quantity. 

If you select the Quantity Complete by Hours check box in Site Maintenance, then all run type 
labor transactions are automatically calculated. .

Max Percent Completed – If you selected the Quantity Complete by Hours check box, use this 
field to specify the maximum percentage that can be calculated automatically. When the 
percentage complete meets the threshold that you specify, automatic calculation of quantity 
complete is stopped. The operation remains on your schedule until the operation is manually 
closed. This formula is used to calculate the number of hours for the operation that remain on 
your schedule:

((100 - value specified in Max Percent Completed field)/100) * total hours required for the 
operation

To complete the labor on an operations, users must manually close the operation. See 
"Completing Labor on Operations with Max Percent Complete Thresholds" on page 7–14 in this 
guide. 

11 To prevent this engineering master from being used to generate a work order or to be considered 
in planning and scheduling, select the Inactive check box. You can select this check box if the 
engineering master is in process and not yet complete. You can only select this check box if the 
engineering master is not specified in the Eng Master ID field in Part Maintenance. 

To allow this engineering master to be used to generate a work order and to be used in 
scheduling and planning, clear the Inactive check box.

12 Select the Allow Alternate Parts check box to allow alternate parts to be used in place of the 
material requirements specified on the master. When you select this option, the system activates 
the Alternate Parts tab on any material requirements you add to the master. If the originally 
specified part is unavailable when the master goes into production, you can use an alternate part 
instead. Clear the check box to prevent the use of alternate parts on a master. 

13 Click the Pict/Object button to associated a graphic with the engineering master. This provides 
shop floor access to the object.

14 Click the Variables button to define variable dimensions referenced in material requirements.

To add a variable to the master, click the Insert button to add a new line to the table, then enter 
the following information on the new line:

Name – The name that is used to reference the variable in material requirement dimensions.

Variable – The numerical value that the variable assumes.

Continue to add as many lines as needed using this procedure. For example, you might add 
variables named LENGTH, WIDTH, and DEPTH.
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15 Click Ok when finished.

When a work order is created from this master, the value you specify here is copied as the 
default. You can then modify the variable values for each new work order. This allows you to 
adjust work order required quantities without modifying individual material requirements.

16 Click the G/L Accts button to override WIP G/L Accounts.

If you are using the Infor VISUAL Financials  interface, there are four general ledger accounts 
associated with a work order. These are Work in Process accounts for each of the four cost 
categories: Material, Labor, Burden, and Service.

Normally, these accounts are read from the Product Code definition, if one is associated with the 
Part ID, or from the default G/L account interface settings.

If you want to override them for any work order produced from this master, enter each account, or 
select one by pressing the appropriate button.

17 Click Ok to save the changes.

18 Click the User Defined tab, and select a User Defined Field Layout ID if appropriate. 

19 Click the Engineering tab to designate this master as eligible for updating with the Master 
Updater function. 

This tab also displays information about when the master was last updated. See "Using the Leg/
Master Updater" on page 3–97 in this guide

20 Click Save to create the new master.

The master header appears in the window in home position, and the dialog box automatically 
closes.

Adding Operations
After you create the base master, you can begin to add operations to it. There must be at least one 
operation for you to specify material requirements or legs. Because each operation is different and 
your requirements for operation information may vary, the procedure below describes how to add an 
operation with only the basic operation information. Procedures for adding supplemental operation 
information follow this procedure.

1 Select the header or leg to which you want to add the operation.

You may select the leg by clicking on the master header (if you want to add to the main leg) or a 
leg header. You can also select a leg by clicking on any other operation or material on the same 
leg.

For a new master, your only option is to select the header to add the first operation.

2 Select Add Operation from the Edit menu, click the Add Operation button on the Form toolbar, 
press CTRL+O or, if your popup menu is active, right-click the header card and select Add 
Operation from the popup menu.

3 Specify an Operation Type, if any.
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You can define Operation Types in Shop Resource Maintenance; they act as operation templates 
and can contain all of the information you need to fill in here.

If you want to use a template, enter its name, or select it from the drop-down menu.

You are asked to confirm that you want to copy the default information in the type. If you select 
Yes, all of the information in the operation type is copied into this operation.

You can set up a preference in Preferences Maintenance to always load the default information 
type and suppress this message. See "Suppressing the Load Defaults from Operation Type 
Message" on page 3–59 in this guide.

4 Adjust the Sequence Number, if necessary.

The Sequence Number identifies the operation within the selected leg. By default, numbers are 
generated in increments of ten. The sequence number for a new operation always defaults to ten 
plus the last operation number, so the new operation is added to the end.

If you want to add the operation at another position, adjust the sequence number so that it is in 
between the two surrounding operations.

Note: When building masters, be sure to leave enough room between operation sequence 
numbers. If you feel you may add more than nine operations between the current ones, use 
increments larger than ten.

5 Specify a Resource ID.

Each operation must specify the Resource ID of the shop resource it uses. You can enter the ID, 
or select it by pressing the Resource ID button. You can modify the Setup, Run time, Duration and 
At Start for the selected resource. Shop Resources are defined in Shop Resource Maintenance.

If you are licensed to use multiple sites, you can select only those resources that exist in the site 
on the header card. If you are licensed to use a single site, you can select any resource in your 
database.

6 If you specified a subcontractor resource, enter the Service ID, or click the Service ID button and 
select a Service ID from the table.

You can define Service IDs in Service Maintenance. They define information for the actual service 
that you are using to meet the resource requirement.

If you are licensed to use multiple sites, you can select only those services that exist in the site on 
the header card. If you are licensed to use a single site, you can select any service in your 
database.

7 Enter Setup and Run Information, including:

Setup hrs – Enter a setup time if it applies. The default is zero.

Run/Run Type – Use the Run and Run Type fields together to express the run time.

In the Run field, enter the number of the run, which you qualify in the Run Type filed.

You can specify run time in Hours/Piece, Pieces/Hour, Minutes/Piece, Pieces/Minute, Hours/
Load, Loads/Hour. Keep in mind that “piece” refers to any unit quantity of the material.

For example, if a product is produced in feet, and you know it takes 15 minutes to produce a foot, 
the run time is 15 Minutes per Piece. Enter 15 in the Run field, and Minutes/Piece in the Run Type 
field.
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Load – You can also express run time in terms of a standard load size for the resource. Use the 
field when the material is processed in discrete loads. When you specify Hours/Load or Loads/
Hour, you must also provide the load size.

The Start Quantity for the operation is broken into the number of loads needed. For example, if 
101 units are incoming and the load size is 100, two loads will need to be processed to complete 
the job.

For subcontractor operations, enter Transit Days in the Transit Days field. This is the total time 
between the start of the operation and the time the material is back in house and ready for the 
next operation.

You enter this information instead of setup and run time.

8 Enter any text specifications in the multi-line Specifications field.

These specifications appear in the Manufacturing Window, engineering reports, and shop 
traveller.

9 Enter the Move Information.

In the Move Hrs field, enter the number of hours that must pass between the end of this operation 
and the beginning of the next.

In the Min Move Qty field, enter the minimum number of pieces, or quantity of material, that can 
be moved from one operation to the next when the total operation is not yet complete. This allows 
scheduling of overlapping operations based on a continuous quantity feeding from one to the 
next. Leave this field blank to specify no overlap.

To specify the maximum overlap possible, enter 0.0001, the smallest minimum move quantity 
supported. This essentially schedules the operations in parallel.

If you specify a minimum move quantity on an operation that uses a rate-based part as a material 
requirement, the minimum move quantity determines when the current operation can begin and 
when the subsequent operation can begin. See "Rate-based Parts" on page 5–1 in this guide.

10 Click the Save button on the main toolbar.

The operation is added to the Manufacturing Window.

If you want to quickly add an operation with minimal details, clear the Operation Edit Form option on 
the Views menu.

When you add an operation, the system displays a table of resources. Select the resource you want 
to use for the operation.

An operation for that resource is created with the next sequential number using only the information 
from the resource.

Note: If you have opened the Operation child window, you can use the Show/Hide Edit Operation 
Form toolbar buttons to hide or show the Operation window.

Entering Scrap/Yield Information
You can add scrap and yield information to a new operation.
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1 From the Operation dialog box, click the Scrap/Yield tab.

2 Enter the Scrap/Yield percent for the operation. 

3 Use the radio buttons to indicate whether the percentage represents the final yield from the Start 
Quantity, or the scrap lost from that quantity.

4 Enter the fixed scrap quantity.

5 Click the Override Quantities check box to override the quantities that are automatically 
calculated.

Operation scrap factors are automatically used to calculate the quantity of in process material that 
should enter and leave this operation. In some cases, you may want to override one or both of 
these quantities.

This feature forces a unit of measure change during the manufacturing process.

For example, your company may produce a product in terms of a desired number of discrete 
pieces. The first three operations, however, may involve batch processing of some raw material 
that are measured in kilograms. In this case, you want the first three operations to work in 
kilograms, and the rest to work in Each.

Start and End Quantity are automatically calculated, working back from the last operation. You 
can therefore use Override Quantities to change the Start and End for the first three operations to 
be expressed in kilograms rather than Each. You can also use a leg to represent the material 
processing part of the process.

When you select the Override Quantities check box, the Start Quantity and End Quantity that are 
calculated appear. You can then change these as appropriate.

In graphical mode, a lower case q appears to the upper right of the card for the operation, to alert 
you that you have overridden quantities for this operation.

6 In the Inspection section, specify whether an inspection is required during this operation. Specify 
this information:

Required on Setup – Select this check box if inspection is required during the set up of the 
operation. 

Required on Run – Select this check box if inspection is required during the production run.

Plan ID – If you use Infor Quality Management, specify the ID of the inspection plan. After you 
specify an ID, click the Open button to view the plan in IQM.

If you specified an auto-reporting resource in the Resource ID field or an outside service in the 
Service ID field, then the inspection check boxes and field are not available. 

7 Click the Save button on the Form toolbar to save the new information.
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Specifying Predecessor Operations
Specify a predecessor operation on the Other tab. The operation that you specify as the predecessor 
operation must be scheduled to be complete before the selected operation. For example, if you 
specify 4/20 as the predecessor operation of operation 5/10, then operation 4/20 is scheduled to be 
complete before operation 5/10.

You can specify any operation as the predecessor of another operation provided that the predecessor 
operation is not in the same sub ID structure. If you specify a predecessor operation that would result 
in a loop, the system prevents you from saving the predecessor operation. For example, if you specify 
4/20 as the predecessor operation of operation 5/10, you could not successfully specify 5/10 as the 
predecessor of 4/20. 

To specify a predecessor operation:

1 Open the operation card you want to use. The operation you open is the operation that has a 
required predecessor.

2 Click the Other tab.

3 Click the Pred Sub ID browse button and select the operation that must be completed before the 
work on the operation you are viewing can begin.

4 Click Save.

When the system schedules the work order, the system schedules the predecessor operation before 
the selected operation. 

Viewing Predecessor Operations
You can view the predecessor operations defined on a work order or engineering master. Select Info, 
Precdecessor Operations. The system displays operations along with their predecessors.

Selecting a Test ID
You can use the Manufacturing quality modules to test the operations in your engineering master. By 
testing the results of each operation, you can ensure that the product is correct before beginning the 
next operation. 

1 From the Operation dialog box, click the Other tab.

2 Click the Test ID button to select a predefined test from Statistical Process Control.

The List of Tests dialog box appears.

3 Select a Test ID and click Ok.

4 Click Save on the Form toolbar to save the new information.

The test is ran after you enter the results in Statistical Process Control.
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Specifying a Drawing Number
If there is a specific drawing associated with this operation, you can enter its drawing number and 
revision number in the fields in the Other section of the Operation dialog box.

1 Enter the drawing number in the Drawing # field.

2 Enter the revision number in the Rev field.

3 Enter the drawing file name for this part. You can click the icons to browse and select a drawing.

4 Click Save on the Form toolbar to save the new information.

Specifying When Setup Can Begin
Use the Setup Overlaps Previous Operation check box to specify whether the setup process for the 
operation can begin before the previous operation is complete.

1 Open the work order. You must manually specify this setting on each work order. You cannot copy 
the setting from an engineering master, from another work order, or by using drag-and-drop. 

2 On the Operation card, click the Other tab.

3 If the operation can be set up while the previous operation is in process, select the Setup 
Overlaps Previous Operation check box. When you schedule the operation, the setup portion of 
the operation overlaps the previous operation. 

If the first operation in the work order has a fabricated material requirement, select this check box 
to indicate that the operation can overlap the last operation of the work order that produces the 
material requirement. 

If the first operation in the work order does not have a fabricated material requirement, then 
selecting the check box has no effect on scheduling. 

If the previous operation must be completed before the set up can begin, clear the check box.

Setting Up Labor Reporting
If percent complete, quantity complete by hours, and max percent completed information has not 
been set up in Site Maintenance or on the Header card, you can specify the information on the 
Operation card. 

1 Select Eng/Mfg, Manufacturing Window.

2 Open the master that contains the operation.

3 Open the operation card.

4 Click the Other tab.

5 Specify this information:
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Percent Complete – To record labor by percentage complete instead of quantity complete, select 
this check box. When a user reports labor for the run of this operation, labels in the labor ticket 
entry programs are updated to indicate that quantities are reported as percentages. 

Quantity Complete by Hours – To automatically calculate quantity complete or percentage of 
completion based on the hours reported on the labor ticket, select this check box.

If you report labor based on quantity complete, then this calculation is made to determine the 
quantity completed during the labor ticket:

(hours reported on ticket/total estimated hours for operation) * operation quantity

If you report labor based on percentage complete, then this calculation is made to determine the 
percentage:

(hours reported on ticket/estimated hours for operation) * 100

The operation is automatically closed when the quantity or percentage complete equals or 
exceeds the operation quantity. 

If you select the Quantity Complete by Hours check box in Site Maintenance, then all run type 
labor transactions are automatically calculated. 

Max Percent Completed – If you selected the Quantity Complete by Hours check box, use this 
field to specify the maximum percentage that can be calculated automatically. When the 
percentage complete meets the threshold that you specify, automatic calculation of quantity 
complete is stopped. The operation remains on your schedule until the operation is manually 
closed. This formula is used to calculate the number of hours for the operation that remain on 
your schedule:

((100 - value specified in Max Percent Completed field)/100) * total hours required for the 
operation

To complete the labor on an operations, users must manually close the operation. See 
"Completing Labor on Operations with Max Percent Complete Thresholds" on page 7–14 in this 
guide. 

6 Click Save. 

Scheduling Discontinuous Operations
You can override the default values for discontinuous operations in the Other section of the Operation 
dialog box; the defaults are set in Shop Resource Maintenance.

1 Select or clear the Schedule Discontinuous check box to turn that feature on or off, depending 
on how it is set from Shop Resource Maintenance.

2 If you are enabling discontinuous operations, specify the minimum segment size for the operation 
in the Min Segment Size (Hours) field.

The minimum segment size is the minimum number of hours of run that should be scheduled in 
one segment.

3 Click Save on the Form toolbar to save the new information.
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Specifying Capacity Use Information
You can specify minimum and maximum number of resource units needed for the operation in the 
Other section of the Operation dialog box.

1 Enter a minimum number of resource units needed for this operation in the Capacity Use - Min 
field.

Enter a maximum number of resource units this operation will use in the Capacity Use - Max field.

2 Click Save on the Form toolbar to save the new information.

Overriding Costs
By default, standard resource rates are copied into the 10 cost fields when you save the operation. If 
you want to override one or more of these values, you can do that in the Costs section of the 
Operation dialog box.

1 Click the Costs tab in the Operation dialog box.

The Costs information appears.

2 Enter information into the following costing fields:

Setup cost per hour – The costs involved in setting up the operation per hour. For example, if 
your setup time for the operation is two hours and your setup cost per hour is $25.00, your setup 
cost equals $50.00.

Run cost per hour – The costs involved in running the operation per hour. For example, if your 
run time for the operation is a half hour and your run cost per hour is $50.00, your run cost equals 
$25.00.

Run cost per unit – The costs involved in producing one unit. In most manufacturing situations, 
either run cost per hour or run cost per unit is used, rarely both. For example, if your run cost per 
unit is $50.00 and you produce 10 units, your total run cost is $500.00.

Setup burden % – The burden rate for setting up the operation, calculated as a percent of setup 
labor.

Setup burden/hr – The burden involved in setting up the operation per hour. For example, if your 
setup time for the operation is two hours and your setup burden cost per hour is $10.00, your 
setup cost equals $20.00.

Run burden/hr – The burden involved in running the operation per hour. For example, if your run 
time for the operation is a half hour and your run burden per hour is $20.00, your run cost equals 
$10.00.

Run burden/unit – The burden involved in producing one unit. In most manufacturing situations, 
either run burden per hour or run burden per unit is used, rarely both. For example, if your run 
burden per unit is $10.00 and you produce 10 units, your total run cost is $100.00.

Run burden % – The burden rate for running the operation, calculated as a percent of run labor.

Fixed burden – A one time burden amount, regardless of other burden.
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Don’t Reset – Select this check box to prevent costs from being reset.

Overriding costs affects only the estimated cost of the work order. Actual rates are always taken 
from resource masters (for standard costing) or employee labor rates (for actual costing). 

3 Click Save on the Form toolbar to save the new information.

Specifying Concurrent Resources
An operation can require more than one shop resource. The additional resources are used 
concurrently with the resource you specify in the operation card header. Specify the additional 
resources on the Advanced tab.

1 In the Operation dialog box, click the Advanced tab.

The Concurrent Resources information is displayed.

2 Click the Insert Row button.

3 Specify this information:

Resource ID – Specify the ID of the resource that runs concurrently with the resource specified 
on the operation. 

Setup – If the resource is used concurrently during the setup of the operation, select this check 
box.

Run – If the resource is used concurrently during the run of the operation, select this check box.

Duration % – Specify the percentage of the total operation time that this resource is used. For 
example, if the resource is used during half of the total operation time, specify 50.

At Start –  If the resource is concurrent from the start of the operation, select this check box. If the 
resource is concurrent at the end of the operation, clear this check box. 

# Mem to Schedule – If you specified a group resource in the Resource ID column, and the 
group schedules its members individually, specify the number of members in the group that 
should be scheduled. A group resource schedules its members individually when the Schedule 
One option is selected in the Group Exclusivity section in Shop Resource Maintenance. See 
"Adding Shop Resources" on page 2–3 in this guide.

The total duration of the run time is split among the number of members that you schedule. For 
example, presume the total run time for an operation is 5 hours. If you specify 100% in the 
Duration % column and 2 in the # Mem to Schedule column, then each member is scheduled for 
2.5 hours. For setup time, the full setup duration is scheduled for each resource. For example, if 
the setup time on the operation is 2 hours, and you specified 50% in the Duration % column and 2 
in the # Mem to Schedule column, then each member is scheduled for one hour of setup time. 

# Group Members – If you specified a group resource in the Resource ID column, and the group 
schedules its members individually, the total number of members in the group is displayed this 
column. 



Creating Engineering Masters

3 – 58 | Infor VISUAL Inventory User’s Guide 

Sched Eq. Cap. – Select this check box to schedule the concurrent resource on the same 
number of units as the primary resource in the operation. For example, if you specified 2 in the 
Capacity use - max and Capacity use - min fields on the Other tab, select this check box to also 
use two units of the concurrent resource. If the concurrent resource is a group resource, you must 
specify 1 in the # Mem to Schedule column before you can select this check box.

4 Click Save.

After you save the concurrent resources, a letter C is displayed outside the upper left corner of the 
graphical operation card. The C indicates that concurrent resources are present for this operation. 
The C is displayed in the Graphical display mode only. 

Adding Outside Service Information
If you specified a Contractor resource type, the Service tab is available. Use the Service tab to specify 
outside service vendor information.

1 In the Operation window, click the Service tab.

2 Click the Vendor ID button to select the vendor that provides this service.

3 Click the Vendor Service ID button to select a the Vendor Service ID for this outside service.

4 Click the Service Part ID button to select the part that you are sending out to be serviced.

Note: If you have set up this information in Outside Service Maintenance, the Service Part ID is 
automatically inserted. If you want to override this, click in Service Part ID button and select the 
part you want to use. Depending on how you have set up this outside service, this part may not be 
the same part you have described on this Work Order’s Header Card.

5 Click the Warehouse ID button to select a warehouse ID for the outside service provider.

6 Click the Save button on the main toolbar to save any changes to the Operation dialog box.

Using Operation User Defined Field Labels
You can specify user defined field labels for operations in work orders. Each operation may have a 
different label. You cannot, however, define new user defined field label layouts from the Operations 
window. To define new label layouts, use Customer Maintenance, Part Maintenance, or Vendor 
Maintenance. After you create label layout IDs, they are available system-wide, wherever user 
defined fields are present. 

1 Click the User Defined tab.

2 From the User Defined Field Layout ID list box, select a Label ID for the operation.

The Label ID fields appear.

3 Enter any necessary information in the fields. In the graphic above, the fields pertain to the 
operation itself and any personnel who may participate in the completion of the operation. The 
greatest advantage of user defined fields is that they allow you to maintain operation-specific 
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information, so throughout the enterprise you can record and share special information with those 
who have access to the Manufacturing Window.

Suppressing the Load Defaults from Operation Type Message
When you select a type on the Operation card, you are prompted to load defaults from the operation 
types. If you always click Yes in this dialog, you can set up a preference in Preference Maintenance to 
suppress this message. When you suppress this message, the defaults from the operation type will 
always be loaded.

To set up the preference:

1 Select Admin, Preferences Maintenance.

2 Click the Insert button.

3 Specify this information:

Section – Specify ManufacturingWindow.

Entry – Specify SkipMsgLoadOpTypeDef.

Value – Specify Y. 

4 Click Save.

You may need to close and reopen the Manufacturing Window to apply the new setting.

Adding Material Requirements
After you have defined an operation, you can add material requirements to it. These specify required 
materials at the specified operation. If you need to have the same material at multiple points in the 
production process, you must create one material requirement for each operation where you need the 
material. Material required can be a purchased inventory part, a fabricated part, or a special non-
inventory part.

Note: If you are adding multiple materials to a work order, you can open the part browse dialog box 
and drag and drop parts onto the operation. The New Material window is populated with the 
appropriate information.

To add a material requirement:

1 Select an operation to which you want to add the material requirement.

All material requirements are associated with a specific operation. This allows material planning 
to plan supply based on the required date of the operation, rather than the whole work order.

Select the operation to which you want to add the requirement. You can also select any other 
existing material requirement on the same operation.

2 Select Add Material from the Edit menu, press CTRL+M, click the Add Material button on the 
Form toolbar, or, if your popup menu is active, point to the operation to which you want to add a 
material, right-click, and select Add Material from the popup menu.
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Notice the two radio buttons: Material and Leg/Detail. The Material button is selected by default. 
You should leave this selection as is. If you choose Leg/Detail, you will create a leg instead of a 
material requirement.

3 Adjust the Piece Number, if necessary.

Piece numbers are automatically assigned to material requirements on the same operation and 
gives them increments of 10. These have less significance than operation sequence numbers, 
because the order of material requirements within an operation is usually irrelevant. You can, 
however, adjust this number, and also renumber them to place the parts in order by Part ID. You 
can do this using Renumber Piece Numbers by Part ID after you define the materials. This 
function is described later.

4 Specify the material in the Part ID field. Do one of these tasks:

• To specify an existing part as the material, click the Part ID browse button and select the
material to add. If you are licensed to use multiple sites, the browse table shows parts that
exist in the site ID selected on the header card. If you are licensed to use a single site, the
browse table shows all parts.

If you select a consumable part, the Costs, Vendor, and Quotes tabs are inactive. However, 
because you cannot enter consumable parts into inventory, and because they are expensed 
at the time of receipt, the Issued Qty field is active. After you have entered the appropriate 
information for the consumable material a violet card instead of a standard red material card 
appears in the graphical display.

If you specify a part ID that is already used, you are asked to confirm that you want to add the 
part. Click Yes to add the part. Click No to select a different part. If you always click Yes in this 
message, you can suppress the message in Preferences Maintenance. See "Suppressing the 
Part ID Already Used Message" on page 3–68 in this guide.

• To specify a new part, enter a new ID in the Part ID field. You are asked if you would like to
create a new part here.

If you click Yes, the New Part dialog box appears

Enter a Description for the part, whether it is Purchased, Fabricated, and/or Detail Only. This 
allows you to continue the process without having to go to Part Maintenance to create the 
material first. You should open your new part in Part Maintenance to define the other 
information for the part.

The new part is added to your database. If you are licensed to use multiple sites, the new part 
is added to the site selected in the header card only. 

You cannot classify a new part as a consumable. You can only classify a part as consumable 
in Part Maintenance. Because consumables serve no purpose in material planning, 
scheduling, or costing, consumables appear only so that you can view them and place them 
on picklists. Consumables are expensed upon receipt, so a consumable material’s quantity at 
any one time is not important. See the “Part Maintenance” chapter in the Inventory guide.

• If this is a requirement for a non-inventory part, leave the Part ID blank. For this type of part,
you should always provide Specifications to describe the part. The unit of measure for a non-
inventory part is implicit. Because there is no part master, it is assumed the quantities are in
the default unit for the part. If you want to specify a unit of measure, use the Usage Unit of
Measure field as described below.
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Price break information for non-inventory parts is set up in Vendor Parts Supplied in Part 
Maintenance. For more information, refer to the “Part Maintenance” chapter in the Inventory 
guide.

5 If appropriate, enter a valid Warehouse ID for the part or click the Warehouse ID button to select 
one from the list. This is the warehouse from which you are issuing the material requirement.

6 Select the Inherit Demand Warehouse check box if you would like the part to be assigned to the 
warehouse specified in the Header Card. Clear the check box if you do not want to assign the part 
to the warehouse specified in the Header Card (for example, if you use universal planning for the 
part). 

If you selected the Do Not Inherit Demand Warehouse for the part in Part Maintenance, the 
system does not allow you to assign the part to the warehouse in the Header Card. The system 
disables the Inherit Demand Warehouse check box on the Material Card.

7 If the material specified in the Part ID field is an alternate part for the original part specified in the 
work order, the system selects the Alternate Part ID check box and inserts the piece number of 
the original part in the Original Issuing Part # field. 

8 Enter the quantity of the material that is required per unit of in the Qty Per field.

Use the Qty Per (Start Qty) radio button to specify Quantity Per based on the amount needed per 
incoming material. Use the Quantity Per (End Qty) field to specify Quantity Per based on the 
amount needed per unit of outgoing master (the End Quantity).

9 Enter any fixed material requirement quantity in the Fixed Qty field.

A fixed material quantity is a quantity of material required one time, regardless of work order 
quantity. This could be fixed scrap caused by setup or test, or could be any material required to 
produce the parent part.

10 If there is a known scrap percentage, enter it in the Scrap % field.

This percentage is added to the base quantity required to make up for the loss.

11 Enter dimensions for the material in the Dimensions field.

Dimensions specify a formula for use in determining quantity required. Dimensions are factored 
into the Quantity Per in calculating the total quantity required to meet the requirement.

This formula can contain only constants. For example, if you require an area of sheet metal to 
produce a part two feet by four feet in dimension, you can specify 2*2. The formula is plainly 
stated for determining the requirement. If dimensions change, you can change the formula rather 
than redoing the calculations to get a new quantity per.

You can use the following basic operators when specifying formulas:

+Addition

-Subtraction

*Multiplication

/Division

** Raise to a Power
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You can use parentheses for grouping. You can develop any complexity of formula. Dimensions 
are specified in a language called SAL, the language in which ERP Express (VISUAL) is written. 
A rich selection of mathematical functions is available you for use.

When variables are included in a formula, each variable name must be enclosed in square 
brackets. For example, [LENGTH]*[WIDTH].

Consider this example:

Sheet steel is formed into tubes of a variable diameter and length. You want the material 
requirement for the raw material to be expressed in square feet. Additionally, the sheet steel is 
available in square footage up to six feet wide and to any length. You have set up the conversion 
of one foot for six square feet for the part, so you specify a Usage Unit of Measure of Square 
Feet.

You can set up variables called DIAMETER and LENGTH in the work order header. These are set 
for each work order to control those parameters. The total square footage required is the length 
times the circumference of the tube. The circumference of a circle is given by Pi x Diameter, 
where Pi is a constant. Therefore, the following dimensions express the quantity needed:

[LENGTH]*[DIAMETER]*SalNumberPi()

SalNumberPi is a function that returns the mathematical constant Pi.

If Qty Per for this material requirement is 2, then the number this dimension produces is multiplied 
by 2 to determine the total material requirement.

12 Enter the unit of measure in which the material is used in the Usage U/M field. You can click the 
Usage U/M button and select a unit of measure from the table.

By default, the Stock Unit of Measure for a part is used to interpret the Quantity Per and Fixed 
Quantity values. You can specify a different unit of measure for these quantities. For non-
inventory materials, you must use this field to specify the unit of measure for the part.

In order to use this override, you must have already defined a conversion factor between the 
Stock and Usage units. You can do this in global Unit of Measure maintenance, or specifically for 
the part. For example, a global conversion specifies 100 centimeters to one meter. Alternatively, 
you might purchase sheet steel by the foot, in rolls six feet wide. You may want to specify usage in 
square feet. In this case, you cannot set a global conversion of feet to square feet, but you can set 
one for that specific part. For the sheet steel, one foot equals six square feet.

13 If you selected a piece tracked part in the Part ID field, specify the dimensions for one piece in the 
Length, Width, and Height fields. If a particular dimension is not required, the field is not available. 
Specify the dimensions in the unit of measure displayed in the Usage U/M field. If you use a piece 
tracked part for the material requirement, you cannot specify a usage unit of measure. You must 
use the usage unit of measure specified for the part in Part Maintenance.

14 Click the Specifications tab.

15 Enter any information or specifications regarding this requirement in the Specifications window. If 
this is a non-inventory part requirement, it is important that you enter some description in this 
field.

16 If there is a drawing associated with this requirement, enter the Drawing Number, Revision, 
Effective Date, and Discontinue Date in the appropriate fields.

17 Click the Save button on the main toolbar to save the information.
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If you want to quickly add a material with minimal details, clear the Material Edit Form option on the 
Views menu.

When you add a material, the system displays a list of parts. Select the part you want to use for the 
material.

A material requirement is created with the next sequential number using only the information from the 
part record.

Note: If you have opened the Material child window, you can use the Show/Hide Edit Material Form 
toolbar buttons to hide or show the Material window.

Overriding Material Costs
1 Click the Costs tab.

By default, standard part costs are copied into the cost fields from the part master when it saves 
the material. If you want to override one or more of these values, enter them now. This can also 
be done after the material has been saved.

For a non-inventory requirement, you must use these fields to specify the costs if you want them 
to show up in cost estimates. Additionally, if you are using standard costing, these fields are used 
as the standard costs.

For Standard Costing – When you specify the Part ID for a material requirement, the standard 
rates are copied into the requirement from the part master. Although you can override the rates at 
this point, they are only used to provide cost estimations for the material requirement. Standard 
costs are always taken from part masters.

For Actual Costing – The material requirement card issue burden values override the part card 
issue burden values when setting the "actual burden” for the work order issue transactions. 
Actual costs are always taken from PO/Invoice prices.

2 Enter values into the seven cost override fields (five costs and two burdens).

3 Click the Save button on the main toolbar to save the new information.

Specifying Vendor Information
1 Click the Vendor tab.

2 Enter information into the following vendor fields:

Vendor ID – Click the Vendor ID button to browse the VENDOR table and specify a vendor for a 
non-inventory part. This might be a part on a quote master that you have yet to give a master, or a 
special part for a job that you will never give a master. This provides a vendor you can use when 
purchasing the material to the job.

Vendor Part ID – Enter the vendor’s catalog number for the part. Again, this is most useful for 
non-inventory parts.

Mfg Name – Enter the name of the manufacturer for the part.
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Mfg Part ID – Enter the manufacturer’s Part ID for the part.

3 Click the Save button on the main toolbar to save the new information.

Specifying Planning/Leadtime Information
Before reading this section, be aware that the column PLANNING_LEADTIME in the 
REQUIREMENT table is in fact different than the column PLANNING _LEADTIME in the PART table. 
The Concurrent Scheduler uses the column PLANNING_LEADTIME in the REQUIREMENT table 
exclusively during material checks.

Use the Planning Leadtime field to override a part’s planning leadtime at the requirement level. The 
scheduler uses the planning leadtime override at the material requirement level during material 
checks.

Also, you can enter planning leadtimes for non-part requirements. The scheduler uses the planning 
leadtime override at the material requirement level during material checks.

Because this field is an override field, the field is not populated with the material’s default planning 
leadtime from Part Maintenance. The Concurrent Scheduler uses the default planning leadtime from 
Part Maintenance if this field is null at the requirement level.

1 Click the Planning tab.

The following read-only fields appear in the window.

Required Date – The required date is the date on which the Concurrent Scheduler determines 
the material requirement is required. Before you run the scheduler, the field is filled with the work 
order’s Release Date.

Several factors influence how the date is determined. If you specify that the Concurrent Scheduler 
forward schedule the work order from release date or that the release date is hard, you may 
receive a different date than if you permit the normal backwards scheduling scenarios to run. See 
earlier in this chapter for more information on scheduling work orders.

Calculated Quantity – The quantity of the material needed to fulfill the material requirement is 
displayed. You must change the status of the work order to Released before quantities are 
recalculated and this value is displayed.

For non-piece tracked parts, the calculated quantity is the Work Order or Leg Header Quantity * 
((1 + Scrap %) * Qty Per) + Fixed Quantity) * Dimensions. If the Usage U/M is different from the 
Stock U/M, the quantity is converted to the Stock U/M. This value is rounded up to the next whole 
number. 

If the material requirement is for a piece tracked part, then the calculation made for this field 
depends upon the CalcQtyByPieces setting in Preferences Maintenance. If this setting is set to Y, 
then the calculated quantity is equal to the Calculated Piece Qty. If this setting is set to N, then  
the calculated quantity is equal to the actual quantity used in the work order. See "Calculated 
Quantity Values for Piece Tracked Parts" on page 3–16 in this guide.

Calculated # of Pcs - A value is displayed in this field only if this requirement is a piece tracked 
part. To determine the value in this field, the total amount of part needed to meet this requirement 
is divided by the size of one material piece. The value is rounded up to the next whole number 
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and inserted in this field. If you place a purchase order for this requirement, the value in this field 
is inserted in the # Pieces column on the purchase order line. See "Calculated Values for Piece 
Tracked Parts" on page 3-15 in this guide.

Calculated Piece Qty - A value is displayed in this field only if this requirement is a piece tracked 
part. To determine the value in this field, the Calculated # of Pcs is multiplied by the size of one 
material piece. If you place a purchase order for this requirement, this value is inserted in the 
Quantity field on the purchase order line. 

Issued Quantity – The quantity of the material you have issued thus far to satisfy the 
requirement. When the Issued Quantity matches the Calculated Quantity, you have fully met the 
material requirement.

Allocated Quantity – The quantity you have issued to the material requirement from any one or 
multiple sources of supply. Types of supply include (CP) Coproducts, (I) Inventory, (PD) Purchase 
Order Delivery Schedules, (PO) Purchase Orders, (WH) Interbranch Transfers, and (WO) Work 
Orders.

Use the Edit menu option Allocate Supply to this Material to allocate quantities to a work order 
material requirement. See later in this chapter for more information on allocating supply to 
material requirements.

Fulfilled Quantity – After you have allocated a quantity to a material requirement, you must, 
depending on which supply type you specified, issue/receive the quantity from the source of 
supply (the 6 supply types above) to the material requirement. Before supply arrives and is 
available for use on the work order, it is considered allocated; upon reception/issue, it becomes a 
fulfilled quantity.

After a requirement receives the allocated quantity, the Fulfilled Quantity field is populated with 
the appropriate amount. For example, if you allocate an unreceived purchase order line with a 
quantity of 200 to a work order material requirement, the Planning tab would display an Allocated 
Quantity of 200, but a Fulfilled Quantity of 0. After you receive the purchase order into the 
appropriate warehouse using Purchase Receipt Entry, the Fulfilled Quantity on the Planning tab 
would then display 200, as the allocated quantity—the conditional source of supply until now—is 
real, in the warehouse and fulfilling its purpose of supplying the requirement.

Using Material User Defined Field Labels
You can specify user defined field labels for material requirements in work orders. Each material 
requirement may have a different label. You cannot, however, define new user defined field label 
layouts from the Material Requirement window. To define new label layouts, use Customer 
Maintenance, Part Maintenance, or Vendor Maintenance. After you create label layout IDs, they are 
available system-wide, wherever user defined fields are present. 

1 Click the User Defined tab.

2 From the User Defined Field Layout ID list box, select a Label ID for the material requirement.

The Label ID fields appear.

3 Enter any necessary information in the fields. The fields pertain to the material itself and any 
personnel who may come into contact with the handling and processing of the material. The 
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greatest advantage of user defined fields is that they allow you to maintain material-specific 
information, so throughout the enterprise you can record and share special information with those 
who have access to work in the Manufacturing Window.

Specifying Reference Designators
Use the Ref Designator tab to specify the location where the material in the requirement should be 
placed. The Ref Designators tab is especially useful if you are working with circuit boards or some 
other object where you can specify location with an XY coordinate. 

You can enter a reference designator for each instance of the part on the material card. For example, 
if you use 5 Part A’s on a material card, you can specify 5 reference designators. If you attempt to 
enter more than or less than 5 reference designators, the system warns when you save the reference 
designators. 

Each reference designator in a particular master (work order, engineering master, or quote master) 
must be unique on each material card. 

To specify a reference designator:

1 Click the Ref Designator tab.

2 Click the Insert button.

3 Specify the following information:

Ref Designator ID – Specify the ID for the reference. 

X Coordinate – Specify the part location along the X axis.

Y Coordinate – Specify the part location along the Y axis.

Description – Specify a description of the reference. 

4 Click Save.

If you are entering multiple reference designators, you can use the Reference Designator Range 
section to create multiple reference IDs. After you create multiple IDs, you can specify the X 
coordinate, the Y coordinate, and the description on each row in the table. 

Specify the following information:

Prefix – Specify a prefix for the reference ID.

Beginning # – Specify the number to use for the first reference ID.

Ending # – Specify the number to use for the last reference ID.

Click Save. The system generates the reference IDs and inserts them in the table. 

Specify the X coordinate, the Y coordinate, and the description, then click Save again.

If you would like to use an existing reference ID, click the Ref Designator ID browse button and 
select the reference ID you would like to use. The system inserts the selected reference ID into the 
table. 
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Specifying Alternate Parts
Use the Alternate Parts tab to specify the parts that can be used in place of the main part on the 
material card. The system activates this tab when you select Allow Alternate Parts on the Header 
Card. 

If you do not have security access to add alternate parts, the system deactivates the tab.

When you create a new material card and access the Alternate Parts tab, the system inserts the 
alternate parts identified for the main part in Part Maintenance. You can add alternate parts on a 
material card, but these parts will apply to the active material card only. Any alternate parts you 
specify on the material card will not be added to the main part record in part maintenance.

When you specify an alternate part, make sure your choice is valid for the work order. For example, if 
your work order’s end product is Part A, you cannot use Part A as a substitute part for any other part 
on the master. Similarly, if your work order consists of several sub-assemblies, the end product of a 
sub-assembly cannot be used as an alternate part for any of the materials that make up the sub-
assembly.

Because you specify default alternate parts on the part record in Part Maintenance, you may find that 
some of the alternate parts listed in the Alternate Parts tab are not valid selections for a particular 
work order. You can delete the invalid alternate parts by selecting the line item, then clicking the 
Delete  button. Click Save to complete the deletion.The system only deletes the alternate part for use 
with the selected work order. It does not remove the alternate part from the Part Maintenance record. 
If you delete the invalid alternate part from the material card, the part will not be eligible to issue to the 
work order in Inventory Transaction Entry. 

To add an alternate part to the material card:

1 Click the Alternate Parts tab.

2 Click the Insert button.

3 Double-click the Part ID browse button and select a part. If you intend to issue the alternate part 
to this requirement card in Inventory Transaction Entry, make sure you select an alternate part 
with the same unit of measure as the part it replaces.

The system inserts the description.

4 Assign a rank to the alternate part. Use the rank field to indicate your preference to use the part 
as an alternate. This field is optional.

5 Click Save.

You can also drag an alternate part from the Alternate Part Information window or from the Part ID 
browse table to the alternate part table.

You can issue an alternate part to a work order in Inventory Transaction Entry. The alternate part you 
issue in Inventory Transaction Entry must have the same unit of measure as the original part. If you 
decide to use an alternate part, the system creates a new material card with the alternate part in the 
part ID field. The system selects the Alternate Part check box and inserts the piece number of the 
original part that the alternate part is replacing.

You can also use alternate parts in the Material Planning Window. You can drag an alternate part 
from the Alternate Parts dialog box on to a material requirement. The system replaces the original 
part ID and usage UM in the material card with the part ID and usage UM of the alternate part.
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The system retains the original part’s material card. In the Alternate Parts tab, the system inserts the 
quantity of alternate part issued to the material requirement. 

The system indicates that an alternate part has been issued in the following ways:

Material Card – The system selects the Alternate Part check box and inserts the piece number of the 
original part in the Original Issuing Piece # field.

Graphical View - 1 Window –  On the material card for the alternate part, the system inserts the 
piece number of the original part’s material card in parentheses next to the piece # of the alternate 
part material card; for example, 20(10). 

Graphical View - 2 Window, Text View - 1 Window, and Text View - 2 Window – The system 
inserts the piece number of the original part’s material card in parentheses next to the piece # of the 
alternate part material card; for example, 20(10).

Grid  – The system inserts the piece number of the original material card in the Alt Part Parent Piece 
# column on the line where the alternate part is displayed. The system inserts the piece number of the 
alternate part material card in the Alt Part Piece # column on the line where the original part is 
displayed.

Viewing Alternate Part Information
You can view the availability of the original part and the alternate parts in the Alternate Parts 
Information dialog box.

Select View, Alternate Part Information.

The system lists the original material in the Available Parts list and the alternate parts specified on the 
material card in the Alternate Parts list. Click a part in the left pane to view information about the part 
in the tables. 

Suppressing the Part ID Already Used Message
When you select a part on the material card that has already been used in the leg or operation, you 
are asked to confirm that you want to add the part. If you always click Yes in this dialog, you can set 
up a preference in Preference Maintenance to suppress this message. When you suppress this 
message, the duplicate part will always be added.

To set up the preference:

1 Select Admin, Preferences Maintenance.

2 Click the Insert button.

3 Specify this information:

Section – Specify ManufacturingWindow.

Entry – Specify MsgPartAlreadyUsed.

Value – Specify Y. 
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4 Click Save.

You may need to close and reopen the Manufacturing Window to apply the new setting.

Adding Legs
Adding a leg is similar in many respects to adding a standard material requirement. The same window 
is used for both functions. Legs are always associated with operations, just as material requirements 
are.

1 Select the operation to which you want to add the leg. You can also select any other existing 
material requirement on the same operation.

2 Select Add Leg/Detail from the Edit menu, press CTRL+L, click the Add Leg/Detail button, or, if 
your popup menu is active, point to the operation to which you want to add a leg, right-click, and 
then select Add Leg/Detail from the popup menu.

Notice the two radio buttons: Material and Leg/Detail. The Leg/Detail button is automatically 
selected. You should leave this selection as is. If you choose Material, you will create a material 
requirement instead of a leg. You cannot change this material requirement after creating it.

3 Adjust the piece number if necessary.

Legs also have a piece number. You can manipulate this identifier in the same way as for a 
material requirement.

4 Adjust the Sub ID, if necessary.

Sub ID identifies a leg uniquely within a master/work order. This ID is automatically assigned, and 
the main leg is always 0. You can change this ID if you want, but you must not use an existing Sub 
ID. It is best to allow this number to be automatically assigned.

5 Specify a Part ID for a leg.

This indicates that the assembly corresponds to a part that is also a separate inventory part. 
However, you must still enter the engineering structure here, and you must maintain any separate 
structure independently.

This field is not required.

6 Specify the following Quantity Information: Quantity Per, Fixed Qty, Scrap %, Qty Per Start or End, 
Dimensions, Reference # and Usage U/M.

Specify all of this information in the exact same way as for materials. You are simply indicating the 
amount of the fabricated assembly needed, rather than an inventory part.

7 Click the Specifications tab and enter specifications and engineering information for the 
following fields:

Specifications – Enter any material/leg specifications here.

Drawing Number – If there is an engineering drawing associated with the leg, enter the drawing 
number here.

Rev – Enter any revision number for an engineering drawing here.



Creating Engineering Masters

3 – 70 | Infor VISUAL Inventory User’s Guide 

Effective Date/Discontinue Date – These are the same as for material requirements. You can 
also select Effective Date and Discontinue Date from the ERP Express (VISUAL) Calendar.

8 Click the Engineering tab to designate the leg as eligible for updating using the Leg Updater. You 
can also view information about when the leg was last updated by an engineering master. See 
"Using the Leg/Master Updater" on page 3–97 in this guide

Allow Update from Master – Select this check box to allow the leg to be updated by engineering 
masters. 

Last Update From Ref – The system inserts the base ID of the engineering master that updated 
the leg.

Last Update Part Eng ID – The system inserts the engineering ID of the master that updated the 
leg.

Last Update Date – The system inserts the date that the leg was last updated.

Last Update User ID – The system inserts the ID of the user who performed the update.

You can also view this information on the Engineering tab of the Leg Header card.

9 Click the Save button on the main toolbar to save the new information.

The leg is created and added to the structure. You can now add an operation to this leg, and add 
additional operations, material requirements, and other legs.

After clicking on the Save button, the Leg/Detail window clears. It is now ready to add another leg 
to the same operation.

Note: Cost overrides do not apply to legs. Costs from legs come from the operations and 
materials you specify on the leg.

If you want to quickly add a leg with minimal details, clear the Leg Edit Form option on the Views 
menu.

Note: If you have opened the Leg child window, you can use the Show/Hide Edit Leg Detail Form 
toolbar button to hide or show the Leg window.

Updating Engineering Master Hours
Engineering Masters define the standard method for making a particular part. Because you may 
develop an engineering master long before you actually begin producing a part, these standards may 
change. Use the Update Hours option to update your Engineering Masters with actual performance 
information from the shop floor or new values that you specify manually. 

1 With an engineering master open in the Manufacturing Window, select Edit, Update Hours.This 
menu option is only available if you are viewing an engineering master.

Basic information about the engineering master is displayed in the Engineering Master section, 
and a list of operations in the engineering master is displayed in the Operations table. In the Work 
Orders table, a list of work orders that have been created from the engineering master is 
displayed.

2 Specify updated setup and run information. Perform one or both of these steps:
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• To calculate new setup and run values from work orders, select one or more work orders in
the Work Order table. Click Calculate. For each operation, the average set up and run values
from the selected work orders is calculated. The values are inserted in the New Setup and
New Run columns. 

If you selected work orders that have different resources or sequence numbers from the 
engineering master, a message is displayed that warns you that the calculations could be 
inaccurate. Click Yes to continue or No to select other work orders. 

If you selected work orders that have non-matching run types or load quantities, a message is 
displayed. Click Yes to continue or No to select other work orders. 

• To update setup and run information manually, specify the values to use for each operation in
the New Setup and New Run columns. 

3 To update the engineering master, click Save.

You are warned that you are about to make permanent changes to the engineering master.

4 To make the changes, click Ok.

5 To print a report that details the current run/setup versus the new run/setup, click the Print button.
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Creating Quote Masters
The process for creating a quote master is similar to the process for creating an engineering master. 
Exceptions are noted in this section.

See the “Estimating Window” chapter in the Sales guide for more information about quotes.

To create a quote master:

1 Select File, New.

2 Click the Quote Master option.

3 Specify information on the header card, just as you would for an engineering master. 

4 Add operations. If you added a Service ID, click the Quote tab.

5 Specify this information:

Quantity – The part amount serviced.

Unit Cost – The cost per unit.

Base Charge – The one time fixed cost for performing the basic service. The costs plus the cost 
per unit multiplied by the units of service is the total cost for a specific service.

Min Charge – The minimum that is charged for a service. If the service ordered costs more than 
the minimum charge allowed, the actual cost is charged. If the service ordered costs less than the 
minimum charge, the minimum charge is charged.

6 Add Materials as you would for an engineering master. 

7 On the Material card, click the Quote tab. 

You can set quantity break costs in the Material dialog box. Use this function only when the 
material requirement is for a Quote Master, and for a non-inventory part. Quantity Break Costs 
allows you to specify quantity price breaks and a minimum charge that the Estimating Window 
can use to project costs.

Specify this information:

Unit Cost – Specify the quoted cost per unit of material. 

Fixed Cost – Specify the quoted fixed cost for the quantity. Fixed cost is a onetime cost of the 
purchase, regardless of order quantity.

Minimum Cost – Specify the Minimum Cost for the quantity. Any calculated cost based on unit 
price and fixed cost that is lower than this value is increased to this cost.

Leadtime – Specify how many days it takes for the vendor to deliver the quantity. This field is 
informational only. You can use it to help you decide which vendor quote to accept, but the value 
is not used in material planning or scheduling.

8 Click the Save button on the main toolbar to save the new information.
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Managing Work Orders
This section discusses the features and functions that are more specific to work orders than 
engineering and quote masters.

Creating New Work Orders
Creating a new work order is similar to creating an engineering master. You use the same 
Engineering Master/Work Order dialog box, but you need to enter the extra data specially for work 
orders: Release Date and Want Date (and Split ID, if appropriate).

1 Select New from the File menu or click the New button on the Main toolbar.

If another master/work order is currently loaded in the Manufacturing Window, it is moved to the 
back but leaves it open while you’re creating this new one. Tile the two to view them both.

2 Select the Work Order radio button.

3 If you are licensed to use multiple sites, click the Site ID arrow and select the site for the work 
order. If you are licensed to use a single site, this field is unavailable.

4 Enter a Part ID.

All work orders specify the production process for a fabricated part. 

Enter the Part ID for the part, or select it by clicking the Part ID button to call up the parts browse. 
You can also browse by part description by pressing the Part Description button.

If the Part ID does not exist, you are asked if you would like to create a new part.

If you click Yes, the New Part dialog box appears.

Enter a Description for the part, whether it is Purchased, Fabricated, and/or Detail Only. This 
allows you to continue the process without the interruption of using Part Maintenance. Make a 
point of returning to Part Maintenance at some point, though, to more thoroughly enter part 
information.

5 Enter a Warehouse ID for the part or click the Warehouse ID button to select one from the list.

If the part you are using in this work order is new, it has no warehouses and you cannot select a 
warehouse from the table. To add this new part to a warehouse, manually enter a valid 
Warehouse ID and click the Yes button when you are asked if you want to add this part to the 
warehouse.

6 Enter a Base ID/Job ID in the Base ID/Job ID field.

The Base ID is also known as the Job ID. This uniquely identifies the work order.

7 Enter an Lot ID in the Eng ID/Lot ID field.

The Lot ID identifies a specific lot within a larger work order specified by the Base ID. This allows 
all of the lots to have the same Base ID.

8 Enter a Split ID in the Split ID field.
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The Split ID uniquely identifies the child lots of a work order lot that was split. In this way, all splits 
can have the same Base ID/Lot ID as the parent lot. You can use this field to allow a manual split.

9 Enter a Release Date in the release date field.

This is the earliest date the work order can start production. You can use the calendar option to 
select a date.

10 Enter a Want Date in the want date field.

This is the date the finished goods from the work order should be available.

11 Enter a Quantity in the quantity field.

This is the desired quantity that should be received into finished goods. This information 
ultimately drives the actual run time of each operation, and thus the entire schedule.

12 Enter the following Engineering Information:

Specifications – This is a multi-line text field that lets you enter specification text to describe the 
work order. Use the Copy and Paste buttons to copy the entire contents of the Specifications 
window, or to replace the entire contents of the window with the clipboard.

Engineered By – Specifies the person responsible for the master.

Engineered Date – Date associated with this revision of the master. You can also select an 
Engineering Date using the Calendar object provided.

Drawing Number – Drawing number of the engineering drawing for this work order.

Drawing Rev – Revision of the drawing number for this work order.

Drawing File – The path to drawing file.

Entered By – The method used to create the master. This field is populated by the system. See 
"Working with Information in the Entered By Field" on page 3–80 in this guide.

Product Code – The Code associated with a product of this work order. Each product code can 
have a unique G/L account for inventory, WIP, and cost of goods sold. Select a product code from 
the drop down menu.

Commodity Code – The Code associated with a Commodity of this work order. Select a 
commodity from the drop down menu. You can also enter the Commodity Code and save the 
information by clicking the Save button. 

All of these fields are optional.

13 Select the Forward Schedule from Release Date check box to force the Concurrent Scheduler 
to forward schedule this work order. If left clear, work orders are scheduled backwards from their 
want date.

14 Select the Treat Release Date as Hard check box to set this work order’s release date as the 
earliest point at which work may begin on it. The Concurrent Scheduler will not schedule any work 
to begin on this work order before this date. If you have set a global hard release date preference 
in Site Maintenance, you do not have to set it here because the global setting overrides all others.

15 Specify how to report labor for all operations in this master. The settings that you specify are 
copied to work orders that you generate from the master. If the fields listed below are unavailable, 
then the information has been specified in Site Maintenance and cannot be customized for this 
master:
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Percent Complete – To record labor by percentage complete instead of quantity complete, select 
this check box. When a user selects an operation that uses percentage complete reporting, labels 
in the labor ticket entry programs are updated to indicate that quantities are reported as 
percentages. If you use BTS, a Percent Completed prompt is displayed. 

Quantity Complete by Hours – To automatically calculate the percentage of completion based 
on the labor hours that have been reported, select this check box. If you use automatic 
calculation, then the hours reported on the labor ticket are divided by the estimated hours for the 
operation to determine the percentage of completion. The operation is closed when the 
percentage of completion equals or exceeds 100%.

Max Percent Completed – If you selected the Quantity Complete by Hours check box, use this 
field to specify the maximum percentage that can be calculated automatically. When the 
percentage complete meets the threshold that you specify, automatic calculation of quantity 
complete is stopped. The operation remains on your schedule until the operation is manually 
closed. This formula is used to calculate the number of hours for the operation that remain on 
your schedule:

((100 - value specified in Max Percent Completed field)/100) * total hours required for the 
operation

To complete the labor on an operations, users must manually close the operation. See 
"Completing Labor on Operations with Max Percent Complete Thresholds" on page 7–14 in this 
guide. 

16 Click the Pict/Object button to associated a graphic or OLE2 object with the work order. This 
provides shop floor access to the object.

17 Click the Variables button to define variable dimensions referenced in material requirements.

The Work Order Variables dialog box appears. For a new work order, this window is empty.

To add a variable to the work order, click the Insert button to add a new line to the table, then 
enter the following information on the new line:

Name – The name that is used to reference the variable in material requirement dimensions.

Variable – The numerical value that the variable assumes.

Continue to add as many lines as needed using this procedure. For example, you might add 
variables named LENGTH, WIDTH, and DEPTH.

Click Ok when you are finished.

When a work order is created from this master, the value you specify here is copied as the 
default. You can then modify the variable values for each new work order. This allows you to 
adjust work order required quantities without modifying individual material requirements.

18 Click the G/L Accts button to override WIP G/L Accounts.

If you are using the Financials interface, there are four general ledger accounts associated with a 
work order. These are Work in Process accounts for each of the four cost categories: Material, 
Labor, Burden, and Service.

Normally, these accounts are read from the Product Code definition, if one is associated with the 
Part ID, or from the default G/L account interface settings.
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If you want to override them for any work order produced from this master, press the G/L 
accounts, enter each account, or select one by pressing the appropriate button.

Click Ok to save the changes.

19 Click the Save button to create the new work order.

The master header appears in the window in home position, and the dialog box automatically 
closes.

Creating New Work Orders from Masters
You can create a new work order by copying an engineering master, a quote master, or another work 
order. If the master contains an obsolete service, you cannot generate the work order.

If you are licensed to use multiple sites, you can create a work order for one site from an engineering 
master, quote master, or work order created in another site, provided that the materials and 
resources exist in both sites.

1 If you are licensed to use multiple sites, open a work order in the site where you want to create a 
new work order. You have to open an existing work order to indicate in which site the new work 
order should be created. If you are creating a work order in your default site, you do not need to 
perform this step.

If you are licensed to use a single site, you do not need to perform this step. You can create a new 
work order from a blank Manufacturing Window.

2 Select File, New Work Order, then select one of the following menu items:

• from Eng Master
• from Work Order
• from Quote Master

3 If you are licensed to use multiple sites, click the From Site ID arrow and select the site that 
contains the master to copy. If you are licensed to use a single site, this field is unavailable.

4 Click the browse button to select the master to copy. If you selected from Eng Master in step 1, 
this field is labeled Part ID. If you selected from Work Order, this field is labeled Base/Job ID. If 
you selected frm Quote Master, this field is labeled Quote ID. 

5 Enter identification of new work order.

You can enter the Base ID, Lot ID, and Split ID, or you can leave the fields blank to allow auto 
numbering to assign them.

6 Enter the desired release date, want date, and desired quantity. You can specify your own values 
or accept the defaults. 

If you are creating a work order from an engineering master, then the release date is calculated 
by subtracting the part’s lead time to the current date. If you are creating a work order from 
another work order or from a quote master, the current date is inserted in the Release Date field.
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The current date is inserted in the Want Date field. If you are generating a work order from an 
engineering master and specify a different Want Date, you must manually update the Release 
Date. The release date is automatically calculated only when you first specify a part ID. 

One is inserted in the Quantity field. 

7 Select the items to copy to the new work order:

Forward Schedule from Release Date – Select this option if you want to forward schedule the 
work order.

Treat release date as hard – Select this option to prevent the Concurrent Scheduler from 
scheduling the work order until its release date arrives. This can be a global setting for all work 
orders in all schedules, for a particular schedule, or per work order, as in this case.

Copy All Document References – Select this option to copy an document references attached to 
the master to the new work order.

Copy Reference Designators – Select this option to copy all reference designators for materials 
to the new work order.

Copy Alternate Parts – Select this option to copy any alternate parts associated with materials to 
the new work order.

8 Click Save to create the new work order.

The work order is created with an Unreleased status.

If your created work order references documents that cannot be copied because they are not part 
of the target site, a message dialog displays allowing you to continue or cancel the procedure.

Note: If you create a work order from a master that uses obsolete resources, the system sets the 
status of the operation that uses the obsolete resource to cancelled. 

Creating New Work Orders in Customer Order Entry
You can create Work Orders automatically for line items in Customer Order Entry. During order entry, 
you can select the New Work Order box on the line item. A New Work Order is created from the 
Engineering Master using the line item Quantity and Desired Ship Date for Quantity and Want Date. 
When using Customer Order Entry, you have the choice of specifying a Firm or Released status for 
the new work order. You can also copy any document references from the engineering master.

This feature provides an easier way to manage make-to-order work orders. The work order is 
automatically linked to the customer order. Inventory receipt and issue is automatic when the order is 
shipped.

You can also create Work Orders through the Generate Order from Quote command in Customer 
Order Entry. When converting a quote to an order, you can choose to have work orders generated. 
You can specify Base ID, Lot ID, Release Date, Want Date, and Status for each order.

For quote line items with quote masters, a New Work Order is created from Quote Master. For 
inventory line items, a New Work Order is created from Engineering Master. These work orders are 
also linked to the customer order line items. 
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If you are licensed to use multiple sites, the work order is created in the site specified in the customer 
order header.

If the engineering master contains an obsolete service, you cannot generate the work order.

For more information, refer to the “Customer Order Entry” chapter in the Sales guide.

Creating New Work Orders in the Material Planning Window
The Material Planning Window provides complete material management in a single application. You 
can place work orders from the Material Planning Window to plan a supply to satisfy a demand. This 
is perhaps the easiest place to manage creation of new work orders for inventoried parts.

When placing an order this way, the user can specify Base ID, Lot ID, Split ID, Release Date, Want 
Date, Quantity, Status, and Forward Schedule. However, intelligent defaults are set based on the 
selected demand to meet. 

If you are licensed to use multiple sites, the work order is created in the site specified in the Material 
Planning Window header.

For more information, refer to the “Material Planning Window” chapter in the Inventory guide.

Setting Work Order Status
Work orders and their operations, materials, and legs all have independent status values. This 
supports concurrent engineering and manufacturing by allowing individual operations and legs to be 
released while other portions are in process or not even created yet.

These status values are used:

Unreleased – Engineering is in process, or dates and quantities are not firm.

Firm – Engineering is complete, and dates and quantities are firm.

Released – Work is authorized to start based on the specified release date.

Setup Complete – For operations only, setup is complete, operation is ready to run. This is really a 
sub-status of Released.

Closed – Work Order is completed.

Canceled – Work Order will not be started or completed.

A great many functions and reports operate on work orders that have a status value or values that 
you can specify. Many others functions work strictly with work orders of a specific status.

For material planning and shop scheduling purposes, Firm and Released work orders, operations, 
and legs are treated the same. These status values indicate that they should be considered as 
causing demand and producing supply.

In general, only Released operations have labor reported against them, and only Released material 
requirements are issued. However, you are allowed to perform these functions on Firm and 
Unreleased operations and materials, though warnings are issued.
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A work order must be firm or released before any of its finished goods can be received into inventory 
or issued to a customer order or another work order. New operations and requirements added to an 
in-process work order are added with a default status of Unreleased. This allows control of deviations 
to a standard process.

To set the status of work orders and their operations, legs, and requirements,

1 Open the work order in the Manufacturing Window.

2 Select the lowest level object (header, leg, operation, material) for which you want to set the 
status.

3 Select the status from the Status Change menu.

The default behavior for a status change is to set the status of all subordinate objects to the same 
status.

If you selected the work order header, this changes the status of all objects on the work order. If 
you selected a leg, this changes all of the operations and requirements on the leg. If you selected 
an operation, this changes all material requirements and legs on the operation as well. Material 
requirements have no subordinate objects.

4 If you only want to change the status of the selected object, clear the Change Status of 
Subordinate Materials and Operations check box.

5 Click the Ok button.

The status of the object is changed.

You can control which status values can be set on a per-user basis, using the Application User 
Permissions command of Security Maintenance. This allows a user to create an unreleased or firm 
work order, but requires a different user to actually perform the release. These permissions only apply 
to these explicit status changes; automatic changes are performed regardless of permissions.

Automatic Status Changes
The following applications change status of work orders and their objects automatically. Most of these 
changes involve automatically closing an object based on reported completion. Note that automatic 
Closes never close subordinate operations or requirements. Each individual operation or requirement 
is theoretically closed by a labor ticket entry or material issue.

Work Order Travellers – The Work Order Traveller function allows automatic release of firmed work 
orders along with the printing of their travellers. You can choose whether to release all subordinate 
operations, legs, and requirements as well.

This is the only function that automatically releases a work order. You should use Program Security to 
limit access to this application to the users who have permission to release a work order.

Customer Order Entry – When you create a work order through this application, you can specify its 
status as Firm or Released.

Inventory Transaction Entry – When all required material is issued to a requirement, it is 
automatically closed. If an Issue/Return is done, the requirement is re-released.
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When the desired quantity for a work order has been received into finished goods, the work order is 
closed. Note that this does NOT close subordinate operations and requirements—they should be 
closed by Labor Ticket Entry and material issuing, or must be closed manually. If a Receipt/Return is 
done, the work order is re-released.

Purchase Receipt Entry – When you receive all required material for a requirement that is linked to a 
purchase order, the requirement closes automatically. If returns occur through Purchase Receipt 
Entry, the requirement is re-released.

Service Receipt Entry – When you receive back all required material from a service operation, the 
operation is closed automatically.

Labor Ticket Entry –  The operation is closed when the quantity or percent completed for an 
operation reaches, or exceeds, the End Quantity that you require.

If a maximum percent complete threshold has not been specified for the operation, then these 
calculations are used to determine the percentage of completion:

• If you report labor based on quantity, then Quantity Completed is divided by the to the total work
order or leg quantity and multiplied by 100 to determine the completion percentage. 

• If you report labor based on percentage, then the total percentage reported as complete is used
to update the completion meter.

If a maximum percent complete threshold has been specified for the operation, then the percentage 
of completion calculation stops when the threshold has been reached. To update the completion 
meter after the automatic calculation threshold has been reached, you must manually update the 
quantity or percentage complete on the labor ticket. 

If you marked Resource ID for any lower-level operations as Automatic Reporting, these operations 
are closed. This allows management of operations that do not have labor reported against them.

The automatic reporting feature does NOT record any labor hours against the automatically closed 
operations. They appear with a setup and run time of zero if you do not report labor tickets against 
them.

Shipping Entry – Shipping Entry causes a receipt of finished goods and an issue to a customer order 
for work orders that are linked to customer orders.

When this causes the total required quantity to be received, the work order closes. If a Ship Return is 
done, the work order is re-released.

Material Planning Window – You can modify the status of supply work orders directly from the 
Material Planning Window main screen.

Working with Information in the Entered By Field
You can create work orders and masters in a variety of ways. Use the Entered By field on the header 
card to track how a work order or master was created. The Entered By field shows the ID of the user 
who created the quote master, engineering master, or work order, the VISUAL program used to 
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create the master, and how the master was created. This table shows the actions that create work 
orders and the message that is displayed in the Entered By field for each action. Information in 
brackets is replaced by information from your database.

How the master was created Entered By message

Import of a BillOfResoources BOD [User ID] – BOD2DBSRVC – import 
BillOfResources BOD

Import of the ProductionOrder BOD [User ID] – BOD2DBSRVC – import 
ProductionOrder BOD

Import a file in Advanced Planning and Scheduling 
Import [User ID] – VMAPSIMP – import file

Running the DBR Scheduler [User ID] – VMDBRSCH – DBR Schedule

Running the DBR schedule with the DBR 
Scheduling Service [User ID] – VMDBRSVC – DBR Schedule

Synchronizing with DesignLink [User ID] – VMDLSYNC – import file

Applying ECN changes to a work order [User ID] – VMECNENT – apply changes to 
work orders for ECN [ECN ID]/[ECN Line #]

Creating a work order for planned equipment 
maintenance

[User ID] – VMEQPMM – create Work 
Order for Planned Maintenance Job ID [Job 
ID]

Creating a profile for a piece of equipment [User ID] – VMEQPMM – Equipment Profile 
[Profile ID] for Equipment ID [Equipment ID]

Creating a work order by coping a quote [User ID] – VMESTWIN – copy Quote 
[Quote ID]/[Quote Line #]

Creating a work order by saving a quote for a 
project

[User ID] – VMESTWIN – save Quote 
[Quote ID]

Creating a work order by saving a quote [User ID] – VMESTWIN – save Quote 
[Quote ID]/[Line #]

Creating a work order by saving a quote created 
with MPC

[User ID] – VMESTWIN – save Quote 
Quote [Quote ID]/[Line #] (MPC)

Creating a work order by importing an Excel file in 
the Manufacturing Window [User ID] – VMMFGWIN – import Excel file

Manually creating a master in the Manufacturing 
Window or Project Window. 

[User ID] – VMMFGWIN – new [Master 
Type]. The types are Eng Master, Project, 
Quote Master, and Work Order.

Creating a work order from another master in the 
Manufacturing Window or Project Window.

[User ID] – VMMFGWIN – new Work Order 
from [Master Type]. The types are Eng 
Master, Project, Quote Master, and Work 
Order.
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Creating a work order by splitting an existing work 
order in the Manufacturing Window

[User ID] – VMMFGWIN – split Work Order 
[Work Order ID]

Generating a customer order from a quote with 
Create Work Orders also check box selected in the 
Customer Order Entry window.

[User ID] – VMORDENT – generate Order 
[Customer Order ID] from Quote [Quote ID]/
[Quote Line #]

Generating a customer order from a quote that is 
generated by MPC in the Customer Order Entry 
window

[USER ID] – VMORDENT – generate Order 
[Customer Order ID] from Quote [Quote ID]/
[Quote Line #] (MPC)

Saving a customer order with the New W/O check 
box selected in the Customer Order Entry window

[User ID] – VMORDENT – save Order 
[Customer Order ID] [Customer Order Line 
#] 

Saving a customer order with a new work order 
generated by MPC in the Customer Order Entry 
window

[User ID] – VMORDENT – save Order 
[Customer Order ID] [Customer Order Line 
#] (MPC)

Generating a customer order from a quote with 
Create Work Orders also check box selected in the 
Order Management Window.

[User ID] – VMORDWIN – generate Order 
[Customer Order ID] from Quote [Quote ID]/
[Quote Line #]

Generating a customer order from a quote that is 
generated by MPC in the Order Management 
Window

[USER ID] – VMORDWIN – generate Order 
[Customer Order ID] from Quote [Quote ID]/
[Quote Line #] (MPC)

Saving a customer order with a new work order 
generated by MPC in the Order Management 
Window

[User ID] – VMORDWIN – save Order 
[Customer Order ID] [Customer Order Line 
#] (MPC)

Saving a customer order with the New W/O check 
box selected in the Order Management Window

[User ID] – VMORDWIN – save Order 
[Customer Order ID] [Customer Order Line 
#] 

Firming a planned work order in the advanced 
mode of the Material Planning Window [User ID] – VMPLNWIN – firm Order

Firming or releasing a planned order in the 
Material Planning Window

[User ID] – VMPLNWIN – firm/release 
Planned Order

Placing a work order in the Material Planning 
Window [User ID] – VMPLNWIN – place Work Order

Creating a quote for an RMA in RMA Entry [User ID] – VMRMAENT – create Quote for 
RMA [RMA ID]

Creating an evaluation work order for an RMA in 
RMA Entry

[User ID] – VMRMAENT – evaluation for 
Order [Customer Order ID] for RMA [RMA 
ID] 

How the master was created Entered By message
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Creating a repair work order for an RMA in RMA 
Entry

[User ID] – VMRMAENT – repair for Order 
[Customer Order ID] for RMA [RMA ID]

Creating a repair work order in RMA Entry [User ID] – VMRMAENT – repair Work 
Order [Work Order ID] for RMA [RMA ID]

Creating a work order for unplanned equipment 
maintenance [User ID] – VMUPMNT – save Call [Call ID]

How the master was created Entered By message
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Scheduling Work Orders
The following section covers how work order schedules are checked and the actual scheduling of 
work orders is performed. See “Concurrent Scheduler and Scheduling Window.”

Checking Schedule Availability
The Check Availability command in the Manufacturing Window allows you to test schedule a work 
order or a master against one of the current schedules to see how it would fit. Use the Global 
Scheduler or the Schedule This Work Order command in the Manufacturing Window to permanently 
schedule the order.

To use this feature:

1 Select the work order to schedule.

2 Select Check Availability from the File menu.

If this work order has a hard release date, the Treat Release Date as Hard check box is selected.

3 Select the Schedule ID of the schedule you want to check against.

To see how this work order would fit into the current schedule, choose the production schedule 
from the Schedule ID drop down menu. 

To see how this work order would fit into a “what if” schedule, select the schedule ID from the 
drop-down menu. This allows you to see how the work order affects resource loadings. This may 
require higher or lower headcount if you are to meet a schedule.

4 In the Work Order/Master to schedule field, the work order you selected in step 1 is inserted. If the 
part in the work order has an engineering master, you can check availability based on the 
engineering master instead. Click the arrow and select the engineering master. 

5 If necessary, change the Release Date and Want Date.

Release Date and Want Date default from the work order header. You can change these fields if 
you want to examine the impact of different dates.

These do not permanently change the work order Release and Want Dates. You may also want to 
generate one by using the other, as follows:

a If you have a desired Release date and Want date, you may want to check whether they are 
possible to meet based on the current schedule. Leave both fields set to these dates.

If you would like the work order to begin immediately, check the Force Forward Schedule box.

b If you have a projected release date, you may want to determine a reasonable Want Date to 
promise. Set the Release Date, leave Want Date blank, and check the Force Forward 
Schedule box. Assuming your current schedule is accurate, this estimates a realistic Want 
Date.

6 If necessary, change the Desired Quantity.

Desired Quantity defaults to the work order desired quantity. You may change the quantity if you 
want to see the effects of a different quantity.
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7 If you want the schedule check to include a check of material availability, select the Check 
Material Availability check box.

This examines material lead times and purchase orders that have already placed in determining 
when you can start work based on available materials.

8 Click the Schedule button to start the check.

This information appears in the Output Information section of the Check Availability dialog box:

Scheduled Start Date – This is the date on which the first operation of the work order would start.

Scheduled Finish Date – This is the date the work order is scheduled to be finished. If you’re 
checking against a specified Want Date, you should compare whether this date is on or before it. 
If it is neither, the check shows that the date cannot be met with the schedule as it stands. You 
may want to run the check against an infinite schedule to see where the overloaded resources 
are.

If you are using this feature to determine a reasonable Want Date, you can use this scheduled 
finish date as the Want Date. You may want to add a safety factor to it.

Determinate Path Days Delay – This is the total time between the start and finish dates of the 
determinant path that is not occupied by actual scheduled production. This provides a measure of 
how much earlier your want date could be if no other work orders were scheduled to interfere with 
this one. Visually, this is the sum of the horizontal gaps between successive operations of the 
determinant path in the Scheduling Window that are not caused by weekends or other 
nonproduction time.

Total Days Delay – Similar to Determinant Path Days Delay, this is the days delay for all 
operations in the work order, not just the determinant path.

Rate per Day – Information is displayed in this field if the part is a rate-based part. This field 
shows the quantity that the work order produces each day. See "Rate-based Parts" on page 5–1 
in this guide.

First Delivery Date – Information is displayed in this field if the part is a rate-based part. The first 
day that the part is scheduled to be produced based on the schedule input settings. Note that the 
quantity produced on the first delivery date could be less than the daily rate. If the total quantity 
produced in the work order is not a multiple of the daily rate, then a quantity that is less than the 
daily quantity is produced on the first day. For example, if the daily rate of a part is 8 and the total 
quantity of the work order is 20, then 4 parts are produced on the first day. 

9 When checking the schedule, actual place holding items are put into the schedule database. 
When you press the Close button, you’re asked if you want to remove the results of this check 
from the schedule. You may want to leave them in the following circumstances:

a You will shortly schedule this work order, but not immediately. You can leave the items 
scheduled in to reserve the space in case additional items are also scheduled in the mean 
time.

b You want to examine the results of the check in more detail by using the Scheduling Window. 

If you answer NO to remove results, you can remove them later by using the Purge Availability 
Checks option in the Global Scheduler.
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Scheduling the Current Work Order
Use the Schedule Current Work Order command to schedule the current work order into a schedule 
without running the full global scheduler. To do this:

1 Select Schedule Current Work Order from the File menu.

This dialog box is similar to the Check Availability window, with the following differences:

• You are only free to change the Schedule ID to use the Check Material Availability option and
the Freeze Started operations option. The other items are locked in from the work order
header.

• When you press Schedule, the work order is actually permanently scheduled, rather than just
checked.

Note: When you schedule an individual work order into an existing schedule this way, the work 
order necessarily gets the lowest priority among all orders that are already in the schedule unless 
it has a hard release date. This function never modifies existing work order schedules; the current 
work order is fit in where possible. If this is not the result you want, you should use the Concurrent 
Scheduler to schedule this work order, and reschedule all others. Schedule Current Work Order is 
most useful when the work order is planned for a time period where there is little other activity. 
Then, this function quickly schedules the new order without the overhead of rescheduling all other 
orders.

2 In the Schedule ID field, the production schedule ID is inserted. To schedule the work order in a 
“what if” schedule, select the appropriate schedule ID. 

3 In the Work Order to Schedule field, the ID of currently selected work order is inserted. 

4 If you want the schedule check to include a check of material availability, select the Check 
Material Availability check box.

5 If you want the schedule check to include a check of service availability, select the Check Service 
Availability check box.

6 If you want to freeze started operations before scheduling, select the Freeze Started Operations 
check box.

7 Click the Schedule button to start the check.

This information appears in the Output Information section of the Schedule Work Order dialog 
box:

Scheduled Start Date – This is the date on which the first operation of the work order will start.

Scheduled Finish Date – This is the date on which the work order is scheduled to be completed.

Determinate Path Days Delay – This is the total time between the start and finish dates of the 
determinant path that is not occupied by actual scheduled production. This provides a measure of 
how much earlier your want date could be if no other work orders were scheduled to interfere with 
this one. Visually, this is the sum of the horizontal gaps between successive operations of the 
determinant path in the Scheduling Window that are not caused by weekends or other 
nonproduction time.

Total Days Delay – Similar to Determinant Path Days Delay, this is the days delay for all 
operations in the work order, not just the determinant path.
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Showing Work Order Audit Information
Use the Work Order Audit option to display work order audit information for an individual work order in 
the current Schedule ID. You must activate the Work Order Audit function in the Concurrent 
Scheduler to view work order audits.

1 You can also access the Work Order Audit Detail dialog box by selecting Work Order Audit 
Detail from the Info menu of the Scheduling Window, or by choosing a work order and clicking on 
the Show Detail button in the Work Order Audit dialog box, also available from the Info menu.

The ID of the work order appears in the Work Order ID read-only field at the top of the dialog box.

A list of operations and result details appears in the below table.

2 To view the results of a scheduling pass, check the Result column of each operation. The result 
column contains the single character result code for the scheduling pass.

3 Click the Result Description button to see what the results codes mean

The Audit Result Codes dialog box contains a list of audit result codes for operations in the 
current work order.

4 Select the Show Critical Material check box to highlight materials that are severely late, or 
“critical” to the work order being completed on time. Those materials become red.

5 Click the Print button to output the work order audit results to your default printer.

Scheduling Selected Work Orders
This option is not available if you are licensed to use DBR or Easy Lean. If you are licensed to use 
DBR or Easy Lean, use the DBR Scheduler to create and schedule work orders. See "DBR 
Scheduling" on page 17–39 in this guide.

You can choose to schedule multiple selected work orders. To use this option: 

1 If you are licensed to use multiple sites, open a master that belongs to the site that contains the 
work orders to schedule. If you are licensed to use a single site, open any master.

2 Select File, Select and Schedule Work Orders.

3 Double-click the Work Order ID browse button and select the work orders you would like to 
schedule. You can select multiple work orders from the dialog box, or you can select work orders 
one at a time. If you plan to use the Table window order option, you may want to select work 
orders one at a time to arrange the work orders in the order you want.

The system displays the following information about each work order:

Global Rank – The system inserts the priority you set for the work order. Set work order priorities 
in the Work Order Priority dialog box.

Release Date – The system inserts the date the work order’s status was changed to Released.

Want Date – The system inserts the want date from the work order header.

Start Date – This is the date on which the first operation of the work order will start.
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Finish Date – This is the date on which the work order is scheduled to be completed.

Determinate Path Days Delay – This is the total time between the start and finish dates of the 
determinant path that is not occupied by actual scheduled production. This provides a measure of 
how much earlier your want date could be if no other work orders were scheduled to interfere with 
this one. Visually, this is the sum of the horizontal gaps between successive operations of the 
determinant path in the Scheduling Window that are not caused by weekends or other 
nonproduction time.

Total Days Delay – Similar to Determinant Path Days Delay, this is the days delay for all 
operations in the work order, not just the determinant path.

4 Select the Schedule ID.

To add the work order the current schedule, choose the production schedule.

5 Select from the following options:

Check Material Availability – Select this option to check that materials are available as part of 
the scheduling process.

Check Service Availability – Select this option to check that services are available as part of the 
scheduling process.

Treat release date as hard – Select this option to enforce the release date on the work order. 
The system schedules the work order to begin on the release date. If you clear this option, the 
system disregards the release date and schedules the work order as time and materials allow.

Freeze started operations – Select this option to freeze the schedule of any started operations. If 
you clear this check box, the system may reschedule started operations.

6 Select the order the system should schedule the work orders. Select one of the following options:

Order want date – The system schedules the work order with the earliest want date first, the 
second earliest want date second, and so on.

Priority, want date – The system schedules the work order with the highest priority and the 
earliest want date first. The system schedules all work orders with the highest priority before 
scheduling other work orders.

Priority, release date – The system schedules the work order with the highest priority and the 
earliest release date first. The system schedules all work orders with the highest priority before 
scheduling other work orders.

Table window order – The system schedules the work orders in the order in which they are 
displayed in the work order table. 

7 Click the Schedule button to schedule the work orders.

Using the Concurrent Scheduler
Use the Concurrent Scheduler to schedule all firmed and released work orders. It supports multiple 
finite and infinite capacity schedules.

Use the Scheduling Window to view the results of one or more global schedules in a graphical mode.
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Copying and Pasting

Copying & Pasting Operations
If you are licensed to use multiple sites, you can copy and paste operations between sites, provided 
that the resource in the operation exists in both sites. If you are copying materials in conjunction with 
the operation, the parts must exist in both sites as well. After you copy and paste, check the 
warehouse ID field on any material cards to ensure that the warehouse specified exists in the site on 
the master header. 

If an existing operation contains an obsolete resource, then you cannot copy the operation. 

Use the Copy and Paste commands to copy operations.

1 Select the operation you want to copy.

2 Select Copy from the Edit menu or right-click and choose Copy from the pop-out menu.

3 To replace the contents of an existing operation with the copied one, select the operation to 
replace and select Paste from the Edit menu.

The copied operation replace all operation fields except Sequence Number.

To insert the operation as a new operation, select the header (to paste it onto the main leg) or a 
leg header (to paste it onto a leg), and select Paste from the Edit menu.

A new operation is created on the selected leg, with all the attributes of the one you copied. You 
can only do this if there is not another operation with the same sequence number on the leg.

When you copy an operation, its material requirements and legs are also copied.

If the current operation already has a leg or piece number of the same number, you cannot paste.

Copying & Pasting Operations and Materials Using the SHIFT and 
CTRL Keys
You can use the SHIFT and CTRL keys on your keyboard to select multiple operations and materials 
to copy and paste/drag and drop from one work order/master to another. For example:

If you select an operation, hold down the SHIFT key, and click the mouse on another operation—not 
sequential to the first—all operations are selected between the two designated operations.

If you hold down the SHIFT key and CTRL key, and then select an operation, all operations are 
automatically selected on that leg.

If you select an operation, hold down the CTRL key, and then click the mouse on another operation, 
All operations are selected while the CTRL key is pressed, regardless of position in the structure.

With multiple operation/materials selected, you can use the Edit menu options Copy and Paste or 
simply drag and drop the cards to the other work order/master. See the section earlier in this chapter 
for more information on dragging and dropping.
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Copying & Pasting Material Requirements
If you are licensed to use multiple sites, you can copy and paste materials between sites, provided 
that the part ID in the material card exists in both sites. After you copy and paste, check the 
warehouse ID field on any material cards to ensure that the warehouse specified exists in the site on 
the master header.

1 Select the material requirement you want to copy and select Copy from the Edit menu, or, if you 
have the popout menu active, right-click the card and select Copy from the popup menu.

2 To replace the contents of an existing requirement with the copied one, select the operation to 
replace and select Paste from the Edit menu.

All material fields are replaced except Piece Number.

To insert the material requirement as a new requirement on an operation, choose the operation 
and select Paste from the Edit menu.

A dialog box appears, asking you to enter a piece number for the new requirement.

3 Enter a piece number then click Ok.

A new material requirement is created for the selected operation, with all the attributes of the 
copied one. You can only do this if there is not another requirement with the same piece number 
on the operation.

Copying & Pasting Legs
Before you can copy and paste a leg, you must create a new operation to which you will paste the 
copied leg.

1 Select the operation you to which you want to copy the leg.

2 Select Add Leg from the Edit menu and follow the procedures for adding a leg.

3 Select the leg you want to copy and choose Copy from the Edit menu.

This copies the entire leg structure.

4 Select the new leg you created, and choose Paste from the Edit menu.

The leg structure is added to the new leg. You can paste to an existing leg, but it cannot have any 
of the same operation sequence numbers.

Using Drag and Drop to Copy Work Orders and Masters
The Manufacturing window supports the dragging and dropping of work order/master material and 
operations from an existing work order/master to a new work order/master, or one for which only a 
header card and no operations or materials exist. The act of dragging and dropping is equal to 
copying and pasting: material and operation information is copied from the source work order/master 
to the new work order.
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Because dragging and dropping is a physical From/To operation, you must have multiple windows 
open. Open and arrange side by side the work order/master from which you are copying information 
and the work order to which you are copying the information. See earlier for more information on 
opening and arranging multiple windows.

If you are licensed to use multiple sites, you can drag and drop between sites provided that the 
resources and materials you are dragging and dropping exist in both sites. After you drag and drop, 
check the warehouse ID field on any material cards to ensure that the warehouse specified exists in 
the site on the master header. 

For example:

1 Open an existing work order. This should be the work order from which you want to copy 
information.

2 Start a new work order. Enter necessary information in the Edit dialog box and save the work 
order.

3 Tile the windows so you can view both and easily drag and drop between the two.

4 Point anywhere on the work order/master you want to copy from and hold down the left mouse 
button until a box appears. You have the option of using the SHIFT and CTRL keys to select 
contiguous and non-contiguous operations and materials to drag and drop. See later in this 
chapter for more information.

5 Drag the box into the adjacent window and release the box anywhere on the new work order/
master header card.

The progress of the copy and paste operation is displayed in a dialog box. If, for some reason, the 
operation was not successful or the paste types were incompatible, an error message is 
displayed.

Note: Any document references from the information you are copying is automatically copied; it is 
assumed you want to copy these document references.

If you try to drag and drop a work order/master to another window in which there is a work order/
master with an identical sequence number, a message box is displayed warning you that pasting 
would cause a duplicate key for an operation.

It is important to remember that when a copy and paste function is performed, operations and 
materials are copied but quantity and other header fields are not copied, such as engineering 
drawings or revision numbers. Nor does a work order/master’s labor tickets or materials issues/
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links get copied to the new work order/master. After you’ve created the new work order, you can 
modify it as necessary. Because the new work order does not inherit the other’s status, you can 
now Release it to the floor if you choose and begin to report labor against it.

Copying Structures
During the building or maintenance process, you may want to replicate a portion of an existing master 
or work order in another one. This is useful for building masters and work orders using standard 
strings of operations and material requirements. You can do this using the Copy From command.

If you are licensed to use multiple sites, you can use this function within the same site only. You 
cannot copy from one site to a second site.

Copying Existing Master/Work Orders to New Masters
1 From the File menu, select New.

2 Click Save. A single header master is created.

3 Select the header and select Copy From from the Edit menu.

4 In the Type box, select the type of master to copy.

5 Click the Base ID browse button and select the master to copy.

6 Click the Ok button.

If an operation in the master contains an obsolete resource, then a message is displayed 
informing you that the master contains an obsolete resource. The new master is not created. 

The system asks if you want to overwrite the information in the header. Click Yes to continue.

The selected master/work order is copied to the new header.

The Copy From function copies all data elements from the indicated Work Order/Master including 
quantity, release date and want date. You should use New Work Order From functions to launch 
new work orders to be released, as they do not overwrite these values.

Note: If the master/work order you are copying contains any document references, those 
references are copied to the header card of the new work order.

Copying Entire Master/Work Orders to Become Legs of the Current 
Master Work/Orders
1 Select the operation to which you want to add the leg and add the leg using the procedures 

described above.

2 Select the leg header and from the Edit menu, select the Copy From option.
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A dialog box appears, allowing you to enter Base ID, Lot/Eng ID, and Split ID of the master/work 
order from which you are copying. You can also use the standard Search function.

3 Click the Ok button.

The selected master/work order is copied to the leg. The leg header you selected replaces the 
header of the copied master/work order, and the entire structure is added to the new leg. This 
also includes any legs on the copied structure.

Note: If the master/work order you are copying contains any document references, those 
references are copied and added to any references you have on the header card of the current 
master/work order.

Copying an Operation of an Existing Master/Work Order to Replace 
an Existing Operation of the Current Work Order
1 Select the operation that you want to replace with the copied operation and select Copy From 

from the Edit menu.

2 Specify the master/work order ID information.

A table appears, listing every operation in the specified master/work order.

3 Select ONE operation that you want to use to replace the current one.

4 Click the Ok button.

The currently selected operation retains its sequence number, but it is replaced with the contents 
of the copied operation. Any material requirements are copied on the copied operation, but 
requirements are not removed on the current operation. You can only copy requirements if they 
have a different Piece Number from requirements on the current operation. For example, you 
cannot copy an operation that has a requirement with a Piece Number 10 if the current operation 
already uses that piece number.

Using Copy From allows you to build masters and work orders from standard templates and 
other existing pieces. However, you should consider the following issues when using this feature:

• Copying an Engineering Master into another work order makes that engineering master
unique to that work order. This means that if you change the engineering master, it is NOT
changed in that work order (or any other work order to which it has been copied).

If you are building and stocking subassemblies and issuing them to work orders, you should 
NOT use Copy From. You should add the subassembly to the work order as a material. That 
way, if you have to change the engineering master, it also changes in any work orders to 
which it has been added using the Add Material function.

• Use Copy From if you are building a unique subassembly as a part of a work order. You can
copy from an existing engineering master and modify it once it is in the work order, if
necessary.
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Purchasing Materials and Services
You can purchase materials and services from the Manufacturing Window. 

If you are licensed to use multiple sites, the purchase order is generated in the site specified on the 
work order header.

To generate a purchase order:

1 Open the Purchase Material dialog box by either:

• Selecting the material requirement from the Manufacturing Window and choose Purchase
This Material/Service from the Edit menu.

• Placing a PO in the Material Availability window by selecting a requirement line and choosing
Purchase This Material/Service from the Edit menu.

The Purchase Material dialog box is displayed. The Work Order ID, Operation Sequence Number, 
Piece Number, and Net Quantity Required of the material appear in the table at the upper left.

2 This information about quantities is displayed next to the table:

Reqd Qty – This is the quantity needed to fulfill the material requirement. For non-piece tracked 
parts, this quantity is equal to the Calculated Quantity field on the Planning tab of the Material 
Card. For piece tracked parts, this quantity is equal to the Calculated Piece Qty field on the 
Planning tab of the Material Card. This is true for piece tracked parts even if you use the actual 
quantity used calculation for the Calculated Quantity field. See "Calculated Quantity Values for 
Piece Tracked Parts" on page 3–16 in this guide.

Add’l Qty – This field is available only if you are purchasing a non-piece tracked part. Specify the 
additional quantity you require in the Add’l Qty field. Order Quantity is equal to Required Quantity 
+ Additional Quantity.

Reqd Pcs – This field is used only if you are purchasing a piece-tracked part. This is the total 
number of whole pieces needed to fulfill the material requirement. This value is equal to the 
Calculated # of Pcs field on the Planning tab of the Material card. 

3 Specify requirement linking.

You may want to link the purchase directly to the material requirement. This marks the purchase 
for the job, and enables automatic issuing of the material when it is received.

The Link to Each Requirement check box is checked by default. If you do not want to link the 
purchase to this job, clear this check box.

If you are unsure of which purchase orders may already be linked, you can select the work order 
requirement from the upper table, and any existing linked POs for this requirement are listed in 
the table at the bottom of the screen. Additionally, the Total Quantity Required and Total Quantity 
Issued for the requirement appear. This allows you to assess what quantities have already been 
purchased to the job, and which are still needed.

4 Click the Order button to place the order.
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Purchase Order Entry is automatically started. The preferred vendor for the part, or the Vendor ID 
specified in the requirement is used for the PO. If you are linking to the requirement, one PO line 
item is created for the requirement, and an additional line item is created for any additional 
quantity ordered. If you are not linking to the requirement, then a single line item is created. 
Receive Date for all items default to the Required Date for the material requirement.

You can edit any or all of the information in this order. To place the order press Save. To cancel 
without placing the order, Close the Purchase Order Entry window.

You can build a purchase order for multiple requirements purchased from the same vendor. After 
making the first purchase, leave the Purchase Order Entry window open. Each time you use 
Purchase This Material/Service, a line is added to the current purchase order, rather than creating a 
new one. When finished, Click the Save button and use the Clear option to ready the Purchase Order 
Entry screen for any other orders.

Allocating Quantities of Selected Purchase Order Links
When you use Purchase Order Entry to purchase a material/service through the Manufacturing 
Window, you can allocate quantities of that material on the purchase order line.

For example, if you purchase 5,000 1/4 Plates (Total Quantity Required) for a work order 
requirement, and then allocate 122 (Total Quantity Allocated) of those plates during the completion 
of the purchase order line item, the Purchase Material dialog box displays this information after you 
save the purchase order and return to the Manufacturing Window. PO-30008 is the open purchase 
order from which you are both purchasing and allocating the parts.

Dispatching Services
You can dispatch parts to outside service vendors using the Manufacturing Window, but you must 
have a purchase order linked to the operation. You can start Purchase Order Entry from the 
Manufacturing Window.

If you are licensed to use multiple sites, the dispatch record is created in the site ID specified on the 
work order header card.

1 In the Manufacturing Window, select the service operation that you want to dispatch.

2 Select Dispatch this Service from the Edit menu.

This menu option is only available if you are pointing to an outside, contracted service operation 
card in the Manufacturing Window. By default, these cards are light blue in color.

If there is no service purchase order linked to this operation, a dialog box appears, asking if you 
want to purchase this service.

3 Click the Yes button.

The Order Quantity field shows the total quantity used in the operation.
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When you first seek to dispatch a service, these two fields are the only present fields. After 
ordering the dispatch of a quantity, you can carry out subsequent dispatches by entering a value 
in the Dispatch Quantity field. See the rest of this procedure for more information.

4 In the Dispatch Quantity field, enter the quantity you want to dispatch to the service at this time.

This value, either alone or in combination with the Total Quantity Dispatched value, cannot 
exceed the Order Quantity of the service.

If you issue purchase orders with the preference Auto Dispatch Services specified in the 
Purchase Order Entry window, the Dispatch Quantity field is unavailable and the value mirrors the 
Order Quantity, as all service quantities are set for auto dispatch. For more information, refer to 
the “Purchase Order Entry” chapter in the Purchasing guide.

Click the Order button.

The Purchase Order Entry window appears. The window contains the current information for the 
service vendor. The Dispatch Quantity column of the table shows the dispatch quantity you 
specified in the Purchase Service dialog box.

When you return to the Manufacturing Window you can view what quantity was dispatched in the 
Total Quantity Dispatched column.

Subsequent service dispatches allow you to view the Total Quantity Dispatched field, which 
displays what quantity of the Order Quantity was dispatched.

5 Enter an amount that, in combination with the Total Quantity Dispatched value, does not exceed 
the Order Quantity of the service.

If you enter a greater value, an error message is returned, and the procedure is halted.

6 Click the Dispatch button.

This time, the Service Dispatch Entry window opens for you to specify service dispatch 
information.

Save the dispatch.

7 When you return to the Manufacturing Window, service dispatches appear in the line item table.
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Using the Leg/Master Updater
If you have created a leg in a master from another master, you can use the Leg Updater to update the 
leg if you change the original master. Similarly, you can apply changes you make to a leg to the 
original master.

If you are licensed to use multiple sites, legs and masters are updated within the same site only. You 
can not use this function to update a master or leg in one site from a master or leg in a second site.

Designating Legs and Engineering Masters as Eligible for 
Updating
Before you can use the master updater to update masters from legs, you must designate masters as 
eligible for updating. To designate an engineering master as eligible for updating from legs:

1 Open the engineering master.

2 Open the header card.

3 Click the Engineering tab.

4 Select the Allow Update from Leg check box.

5 Click Save.

If the engineering master has legs, then you need to designate each leg as eligible for updating. Open 
the leg header card, click the Engineering tab, and select the Allow Update from Master check box.

Before you can use the leg updater to update legs from masters, you must designate legs as eligible 
for updating. To designate a leg as eligible for updating from an engineering master:

1 Open the work order, quote master, or engineering master.

2 Open the header card of the leg.

3 Click the Engineering tab.

4 Select the Allow Update from Master check box.

5 Click Save.

Updating Engineering Masters from Legs
You can update an Engineering master from a leg on any type of master: work order, engineering 
master, or quote master. 

To update an engineering master from the leg of another master:

1 Select Edit, Legs, Update Master from Leg.
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2 If you accessed the dialog box from a master, the system inserts the Part ID, Type, Base ID, Lot 
ID, Split ID, and Sub ID you selected in the Manufacturing window. Click the browse buttons to 
change the information.

3 If you have more than one engineering master for the part ID, click the Eng ID arrow to select the 
engineering ID to update. The system displays only the IDs of engineering masters that are 
eligible for updating.

4 Click Save. 

5 The system asks if you want to print a pre-update engineering report. The pre-update engineering 
report displays the original information from the engineering master before any changes are 
applied. Click Yes to view the report or No to proceed with the update without viewing the report. 
If you click yes, specify the output options and click Ok. Print a copy of the report to compare to 
the after-update engineering report.

6 After the system updates the master, it asks if you want to print an after-update engineering 
report. You can compare this report to the pre-update engineering report to view the changes the 
update process made. Click Yes to view the report. Click No if you do not want to review the 
report.

7 The system asks if you want to update any legs that use the master that you updated. Click Yes 
to open the Update Legs from Master dialog box. Refer to the following procedure for more 
information. Click No if you do not want to update legs that use the engineering master.

Updating Legs from Engineering Masters
You can update a leg on any type of master: work order, engineering master, or quote master. You 
cannot update a leg if any one of the following conditions is true:

• Quote masters linked to quotes that have been printed. 
• Any master with an active ECN, unless you are on the implementation team for the ECN.
• Any work order with a status of Closed or Canceled.
• Any work order with transactions against any part of the leg. 
• Any master where the Allow Update from Master check box is not selected on the Engineering

tab.

To update a leg from an engineering master:

1 Select Edit, Legs, Update Legs from Master.

2 If you accessed the dialog box from an engineering master, the system inserts the Part ID and 
Source Eng ID. Click the Source Eng ID arrow to select another engineering master. You can 
select a different part by clicking the Part ID browse button and selecting a part, then selecting the 
Source Eng ID. 

3 Use the filters to limit the masters the system displays in the table. Choose from the following 
options:

Type – Select the type of master to view. Select from Work orders, Eng Masters, and Quote 
Masters. You can select more than one option.
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Status – Select the status of the work order. Select from Firm, Released, Unreleased, Closed, or 
Canceled. You can select more than one option. While you can view Closed or Canceled masters 
in the table, you cannot update them. 

Include updatable legs only – Select this check box to view only legs that are eligible to be 
updated. Refer to "Designating Legs and Engineering Masters as Eligible for Updating" on page 
3–97 in this guide. Clear the check box to view any master where the part ID is used for a leg.

Exclude legs already updated to part engineering ID – Select this check box to exclude any 
legs that have already been updated by the selected engineering master. Click the arrow to 
specify the master.

Exclude legs updated after – Select this check box to exclude any legs that have been updated 
after the date you specify. Click the calendar button to select the date to use.

The system inserts the masters that meet your filter criteria in the table. The table contains the 
following information:

Update Leg – Click the check box if you want the system to update the leg when you click the 
save button. Clear the check box if you do not want to update the leg. Click the Mark All button to 
select all masters eligible for updating. Click the Unmark All button to clear all Update Leg check 
boxes.

Work Order/Master Leg – The system inserts the ID of the master or leg where the part is used.

Message – The system inserts “Leg does not allow updates” if the leg is not eligible to be 
updated. The system displays this message if the Allow Update from Master check box has been 
cleared on a leg card, if the master is Closed or Canceled, or if the work order has any 
transactions against the leg to be updated. If the master has an active ECN, the system displays 
the “Leg does not allow updates” message if you are not on the implementation team. If you are 
on the implementation team, the system displays a caution message.

The system inserts “Update Allowed” if the leg can be updated.

Work Order Status – The system inserts the current status of the master.

Leg Status – The system inserts the current status of the leg.

Quantity Per – The system inserts the quantity of part required per end product produced as 
specified on the master or leg header card. You can change this value. Click in the Quantity Per 
field and specify a new value.

Scrap % – The system inserts the percentage of part lost as scrap during the production process 
as specified on the master or leg header card. You can change this value. Click in the Scrap % 
field and specify a new value.

Fixed Quantity – The system inserts the fixed quantity of the part consumed as specified on the 
master or leg header card. Fixed quantity is a one time quantity of the required material that is 
used regardless of the work order quantity. You can change this value. Click in the Fixed Quantity 
field and specify a new value.

Unit of Measure – The system inserts the unit of measure of the part.

Dimensions – The system inserts the dimensions as specified on the master or leg header card. 
You can change this value. Click in the Dimensions field and specify a new value.

Last Update From Ref – If the leg has been updated before, the system inserts reference 
information from the most recent previous update.
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Last Update Part Eng ID – If the leg has been updated before, the system inserts the part 
engineering ID used in the most recent previous update.

Last Update Date – If the leg has been updated before, the system inserts the most recent 
update date.

Last Update User ID – If the leg has been updated before, the system inserts the ID of the user 
who last updated the master.

4 Click Save. 

5 The system asks if you want to print a pre-update engineering report. The pre-update engineering 
report displays the original information from the masters before any changes are applied. Click 
Yes to view the report or No to proceed with the update without viewing the report. If you select 
yes, specify the output options and click Ok. Print a copy of the report so you can compare it to 
the after-update engineering report.

6 After the system updates the masters, it asks if you want to print an after-update engineering 
report. You can compare this report to the pre-update engineering report to view the changes the 
update process made. Click Yes to view the report. Click No if you do not want to review the 
report.

Printing a Where Used on Leg Report
You can view where an engineering master is used as a leg on another master by printing the Where 
Used on Leg Report. To print the report:

1 From the Update Legs From Master dialog box, click the Print button.

2 The system inserts the part ID and the filters you selected in the Update Legs from Master dialog 
box in the Where Used on Leg Report dialog box. You can change any of the filters in the Type 
and Status sections. You can also change your selections in the Include updatable legs only, 
Exclude legs already updated to part eng ID, and Exclude legs updated after check boxes.

3 In the Order By section, select the sort order for the report. You can sort the report By Type, By 
Status, or By Workorder/Master.

4 Select the output for the report.

5 Click Ok. 

The report displays the Part ID you selected for the report along with the part’s description and 
stock unit of measure. It lists the master Type, Work Order/Master Leg ID, the Allow Updates flag, 
Leg Status, Last Update Date, Last Update By, and Last Update from Reference for each master 
where the part is used.

Viewing Update Information
You can view information about when a leg was last updated from a master or when a master was 
last updated from a leg. To view information about when a leg was last updated from a master:
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In the Update Legs from Master dialog box, select a Part ID and the appropriate filters. The system 
inserts the following information:

Last Update From Ref – The system inserts the base ID of the engineering master that updated the 
leg.

Last Update Part Eng ID – The system inserts the engineering ID of the master that updated the leg.

Last Update Date – The system inserts the date that the leg was last updated.

Last Update User ID – The system inserts the ID of the user who performed the update.

You can also view this information on the Engineering tab of the Leg Header card.

To view information about engineering masters that have been updated by legs, select the 
engineering master’s header card and click the Engineering tab.

The system displays the following information:

Last Update From Ref – The system inserts the ID of the leg that updated the engineering master.

Last Updated – The system inserts the date that the master was updated.

Last Updated By – The system inserts the ID of the user who performed the update.
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Allocating Supply to Work Order Material 
Requirement Demand
You can allocate supply quantities to work order material requirements from inventory stock, 
purchase order lines, purchase order delivery schedule lines, coproduct supply, interbranch transfers, 
and other work orders. It is possible to assign quantities to the same work order material 
requirements from all six of these sources as long as the work order material requirement and the 
supply links you create have the same Warehouse ID.

If you are licensed to use multiple sites, you can allocate supply from site specified on the work order 
header only.

Allocating Coproduct Supply Quantities to Work Order 
Material Requirements
1 In the Manufacturing window, point to the material requirement card to which you want to allocate 

supply.

2 From the Edit menu, select Allocate Supply to this Material.

The following information appears in the header section. Use these fields as a quick reference 
when establishing supply links to work order material requirements.

Quantity Required – The quantity of the material requirement.

Quantity Issued – The quantity of the material requirement that you have issued from inventory. 
If this quantity is equal to the Quantity Required, further supply is unnecessary. In this case, all of 
the material’s requirements have been met—the only requirement being quantity. For more 
information, refer to the “Inventory Transaction Entry” chapter in the Inventory guide.

Quantity Allocated – The quantity that you have allocated from the supplying sources towards 
meeting this material requirement. If this quantity is equal to the Quantity Required, further supply 
is unnecessary.

Quantity Fulfilled – The allocated quantity of the material requirement that has been fulfilled by 
supply.

Quantity Unallocated – The quantity of this material requirement to which you have yet to 
allocate supply.

Part ID – The Part ID of this material requirement.

Part Description – The description of this part, also the material requirement.

Stock U/M – The stock unit of measure of the part.

Warehouse ID – The Warehouse ID of the material requirement; also, the warehouse in which 
you house it; also the point from which you are issuing it.

Required Date – The date before which or on which you need the material requirement.

3 Click the Insert button to begin establishing supply links.
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4 From the Type list box, select CP.

5 Double-click Supply Base ID to search for eligible coproduct supply.

The Work Order Coproducts Supply dialog box appears.

6 Using the options in the header section of the dialog box, configure a search for coproduct supply 
and click the Apply button.

All qualifying coproducts appear.

7 Select the line from which you want to allocate supply to meet the current material requirement 
demand and click the Ok button.

The line appears in the Supply Links dialog box line item table.

8 In the Allocate Quantity column, enter the quantity that you want to allocate from the coproduct 
supply quantity to the work order material requirement.

This quantity cannot be greater than the Quantity Unallocated of the material requirement or the 
Supply Quantity of the coproduct line. If you attempt to enter a quantity here that will result in the 
over-allocation of supply to the material requirement (A number greater than the Quantity 
Unallocated) or the use of more Supply Quantity than is available (A number greater than the 
Supply Quantity), you are warned that this is not possible.

9 Click Save to commit the link of supply from the coproduct quantity to the work order material 
requirement.

Allocating Inventory Quantities
1 In the Manufacturing window, point to the material requirement card to which you want to allocate 

supply.

2 From the Edit menu, select Allocate Supply to this Material.

The following information appears in the header section. Use these fields as a quick reference 
when establishing supply links to work order material requirements.

Quantity Required – The quantity of the material requirement.

Quantity Issued – The quantity of the material requirement that you have issued from inventory. 
If this quantity is equal to the Quantity Required, further supply is unnecessary. In this case, all of 
the material’s requirements have been met—the only requirement being quantity. For more 
information, refer to the “Inventory Transaction Entry” chapter in the Inventory guide.

Quantity Allocated – The quantity that you have allocated from the supplying sources towards 
meeting this material requirement. If this quantity is equal to the Quantity Required, further supply 
is unnecessary.

Quantity Fulfilled – The allocated quantity of the material requirement that has been fulfilled by 
supply.

Quantity Unallocated – The quantity of this material requirement to which you have yet to 
allocate supply.

Part ID – The Part ID of this material requirement.
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Part Description – The description of this part, also the material requirement.

Stock U/M – The stock unit of measure of the part.

Warehouse ID – The Warehouse ID of the material requirement; also, the warehouse in which 
you house it; also the point from which you are issuing it.

Required Date – The date before which or on which you need the material requirement.

3 Click the Insert button to begin establishing supply links.

4 From the Type list box, select I.

5 Double-click Supply Base ID to view a list of the warehouses and the material requirement’s 
availability status within them.

The Warehouses for part dialog box appears.

The line item table contains the following columns:

Warehouse ID – The ID of the warehouse that carries this part.

Available Quantity – The quantity of the part that is available to the customer in this warehouses 
and its locations. Though this many parts are available, actual availability can be different for each 
customer that seeks to purchase this part. For more information, refer to the “Customer Order 
Entry” chapter in the Sales guide.

Committed Quantity – The quantity of parts in this warehouse and its locations that you have 
committed through demand fulfillment to customer orders, interbranch transfers, work material 
requirements, and inventory. These parts are not locked or unavailable, however.

Expected Quantity – The quantity of parts that you expect to receive into this warehouse from 
purchase orders, work orders, coproducts supply and interbranch transfers. You can allocate 
expected quantities to customer orders, work order material requirements, interbranch transfers 
and inventory.

Expected/Committed Quantity – The quantity of parts that you expect to receive into this 
warehouse from purchase orders, work orders, coproduct supply and interbranch transfers that 
you have already committed to the demand fulfillment of customer orders, interbranch transfers, 
work material requirements, and inventory.

6 Select the warehouse from which you want to allocate supply to meet the current material 
requirement demand and click the Ok button.

The line appears in the Supply Links dialog box line item table.

7 In the Allocate Quantity column, enter the quantity that you want to allocate from the warehouse 
supply quantity to the work order material requirement.

This quantity cannot be greater than the Quantity Unallocated of the material requirement or the 
Supply Quantity of warehouse inventory. If you attempt to enter a quantity here that will result in 
the over-allocation of supply to the material requirement (A number greater than the Quantity 
Unallocated) or the use of more Supply Quantity than is available (A number greater than the 
Supply Quantity), you are warned that this is not possible.

8 Click Save to commit the link of supply from the inventory to the work order material requirement.
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Allocating Purchase Order Delivery Schedule Quantities
1 In the Manufacturing window, point to the material requirement card to which you want to allocate 

supply.

2 From the Edit menu, select Allocate Supply to this Material.

The following information appears in the header section. Use these fields as a quick reference 
when establishing supply links to work order material requirements.

Quantity Required – The quantity of the material requirement.

Quantity Issued – The quantity of the material requirement that you have issued from inventory. 
If this quantity is equal to the Quantity Required, further supply is unnecessary. In this case, all of 
the material’s requirements have been met—the only requirement being quantity. For more 
information, refer to the “Inventory Transaction Entry” chapter in the Inventory guide.

Quantity Allocated – The quantity that you have allocated from the supplying sources towards 
meeting this material requirement. If this quantity is equal to the Quantity Required, further supply 
is unnecessary.

Quantity Fulfilled – The allocated quantity of the material requirement that has been fulfilled by 
supply.

Quantity Unallocated – The quantity of this material requirement to which you have yet to 
allocate supply.

Part ID – The Part ID of this material requirement.

Part Description – The description of this part, also the material requirement.

Stock U/M – The stock unit of measure of the part.

Warehouse ID – The Warehouse ID of the material requirement; also, the warehouse in which 
you house it; also the point from which you are issuing it.

Required Date – The date before which or on which you need the material requirement.

3 Click the Insert button to begin establishing supply links.

4 From the Type list box, select PD.

5 Double-click Supply Base ID search for purchase order delivery schedule lines from which you 
can allocate supply to the current work order material requirement.

The Purchase Order Delivery Schedule Supply dialog box appears.

6 Using the options in the header section of the dialog box, configure a search for purchase order 
delivery schedule line supply and click the Apply button.

All qualifying purchase order delivery schedule lines appear.

7 Select the line from which you want to borrow supply to meet the current material requirement 
demand and click the Ok button.

The line appears in the Supply Links dialog box line item table.

8 In the Allocate Quantity column, enter the quantity that you want to allocate from the purchase 
order delivery schedule line to the work order material requirement.
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This quantity cannot be greater than the Quantity Unallocated of the material requirement or the 
Supply Quantity of the purchase order delivery schedule line. If you attempt to enter a quantity 
here that will result in the over-allocation of supply to the material requirement (A number greater 
than the Quantity Unallocated) or the use of more Supply Quantity than is available (A number 
greater than the Supply Quantity), you are warned that this is not possible.

9 Click Save to commit the link of supply from the purchase order delivery schedule line to the work 
order material requirement.

Allocating Purchase Order Quantities
1 In the Manufacturing window, point to the material requirement card to which you want to allocate 

supply.

2 From the Edit menu, select Allocate Supply to this Material.

The following information appears in the header section. Use these fields as a quick reference 
when establishing supply links to work order material requirements.

Quantity Required – The quantity of the material requirement.

Quantity Issued – The quantity of the material requirement that you have issued from inventory. 
If this quantity is equal to the Quantity Required, further supply is unnecessary. In this case, all of 
the material’s requirements have been met—the only requirement being quantity. For more 
information, refer to the “Inventory Transaction Entry” chapter in the Inventory guide.

Quantity Allocated – The quantity that you have allocated from the supplying sources towards 
meeting this material requirement. If this quantity is equal to the Quantity Required, further supply 
is unnecessary.

Quantity Fulfilled – The allocated quantity of the material requirement that has been fulfilled by 
supply.

Quantity Unallocated – The quantity of this material requirement to which you have yet to 
allocate supply.

Part ID – The Part ID of this material requirement.

Part Description – The description of this part, also the material requirement.

Stock U/M – The stock unit of measure of the part.

Warehouse ID – The Warehouse ID of the material requirement; also, the warehouse in which 
you house it; also the point from which you are issuing it.

Required Date – The date before which or on which you need the material requirement.

3 Click the Insert button to begin establishing supply links.

4 From the Type list box, select PO.

5 Double-click Supply Base ID to view a list of all purchase orders in your database.

The Purchase Orders dialog box appears.

6 Select a purchase order and click the Select/Close button.
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7 Double-click Seq #/Line # to search the selected purchase order for eligible lines—an eligible line 
being one with the same Part ID as the work order material requirement.

The Purchase Order Lines dialog box appears.

8 Using the options in the header section of the dialog box, configure a search within the selected 
purchase order and click the Apply button.

If there are any, all qualifying lines in the selected purchase order appear.

9 Select the line from which you want to allocate supply to meet the current material requirement 
demand and click the Ok button.

The line appears in the Supply Links dialog box line item table.

10 In the Allocate Quantity column, enter the quantity that you want to allocate from the purchase 
order line to the work order material requirement.

This quantity cannot be greater than the Quantity Unallocated of the material requirement or the 
Supply Quantity of the purchase order line. If you attempt to enter a quantity here that will result 
in the over-allocation of supply to the material requirement (A number greater than the Quantity 
Unallocated) or the use of more Supply Quantity than is available (A number greater than the 
Supply Quantity), you are warned that this is not possible.

11 Click Save to commit the link of supply from the purchase order line to the work order material 
requirement.

After you have established a link of supply from a purchase order line to a work order material 
requirement, you can highlight the line in the Supply Links dialog box line item table and click the 
Purchase Order button to view that purchase order. Until you have saved this purchase order line 
supply link, though, this button is unavailable.

Allocating Interbranch Transfer Quantities
1 In the Manufacturing window, point to the material requirement card to which you want to allocate 

supply.

2 From the Edit menu, select Allocate Supply to this Material.

The following information appears in the header section. Use these fields as a quick reference 
when establishing supply links to work order material requirements.

Quantity Required – The quantity of the material requirement.

Quantity Issued – The quantity of the material requirement that you have issued from inventory. 
If this quantity is equal to the Quantity Required, further supply is unnecessary. In this case, all of 
the material’s requirements have been met—the only requirement being quantity. For more 
information, refer to the “Inventory Transaction Entry” chapter in the Inventory guide.

Quantity Allocated – The quantity that you have allocated from the supplying sources towards 
meeting this material requirement. If this quantity is equal to the Quantity Required, further supply 
is unnecessary.

Quantity Fulfilled – The allocated quantity of the material requirement that has been fulfilled by 
supply.
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Quantity Unallocated – The quantity of this material requirement to which you have yet to 
allocate supply.

Part ID – The Part ID of this material requirement.

Part Description – The description of this part, also the material requirement.

Stock U/M – The stock unit of measure of the part.

Warehouse ID – The Warehouse ID of the material requirement; also, the warehouse in which 
you house it; also the point from which you are issuing it.

Required Date – The date before which or on which you need the material requirement.

3 Click the Insert button to begin establishing supply links.

4 From the Type list box, select WH.

5 Double-click <Supply Base ID> to search for eligible interbranch transfer supply – eligible in this 
case being IBTs with To Whose Warehouse IDs that match the Warehouse ID of the material 
requirement at hand.

The Interbranch Transfer Supply dialog box appears.

6 Using the options in the header section of the dialog box, configure a search for interbranch 
transfer supply and click the Apply button.

If there are any, all qualifying incoming interbranch transfer lines appear.

7 Select the line from which you want to allocate supply and click the Ok button.

The line appears in the Supply Links dialog box line item table.

8 In the Allocate Quantity column, enter the quantity that you want to allocate from the interbranch 
transfer line to the current work order material requirement.

This quantity cannot be greater than the Quantity Unallocated of the material requirement or the 
Supply Quantity of the IBT line. If you attempt to enter a quantity here that will result in the over-
allocation of supply to the material requirement (A number greater than the Quantity Unallocated) 
or the use of more Supply Quantity than is available (A number greater than the Supply Quantity), 
you are warned that this is not possible.

9 Click Save to commit the link of supply from the incoming interbranch transfer to the current work 
order material requirement.

Allocating Work Order Quantities
1 In the Manufacturing window, point to the material requirement card to which you want to allocate 

supply.

2 From the Edit menu, select Allocate Supply to this Material.

The following information appears in the header section. Use these fields as a quick reference 
when establishing supply links to work order material requirements.

Quantity Required – The quantity of the material requirement.
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Quantity Issued – The quantity of the material requirement that you have issued from inventory. 
If this quantity is equal to the Quantity Required, further supply is unnecessary. In this case, all of 
the material’s requirements have been met—the only requirement being quantity. For more 
information, refer to the “Inventory Transaction Entry” chapter in the Inventory guide.

Quantity Allocated – The quantity that you have allocated from the supplying sources towards 
meeting this material requirement. If this quantity is equal to the Quantity Required, further supply 
is unnecessary.

Quantity Fulfilled – The allocated quantity of the material requirement that has been fulfilled by 
supply.

Quantity Unallocated – The quantity of this material requirement to which you have yet to 
allocate supply.

Part ID – The Part ID of this material requirement.

Part Description – The description of this part, also the material requirement.

Stock U/M – The stock unit of measure of the part.

Warehouse ID – The Warehouse ID of the material requirement; also, the warehouse in which 
you house it; also the point from which you are issuing it.

Required Date – The date before which or on which you need the material requirement.

3 Click the Insert button to begin establishing supply links.

4 From the Type list box, select WO.

5 Double-click <Supply Base ID> to view a list of all the work orders in your database.

The Work Orders dialog box appears.

Select only those work orders with a Part ID that is the same as the work order material 
requirement to which you are currently assigning supply quantities.

6 Select an appropriate work order and click the Ok button.

The work order line appears in the Supply Links dialog box line item table.

7 In the Allocate Quantity column, enter the quantity that you want to allocate from the work order 
quantity to the current work order material requirement quantity.

This quantity cannot be greater than the Quantity Unallocated of the material requirement or the 
Supply Quantity of the work order line. If you attempt to enter a quantity here that will result in 
the over-allocation of supply to the material requirement (A number greater than the Quantity 
Unallocated) or the use of more Supply Quantity than is available (A number greater than the 
Supply Quantity), you are warned that this is not possible.

8 Click Save to commit the link of supply from the work order to the current work order material 
requirement.
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Allocating Work Order Quantities
You can allocate work order quantities to 2 different types of demand. An allocation is a designation 
of a quantity coming from one place to be used eventually in another. For example, a quantity of 
plates you produce through an in-house work order may be earmarked for use in a customer order. 
Using this procedure you can link the work order header Part ID to a customer order in the database.

You can allocate from a work order to the following types:

• Customer Orders
• Work Order Material Requirements

Allocating Quantities to Customer Order Demand
1 With the work order from which you want to allocate quantities open, point to the work order 

header card and select Allocate Demand to this Work Order from the Edit menu.

2 Click the Insert button to begin adding demand allocation information.

3 From the Type list box, select CO.

4 If you know the customer order ID to which you are allocating quantities, double-click the 
Demand Base ID and select the order. You can leave this field blank.

5 Double-click Seq #/Line # to view a list of customer order lines. If you specified a customer order 
in step 4, the lines for the order that you selected are displayed. The table shows information 
about the part on the order line, the desired ship date of the order line, the current quantities that 
have been allocated, the current shipped quantity, the current fulfilled quantity, the status of the 
line, and the ID of the warehouse from the order line. In the Status column, these codes are used:

A - Inherit

C - Closed

F - Firmed

H - On Hold 

R - Released

X - Cancelled

6 Use the search options in the Options and Sort by sections to filter and sort the results in the 
table, and then click Apply.

All customer order line items that meet your search specifications appear.

7 If any appear, select the appropriate line and click the Ok button.

The customer order line information appears in the Assign to Demand dialog box line item table.

8 In the Allocate Quantity column, enter the quantity of the customer work order that you want to 
allocate to the customer order line item.

The quantity you enter here cannot be greater than the Demand Unallocated Quantity of the 
customer order line item or the Available Quantity of the work order itself.



Allocating Work Order Quantities

Infor VISUAL Inventory User’s Guide | 3 – 111

9 Click Save to commit the allocation of work order supply to customer order line item demand.

Allocating Quantities to Work Order Material Requirement 
Demand
1 With the work order from which you want to allocate quantities open, point to the work order 

header card and select Allocate Demand to this Work Order from the Edit menu.

2 Click the Insert button to begin adding demand allocation information.

3 From the Type list box, select RQ.

4 Double-click Demand Base ID to view a list of work orders to which you can allocate supply.

The Work Orders dialog box appears.

5 Select the appropriate work order that contains a material requirement that matches the current 
work order part, and click the Select/Close button.

6 Double-click Piece # to view the material requirements for the work order you selected.

The Work Order Material Requirements Demand dialog box appears.

The line item table contains the following columns:

Sequence # – The sequence number of the material requirement in the work order to which you 
are allocating demand.

Piece # – The piece number of the material requirement in the work order to which you are 
allocating demand.

Part ID – The ID of the part/material you are allocating.

Description – A description of the above part.

Calculated Quantity – The quantity of the material requirement in the work order.

Allocated Quantity – The quantity of the material requirement to which you have already 
allocated demand. This value less the Calculated Quantity equals the Demand Unallocated 
Quantity.

Fulfilled Quantity – The allocated quantity the supplying source has fulfilled.

Warehouse ID – The default Warehouse ID of the material requirement. This must be the same 
as the work order from which you are allocating demand.

7 Select the material requirement to which you want to allocate current work order supply and click 
the Ok button.

The information appears in the Assign to Demand line item table.

8 In the Allocate Quantity column, enter the quantity of current work order supply that you want to 
allocate to the line of work order material requirement demand.

The quantity you enter here cannot be greater than the Demand Unallocated Quantity of the work 
order material requirement or the Available Quantity of the work order itself.
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9 Click Save to commit the allocation of work order supply to work order material requirement 
demand.

Viewing Work Order Demand Allocation Information
You can view what quantity of a work order you have allocated to demand and what quantity you still 
have available to allocate.

With the work order for which you want to demand allocation information open, point to the work order 
header card and select Allocate Demand to this Work Order from the Edit menu.

The Assign to Demand dialog box appears.

The header section of the dialog box contains the following information:

Work Order ID – The ID of the current work order.

Desired Quantity – The quantity of the work order.

Received Quantity – The quantity of the work order demand assignments you have received.

Allocated Quantity – The quantity of the work order that you have allocated to demand. As the 
Allocated Quantity increases, the Available Quantity decreases.

Fulfilled Quantity – The allocated quantity fulfilled by the work order.

Available Quantity – The quantity still available to you to allocate to demand. As the Allocated 
Quantity increases, the Available Quantity decreases.

All demand links appear in the line item table.
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Importing and Exporting Work Orders and Masters
These functions allow masters and work orders to be written to ASCII text files, and to be read back 
from these files. This feature can be used in the following ways:

• Importing/Exporting from Other Systems – Many other systems output and accept a text file
format. You may be able to output engineering information from another system and reformat the
text in a way that is suitable to be imported into VISUAL.

• Transferring Information Between Databases – You can also use this feature to move
information from one VISUALdatabase to another.

Note: Do not attempt to import data from an exported VISUAL file that you have changed, or from 
another system, without assistance from your Infor Global Solutions Associate or Customer Support. 
There are many issues involved. For example, if you are importing a master with new Part IDs, you 
must also provide for the Part IDs to be loaded into Part Maintenance.

Exporting Work Orders and Masters
Use the Export command to save the Work Order/Engineering Master currently on your screen to a 
file on your computer. The details are saved to the file you assign.

1 Select Export from the Edit menu

The Export dialog box appears.

2 Enter a unique file name with the extension .eng. (This extension is optional.)

3 Select the disk drive and directory into which you want to export the master.

A message appears, indicating that the information is being copied. When it is completed, you are 
returned to the Manufacturing Window details screen.

The information now exists in the file name .eng in the directory you specified in the same format 
used by the clipboard copy/paste functions.

Importing Work Orders and Masters
Use the Import command to bring in (copy details into your current window) a Work Order/
Engineering Master file that has been previously exported.

1 If you are importing information to a work order/engineering master that currently contains details 
(operations and/or materials), position the cursor (focus) on the location where you want the 
information pasted. However, if you are pasting information into a work order/engineering master 
with no details, the focus is unimportant.

2 Select Import from the Edit menu.

The Import dialog box appears
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3 Enter the filename .eng from which you want to copy information into your current detail screen. 
You can choose from the file names that appear in the File name box in the upper corner of the 
window.

4 If you do not specify the correct disk drive, you can change it here. If you saved (exported) the 
information with an extension other than .eng, you must enter the extension, or use *.* to display 
all files in the directory.

5 Select the file to import and click the Open button.

A message appears, informing you that information is being pasted. When it is completed, you 
are returned to the Manufacturing Window details dialog box.

The information from the file is now pasted into your current detail window.

Note: Different versions of VISUAL may support different versions of the clipboard format. This 
file is not intended as a permanent archival method but as an easy method to move large pieces 
of one work order/engineering master to another.
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Finding and Opening Masters and Work Orders
To edit a master, you must first call it into the Manufacturing Window. Use the Open and Search 
commands for this purpose.

1 Select Open from the File menu or click the Open button on the main toolbar.

The Manufacturing Window Search dialog box appears.

2 Select the radio button for Engineering Master, Work Order, or Quote Master.

You must select the proper type. You cannot open an engineering master if you select the Work 
Order button.

3 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which the 
master was created. If you are licensed to use a single site, this field is unavailable. 

4 Click the Base ID browse button to select the master to open. 

You can also create a new master/work order by clicking on the New button.

5 Select the size preferences and display mode here, so you do not need to immediately access the 
View menu after opening.

Select the radio buttons for size preference and display mode. These are the same as the View 
menu functions.

6 Click the Ok button to open the master/work order.

If there is already a master/work order in the Manufacturing Window, it is closed automatically. If 
an edit to an object was in process, you are allowed to confirm this action.

Searching for Sub IDs in the Current Work Order
Masters and work orders can have a number of subassembly legs, each of which represents the 
independent production of a subassembly required by the parent operation.

Rather than trying to locate Subassembly leg IDs by eye in a master or work order that may have 
numerous legs, you can search the current work order for a specific Sub ID by selecting Find Sub ID 
from the Edit menu.

The primary leg is always Sub ID zero.

To find a Sub ID:

1 Select Edit, Legs, Find Sub ID.

The Find Sub ID dialog box appears.

2 Enter the Sub ID of the leg you want to locate.

3 Click Search to execute the search.

If the Leg Sub ID is found, the leg “card” appears at the bottom left of the screen with an arrow 
pointing to it. So the location of the leg Sub ID is obvious, you should only be able to see the leg 
card.
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Now, by scrolling to regain a full screen view, you can see the relation of the subassembly leg to 
the work order or master.

At any point, click Cancel to abandon your search.
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Editing Masters and Work Orders
You can do basic editing using the same windows you used to add the original header, operations, 
materials, and legs. You can modify virtually all information at any time. Exceptions are Base ID, Lot 
ID, Split ID and Sub ID.

There are four methods for editing Manufacturing Windows objects:

• Select the object, and select Edit from the Edit menu
• Select the object, and press CTRL+E
• Double-click the Object
• If the popout menu is active, right-click the object and select Edit from the popout menu.

Any of these methods call up the editor for the object: header, operation, material, or leg/detail. This is 
the original window that you used to create the object. These windows are “non-modal.” After a 
window appears, you do not need to close it to move between objects. For example, if you edit one 
operation, you can leave the Operation window up, and simply select the next operation to work on. 
The window refills with the contents of the new operation.

All three editing windows (header, operation, material/leg detail) can be displayed at once. Only the 
one corresponding to the currently selected object is used at any one time. For example, if both the 
Operation and Material windows are displayed, and you select an operation, the Material window is of 
no use to you.

You can use two functions to renumber items in an Engineering Master or Quote Master. Use the 
Renumber Operations dialog box to renumber the operations in an engineering master. You cannot 
renumber the operations on work orders or quote masters. Use the Renumber Pieces by Part ID to 
renumber material requirements for an operation in ascending order by part ID.

Editing Header Information
1 Click the header card and select Edit from the Edit menu, press CTRL+E, or, if your popout menu 

is active, right-click the header card and select Edit from the popout menu.

The Header Information dialog box appears

2 Modify the appropriate information.

For a master, you can modify any information except Part ID, Base ID and Eng ID. You can also 
modify Picture/Object, G/L Accounts, and Variables.

For a work order, you can modify these fields, and also Part ID, Release Date and Want Date.

3 Click Save to save the changes, or Cancel to abort the changes.

The window automatically closes.
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Defining Coproducts
You can define co-product parts manufactured on this work order. You can define quantities and 
percentage of cost.

1 Click the Coproducts button.

2 Click the Insert button to add a new coproduct.

A new line appears in the line item table.

3 Click the Part ID browse button and select the part ID for the coproduct. If you are licensed to use 
multiple sites, the browse table shows parts that exist in the currently selected site. If you are 
licensed to use a single site, the browse table shows all parts in your database.

4 Enter the percentages and the quantity in the appropriate columns.

5 Choose whether the coproduct is a static quantity or a ratio to header quantity. See the 
“Coproducts” chapter in this guide.

6 Click the Save button to save the new coproduct.

Note: The Assign to Demand button allows you to assign coproduct quantities to demand. 

Deleting Masters and Work Orders
To delete an engineering master, quote master, or work order, the master or work order must meet 
certain criteria:

• Work orders must meet these criteria:
• The work order cannot have inventory, service, labor, or split transactions.
• The work order cannot be linked to demand.
• Work order material requirements cannot be linked to supply. 
• Costing cannot be pending for the work order.
• The work order cannot have a WIP value.

• Quote masters cannot be linked to a quote ID.
• Any engineering master can be deleted. If the engineering master is the default master for a part,

a message is displayed.

1 Open the work order or master.

2 Click the header card once to select it. Do not open the header card.

3 Select Edit, Delete or click the Delete button on the toolbar. 

4 In the message that is displayed, click Yes to confirm the deletion. One of these actions occurs:

• If you are deleting the default engineering master for a part, a message is displayed. Click
Yes to delete the master. 

• If the work order or master cannot be deleted, a message is displayed. Click Ok to exit the
message. The work order or master is not deleted. 



Editing Masters and Work Orders

Infor VISUAL Inventory User’s Guide | 3 – 119

Editing Operations
1 Select the operation you want to edit, then select Edit from the Edit menu. Alternatively, right-click 

the operation and select Edit from the popout menu.

If your current viewing mode has operations hidden, you need to select Show/Hide Operations 
from the View menu so that operations are shown.

2 Edit the appropriate information.

You can edit all of the fields of an operation.

3 Click Save on the Main toolbar to save the changes. Select Close from the File menu to close the 
dialog box without saving the changes.

Deleting Operations
To delete an operation, select it and choose Delete from the Manufacturing Window Edit menu or 
click the Delete button on the Form toolbar.

You are prompted to confirm the deletion. All material requirements and legs that are attached to the 
operation are automatically deleted as well. Start, end, and material quantities are automatically 
recalculated.

Renumbering Operations
The Renumber Master Operations function has these limitations:

• You cannot renumber operations in a work order.
• You cannot renumber operations if the engineering master has an active ECN.
• You cannot specify a blank or duplicate operation number.
• You cannot create a scheduling loop. A message is displayed if you cause a scheduling loop.

1 Open the Engineering Master or Quote Master whose operations you want to renumber.

2 If your master has legs, select a card in the leg to renumber the operations in the leg. To 
renumber operations associated with the header, then select a card linked to the header. If your 
master does not have legs, you can skip this step.  

3 Select Edit, Renumber Master Operations. Operations are listed in a table in their current 
sequence.

4 In the Seq # column, specify the new sequence number for each operation.

5 Click Ok.
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Editing Material Requirements
To edit a material requirement:

1 Open the Material information window.

2 Edit the appropriate information.

3 Click Save on the Main toolbar to save the changes. Select Close from the File menu to close the 
dialog box without saving the changes.

Finding a Material Requirement by Part ID
It may be difficult to locate a material requirement, because the Part ID is usually the information of 
interest. The Find Part ID function allows you to locate material requirements by Part ID.

1 From the Edit menu, select Parts, then Find Part ID.

2 Enter the Part ID you are looking for in the Part ID field.

3 Click the Find Next button.

If the part is found in a requirement, the requirement is automatically selected and placed in the 
home position.

If the part is not found, the message End of Part List Encountered in Search appears.

4 You can continue to search for other instances by reselecting Find Part ID.

The prior search string is retained.

5 Click the Find Next button again to find the next requirement.

You can also use wildcards in the search string to search for any parts with a particular pattern.

You can continue to search for other instances by reselecting Find Part ID. The prior search 
string is retained. Click Search again to find the next requirement.

Finding Material Requirements by Reference Number
If you use reference numbers on your material cards, you can use this reference number to find the 
material requirement card you would like to edit or review.

To search for a material requirement by reference number:

1 Select Edit, Find Requirement by Reference.

2 In the Reference # field, specify the reference ID to find.

3 Click Find Next. If a material requirement has the specified reference number, the material 
requirement is selected. In the Graphic and Text views, an arrow is inserted next to the 
requirement. In the Grid view, the material requirement line is highlighted.

4 Click Find Next again to find the next instance of the reference ID. 
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If the reference number is not found, or if the last instance of the reference ID has been found, 
this message is displayed: “End of referenced requirements encountered.”

Renumbering Piece Numbers
Material requirement piece numbers are assigned sequentially as you add requirements and legs to 
an operation. When a single operation has a large number of materials, you may want to resequence 
the requirements by Part ID. This makes the list more manageable.

You can only perform this operation on a master, because a work order could have references to 
existing piece numbers.

To renumber piece numbers:

1 Select the operation of which you want to renumber the pieces.

2 From the Edit menu, select Parts, then Renumber Pieces by Part ID.

The pieces are renumbered and the display is refreshed.

Mass Replacing Material Requirement Parts
You can change a Part ID for a material requirement by editing the requirement. However, you may 
need to replace many requirements for the same Part ID with a new one.

For example, you may want to make a temporary or permanent substitution on a number of work 
orders or masters. This function allows you to selectively replace Part IDs in multiple requirements 
across multiple master/work orders. It also allows you to concurrently adjust quantity and cost 
information.

If you are licensed to use multiple sites, you can use this function on a site-by-site basis only. You can 
replace material requirement parts for the site ID of the currently selected master.

1 If you are licensed to use multiple sites, open a master created in the site in which you are 
replacing material requirement parts. If you are licensed to use a single site, open any master.

2 Select Parts from the Edit menu, then select Material Req Part Replace by Part Used.

3 Enter or click the Part ID button to select the Part ID of the part that you want to replace.

When you select the part, or when you enter the part and tab from the field, a list of all 
requirements that use the material and are eligible for replacement appear. You can replace a 
requirement if it is used in an engineering master or quote master, or if it is used in a work order 
and no material has been issued to it yet.

The table includes the following columns:

Caution:  This function has the potential to modify a large number of material requirements, 
especially when the Replace All function is used. Be careful when using this function.
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Work Order/Master – Base ID-Sub ID/Eng ID of Quote and Engineering Masters. These are 
preceded by the letter M for engineering master, and Q for quote master.

Base ID-Sub ID/Lot ID of work orders – Identifies the leg containing the requirement.

Seq # – Sequence number of the operation containing the requirement.

Piece # – Piece number of the requirement.

You can selectively check the Work Order, Eng Masters, and Quote Masters boxes to display only 
certain types of master/work orders.

4 Enter the Part ID of the part you want to substitute. Click the New Part ID button to browse the 
PART table.

This part is used to replace every requirement you select.

5 Modify any of the following requirement fields: Quantity Per, Scrap%, Fixed Quantity, and 
Dimensions.

This makes it possible to adjust quantity or scrap% because of the substitution.

6 Click the Reset Costs check box to reset costs. You can also choose to bring the standard 
material costs for the new Part ID into the replaced requirements.

If you need estimates to be accurate, check this box. If you want the difference in cost between 
the old and new material to show up as a costing variance, then clear the box. Estimates are at 
the old cost, but actuals at the new.

7 Select the lines you want to replace.

8 Click the Replace Selected button to replace only the selected lines, or Replace All to replace 
requirements for all lines showing in the table.

Deleting Material Requirements
To delete a material requirement, select it then select Delete from the Edit menu or click the Delete 
button on the Form toolbar. You are prompted to confirm the deletion. Start, end, and material 
quantities are recalculated automatically after the deletion.

Mass Deleting Material Requirements

You can delete multiple material requirements in a method similar to for replacement.

Caution:  This command has the potential to delete a large number of material requirements 
from many masters and work orders, especially if you use the Delete All command. 
You cannot recover this information except through your own backups. Be careful 
when using this command.
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If you are licensed to use multiple sites, you can use this function on a site-by-site basis only. You can 
delete material requirement parts for the site ID of the currently selected master.

To perform a mass delete:

1 If you are licensed to use multiple sites, open a master created in the site in which you are 
replacing material requirement parts. If you are licensed to use a single site, open any master.

2 Select Parts from the Edit menu, then select Material Req Delete by Part Used under Parts.

3 Enter a Part ID or click the Part ID button to select the part with requirements you want to delete.

When you select the part, or when you enter the part and tab from the field, a list of all 
requirements that use the material and are eligible for deletion appear. You can delete a 
requirement if it is used in an engineering master or quote master, or if it is used in a work order 
and no material has been issued to it yet.

The Material Requirement Delete by Part Used Table includes the following columns:

Work Order/Master – Base ID-Sub ID/Eng ID of Quote and Engineering Masters. These are 
preceded by the letter M for engineering master, and Q for quote master.

Base ID-Sub ID/Lot ID of work orders – Identifies the leg containing the requirement.

Seq # – Sequence number of the operation containing the requirement.

Piece # – Piece number of the requirement.

You can selectively check the Work Order, Eng Masters, and Quote Masters boxes to display only 
certain types of master/work orders.

4 Select the lines to delete from the table.

5 Click the Delete Selected button to delete only the selected lines, or Delete All to delete 
requirements for all lines showing in the table.

Editing Legs
To edit a leg/detail:

1 Open the Material information dialog box for the leg.

2 Make any necessary changes.

You can change any of the information in a leg, with the exception of Piece Number and Sub ID.

3 Click Save on the main toolbar to save the changes.

Deleting Legs
To delete a leg, select its header, then select Delete from the Manufacturing Window Edit menu or 
click the Delete button on the Form toolbar.

You are prompted to confirm the deletion.
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All subordinate operations and material requirements are deleted along with the leg. Start, end, and 
material quantities are automatically recalculated after the deletion.
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Recalculating Quantities
Start and End Quantity are automatically calculated for each operation, as well as each required 
material quantity. Because calculation must begin with the final operation and work backwards, this 
operation may sometimes take more than a few seconds.

Because of this, recalculations are not made every time you change a quantity. Instead, 
recalculations are made when necessary. When this happens, you are informed that recalculation is 
occurring, and the progress is displayed. Sometimes, you are prompted for confirmation before this 
takes place.

You may also need to force a recalculation. For example, if you are adjusting Start and End Quantity 
for an operation, you may first want to see what the calculated quantities are.

To force a recalculation, select Recalculate Quantities from the Edit menu or click the Recalculate 
Quantities button on the Form toolbar.

When the quantities are current, a check mark is placed next to this option. If you see the check mark, 
it is unnecessary to recalculate.
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Resetting Costs from Standards
As you add operations and materials to a master/work order, the standard costs for resources and 
materials are loaded from the shop resource masters, service masters, and part masters. 
Occasionally, you may override these values. Additionally, standards change on some periodic basis.

If you are licensed to use multiple sites, these standard costs are defined on a site-by-site basis.

The Reset Costs from Standards command allows you to refresh all of the standard cost information 
from the original masters. If you are licensed to use multiple sites, the site-specific standard costs you 
defined are used to update the costs in the master.

To reset costs from standards:

1 Select Reset Costs from Standards from the Edit menu or click the Reset Costs from Standard 
button on the Form toolbar.

This dialog box allows you to select which combination of the three standards (operation, service, 
material) you want to reset. The default is to reset all costs.

2 Select the check boxes for the standards you want to reset.

3 Click Ok to perform the update.

All selected costs are updated. Note that non-inventory parts are not updated, as there is no 
corresponding part master.

Note: The maintenance applications have functions of their own that allow you to “push” the new 
values into multiple masters/work orders, rather than “pull” them from this side. Part Maintenance 
provides Reset Material Requirement Costs. Shop Resource Maintenance and Service 
Maintenance provide Reset Operation Costs.
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Assigning Parts to Warehouses
Use the Assign Parts to Warehouse feature to add parts to warehouse locations directly from the 
Manufacturing Window. 

You can only add fabricated parts along with any material requirements on the engineering master.

If you have selected the Create New Location and Assign to Part option in Site Maintenance, you can 
add locations to your warehouse during this procedure. If you have selected the Assign Existing 
Location to Part option or the Not Allowed option, you can only add parts to existing warehouse 
locations.

If you are licensed to use multiple sites, you can assign parts to warehouses on a site-by-site basis 
only. 

To add parts to your warehouse: 

1 If you are licensed to use multiple sites, select a master that belongs to the site where you are 
adding parts. If you are licensed to use a single site, open any master.

2 Select Edit, Assign Parts to Warehouse. 

3 Specify the following information:

Part ID – Click the Part ID button and select the part you would like to assign to the warehouse. 
Select a fabricated part; you cannot add a non-fabricated part.

Part Eng ID – Click the Part Eng ID arrow and select the engineering ID of the master you want 
to use.

Warehouse ID – The system inserts the project Warehouse ID from the header card. 

Location ID – Click the Location ID button and select the location within the warehouse where 
you want to store the part.

If you have allowed part locations to be created on the fly, you can specify a new location ID in the 
field. The system will add the new location to the selected warehouse when you click Save.

Status – Select a status option for the part. If you specify On Hold, specify a Hold Reason ID in 
the Hold Reason ID field.

Description– If you are creating a new warehouse location, enter a description for the location in 
the Description field.

Engineering Master Material Requirement – Select the Include Engineering Master Material 
Requirements check box to add the parts from the material requirements on the fabricated part's 
Engineering Master to the warehouse location as well. 

Include Co-Products – If you selected a fabricated part, select the Include Co-Products check 
box to add the co-products specified on the fabricated part's engineering master to the warehouse 
location as well. 

4 Click Save. If you specified a new location in the Location ID field, and you have allowed the 
creation of part locations on the fly, the system asks you if you want to create the location. Click 
Yes to continue, or No to return to the Assign Parts to Warehouse dialog box.

If you have not allowed the creation of part locations on the fly, you must select an existing 
location ID for the system to save the information.
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The system adds the part ID you specified to the warehouse location. If you selected the Include 
Engineering Master Material Requirements check box or the Include Co-Products check box, the 
system adds the appropriate parts to the warehouse location.

5 Click Close to exit the dialog box.
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Splitting Work Orders
You can split work orders if you want to speed the production of a specific quantity of an order for 
delivery. You should think of the original work order as the parent work order and the split work order 
as the child. A parent work order may have many child work orders.

When you split a work order, Operation, Material and Service costs are prorated for operations 
sequentially numbered before the split according to the ratio of the Split Quantity to the original 
Desired Quantity. It is important to remember that with ending quantity scrap is taken into 
consideration through all of the operations. When you split a work order, the split amount must also 
reflect the same assumed scrap quantities.

For example, you may have a desired quantity of 1000 for a work order. Because each of the three 
operations generates 10% scrap, a quantity of 1372 is planned.

Costs that you incur for sequentially numbered operations after the split reside solely on the parent 
work order or child work order respectively. You must pay special attention to materials and services 
that are linked to Purchase Orders. Parent and Child work orders share costs by assigning portions of 
the Purchase Order to the splits.

Split Work Order numbering conventions:

You can identify a split work order by the decimal point in the Lot ID.

• 40001 / 1 is Work Order ID 40001 - Lot ID = 1 Split ID = 0 = A Parent Work Order
• 4001 / 1. is Work Order ID 40001 - Lot ID =1 Split ID = 1 =A Child Work Order

The full work order number takes the form:

Base ID - Sub ID / Lot ID . Split ID (Operation Sequence Number)

For example:

• Operation 40 of Sub ID 3 of Work Order 40009 Lot 2 Split 1 appears abbreviated as: 40009-3 / 2.1
(40)

• When Sub ID and Split ID are zero, the SUB ID and Split ID are omitted from the abbreviation,
therefore, Operation 40 of the Sub ID of Work Order 40009 Lot 2 Split 0 appears abbreviated as:
4009 / 2 (40)

If you are licensed to use multiple sites, you can split work orders within the same site only. The 
“child” split work orders are created in the same site as the “parent” work order.

1 To access the Split Work Order dialog box, select Split Work Order from the Edit menu.

The point in the work order (the Split ID and Sub ID) at which you want to split the work order 
appears in the read-only fields at the top of the dialog box.

2 Enter a new Split ID into the New Split ID field.

3 Enter the split quantity for the order in the Split quantity for order field.

4 Enter the split quantity for the operation in the Split quantity for operation field.

Note: The split quantity for the order must be greater than zero and less than the order quantity.

5 Select a Release Date and Want Date. Use the calendar button or manually enter a date.

6 Select the items to copy to the split work order:
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Copy All Document References – Select this option to copy all document references from the 
original work order to the split work order.

Copy All Reference Designators – Select this option to copy reference designators from the 
material cards.

Copy Alternate Parts – Select this option to copy the alternate parts from the material cards.

7 Click Ok to split the work order.
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Viewing Master/Work Order Information
The Info menu provides viewing options for every aspect of the estimated and actual production of a 
work order. Informational displays range from total work order summaries to lists of every individual 
source document for the work order.

Viewing Cost Information
You can view complete summary and detailed cost information for the current work order. You can 
view this information in a table and as a graph.

To view costs, select Info, Costs.

In both the table and the graph, these types of costs are displayed:

Estimated – Estimated cost is based on the quantities and costs shown in each operation and 
material requirement. This is the only cost shown for a master.

Actual – The costs used for actual costs depend on your costing method. 

If you use the standard costing method, then the actual costs for a material requirement is calculated 
by multiplying the costs defined for the material in Part Maintenance by the quantity of part issued to 
the work order. Labor costs are calculated based on the time recorded on the labor tickets and the 
shop resource standards on the operation. 

If you use the actual costing method, then the actual costs from linked purchase orders or from the 
FIFO layer is used for material requirement costs. The actual time spent on an operation is multiplied 
by the employee’s labor rate to calculate labor costs. 

If you use the average costing method, then the average cost of each material requirement based on 
your current inventory is used.The actual time spent on an operation is multiplied by the employee’s 
labor rate to calculate labor costs. 

Variance – The variance is calculated by subtracting the actual cost from the estimated cost. 

Projected – Projected cost is equal to the actual cost of the completed work or issued materials, plus 
the remainder of the work at estimated cost.

Viewing Costs in a Table
When you access the Costs dialog, a table shows the costs for the order. One line is displayed for 
each object in the work order. The lines are arranged in the same order as the work order: the header 
card is displayed first, operations attached to the header are nested under the header, materials 
attached to operations are nested under the operation, and so on. You can expand and collapse 
nested objects in the work order. For example, collapse all operations and materials and view only the 
header.

Costs from subordinate objects are totaled into the next level. For example, material requirement 
costs contribute to costs for their operations. The header card line shows totals for the entire work 
order. 
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For material requirements and legs, the calculated quantity required is displayed. For operations, the 
End Quantity out of the operation is displayed. For the entire work order, the Desired Quantity is 
displayed.

Actual cost fields are blank unless some cost has been accumulated against the line.

Viewing Cost Details in the Costs Table
You can view details for estimated costs, actual costs, variance costs, projected costs, and labor 
hours. When you view details for estimated, actual, and variance costs, the material, labor, service, 
and burden costs that make up the total in of each cost category are displayed. When you view 
details for labor hours, the number of setup hours and run hours are displayed. 

To display cost details, select the appropriate option from the View menu.

Specifying Color Preferences in the Costs Table
To help you identify costs in the table, you can set up color preferences for each type of cost. You can 
also specify a color preference to use in conjunction with the search feature.

The colors you specify are used with all masters. 

To specify color preferences:

1 In the Costs table, select Options, Preferences.

2 Specify this information:

Estimated Columns – Click the browse button and select the color to use for columns that show 
estimated costs.

Actual Columns – Click the browse button and select the color to use for columns that show 
actual costs.

Variance Columns – Click the browse button and select the color to use for columns that show 
cost variances.

Projected Columns – Click the browse button and select the color to use for columns that show 
projected costs.

Found Rows – Click the browse button and select the color to use to highlight rows that match 
your search criteria.

3 Click Ok. 

Finding Information in the Costs Table
Use the Find feature to locate cost rows that match criteria that you specify. You can search the costs 
table for part IDs, resource IDs, sub IDs, and descriptions. Your search term can contain any 
alphanumeric character. When you run the search, any instance of your search term is located, 
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whether the term is found at the beginning of an ID or description or within an ID or description. 
Search terms are case-insensitive. For example, if you specified LAT in the Description column, then 
your search would locate instances of 1/4 PLATE and Wood Lathe.

After you run a search, you can use the Find Next and Find Previous buttons to navigate among your 
search results. You can also use the Up key and the Down key to navigate among your search 
results. If you specified a color for Found Rows in the Preferences dialog, then all rows that match 
your search criteria are highlighted with the color you specified. 

To run a search, the table must be expanded to show all lines in the table. The Find feature is not 
available until all lines are expanded.

To run a search:

1 In the costs table, click any Plus icons to expand all lines.

2 Click Find. A row is added at the top of the table. The row contains columns for Part ID, Resource 
ID, Sub ID, and Description. 

3 Specify your search criteria. If you specify criteria in more than one column, then a cost row must 
match all criteria you specify to be included in the search result. Specify this information:

Part ID – To search for part IDs, specify the search criteria to use in this column. Any header card, 
material card, and leg card lines that match your criteria are included in the search result. 

Resource ID – To search for resource IDs, specify the search criteria to use in this column. Any 
operation card lines that match your criteria are included in the search result.

Sub ID – To search for sub IDs, specify the search criteria to use in this column. Any operation 
card lines that match your criteria are included in the search result.

Description – To search for part and resource descriptions, specify the search criteria to use in 
this column. Any header, leg, operation, and material lines that match your criteria are included in 
the search result. 

4 Click Find. The first line in the table that matches your criteria is selected. If you specified a color 
preference for found rows in the Options dialog, then the lines that match your criteria are 
highlighted in the color you specified. If no lines in the table match your criteria, then this message 
is displayed: No matches were found. 

Note: If you did not set up a found rows color preference before you ran your search, you can set 
up the preference after you run the search. Select Options, Preferences... and select the color to 
use for Found Rows. After you exit the preferences dialog, the rows that match your search 
criteria are highlighted with the color you select. You do not need to rerun your search. 

5 To find the next line that matches your criteria, click Find Next or press the Down Arrow key. 

To find the previous line that matches your criteria, click Find Previous or press the Up Arrow 
key.

After the last line that matches your criteria is located, this message is displayed: No more 
matches were found.

To clear the search criteria, click Reset. 
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Exporting Information from the Costs Table
You can export information from the costs table. You can generate a report, you can export the 
information to Microsoft Excel, and you can export the information as an XML file. You can perform 
these functions from the table view only.

When you generate a report, only the quantity, total estimated costs, total actual costs, total variance, 
and total projected costs for each line in the costs table are displayed. Detail information and labor 
hour information is not displayed in the report. 

To generate the report, select the report output and click Print. 

To export the information in the table to Microsoft Excel, click Send to Microsoft Excel. All 
information shown in the costs table is exported to an Excel file.

To export to an XML file:

1 Select File, Send to XML. 

2 Specify this information:

File Name – Specify the name of the exported file.

XML to Write – Specify the type of XML to export. Click one of these options:

Schema – Click this option to export the XML schema. The schema is a list of elements, 
attributes, and data types. The document shows the structure of the information, but does not 
include any of the information in the Costs dialog. A schema has a DTD extension.

Document – Click this option to export the data in the Costs dialog in an XML file. 

Both – Click this option to export both the Schema and the Document. 

Tags – Specify how to construct the tags for elements. To use the names of the columns as 
displayed in the Costs table, click Columns. To use the names of the database columns, click 
Use Item Name. 

3 Click Export. 

Viewing Costs as a Graph
You can view work order costs as a bar graph. When you view costs as a bar graph, you can gauge 
the work order’s profitability at-a-glance. You can view summary information or detailed information in 
the graph.

To view costs as a bar graph:

1 In the Costs dialog, select View, Production Order Status. 

2 Select the graph to view:

• To view the summary graph, select View, Detail until the check mark next to the menu item is
cleared.   The summary graph shows total estimated, actual, and projected costs. 

• To view the detail graph, select View, Detail until a check mark is placed next to the menu
item. The detail graph shows the estimated, actual, and projected costs for each cost source.
The X-axis shows separate buckets for Material, Labor, Burden, Service, and Total costs. You
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can use the detail graph to analyze which cost sources contribute the most to your overall
work order costs. You can also analyze which cost sources are most consistent with their
estimated costs. 

Both graphs show the sell price of the finished good. For work orders linked to sales orders, the 
extension price on the linked sales order line is used as the sell price. For unlinked quantities, the 
selling unit price multiplied by the unlinked quantity is used. 

Viewing Status Information
The Status window provides a tabular format for viewing schedule, status, and completion information 
for the current work order. You can also view basic information for a master.

To view status information, select Status from the Info menu or click the Status button on the Form 
toolbar. The Status window may take a few moments to appear, because every labor ticket source 
document must be accessed for each operation.

A line is shown for the work order header, and for each leg and operation. The following information 
appears for each:

Start – Scheduled Start Date from the production schedule. Does not apply to service operations.

Finish – Scheduled Finish Date from the production schedule.

Est Setup Hours – Estimated Setup Hours as specified in the operation.

Act Setup Hours – Actual Setup Hours reported through Labor Ticket Entry.

Est Run Hours – Calculated Estimated Run Hours as specified in the operation.

Act Run Hours – Actual Run Hours reported through Labor Ticket Entry.

Variance – (Estimated Setup + Estimated Run) - (Actual Setup + Actual Run). Positive variance is 
shown in blue, negative in red.

% Var – 100 x (Actual Setup + Actual Run) / (Estimated Setup + Estimated Run). This shows the 
actual hours as a percentage of the estimated hours.

Transit Days – Transit days, for service operations only.

Est Qty In – Calculated Start Quantity for the operation, as explained in the “Concepts” section at the 
beginning of this chapter.

Est Qty Out – Calculated End Quantity for the operation.

Act Qty In – Total of Quantity Completed and Quantity Deviated reported through Labor Ticket Entry. 
These total to the incoming quantity for this operation.

Scrap Qty – The amount of scrap lost during the operation.

Act Qty Out – Actual Quantity Completed as reported through Labor Ticket Entry.

%Yield – 100 x (Actual Quantity Out/Actual Quantity In), providing yield for the operation as a 
percentage of the incoming quantity.

Available Qty – The quantity currently available.
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You can show and hide leg details by double-clicking on the line for the leg.

Exiting the Status Window
To exit the Status window, select the Exit! menu selection.

Printing Status Window Information
To print the information in the Status window, select the Print menu option. The standard print dialog 
box appears.

Viewing Labor Ticket Information
To view labor tickets reported against the current work order, select Info, Labor Tickets or click the 
Labor Tickets button on the Form toolbar.

The Labor Tickets window appears. The window shows all fields of every labor ticket associated with 
the work order.

Labor tickets are the source of all actual reported setup and run hours, as well as completed and 
deviated quantities. 

You can view labor tickets in Date Sequence or Operation Sequence by selecting the appropriate 
option from the View menu.

To view labor tickets that are currently in process, select the Show In-Process Tickets Only check 
box. 

Viewing Material Issue Information
To view all inventory Issue and Issue/Return transactions executed against requirements of the 
current work order, select Material Issues from the Info menu or click the Material Issues button on 
the Form toolbar.

The Material Issues window shows all fields of every Issue and Issue/Return transaction associated 
with the work order. Inventory Transactions are the source of all actual material issue quantity and 
cost data for the work order. 

Material Issues also shows Receipt transactions of finished goods from this work order, and Receipt/
Returns back to WIP.

You can view inventory issue transactions in Date Sequence or Material Sequence by selecting the 
desired option from the View menu. Material Sequence orders the transactions by Sub ID, Operation 
Sequence Number, and Piece Number of the requirement.
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Exiting the Material Issues Window
To exit the Material Issues window, select the Exit! menu selection.

Viewing Service Dispatches and Receipts
Note: An outside service must be dispatched in Purchase Order Entry before it is displayed in this 
table. Undispatched outside services are not displayed in this table. For more information, refer to the 
“Purchase Order Entry” chapter in the Purchasing guide.

You can view records of all outside services that you dispatch via a linked purchase order from the 
Manufacturing Window in the Work Order Service Dispatch and Receipts line item table.

From the Info menu, select Services Dispatches and Receipts to view all outside dispatched 
services and receipts for the current work order.

The Work Order Service Dispatches and Receipts dialog box appears.

When you click View you can see that the table is currently displaying “All services for the current 
work order.”

Click the Exit button to close the Work Order Service Dispatches and Receipts dialog box.

Viewing Work Order Receipts
Use the Work Order Receipts dialog to view the receipt transactions made against the work order. 
Both receipts and receipt returns are displayed. If a work order has co-products, then receipt 
transactions for co-products are also displayed.

To view work order receipts:

Select Info, Work Order Receipts. For each transaction, this information is displayed:

Transaction ID – The ID of the inventory transaction is displayed.

Description – The description of the inventory transaction is displayed.

Split ID – If the work order is a split work order, the split ID is displayed.

Sub ID – The sub ID of the work order is displayed.

Site ID – The site ID associated with the work order is displayed.

Part ID – The ID of the part received is displayed.

Transaction Type – The type of inventory transaction is displayed.

Class – The class of the inventory transaction is displayed.

Quantity – The quantity received or returned is displayed.

Transaction Date – The date of the transaction is displayed.
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Customer Order – If the transaction is associated with a customer shipment or return, the ID of the 
customer order is displayed.

Cust Order Line – If the transaction is associated with a customer shipment or return, the line of the 
customer order allocated to the work order.

Warehouse ID – The ID of the warehouse that received the quantity or returned the quantity is 
displayed.

Location – The location in the warehouse that received the quantity or returned the quantity is 
displayed. 

Viewing Splits
To view a list of work orders that have been split from and to the current work order, select Splits 
from the Info menu.

The Splits dialog box appears displaying split costs to and from the current work order.

Click the Exit button to close the Splits dialog box.

Viewing the Sales Lifecycle
If the current work order is linked to a customer order, you can view the sales lifecycle for the order. 
Select Info, Sales Lifecycle....

See "Viewing Document Lifecycles" on page 8–2 in the Concepts and Common Features guide.

Viewing the Purchasing Lifecycle
If the current work order is linked to a purchase order, you can view the purchasing lifecycle for the 
order. Select Info, Purchasing Lifecycle....

See "Viewing Document Lifecycles" on page 8–2 in the Concepts and Common Features guide.

Viewing Alternate Parts
To view a list of alternate parts for the material requirements in the master, select Info, Alternate 
Parts. The system displays a list of alternate parts for the currently selected object and any child 
objects. For example, if you select the header card, the system displays alternate part information for 
all material requirements in the master. If you select an operation, the system displays alternate part 
information for any material requirements associated with the operation.
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Viewing Material Availability Information
The Material Availability option provides complete access to the material planning system in the 
context of the current work order. Rather than using Material Planning Window and Purchase Order 
Entry independently, you can let Manufacturing Window start and manage those windows for you.

The Material Availability window allows you to examine the availability of all inventory parts required 
on the master/work order, and the potential impact of each requirement on inventory levels for that 
part. Additionally, you can view requirements and purchase order links for all parts, inventory or non-
inventory. Finally, you can place purchase orders from this window.

To view material availability information, select Material Availability from the Info menu or click the 
Material Availability button on the Form toolbar.

The Material Availability window appears, with one line for each requirement in the current master/
work order.

The following information appears for each:

Trace – By default, the Trace check box is selected for all trace parts.

Note: You can also view the Trace details in the Inventory Trace Details window by selecting 
Trace Details option from right-click menu.

Detail – Operation Number, Piece Number, Part ID, and Description of the material requirement. If 
the part is a non-inventory part, then the Specification from the material requirement is shown instead 
of the Part ID.

Part ID – The ID of the required part.

Stock UM – The unit of measure used to stock the part.

Subord Sub ID – The sub ID of the leg header. 

Seq # – The operation sequence number.

Pc # – The material piece number.

Quantity Required – The required quantity of the material for the operation.

Quantity Issued – The quantity that you have issued to the material requirement thus far.

Unit Cost – The cost of per unit of the material as specified on the material card.

Fixed Cost – The fixed cost charged for the part as specified on the material card.

Vendor Part ID – The ID the vendor uses for the part.

Required Date – The date the material must be available for the operation, as determined by the 
Concurrent Scheduler. If the work order has not been scheduled, or this is a master, this field reads 
Not Sched.

Projected Available (After Ship) – This column displays the total quantity remaining in 
warehouse locations with a status of Available after the part is issued to all work orders where it is 
required. The supply calculation depends upon whether a warehouse ID is displayed in the 
Warehouse ID column and the value specified for the UseUniversalForMaterialAvailability 
preference:
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• If an independently planned warehouse is displayed in the Warehouse ID field, then this
column shows the quantity remaining in available locations in the specified warehouse only. 

• If a universally planned warehouse is displayed in the Warehouse ID field and you specified Y
for the UseUniversalForMaterialAvailability preference, then this column shows the total
quantity remaining in all universal warehouse locations with a status of Available. If you are
using multiple sites, the quantity shown is for the site specified in the order header only. 

• If a universally planned warehouse is displayed in the Warehouse ID field and you specified N
for the UseUniversalForMaterialAvailability preference, then this column shows the quantity
stored in available locations for the specified warehouse.

• If you did not specify a warehouse on the line, then this column shows the total quantity
remaining in all universal warehouse locations with a status of Available. If you are using
multiple sites, the quantity shown is for the site specified in the order header only.

Warehouse – The Warehouse ID of the material requirement.

On Hand – This column shows the quantity currently stored in warehouse locations with any 
status. 

The calculation depends upon whether a warehouse ID is displayed in the Warehouse ID column 
and the value specified for the UseUniversalForMaterialAvailability preference:

• If an independently planned warehouse is displayed in the Warehouse ID field, then this
column shows the current quantity in all locations in the specified warehouse only. 

• If a universally planned warehouse is displayed in the Warehouse ID field and you specified Y
for the UseUniversalForMaterialAvailability preference, then this column shows the current
quantity in all universal warehouse locations. If you are using multiple sites, the quantity
shown is for the site specified in the order header only.

• If a universally planned warehouse is displayed in the Warehouse ID field and you specified N
for the UseUniversalForMaterialAvailability preference, then this column shows the current
quantity in all locations in the specified warehouse only.

• If you did not specify a warehouse on the line, then this column shows the current quantity in
all universal warehouse locations. If you are using multiple sites, the quantity shown is for the
site specified in the order header only.

Available – This column shows the quantity currently stored in warehouse locations with the 
Available status. 

The calculation depends upon whether a warehouse ID is displayed in the Warehouse ID column 
and the value specified for the UseUniversalForMaterialAvailability preference:

• If an independently planned warehouse is displayed in the Warehouse ID field, then this
column shows the current quantity in available locations in the specified warehouse only. 

• If a universally planned warehouse is displayed in the Warehouse ID field and you specified Y
for the UseUniversalForMaterialAvailability preference, then this column shows the current
quantity in all universal warehouse locations with the status of Available. If you are using
multiple sites, the quantity shown is for the site specified in the order header only.

• If a universally planned warehouse is displayed in the Warehouse ID field and you specified N
for the UseUniversalForMaterialAvailability preference, then this column shows the current
quantity in available locations in the specified warehouse only.
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If you did not specify a warehouse on the line, then this column shows the current quantity in all 
universal warehouse locations with the status of Available. If you are using multiple sites, the quantity 
shown is for the site specified in the order header only.

Dimensional Info – If this is a piece-tracked part, the number and dimensions of the piece.

# Pieces – The quantity of material required per unit. 

Dimension UM – If this is a piece-tracked part, then unit used to measure the part’s dimensions.

Vendor – The ID of the preferred vendor.

Purchase Order – If material has been purchased directly to this requirement, then a purchase order 
number appears.

Status – The status of the purchase order.

Desired Recv Date – The date that the you want to receive the purchase order.

Promise Delivery Date – The date that the vendor promised to deliver the parts.

Qty Ordered – The quantity orders on the purchase order.

Potential PO Supply Orders – The total quantity on order that could meet demand. 

To calculate the quantity, firmed and released purchase orders for eligible warehouses are identified. 
This table shows the purchase orders that are used depending on the warehouse that is specified on 
the Material card: 

Material requirement warehouse type Purchase Orders

Independently planned Only purchase orders for the independently 
planned warehouse are considered. 

Universally planned

The purchase orders that are included 
depend upon the value that is specified for 
the UseUniversalForMaterialAvaillability 
entry in the Visual Mfg section of 
Preferences Maintenance:
 If the 

UseUniversalForMaterialAvailability 
entry is false or not specified, then only 
purchase orders for the warehouse that 
is specified on the requirement are 
included in the calculation.

 If the 
UseUniversalForMaterialAvailability 
entry is true, then purchase orders for all 
universally planned warehouses are 
included in the calculation. Purchase 
orders with no warehouse are also 
included. 
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Received or allocated quantities on eligible purchase orders are subtracted from the total quantity that 
has been ordered or fulfilled. Purchase order lines with negative quantities are not included in the 
calculation. The result is displayed in the Potential PO Supply Orders column. 

Link Quantity Allocated – The portion of this material’s Quantity Required that you have allocated 
through the establishment of supply links to the requirement or demand links from the requirement. 
See the earlier section on allocating supply quantities to material requirement demand earlier in this 
chapter.

Link Quantity Received – The portion of a linked quantity that you have received. For example, if 
there is a purchase order link to a material requirement, after you receive that purchase order, the 
portion of the P/O Order Quantity that you allocated appears here.

Required Quantity Allocated – The portion of the material requirement’s Required Quantity that 
you have accounted for through the use of allocations.

Required Quantity Fulfilled – The portion of the material requirement’s Required Quantity that has 
been fulfilled through the use allocations.

Safety Stock – Extra amount of a part that you plan to keep in excess of real demand to cover 
fluctuations in demand caused by unplanned orders, scrap, or other events.

Minimum Order Qty – The minimum amount of the part you can order.

Multiples of – The multiple of part you can order. For example, if this value is 5, then you can order 
the part in multiples of 5.

Stocked – If this part is stored in your inventory, then Y is displayed. If you do not stock this part in 
your inventory, then N is displayed.

You can sort the table by these columns:

• Detail
• Part
• Projected Available
• On Hand
• Available
• Vendor
• Purchase Order
• Status
• Desired Recv Date

If you perform an action that affects material availability, such as creating a purchase order or 
updating and recalculating material quantities, you can click the Refresh button on the Manufacturing 
Window toolbar to refresh the information in the Material Availability dialog. 

Warehouse not specified

Purchase orders for all universally planned 
warehouses and purchase orders with no 
warehouses are included in the calculation. 
Purchase orders for independently planned 
warehouses are not included.

Material requirement warehouse type Purchase Orders
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Setting the UseUniversalForMaterialAvailability Preference
Use Preferences Maintenance to specify how to calculate quantities in the Material Availability dialog 
when a universally planned warehouse is specified as the supplying warehouse. 

To set the preference:

1 Select Admin, Preferences Maintenance.

2 Click the Insert button.

3 Specify this information:

Section – Specify Visual Mfg.

Entry – Specify UseUniversalForMaterialAvailability.

Value – To display the quantities for all universally planned warehouses when a universally 
planned warehouse is specified as the supply, specify Y. To display the quantities in the specified 
universally planned warehouse only, specify N. 

4 Click Save. 

Viewing Purchase Order Links
You can see more information on linked purchase orders from the Material Availability window. To do 
this:

1 Select a line in the Material Availability window, then select Purchase Order Links from the View 
menu.

The table shows each separate PO link for the requirement. The following information appears in 
the window:

Specification – The Specification from the Material window for the requirement. This is NOT the 
specification for the Part ID or Purchase Order.

Total Required – The Quantity Required from the Material Availability window.

Total Issued – Quantity Issued from the Material Availability window.

Total Ordered – Total of all purchase order line item order quantities.

Total Received – Total quantity so far received against all linked purchase order lines.

Stock U/M – Stock keeping unit of measure. All of the above quantities appear in this unit.

The table contains one line for each purchase order line linked to the selected requirement. Most 
of the important information from the PO line is shown:

Order ID, Line # – The Our Order ID and line number from the purchase order.

Vendor ID – Vendor that the purchase order is to.

Vendor Part ID – Vendor’s catalog number, if any.

Order Quantity – Quantity from the PO line item.
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Recv Quantity – Quantity so far received for this line item.

Status – The status of the purchase order.

Purchase U/M – Line item unit of measure, which may be different from the Stock U/M. All line 
item quantities are shown in terms of this unit of measure.

P/O Allocated Quantity – The portion of the P/O Order Quantity that you have allocated to the 
material requirement.

Link Allocated Quantity – The portion of this material’s Quantity Required that you have 
allocated from this purchase order.

Link Received Quantity – The portion of this material requirement’s allocated quantity that you 
have received from this purchase order.

2 If you need to view further information, or edit the purchase order, double-click the Order ID 
column.

Purchase Order Entry starts, with the selected PO loaded. You can view all order information, 
including specifications and notes. Depending upon your privilege settings, you may also be able 
to edit the order.

When you are finished viewing and editing the purchase order information, you can exit Purchase 
Order Entry, or simply move back to the Purchase Order Links dialog box. If you leave Purchase 
Order Entry open, you do not need to restart it the next time you use it.

3 Click the Close button to close the Purchase Order Links dialog box.

Purchasing One Material
You can place a purchase order for a material directly from the Material Availability window by 
selecting a line and choosing Purchase One Material from the Edit menu.

If you are licensed to use multiple sites, the purchase order is created in the site specified on the 
header card of the work order.

Purchasing Multiple Materials
To purchase more than one material at the same time:

1 Select each line and choose Purchase All Selected Lines from the Edit menu in the Material 
Availability window.

Purchase Order Entry opens.

All materials are placed on one purchase order, so you must choose materials that you have 
purchased from the same vendor. Vendor ID defaults to the first Preferred Vendor ID found. For 
example, if the first part does not have a preferred vendor, but the second one does, that Vendor 
ID is used. You can set the Preferred Vendor ID in Part Maintenance. The Purchase Order Date 
defaults to the current date.
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Each line quantity for a part defaults to the balance required to meet the requirement, and the 
Recv Date defaults to the Required Date for the material requirement. Each line is linked to the 
work order requirement.

2 Modify any of the information in Purchase Order Entry.

3 Click the Save button to create the purchase order.

You can exit Purchase Order Entry, or simply return to the Material Availability screen.

Printing Material Availability
To print the contents of the Material Availability dialog, click the Print button. The standard printer 
dialog box appears. Enter the appropriate information and click Ok to print.

Exporting Material Availability Information to Microsoft Excel
You can send the contents of the Material Availability dialog to Microsoft Excel. Select the rows that 
you want to send, and then select File, Send to Microsoft Excel.

Exiting Material Availability
To close the Material Availability window, click the Exit button.

Material Netting
Material Netting provides direct access to the Material Planning Window for material netting.

If you are licensed to use multiple sites, you can net material on a site-by-site basis only. Materials 
are netted in the site specified on the header card of the work order.

You can access Material Netting in three ways from the Manufacturing Window:

• Select the material requirement from the Manufacturing Window and choose Net This Material
from the Info menu.

• Select Net This Material from the Info menu of the Material window while editing the material
requirement.

• From the Material Availability window, select a requirement line and choose Netting from the
View menu. You can also just double-click the line.

In all cases, the material requirement must be for an inventory part.

Material Planning Window opens, with the selected Site ID and Part ID specified. For more 
information, refer to the “Material Planning Window” chapter in the Inventory guide.
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Viewing Resource Schedule Information
You can view resource schedule information using commands from the Info menu.

Viewing a Total Shop Schedule
To see the current production schedule, select Resource Schedule (all) from the Info menu.

The Scheduling Window opens with the production schedule loaded.

The current work order is set as the focus work order — its operations appear in yellow to set them 
apart from other work orders.

Viewing a Schedule for the Current Work Order
To display a graphical view of the schedule for the current work order, select Work Order/Master 
Schedule from the Info menu or click the Work Order/Master Schedule button on the Form toolbar.

A “mini” Scheduling Window appears.

Be sure the order has been scheduled and updated before viewing this screen.

Unlike the Scheduling Window, each leg of the work order is shown on its own line, and all operations 
on that leg are shown horizontally, regardless of the resource used. This allows you to examine the 
interplay between different subassemblies of the work order.

To display the popup card for an operation, point at it and hold down the right mouse button. This 
gives the same information shown in the Manufacturing Window card.

To zoom in and out in the time frame, select Zoom In or Zoom Out from the View menu. You can 
also use the plus (+) and minus (-) keys on the numbers keypad to the right of the keyboard.

Select Home from the View menu to start the work order.

To exit the window, select the Exit menu option.

Viewing Resource Detail
To view detailed information for a specific Resource ID, select any operation that uses that resource, 
and select Resource Schedule (detail) from the Info menu or click the Resource Schedule button 
on the Form toolbar.

A dialog box appears, showing the operation schedule for every operation in the production schedule 
that uses the same resource. This dialog box is identical to the Resource Detail window in the 
Scheduling Window.
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Viewing Customer Order Status
Just as Material Availability provides complete information on the supply side of a work order, 
Customer Order Status provides comprehensive information on customers orders that are linked to 
this work order. This linkage may have occurred through Customer Order Entry, or by placing a work 
order through Material Planning Window. One or more customer orders could be linked to the current 
work order.

To view customer order status information, select Customer Order Status from the Info menu.

The following information appears in the dialog box:

Total Production Ordered – The Desired Quantity of the work order, irrespective of linked customer 
orders.

Total Production Received – The total quantity of the work order received to finished goods, 
irrespective of customer shipments.

Total Order Quantity – The total quantity of all customer order line items linked to this work order.

Total Shipped Quantity – The total quantity of all linked line items that has been shipped against the 
orders.

The table contains one line for each customer order line linked to the work order. Most of the 
important information from the order line is shown:

Order ID, Line # – The Order ID and line number from the customer order.

Customer ID – The customer ordering the material.

Misc Ref. – The reference description from the order line. Usually shows part description.

Part ID – The Part ID from the customer order.

Description – A description of the Part ID from the part master.

Customer Part ID – The customer’s reference for the part, if available.

Order Quantity – Order Quantity from the order line item.

Shipped Quantity – The quantity shipped against this line item.

Status – The status of the customer order line.

Released is displayed if one of these conditions is met:

• The customer order line has a status of Released
• The customer order header has a status of Released and the customer order line has a status of

Inherit.

Firmed is displayed if one of these conditions is met:

• The customer order line has a status of Firmed
• The customer order header has a status of Firmed and the customer order line has a status of

Inherit.

On hold is displayed if one of these conditions is met:

• The customer order line has a status of On Hold
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• The customer order header has a status of On Hold and the customer order line has a status of
Inherit.

Closed is displayed if one of these conditions is met:

• The customer order line has a status of Closed
• The customer order header has a status of Closed and the customer order line has a status of

Inherit.

Cancelled is displayed if one of these conditions is met:

• The customer order line has a status of Cancelled
• The customer order header has a status of Cancelled and the customer order line has a status of

Inherit. 

Ship On – The Desired Ship Date for the order line.

Shipped Date – Actual Ship Date from the packlist for the shipped line.

Promise Date – The date on which you promised to deliver the customer order.

Showing Backlog and Shipments
Normally, all orders of all status values are displayed. There are two other viewing modes for this 
table, controlled by the Show radio buttons at the upper right. If you select Backlog, then only Firm, 
Released, or On Hold order lines that have some unshipped quantity are shown.

If you select Shipments, only orders that have packlists against them are displayed. One line 
appears for each packlist that contains shipments of each order line. This may cause the same Order 
ID/Line # combination to display more than once, but each line represents a separate packlist line. In 
this case, each line represents a single packlist shipment, and the Shipped Quantity shows the 
amount shipped on that packlist. Returns appear as negative Shipped Quantities.

Accessing the Customer Order
While checking the current customer order status, if you need to view further information, or edit the 
customer order, select a line and place the mouse pointer over the Order ID column until it becomes a 
hand.

Double-click the column.

Customer Order Entry opens with the selected order loaded.

You can view all order information, including specifications and notes. Depending upon your privilege 
settings, you may also be able to edit the order.

When finished, you can exit Customer Order Entry, or simply return to the Customer Order Status 
window.
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Viewing Pictures/Objects
To view the Picture/Object for the work order/master, a leg, operation, or material requirement, select 
the object and choose Picture from the Info menu, press F12, or click the Picture button on the Form 
toolbar.

The graphic or object appears in a resizable window that automatically scales the graphic. A linked or 
embedded object usually displays an icon representing the object. Double-click the icon to activate its 
player. For example, if a media clip is linked to the object, double-click to get the viewer control that 
lets you start and stop the movie. If a Microsoft Word document is linked, double-click to activate 
Word to allow viewing of the document.

The Options menu commands in the Picture window control the display. If you select Scale from the 
Options menu, the picture appears to scale, with as much of the upper-left corner showing as 
possible.

If you select Size to Fit from the Options menu, the picture appears reduced or enlarged (usually 
reduced) to fit in the display frame, changing the aspect ratio if necessary to fill the frame.

If you select Size for Best Fit, the picture appears reduced or enlarged to fit in the display frame, 
while preserving the aspect ratio.

Viewing Notations
You can view and edit two types of notations from the Manufacturing Window:

• Part Notations are associated with the Part ID of the master/work order — the same set of
notations are seen for every master/work order for that Part ID.

• Work Order/Master Notations are associated with the current master/work order.

Access Notation windows through the File menu. You can leave these windows open and display the 
notations for the current Work Order and Part ID.

Work Order Hours Roll-up Information
Use the Work Order Hours Roll-up dialog to compare the actual labor hours spent on a work order to 
standard expected hours. Set up standard hours in Part Maintenance. See "Calculating Standard Unit 
Hours" on page 3–59 in the Inventory guide.

If only purchased parts are used as material requirements in the work order, then one line for the part 
specified on the work order header is displayed in the Work Order Hours Roll-up dialog. 

If fabricated parts are used in material requirements for the work order, then both the work order 
header part and fabricated material requirements are displayed in the Work Order Hours Roll-up 
dialog. The standard and actual labor spent for all fabricated parts in the work order are displayed in 
the table. 

If the fabricated material requirements on the work order also include fabricated parts in their 
engineering masters, then those parts are also included in the Work Order Hours Roll-up dialog box.
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For example, PART A is a material requirement on an engineering master for PARENT PART. PART 
A is a fabricated part. On the engineering master for PART A, PART B is a fabricated material 
requirement. 

You generate a work order for PARENT PART, and then view the Work Order Hours Roll-up. 
PARENT PART is displayed on the first line and Part A is displayed on the second line.

After you issue PART A to the work order and run inventory costing, the Work Order Hours Roll-up 
dialog is updated. PART B is added to the Work Order Hours Roll-up dialog. If PART B does not have 
fabricated parts in its engineering master, no other parts are displayed in the dialog. If PART B does 
have fabricated parts in its engineering master, then those parts are also displayed in the Work Order 
Hours Roll-up Information. 

Work Order Hours Roll-up Dialog and Costing Method
To use the Work Order Hours Roll-up dialog, the parent entity of the site must use the Actual costing 
method. 

If Average or Standard costing is used, a message is displayed when you access the dialog. 

Viewing Work Order Hours Roll-up Information
Note: To ensure that you are viewing up-to-date information, run the top two options of the Costing 
Utilities before accessing the Work Order Hours Roll-up dialog. 

By default, total standard, actual, variance, and projected hours are displayed in the table. To add 
setup and run detail columns to the table, use the View menu.

1 Select Eng/Mfg, Manufacturing Window.

2 Open the work order whose hours you want to view.

3 Select Info, Work Order Hours Roll-up. This information is displayed:

Quantity Required – The quantity required to make the part that is specified on the work order 
header. This part is listed in the first line of the dialog. 

Quantity Costed – Of the quantity issued to the work order, the quantity that has been costed. 
The costed quantity is used to calculate the actual hours. If a requirement was deliberately over-
issued to the work order, then this value can exceed the quantity required.

Std. Total Hours – The standard total hours to complete the quantity displayed on the line. This 
value is calculated by adding the standard setup hours to the standard run hours.

Std. Setup Hours – The standard total hours to set up the quantity displayed on the line.

If the quantity on the default engineering master is not 1, then the standard setup hours in the first 
row are calculated by multiplying the quantity required by the standard hours setup value that is 
specified for the part in Part Maintenance. 

For the other rows in the table, one of these calculations are made:
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• If no parts have been issued or costed, then the standard setup hours are calculated by
multiplying the quantity required by the multi-level setup value specified for the part in Part
Maintenance.

• If parts have been issued and costed, then the standard setup hours are calculated by
multiplying the quantity required by the standard hours setup value specified for the part in
Part Maintenance.

See "Calculating Standard Unit Hours" on page 3–59 in the Inventory guide.

Std. Run Hours – The total hours that are estimated to complete the run of the quantity displayed 
on the line. 

For the first row in the table, the standard run hours are calculated by multiplying the quantity 
required by the standard hours run value that is specified for the part in Part Maintenance. 

For the other rows in the table, one of these calculations are made:

• If no parts have been issued or costed, then the standard run hours are calculated by
multiplying the quantity required by the multi-level run value specified for the part in Part
Maintenance.

• If parts have been issued and costed, then the standard run hours are calculated by
multiplying the quantity required by the standard hours run value specified for the part in Part
Maintenance.

See "Calculating Standard Unit Hours" on page 3–59 in the Inventory guide.

Act. Total Hours – The total hours that have been reported on labor tickets for the work orders 
producing the part.

Act. Setup Hours – The hours that have been reported on setup labor tickets.

Act. Run Hours – The hours that have been reported on run labor tickets.

Var. Total Hours – The standard total hours minus the actual total hours.

Var. Setup Hours – The standard setup hours minus the actual setup hours. 

Var. Run Hours – The standard run hours minus the actual run hours. 

Projected Total Hours – For the first row in the table, one of these calculations is made:

• If the main work order is closed or cancelled, the actual total hours are displayed.
• If the main work order is open but no header quantity has been received, the projected hours

are calculated by adding the standard total hours and the actual total hours.
• If the main work order is open and header quantities have been received, the projected hours

are calculated using this formula: (remaining quantity * (standard hours/required quantity)) +
actual hours.

For all other rows, one of these calculations is made:

• If the costed quantity is greater than or equal to the required quantity, the actual hours are
used.

• If the costed quantity is less than the required quantity, then projected hours are calculated
using this formula: (remaining quantity * (standard total hours/required quantity)) + actual total
hours

Projected Setup Hours – For the first row in the table, one of these calculations is made:
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• If the main work order is closed or cancelled, the actual setup hours are displayed.
• If the main work order is open but no header quantity has been received, the projected setup

hours are calculated by adding the standard setup hours and the actual setup hours.
• If the main work order is open and header quantities have been received, the projected hours

are calculated using this formula: (remaining quantity * (standard setup hours/required
quantity)) + actual setup hours.

For all other rows, one of these calculations is made:

• If the costed quantity is greater than or equal to the required quantity, the actual setup hours
are used.

• If the costed quantity is less than the required quantity, then projected setup hours are
calculated using this formula: (remaining quantity * (standard setup hours/required quantity))
+ actual setup hours

Projected Run Hours – For the first row in the table, one of these calculations is made:

• If the main work order is closed or cancelled, the actual run hours are displayed.
• If the main work order is open but no header quantity has been received, the projected run

hours are calculated by adding the standard run hours and the actual run hours.
• If the main work order is open and header quantities have been received, the projected hours

are calculated using this formula: (remaining quantity * (standard run hours/required quantity))
+ actual run hours.

For all other rows, one of these calculations is made:

• If the costed quantity is greater than or equal to the required quantity, the actual run hours are
used.

• If the costed quantity is less than the required quantity, then projected run hours are
calculated using this formula: (remaining quantity * (standard run hours/required quantity)) +
actual run hours

4 When you are finished viewing work order hours roll-up information, select File, Close. 

Viewing Work Order Actual Hours Detail Information
To view the transactions that were used to calculate the actual hours spent on manufacturing 
subassemblies, use the Work Order Actuals Hours Detail dialog. While other transactions, such as 
purchase orders, may be displayed in the dialog, these transactions do not contribute to the actual 
hours calculation since they are not associated with labor tickets. Only work orders contribute to 
actual hours calculations. 

1 Select Eng/Mfg, Manufacturing Window.

2 Open the work order whose hours you want to view.

3 Select Info, Work Order Hours Roll-up. 

4 Select the subassembly that you want to view.

5 Select Info, Work Order Actual Hours Detail. This information is displayed:
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Cost Dist Type – The type of supply transaction, such as work order or purchase order.

Cost Dist ID – The ID of the supply transaction.

Quantity Costed – The quantity from the supply transaction that has been issued to the work 
order and has been costed. This quantity may not match the total quantity that was produced on 
the supply transaction. 

Act Total Hours – The total of the actual setup and run hours that were spent manufacturing the 
costed quantity.

Act. Setup Hours – The actual hours that were spent setting up the operations that produced the 
costed quantity.

Act. Run Hours – The actual hours that were spent running the operations that produced the 
costed quantity. 

6 To exit the dialog, select File, Exit. 

Specifying Color Preferences in the Work Order Hours Roll-up Dialog
To help you identify hour categories in the table, you can set up color preferences for each type of 
hours total. 

To specify color preferences:

1 In the Work Order Hours Roll-up dialog, select Options, Preferences.

2 Specify this information:

Standard Columns – Click the browse button and select the color to use for columns that show 
standard hours.

Actual Columns – Click the browse button and select the color to use for columns that show 
actual hours.

Variance Columns – Click the browse button and select the color to use for columns that show 
variances.

Projected Columns – Click the browse button and select the color to use for columns that show 
projected hours.

3 Click Ok. 

Viewing Exceptions
By creating rules and checking your work orders against those rules you can check for any events 
occurring to materials or operations. This allows you to manage by exception rather than by 
individually reviewing every card on a work order.
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Creating and Editing Exceptions
If you are licensed to use multiple sites, you can create exceptions at the tenant level only.

To create exceptions:

1 Open the Manufacturing Window Exceptions window by selecting Exceptions from the Edit 
menu.

The Manufacturing Window Exceptions window opens with any exceptions you have previously 
entered.

2 Click the New toolbar icon.

The New/Edit Manufacturing Window Exceptions window opens.

3 Enter an identifying name for this exception in the Name field.

4 Click the Object Type arrow and select the type of exception you are creating.

You can select:

• Material
• Operation
• Service
• Leg
• W/O Header

Note: The appropriate data items for the type you selected appears. A data input field appears 
allowing you to enter specific information against which you can base the exception.

5 Enter a description for this exception in the Description field.

6 If you want to set a priority for this exception, enter it in the Priority field.

Set priorities only if you want exceptions in a specific order processed.

7 Select the Data Item you want to use for the exception.

Some Data Items have predefined functions associated with them. For example, if you select a 
date data item, CurrentDate appears in the Functions list. You can select CurrentDate to compare 
the selected data item to the current date.

8 Select the operator you want to use for this exception.

There are four types of operators from which you can select:

• Comparison

> Greater than

< Less than

>= Greater than or equal to

<+ Less than or equal to

= Equal to

!= Not equal to
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• Arithmetic

+ Plus

- Minus

• Boolean

And

Or

Not

• Grouping

( – Open bracket

) – Close bracket

9 If you have selected a Data Item that has a Predefined Function, select the Function you want to 
use from the Function list.

10 When you have finished creating your Exception, click the Save toolbar button.

Note: If you want to clear your exception, click the Clear Expr button at the bottom of the New/
Edit Manufacturing Window Exception window.

Editing Exceptions
To edit your exception rules, open the New/Edit Manufacturing Window Exception window, select the 
Exception you want to edit, and click the Edit Row toolbar icon.

Using Default Exception
Infor has included some default exceptions to the exceptions window that you can modify to meet 
your specific needs. To use these Exceptions, click the Import Default Exceptions toolbar button.

Deactivating Exceptions
You can deactivate exceptions without deleting them by clearing the Active check box.

Viewing Exceptions
To view the current card's exceptions, select Exceptions from the View menu.
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The Exceptions dialog box appears populated with all of the exceptions (to the "active" rules you set 
up for the work order) for the current card. The cards in the work order that do not have exceptions 
appear faded while the cards with exceptions appear bright.

Listing All Exceptions
To view all of the exceptions for all of the cards in the current work order, select List All Exceptions 
from the View menu.

If you do not select the List All Exceptions option, only the exceptions for the selected card appear in 
the Exceptions table.

Viewing the Engineering Master for a Fabricated Part
If a material in a master is a fabricated part, you can open the part’s default engineering master. You 
can access this feature from the Header Card, from a Leg header card, and from the Material card. 

If you have enabled the pop up menu, you can right-click the Material card and select Open 
Engineering Master to open the master for the requirement. 

To open a master from an open Material card or Leg/Detail card, select Info, Open Engineering 
Master.

To open a master from an open Header card, click the Engineering Master button. 

Viewing Audit History
If you are auditing information in database tables related to masters, you can view a history of the 
changes made to a master in the Audit History dialog. 

A system administrator must grant you permission to view this dialog. 

Use Audit Maintenance to set up the audit. See "Audit Maintenance" on page 5–1 in the System 
Administration guide.

Information is written to this dialog if you are auditing these database tables:

• WORK_ORDER
• REQUIREMENT
• REQUIREMENT_COST
• OPERATION
• OPERATION_RESOURCE

To view audit history information:

1 Select Eng/Mfg, Manufacturing Window.
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2 Open a master.

3 Select Info, Audit History.

4 This information is displayed:

ID – The primary key of the database record that was changed.

User ID – The ID of the user who made the change.

Date – The date that the change was made.

Field – The database table and column that was changed.

Old Value – The original value.

New Value – The new value.

Action – The action that occurred to update the date. These actions are used:

Insert – A new value was created.

Update – An existing value was changed.

Delete – A value was deleted. 

Exporting Audit Information
You can export Audit Information to Microsoft Excel or to an XML file. 

Exporting Audit Information to Microsoft Excel
To export the information to Microsoft Excel:

1 Select Eng/Mfg, Manufacturing Window.

2 Open a master.

3 Select Info, Audit History.

4 In the table, select the rows to export.

5 Right-click the table and select Send to Microsoft Excel. Microsoft Excel is opened, and the rows 
you selected are inserted in the spreadsheet.

Exporting Audit Information to XML
To export audit information to XML:

1 Select Eng/Mfg, Manufacturing Window.

2 Open a master.

3 Select Info, Audit History.
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4 In the table, select the rows to export.

5 Right-click the table and select Send to XML.

6 Specify this information:

File Name – Specify the name to use for the XML file.

XML to Write – Specify the content to include in the file. Click one of these options:

Schema – Click this option to export the schema only. The XML structure is exported, but no 
information from the table is exported.

Document – Click this option to export the rows that you selected in the Audit History table in 
XML format. 

Both – Click this option to export both a schema file and a document file.

Tags – Specify the information to use for the XML tags. Click one of these options:

Use column name – Click this option to use the database column names for the tags.

Use item name – Click this option to use the column names as displayed in the Audit History 
table for the tags.

7 Click Export. 
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User Toolbar and the Manufacturing Window
If you use the User toolbar to pass information to custom applications, you can pass information from 
an operation card or material card in two ways:

• You can open the card, and then click the button on the User toolbar.
• From the main master window, you can highlight the card and then click the button on the User

toolbar.

See "Adding User Toolbars" on page 4–12 in the Concepts and Common Features guide.
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Printing in the Manufacturing Window
The Manufacturing Window allows you to print engineering reports and user defined reports.

Printing Engineering Reports
The Print Engineering Report command provides a printed format of all important information on a 
Master/Work order, Eng Master and Quote Master. This includes all header fields, and all data fields 
of legs, operations, and details. A Short Form provides a one-line-per-item format of basic quantity 
and labor information for the work order and each leg, operation, and material requirement.

To print an engineering report:

1 Select Print Engineering Report from the File menu or click the Print Engineering button on the 
Form toolbar.

2 The Base ID, Lot ID/Eng ID, and Split ID of the currently selected master or work order is inserted. 
To print a different master, specify a different ID in the Base ID, Lot ID/Eng ID, and Split ID fields.

3 If you want to print the abbreviated report, check the Short Form check box.

4 If you want masters containing obsolete parts disregarded, click the Skip Masters with Obsolete 
Parts check box. Obsolete parts are parts that are still in inventory but off limits to any kind of use. 
Select the correct print destination from the drop down box.

Select Print to output the report to paper.

Select View to view this report on screen.

Select File if you want to print this report to another file.

Select E-mail if you want to send the report as a Rich Text Format through electronic mail.

5 Click the Ok button.

If you selected Print, a standard Windows Print dialog box appears.

If you selected View, the report appears on screen.

If you selected File, a Print to File dialog box appears.

If you selected E-mail, when you generate the report the system attaches the file to a Microsoft 
Outlook e-mail. See your Microsoft Outlook user documentation.

6 If you selected Print, enter any appropriate information in the Print dialog box and click Ok to print 
the report.

If you selected View, you can then print the report by clicking on the Print button or by selecting 
Print from the Print menu.

If you selected File, enter a filename in the Print to File.

If you selected E-mail, when you generate the report the system attaches the file to a Microsoft 
Outlook e-mail. See your Microsoft Outlook user documentation.
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Printing Traveller Reports
To print Traveller Reports from the Manufacturing Window, select Work Order Traveller Reports 
from the File menu. The Work Order Traveller window opens populated with the appropriate 
information from the current work order.

See the “Work Order Travellers” chapter in this guide.
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What are Coproducts?
A coproduct is another part produced by a work order in addition to the main part. A work order or 
master specifies a part in its header that is the main part of the order. You may or may not assign this 
part a part number. The coproduct list specifies the additional parts that are made along with the main 
part. All coproducts must have part numbers and are the primary keys of the record.

Do not confuse coproducts with by-products. A by-product is similar to a coproduct in that it is an 
additional part that gets its value through a work order. The difference is in the method used to cost 
the additional parts. Coproducts are costed directly from work order details and calculates them 
based on a percentage of the entire order cost. You can assign values to coproducts much like 
materials are assigned values.

For example, a group of stamp parts that each have a different form, fit and function, but that you 
produce from the same raw material at the same time are coproducts. The resulting scrap material 
from the stamping process is a by-product.

Continuing the example of stamp parts, consider a group of four parts that you produce from a single 
sheet of stainless steel.

The first part is selected as the main part. This is a fairly arbitrary decision, but should not create 
difficult “quantity per” relationships.

The percent of cost calculation distributes the cost of the entire order to each individual part that you 
produce. The above relationship forces the following unit costs, assuming the order costs a total of 
$1,000.

The total cost of the order is computed, and it is apportioned to each of the coproducts including the 
main part, and then a unit cost for each coproduct is computed.

Part # Description  Quantity Per Percent of Cost 

A67889 Left Side 1 2 

A67882 Right Side 1 2 

A67888 Bottom/Top 2 4 

A67871 Front/Back 2 2 

Part # Description  Quantity Per Percent of Cost 

A67889 Left Side 1 2 

A67882 Right Side 1 2 

A67888 Bottom/Top 2 4 

A67871 Front/Back 2 2 
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Setting Up Coproducts
To add a coproduct to a master or work order:

1 Select Eng/Mfg, Manufacturing Window.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the master. If you are licensed to use a single site, this field is unavailable.

3 Open the master to which you are adding coproducts. 

4 Double-click the Header card. 

5 Click the Coproducts button.

6 Click the Insert button.

7 In the Part ID column, double-click the Part ID button to select a part from the Parts table.

If you are licensed to use multiple sites, the table shows only the part IDs that exist in the selected 
site. If you are licensed to use a single site, the table shows all part IDs.

When you enter or select a part, the part description is displayed in the Description column.

8 Enter the percent of cost for each cost category for the entire order that is assigned to this part.

The total of percentages in each cost category must not exceed 100. The main part percentage is 
the difference in the sum of the coproduct percentages.

9 Specify the quantity of coproduct that is produced. Complete one of these tasks:

• If the quantity of coproduct that is produced in a work order is fixed, click the Static option.
Then, specify the quantity in the Desired Quantity column. When you specify a static quantity,
the quantity of coproduct that is produced by a work order has no relation to the quantity of
main part that is produced. For example, you create an engineering master that produces a
static quantity of 500 units of the coproduct. If you create a work order from the engineering
master for a quantity of 5 units of the main part, the quantity of coproduct on the work order is
500. If you create a work order for a quantity of 1 unit of main part, the quantity of the
coproduct is 500. 

• If the quantity of coproduct that is produced is a function of the quantity of main product, click
the Ratio to Header Qty option. Then, in the Qty Per field specify the quantity of coproduct
that is produced for each unit of the main product. For example, to produce two units of
coproduct for each unit of the main product, specify 2 in the Qty Per field. If you product 5
units of the main part, then 10 units of the coproduct are produced. 

10 Double-click Receiving Warehouse ID to select from a list of valid warehouses the warehouse 
into which you want to receive the coproducts.

11 Click Save.

To add another coproduct, click the Insert button and repeat this procedure. Note that if you add a 
second coproduct, you must use the same quantity type as the first coproduct. 
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Linking Coproducts to Customer Orders
Customer order line items refer to work orders. The part number on the line item may be any part 
number from the work order, the main part or any of the coproducts.

When the coproduct list is examined to determine whether the user is connecting the line item to an 
already defined coproduct, the Part ID of the line item is compared with the Part ID of the order 
header and each Part ID in the coproduct list. You can leave only one of these parts unnumbered. If 
you leave more than one unnumbered, it is unknown if the user is creating a new reference. Because 
you want to make it easy for parts to be found that you receive, the numbering of parts is vital to the 
shipping and receiving process.

Use Customer Order Entry to link coproducts to work orders.

Linking Coproducts to New Work Orders
You can link coproducts to new and existing work orders. For new work orders, you can only specify 
the main part in Customer Order Entry; enter the coproducts to the new work order in the 
Manufacturing Window.

1 Select Customer Order Entry from the Sales menu of the Main window.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

3 Enter the Customer Order ID in the Our Order ID field. You can also click the Our Order ID button 
and select an order from the Orders table.

The information for the order appears in the Customer Order Entry window.

4 Click the Insert button to add a new line item to the table.

A blank line appears in the table. 

5 Enter the quantity of the part created in this work order in the Quantity column.

6 Enter a unique Work Order ID in the Job ID column.

Because you are entering a new work order with a unique ID, a dialog box appears, asking if you 
want to create the new work order.

7 Select the appropriate job status for the new work order (Unreleased, Firmed, or Released), then 
click the Ok button.

A check mark appears in the New W/O field.

8 Tab to the Part ID field and enter or select a part.

If you double click the Part ID column header, a dialog box appears, asking if you want to browse 
the Parts table by Part ID or Part Description. Notice that the Coproducts option button is grayed 
out. This is because you are entering a part for a new work order.

When you select a part, the part information is filled in for the part.

9 Enter the unit price for the part in the Unit Price column.
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10 Click Save to save the new line item.

Now you need to open the Manufacturing Window and add the coproducts to the new work order.

11 From the Customer Order Entry window, select File, then Manufacturing Window from the Sales 
pop out menu.

The Manufacturing Window search dialog box appears.

12 Click the Site ID arrow and select the site to use.

13 Enter the Base ID for the work order you just created.

The new work order appears in the Manufacturing Window.

14 Enter the coproducts for this work order using the procedure described earlier in this chapter. 

Linking Coproducts to Existing Orders
You can link coproducts to existing work orders directly from Customer Order Entry.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the order. If you are licensed to use a single site, this field is unavailable. 

2 Enter the customer Order ID in the Our Order ID field.

The information for the order appears in the Customer Order Entry window.

3 Click the Insert button to add a new line item.

A blank line appears in the table. 

4 Enter the quantity of the part created in this work order in the Quantity column.

5 In the Job ID column, enter the Work Order ID to which you want to link the coproduct.

6 Double-click the Part ID column header to select the part the customer is purchasing. The system 
offers you the option of browsing by Part ID, Part Description, or Coproducts.

7 Enter the unit price for the part in the Unit Price column.

8 Click Save to save the new line item.
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Receiving Coproducts into Inventory
Each part that a work order references is handled independently. You can receive one of the parts in 
a work order without receiving the others.

Inventory transactions for each receipt you enter are created. This means that the inventory 
transaction table carries several inventory transactions for a given work order, each referring to a 
different Part ID.

Use Inventory Transaction Entry to receive coproducts into inventory.

1 Select Inventory Transaction Entry from the Inventory menu of the Main window.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which the 
work order was created. If you are licensed to use a single site, this field is unavailable.

3 In the Work Order ID field, enter the work order that references the coproduct. You can also click 
the Work Order ID button to select a work order from the Released Work Orders table.

If the work order’s main part is linked to a customer order, a dialog box appears, telling you that 
you can only receive the coproducts from the work order.

You are receiving the coproducts from this work order, so click Ok to continue.

The information for the work order appears in the Inventory Transaction Entry window. Notice that 
the Part ID button is grayed out. Because the main part from the work order is linked to a 
customer order, you can only receive the coproducts.

4 Select the coproduct you want to receive from the Part ID drop down box.

5 In the Quantity field, enter the quantity of the coproduct part that you are receiving

6 Select the Receipt radio button.

7 In the Warehouse and Location fields, enter a warehouse and a location into which you are 
receiving the part.

8 Click Save.

The coproduct is added into inventory and creates a Transaction ID. Repeat this procedure to add 
additional coproducts into inventory.
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Shipping Coproducts
Use Shipping Entry to ship coproducts. Similar to receiving parts into inventory, the shipping process 
for each part on the work order is handled separately.

1 Select Shipping Entry from the Sales menu of the Main window.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you 
created the customer order. If you are licensed to use a single site, this field is unavailable.

3 In the Order ID field, enter the customer order that contains the coproducts you want to ship.

The customer information for the order appears in the Customer Shipments window. The line 
items show all the parts for the customer order.

4 Highlight the line that contains the coproduct you want to ship.

5 Click in the Ship Quantity column and enter the quantity of the part you are shipping.

If the quantity you are shipping is less than the total quantity ordered for that part, a dialog box 
appears, asking if you want to close the line’s remaining balance.

Click Yes to close the line or No to keep the line open.

6 Enter the appropriate shipping information.

7 Click Save on the main toolbar to ship the part.
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Netting and Coproducts
The Material Planning Window provides a view of a part’s supply and demand. This is called netting. 
This procedure must handle coproducts. A coproduct implies that the work order produces each of 
the parts in the coproduct list, therefore, netting must “see” these quantities of parts in its analysis of a 
part’s supply picture.

For more information, refer to the “Material Planning Window” chapter in the Inventory guide.
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Costing and Coproducts
Whenever you create a new receipt, the part standard is assigned as the cost. If you are using the 
Standard costing method, this cost is permanent and does not change. Each individual part in the 
coproduct list provides its own standard.

If you are using actual costing, the cost of each work order is eventually recalculated, and ultimately 
each receipt, and the actual cost is assigned as the receipt cost. This is done by the Costing Utilities.

For single-part work orders this is simply a process of summing the cost of the work order, calculating 
a unit cost, multiplying the unit cost by the receipt quantity, and saving the result in the receipt.

For multipart work orders, the process is different. Each of the coproducts may have a different unit 
cost. This unit cost is related to the cost of the entire order.

A total cost for the order is calculated. Each part, including the main part, has some part of the total 
cost assigned to it. Each coproduct simply has a percentage associated with it. This percentage 
(divided by 100) multiplied by the total cost is the total cost of the coproduct. This total is divided by 
the coproduct quantity to compute a unit cost for the coproduct. This unit cost is then used to compute 
the receipt cost.

The main part has an implied percent of cost. This percentage is calculated by subtracting the sum of 
the percents of the coproducts from 100. The remaining steps are the same as for the coproducts.

Each coproduct is not costed to Financials separately. As a result, independent product line costing is 
not possible for coproducts. This is because the work order itself is costed to the ledger, not its 
individual transactions. The product line of the work order is applied, not the product line of the parts 
themselves. All parts of a multipart work order are treated as if they are part of the same product line.
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Allocating Coproducts to Demand
You can allocate coproduct supply quantities to satisfy outside demand.

You can allocate coproduct supply to the following five demand sources:

• Customer Order Delivery Schedule Lines
• Customer Orders
• Inventory
• Work Orders 
• Interbranch Transfers

When entering coproducts, the quantity that you enter in the Desired Quantity column is the quantity 
of the coproduct (part) that you want the work order to produce; it also is the quantity that becomes 
available to you to allocate to the above five sources of demand.

1 With the work order that contains the coproduct you want to allocate to demand open, double-
click the work-order header card or highlight the work order header card and select Edit from the 
Edit menu.

The Engineering Master/Work Order dialog box appears.

2 Click the Coproducts button.

The Coproducts dialog box appears.

Refer to the appropriate following procedure for specific allocation instructions.

Allocating Coproduct Supply Quantities to Customer Order 
Delivery Schedule Demand
If you are licensed to use multiple sites, you can allocate supply to demand on a site-by-site basis 
only. You cannot allocate supply from one site to demand in a second site.

1 With the Coproduct line from which you want to allocate demand highlighted, click the Assign to 
Demand button.

The Assign to Demand dialog box appears.

The following read-only information appears in the dialog box header section.

Work Order ID – The ID of the work order that produces this coproduct.

Desired Qty – The quantity of the coproduct that you want the work order to produce. Enter this 
quantity as you enter coproducts information for a work order. Also, this is the quantity available to 
you to assign to demand.

Received Qty – The quantity of the coproduct Desired Quantity that you have received into 
inventory. A work order must be released before you can receive any coproduct quantities into 
inventory. 

Allocated Qty – The portion of the Desired Quantity that you have allocated thus far to demand. 
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Fulfilled Qty – The quantity that has been fulfilled from an allocation. When you issue this 
quantity to the demand source, the demand allocation is then fulfilled.

Available Qty – The portion of the coproduct Desired Quantity that you have yet to allocate to 
demand sources and is therefore still available for allocation. Before you begin to establish 
demand links, this value is equal to the Desired Quantity.

Part ID – The ID of the coproduct.

Part Description – A description of the coproduct.

Stock U/M – The stock unit of measure of the coproduct.

Warehouse ID – The Warehouse ID of the coproduct. The object of any demand link you 
establish must also have this Warehouse ID. If you attempt to establish a link to a potential 
demand source that does not have this same Warehouse ID, you are warned and cannot 
continue.

Sched Finish Date – The date on which the work order responsible for the production of this 
coproduct is scheduled to finish.

Desired Want Date – The date by which you want to receive the coproduct into inventory.

2 Click the Insert button to begin adding demand allocation information.

3 From the Type list box, select CD.

4 Double-click Demand Base ID or Piece # to view a list of customer order delivery schedule lines 
to which you can allocate supply.

The Customer Order Delivery Schedule Demand dialog box appears.

5 Using the search options in the Options and Sort by sections, configure a search for C/O delivery 
schedule lines and click the Apply button.

All customer order delivery schedule lines that meet your search specifications appear.

6 Select the appropriate line and click the Ok button.

The customer order delivery schedule line information appears in the Assign to Demand dialog 
box line item table. 

7 In the Allocate Quantity column, enter the coproduct quantity that you want to allocate to the 
customer order delivery schedule line.

The quantity you enter here cannot be greater than the Demand Unallocated Quantity of the 
customer order delivery schedule line or the Available Quantity of the coproduct.

8 Click Save to commit the allocation of coproduct supply to Customer Order delivery schedule 
demand.

Allocating Coproduct Supply Quantities to Customer Order 
Demand
If you are licensed to use multiple sites, you can allocate supply to demand on a site-by-site basis 
only. You cannot allocate supply from one site to demand in a second site.
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1 With the Coproduct line from which you want to allocate demand highlighted, click the Assign to 
Demand button.

The following read-only information appears in the dialog box header section.

Work Order ID – The ID of the work order that produces this coproduct.

Desired Qty – The quantity of the coproduct that you want the work order to produce. Enter this 
quantity as you enter coproducts information for a work order. Also, this is the quantity available to 
you to assign to demand.

Received Qty – The quantity of the coproduct Desired Quantity that you have received into 
inventory. A work order must be released before you can receive any coproduct quantities into 
inventory.

Allocated Qty – The portion of the Desired Quantity that you have allocated thus far to demand.

Fulfilled Qty – The quantity that has been fulfilled from an allocation. When you issue this 
quantity to the demand source, the demand allocation is then fulfilled.

Available Qty – The portion of the coproduct Desired Quantity that you have yet to allocate to 
demand sources and is therefore still available for allocation. Before you begin to establish 
demand links, this value is equal to the Desired Quantity.

Part ID – The ID of the coproduct.

Part Description – A description of the coproduct.

Stock U/M – The stock unit of measure of the coproduct.

Warehouse ID – The Warehouse ID of the coproduct. The object of any demand link you 
establish must also have this Warehouse ID. If you attempt to establish a link to a potential 
demand source that does not have this same Warehouse ID, you are warned and cannot 
continue.

Sched Finish Date – The date on which the work order responsible for the production of this 
coproduct is scheduled to finish.

Desired Want Date – The date by which you want to receive the coproduct into inventory.

2 Click the Insert button to begin adding demand allocation information.

3 From the Type list box, select CO.

4 Double-click Demand Base ID to view a list of customer orders to which you can allocate supply.

The Customer Orders dialog box appears.

You may want to view only those customer orders with the same Part and Warehouse IDs as the 
coproduct. Double-click Seq #/Line # instead of Demand Base ID to view only those orders.

5 Select an order and click the Select button.

6 Double-click Seq #/Line # to view a list of eligible lines from the customer order you selected.

7 Using the search options in the Options and Sort by sections, configure a search for customer 
order line items and click the Apply button.

All customer order line items that meet your search specifications appear.

8 Select the appropriate line and click the Ok button.
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The customer order line information appears in the Assign to Demand dialog box line item table.

9 In the Allocate Quantity column, enter the quantity of the coproduct that you want to allocate to 
the customer order line item.

The quantity you enter here cannot be greater than the Demand Unallocated Quantity of the 
customer order line or the Available Quantity of the coproduct.

10 Click Save to commit the allocation of coproduct supply to customer order demand.

Allocating Coproduct Supply Quantities to Inventory 
Demand
1 With the coproduct line from which you want to allocate demand highlighted, click the Assign to 

Demand button.

The following read-only information appears in the dialog box header section.

Work Order ID – The ID of the work order that produces this coproduct.

Desired Qty – The quantity of the coproduct that you want the work order to produce. Enter this 
quantity as you enter coproducts information for a work order. Also, this is the quantity available to 
you to assign to demand.

Received Qty – The quantity of the coproduct Desired Quantity that you have received into 
inventory. A work order must be released before you can receive any coproduct quantities into 
inventory.

Allocated Qty – The portion of the Desired Quantity that you have allocated thus far to demand.

Fulfilled Qty – The quantity that has been fulfilled from an allocation. When you issue this 
quantity to the demand source, the demand allocation is then fulfilled.

Available Qty – The portion of the coproduct Desired Quantity that you have yet to allocate to 
demand sources and is therefore still available for allocation. Before you begin to establish 
demand links, this value is equal to the Desired Quantity.

Part ID – The ID of the coproduct.

Part Description – A description of the coproduct.

Stock U/M – The stock unit of measure of the coproduct.

Warehouse ID – The Warehouse ID of the coproduct. The object of any demand link you 
establish must also have this Warehouse ID. If you attempt to establish a link to a potential 
demand source that does not have this same Warehouse ID, you are warned and cannot 
continue.

Sched Finish Date – The date on which the work order responsible for the production of this 
coproduct is scheduled to finish.

Desired Want Date – The date by which you want to receive the coproduct into inventory.

2 Click the Insert button to begin adding demand allocation information.

3 From the Type list box, select I.
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4 Double-click <Demand Base ID> to view a list of warehouses that currently contain the 
coproduct.

The Warehouses for Part dialog box appears.

The Warehouses for Part dialog box line item table contains the following columns.

Warehouse ID – The ID of the warehouse.

Available Quantity – The quantity of parts that the warehouse currently has available for use.

Committed Quantity – The quantity of parts that you have committed through allocation or order 
fulfillment.

Expected Quantity – The quantity of parts that you are expecting to receive into the warehouse.

Expected/Committed Quantity – The quantity of expected parts that you have already 
committed to order fulfillment.

5 Select the appropriate warehouse and click the Ok button.

6 In the Allocate Quantity column, enter the quantity you want to assign to inventory.

Remember, because inventory (Warehouse ID) is the default destination for these parts, the link 
that you are now establishing is a preventative measure against other links of demand.

The quantity you enter here cannot be greater than the Available Quantity of the coproduct.

7 Click Save to commit the allocation of coproduct line supply to inventory.

Allocating Coproduct Supply Quantities to Work Order 
Material Requirement Demand
If you are licensed to use multiple sites, you can allocate supply to demand on a site-by-site basis 
only. You cannot allocate supply from one site to demand in a second site.

1 With the coproduct line from which you want to allocate demand highlighted, click the Assign to 
Demand button.

The Assign to Demand dialog box appears.

The following read-only information appears in the dialog box header section.

Work Order ID – The ID of the work order that produces this coproduct.

Desired Qty – The quantity of the coproduct that you want the work order to produce. Enter this 
quantity as you enter coproducts information for a work order. Also, this is the quantity available to 
you to assign to demand.

Received Qty – The quantity of the coproduct Desired Quantity that you have received into 
inventory. A work order must be released before you can receive any coproduct quantities into 
inventory.

Allocated Qty – The portion of the Desired Quantity that you have allocated thus far to demand.

Fulfilled Qty – The quantity that has been fulfilled from an allocation. When you issue this 
quantity to the demand source, the demand allocation is then fulfilled.
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Available Qty – The portion of the coproduct Desired Quantity that you have yet to allocate to 
demand sources and is therefore still available for allocation. Before you begin to establish 
demand links, this value is equal to the Desired Quantity.

Part ID – The ID of the coproduct.

Part Description – A description of the coproduct.

Stock U/M – The stock unit of measure of the coproduct.

Warehouse ID – The Warehouse ID of the coproduct. The object of any demand link you 
establish must also have this Warehouse ID.

If you attempt to establish a link to a potential demand source that does not have this same 
Warehouse ID, you are warned and cannot continue.

Sched Finish Date – The date on which the work order responsible for the production of this 
coproduct is scheduled to finish.

Desired Want Date – The date by which you want to receive the coproduct into inventory.

2 Click the Insert button to begin adding demand allocation information.

3 From the Type list box, select RQ.

4 Double-click <Demand Base ID> to view a list of all the work orders in your database.

You can double-click <Piece #> at this point to view a list of only those material requirements with 
the same Part ID as the current coproduct.

The Work Orders dialog box appears.

5 Select the appropriate work order that contains a material requirement with the same Part  ID as 
the coproduct, and click the Select/Close button.

6 Double-click <Piece #> to view the material requirements for the work order you selected.

The Work Order Material Requirements Demand dialog box appears.

The line item table contains the following columns:

Sequence # – The sequence number of the material requirement in the selected work order.

Piece # – The piece number of the material requirement in the selected work order.

Part ID – The ID of the material requirement. This ID must match the coproduct Part ID.

Description - A description of the above part.

Calculated Quantity - The quantity of the material requirement in the work order.

Allocated Quantity - The quantity of the material requirement to which you have already 
allocated demand. This value less the Calculated Quantity equals the Demand Unallocated 
Quantity.

Fulfilled Quantity - The quantity the supplying source has fulfilled.

Warehouse ID - The default Warehouse ID of the material requirement. This ID must match the 
coproduct Warehouse ID.

7 Select the coproduct supply and click the Ok button.

The information appears in the Assign to Demand line item table.
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8 In the Allocate Quantity column, enter the coproduct quantity  you want to allocate to the material 
requirement.

The quantity you enter here cannot be greater than the Demand Unallocated Quantity of the work 
order material requirement or the Available Quantity of the coproduct.

9 Click Save to commit the allocation of coproduct line supply to work order material requirement 
demand.

Allocating Coproduct Supply Quantities to Interbranch 
Transfer Demand
If you are licensed to use multiple sites, you can allocate supply to demand on a site-by-site basis 
only. You cannot allocate supply from one site to demand in a second site.

1 With the coproduct line from which you want to allocate demand highlighted, click the Assign to 
Demand button.

The following read-only information appears in the dialog box header section. 

Work Order ID - The ID of the work order that produces this coproduct.

Desired Qty - The quantity of the coproduct that you want the work order to produce. Enter this 
quantity as you enter coproducts information for a work order. Also, this is the quantity available to 
you to assign to demand.

Received Qty - The quantity of the coproduct Desired Quantity that you have received into 
inventory. A work order must be released before you can receive any coproduct quantities into 
inventory.

Allocated Qty - The portion of the Desired Quantity that you have allocated thus far to demand.

Fulfilled Qty - The quantity that has been fulfilled from an allocation. When you issue this quantity 
to the demand source, the demand allocation is then fulfilled.

Available Qty - The portion of the coproduct Desired Quantity that you have yet to allocate to 
demand sources and is therefore still available for allocation. Before you begin to establish 
demand links, this value is equal to the Desired Quantity.

Part ID - The ID of the coproduct.

Part Description - A description of the coproduct.

Stock U/M - The stock unit of measure of the coproduct.

Warehouse ID - The Warehouse ID of the coproduct. The object of any demand link you establish 
must also have this Warehouse ID. If you attempt to establish a link to a potential demand source 
that does not have this same Warehouse ID, you are warned and cannot continue.

Sched Finish Date - The date on which the work order responsible for the production of this 
coproduct is scheduled to finish.

Desired Want Date - The date by which you want to receive the coproduct into inventory.

2 Click the Insert button to begin adding demand allocation information.
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3 From the Type list box, select WH.

4 Double-click <Demand Base ID> to view a list of IBT lines to which you can allocate supply.

The Interbranch Transfer Demand dialog box appears.

5 Using the search options in the Options and Sort by sections, configure a search for IBT lines and 
click the Apply button.

All IBT lines that meet your search specifications appear.

6 Select the appropriate line and click the Ok button.

The IBT line information appears in the Assign to Demand dialog box line item table.

7 In the Allocate Quantity column, enter the coproduct quantity you want to allocate to the IBT line.

The quantity you enter here cannot be greater than the Demand Unallocated Quantity of the IBT 
line or the Available Quantity of the coproduct.

8 Click Save to commit the allocation of coproduct quantities to Interbranch Transfer demand.

Viewing Coproduct Demand Allocation Information
At any time you can view what portion of a coproducts Desired Quantity you have allocated to 
demand and what quantity you still have available to allocate.

1 Open the work order to which the coproduct belongs.

2 Double-click the work order header card.

The Engineering Master/Work Order dialog box appears.

3 Click the Coproducts button.

The Coproducts dialog box appears.

4 With the coproduct line for which you want to view demand allocation information highlighted, 
click the Assign to Demand button.

The Assign to Demand dialog box appears.

Demand links appear in the line item table.

You can view the following information for each demand link:

Type - The Type ID of the demand link. Possible types include: CD (Customer Order Delivery 
Schedule), CO (Customer Order), I (Inventory), RQ (Work Order Material Requirement), and WH 
(Interbranch Transfer)

Demand Base ID - The ID of the above type. For example, if this demand link is to a customer 
order, the ID of the customer order appears here.

Lot ID - If the demand link is to a material requirement (Type RQ), the Lot ID of the work order to 
which this material requirement belongs appears here.

Split ID - If the demand link is to a material requirement (Type RQ), the Split ID of the work order 
to which this material requirement belongs appears here.
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Sub ID -  If the demand link is to a material requirement (Type RQ), the Sub ID of the work order 
to which this material requirement belongs appears here.

<Seq #/Line #> - If the demand link type is a material requirement, the sequence # of the material 
in the work; if the demand link type is a customer order delivery schedule (CD), a customer order 
(CO), or a interbranch transfer (WH), the line as it appear in the appropriate order.

Piece # - If the demand link is a customer order delivery schedule, the number of the delivery 
schedule line in the delivery schedule.

Demand Required Date - The required date of the demand source. See Demand Base ID.

Allocate Quantity - The quantity that you have allocated to the demand source.

Demand Unallocated Quantity - The portion of the Demand Quantity to which you have yet to 
allocate supply.

Demand Quantity - The quantity of the Demand Base ID. If the Demand Base ID is a customer 
order, the quantity of the customer order.

Supplied Quantity - The portion of the Demand Base ID that you have shipped.

Link Allocated Quantity - For this line, the quantity you have allocated to the Demand Base ID.

Link Received Quantity - For this line, the quantity that the Demand Base ID has received.

Link Issued Quantity - For this line, the quantity you have issued to the Demand Base ID.

Demand Part ID - The ID of the part you have allocated to the Demand Base ID.

Substitute Part - This check box is selected if this part is a substitute part.

New Part Warehouse - This check box is selected if this warehouse is a new part warehouse.
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Chapter 5: Rate-based Parts

This chapter includes this information:
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What are Rate-based Parts?
A rate-based part is a fabricated part that you produce in predictable daily quantities. Because the 
daily run rate is predictable, the quantity produced per day is used to determine when supply of the 
part is anticipated to be available to meet demand. 

When you sell a rate-based part, the daily rate is used to calculate when the part is projected to be 
available to meet customer demand.

When a work order consumes a rate-based part in a material requirement, the work order can be 
scheduled to begin earlier than if the part is not rate-based. For example, presume you have work 
orders with these parameters:

If Part A is not a rate based part, then work order 002 would be scheduled to start after work order 
001 is due to be complete. 

If Part A is a rate based part, then work order 002 would be scheduled to start after work order 001 
produces 10 parts. If work order 001 produces 10 parts per day, then work order 002 would be 
scheduled to start one day after work order 001 starts. 

Determining the Daily Production Rate for Rate-based 
Parts
To determine the daily production rate for a rate-based part, this calculation is used:

hourly run rate of last operation on work order * hours resource runs each shift * number of shifts

For example, if the last operation on the work order for the rate based part has a run rate of two 
pieces an hour, each shift is eight hours long, and you run the resource for two shifts, this calculation 
is made:

2 * 8 * 2 = 32

If the total quantity produced on the work order is not a multiple of the daily rate, then the work order 
is backwards prorated from the finish date. For example, if the daily run rate is 32 and the total 
quantity produced on the work order is 100, then a quantity of four would be available for planning 
purposes on the first day of production, followed by a quantity of 32 for the next three days. 

Work order 001 Produces 100 Part A

Work order 002 Requires 10 part A for production
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Setting Up Rate-based Production
To use rate-based parts in production, you must specify these scheduling settings:

• In Site Maintenance, the Use All Supply Before Applying Lead-time in Material Checks check box
must be selected for the site where you produce rate-based parts.

• In the Global Scheduler, you must select the Materials Checked check box for the production
schedule.

• In the Global Scheduler, you must select the Allocate fabricated materials check box on the
Allocations tab in the Schedule Preferences dialog. 

To set up parts for rate-based production, set up this information:

• In Part Maintenance, select the Rate Based Fabrication check box
• In the Manufacturing Window, specify the run rate on the last operation of the work order that

produces the rate based part. The run rate of the last operation determines the number of parts
that are produced each day. You can set up the default run rate on the part’s engineering master. 

Setting Up Scheduling for Rate-based Parts
To set up scheduling settings for rate-based production:

1 Select Admin, Site Maintenance.

2 In the Site ID field, select the site where you produce rate-based parts.

3 Click the Scheduling tab.

4 Select the Use All Supply Before Applying Lead-time in Material Checks check box.

5 Click Save.

6 Select Scheduling, Global Scheduler.

7 In the row that contains the production schedule for the site you selected in step 2, select the 
Materials Checked check box.

8 Ensure that the row that contains the production schedule is selected, then select Options, 
Schedule Preferences. 

9 Click the Allocations tab.

10 Select the Allocate fabricated materials check box. 

11 Click Ok.

Setting Up Rate-based Parts
To specify that a part is rate-based, use Part Maintenance.

1 Select Inventory, Part Maintenance.
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2 If you are licensed to use multiple sites, click the Site ID field and select the site for the part. If you 
use a single site, the field is unavailable. 

3 Click the Part ID button and select the part. 

4 Select the Fabricated check box.

5 Clear the Stocked check box. 

6 Click the Planning tab.

7 Select the Rate Based Fabrication check box.

8 Click Save.

9 Select Eng/Mfg, Manufacturing Window.

10 If you created an engineering master for the part and want to set a default run rate, click Eng 
Master. If you are setting the run rate on an individual work order, click Work Order.

11 Open the master or work order.

12 Open the last operation.

13 On the Setup/Run tab, specify the run and the run type for the operation.

14 Click Save. 
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Scheduling and Planning Rate-based Parts
In scheduling, the daily rate of the rate-based part is used to determine when work orders that 
consume the part can be scheduled. Similarly, the daily rate is used in the Material Planning window 
to determine when supply is available to meet demand.

Running the Concurrent Scheduler for Rate-based Parts
Before you run the Concurrent Scheduler, ensure that you have set up the preferences that are 
required for scheduling rate-based parts. See "Setting Up Scheduling for Rate-based Parts" on page 
5–3 in this guide. 

After you set up rate-based parts, run the Concurrent Scheduler. Work orders that consume the rate-
based part are scheduled as soon as sufficient quantity of the rate-based part is available.

Viewing Rate-based Parts in the Material Planning Window
In the standard view of the Material Planning Window, one row is created for each day that a rate-
based work order is scheduled or projected to be run. An asterisk is displayed after the work order ID 
to indicate that the work order is for a rate-based part.

In the advanced view of the Material Planning Window, use the Planning Period Details dialog to view 
daily production quantities of rate-based parts. Work orders for rate-based parts are not designated 
with an asterisk in the advanced view. 

You can generate planned orders for rate-based parts. The quantity of the planned order is equal to 
the larger of these two values:

• The total quantity required by the demand order
• The minimum order quantity for the rate-based part

If the quantity on the planned order exceeds the daily rate of the rate-based part, multiple supply lines 
are displayed.

If a rate-based part has its own material requirements, then planned orders can be generated to meet 
the demand created by the rate-based part. If the minimum order quantity of the material requirement 
is less than the daily run rate of the parent rate-based part, then one planned supply order is 
generated for each day of demand. 

The ability to generate planned orders depends upon the order policy of the part. See “Using Material 
Requirements Planning” on page 10-37 of the Inventory guide. 
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Checking the Availability of a Rate-based Part
When you check the availability of a rate-based part in Customer Order Entry or the Manufacturing 
Window, this additional information is displayed:

Rate per Day – The quantity that the work order produces each day.

First Delivery Date – The first day that the part is scheduled to be produced based on the schedule 
input settings. Note that the quantity produced on the first delivery date could be less than the daily 
rate. If the total quantity produced in the work order is not a multiple of the daily rate, then a quantity 
that is less than the daily quantity is produced on the first day. For example, if the daily rate of a part is 
8 and the total quantity of the work order is 20, then 4 parts are produced on the first day. 
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Rate-based Parts and Minimum Move Quantities
If you specify a minimum move quantity on an operation that uses a rate-based part as a material 
requirement, the minimum move quantity determines when the current operation can begin and when 
the subsequent operation can begin. 

For example, presume that you have a work order with two operations: operation 10 and operation 
20. Operation 10 uses a rate-based part as a material requirement. If you specify 3 as the minimum 
move quantity on operation 10, operation 10 is scheduled to begin when 3 units of the rate-based 
material requirement are available. In addition, operation 20 is scheduled to begin when operation 10 
produces 3 units. 
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What is Scheduling?
Scheduling is the process of planning the different events involved in the manufacturing process.

There are three major reasons for creating a schedule:

• to understand how much of your capacity is already occupied
• to identify possible future threats to on-time deliveries 
• to help your production, procurement, and sales departments to work together more successfully

You are provided with two powerful tools, the Concurrent Scheduler and the Scheduling Window. Use 
both of these tools to properly schedule all of your manufacturing activities.

Load Versus Capacity
Load and capacity are two dimensions of a schedule. Load is the total amount of work hours 
scheduled for a given resource. Capacity is the maximum amount of work hours a resource is 
available for each shift of each day, and how many units of capacity are available during that period. If 
the load for a job exceeds the capacity, you cannot complete the job on-time unless you assign 
additional resources to handle the excess load.

For example, if a work center has 3 machines that operate 8 hours per day, the work center has 24 
resource-hours of capacity. If you are scheduling a job that requires 32 resource-hours (load), you 
need to assign an additional resource (perhaps one extra machine working one 8 hour day) to handle 
the excess load.

What is Load?
The three dimensions of load are: 

• which resources 
• when
• how much

The when and how much dimensions are expressed in three measurements: date/time, numbers of 
hours, and units.

Only firmed and released operations of work orders can cause load. The only exceptions are 
temporary loads created by on-line availability checks or by MRP-generated planned orders in 
schedules other than the production schedule.

What is Capacity?
There are two dimensions to capacity: 

• when 
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• how much 

The when dimension is expressed in date/time format; the how much dimension is expressed in 
number of units format.

The time dimension (when) of capacity may be different for each day in the foreseeable future. 
Capacity for each day is expressed in terms of starting time of first shift and numbers of hours each 
on first, second and third shifts. The number of units dimension is expressed as the number of tasks 
or operations that can occur at one time in each of three shifts. For example, it is possible that you 
work more than one shift per day, yet do not have identical levels of staffing on each shift.

Schedule Inputs
These items are actually attributes of the schedule itself or the scheduling run.

Schedule Type
The Concurrent Scheduler supports two types of schedule: Finite and Infinite capacity. A finite 
capacity schedule uses the capacities defined for each shop resource. An infinite capacity schedule 
ignores any capacity constraints. See “Behind the Scenes of the Scheduling Process” later in this 
chapter.

Check Material Availability
This option allows on-hand quantities, planned availability, and part acquisition lead times to affect 
the schedule. See “Running the Concurrent Scheduler” later in this chapter.

Fit Tolerance
This is the percentage of an operation’s duration which the scheduling loading algorithm considers a 
successful schedule slot for the given operation. For example, if you have this value set to 90, the 
Scheduler looks for a slot into which it can fit 90% of the operation. The Scheduler assumes that you 
can complete the remaining 10% of the operation in this 90% time slot. The value must be between 
50 and 100 percent.

See “Setting Concurrent Scheduler Preferences” later in this chapter.
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Work Order Scheduling Inputs
This section outlines the information taken from work orders in creating a global schedule. See the 
“Manufacturing Window” chapter in this guide.

Scheduling Mode
The Concurrent Scheduler schedules each work order in one of two modes, which you can control at 
the work order level.

Backward Schedule
The work order’s Want Date drives the scheduling of the order. The scheduler works backwards from 
the final operation to schedule each preceding one.

Forward Schedule from Release Date
Scheduling of the work order is driven by the work order’s Release Date, working forward from the 
first operation to schedule each subsequent one.

Operation Duration
Each work order operation has a calculated Start Quantity feeding into it that depends upon the work 
order desired quantity and scrap levels on downline operations. Run hours are calculated based on 
the specified Run time, Run Type, and Loadsize (if you use them).

The total labor hours and total resource-hours you need to complete an operation are determined by:

Resource Hours = (Setup Hours x #Machines) + (Start Quantity x Run Hours / 
#Machines)

An additional factor is any specified Move Hours for the operation. Although these do not produce 
load on the resource, they affect when the next operation can begin. You can express the effective 
duration of an operation by:

Operation 
Duration = Resource-Hours + Move Hours

= Setup Hours + (Start Quantity x Run Hours/
Quantity) + Move Hours
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You can express a service operation by:

Operation Overlap
These formulas are actually only correct when no overlap applies. The Minimum Move Quantity of an 
operation allows you to specify how much of an operation’s pieces or quantities that you require to be 
complete before they can begin to feed the next one. This causes the Could Start Date for an 
operation to become more favorable (later for a backward schedule, earlier for a forward schedule).

For example, if an operation’s End Quantity is 100, and Minimum Move Quantity is 50, then the next 
operation can begin halfway through the previous one’s duration, assuming that the run rates are 
equal. If the consuming operation has a faster run rate than the supplying operation, then it starts 
later than half way through so that it does not run out of pieces before the supplying operation has 
finished producing them. In terms of the leadtime, this effectively cuts the run portion of this 
operation’s duration in half.

Subassembly Legs
Each subassembly of a work order is scheduled independently in terms of starting date. The 
completion of the last operation of a subassembly determines when its parent operation can begin, in 
the same way a previous operation would. Where both apply, the latest one determines when the 
next operation can start. The Minimum Move Quantity for the final operation of a leg allows an overlap 
with its parent operation.

Operation Start Date and Status
If you have already started (released) an operation when you run the Scheduler, its completion status 
is taken into account. If you mark setup as completed, setup time for the operation is not scheduled. 
Quantity Completed is compared against End Quantity to prorate the remaining time you need to 
complete the operation. You can schedule started work orders first, either freezing or not freezing 
started operations after they have been scheduled.

Service Start Date
For subcontractor operations, use the Service Receipt Entry/Service Status function to indicate a date 
when you shipped materials to an outside service. When running a new schedule, this date is used to 
deduct from the required Transit Days of this operation based on the fact that you have already 
started the operation.

Operation 
Duration = Transit Days
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Material Lead Time
If you are using Check Material Availability, material acquisition leadtime enters into the situation in 
the same way as operation lead time. In this case, material availability constrains start dates of 
operations. Start dates do not change if you plan on having material available in time for an operation 
start. Start dates do not change if you can make material available for the operation start.

For example, consider a special material that is not in stock, with a lead time of 15 days. If the current 
shop resource loading would allow the operation to start 5 days from today, Check Material 
Availability pushes the operation out to the full 15 days, affecting all dependent operations as well.

In checking material availability, four things are considered. First, current inventory levels might show 
a sufficient quantity to meet a requirement. Second, outstanding purchase orders may show 
additional quantities that you plan to receive. Third, the part’s lead time shows the maximum time that 
you must wait for the material, if the current and planned orders don’t meet the need. Finally, 
materials you are expecting from planned work orders are considered.

Concurrent Resources
If you specify concurrent Setup and Run resources for an operation, these add parallel resource-hour 
requirements for the resources. The capacity and calendars of those resources are used to schedule 
in the same way as the primary resource. The calendars of the concurrent resources can constrain 
the scheduling of the primary resource.

Discontinuous Operations
The Scheduler supports discontinuous scheduling of operations. You can set up a shop resource so 
that operations that use that resource are scheduled discontinuously. See “Setting Up Discontinuous 
Resources” in the Shop Resource Maintenance chapter.

You can overwrite the default values setup in Shop Resource Maintenance by editing the operation in 
the Manufacturing Window. See “Editing Operations” in the Manufacturing Window chapter.

During scheduling, when a load conflict occurs on a unit, the scheduled duration of run on that unit is 
compared with the minimum segment size. If the scheduled duration is at least the minimum segment 
size, then the Scheduler creates a “segment” schedule from that unit. Scheduling continues until a 
collection of “segment” schedules is found, disjointed with respect to time, but sufficient to 
successfully schedule the operation’s duration.

Each scheduled, disjointed segment is independent and contains its own setup and assigned units. A 
segment may use different units from another, and depending on usage, min/max settings may have 
a different number of units than any other segment.
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Resource Minimums and Maximums
The Scheduler schedules quantities of the same operation to run in parallel on multiple units of 
resource. For each operation, you can specify the minimum units required to start the operation. The 
operation is not scheduled unless at least this many simultaneous units are available. You can also 
specify the maximum an operation can use. If you don’t want an operation scheduled in parallel, 
specify a maximum of 1 and leave the maximum set to default to 1.

Work Order Priority
The Concurrent Scheduler allows you to prioritize work orders on a scale of one to fifty. In situations 
where work orders compete for the same resource, you can decides which takes priority.

Resource Scheduling Inputs
This section outlines the shop resource items used by the Concurrent Scheduler in creating a 
schedule. See “Part Maintenance” and “Shop Resource Maintenance”.

Schedule Type
You can mark operation scheduling types in two ways:

Schedule Continuous means that there is sufficient capacity for performing the entire operation.

In Schedule Discontinuous, you can specify a minimum segment size. A minimum segment size must 
be scheduled as the required run duration on one unit before the segment is eligible.

Capacity Type
You can mark shop resources in one of two ways. Schedule Normally indicates a finite capacity. If 
you do not select Schedule Normally, it is assumed that the resource has infinite capacity.

Calendar
The resource weekly calendar for a resource specifies the duration of each of three shifts for the 
seven weekdays. Calendar exceptions allows you to modify the calendar as necessary. Calendars 
can be resource specific and/or schedule specific.
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Resource Capacity
Resource capacity is defined as how many hours a given resource is available for each shift of each 
day and how many units of capacity are available during that period.

For example, if a work center has 3 machines that operate 8 hours per day, the work center has 24 
resource-hours of capacity.

If the work center perspective sees 3 machines, each operating 8 hours per day on the same shift, 
there are 24 hours of machine availability. If there are 3 jobs or less, totaling 24 hours or less, then the 
work center perspective is correct.

However, the work center perspective does NOT account for the fact that only three jobs can be run 
at any given time, regardless of duration.

This is seen as a shift that is 8 hours long with 3 units of capacity. This means that you can schedule 
a maximum of 3 operations to coincide with one another during that given period of time.

This is different from 24 hours of capacity by having one unit available for 24 hours.

When you specify a number of units of capacity, a unit number is assigned to each one, starting with 
0. For example, if a drill resource has a capacity of 3 on the first shift, operations on units 0, 1, and 2 
are scheduled. The Scheduler always loads unit 0 first, then unit 1, and so on. This is significant in the 
following situations:

Some Operations are Shorter Than a Given Shift
Consider an example where each operation takes 2 hours, and you have the capacity described 
above of one 8 hour shift that has 3 units of capacity. The Scheduler schedules up to twelve of these 
2-hour operations per day: each unit can do 4 operations in its 8 hours, with 3 running in parallel.

Capacities Vary Between Shifts
Consider the same example, but add a second shift of 8 hours with only 2 units of capacity. The 
Scheduler sees this as a work center having a maximum of 3 machines. The first two are available 16 
hours (8 hours on the first shift, and 8 hours on the second shift), and the third is available only 8 (8 
hours on the first shift). When the Scheduler loads the operations for this work center, it first looks at 
capacity for unit 0 (the first machine). Therefore, it may schedule up to 16 hours of time on that 
machine. If neither the first nor second machine are available, the Scheduler uses the third, which has 
only 8 hours available on this day on the first shift.

It is important to note that this operation remains on this unit for its entire duration. This means that 
the operation is not eligible to use extra second shift time on the next day whether it is available or 
not, or any day because there is no third machine on second shift. The assumption is that you cannot 
move the operation from this machine once it has begun. This may often be reasonable for a 
quantities of one, or any time there is significant setup involved, but it may be a problem when staffing 
causes capacity to vary. In this case, an operator can move between machines. You can raise the 
priority of the work order to correct this problem.
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When the Scheduler starts an operation, if units 0 and 1 have load and unit 2 does not, the Scheduler 
starts with unit 2. However, if either unit 0 or 1 become available and the Scheduler finds a better 
schedule on 0 or 1, it chooses the better schedule. In the forward direction, the start of the schedule is 
delayed if it results in an earlier finish. In the backward direction, an earlier finish date is chosen if it 
results in a later start, perhaps due to more capacity duration.

Scheduling Outputs
For each work order, the Scheduler produces the following information:

Start Date & Finish Date
For each operation, the Scheduler determines a start and finish date. You can imply the start date of 
the work order by the start date of the first operation. You can imply finish date by the finish date of 
the last operation. An operation may be scheduled for resources with multiple units of capacity to run 
on more than one simultaneously. In general, each schedule entry specifies a start and end time on a 
specified unit of a resource.

Determinant Path
The determinant path is the set of operations in a work order that controls the duration of the work 
order. This is measured AFTER the Scheduler takes resource constraints into account. You can call 
the path that the Scheduler measures before considering these constraints a “critical path.”

The determinant path operations appear in the Scheduling Window as green bars. Late determinant 
path operations appear as olive bars.

The Production Schedule
If you are licensed to use multiple sites, each site has one production schedule. The Manufacturing 
and Scheduling Window assumes that this schedule is the “actual” plan for the site. Dates from the 
production schedule are the ones shown on the manufacturing window display for scheduled work 
orders. They are also displayed in the Scheduling Window. If a work order or operation is not 
scheduled, it is marked Not Sched.

If you are licensed to use a single site, you have one production schedule for your entire enterprise.

Sites and the Concurrent Scheduler
 These conditions apply when you run the concurrent scheduler in sites: 
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• Within a site, you can run the concurrent scheduler for one schedule at a time. If a user attempts
to run the scheduler in a site where the scheduler is already running, a message is displayed. The
message shows who is currently running the scheduler in the site and when the scheduling
process began. For example, if you are running the concurrent scheduler for your production
schedule in Site A, a second VISUAL user cannot run the concurrent scheduler for your “what if”
schedule in Site A or try to schedule a work order for Site A from the Manufacturing Window.
Similarly, users cannot run the scheduler in a site if the scheduling service is already running the
scheduler for the same site.

• The concurrent scheduler can be run simultaneously in different sites. For example, if you are
running the concurrent scheduler for Site A, a second user can run the scheduler for Site B at the
same time. 

• If you are licensed to use a single site, then the scheduler can be run for one schedule at a time. 



What is the Concurrent Scheduler?

Infor VISUAL Inventory User’s Guide | 6 – 11

What is the Concurrent Scheduler?
The Concurrent Scheduler schedules and reschedules all released and firmed Work Orders in your 
shop based upon the due dates and/or priorities you specify. You can supply your customers with 
accurate availability and delivery dates if you use the Concurrent Scheduler on a regular basis.

Use the Concurrent Scheduler to determine several important things about your production schedule:

• When to begin and finish every operation of your firmed and released work.
• Whether, given the amount of capacity you have designated for each work center, you will be able

to meet the want dates of these orders.
• When you could add additional capacity to improve your deliveries.
• When you have excess capacity for a resource.

You can also use the Concurrent Scheduler to:

• Create “what-if” schedules to determine the outcome of various changes in capacity, load, and
calendar settings.

• Check the schedule availability and impact of work orders that results from quotations and
customer orders. You can do this directly from the Estimating Window, Customer Order Entry, and
the Manufacturing Window.

The Scheduling Window is an indispensable tool when you want a “birds-eye” or long range view of 
what has been scheduled to happen in your shop relative to Work Orders that you have released to 
the floor. Each operation is clearly displayed in a graphical format. You can “zoom in” to look at 
specific dates and operations, or you can “zoom-out” to get a broad view of the scheduled events. 
You can view up to three schedules at one time on the same screen. You can choose to view your 
production schedule and “what if” schedules, or, if you are licensed to use multiple sites, you can view 
schedules from different sites at the same time. 

The Scheduling Process
After you have set up and verified shop resources and part lead times, you can begin the scheduling 
process. This involves the following steps: The steps of the scheduling process include:

Scheduling the Job

1 Start the Concurrent Scheduler.

2 Set Concurrent Scheduler preferences.

3 Create a New Schedule or activate an existing schedule.

4 Select the appropriate scheduling options.

5 Run the schedule.

Viewing the Results

1 Open the Scheduling Window.

2 Load schedule you just created.
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3 View the schedule.
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Starting the Concurrent Scheduler
To access the Concurrent Scheduler:

Select Scheduling, Concurrent Scheduler.

If you have not yet created production schedules, you are prompted to create them when you access 
the Concurrent Scheduler for the first time. You can define production schedules in the Concurrent 
Scheduler, or you can define production schedules in Site Maintenance.

Setting Concurrent Scheduler Preferences
Use Concurrent Scheduler Preferences to specify the settings to use when you run a schedule. 

If you are licensed to use a single site, you can set up tenant-level and schedule-level preference 
settings. When you create a new schedule, the tenant-level settings are used for the default settings 
for the schedule. You can edit the schedule-level preferences to override the tenant-level settings. If 
you do not create tenant-level or schedule-level preference settings, then the system default settings 
are used. 

If you are licensed to use multiple sites, you can set up tenant-level, site-level, and schedule-level 
preference settings. When you create a new schedule in a site, the site-level settings are used for the 
default settings for the schedule. If site-level settings are not available, then the tenant-level settings 
are used. You can edit the schedule-level preferences to override the tenant- or site-level settings. If 
you do not create tenant-level, site-level, or schedule-level preferences, then the system default 
settings are used. 

In the Global Scheduler window, users must have system administrator privileges to change 
scheduler preferences. Other users can view the preferences but cannot make changes. 

The SYSADM user can edit scheduler preferences in Preferences Maintenance. 

To specify concurrent scheduler preferences:

1 Perform one of these steps:

• To specify tenant-level preferences, do not select a schedule. Select Options,
Preferences.... In the Title bar, Preferences - **Tenant** is displayed.

• To specify site-level preferences, select a schedule for the site. Select Options,
Preferences.... In the Title bar, Preferences - plus the name of the site you selected is
displayed.

• To specify schedule-level preferences, select the schedule. Select Options, Schedule
Preferences. In the Title bar, Preferences - plus the ID of the site and the schedule are
displayed.

2 Set these preferences:

Schedule Horizon – Enter the maximum number of days into the future you want the Scheduler 
to search for work order want dates. 
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Fit Tolerance – Enter a percentage that represents the capacity necessary relative to the size of 
the operation in order for the operation to be successfully scheduled in finite scheduling mode. 
For example, a value of 90 indicates that an 8 hour operation can successfully fit into a 7.2 hour 
open slot. (8 hours x 90% = 7.2 hours) 

Schedule Pieces if Run Minutes per Piece is at Least – Use this option with min/max 
scheduling. The run minutes per piece must be at least 10 minutes. The Scheduler does not split 
the duration for one piece among multiple units.

For example, if you are scheduling an operation with 10 pieces on 3 units and the run type is 1 
hour per piece, the Scheduler schedules 4 pieces on unit 0 and 3 pieces each on units 1 and 2.

3 In the Generate section, select audit record options you want to use:

Work Order Audit – Select the Work Order Audit check box to generate an audit record for each 
pass that the Scheduler makes when processing a work order. The maximum is three entries per 
work order.

Operation Audit – Select the Operation Audit check box to generate an audit record for each 
attempt to schedule each operation of a work order. This option must be active to use the Audit 
mode in the Scheduling Window.

Selecting the Operation audit check box automatically selects the Work order audit check box. 
Clearing the Work order audit check box automatically clears the Operation audit check box.

Throughput Audit – Select this check box to generate the operation audit results required for 
Throughput analysis only. Selecting the Throughput Audit check box automatically selects the 
Work order audit check box. Clearing the Work order audit check box automatically clears the 
Throughput audit check box. 

4 In the Sort By section, select how you want the schedule sorted:

Order Want Date – To sort the schedule based on the date on which the order is wanted, select 
the Order Want Date option button.

Priority, Want Date – To sort your schedule based on priority first then want date, select the 
Priority, Want Date option button.

Priority, Release Date – To sort your schedule based on priority first then release date, select the 
Priority, Release Date option button.

5 In the When “schedule as of” is Today section, select how you want the scheduling time handled:

Default “at time” to midnight – If you want time appearing in the Global Schedule dialog box to 
appear as Midnight, select the Default “at time” to midnight option button.

Default “at time” to current time – If you want time appearing in the Global Schedule dialog box 
to appear as the current system time, select the Default “at time” to current time option button.

6 In the Schedule started work orders section, select how you want work orders that are already in 
progress handled:

Normally – If you select the Normal option, all started work orders with history are scheduled in 
their original position in the work order sort order.
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First, don’t freeze started operations – If you select this option, all started work orders are 
processed first. The sort of the started work orders is still based upon the sort selection (for 
example, Want Date). During the scheduling of these started work orders, any started operations 
are not frozen after being scheduled. They will be scheduled normally if scheduled in a later run.

First, freeze started operations – If you select this option, all started work orders are processed 
first. The sort of the started work orders is still based upon the sort selection (for example, Want 
Date). During the scheduling of these started work orders, any started operations are frozen after 
being scheduled. They will be scheduled using frozen operation scheduling logic if scheduled in a 
future run.

Note: Depending on the new schedule, your started operations may move.

7 Click the OK button.

Setting After Forward Pass Options
Use the After Forward Pass tab to select what you want the Scheduler to do after a forward 
scheduling pass.

1 Click the After Forward Pass tab.

2 Select the appropriate schedule forward options.

Note: The following three options apply only to forward-scheduled work orders. Forward-
scheduled work orders are work orders for which you have set the Forward Schedule from 
Release Date option in the Manufacturing Window.

Backward Schedule – Select this option button if you want the Concurrent Scheduler to attempt 
the backward scheduling of work orders for which you have set the Forward Schedule from 
Release Date option, after attempting to schedule using a forward pass.

Backward Schedule if On Time – Select this option if you want the Concurrent Scheduler to 
attempt to schedule work orders for which you have set the Forward Schedule from Release Date 
option in a backward direction if they are on time after a forward pass. This option allows the 
Concurrent Scheduler to adjust the position of these work orders in a schedule. For example, by 
backward scheduling already on-time work orders, the Concurrent Scheduler may be able to 
move the release date of a work order closer to its want date and thereby free up resource 
capacity and eliminate lag time that may exist if a forward-scheduled work order completes 
without delay and there are still a considerable number of days until the want date arrives.

Do Not Backward Schedule – Select this option button if you do not want the Concurrent 
Scheduler to backward schedule work orders for which you have set the Forward Schedule From 
Release date preference. The work order’s release date as you set it in the Manufacturing 
window determines its position in the schedule.

3 If you want to preserve the determinant path, select the Preserve Determinant Path check box.

The determinant path is the set of operations in a work order that controls the duration of the work 
order. This is measured AFTER the Scheduler takes resource constraints into account. You can 
call the path that the Scheduler measures before considering these constraints a “critical path.”
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The determinant path operations appear in the Scheduling Window as green bars. Late 
determinant path operations appear as olive bars.

4 Choose what to do with work orders that you have not set to be forward scheduled from their 
release date. The same three options apply.

Backward Schedule – Select this option if you want the Concurrent Scheduler to attempt the 
backward schedule of work orders after a forwards pass. If the Concurrent Scheduler has already 
scheduled a work order in a backwards direction, the work order stays where it is in the schedule.

Backward Schedule if On Time – Select this option if you want the Concurrent Scheduler to 
attempt the backward schedule of work orders after a forward pass if the work order is on time at 
that point. If the Concurrent Scheduler has already scheduled a work order in a backward 
direction, the work order stays where it is in the schedule.

Do Not Backward Schedule – Select this option if you do not want the Concurrent Scheduler to 
attempt a backward scheduling pass of work orders after a forward pass.

5 If you want to preserve the determinant path, select the Preserve Determinant Path check box.

For more information, refer to the “Estimating Window” chapter in the Sales guide.

6 If you are finished making changes to your scheduling preferences, press click the OK button.

Setting Allocation Options
A “front-end” scheduling scheme is supported by scheduling supplying work orders ahead of 
consuming work orders. A list of work orders is first constructed with either want date or priority taking 
precedence, depending upon your choice. 

Allocation is determined in this sequence:

1 If the Allocate fabricated materials check box is selected, then the system will pass supplying 
work orders to the scheduler before consuming work orders. This is done by constructing a new 
list that re-sequences the work orders in the original list. Each work order in the original list is 
processed in sequence as follows:

a The work order is searched for any requirement that has a named part, is not linked to a P/O 
and is not a leg header.

b For each such requirement:

• If customer demand for the requirement’s part ID has not previously determined, then 
demand for that part from any customer orders that meet the conditions setup in item 1 is 
determined. This is done once for each encountered part ID.

• If supply for customer order demand for the part has not previously been allocated, then 
an attempt is made to allocate supply to the demand from qualifying customer orders as 
follows:
• First, any available supply is taken from inventory and allocated to the qualifying 

customer orders.
• Then, if there is insufficient supply in inventory for the customer order demand, supply 

is taken from any work orders in the list to be scheduled. This is done by searching 
the list for enough supplying work orders to cover the customer order demand. Each 
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supplying work order that is found is processed by going through the steps outlined 
here in a) through c). 

• Next, supply is sought for demand from the requirement. 
• As with customer orders, supply is sought first from available inventory.
• If there is insufficient supply in inventory, then supply is taken from work orders in the 

list to be scheduled. The list is searched for enough supplying work orders to cover 
the demand (if there are enough). Each supplying work order that is found is 
processed by going through the steps outlined here in a) through c).

c The work order is added to the list containing the new scheduling sequence of work orders.

d The work order is marked as processed. This prevents supplying work orders which have 
been selected as a source of supply from being reprocessed if they were selected from the 
original list. 

This results in a new scheduling sequence of work orders where the lower level supplying work 
orders are selected for scheduling before consuming work orders.

2 The parts, availability and customer demand are optionally logged to the scheduling log file.

3 Supplying work orders which have been given a higher scheduling priority are optionally logged in 
the scheduling log file.

To select Allocations settings:

1 Click the Allocations tab.

2 To schedule supplying work orders before consuming work orders, select the Allocate fabricated 
materials check box.

When you select this box, the order of all work orders is resequenced. Use the part lead-time and 
additional days fields to set a time period so that materials are available for customers whose 
desired ship date is within that period.

3 In the Add to scheduling log section, specify the information to add in the VMGLBSCH.log file:

Part allocation information – If you want to log parts, availability and customer demand to the 
scheduling log file, select the Part allocation information check box.

Work order allocation information – If you want to log supplying work orders with higher 
scheduling priorities in the scheduling file, select the Work order allocation information box if 
you want to log supplying work orders with higher scheduling priorities in the scheduling file.

4 In the During scheduling, allocate supply section, select how you want supply allocated when 
netting parts:

Non-Work Orders first – Select this option button if you want supply first allocated to all non-
work order demand (essentially customer orders). This reserves supply for customer orders that 
is not available for any work order requirements being scheduled: customer orders are fulfilled 
from the available supply pool before any work order requirements can draw supply from it.

Work Order Requirements First – Select this option button if you want do not want supply 
allocated to non-work order demand—customer orders. This leaves all supply available to fulfill 
work order requirement demand during scheduling.
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Based on Date Sequence – Select this option button if you want supply allocated according to 
demand date priority. When scheduling work order requirements, supply is allocated based on the 
demand required date. However, once supply is allocated to a work order requirement, it is NOT 
re-allocated to another work order requirement scheduled at a later time in the scheduling 
sequence, even if it has an earlier demand date. Essentially, when a work order requirement is 
scheduled, customer orders with an earlier demand date draw supply from the available supply 
pool and any remaining supply is available to satisfy the work order requirement. After the supply 
is allocated to the work order requirement, no other work order requirement can draw from that 
allocated supply, even if it has an earlier demand date.

5 In the Create Material Supply Links for Supply Within section, specify the supply links to create:

Project Warehouses – To create links to supply within project type warehouses, select the 
Project Warehouses check box.

Universal Warehouses – To create links to supply within universal type warehouses, select the 
Universal Warehouses check box.

Allocate supply even if insufficient to meet demand – To allocate supply even if you do not 
have enough supply to meet the demand, select the Allocate supply even if insufficient to 
meet demand check box.

6 If you are finished making changes to your scheduling preferences, press click the OK button.

Setting Material Scheduling Options
Using the options on the Material tab you can select how you want the material handled for 
scheduling.

To set material scheduling options:

1 Click the Material tab.

2 Select how you want material checked:

Part ID – To strictly look for the supply of the Part ID regardless of the warehouse in which it 
resides, select the Part ID option.

Associated warehouse, then set of universal warehouses – To have the associated 
warehouse checked before your universally planned warehouses, select this option.

3 To use your inventory supply before creating orders to fill that demand, select the Use Inventory 
Supply First check box.

4 To not allow supply to be netted for material that is required after its lead-time, select the Do not 
net supply for material required after its lead-time plus X days check box. In the text box, 
specify the number of days after the lead-time to not allow netting for material required. 

5 If you have finished making changes to your scheduling preferences, click the OK button.
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Creating a New Schedule
You can create as many global schedules as you need. Each can have its own set of resource 
calendars and capacities. The production schedule is used to schedule your work orders. You can 
view the others in the Scheduling Window.

1 Click the Insert Row button on the main toolbar to open a blank line in the Scheduler table.

2 Enter a Schedule ID in the Schedule ID column. Press the Tab key to continue to the next column.

3 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use for this 
schedule. If you are licensed to use a single site, this field is unavailable. 

4 Select the check box in the Infinite Capacity column if you want this schedule to have infinite 
capacity. Press the Tab key to continue to the next column.

Infinite capacity has the maximum number of supported units of capacity for every shop resource 
defined. Internally this equates to 4094 units of capacity for each resource.

5 Select the check box in the Materials Checked column if you want material availability checked for 
this schedule. Press the Tab key to continue to the next column.

6 Select the check box in the Services Checked column if you want service availability checked for 
this schedule. Press the Tab key to continue to the next column.

7 Select the Hard Release check box if you want work order release dates considered as hard 
release dates in this schedule. Press the Tab key to continue to the next column. With this check 
box selected, the Concurrent Scheduler does not schedule any activity to occur on a work order 
before the release date specified in the Manufacturing window. See the “Manufacturing Window” 
chapter.

You can specify this setting for all schedules in the site in Site Maintenance. If you select the Treat 
All Release Dates as Hard in All Schedules check box on the Scheduling tab of Site Maintenance, 
then all schedules in the site will consider work order release dates as hard dates. 

8 Select the check box in the Active column if you want to include this schedule when you choose 
the Global Schedule All Active option from the File menu. Press the TAB key to continue to the 
next column.

9 Click the Save button on the main toolbar. The remaining fields are completed when you run the 
Concurrent Scheduler.

Specifying the Production Schedule
After you create schedules, you can choose which schedule is the production schedule. If you are 
licensed to use multiple sites, you can define one production schedule per site. If you are licensed to 
use a single site, you can define only one production schedule for your enterprise.

To designate a production schedule:

1 Select the row that contains the schedule to use as the production schedule. Select a schedule 
that is not already designated as a production schedule. 

2 Select File, Define site’s production schedule.
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The Site ID associated with the schedule you selected is displayed in the dialog box header. This 
is the site for which you are designating the production schedule. You cannot create a schedule in 
one site, then use it as the production schedule in a second site.

3 Click the ID arrow and select the schedule to use for the production schedule. The list shows all 
schedules created in the site specified in the header.

4 Click Ok.

The Prod Sched check box is selected in the table.

Deleting a Schedule
1 Highlight the schedule you want to delete by clicking in the left-most column of the Schedule ID 

table.

2 Click the Delete Row button on the main toolbar.

An X appears in the left-most column on the table next to the selected line.

3 Click the Save button on the main toolbar to complete the deletion.

Activating Schedules
This feature allows a schedule to be acted on if you select the Schedule All Active option.

1 Highlight the schedule you want to activate or deactivate.

2 Either select the Active check box or click the Make Active button on the main toolbar.

A check mark appears in the Active column.

3 Select the Save button on the main toolbar to activate the schedule.

Selecting Scheduling Options

Using Weekly Calendars
Use the weekly calendar option to set calendars for all schedules, all resources, or for specific 
schedules and resources.

Setting Up Your Standard Calendar
Your standard calendar applies to all schedules and all resources. 
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If you are licensed to use multiple sites, you can set up a standard calendar on a site-by-site basis 
only.

1 Select Weekly Calendars from the File menu of the Concurrent Scheduler.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site for which you 
are defining the standard calendar. If you are licensed to use a single site, this field is unavailable.

3 Set Schedule ID to **All** and Resource ID to **All**.

If you are licensed to use multiple sites, this is equivalent to using Site Maintenance to edit the 
weekly calendar.

If you are licensed to use a single site, this is the equivalent of using Application Global 
Maintenance to edit the weekly calendar.

Setting Up a Calendar to Apply to All Resources of a Specific Schedule
1 Select Weekly Calendars from the File menu.

The Weekly Calendar dialog box appears.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site for which you 
want to set up a calendar for all resources. If you are licensed to use a single site, this field is 
unavailable.

3 Select the desired Schedule ID, and leave Resource ID set to **All**.

To setup a calendar specific to a resource, but for all schedules, select a Site ID, leave Schedule 
ID set to **All**, and set the Resource ID for the desired resource.

At any point, the Scheduler is scheduling a specific resource for a specific schedule. It searches for 
the calendar in the following order:

1 Look for a calendar specific to the schedule and the resource.

2 If not found, look for a calendar specific to the resource, but for all schedules.

3 If not found, look for a calendar specific to the schedule, but for all resources.

4 If not found, use the calendar for all resources and schedules that require definitions.

Setting Up Weekly Calendars
1 In the Concurrent Scheduler window, select Weekly Calendar from the File menu.

Note: By default, it is assumed that the 1st shift starts in the morning (AM). Therefore, for speedy 
entry of time, simply enter the hour number. For example, if the shift starts at 7:00:00 AM, you 
only need to enter 7. The rest of the entry is filled automatically.

2 If you are licensed to use multiple sites, click the Site ID and select the site for which you are 
setting up a weekly calendar. If you are licensed to use a single site, this field is unavailable.

3 From the Schedule ID list box, select the schedule for which you want to establish the calendar.

If you have not set the weekly calendar for this schedule, the calendar is blank.
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4 Click in the 1st Shift Start field next to day you want to set. Enter the time that the 1st shift starts.

5 Enter the number of hours that the resource can be used for each of the shifts.

To the Scheduler, a shift is a contiguous period of time in which an individual or team operates a 
given resource. When specifying hours per shift, you are indicating the amount of time a given 
unit of capacity is available.

If you’re defining a machine tool’s availability for each shift it is operated, overlapping is 
inappropriate because the machine is not actually available for the overlapped period for one of 
the adjacent shifts.

If a resources unavailable on a day or during a shift, put a zero (0) in it.

6 After you have entered all of the weekly scheduling information for the resource, click the Save 
button.

To delete a weekly schedule day, click the Delete button.

Setting Calendar Exceptions
Use the calendar exceptions option to set calendar exceptions for all schedules, all resources, or for 
specific schedules and resources.

A calendar exception is a holiday, planned shutdown, or other interruption of capacity that does not 
occur at regular times. If the capacity you are defining occurs in a cyclical manner (i.e. weekly), you 
should define it as a function of the weekly calendar.

1 Select Calendar Exceptions from the File menu of the Concurrent Scheduler.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site for which you 
are setting up a calendar exception. If you are licensed to use a single site, this field is 
unavailable.

3 From the Schedule ID drop down box, select the schedule for which you want to establish the 
calendar. If the exception is to affect only one resource, select the appropriate Resource ID from 
the drop down box.

If you have not set weekly calendar exceptions for this schedule, the calendar exceptions box is 
blank.

4 Click the Insert button to add an exception to the calendar.

A blank line appears at the end of the current exceptions.

5 Enter the start date and end date for the exception. For example, if the resource will not be 
available on the 25th of December, enter 12/25/12 for the start and end date.

6 Enter the 1st shift start time and the shift duration for the exception. If you are not going to operate 
the resource during the shift, enter zero (0).

The Scheduler uses the information you enter here to adjust the normal weekly calendar setting 
for the date of the exception, thereby giving an accurate estimation of resource availability.

You can edit any field by clicking in the field and making the change.
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You may either increase or decrease the shift duration for a given period of time. For instance, if 
you are going to work a half day on a Saturday, specify that for the given date by entering 8/5/01 
for the date, 8AM for the start time, and 4 hours for the first shift duration.

If you specify a particular resource and the calendar changes, three additional columns appear. 
The columns are capacity for each shift in terms of machines or individuals. This allows you to 
override (e.g. increase or decrease) the capacity of the particular resource during the period you 
specify.

7 Click the Save button to save your calendar exceptions.

To delete an exception, highlight the exception line and click the Delete button.

An X appears to the left of a deleted exception line. The exception is deleted when you click the 
Save button.

Setting Work Order Priorities
This option gives you the ability to set the priority (global rank) of firmed and released work orders. 
You can also reset the priority of these work orders by Want Date. By setting priorities, those work 
orders that you want to have first opportunity at shop resources are scheduled first. All remaining 
orders are scheduled around them.

1 Select the schedule for which you are setting up work order priorities. 

2 Choose Work Order Priority from the File menu of the Concurrent Scheduler.

If you are licensed to use multiple sites, the table shows only the work orders created in the site 
associated with the schedule you selected. If you are licensed to use multiple sites, the table 
shows all work orders eligible to be scheduled.

To browse work orders using query by example, click Search button.

3 Move to the Priority (Rank) field and enter the rank for this work order.

A rank of 50 is automatically assigned. You can edit this value. The highest priority is 0. You 
may enter any two digit number.

To have the priority set according to want date, click the Reset priority by Want Date button 

This reverts all priorities back to 50.

4 Click the Save button to save the work order priority.

You should adjust work order priority only on an exception basis. If the want date is not sufficient 
to indicate the relative priority of the work order, then use priority to increase the work order’s 
chance at receiving available capacity. You may need to give a particular work order a higher 
priority in the following situations:

a It is for your most important customer.

b It has an undependable estimated time and may take longer than expected.

Its total production time is longer than your usual work order, and competes with shorter leadtime 
orders for the same want date.
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There are also reasons you may want to reduce a work order’s priority. These decisions are 
generally unique to your business. With the existing information, the Concurrent Scheduler 
creates an appropriate schedule. When you know about external factors that affect the schedule, 
priority is your tool to adjust how the Scheduler treats work orders.

A suggested method of assigning priorities is to pick 0 for your highest priority, and then 10, 20, 
30, and 40 for groups of orders that have varying levels of priority that are less than the highest 
priority orders, but greater than the lowest (remember, 50 is the default). You can then use these 
as standard priority “buckets.” You should not attempt to assign individual priorities on an order-
by-order basis. Instead, use priority to handle special cases.

Viewing and Unfreezing Frozen Operations
Use the Frozen Operations feature to view the list of operations that are frozen in the Scheduler ID. 
You can also use this feature to unfreeze the operations that are scheduled normally when you run 
the Concurrent Scheduler.

1 In the Concurrent Scheduler window, highlight the Schedule ID for which you want to view the 
frozen operations.

2 Select Frozen Operations from the File menu.

If you are licensed to use multiple sites, the table shows frozen operations for the selected site 
only. If you are licensed to use a single site, the table shows all frozen operations.

There are two drop down boxes in this window. One is for the Schedule ID, which defaults to the 
one you highlighted in the Concurrent Scheduler window. The other is the Resource ID, which 
defaults to **All**. You can choose another Schedule ID or a specific Resource ID from the 
appropriate drop down box.

The table in this window displays all frozen operations for the chosen Schedule ID/Resource ID 
combination.

3 To unfreeze, highlight the operation and click the Unfreeze button.

An x appears in the left column beside the operation.

4 Click the Save button.

The operation you unfroze disappears from the dialog box.

Viewing Work Order Audit Details for a Schedule
Use the Show Work Order Audit option to display work order audit information for work orders in a 
schedule.

1 With the appropriate schedule highlighted, select Show Work Order Audit from the File menu.

2 From the Schedule ID list box, select the Schedule ID for which you want to view Work Order 
Audit information.

The scheduled work orders for that Schedule ID appear.
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3 Click Close when you have finished examining work order audit information.

Viewing Resource Audit Details for a Work Order in a Schedule
Use this function to view resource audit details for a work order in a schedule.

1 From the Work Order Audit Detail dialog box, click Show Detail.

The top portion of the dialog box consists of the identifying information of the part that the work 
order is for, the Work Order ID, the rank of the work order in the schedule, and the pass count.

2 Select the Show Critical Material check box to view materials that most constrain the work order 
in the schedule. For example, if there are three materials in a work order, the first with lead time of 
10 days, the second with a leadtime of 6 days, and the third with a leadtime of 25 days, the 
material with the longest leadtime—in this case 25 days—is highlighted in red to alert you that 
there may be a potential problem with the material that may result in the work order being late. 
After identifying such critical instances in a work order, you can take steps to rectify the situation.

3 Highlight a line and click Result Desc to view a list of audit result codes. These single-letter, 
unique identifiers appear in the Result column for every line item.

4 Click Close when you are done viewing resource audit details.

Copying Schedules
Use the Copy Schedule option to copy calendar and calendar exceptions and schedule information 
from one Schedule ID to another. You can also use this option to copy the schedule information from 
one Schedule ID to another.

If you are licensed to use multiple sites, you can copy one schedule to a second schedule within the 
same site only. You cannot copy a schedule created in one site to a schedule in a second site.

1 If you are licensed to use multiple sites, select a schedule in the site where you are copying 
schedules. If you are licensed to use a single site, you do not need to perform this step.

2 Select Copy Schedule from the File menu.

3 Select the schedule you want to copy from the From drop down menu.

4 Select the schedule you want to copy the original schedule to from the To drop down menu.

To copy to a brand new Schedule ID, type the new ID into the To combo box.

If you choose to copy over an existing schedule, the system asks if you want to replace the 
existing schedule.

Click Yes to continue or No to cancel.

5 Select the appropriate copy options:

Click the Calendars and Schedule radio button to copy the Calendars and Schedule of the 
chosen schedule.

Click the Calendars ONLY radio button to copy only the calendars of the chosen schedule.
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Click the Priority Settings radio button to copy the Priority Settings of the chosen schedule.

6 Click the Copy button to copy the schedule.

Click the Cancel button to close the dialog box without copying the schedule.

Purge Availability Checks
Use the Purge Availability Checks option to remove any non-released and non-firmed work orders 
and all engineering masters and quote masters that have been used to determine availability against 
a particular schedule.

These availability checks are automatically purged when you run the Concurrent Scheduler. This 
option allows you to delete availability checks without running the Concurrent Scheduler. This frees 
up the shop resources for new availability checks or new work orders that you want to schedule.

You can delete availability checks as they are done, though you may want to keep them instead. This 
is generally the case when you are checking the availability on several competing projects at once 
and need the capacity that was allocated to each one to take capacity from the other related projects. 
This option is here to remove these simultaneous checks so that additional checks can be made 
without this competing load.

1 Highlight the schedule from which you are purging availability checks.

2 Select Purge Availability Checks from the File menu.

3 Click Ok to start the purge process.

Click Cancel to return to the Concurrent Scheduler window without processing the schedule.

Viewing Scheduled Planned Orders
Use the Scheduled Planned Orders option to view all of the scheduled planned orders for selected 
Schedule IDs.

1 Highlight a Schedule ID in the Concurrent Scheduler window. This cannot be the Standard 
schedule.

2 Select Scheduled Planned Orders from the File menu.

The Scheduled Planned Orders dialog box appears. The table window within the dialog box 
displays the list of all planned orders that were processed in the Schedule you selected.

3 To remove a planned order from the schedule, highlight that order in the table window and click 
the Remove from Schedule button.
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Running the Concurrent Scheduler Manually
After you have created any new schedules and activated any existing schedules, use the Concurrent 
Scheduler to initiate a global schedule.

There are three scheduling options:

• Global Schedule
• Global Schedule all Active
• Select and Schedule Work Orders

Global Schedule requires that you select a schedule to run. The Concurrent Scheduler processes 
only one schedule using this function.

Global Schedule All Active processes all schedules that are marked as active.

Select and Schedule Work Orders lets you select the work orders you want to schedule.

Using Global Schedule or Global Schedule All Active 
Options
The Scheduler sorts all work orders eligible for scheduling (firmed and released work orders) in order 
by their priorities, want date and then release date within each priority group. Thus, if any two work 
orders have the same priority, the Scheduler uses the want date and then the release date to 
determine the sequence in which to schedule them.

The Scheduler loads only firmed and released operations and materials. It first attempts to schedule 
work orders backwards from the want date to determine if there is enough capacity and time 
(according to the calendar which applies to the schedule in question) to complete each operation.

If there is insufficient capacity and/or time to schedule each operation (i.e. one or more operations 
must start before the current date), then the Scheduler forward schedules the order to determine a 
suitable finish date. The order is then backward scheduled again, this time from the finish date rather 
than the original want date. Because it was forward scheduled moments before, the order fits.

Backward scheduling is performed so that each operation is given its latest possible start date, 
reducing your work in process value for both raw material issued to work in process and value added 
to work in process via labor.

The first work order that is scheduled has all of the capacity to itself and has the best chance of the 
Scheduler scheduling it on time. Keep in mind that it may still be impossible to satisfy your want date 
if there is insufficient time to perform the given operations starting on the current date through the 
desired want date.

Scheduling proceeds for all work orders unless you select Stop. You are prompted for confirmation 
before the scheduling process terminates.

To begin the Concurrent Scheduler:

1 Select either Global Schedule or Global Schedule all Active from the File menu. You can also 
click the Global Schedule or Global Schedule All Active buttons on the main toolbar.
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The Global Schedule All Active dialog box is similar to the one shown above, except there is no 
Schedule ID field.

2 Choose the appropriate options from the dialog box:

Enter the schedule as of date and time. The default is midnight of the current day.

Select the sort type you want; either by order want date or priority want date. The Want option 
sorts by want date; the release date priority option sorts by priority, want date, and release date.

Select the method for scheduling started work orders. You can schedule started work orders 
normally. You can schedule started work orders first without freezing these started operations. Or, 
you can schedule started work orders first and freeze these started operations.

3 Click Ok to close the dialog box and begin the scheduling process.

A dialog box appears during processing to show progress. This process can take a considerable 
amount of time, depending on the number of work orders that have to be processed.

Stopping the Scheduler causes you to lose any frozen operations. They become unfrozen and the 
Scheduler schedules them normally on the next run.

You should run the Concurrent Scheduler on a daily basis. If you leave your equipment running at 
night, you should arrange to run it each evening, so that when you come in the next morning all 
the scheduling has been done.

Scheduling Selected Work Orders
You can choose to schedule only some of the work orders. To use this option: 

1 If you are licensed to use multiple sites, select a schedule that belongs to the site for which you 
are scheduling work orders. If you are licensed to use a single site, you do not need to perform 
this step. 

2 Select File, Select and Schedule Work Orders.

3 Double-click the Work Order ID browse button and select the work orders you would like to 
schedule. You can select multiple work orders from the dialog box, or you can select work orders 
one at a time. If you plan to use the Table window order option, you may want to select work 
orders one at a time to arrange the work orders in the order you want.

The system displays the following information about each work order:

Global Rank – The system inserts the priority you set for the work order. Set work order priorities 
in the Work Order Priority dialog box.

Release Date – The system inserts the date the work order’s status was changed to Released.

Want Date – The system inserts the want date from the work order header.

Start Date – This is the date on which the first operation of the work order will start.

Finish Date – This is the date on which the work order is scheduled to be completed.
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Determinate Path Days Delay – This is the total time between the start and finish dates of the 
determinant path that is not occupied by actual scheduled production. This provides a measure of 
how much earlier your want date could be if no other work orders were scheduled to interfere with 
this one. Visually, this is the sum of the horizontal gaps between successive operations of the 
determinant path in the Scheduling Window that are not caused by weekends or other 
nonproduction time.

Total Days Delay – Similar to Determinant Path Days Delay, this is the days delay for all 
operations in the work order, not just the determinant path.

4 Select the Schedule ID.

5 Select from the following options:

Check Material Availability – Select this option to check that materials are available as part of 
the scheduling process.

Check Service Availability – Select this option to check that services are available as part of the 
scheduling process.

Treat release date as hard – Select this option to enforce the release date on the work order. 
The system schedules the work order to begin on the release date. If you clear this option, the 
system disregards the release date and schedules the work order as time and materials allow.

Freeze started operations – Select this option to freeze the schedule of any started operations. If 
you clear this check box, the system may reschedule started operations.

6 Select the order the system should schedule the work orders. Select one of the following options:

Order want date – The system schedules the work order with the earliest want date first, the 
second earliest want date second, and so on.

Priority, want date – The system schedules the work order with the highest priority and the 
earliest want date first. The system schedules all work orders with the highest priority before 
scheduling other work orders.

Priority, release date – The system schedules the work order with the highest priority and the 
earliest release date first. The system schedules all work orders with the highest priority before 
scheduling other work orders.

Table window order – The system schedules the work orders in the order in which they are 
displayed in the work order table. 

7 Click the Schedule button to schedule the work orders.

Showing Work Order Audit Information
Use the Work Order Audit option to display work order audit information for an individual work order in 
the current Schedule ID. You must activate the Work Order Audit function in the Concurrent 
Scheduler to view work order audits.

1 Click the Work Order Audit... button. 

The ID of the work order appears in the Work Order ID read-only field at the top of the dialog box.
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A list of operations and result details appears in the below table.

2 To view the results of a scheduling pass, check the Result column of each operation. The result 
column contains the single character result code for the scheduling pass.

3 Click the Result Description button to see what the results codes mean

The Audit Result Codes dialog box contains a list of audit result codes for operations in the 
current work order.

4 Select the Show Critical Material check box to highlight materials that are severely late, or 
“critical” to the work order being completed on time. Those materials become red.

5 Click the Print button to output the work order audit results to your default printer.
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Running the Concurrent Scheduler with the 
Scheduling Service
You can use the Scheduling Service to run the Concurrent Scheduler automatically on the days and 
times you specify. If you have multiple sites and would like to run the service for all sites, then you 
must install the service separately for each site. 

To specify when to run the service, use the Set as Scheduled dialog in the Concurrent Scheduler. 
You can use the service to run the concurrent scheduler up to six times a day. You also specify the 
standard settings to use to run the schedule, such as the sort order and how to schedule started work 
orders.

You can set up a run schedule for one schedule ID per site. If you attempt to set a run schedule for a 
second schedule ID in a site, a message is displayed that states that you are changing the schedule 
that is run with the Scheduling Service. 

Any user that has access to the Set as Scheduled dialog in the Concurrent Scheduler window can 
edit the run schedule for a schedule ID. The system administrator can control which users have 
access to the Set as Scheduled dialog. 

After the service is installed and the service schedule is set up, the database is examined based on 
the polling interval you specify to see if a schedule needs to be run. When the service finds a 
schedule that needs to be run, the service opens the Concurrent Scheduler and runs the schedule 
based on the settings you specify in the Set as Scheduled dialog. 

If you set up the Scheduling Service, you can still run the Concurrent Scheduler manually. 

Installing the Scheduling Service
The Scheduling Service is installed by site. If you have multiple sites, install the service for each site 
whose schedules you would like to run with the service.

The computer where you install a service must have these components installed: 

• VSRVANY.EXE – VSRVANY.EXE is a VISUAL tool that allows the service executables to be run
as a service. VSRVANY.EXE must be installed in the same directory as the service executables.
VSRVANY.EXE is installed with the VISUAL installer. 

• SC.EXE – SC.EXE is a Microsoft Windows tool used to make modifications to services and to
remove services. SC.EXE is commonly installed with Microsoft Windows. Run a Microsoft
Windows search to verify that SC.EXE is installed. SC.EXE does not have to be in the same
directory as the services executables; you can leave SC.EXE in the directory where Microsoft
installed it. 

• Gupta Runtimes – You must also have the Gupta runtimes for your version of VISUAL installed
on the computer where you run the service.

To install the service:

1 In your VISUAL executables directory, locate VMSCHSVC.EXE.

2 Perform one of these steps:
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• If you do not use single sign-on, right-click VMSCHVC.EXE and select Run as
Administrator. The Sign In dialog is displayed.

3 If you do use single sign-on, run a command prompt as the System Administrator. In the 
Command Prompt line, specify <service path>/VMSCHSVC.EXE -SYSADM. Replace <Service 
path> with the path where VMSCHSVC.EXE is installed. The Sign In dialog is displayed.

4 Specify this information:

User ID – Specify the user ID that the service uses to sign into the VISUAL database. This can be 
any valid VISUAL user ID who has access to the site for which you are setting up the service. This 
user must also have security permissions to access the Concurrent Scheduler (VMGLBSCH.exe)

Password – Specify the password associated with the user ID.

Database – Specify the database on which to run the service. 

5 Click Sign In. The name and description of the service is displayed. 

6 Specify this information:

Site ID – Specify the ID of the site whose schedules you want to run with the service.

Log File Directory – Specify where to store the log file for the service. 

Polling Interval – Specify how frequently the service should check to see if the concurrent 
scheduler should be run for the site. Specify the interval in seconds. The maximum value is 900 
seconds. If you specify a value greater than 900, your value is replaced with 900.

Log Level – Specify the level of information to write to the log file. Click one of these options:

None – To write the time the service started, click this option. This option is recommended for 
normal production environments.

Error – To write the time the service started and any error messages, click this option.

Info – To write to the time the service started, error messages, and additional information 
about the service, click this option. The use of this option is recommended only if you are 
troubleshooting issues with the service. When you use this option, the size of the log file 
grows quickly. 

The log file's name is VMSCHSVC_[Your Site Name].log. The size of the log file is limited to 1 
MB. When the log file approaches 1 MB, the log is renamed to VMSCHSVC_[Your Site 
Name]_[Current date time].log, and a new VMSCHSVC_[Your Site Name].log is created.

7 Click Install Service.

8 To install the service for another site, repeat steps 5 and 6. Repeat these steps for each site 
whose schedules you would like to run with the service. 

Scheduling the Service
After you install the Scheduling Service, specify when the Scheduling Service should be prompted to 
run schedules with the Concurrent Scheduler.
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You can set up a run schedule for one schedule ID per site. If you attempt to set a run schedule for a 
second schedule ID in a site, a message is displayed that states that you are changing the schedule 
that is run with the Scheduling Service. 

If you use multiple sites and you want to use the Scheduling Services to run schedules in all of your 
sites, you must install the Scheduling Service in each site.

To schedule the Scheduling Service:

1 Select Scheduling, Global Scheduler.

2 In the table, select the schedule that you will run with the Scheduling Service. Make sure you 
select a schedule from a site for which you have set up the Scheduling Service.

3 Select File, Set as Scheduled. The ID of the schedule you selected is displayed. 

4 If the schedule you selected is not a production schedule, then specify this information:

Infinite Schedule – To ignore any resource capacity constraints, select this check box. To factor 
resource capacity constraints into the schedule, clear this check box.

Schedule Planned Orders – To schedule planned orders generated by Material Resource 
Planning, select this check box. To omit planned orders from the schedule, clear this check box. 

5 In the Sort by section, specify the order in which to schedule the work orders. Click one of these 
options:

Order want date – Click this option to schedule the work order with the earliest want date first, 
the second earliest want date second, and so on.

Priority, want date – Click this option to schedule the work order with the highest priority and the 
earliest want date first. All work orders with the highest priority are scheduled before scheduling 
other work orders.

Priority, release date – Click this option to schedule the work order with the highest priority and 
the earliest release date first. All work orders with the highest priority are scheduled before 
scheduling other work orders. 

6 Specify this information:

Check Material Availability – To consider the availability of materials required by work orders 
when building the schedule, select this check box. To schedule work orders as if the materials are 
available, clear this check box. See "Behind the Scenes of the Scheduling Process" on page 6–37 
in this guide.

Check Service Availability – To consider the availability of outside services required by work 
orders when building the schedule, select this check box. To schedule work orders as if the 
outside services are available, clear this check box. 

Treat release date as hard – To enforce the release dates of the work orders, select this check 
box. Work orders are scheduled to begin on the release date. To disregard the release date 
schedule work orders as time and materials allow, clear the check box. 

7 In the Schedule started work orders section, click one of these options:

Normally – To schedule all started work orders with history in their original position in the 
schedule, click this option. 
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First, don’t freeze started operations – If you click this option, all started work orders are 
processed first. The sort of the started work orders is still based upon the sort selection (for 
example, Want Date). During the scheduling of these started work orders, any started operations 
are not frozen after being scheduled. They will be scheduled normally if scheduled in a later run.

First, freeze started operations – If you click this option, all started work orders are processed 
first. The sort of the started work orders is still based upon the sort selection (for example, Want 
Date). During the scheduling of these started work orders, any started operations are frozen after 
being scheduled. They will be scheduled using frozen operation scheduling logic if scheduled in a 
future run.

8 Specify when the service is active. Specify this information:

Start Date – Specify the date that the service should start checking for updates. Leave this field 
blank or specify today’s date if you do not want to delay the start of the service.

End Date – Specify the last date that the service should check for updates. Leave this field blank 
if you do not want to set up an expiration date for the service.

Enabled – To use the service with the selected schedule, select this check box. To stop using the 
service, clear this check box. 

9 In the Run Type section, weekly is selected. You cannot change this selection. This selection 
indicates that the service should check for updates only on the days and times you specify.

10 In the Days of Week section, specify the days of the week to run the service. 

11 Use the Run At section to specify the times of day that the service should check for updates. The 
times you specify apply to all days that you run the service. You can run the service up to 6 times 
a day.

Depending on the polling interval that was specified when the service was installed, the scheduler 
might not be run exactly at the time you specify. At the times that you specified, the scheduler is 
flagged as needing to be run. The scheduler is started when the scheduler service polls the 
database and finds that the scheduler needs to be run. When you specify a time, the scheduler 
could be run at any time between the time that you specify and the time that you specify plus the 
polling interval. For example, if you specify 7:00:00 as the start time and the polling interval is 600 
seconds, then the scheduler is started sometime between 7:00:00 and 7:10:00. 

12 To prevent the concurrent scheduler from running while MRP is running, select the Delay for 
MRP Processing check box. To allow the concurrent scheduler to run when MRP is running, 
clear the Delay for MRP Processing check box. 

13 Click Save. 

Coordinating MRP and Scheduling Service Schedules
Since material requirements planning and scheduling can be dependent upon each other, you can 
set up the schedules for these services to ensure that each runs only when the other is not running. 
When you set up the MRP service schedule, select the Delay for Scheduling check box to ensure that 
MRP is not run while scheduling is being run. When you set up the Scheduling service schedule, 
select the Delay for MRP check box to ensure that Scheduling is not run while MRP is being run.
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If you want to run the MRP service and Scheduling service in a particular order, you should consider 
the polling interval that you use for the services when you specify start times. When you set up a 
schedule for a service, the service may not start exactly at the run time you specify because of the 
polling interval. For example, if you specified that a service should start at 7:00:00 a.m. and your 
polling interval is 600 seconds, the service could start as late as 7:09:59. To run services in a 
particular order, the start time of the second service should be greater than the start time of the first 
service plus the largest polling interval used on the services. For example, if you set up services with 
these parameters, then the MRP service will be run before the Scheduling service: 

MRP Service

Polling Interval – 300 seconds

Run At time – 7:00:00 a.m.

Delay for Scheduling check box – selected

Scheduling Service

Polling Interval – 600 seconds

Run At time – 7:11:00 a.m.

Delay for MRP check box – selected

To make the start of the Scheduling service more predictable, you can adjust the start time of the 
Scheduling service to account for the typical duration of the MRP run. For example, if MRP typically 
takes an hour to run, you could set the Scheduling service to start an 75 minutes after the MRP 
service. Since the MRP service would be complete before the scheduled start of the Scheduling 
service, the Scheduling service would more likely start nearer to the start time you specified.

Deactivating the Service
To deactivate the service for a particular schedule ID:

1 Select Scheduling, Global Scheduler.

2 In the table, select the schedule that you are running with the Scheduling Service. 

3 Select File, Set as Scheduled. The ID of the schedule you selected is displayed. 

4 Clear the Enabled check box.

5 Click Save. 

Removing the Scheduling Service
To remove the service for a site:

1 In your VISUAL executables directory, locate VMSCHSVC.EXE.

2 Right-click VMSCHSVC.EXE and select Run as Administrator. The Sign In dialog is displayed.

3 Specify this information:
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User ID – Specify the user ID that the service uses to sign into the VISUAL database. This can be 
any valid VISUAL user ID.

Password – Specify the password associated with the user ID.

Database – Specify the database on which to run the service. 

4 Click Sign In.

5 In the Site ID field, specify the ID of the site where you no longer want to run the scheduling 
service.

6 Click Remove Service. None of the site's schedules will be run with the Scheduling Service. You 
must generate the site's schedules manually in the Concurrent Scheduler window. 
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Behind the Scenes of the Scheduling Process
What happens after you begin the scheduling process?

Unless you instruct it to do otherwise, the Concurrent Scheduler first attempts to backward finite 
schedule every work order. Backward indicates that the Scheduler initially schedules the final 
operation, then the next to last one and so forth. Finite indicates that more load is not placed into a 
time period than there is capacity in that same time period.

There are three ways to avoid this: 

• Select the Infinite Capacity checkbox for the Schedule ID. You cannot do this for the production
Schedule ID.

• Clear the Schedule normally checkbox for a Resource ID. This way, you could possibly overload
resources.

• Select the Forward Schedule from Release Date checkbox in the header card of a work order.

The duration of an operation is computed by calculating the time you need to accomplish the 
operation remaining quantity (ending quantity minus completed quantity) plus any setup time for the 
operation.

When making the initial backward finite schedule for a work order, the Concurrent Scheduler attempts 
to load the last operation of a work order so that it schedules it to finish at the end of the workday 
prior to the want date of the work order.

If load from other operations causes a conflict, making it impossible to fit the entire operation (or the 
preset “Fit tolerance” percentage of the operation), the Scheduler searches through earlier openings 
in capacity to find a slot in which the operation fits. The start date is then calculated for the operation 
based on the scheduled completion date of the operation.

If you instruct the Scheduler to Check Material Availability, it checks to make sure that all materials 
required by the final operation are available on the scheduled start date of the operation. If a 
purchase order line is linked to the material, then the due date of that line item must be before the 
proposed scheduled start date for the operation. If there is no linking and the material has a Part ID, 
then the Scheduler checks to see if a sufficient quantity of the material is available on the proposed 
start date of the operation. The Scheduler considers the quantity currently on hand, adding in all 
supply orders (including planned orders, purchase orders and work orders for fabricated components) 
that are due on or before the proposed start date, and subtracting the quantities all other work orders 
need that have been scheduled prior to this one that need the material on or before the proposed 
start date. The Scheduler uses the line item due date as the “due in” date for incoming purchase 
orders and the want date for incoming work orders that make fabricated components. It also accounts 
for demand caused by planned orders. If insufficient quantity of material is available, there is a check 
to see if there is enough time to initiate a new order by examining the part’s lead-time. Lead-time on 
the work order requirement is first looked for. If lead-time is not specified on the work order 
requirement, then the part warehouse is looked for to find lead-time. If the lead-time is not specified 
on either the work order requirement or part warehouse, then the lead-time specified for the part in 
Part Maintenance is used. If material is not available, the Scheduler stops scheduling in the backward 
direction and begins a forward finite schedule.

After the Scheduler successfully places the final operation in the backward direction, it attempts to 
load the next-to-last operation of the work order so that it finishes at the same time that it scheduled 
the final operation to begin.
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Two settings on the next-to-last operation can affect this process: minimum move quantity and move 
hours.

When minimum move quantity is not null, the Concurrent Scheduler attempts to load the next-to-last 
operation of the work order so that it schedules the last unit of the minimum move quantity to be done 
at the same time it schedules the final operation to begin. The move hours setting determines the 
minimum required offset from this optimal positioning. If needed, material availability is also checked.
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Viewing the Scheduling Results
Because scheduling is a batch process, the Concurrent Scheduler itself is limited in user interaction. 
The Scheduler takes the input you enter and processes it to suggest the optimal shop schedule. The 
input required from you is limited to making some choices about how to produce the schedule.

The main schedule viewing and analysis tool is the Scheduling Window. Schedule results also appear 
in the Manufacturing Window and Material Planning Window.

Note: You may want to consider a Windows program scheduler, which, like the Concurrent 
Scheduler, you can leave unattended. Some alternative desktop packages and automatic backup 
systems support this feature. You may want to consider this for Costing Utilities too.

Starting the Scheduling Window

The Scheduling Window lets you view the shop schedule relative to firmed and released work orders. 
Its flexibility gives you the ability to view multiple resources and schedules at the same time. If you are 
using the Concurrent Scheduler, this window is a must for viewing the results of the schedule.

Select Scheduling Window from the Scheduling menu.

A dialog box appears as the schedule is loaded. You can click the Abort button to stop the process.

If you are licensed to use multiple sites, the production schedule for your default site ID is loaded 
when you launch the Scheduling Window. You can select a different schedule in the Scheduling 
Window. If you are licensed to use a single site, the production schedule for your enterprise is loaded 
when you launch the Scheduling Window.

Understanding the Scheduling Window
The Scheduling Window uses a graph style display to provide you with a lot of useful information on 
one screen. Resources are listed on the vertical axis. For definitions of these resources, see the 
Presentation Sequence window of Shop Resource Maintenance. If you have not set a presentation 
sequence, resources appear in the order you created them. Using the navigational arrows, you can 
advance on the date axis and on the resource axis.

First shift Second shift 

Third shift capacity 
unit
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When you start the Scheduling Window, each tick-mark on the horizontal axis represents a day of the 
month. The month and year appear at the first of each month. When you zoom-in to the point where a 
day takes up most of the screen, individual hour marks appear as well. The red numbered hours are 
AM, and the black numbers are PM.

A schedule appears only starting with the first shift of the current date. The Loading Horizon 
parameter from the Edit menu controls how many days of schedule appear from today. If operations 
that have been scheduled further along seem to be missing, you may need to make this parameter 
larger.

The Shift Capacity boxes are the black outlined boxes to the right of the resource. Each box indicates 
one unit of capacity for the specific resource for each shift. One capacity unit is equivalent to the 
duration of the shift. Therefore, if you have two machines available for the 1st shift, which is 8 hours 
long, the Scheduling Window displays 2 boxes stacked vertically under the 1 (first shift) heading. This 
equals 16 hours of capacity for the first shift.

The 1, 2, and 3 markings at the top of the column represent the three shifts of the day. For example, a 
capacity box in the 1 column means the resource is available during the first shift. Note that the exact 
hours available depends upon the setting in Shop Resource Maintenance, or possibly in a calendar 
exception.

Conventions
A standard abbreviation format is used when operations appear in the Scheduling Window to indicate 
the work order Base ID, Lot ID, Split ID, Sub ID and operation sequence of the operation.

The format is:

Work Order Base ID-Sub ID/Lot ID. Split ID (Operation Sequence Number)

Operation 40 of Sub ID 3 of Work Order 40009 Lot 2 Split 1 appears abbreviated as:

40009-3/2.1 (40)

When Sub ID and Split ID are zero, they are omitted from the abbreviation. So Operation 40 of Sub ID 
0 of Work Order 40009 Lot 2 Split 0 appears abbreviated as:

40009/2 (40)

Understanding the Operation Bar Color Code
The horizontal bars in the main window represent the operations that have been scheduled to take 
place, or are in process at that shop resource.

Cyan – An on-time work order operation. The operation will be complete before the work order want 
date.
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Orange – An on-time project task (available to licensed Project users only). The task will be complete 
before the project want date.

Purple – An on-time planned order operation.

Red – A late or “just in time” work order operation. Operation’s finish date is on or after the want date 
of its work order.

Dark Orange – A late or “just in time” project task (available to licensed Project users only). The task 
will be complete on or after the project want date.

Dark Purple – A late or “just in time” planned order operation.

Blue – A frozen work order operation. Frozen operations cannot be rescheduled.

Brown – A frozen project task. Frozen tasks cannot be rescheduled.

Light Yellow – Indicates that you have selected the work order operation or project task. If the text is 
blue, the operation or task is frozen. When you select an operation or task, the system highlights the 
dates at the top of the scheduling window that work is scheduled to occur on the operation or task. 
The system also highlights the resource on the left of the window.

Dark Yellow – Indicates that you have selected a work order operation or project task that is late. If 
the text is blue, the operation or task is frozen. When you select an operation or task, the system 
highlights the dates at the top of the scheduling window that work is scheduled to occur on the 
operation or task. The system also highlights the resource on the left of the window.

Green – Operation or task is part of the determinant path and is on time. If the text is blue, the 
operation or task is frozen.

Dark Green – Operation is part of the determinant path, and will be late or just in time.

If there are large differences between the durations of operations (for example, one is for an hour, 
and another is for a day or days) the bars for the short operations may be very narrow. You can use 
the right-mouse button function even on these tiny bars. You can also use the zoom-in function in the 
View menu, or the plus (+) key, to zoom in until the bar is larger.
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Tooltip Information
When you place the cursor over an operation or project task, the system displays the tooltip window. 
The tooltip window shows basic information for the operation or project task, including the part, work 
order operation number, the start and finish date, the want date, the material requirements, 
availability, and whether the operation is determinant. For project tasks, the system also displays the 
associated WBS code. If a work order is attached to a project task, the system displays the linked 
project task.

You can deactivate the tooltip window. If you are currently using the tooltips, select Info, Show 
Tooltips to clear the check mark next to the Show Tooltips menu item. To reactivate the tooltip 
window, select Info, Show Tooltips again. 

Setting Scheduling Window Options
You can set a variety of options to customize the Scheduling Window to your needs. You can find 
many of these options under the Options menu.

All of the selections under the Options menu toggle between being active and inactive. A check mark 
to the left of the menu selection indicates that it is currently active. Select a menu option to activate it; 
select the menu option again to deactivate it.

Showing Part IDs
You can view Part IDs in Operation Bars and at the top of display windows by selecting Show Part 
from the Options menu. Before Part IDs appear, though, you must select Refresh from the File menu.

Many of the menu selections under the Options menu also have corresponding buttons on the 
Toolbar. See the “Using the Toolbar” section later in this chapter.

Showing/Hiding Capacity
Activate the Show Capacity option if you want the Scheduling Window display to include a graphical 
display of capacity available on a daily basis.

Click the Capacity button to show/hide capacity.

Showing/Hiding Operations
Deactivate the Show Operations option when you do NOT want to see load against capacity for a 
Schedule ID and to make it easier for you to see the capacity display.

Click the Operations button to show/hide operations.
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Showing/Hiding the Grid
Activate the Show Grid option to display a black vertical line within the display at midnight of each 
day, with a thicker black line at midnight on Sunday.

Showing/Hiding the Status Bar
Activate Show Status Bar to display a status bar at the bottom of the display. When you right click a 
push button in the tool bar, a brief description of the function of that button appears in the status bar. 
As you drag an operation to a different date and time, the status bar displays the time and date upon 
which you are about to drop the operation.

Setting Scheduling Window Preferences
You can set a number of preferences for the Scheduling Window. All of these preferences apply only 
to the computer at which you set them.

1 Select Preferences from the Options menu.

2 Select from the following options:

Load Horizon – Enter the Load Horizon you want to use as a default when you first open the 
Scheduling Window. You can also set the load horizon by selecting Load Horizon from the Edit 
menu.

Drag and Drop – Activate this checkbox if you want a confirmation dialog box to appear when 
you drop a dragged operation.

Exit – Activate this checkbox if you want a confirmation dialog box to appear when you choose to 
exit the Scheduling Window.

Show Grid Lines – Check this box if you want to activate the “Show Grid” option when you first 
open the Scheduling Window.

Show Military Time – Check this box if you want the time portion of scheduled operation start 
and finish dates displayed in 24 hour clock format rather than with an AM/PM designation.

‘D’ – Determinant Path – Activate this checkbox to filter Determinant path schedule passes out of 
the Work Order Audit Detail display.

‘N’ – No result – Activate this checkbox to filter ‘No result’ attempts out of the Work Order Audit 
Detail display.

Using the View Menu 
Use the options in the View menu to help you find the information you want to view in the Scheduling 
Window. 
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Setting the Display Date 
Use the Date option to set the earliest displayed date to any date after the “as of” date of the current 
Schedule ID. Using this option can be quicker than scrolling.

1 Select Date from the View menu or click the Date button on the main toolbar.

2 Enter the start date, or click the Calendar button to bring up a calendar. Select a date from the 
calendar.

3 Click Ok to set the start date, or Cancel to close the dialog box without setting the start date.

Using the Home Option
Use the Home option to set the earliest displayed date to the “as of” date of the current Schedule ID.

Select Home from the View menu.

The display date is set to the “as of” date.

Zooming In/Out
Use Zoom In to view a smaller number of days in the display. This makes it easier to see the load 
exerted by short operations. You can use this option a maximum of six times in succession from the 
default resolution. The fifth and sixth highest resolutions display time of day in addition to date.

To zoom in, click the Zoom in button on the main toolbar.

Use Zoom Out to view a larger number of days in the display. This makes it easier to view operations 
and work orders of long duration on a single screen. You can use this option once from the default 
display resolution. The window then displays approximately six weeks of load and capacity on a 
standard 640 X 480 resolution monitor.

To zoom out, click the Zoom out button on the main toolbar.

You can also use the mouse wheel to zoom in and out. Hold the CTRL key down, then use the mouse 
wheel to adjust the zoom level.

When you close the Scheduling Window, the system retains the zoom level you set. When you next 
open the Scheduling Window, the zoom level will be the same as when you last exited the window. 

Setting Shop Views 
Use the Set Shop View option to limit the resources displayed to a subset of all possible resources. 
You can define shop views in Shop Resource Maintenance.

1 Select Set Shop View from the View menu.
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2 Choose a shop view from the drop down list box to display the list of resources belonging to that 
shop view.

Select ***Full View*** to display load and capacity for all defined resources that were processed 
in the current Schedule ID. When you first open the Scheduling window, it defaults to showing the 
last shop view that appeared on that computer.

3 Click Ok to select that view, or Cancel to close the dialog box without selecting a view.

Using Animation Mode
Use Animation mode to step through the painting of the Scheduling Window display one work order or 
one operation at a time. The work orders and operations appear in the position at which each was 
successfully scheduled, starting with the focus operation.

This is one way you can view what the load against capacity was before an operation was 
successfully scheduled. Only the load for all operations that were scheduled prior to the focus 
operation in the current Schedule ID and the focus operation appear.

Note: If you filtered the Scheduling Window using the options available in the Info menu, the 
Animation Mode may not function as you expect. The Next Operation and Next Work Order buttons 
consider all scheduled operations and work orders, not just the work orders or operations that meet 
your filter criteria. As a result, clicking the Next Operation or Next Work Order buttons may not seem 
to have an effect in the Scheduling Window. We recommend clearing any filters before you enter 
Animation Mode.

1 Select Animation Mode from the View menu or click the Animation button on the main toolbar.

The Scheduling Window removes all information from the window display.

2 Click the Next Operation button or select Next Operation from the View menu to display only the 
next operation as it was successfully scheduled (which may be the first operation of the next work 
order in the schedule, if the current one is the last one on its work order).

Click the Next Work Order button or select Next Work Order from the View menu to paint the 
remaining operations of the current work order.

The respective Previous functions work the process in reverse.

3 Select Animation Mode again to exit Animation mode.

Using Audit Mode
Use the Audit mode to view attempts at scheduling operations, starting with either the first or last 
operation of the work order to which the focus operation belongs.

Whether Audit mode begins with the first or last operation depends on whether the Concurrent 
Scheduler forward or backward scheduled the work order initially. The results of all attempts prior to it 
are processed and painted. This is a way to view what the load against capacity was before an 
operation was attempted to be scheduled.
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Note: If you filtered the Scheduling Window using the options available in the Info menu, the Audit 
Mode may not function as you expect. The Next Operation and Next Work Order buttons consider all 
scheduled operations and work orders, not just the work orders or operations that meet your filter 
criteria. As a result, clicking the Next Operation or Next Work Order buttons may not seem to have an 
effect in the Scheduling Window. We recommend clearing any filters before you enter Audit Mode.

1 Select Audit Mode from the View menu.

All graphical scheduling information is removed from the Scheduling Window. An Operation Audit 
dialog box is displayed with operation information. The first (for forward scheduling) or last (for 
backward scheduling) operation has the focus.

2 Use the Next Operation function to move to the next attempt for the same work order.

Use the Next Work Order function to fast forward through all attempts for the current work order 
to the first attempt for the next work order.

The respective Previous functions work the process in reverse.

Synchronizing Windows
Use Synchronize Horizontal and Synchronize Vertical when you have two or more schedule 
windows open at the same time. The Synchronize commands “lock” the two windows together when 
you scroll. This allows you to view both schedules together when you are scrolling.

To synchronize multiple windows:

1 Select Tile Horizontal from the Window menu.

All of your open windows appear, from the top to bottom.

2 Select Synchronize Horizontal from the Window menu.

3 Now scroll one of your windows.

All of the other windows now scroll along with the one you are scrolling.

Select Synchronize Vertical when you want to scroll up and down the lists of resources in more 
than one schedule window.

Setting the Load Horizon
You can control how many days the Scheduling Window displays load from the current date. If you 
have operations that can be scheduled further out, you may need to adjust the loading horizon.

You must edit the loading horizon BEFORE loading a schedule.

1 Select Loading Horizon from the Edit menu.

2 Enter the load horizon in days. Click Ok.

3 Load the Schedule ID.
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The Schedule ID appears in the Scheduling Window. A solid blue vertical line appears in the 
window at the point in the schedule at which the horizon occurs.
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Scrolling
You can scroll the Scheduling Window left and right and up and down in the following ways:

• Use the scroll bars on the right and bottom of the window.
• Use the mouse wheel. The mouse wheel by itself scrolls the window up and down. Hold down the

Shift key while using the mouse wheel to scroll the window left and right. 
• Drag the window. Position the cursor over a blank space (that is, not over an operation or task) in

the Scheduling Window. The cursor changes to a hand. Click and hold the mouse button. The
hand cursor changes to indicate that it has “grabbed” the window. Move the mouse to scroll the
window. 
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Filtering Information in the Scheduling Window
Use the options in the Info menu to filter the information that the system displays in the Scheduling 
Window. 

Highlighting Work Orders
When you highlight a work order, the program shows the operations for the highlighted order in yellow 
(light yellow for operations scheduled before the order’s want date, bright yellow for operations 
scheduled after the order’s want date). 

This makes it easier for the user to identify the operations belonging to a particular work order during 
the user’s analysis of that Work Order’s schedule.

You can highlight a work order in two ways: enable the Highlight Work Orders on Select feature or 
using the Set Highlight Work Order dialog box to select a specific work order.

Highlighting Work Orders Using Highlight Work Orders on Select
When you enable this feature, the system highlights the work order when you click an operation or 
task in the scheduling window. To enable this feature, select Info, Highlight Work Order on Select. 
The system places a check box next to the menu item.

HIghlighting Work Orders the Using Set Highlight Work Order 
Dialog Box
To highlight a specific work order using the Set Highlight Work Order dialog box:

1 Select Set Highlight Work Order from the Info menu.

The system lists all firmed and released work orders.

2 Select the work order you want to highlight.

3 Click OK.

The Scheduling Window returns. The horizontal bars for the highlighted work order are yellow. 
Operations that have been scheduled on time are light green. Late operations are a darker yellow.
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Viewing Highlighted Work Orders
If you would like to view the highlighted work order in the Manufacturing Window or the highlighted 
project in the Project Window, select Info, View Highlighted Work Order. You can also press 
Shift+F9.

Highlighting the Determinant Path
Use Highlight Determinant Path from the Info menu to highlight the operations along the 
determinant path for the highlighted work order.

The determinant path is the set of operations in a work order that controls the duration of the work 
order. This is measured AFTER the resource constraints have been taken into account. A path that 
you measure before considering these constraints could be called a “critical path.”

To highlight the determinant path:

1 Click an appropriate work order to give it the focus.

2 Select Highlight Work Orders on Select from the Info menu.

The operation becomes highlighted.

3 Select Highlight Determinant Path from the Info menu.

The operations along the determinant path are highlighted. The determinant path operations 
appear in the Scheduling Window as green bars. Determinant path operations that are late 
appear as olive bars.

Highlighting Operations
You can choose to view only those operations that are late or just in time. You can also choose to 
view any operation associated with a late work order, whether the operation itself is late or not.

To view all late operations, select Highlight Late Operations from the Info menu.

All late operations are highlighted in red. 

If you are just beginning to implement scheduling and have a large number of late work orders, you 
may want to deactivate this option until you have been running scheduling regularly.

To view all operations associated with a late work order, select Highlight All Operations for Late Work 
Orders. 

Any late operations are highlighted in red. If the operation itself is on time, then the operation is 
highlighted in purple.
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Showing Work Orders and Projects
If you are licensed to use Projects features, you can choose to view only project-related information. 
Use the following options to filter the information that the system displays:

Show Work Orders and Projects – Select this option to view all projects and work orders.

Show Work Orders – Select this option to view work orders only. The system does not display any 
scheduled projects as defined in the Project window, but it does show any work orders associated 
with a project. It also shows all non-project related work orders.

Show Projects – Select this option to view projects only.

Include Project Work Orders – The system activates this option if you select the Show Projects 
option. Select Include Project Work Orders if you would like to view any work orders associated with 
projects.

Show Work Orders by Task – The system activates this option if you select the Show Projects 
option. If you select this option, the system displays any work orders associated with the project task 
you select.

Showing the Focus Work Order
You can limit the Scheduling Window to display only the operations of the work order to which the 
focus operation belongs and the resources those operations use. This option is very useful to 
examine the schedule for a single work order that might otherwise require you to scroll the display.

To show only the focus work order and related information:

Select Show Focus Work Order from the Info menu.

The Scheduling Window removes all other information and displays only the focus work order 
operations and the resources used by those operations.

Showing All Work Orders
Showing all work orders is the default behavior of the Scheduling Window. Use the Show All Work 
Orders command to leave the Show Focus Work Order mode.

Showing Resource Details
Use the Show Resource Detail option to view the list of ALL work order operations that have been 
scheduled in the resource referenced by the focus operation.

1 Focus on a particular resource by pointing and clicking on an operation associated with that 
resource.

2 Choose Show Resource Detail from the Info menu.
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The window contains the following information:

Start Date – The Concurrent Scheduler determines this start date for this schedule.

Finish Date – The Concurrent Scheduler determines this end date for this schedule.

Work Order ID – Job ID-Sub ID/Lot ID. Split ID for the work order leg containing the operation. 
Sub ID and Split ID are only shown if they are not zero.

Sequence Number – Operation sequence number.

Setup – Is the setup complete for this work order? Yes or No?

Start Quantity – Incoming quantity to the operation from the previous one.

End Quantity – Outgoing quantity required of the operation.

Completed Quantity – Quantity of acceptable pieces that you have completed so far.

Setup Hours – Setup hours for the operation.

Run Hours – Calculated run hours for the operation.

Move Hours – Hours you require between end of run and start of next operation.

Part ID - The part ID on the work order header. To view the part in the Part Maintenance window, 
click on the drill-down arrow.

Part Description - The description associated with the part.

Customer ID - The customer ID of the customer order allocated to the work order. To view the 
customer in the Customer Maintenance window, click on the drill-down arrow.

Customer Name - The name associated with the Customer.

Customer Order - The Order ID of the customer order allocated to the work order. To view the 
customer order in the preferred Customer Order Entry window, click on the drill-down arrow.

The Multiple Links text is displayed when more than one customer order allocation is associated 
with the work order. Click on the drill-back arrow to view the linked customer orders in the Select 
Linked Order to View window.

3 If you want to view the work order for an operation, select it from the window and choose View 
Selected Work Order from the Info menu.

The Manufacturing window appears with work order information.

4 Select Exit from the File menu to return to the previous window.

Select Linked Order to View
Use the Select Linked Order to View window to view all customer orders allocated to a specific work 
order. The window includes this information:

Customer ID - The customer ID of the customer order allocated to the work order. To view the 
customer in the Customer Maintenance window, click on the drill-down arrow.

Customer Name - The name associated with the Customer.
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Customer Order - The Order ID of a customer order linked to the work order. To view the 
customer order in the preferred Customer Order Entry window, click on the drill-down arrow.

Alloc Qty - The allocated quantity associated with the allocation link.

Showing Operation Details
This feature allows you to view a specific operation in a work order.

1 Focus on a particular operation by pointing and clicking on the appropriate operation.

2 Select Show Operation Detail from the Info menu.

You can also display an operation by double-clicking on the appropriate operation.

All of the information in the top sections of the window is identical to that already defined in the 
Manufacturing Window Operation dialog box. The Concurrent Scheduler determines Start and 
Finish dates. The Quantity shown is the End Quantity. Completed is the quantity that you report 
complete in Labor Ticket Entry.

3 Use the NEXT or PREV buttons to show the subsequent or proceeding operation in the same 
Work Order leg.

For example, if you have a Work Order with two legs (i.e. sub_ids), each having operations 10, 
20, 30, and 40, and you are looking at operation 20 of Sub ID 1 (the second leg), use NEXT to 
display operation 30. If you choose PREV, operation 10 appears.

Showing Work Order Audit Information
Use the Show Work Order Audit option to display the work order audit information for all work orders 
in the current Schedule ID. You must have activated the Work Order Audit function in the Concurrent 
Scheduler to view work order audits.

1 Select Show Work Order Audit from the Info menu.

2 You can view detailed information for an individual work order by selecting the appropriate work 
order and clicking on the Show Detail button.

3 Click the Close button to close the dialog box.
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Rescheduling Operations

Rescheduling Operations Using Drag-and-Drop
You can change the scheduled start or finish dates of an operation. You can do this manually by 
typing in either a start date and time or an end date and time, or if you are working with a what-if 
schedule, you can use the drag-and-drop feature to reschedule operations.

Note: You cannot use drag-and-drop functionality to reschedule operations in Production schedules.

To change the start/finish date of an operation using drag-and-drop:

1 In the Scheduling Window:

• To change the start date, click in the left-hand half of the display bar closest to the start of the
operation. Keep the mouse button depressed.

• To change the finish date, click in the right-hand half of the display bar closest to the finish of
the operation. Keep the mouse button depressed.

An arrow appears, indicating that you are changing the start/finish date of the operation.

2 With the left button depressed, move your mouse to the new date. This is “dragging” the 
operation.

The status bar at the bottom of the Scheduling Window displays the new start/finish date and time 
of the operation. Release the left mouse button to affect the scheduling change.

3 When you have moved the operation to the new date, release the left mouse button. This is 
“dropping” the operation.

If you have confirmation enabled in your preferences, you are prompted to confirm the drop.

You can cancel a drop by clicking on the right mouse button before you release the left mouse 
button.

4 Click Yes to confirm the drop, or No to cancel.

After you drop the operation, the operation may be resized and marked as frozen, depending on 
the capacity where you drop it. The Scheduler does not reschedule that operation from its position 
unless you later choose to unfreeze it.

The Scheduler unfreezes a frozen operation and reschedules it if the frozen finish date is less 
than the schedule As Of date. The Scheduler adjusts the duration of frozen operations based on 
the remaining quantity.

Rescheduling Operations Using Menu Commands
You can also change scheduled start and finish dates for an operation by using menu selections.

1 Click the operation you want to reschedule.
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2 Select Freeze Operation Manually from the Edit menu.

3 Select the Start or Finish date radio button.

4 Enter the rescheduled date and time for the operation.

5 Click OK to complete the procedure, or Cancel to close the dialog box without rescheduling the 
operation.
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Changing Resource Capacity
You can change resource capacity for any of the resources in the displayed schedule.

You can choose to increase or decrease the capacity of a resource. You can also choose to decrease 
or increase the capacity of a second resource to correspond with the capacity change of the first 
resource. For example, you can choose to increase the capacity of Resource A by decreasing the 
capacity of Resource B.

Changing the Capacity of a Single Resource
Use the following procedure if changing the capacity of a resource does not affect a second resource. 
You can choose to increase or decrease the resource capacity.

If you are licensed to use multiple sites, you can change the capacity of a resource on a site-by-site 
basis.

1 With the Scheduling Window loaded with the appropriate schedule, scroll the Scheduling Window 
until the date range you want to use is in view. Use the Zoom In feature to view fewer dates; use 
the Zoom Out feature to view more dates. 

2 Hold down the Shift key, then click and hold down the left mouse button in a portion of the window 
that corresponds to both the resource you want to change and the first date that you want to 
change resource capacity. Holding down both the shift key and the left mouse button, drag your 
cursor to the last date that you want to change resource capacity. 

In the above example, capacity change is planned for Jan 1 – Jan 4.

If you are unsure that you selected the proper dates, you will have an opportunity to review and 
change them.

3 Release the Shift key and mouse button. The system opens a dialog box asking if you would like 
to pick a second resource that will receive the inverse of the resource capacity change you make.  
Click Ok without selecting a second resource. 

4 From the Affected Schedule ID list box, select the schedule for which you want to change 
capacity.

Select All to make this change for all active schedules.

5 If the box you dragged did not span the correct range of dates, manually enter a date range for 
the capacity change in the Start and End Date of Capacity fields.

Selecting the Always check box renders the above three fields unavailable. If you select Always, 
you cannot specify a date range or Schedule ID because the capacity adjustments you make 
below will affect all schedules, at all times – or “always.”
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6 If the start time of day is different, modify the start time. The start time of day from the calendar 
exceptions is used for the specified resource.

7 From the Change section, select the appropriate radio button. If you want to increase resource 
capacity, select the Increase (specified resource) radio button. If you want to decrease resource 
capacity, select the Decrease (specified resource) radio button.

8 In the Capacity Change field, enter the capacity change for the selected resource. 255 is the 
maximum capacity per resource unless it is a grouped resource.

9 Select the shift(s) you want this capacity change to affect. You can select all three or any 
combination of the three.

10 Click the Ok button to commit the change of the selected resource’s capacity.

The Scheduling window is reloaded to show the modified resource capacity.

Increasing Resource Capacity that Affects a Second 
Resource
Use the following procedure if increasing the capacity of one resource results in the reduction of 
capacity of a second resource.

If you are licensed to use multiple sites, you can use this feature within the same site only.

1 With the Scheduling Window loaded with the appropriate schedule(s), scroll the Scheduling 
Window until the date range you want to use is in view. Use the Zoom In feature to view fewer 
dates; use the Zoom Out feature to view more dates. 

2 Hold down the Shift key, then click and hold down the left mouse button in a portion of the window 
that corresponds to both the resource that will be affected by the increased capacity of a second 
resource. For example, if increasing the capacity of Resource A means that the capacity of 
Resource B must be decreased, click in the area of Resource B. Holding down both the shift key 
and the left mouse button, drag your cursor to the last date that you want to change resource 
capacity. 

In the above example, capacity change is planned for Jan 1– Jan 4.

If you are unsure that you selected the proper dates, you will have an opportunity to review and 
change them.

3 Release the Shift key and mouse button. The system opens a dialog box asking if you would like 
to pick a second resource that will receive the capacity change you make.This is the resource 
whose capacity you want to increase. For example, if you specified Resource B in step 2 with the 
intention of increasing Resource A’s capacity, click Resource A in the list of resources on the left 
of the Scheduling Window. 
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The system opens the Change Resource Capacity dialog box. The system deactivates the 
Decrease option button. The system inserts the name of the resource you chose in step 3 next to 
the Increase label. The system inserts the name of the resource you chose in step 2 next to the 
Decrease check box label.

4 From the Affected Schedule ID list box, select the schedule for which you want to change 
capacity.

Select All to make this change for all active schedules.

5 If the box you dragged did not span the correct range of dates, manually enter a date range for 
the capacity change in the Start and End Date of Capacity fields.

Selecting the Always check box renders the above three fields unavailable. If you select Always, 
you cannot specify a date range or Schedule ID because the capacity adjustments you make 
below will affect all schedules, at all times – or “always.”

6 If the start time of day is different, modify the start time. The start time of day from the calendar 
exceptions is used for the specified resource.

7 From the Change section, select the Decrease check box if you want to decrease the capacity of 
the specified resource by the amount you are increasing the capacity of the resource specified 
next to the Increase option button. 

8 In the Capacity Change field, enter the capacity change for the selected resource. 255 is the 
maximum capacity per resource unless it is a grouped resource.

9 Select the shift(s) you want this capacity change to affect. You can select all three or any 
combination of the three.

10 Click the Ok button to commit the change of the selected resource’s capacity.

The Scheduling window is reloaded to show the modified resource capacity.
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Displaying Additional Schedules
You can load more than one schedule into the Scheduling Window. Viewing more than one schedule 
in the Scheduling Window makes it easier to analyze the differences between the schedules. This 
can help you decide which schedule would work best for you. 

If you are licensed to use multiple sites, you can load schedules from different sites.

To load additional schedules:

1 Select Load Schedule ID from the File menu or click the Load a Schedule button on the main 
toolbar.

2 Select the new schedule you want to display.

3 Select one of the Action radio buttons:

Select Replace Current Window to replace the current window by creating a new window 

Select Create New Window to create a new window while leaving the old window open.

Select Add to Current Window to add the new schedule to the existing window.

You can add up to three schedules to the same window. After that, you must create a new window 
to add another schedule, or replace the current window with the new schedule.

4 After you have made your selections, choose Ok.

Each schedule that appears in the window is stacked for each resource vertically. The background 
color indicates to which schedule the bars belong. This allows you to compare schedules for each 
resource separately.

The Synchronize Windows option in the Window menu controls how scrolling behaves when you are 
showing multiple schedule windows. If you set this option (a check mark appears in the menu), the 
vertical and horizontal scroll bar for either window causes both windows to scroll. This keeps the 
windows in synch by resource and by date/time. If you have not checked this option, each window 
scrolls independently.

Loading Infinite Schedules
You can quickly display an infinite schedule that you defined using the Concurrent Scheduler by 
selecting the Load Infinite Schedule option from the File menu. The schedule is added to the 
existing schedule.

If you have multiple infinite schedules defined, the first infinite that occurs in the database is picked 
and displayed. If you select the option again, the next infinite schedule is added to the display.
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Copying Schedules
Using Copy Schedule from the Edit menu, you can create a new schedule or copy information from 
one schedule to another.

1 Select Copy Schedule from the Edit menu.

2 Select the schedule you want to copy from the From drop down menu.

3 Select the schedule you want to copy the original schedule to from the To drop down menu.

To copy to a new Schedule ID, type the new ID into the To combo box.

If you choose to copy over an existing schedule, the system displays a dialog box asking if you 
want to replace the existing schedule. Click Yes to replace the schedule, or No to cancel the copy 
procedure.

4 Select the appropriate copy options:

Click the Calendars and Schedule radio button to copy the calendars and schedule of the 
chosen schedule.

Click the Calendars ONLY radio button to copy only the calendars of the chosen schedule.

Click the Priority Settings radio button to copy only the Priority Settings of the chosen schedule.

5 Click the Copy button to copy the schedule.

Click the Cancel button to close the dialog box without copying the schedule.

Deleting Schedules
Use Delete Schedule to delete a Schedule ID and its contents from the database. To delete a 
schedule:

1 Select Delete Schedule from the Edit menu or click the Delete button on the main toolbar.

2 Highlight the Schedule ID for the schedule you want to delete.

3 Click the Delete button to delete the schedule, or Cancel to close the dialog box without deleting 
the schedule.
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What is Labor Ticket Entry?
Use Labor Ticket Entry to record labor transactions. Labor transactions serve three major purposes:

• Records the accumulation of direct labor hours expended against a work order. If you are using
actual costing, this data is used to calculate actual labor costs and resource burdens for the work
order. If you are using standard costing, this data is used to report the accumulation of cost and in
computing the variance between standard and actual costs.

• Records current work order status. Labor ticket transactions for direct labor indicate whether the
setup and/or run for a given operation of a work order is completed, and also the current number
of pieces completed. Thus, the correctness of the system’s knowledge of current shop status
depends upon timely entry of labor ticket transactions.

• Records the accumulation of indirect labor hours. Labor Ticket Entry also allows the recording of
indirect labor hours. This includes time logged for meals, breaks, meetings, or other time not
specific to a work order. You can transfer these transactions to a special indirect labor journal
using the Costing Utilities.

Note that Labor Ticket Entry is NOT a tool for entering employee payroll information. However, you 
can export employee time tickets from Labor Ticket Entry to the Payroll module. Also, if you are 
placing labor transactions for all the time an employee works, you may use the reports provided by 
the Labor Ticket function to derive payroll attendance data.

You can enter Labor Ticket transactions in three different ways:

• Labor Ticket Entry – This is the standard application for entering labor ticket data using the
keyboard and mouse.

• Barcode Labor Ticket Entry – This special application works with a barcode keyboard wedge.
This is a device that plugs into the keyboard line of a standard PC, and allows you to use
barcoding without any other special equipment.

• Remote Barcode Labor Ticket Entry – This application allows you to enter labor data using a
data collection device located at a distance from the computer. A small text display provides the
instructions and feedback required to make the entries.

For more information, refer to “Barcode Labor Transactions” on page 9-1 in this guide.

Both types of barcode entry provide subsets of the total Labor Ticket Entry function.

You can also create labor tickets in VISUAL Time & Attendance.

You must perform certain tasks, such as deleting a ticket or over-reporting time, using the standard 
Labor Ticket Entry application.

Prior to using Labor Ticket Entry, you should have already entered information about all employees 
who are reporting labor. 

Starting Labor Ticket Entry
Labor Ticket Entry is available from the Main window or your Personal Menu Toolbar.

To start Labor Ticket Entry:
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Select Labor Ticket Entry from the Eng/Mfg menu.

Labor Tickets in a Multi-site Environment
If you are licensed to use multiple sites, you must first assign employees to sites before they can 
enter labor tickets. After you add employees to sites, the employees can enter labor tickets for work 
orders created in their assigned sites.
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Setting Up Labor Reporting
You can set up labor reporting preferences in Labor Ticket Entry, Site Maintenance, and the 
Manufacturing Window. 

Use the settings available in the Administrator Setup dialog in Labor Ticket Entry to set up personal 
preferences. The preferences that you specify are applied to your user ID only and are also stored in 
Preferences Maintenance. This table shows the settings that you can specify in the Administrator 
Setup dialog:

Setting Description

Automatically compute qty complete

Select this check box to automatically calculate 
the quantity complete by dividing the elapsed 
hours of the labor ticket by the run time of the 
operation. The calculation can result in 
fractional quantities. 
When the total elapsed hours for all labor 
tickets for the operation exceed the estimated 
time for the operation, the Run Complete check 
box is selected and the operation is closed. 
If the Quantity Complete by Hours check box 
has been selected on the operation to which 
you are reporting labor, then the Automatically 
Compute qty complete setting is ignored. The 
Quantity Complete by Hours check box can be 
selected on the operation itself, on the work 
order header, or in Site Maintenance. 

Use Decimal time format

Select this check box to use the last two digits 
of a four digit number as a percentage of an 
hour. For example, if you type 1250 into the 
Clock Out field, 12:30 is entered into the field. 
The 50 is interpreted as 50% of an hour.
If you clear the check box, then the last two 
digits are read as minutes. If you type 1250 into 
the Clock Out field, then 12:50 is entered into 
the field.

Edit qty complete vs. standard

Select this check box to specify a quantity 
complete that is greater than the quantity 
specified for the operation. Use the Allowable 
percentage over standard field to specify the 
amount over the operation quantity that you 
can enter.
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Use the settings available in Site Maintenance and the Manufacturing Window to set up these labor 
reporting functions:

Allow reporting to obsolete resource

Select this check box to create labor tickets for 
obsolete resources. A message is displayed if 
you attempt to create a labor ticket for an 
obsolete resource, but you can save the labor 
ticket. If you clear this check box, you cannot 
create a labor ticket for an obsolete resource. 

Function Set up

Report labor by percentage complete 
instead of quantity complete. 
Replace the Qty Remaining and Qty 
Completed fields with Percent Remaining and 
Percent Completed fields. 

Select the Percent Complete check box

Enable automatic calculation of quantity 
complete based on hours. 
Automatically calculate quantity or percentage 
complete based on the number of hours 
reported on the labor ticket. 
This feature functions in the same way as the 
quantity complete function available in the 
administrator set up of Labor Ticket Entry,.

Select the Quantity Complete by Hours check 
box.

Deactivate automatic closing of operations. 
Automatically stop calculating the quantity or 
percentage at a threshold that you specify. 
This feature is useful if you engineer to order 
and actual time spent on operations frequently 
exceeds the estimates. When you specify a 
threshold, the automatic calculation stops when 
the threshold is reached. The operation 
remains open, and the remaining time remains 
on your schedule. 
To close the operation, the user must select the 
Run Complete check box on the labor ticket or 
manually update the completed quantity to 
100%. You can also change the status of the 
Operation to closed in the Manufacturing 
Window. 

Select the Quantity Complete by Hours check 
box.
Specify a value in the Max Percent Completed 
field. 

Setting Description
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The settings that you specify at the site level are used for all masters and operations in the site. If you 
do not specify settings at the site level, then you can specify settings on the header card on masters 
and work orders. Settings that you specify on the header card are applied to all operations in the 
master or work order, including operations in legs. If you do not specify settings at the site level or 
header card level, you can specify settings on individual operations.

Setting Personal Preferences in the Administrator Setup 
Dialog
The preferences that you specify in the Administrator Setup are personal preferences. They are 
associated with your user ID. You can also manage these settings in the LaborEntry section in 
Preferences Maintenance.

Note: The System Administrator can designate that certain preferences are global. Individual users 
cannot change global preferences. If the edits that you make in the Administrator Setup dialog are not 
saved, then the preferences are likely global preferences.

1 Select Eng/Mfg, Labor Ticket Entry. 

2 Select File, Administrator Setup.

3 Select these options in the dialog:

Automatically Compute Quantity Complete – Select this check box to automatically calculate 
the quantity complete by dividing the elapsed hours spent on the operation by the run time of the 
operation. Clear this check box to manually specify the completed quantity. 

This setting can be overridden by settings in Site Maintenance and the Manufacturing Window.

Use Decimal Time Format – Select this check box to use the last two digits of a four digit number 
as a percentage of an hour. Clear this check box to use the last two digits of a four digit number as 
minutes. 

Edit Qty Complete vs. Standard – If you select this option, you are warned if the quantity you 
report on a labor ticket is above the calculated operation quantity. Enter what percentage is 
allowable over standard.

Allow reporting to obsolete resources – Select this check box to report labor to obsolete 
resources. If you select this option, you are warned that the resource that you chose is obsolete. 
Clear this option to prevent the reporting labor to obsolete resources.

4 Click Ok.

Setting Preferences in Site Maintenance and the 
Manufacturing Window
If you specify the Percent Complete, Quantity Complete By Hours, and Max Percent Completed 
settings in Site Maintenance, then all operations in your site inherit the settings. The settings cannot 
be overridden at the header card level or operation level in the Manufacturing Window.
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If you do not specify the settings in Site Maintenance, then you can specify the settings at the header 
card level. All operations in the work order, quote master, or engineering master inherit the settings 
that you specify.

If you do not specify the settings in Site Maintenance or at the header card level, then you can specify 
the settings on individual operation cards.

1 Decide the level at which you want to set up percentage of completion functions:

• To specify the settings at the site level, select Admin, Site Maintenance. Click the Defaults
tab. 

• To specify the settings at the header level, select Eng/Mfg, Manufacturing Window and
open the header card of the work order, engineering master, or quote master. 

• To specify the settings at the operation level, select Eng/Mfg, Manufacturing Window and
open the operation. 

2 Specify this information:

Percent complete – To display Percent Remaining and Percent Complete fields in place of 
Quantity Remaining and Quantity Complete fields in Labor Ticket Entry, select this check box.

Quantity Complete by Hours –To automatically calculate quantity complete or percentage of 
completion based on the hours reported on the labor ticket, select this check box.

If you report labor based on quantity complete, then this calculation is made to determine the 
quantity completed during the labor ticket:

(hours reported on ticket/total estimated hours for operation) * operation quantity

If you report labor based on percentage complete, then this calculation is made to determine the 
percentage:

(hours reported on ticket/estimated hours for operation) * 100

The operation is automatically closed when the quantity or percentage complete equals or 
exceeds the operation quantity. 

Max Percent Completed – If you selected the Quantity Complete by Hours check box, use this 
field to specify the maximum percentage that can be calculated automatically. When the 
percentage complete meets the threshold that you specify, automatic calculation of quantity 
complete is stopped. The operation remains on your schedule until the operation is manually 
closed. This formula is used to calculate the number of hours for the operation that remain on 
your schedule:

((100 - value specified in Max Percent Completed field)/100) * total hours required for the 
operation

3 Click Save. 
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Adding Labor Tickets
You can enter these types of transactions in Labor Ticket Entry:

• Setup. Use this type to record the time that is spent setting up a resource for the run.
• Run. Use this type to record the time that is spent manufacturing items.
• Indirect. Use this type to record time that is not related to manufacturing activities. For example,

you can use an indirect labor ticket to record vacation time or administrative overhead time. 

Depending on the type of transaction that you select, fields in Labor Ticket Entry become active.

Adding Setup Labor Tickets
To add setup labor tickets:

1 Select Eng/Mfg, Labor Ticket Entry. 

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you are 
adding a labor ticket. If you are licensed to use a single site, this field is unavailable.

3 In the header, specify this information:

Transaction ID – Leave this field blank. The ID is generated when you save the ticket.

Transaction Date – Specify the date that the labor took place. 

Employee ID – Click the browse button and specify the ID of the employee who completed the 
labor. f you are licensed to use multiple sites, only the employees assigned to the site ID you 
specified in step 2 are displayed. If you are licensed to use a single site, all employee IDs are 
displayed.

Department ID – The employee’s default department ID is inserted, You can specify a different 
department ID. 

Transaction Type – Select Setup.

4 Specify information about the work order operation that you are setting up:

Base ID – Click the browse button and select the base ID of the work order. When you select a 
base ID, values are inserted in the Lot ID, Split ID, and Sub ID fields.

Oper Seq No – Click the browse button and select the operation that you are setting up.\

Resource ID – After you select an operation, the resource used for the operation is inserted in the 
Resource ID field. You can specify a different resource ID. For example, if a last-minute 
scheduling change caused the operation to be set up on a different resource than the resource 
specified on the operation card, you can specify the correct resource.

Earning Code – The employee’s default earning code is inserted in the field. You can specify a 
different earning code. 

5 Specify the duration of the labor ticket. Perform one of these tasks:

• Specify Clock-in and Clock-out Time – Specifying Clock In and Clock Out times
automatically computes elapsed labor hours.
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Times appear in the Clock In and Clock Out fields in formats specified in the International 
section of the Microsoft Windows Control Panel. Control panel allows specification of 12- or 
24-hour formats, along with the separator character, which is usually for time specification. 
Additionally, you can suppress leading zeros for hours (i.e. 8:00 vs. 08:00).

The United States default for time specification has the format hh:mm:ss xM, where hh is the 
hours, mm the minutes, ss seconds, and xM either AM or PM. For examples, 12:17:22 PM 
and 8:00:00 AM. The default suppresses leading zeros for hours.

In general, when specifying a time, you can specify just the left-most significant data, and the 
remainder defaults to zero. Additionally, you can specify a time in 24 hour format. Your entry is 
automatically converted to a fully specified time in the format selected in the Control Panel.

This table shows how the times that you specify are converted:

Additionally, you can specify times in a quick 4-digit format of hhmm. In this case, the mm 
portion is interpreted in one of two ways, depending on the setting of Use Decimal Time 
Format in Administrator Setup. If this is set, then the last two digits are interpreted as a 
percentage of an hour. Otherwise, they are interpreted as minutes. For example, 0825 is 
converted to 8:25:00 AM if Use Decimal Time Format is not set, and 8:15:00 AM (15 minutes 
= 25/100 of an hour) if it is.

• Specify Clock-in and Elapsed Time – If you specify a Clock-in time, and then an Elapsed
Time, the Clock-out time is calculated based on the difference. Note that the Clock-out time is
adjusted each time you change the Elapsed Time.

When you specify clock-in and clock-out times, you cannot specify overlapping times for the 
same employee.

• Specify Elapsed Time – Technically, only Elapsed Time is required to complete a labor ticket.
If tickets are specified this way, actual start and stop times will not be available for historical
purposes.

Note: It is possible to create an In Process labor ticket by entering a clock in and clock out time 
that are the same, and leaving Elapsed Time blank (NOT zero). A ticket of this type represents a 
clocked in employee, who will later clock out to complete the operation. Clocking out is done by 
recalling the ticket and modifying the clock out time and any other fields that need completion, 
such as quantity complete and description. You cannot create overlapping labor tickets in Labor 
Ticket Entry. If you use Labor Ticket Entry to enter labor tickets, each employee can only have 
one in process ticket.

Specified Value Converted Value

8 8:00:00 AM

8 PM 8:00:00 PM

12:17 12:17:00 PM(defaults to 
PM)

17:55 5:55:00 PM

17:55 AM Error (do not specify AM or 
PM with 24 hour times)
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6 In the Break Hours field, specify the amount of time spent on break. The amount that you specify 
is subtracted from the elapsed time.

7 Optionally, in the Description field, specify a description of the labor ticket.

8 In the Cost section, specify any cost override information for the labor ticket.

9 If the set up of the resource is complete, select the Setup Complete check box.

10 Click Save.

Adding Run Labor Tickets
To add a run labor ticket:

1 Select Eng/Mfg, Labor Ticket Entry. 

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you are 
adding a labor ticket. If you are licensed to use a single site, this field is unavailable.

3 In the header, specify this information:

Transaction ID – Leave this field blank. The ID is generated when you save the ticket.

Transaction Date – Specify the date that the labor took place. 

Employee ID – Click the browse button and specify the ID of the employee who completed the 
labor. f you are licensed to use multiple sites, only the employees assigned to the site ID you 
specified in step 2 are displayed. If you are licensed to use a single site, all employee IDs are 
displayed.

Department ID – The employee’s default department ID is inserted, You can specify a different 
department ID. 

Transaction Type – Select Run.

4 Specify information about the work order operation that you are setting up:

Base ID – Click the browse button and select the base ID of the work order. When you select a 
base ID, values are inserted in the Lot ID, Split ID, and Sub ID fields.

Oper Seq No – Click the browse button and select the operation that you are setting up.\

Resource ID – After you select an operation, the resource used for the operation is inserted in the 
Resource ID field. You can specify a different resource ID. For example, if a last-minute 
scheduling change caused the operation to be run on a different resource than the resource 
specified on the operation card, you can specify the correct resource.

Earning Code – The employee’s default earning code is inserted in the field. You can specify a 
different earning code. 

5 Specify the duration of the labor ticket. Complete one of these tasks:

• Specify Clock-in and Clock-out Time – Specifying Clock In and Clock Out times
automatically computes elapsed labor hours.
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Times appear in the Clock In and Clock Out fields in formats specified in the International 
section of the Microsoft Windows Control Panel. Control panel allows specification of 12- or 
24-hour formats, along with the separator character, which is usually for time specification. 
Additionally, you can suppress leading zeros for hours (i.e. 8:00 vs. 08:00).

The United States default for time specification has the format hh:mm:ss xM, where hh is the 
hours, mm the minutes, ss seconds, and xM either AM or PM. For examples, 12:17:22 PM 
and 8:00:00 AM. The default suppresses leading zeros for hours.

In general, when specifying a time, you can specify just the left-most significant data, and the 
remainder defaults to zero. Additionally, you can specify a time in 24 hour format. Your entry is 
automatically converted to a fully specified time in the format selected in the Control Panel.

This table shows how the times that you specify are converted:

Additionally, you can specify times in a quick 4-digit format of hhmm. In this case, the mm 
portion is interpreted in one of two ways, depending on the setting of Use Decimal Time 
Format in Administrator Setup. If this is set, then the last two digits are interpreted as a 
percentage of an hour. Otherwise, they are interpreted as minutes. For example, 0825 is 
converted to 8:25:00 AM if Use Decimal Time Format is not set, and 8:15:00 AM (15 minutes 
= 25/100 of an hour) if it is.

• Specify Clock-in and Elapsed Time – If you specify a Clock-in time, and then an Elapsed
Time, the Clock-out time is calculated based on the difference. Note that the Clock-out time is
adjusted each time you change the Elapsed Time.

When you specify clock-in and clock-out times, you cannot specify overlapping times for the 
same employee.

• Specify Elapsed Time – Technically, only Elapsed Time is required to complete a labor ticket.
If tickets are specified this way, actual start and stop times will not be available for historical
purposes.

Note: It is possible to create an In Process labor ticket by entering a clock in and clock out time 
that are the same, and leaving Elapsed Time blank (NOT zero). A ticket of this type represents a 
clocked in employee, who will later clock out to complete the operation. Clocking out is done by 
recalling the ticket and modifying the clock out time and any other fields that need completion, 
such as quantity complete and description. You cannot create overlapping labor tickets in Labor 
Ticket Entry. If you use Labor Ticket Entry to enter labor tickets, each employee can only have 
one in process ticket.

Specified Value Converted Value

8 8:00:00 AM

8 PM 8:00:00 PM

12:17 12:17:00 PM(defaults to 
PM)

17:55 5:55:00 PM

17:55 AM Error (do not specify AM or 
PM with 24 hour times)
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6 In the Break Hours field, specify the amount of time spent on break. The amount that you specify 
is subtracted from the elapsed time.

7 Optionally, in the Description field, specify a description of the labor ticket.

8 Specify information about the quantity completed:

Qty Required – The total quantity required for the operation is displayed. This field is read-only.

Qty Remaining/Percent Remaining – The total remaining to be completed on the operation. If 
the operation is set up to report completion based on quantities, then Qty Remaining is used as 
the label for this field. If the operation is set up to report completion based on percentage, then 
Percent Remaining is used as the label. 

If quantity or percentage of completion is calculated automatically and a maximum completion 
percentage has been specified, then this value is not updated after the maximum completion 
percentage has been reached. For example, if the operation has a maximum completion 
percentage of 80%, then this field is no longer updated after 80% of the estimated labor hours 
have been completed. Additional hours can be reported, but the percent of quantity remaining 
value is not changed.

See "Setting Preferences in Site Maintenance and the Manufacturing Window" on page 7–6 in 
this guide.

Qty Complete/Percent Complete – If the operation is set up to report completion based on 
quantities, the Qty Complete is used as the label for this field. Specify the quantity that was 
completed on the labor ticket. If the operation is set up to report completion based on percentage, 
then Percent Complete is used as the label for this field. Specify the percentage that was 
completed during the ticket. For example, if 20% has already completed, and you completed an 
additional 10%, specify 10%. 

If automatic calculation of quantities is activated, then a value is calculated for you. You can 
specify a different value than the calculated value. 

If a Max Percent Complete value has also been specified for the operation, then the automatic 
calculation stops when the total labor reported on the operation matches the threshold. You can 
continue to report labor on the operation, but additional quantities are not automatically calculated 
after the threshold is reached. You can manually specify a value even if you are automatically 
calculating values.

Qty Deviated – Specify the number of unusable pieces produced during the elapsed time in the 
Qty Deviated field. These are pieces that are scrapped or rejected by quality control. This field 
provides a historical analysis of completion data. This quantity does not contribute to the total 
quantity completed for the operation, but is recorded as part of the total incoming quantity for the 
operation.

When you specify a deviated quantity, the Deviated Reason ID field is activated. Click the Dev 
Reason ID button and select a reason from the list.

Run Complete – If the operation is complete, select the Run Complete check box. 

If a Max Percent Completed threshold has not been set up for the operation, then this check box 
is selected automatically when the operation is complete. If VISUAL is set up to calculate quantity 
complete by hours, then the Run Complete check box is selected when the total number of hours 
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specified for the operation equals or exceeds the estimated run time for the operation. If VISUAL 
is not set up to calculate quantity complete by hours, the Run Complete check box is selected 
when the quantity remaining is zero and you click the Save button. 

If a Max Percent Completed threshold has been set up for the operation, you must manually 
select the Run Complete check box when the operation is completed. 

9 Specify any cost override information for the labor ticket.

Direct labor costs can accumulate in two different ways; you must set this option in Accounting 
Entity Maintenance during the implementation process. It applies to all transactions:

• Based on hours worked. An hourly rate is multiplied by the elapsed time to get a labor cost for
the labor ticket.

If you are using actual costing, the employee’s pay rate is used (for yearly salaries, the salary 
is divided by 40 hours x 52 weeks to get an hourly rate). This method is also used for all 
indirect transactions.

If you are using standard costing, the hourly cost in the shop resource standard is used (setup 
or run, as appropriate). In both cases, the reported elapsed time is used to compute the labor 
cost.

Additionally, you can also specify a cost per unit. This is always defined in the shop resource 
master; there are separate costs per unit for setup and run.

Both of these values are used in assigning the cost. As a simple example, if an operation 
costs $5 per hour, and $1 per piece, then a reported elapsed time of 1 hour for 5 pieces 
produces a direct labor cost of $10 using the following formula:

(1 hour x 5 + 5 pieces x 1)

• Based on Quantity Produced. This option only applies if you are using standard costing. In
this case, labor cost is computed solely based on quantity completed. Quantity completed
(good and deviated) is used to calculate an effective hourly rate, and uses this hourly rate,
along with the original quantity completed, to calculate the cost.

Overrides are only possible if you are using actual costing.

In that case, a value placed in the Hourly Rate cost field overrides the employee’s standard 
rate. A blank Hourly Rate field indicates that the default is used. It does not appear in the field.

• Additionally, the hourly rate is multiplied by either Multiplier 1 or Multiplier 2 field before using
it.

Multiplier 1 indicates overtime and is always greater than or equal to 1. Multiplier 2 indicates 
proration and is always less than or equal to 1. This is useful for entering labor tickets known 
to be eligible for overtime. You can enter the appropriate multiplier here without overriding the 
actual hourly rate.

10 Click Save. These actions occur: 

• The completion meters in the Manufacturing Window are updated. 
• If a maximum percent complete threshold has not been specified for the operation, then 

these calculations are used to determine the percentage of completion:
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• If you report labor based on quantity, then Quantity Completed is divided by the to the 
total work order or leg quantity and multiplied by 100 to determine the completion 
percentage. 

• If you report labor based on percentage, then the total percentage reported as 
complete is used to update the completion meter.

• If a maximum percent complete threshold has been specified for the operation, then the 
percentage of completion calculation stops when the threshold has been reached. To 
update the completion meter after the automatic calculation threshold has been reached, 
you must manually update the quantity or percentage complete on the labor ticket. 

• Completed operations are closed. If you select the Run Complete check box or if the total
completed equals or exceeds the quantity required, then the operation is automatically
closed. If lower-level operations use shop resources that are designated as automatic
reporting, then the lower-level operations are also closed.

• Auto Issuing of Material Requirements are triggered. If any material requirements feeding into
the operation are for Auto Issue parts, then the material is automatically issued to the work
order operation from the Auto Issue warehouse location in proportion to the quantity
completed.

For example, if the Work Order or Leg quantity is 10, quantity completed is 5, and Quantity 
Per for an Auto Issue part is 3 feet, then 15 feet is issued to the operation 15 = (5 x 3). Auto 
issuing is done for the specified operation, as well as for any Automatic Reporting operations. 
This allows material back flushing for materials that are not explicitly issued to work orders, 
but are pulled as needed.

Completing Labor on Operations with Max Percent Complete Thresholds
If a maximum percent complete threshold has been specified for an operation, then perform one of 
these tasks in Labor Ticket Entry to indicate that labor is complete and the operation is closed:

• Manually select the Run Complete check box on the labor ticket. If you select the Run
Complete check box but do not update quantity/percent complete to 100% of the quantity, then
the operation completion meter does not reach 100%. The operation is still closed.

• Update Quantity/Percent Completed on the labor ticket to equal the total quantity required
for the operation. When the total quantity remaining equals zero, the Run Complete check box is
automatically selected when you save the labor ticket. The operation completion meter will equal
100%, and the operation is closed.

• Use the Manufacturing Window to change the status of the operation to Closed. The
operation completion meter will not equal 100%. 

Adding Indirect Labor Tickets
To add an indirect labor ticket:

1 Select Eng/Mfg, Labor Ticket Entry. 
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2 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you are 
adding a labor ticket. If you are licensed to use a single site, this field is unavailable.

3 In the header, specify this information:

Transaction ID – Leave this field blank. The ID is generated when you save the ticket.

Transaction Date – Specify the date that the labor took place. 

Employee ID – Click the browse button and specify the ID of the employee who completed the 
labor. f you are licensed to use multiple sites, only the employees assigned to the site ID you 
specified in step 2 are displayed. If you are licensed to use a single site, all employee IDs are 
displayed.

Department ID – The employee’s default department ID is inserted, You can specify a different 
department ID. 

Transaction Type – Select Indirect.

Indirect Code – You can leave this field blank. When you select an Indirect ID in the next step, 
the associated code is inserted in this field. The indirect code is used to classify the indirect ID.

4 Specify information about how to account for the cost of the labor ticket:

Indirect ID – Select the indirect ID to which you are reporting labor.

G/L  Account ID – The account associated with the indirect ID that you selected is inserted. You 
can specify a different G/L account ID.

Earning Code – The employee’s default earning code is inserted in the field. You can specify a 
different earning code. 

5 Specify the duration of the labor ticket. Complete one of these tasks:

• Specify Clock-in and Clock-out Time – Specifying Clock In and Clock Out times
automatically computes elapsed labor hours.

Times appear in the Clock In and Clock Out fields in formats specified in the International 
section of the Microsoft Windows Control Panel. Control panel allows specification of 12- or 
24-hour formats, along with the separator character, which is usually for time specification. 
Additionally, you can suppress leading zeros for hours (i.e. 8:00 vs. 08:00).

The United States default for time specification has the format hh:mm:ss xM, where hh is the 
hours, mm the minutes, ss seconds, and xM either AM or PM. For examples, 12:17:22 PM 
and 8:00:00 AM. The default suppresses leading zeros for hours.

In general, when specifying a time, you can specify just the left-most significant data, and the 
remainder defaults to zero. Additionally, you can specify a time in 24 hour format. Your entry is 
automatically converted to a fully specified time in the format selected in the Control Panel.

This table shows how the times that you specify are converted:

Specified Value Converted Value

8 8:00:00 AM

8 PM 8:00:00 PM
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Additionally, you can specify times in a quick 4-digit format of hhmm. In this case, the mm 
portion is interpreted in one of two ways, depending on the setting of Use Decimal Time 
Format in Administrator Setup. If this is set, then the last two digits are interpreted as a 
percentage of an hour. Otherwise, they are interpreted as minutes. For example, 0825 is 
converted to 8:25:00 AM if Use Decimal Time Format is not set, and 8:15:00 AM (15 minutes 
= 25/100 of an hour) if it is.

• Specify Clock-in and Elapsed Time – If you specify a Clock-in time, and then an Elapsed
Time, the Clock-out time is calculated based on the difference. Note that the Clock-out time is
adjusted each time you change the Elapsed Time.

When you specify clock-in and clock-out times, you cannot specify overlapping times for the 
same employee.

• Specify Elapsed Time – Technically, only Elapsed Time is required to complete a labor ticket.
If tickets are specified this way, actual start and stop times will not be available for historical
purposes.

Note: It is possible to create an In Process labor ticket by entering a clock in and clock out time 
that are the same, and leaving Elapsed Time blank (NOT zero). A ticket of this type represents a 
clocked in employee, who will later clock out to complete the operation. Clocking out is done by 
recalling the ticket and modifying the clock out time and any other fields that need completion, 
such as quantity complete and description. You cannot create overlapping labor tickets in Labor 
Ticket Entry. If you use Labor Ticket Entry to enter labor tickets, each employee can only have 
one in process ticket.

6 In the Break Hours field, specify the amount of time spent on break. The amount that you specify 
is subtracted from the elapsed time.

7 In the Description field, optionally specify a description of the labor ticket.

8 In the Cost section, optionally override the hourly rate for the indirect ticket. 

9 Click Save. 

Conducting Data Collection
When you create a work order, you have the option of requiring quality data inspection during a 
particular operation. The data inspection can occur during the set up, the run, or both. On the work 
order, you can also specify the inspection plan to use. If an inspection plan is specified, the plan ID is 
displayed in the Inspection Plan ID field in the Labor Ticket window.

12:17 12:17:00 PM(defaults to 
PM)

17:55 5:55:00 PM

17:55 AM Error (do not specify AM or 
PM with 24 hour times)

Specified Value Converted Value
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If you are integrated to IQM, you can view the inspection plan and access product data collection 
directly from the labor ticket window. 

To review inspection plan information, select Edit, Open Inspection Plan. To open the inspection 
plan specified in Labor Ticket Entry, IQM must contain the site ID specified in Labor Ticket Entry. The 
inspection ID specified in the Labor Ticket Entry must exist for the specified site in IQM. If the site ID 
or inspection plan ID do not match information in IQM, a blank inspection plan form is opened.

To collect product data, select Edit, Open Data Collection. If the inspection plan and site specified in 
Labor Ticket Entry exist in IQM, then the data collection form is opened with the product inspection 
plan information populated. If the inspection plan and site do not match information in IQM, a blank 
data collection form is opened. 

After you complete the data collection, select the Quality Data Collection Complete check box in 
Labor Ticket Entry. Then, save the labor ticket.

Editing Labor Ticket Information
Because labor tickets represent a report of actual status, rather than a static data object, you can 
modify only a limited amount of data in a completed labor ticket. If you need to change a field that is 
not modifiable, you can delete the labor ticket and reenter it. This is allowed for labor tickets that have 
not been posted to the general ledger. You cannot make any modifications or deletions to posted 
labor tickets.

1 In the Labor Ticket Entry window, click the Transaction ID browse button and select the labor 
ticket that you want to edit.

If you edit an overlapping labor ticket, you are prompted to recalculate labor ticket proration. 
Overlapping labor tickets can be created in VISUAL Time & Attendance and through Barcode 
Labor Ticket Entry.

2 Edit any of these fields:

• Transaction Date
• Department ID
• Indirect ID (Indirect transactions only)
• G/L Account ID (Indirect transactions only)
• Clock In, Clock Out, Elapsed Time, Break Hours
• Quantity Completed, Quantity Deviated (Run transactions only)
• Hourly Rate, Multiplier, Unit Rate

3 Click the Save toolbar button to save the changes.

Recalculating Labor Ticket Proration
If you have edited a labor ticket that overlaps with another labor ticket, use the Recalc Proration 
function to recalculate the proration values for the overlapping labor tickets.
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To recalculate the labor tickets for an employee on a specific day:

1 From the Labor Ticket Entry window, select Edit, Recalc Proration.

2 Select the Site ID from the Site ID drop-down list.

3 Select the employee whose labor tickets are to be reviewed from the Employee ID drop-down list.

4 Select the date of the labor tickets to be reviewed in the Date field.

5 If you change your employee or date selections, click Refresh to display labor tickets for your 
updated selections.

6 The Labor Tickets table displays these columns:

Transaction ID – The ID of the labor ticket.

Trans Type - The type of labor ticket. These codes are used:

R - Work Order Run

S - Work Order Setup

I - Indirect

Trans Date - The date that work began on the labor ticket.

Prorated - If the labor ticket has been prorated, this check box is selected.

Clock-in – The time that the employee has clocked in.

Clock-out - The time that the employee has clocked out.

Elapsed Hours – The prorated hours calculated on overlapping labor tickets when the 
environment is set to Prorate Hours.

Unprorated Elapsed Hours – The non-prorated number of hours calculated for the labor ticket. 
This is calculated by subtracting the Clock-in time from the Clock-out time.

Hours Break - The duration of the break or meal.

Multiplier 2 – If you prorate by costs, the multiplier used to calculate the costs.

Multiplier 1 - If the employee shift has a primary multiplier, it displays here.

Base - The ID of the work order associated with the labor ticket. If this labor ticket is associated 
with a project, then the Base ID is the ID of the project master associated with the labor ticket.

Lot - The ID associated with the work order of the job.

Split – The identifier of the work order.

Sub - The leg of the work order, where zero indicates the main leg.

Seq# - The work order operation on which labor was reported.

Indirect ID - The Indirect ID specified for indirect labor transactions.

7 Click Recalculate to adjust the prorated values. If you prorate by hours, then the Hours column is 
updated. If you prorate by costs, then the Hours and Multiplier 2 values are updated.

8 If you want to export the Labor Ticket table information to Microsoft Excel, click Send to Excel. 
Specify the Export File Name and then click Save.
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9 Click Close to close the Recalc Proration dialog.

Retrieving In Process Tickets
To quickly retrieve an in-process ticket, use the Retrieve in Process function. If you are licensed to 
use multiple sites, click the Site ID arrow and select the site where you want to view in-process 
tickets. Click the Retrieve In Process button on the main toolbar. All in-process labor tickets for all 
employees are displayed. To view the in-process ticket for a particular employee, select an employee 
before clicking the Retrieve in Process button. 

Deleting Labor Tickets
You can modify and reenter an existing labor ticket by calling it up and deleting it. You can change all 
information in the deleted ticket. Clicking Save reenters the ticket. Note that this usually creates a 
ticket with a new transaction number.

To delete a labor ticket:

1 In the Labor Ticket Entry window, click the Transaction ID browse button and select the Labor 
Ticket that you want to delete.

2 Click Delete.

3 Click Yes to continue, or No to cancel the deletion.

The Labor Ticket window still contains the transaction information, but the Labor Ticket has been 
removed from the database.

4 Click the New toolbar button to complete the operation.

Caution:  You can only delete labor tickets that have not been posted to the general ledger. 
Only do this to correct a mistake. Labor tickets are used in costing work orders. 
Deleting a ticket can result in an under-costed work order. Therefore, you should 
never delete a labor ticket with the intention of purging VISUAL.
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Working with Backflushing
Backflushing is the process that automatically creates labor tickets and material issue transactions. 

To backflush labor transactions, set up auto-reporting resources. When you use auto-reporting 
resources in work orders, labor that is reported on subsequent operations causes the completion of 
prior operations that use auto-reporting resources. For example, a work order has three operations. 
Operation 10 and operation 20 use auto-reporting resources. Operation 30 does not use an auto-
reporting resource. If a quantity of 2 is completed on operation 30, then a quantity of 2 is automatically 
completed on operation 20 and operation 10. If operation 20 and operation 10 required setup, the 
setup is also complete. 

Use Shop Resource Maintenance to set up auto-reporting resources. Use Site Maintenance to set up 
these behaviors:

• Whether labor tickets are created for auto-reporting resources
• Whether receiving a work order triggers backflush
• Whether subordinate legs are backflushed

To backflush material requirement issues, set up auto-issue. Use Part Maintenance to designate the 
parts that are auto-issued. Use Part Maintenance or Warehouse Maintenance to set up auto-issue 
warehouse locations. Use Site Maintenance to set up when auto-issues are made. 

You can use labor auto-reporting and material auto-issue independently of each other or together. 

Limitations
If you specify an auto-reporting resource on an operation, then these features are unavailable:

• Part traceability. The Begin Traceability at this operation check box on the Setup/Run tab of
the operation is unavailable. You cannot use part trace functionality with auto-reporting resources.

• Inspection. The Required on Setup and Required on Run check boxes on the Scrap/Yield tab of
the operation card are unavailable. You cannot require inspection for auto-reporting resources. 

Setting up Labor Backflush
To set up labor backflush, complete these tasks:

• In Site Maintenance, specify backflush settings
• In Shop Resource Maintenance, create auto-reporting resources

Specifying Backflush Settings in Site Maintenance
1 Select Admin, Site Maintenance.

2 In the Entity ID field, select the parent entity for the site for which you are setting up blackflush.
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3 In the Site ID field, select the site.

4 Click the Defaults tab.

5 Specify these settings:

Autogen Labor During Receipt – Select this check box to backflush labor when you receive a 
work order into inventory or when you ship a customer order that is linked to a work order. 

If you clear this check box, then backflushing is triggered in labor entry only. If you clear this check 
box, then the last operation in a work order must not use an auto-reporting resource. You cannot 
manually report labor to an auto-reporting resource.

Default Employee – If you selected the Autogen Labor During Receipt check box, specify the ID 
of the employee to use on labor tickets that are generated when you ship a customer order that is 
linked to a work order. 

Backflush Subordinate Legs – Select this option to backflush labor to subordinate legs. In 
addition to selecting this check box, you must also specify an auto-reporting resource on the last 
operation in the leg to initiate the backflush of legs.

Generate Labor Tickets During Backflush – Select this check box to generate labor tickets for 
operations that have been backflushed. The costs that are specified on the Costs tab of the 
operation are used to determine the labor costs. 

Clear this check box if you do not want to generate labor tickets for backflushed operations. If you 
clear this check box, then backflushed operations do not have any labor costs. 

6 Click Save. 

Setting Up Auto-reporting Resources
1 Select Eng/Mfg, Shop Resource Maintenance.

2 In the Site ID field, select the site that uses the resource.

3 Double-click the Resource ID browse button and select the resource, or create a new resource.

4 Click the Other tab.

5 Select the Automatic Reporting check box.

6 Click Save.
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Backflush Settings and Behavior
This table shows the labor tickets that are generated when you ship a customer order linked to a work 
order or receive the material into inventory. Note that the Autogen Labor During Receipt check box 
must be selected. To backflush legs, the last operation on the leg must also use an auto-reporting 
resource: 

This table shows the labor tickets that are generated when you enter a labor ticket for an operation. 
To generate backflush transactions from a labor ticket, the last operation on the work order cannot 
use an auto-reporting resource. To backflush legs, the last operation on the leg must also use an 
auto-reporting resource: 

Site Maintenance settings Data backflushed to last 
operation in work order

Data 
backflushed to 
preceding auto-
reporting 
resources in 
same sub ID

Data 
backflushed to 
legs

Backflush Subordinate 
Legs check box cleared
Generate Labor Tickets 
During Backflush check 
box cleared

Auto-reporting resources: 
Quantity
Standard resources: 
Quantity (0-value labor 
ticket)

Qty n/a

Backflush Subordinate 
Legs check box selected
Generate Labor Tickets 
During Backflush check 
box cleared

Auto-reporting resources: 
Quantity
Standard resources: 
Quantity (0-value labor 
ticket)

Qty Qty

Backflush Subordinate 
Legs check box cleared
Generate Labor Tickets 
During Backflush check 
box selected

Auto-reporting resources: 
Quantity, Hrs, Cost, Setup
Standard resources: 
Quantity (0-value labor 
ticket)

Qty, Hrs, Cost n/a

Backflush Subordinate 
Legs check box selected
Generate Labor Tickets 
During Backflush check 
box selected

Auto-reporting resources: 
Quantity, Hrs, Cost, Setup
Standard resources: 
Quantity (0-value labor 
ticket)

Qty, Hrs, Cost Qty, Hrs, Cost

Settings Preceding Ops 
Same Sub ID Legs

Backflush Subordinate Legs cleared
Generate Labor Tickets During Backflush cleared

Qty n/a

Backflush Subordinate Legs cleared
Generate Labor Tickets During Backflush selected

Qty, Hrs, Cost n/a
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Labor Backflush Sample
When you receive the part on your work order into inventory or enter a labor ticket for the last 
operation on the root of your work order, labor is backflushed to operations in a specific sequence. 
For example, using the following work order:

With Autogen Labor on Receipt, Backflush Subordinate Legs, and Generate Labor Tickets 
During Backflush selected in the Site Maintenance window, when you receive the part described on 
Sub 0 or enter a labor ticket for Sub 0 Op 80, it is backflushed in the following order:

1 Sub 0, Op 70.

2 Sub 0, Op 60.

3 Sub 1, Op 60.

4 Sub 1, Op 50.

5 Sub 3, Op 40.

6 Sub 3, Op 30.

7 Sub 4, Op 30.

Backflush Subordinate Legs selected
Generate Labor Tickets During Backflush cleared

Qty Qty

Backflush Subordinate Legs selected
Generate Labor Tickets During Backflush selected

Qty, Hrs, Cost Qty, Hrs, Cost 

Settings Preceding Ops 
Same Sub ID Legs

Sub 0, Op 60
Auto

Sub 0, Op 50
Auto

Sub 0, Op 40
Non-auto

Sub 0, Op 30
Auto

Sub 0, Op 20
Auto

Sub 0, Op 10
Non-auto

Sub 0, Op 70
Auto

Sub 0, Op 80
Non-auto

E Stop

A Stop
E Start

F

A Start

E2

A14

A2

Sub 1, Op 60
Auto

Sub 1, Op 50
Auto

Sub 1, Op 40
Auto

Sub 1, Op 30
Auto

Sub 1, Op 20
Auto

Sub 1, Op 10
Non-auto

A13

D Start
D Stop

A11

A5

A4

Sub 2, Op 30
Auto

Sub 2, Op 20
Non-auto

Sub 2, Op 10
Auto

A12

C Start

C Stop

A10

Sub 3, Op 40
Auto

Sub 3, Op 30
Auto

Sub 3, Op 20
Non-auto

Sub 3, Op 10
Non-auto

B Start
B Stop

A7

A6
Sub 4, Op 30

Auto
Sub 4, Op 20

Auto
Sub 4, Op 10

Non-auto

A8

G Start
G Stop

A9

A3
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8 Sub 4, Op 20.

9 Sub 1, Op 40.

10 Sub 1, Op 30.

11 Sub 2, Op 30.

12 Sub 1, Op 20.

13 Sub 0, Op 50.

14 Backflushing is stopped because a non-auto reporting resource is reached on Sub 0, Op 40.

In order for you take advantage of backflushing for the remainder of the work order, you would—in no 
particular order—have to enter labor tickets for:

Sub 2, Op 20 – backflushes:

1 Sub 2, Op 20.

2 Sub 2, Op 10.

3 Backflushing is stopped because only subordinate legs are backflushed, not preceding legs. In 
this example, there are no subordinate legs to backflush.

Sub 0, Op 40 – backflushes:

1 Sub 0, Op 30.

2 Sub 0, Op 20.

3 Backflushing is stopped because a non-auto reporting resource is reached on Sub 0, Op 10.

Because Sub 1, Op 10 – Sub 3, Op 10 – Sub 3, Op 20 and Sub 4, Op 10 have non-auto reporting 
operations immediately preceding them, no backflushing will be performed when you report labor 
against them.

Auto-issue Parts
An auto-issue part is a material requirement that is automatically issued to a work order when labor 
transactions are made. Users do not have to manually enter inventory transactions to issue the part to 
a work order.

To auto-issue parts, these criteria must be met: 

• The Auto Issue check box must be selected for the part.
• The part must be stored in at least one auto-issue warehouse location.
• A default auto-issue warehouse and location combination must be specified for the part.
• If you have created auto-issue locations in multiple warehouses, at least one default location must

be specified for each warehouse. 
• The part cannot have a trace profile. Traceable parts cannot be auto-issued.
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If you select the Auto Issue check box for a part, but do not assign the part to an auto-issue location, 
then auto-issue transactions are not made. Similarly, if you assign a part to an auto-issue location, but 
do not select the Auto Issue check box, then auto-issue transactions for the part are not made. If a 
warehouse has auto-issue locations, but none of the locations are designated as the default for the 
warehouse, then auto-issues are not made from the warehouse. 

To create an auto-issue part:

1 Select Inventory, Part Maintenance.

2 In the Site ID field, select the site that uses the auto-issue part. Auto-issue is set up at the site 
level. 

3 Click the Part ID field and select the part to auto-issue.

4 In the Settings section, select the Auto Issue check box.

5 Click the Defaults tab.

6 Specify this information:

Auto-issue Warehouse ID – Specify the default warehouse to use for auto-issue transactions for 
this part.

Auto-issue Location ID – Specify the default location to use for auto-issue transactions for this 
part.

7 Click Save.

8 Optionally, specify additional auto-issue warehouses and locations:

a Select Maintain, Warehouse Locations.

b Click Insert.

c Double-click the Warehouse ID button and select a warehouse.

d Double-click the Location ID button and select the location.

e Select the Auto Issue check box.

f If the location is the default auto-issue location for the warehouse, select the Default Whs 
Auto Issue check box. Each auto-issue warehouse must have a default warehouse auto-
issue location. 

g Click Save.

Warehouse Locations and Auto-issue Transactions
To determine the location that is used for auto-issues, this hierarchy is used:

• If a warehouse is specified on the header of the Material Requirement card and a location is
specified on the Planning tab of the Material Requirement card, then the location that is specified
on the Planning tab is used.

• If a warehouse is specified on the header of the Material Requirement card but no location is
specified on the Planning tab, then the location that is designated as the default auto-issue
location for the warehouse is used. 
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• If no warehouse is specified on the header of the Material Requirement card, then the default
auto-issue location that is specified on the Defaults tab in Part Maintenance is used. 

Auto-issue and Issue Negative Settings
The Issue Negative settings that you specify in Site Maintenance do not affect auto-issue 
warehouses. Quantity in auto-issue warehouses can be driven negative regardless of the issue 
negative settings that are specified for the site. 

Auto-issue Transaction Quantities and Timing
Use Site Maintenance to specify the auto-issue method. The auto-issue method that you select is 
used to determine when to issue materials to operations. You can issue materials after the first run 
labor ticket is created for an operation, when a labor ticket has been created with a status of Run 
Complete, or incrementally based on the quantity completed on each labor ticket.

Use Preferences Maintenance to specify whether to include fixed scrap and deviated quantities in the 
calculation for the quantity to auto-issue. 

Specifying an Auto-Issue Method in Site Maintenance
1 Select Admin, Site Maintenance.

2 In the Entity ID field, select the parent entity of the site for which you are specifying the auto-issue 
setting.

3 In the Site ID field, select the site.

4 Click the Defaults tab.

5 In the Auto Issue Method section, click one of these options:

Based on Operation Qty Complete – Click this option to auto-issue material requirements 
incrementally based on the quantity or percent completed on each labor ticket. For example, 
presume that the operation is for a quantity of 5 and the Qty Per for the material requirement is 1. 
If a quantity of 2 is completed on a labor ticket, then 2 units of the material requirement are issued 
(presuming that there is no fixed scrap or deviated quantity). If an operation is closed before all 
quantities are completed, then the material requirement is also closed short. This option is the 
default option

Based on the Full Requirement Qty on First Labor Ticket – Click this option to auto-issue the 
full material requirement quantity after the first run labor ticket is reported for the operation. If you 
backflush labor without creating labor tickets, then the full material requirement is issued after the 
first backflush quantity. 

Depending on how you set up Preferences Maintenance, the issued quantity can include fixed 
scrap and extra materials for deviated quantities that are reported on the first labor ticket.
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If a labor ticket has already been created for the operation or a quantity has already been 
backflushed, then additional material is not issued. For example, if you created a labor ticket for 
an operation and then increased the quantity of the material requirement, the additional 
requirement will not be issued. 

Note: If operations are in process when you select this auto-issue method, additional materials 
are not issued to any in-process operation. To complete material issues for in-process operations, 
you must manually issue the materials. 

Based on Full Remaining Req Qty on Run Complete – When you use this option, materials are 
issued in proportion to the quantity or percent complete on the operation until the Run Complete 
labor ticket is saved to the operation. When the Run Complete labor ticket is saved, all remaining 
material requirements are issued to the operation, even if the operation is closed short. If you 
backflush labor during the shipment of customer orders, then the full remaining quantity of a 
material requirement is issued when the full quantity of the order line has been shipped or when 
the line is closed short. 

Depending on how you set up Preferences Maintenance, this quantity can include fixed scrap and 
extra materials for deviated quantities.

6 Click Save. 

Specifying Auto-issue Preferences
1 Select Admin, Preferences Maintenance.

2 In the Section Filter field, select LaborEntry.

3 Click Insert Row.

4 In the LaborEntry section, specify these preferences:

Entry Description

AutoIssueFixedScrap

Specify Y to also auto-issue the fixed scrap 
that is specified for the material requirement. 
If you specify Y, the fixed scrap is issued in 
the first auto-issue transaction that is made 
for the operation. 
Specify N if you do not want to auto-issue 
fixed scrap. If you specify N, fixed scrap 
quantities must be issued manually. 
If you do not specify a setting, then fixed 
scrap is auto-issued. 
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5 Click Save. 

Using Labor Backflush with Auto-issue Parts
Keep these behaviors in mind when you use backflush and auto-issue parts on the same work order:

• Materials are issued to requirements with auto-issue parts even if you do not generate labor
tickets during backflush.

• Labor is backflushed based on the quantity that is specified in the transaction that generates the
backflush. For example, if a user enters a labor ticket for a quantity of 2 on the last operation of a
work order, a quantity of 2 is backflushed. Materials are auto-issued based on the Auto Issue
Method that is specified in Site Maintenance.

• If you auto-generate labor during receipt transactions and close a customer order short, then the
quantities of material requirement that are issued depend upon the Auto Issue Method that you
use. If you use the Based on Full Remaining Req Qty on Run Complete method or the Based on
full Requirement Qty on First Labor Ticket method, then the full quantity of material requirement is
issued. If you use the Based on Operation Qty Complete method, then a prorated quantity is
issued. 

AutoIssueMaterialReq

Specify Y to auto-issue material requirements 
to cover deviated quantities. For example, if 
the Qty Per for the material requirement is 1, 
and you complete 5 acceptable units and 2 
deviated units, then a total of 7 units of the 
material requirement is issued to the 
operation. If you also auto-issue fixed scrap, 
then the fixed scrap quantity is also issued. 
If you use the Based on the Full 
Requirement Qty on First Labor Ticket 
auto-issue method, then deviated quantities 
that are reported on the first labor ticket are 
included in the total amount of material auto-
issued to the operation. Deviated quantities 
that are specified on subsequent labor tickets 
are not included in the auto-issue calculation. 
Specify N if you do not want to issue material 
for deviated quantities.
If you do not specify a setting, then 
requirements are not auto-issued for 
deviated quantities. 

Entry Description
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Specifying Part Trace Information
Traceability in Labor Ticket Entry records traceability information associated with the reporting of 
completed parts for an operation. This shifts the start of traceability to the point where pieces are 
completed, rather than when they are received into finished goods inventory.

Each Engineering Master for a traceable fabricated part has one operation that is specially marked 
Begin Traceability At This Operation. When completed pieces are reported for this operation, 
traceability information is required.

The Traceability button on the main toolbar becomes active if these conditions are true:

• Reporting against a work order for a fabricated part that is traceable
• Reporting labor for the work order operation that is marked Begin Traceability At This Operation
• Reporting Run labor (not setup)
• Reporting a Quantity Completed

If the transaction or line items refer to traceable parts, you should first enter all data to complete the 
transaction or transaction line items in the normal way.

1 Click the Part Traceability button on the main toolbar.

In the Part Traceability dialog box, you can view a part’s history. The dialog box displays Trace 
Available Quantity, Quantity, Trace ID, and Comments.

2 To override the trace quantity from the Labor Ticket Entry window, click in the Quantity and enter 
a new quantity.

If you change the quantity reported, you are asked to confirm your new quantity.

3 Click Ok to set the new quantity, or Cancel to return to the Traceability dialog box.

4 If you are assigning numbers now, rather than using preassigned numbers, click the Insert 
button.

A new line appears in the table.

5 Enter the quantity available for tracing in the Trace Available Quantity.

6 Enter a quantity in the Quantity field.

You are allowed to have a Quantity be greater than or less than Total Quantity. When you click the 
Close button, the dialog box shown above appears. If you choose to override the quantity, 
Quantity Completed automatically adjusts to the Numbered Quantity.

7 In the Trace ID field, specify the trace ID for the part.

8 Enter comments in the Comments column.

9 Click the Close button to exit the Traceability dialog box.

10 Click the Save button on the main toolbar to complete the transaction.
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Recalculating Overtime
You can account for overtime in Labor Ticket Entry by using the Multiplier override field for tickets 
known to require overtime pay. You can do this if you enter tickets for an employee sequentially, and 
if you monitor the Session Total.

Overtime can be automatically calculated by examining all tickets for a given employee and setting 
multipliers based on accumulated hours.

1 Select Recalc Overtime from the Edit menu.

2 Enter the last date of the week for which you want to recalculate overtime.

The default is the Sunday of the previous week. You can also use the < and > buttons to the right 
of the date field to decrease and advance the date by one day, and the << and >> buttons to 
decrease and advance the date by a week.

3 Enter multiplier and over values for Premium 1.

Premium 1 calculates overtime on anything OVER a specified number of hours per week. The 
multiplier you enter here is used to perform the overtime calculation. The default multiplier is 1.5 
for time over 40 hours.

4 Enter a multiplier for Premium 2 and select the appropriate days of the week.

Use Premium 2 to indicate that hours reported on certain days of the week are multiplied by a 
constant multiplier to arrive at the overtime value. For example, in the Recalculate Overtime 
dialog box shown above, Sunday is checked as a Premium 2 day with a multiplier of 2. This 
causes the time worked on a Sunday to be multiplied by 2 to arrive at the overtime value.

5 Click the Ok button to recalculate the overtime.

All time tickets for the specific week are processed and new overtime multipliers are determined. 
Jobs worked at the end of the week receive the overtime. If a time ticket crosses the overtime 
hour limit, it is broken into two tickets so that overtime only applies to the time over the specified 
limit.

Overtime is recalculated in the following way:

1 For each employee, all direct labor tickets for the specified week are considered. Additionally,   
indirect tickets with an indirect code of Miscellaneous are also considered.

2 Overtime is calculated based on tickets with the value of the multiplier. Therefore, all tickets with a 
value of greater than 1 are reset to 1. If a ticket has a multiplier of less than 1, it is prorated. 
Recalculation of overtime is done by multiplying hours worked by the multiplier, and resetting the 
elapsed time accordingly.

Evaluation of this type of labor ticket in overtime calculations is questionable, because the 
elapsed time does not represent real clock time. These tickets keep a multiplier of 1, regardless of 
whether they fall in overtime or not.

3 The hours for all tickets are totaled. If one ticket overlaps the overtime boundary, it is split into two 
tickets, with clock in and clock out time adjusted accordingly. Quantities completed and deviated 
are prorated between the tickets.

4 Premium 1 is applied to all tickets over the Over hours you specify. If the day matches one of the 
weekdays specified for Premium 2, Premium 2 is used instead.
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Printing Labor Ticket Reports
There are a number of options available for outputting Labor Ticket information.

Printing Summary Reports
Labor Ticket Entry allows you to output a summary report of selected and sorted labor transactions 
for a specified period. This report summarizes all tickets within the minor sort sequence and totals by 
employee within the specified date range. The report calculates subtotals for each major sequence 
and gives a grand total for the entire period.

You can use a different overtime multiplier on the report than on the Labor Ticket Entry window. If you 
enter a different multiplier and check the Determine Overtime box, the report prints using the 
multiplier you enter on the Print Summary screen. A second overtime premium is not supported here. 
If you do not check the box, the report prints using the multiplier (if any) entered during Labor Ticket 
Entry.

If you are licensed to use multiple sites, you can include multiple sites on the same report.

1 Select Print Summary from the File menu or click the Print Summary button on the main toolbar.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 Enter the first Employee ID for the first employee you want to print in the Starting Employee ID 
field and the last employee you want to print in the Ending Employee ID field.

This range of employees includes all employees that fall within the alphabetical range given and 
include the entered IDs. Leave these fields blank for a report of all employees.

4 Enter the date range to print in the Starting Date and Ending Date fields.

The dates default to the current week. You may change these dates by clicking on the fields and 
entering the date or by clicking on the arrow button. The double arrows change the date by a 
week at a time and the single arrow changes the date a day at a time.

5 If you want to calculate overtime for the report, click the Determine Overtime box and enter a 
multiplier in the Over 40 hrs multiplier field.

This is only for the report calculation and does not update the database.

If you select this option, you can sort the report only with a major sequence By Employee ID and 
minor sequence By Date.

6 Select the Include Vac/Hol/Sick check box if you vacation time, holiday time, and sick time 
accounted for in the report.

7 Choose the output destination by clicking on the arrow next to the output field. Select one of the 
following:

Print – Select this option to output the file to a printer. The file is sent to the selected default 
printer.
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View – Select this option to see what the printed output will look like before you print it. When the 
information appears on the screen.

File – Select this option to save the summary information to a text file. You can then edit the file 
using any text editor.

E-mail – Select this option to send the report in a Rich Text Format (.RTF) through electronic mail. 
When you generate the report the system attaches the file to a Microsoft Outlook e-mail. See your 
Microsoft Outlook user documentation.

8 Select the major sequence for the report by clicking on the appropriate radio button in the Major 
Sequence field.

You can list the summary by Employee ID or by the Minor Sequence. Selecting None as the Major 
Sequence causes the summary to be output according to the Minor Sequence.

9 Select the Minor Sequence option.

The Minor Sequence determines how information is listed within the Major Sequence. That is, if 
you select By Employee ID as the Major Sequence, and Date as the Minor Sequence, the 
summary appears in Employee order with each employee’s information in Date order. If you 
select None as the Major Sequence, the summary appears in Minor Sequence only.

10 If you selected Print as the output, click Ok.

A standard Windows printer dialog box appears, allowing you to select the number of copies to 
print.

11 Make the appropriate selections then click Ok.

The summary report is printed.

Printing Detail Reports
Labor Ticket Entry allows you to output a detailed report of selected and sorted labor transactions for 
a specified period. This report displays one line entry per labor ticket per employee. The report 
calculates subtotals for each employee and provides a grand total for the entire period.

You can use a different overtime multiplier in the report than in the Labor Ticket Entry window. If you 
enter a different multiplier and check the Determine Overtime box, the report prints using the 
multiplier you enter in the Print Detail dialog box. If you do not check the Determine Overtime box, the 
report prints using the multiplier you entered (if any) during Labor Ticket Entry.

If you are licensed to use multiple sites, you can include multiple sites on the same report.

1 Select Print Detail from the File menu or click the Print Detail button on the main toolbar.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 Enter the first Employee ID for the first employee you want to print in the Starting Employee ID 
field and the last employee you want to print in the Ending Employee ID field.

This range of employees includes all employees that fall within the alphabetical range given and 
include the entered IDs. Leave these fields blank for a report of all employees.



Printing Labor Ticket Reports

Infor VISUAL Inventory User’s Guide | 7 – 33

4 Enter the date range to print in the Starting Date and Ending Date fields.

The dates default to the current week. You may change these dates by clicking on the fields and 
entering the date or by clicking on the arrow button. The double arrows change the date by a 
week at a time and the single arrow changes the date a day at a time.

5 If you want to calculate overtime for the report, click the Determine Overtime box and enter a 
multiplier in the Over 40 hrs multiplier field.

This is only for the report calculation and does not update the database.

6 Choose the output destination by clicking on the arrow next to the output field. Select one of the 
following:

Print – Select this option to output the file to a printer. The file is sent to the selected default 
printer.

View – Select this option to see what the printed output will look like before you print it. When the 
information appears on the screen.

File – Select this option to save the summary information to a text file. You can then edit the file 
outside of VISUAL using any text editor.

E-Mail – Select this option to send the report in a .RTF to an electronic mail recipient.

7 If you want overtime determined for the employee, select the Determine Overtime check box.

8 If you want Holiday time, Vacation time, and Sick time included in an employee report, select the 
Include Holiday/Sick/Vacation check box.

9 Click Ok.

If you selected Print as the output, a standard Windows printer dialog box appears, allowing you 
to select the number of copies to print.

If you selected View as the output, the report appears on your screen for you to view before 
viewing.

If you selected File as the output, a dialog box appears in which you can specify where you want 
to save the report.

If you selected E-mail as the output, when you generate the report the system attaches the file to 
a Microsoft Outlook e-mail. See your Microsoft Outlook user documentation.

Printing Trace Labels
To print trace labels:

1 Click the Print Trace Labels button on the main toolbar or select Print Trace Labels from the 
File menu.

The Print Part Trace Labels dialog appears, displaying the Transaction ID, Part ID, and 
Description.

2 Select the label format.
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You can choose from the standard label format, or one of three user-defined formats. The user-
defined formats are only be available if the form has been defined.

3 Click the Ok button.

A standard Windows Print dialog box appears.

4 Make any appropriate selections, then click the Ok button to print the labels.

Printing Trace Thermal Labels
Labor Ticket Entry allows you to print thermal labels for traceable labor transactions. Before you can 
print a label, though, you must create the appropriate label types. You can only print LBR_Traceable 
type labels from the Labor Ticket Entry window.

Note: Automotive users should read the “barcode Labor Transactions” chapter before attempting to 
print thermal labels.

1 From the File menu, select Print Trace Labels or click the Print Trace Labels button.

The Print Part Trace Labels dialog box appears.

2 Click the Thermal Labels button.

The VISUAL Print Thermal Labels dialog box appears.

3 If you are licensed to use multiple sites, click the Site ID arrow and select the site associated with 
the transaction. If you are licensed to use a single site, this field is unavailable.

4 Click the Label ID button to choose the label you want to print for this pack list.

See the chart in the appendix for more information on which label types you can use in the Labor 
Ticket Entry window.

5 Click the Label Group ID to choose the Label Group to print. If you are printing only one label, do 
not choose a group. You can choose either a Label ID or a Label Group ID.

The read-only Label Type field is auto-filled with the type of label you specify.

6 If you are printing a group, click the Insert button and add any new labels, if appropriate.

7 Specify a print quantity in the Print Qty. field.

8 Verify that your thermal label printer is configured properly, and then click the Print Labels button.
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Exporting Labor Tickets to Payroll
Before you attempt to export labor tickets to Payroll, you must ensure that the codes in VISUAL and 
the codes in Payroll are the same for the export.

Within Labor Ticket Entry each labor ticket has an Earnings code. You can set up these codes in in 
Employee Maintenance. These are the codes Payroll uses to process Payroll.

You need to set up each of these codes in Payroll. To do this, you must add these codes to the 
earnings and deduction codes in Company Maintenance. See the Payroll documentation for more 
information.

When the codes are the same in both areas, you can prepare the file for the export process.

1 Select VMEXPLAB.EXE from the directory where your executables are installed.

2 Click the SQL/PAY button to select the export attendance transactions to Payroll option.

3 Enter the Company ID in the Company ID field.

4 Enter or select the date range for the export.

Make sure the date range covers all tickets you are importing.

5 Select the appropriate Period type.

You can choose Weekly, Bi-weekly, Semi-monthly, or Monthly.

6 Select the appropriate Pay Rate radio button.

Determine if the pay rate should come from Employee Maintenance or from Payroll.

7 Select an Export Type. You can choose from:

Export in detail – If you export in detail, each labor ticket is included in the export file.

Export in summary – If you export in summary, the labor tickets summarize for each code and 
employee. This is the preferred method for keeping Payroll more manageable. You can always 
review the detail within Labor Ticket Entry if there is a discrepancy.

8 Select the appropriate rounding criteria, if necessary.

9 If you want Import/Export to calculate, check the Determine Overtime check box.

Click the Setup button to set up overtime. Set “Setting Overtime” later in this chapter.

10 Click Ok.

A dialog box appears, prompting you for a file name.

11 Save the file to the root Payroll directory.

At this point you are ready for the import function within Payroll. See the Payroll documentation for 
more information.

Setting Overtime
You can use Import/Export to calculate overtime. Select the set up button.
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1 In the Export Attendance Transactions dialog box, select the Determine Overtime check box.

The Setup button becomes active.

2 Click the Setup button.

3 Enter the appropriate overtime values for Premium 1.

Multiplier – This is the overtime pay rate. For example, a multiplier of 1.5 equals a pay rate of 1.5 
times the base pay rate.

Over – Enter the hours over which the overtime pay rate becomes effective. You can enter this 
value in hours per week and hours per day.

4 Enter the appropriate overtime values for Premium 2, which is effective on the selected day of the 
week.

Multiplier – This is the overtime pay rate.

Day of Week – Select the day or days on which you want the Premium 2 pay rate to be effective.

For example, if you have a multiplier of 2 and check the Sunday check box, the overtime rate on 
Sunday is double the base pay rate.

5 If you want to apply vacation, holiday, and sick time to the regular hours total, click the appropriate 
check boxes.

6 Click Ok to save the changes.

Exporting General Journal Entries from Payroll
Before you can export general journal entries from Payroll, you need to create an export file in 
Payroll. See the Payroll documentation for more information on creating export files.

After you have created the export file and reviewed it in Payroll, you can export the file. To do this:

1 Select Vfimpexp.exe from the directory where your executables are installed.

The Financials Import/Export window appears.

2 Click the Import General Journal button or click the button of the same name on the main 
toolbar.

The Import General Journal Transactions dialog box appears.

3 If you are licensed to use multiple sites, click the Site ID arrow and select the site into which you 
are importing general journal transactions. If you are licensed to use a single site, this field is 
unavailable.

4 Specify a batch date in the Batch Date field.

The accounting period defaults according to the batch date.

5 Enter an identifiable batch description in the Batch Description field.

6 Enter a suspense Account ID.
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The suspense Account ID is for those accounts from Payroll that do not match those of 
Financials.

If the accounts do not match and there is no suspense Account ID set up, the file is not exported.

7 In the Import File field, enter a file name for the file that you are exporting.

8 If you are using a suspense account, you must check the Post Invalid Accounts to Suspense 
account check box.

9 Click the KIS Payroll for Windows M.Y.O.B. format radio button.

This format more closely matches the file format that Payroll has created.

10 Select the appropriate import type option:

Detail – Select this option to create one journal entry and to combine any accounts with the same 
account numbers.

Summary – Select this option to keep the account number separate, even if you have the same 
account numbers within the journal entry. This is the recommended option.

Click the Format Info button for more information.

11 Click Ok to export the file into Financials.

The file is automatically posted to the General Ledger.

See the Payroll and Financials documentation for more information.
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What are Work Order Travellers?
Work Order Travellers are reports that provide two main functions; each is printed as a separate 
report:

• Provide Work Order Paperwork to Shop Operators. This report provides a succinct report of all
pertinent work order, customer, and operation information for a work order, and is specifically
designed to accompany in-process material as it travels through the shop. Thus, it includes all
information needed to manufacture the part, including drawing numbers and revisions,
specifications, Part IDs and quantities. Additionally, you can print the work order traveller with
barcodes for use with the Barcode Labor Entry application. The Traveller Format portion of the
Work Order Traveller provides this function.

• Provide Material Requirement Paperwork to Material Handling Personnel. This report
provides a material pick list for issuing material to a work order. All pertinent part information is
included in the report, including Part ID, unit of measure, specifications, and warehouse locations.
Additionally, you can print the pick list with barcodes for Part IDs. The Picklist Format portion of
the Work Order Traveller provides this function. 

You can print travellers and picklists manually, or you can set up a service to print the travellers and 
picklists for you. If you print travellers manually, you can save your print settings to print profiles. You 
can use these print profiles to quickly set up the Work Order Traveller window for subsequent print 
jobs. 
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Printing Travellers & Picklists
After you select print settings, you can save them for future use. See "Working with Saved Work 
Order Traveller Print Settings" on page 8–6 in this guide. 

Use this procedure to print travellers manually. You can also use a service to schedule traveller print 
jobs. See "Printing Work Order Travellers with the Reporting Service" on page 8–12 in this guide.

If you are licensed to use multiple sites, you can include multiple sites in the report.

To print travellers/picklists:

1 Select Eng/Mfg, Work Order Traveller from the main menu. 

Note: If you are working in the Manufacturing Window, you can select File, Print Work Order 
Traveller Report. The Work Order Traveller Report is opened, and the current work order is 
selected for printing.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report.

3 Select the work orders for which you are printing travellers either by Base ID or by date range:

a To select specific work orders by Base ID click the Base ID browse button. You can select 
one work order or multiple work orders. You can sort and filter the table to help you find the 
work orders to print.

• To sort the table select one of these options:

By Work Order ID – Select this option to sort the table by work order ID. 

By Customer ID – Select this option to sort the table by customer ID. Work orders without 
customers do not appear in the table.

By Planner ID – Select this option to sort the table by planner ID. Work orders without 
planners do not appear in the table.

• To filter the table by work order status, select one or more of these check boxes:

Unreleased – Select this option to view unreleased work orders.

Firmed – Select this option to view firmed work orders.

Released – Select this option to view released work orders.

• Click Ok after you have selected the work orders you would like to print.

b To select a range of work orders based on date, leave the Base ID field blank. Specify this 
information:

Earliest Date and Latest Date – Specify the time period to use to identify the work order 
travellers to print. 

Date Parameter – Specify whether the time period applies to release dates or scheduled start 
dates. If you select Release Date, then travellers for work orders with release dates in the 
time period you specify are printed. If you select Sched Start Date, then travellers for work 
orders with scheduled start dates in the time period you specify are printed.

Status – Select the status of the work orders to consider. Travellers for work orders with the 
status you select are printed.
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4 Add information in the Operation Write-Ins data field with supplementary data that helps to clarify 
and expedite the work order. Use these fields to include additional information on a traveller that 
may, from the time a work order is released until the time it is shipped, make its way to nearly 
every person on the shop floor involved in the production process. If a signature or special note 
may be helpful, enter it in these fields. Click Save as defaults to save write-ins as a default. To 
print the write-in fields you must select the Print operation write-in fields check box before 
printing.

5 Select the format to use:

Traveller format – If you want to sort the traveller by the operation number, you can select the Op 
sequence check box.

Picklist format – If you select Picklist format, select a sort sequence by either Piece number or 
Location ID.

Co-product format – Select this option to print co-product information. You must select this 
check box in conjunction with the traveller format and/or picklist format option.

6 Select the information to include on the traveller or picklist. The check boxes available for 
selection depend upon the document format you selected.

To print a traveller, select this information: 

Print (include) closed ops - To display closed operation information, select this check box. 
Operations can be manually closed, or the can be closed when Run Complete is selected on the 
labor ticket.

Print customer order info – If a customer order is linked to the work order, select this check box 
to include customer order information. This information is included: customer order ID, date, ship 
via code, customer purchase order number, phone number, ID of the ordered part, customer ID, 
customer sold to address, and the customer ship to address.

Print operation write-in fields – To print the information specified in the write-in fields, select this 
check box.

Print part locations – To include a list of warehouse locations where the materials on the work 
order are stored, select this check box. When you select this check box, the Print Only Locations 
w/ Quantity and Use Work Order Warehouses check boxes become available. Select the Print 
only locations w/quantity check box to include only those locations with on-hand inventory for 
the part. Select the Use work order warehouses check box to print only those part locations 
associated with the warehouses specified on the work order.

Print traceability info – To print part trace information, select this check box.

Print reference designators – To print reference designators associated with materials, select 
this check box. Only the reference designator ID is printed on the traveller; the X-Y coordinates 
and descriptions are not printed.

Print alternate parts – To print a list of alternate parts available for each material, select this 
check box.

Print W/O header barcodes – To include a barcode for the work order header, select this check 
box.

Print traveller ops barcodes – To include a barcode for each operation, select this check box. 
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Print Code39 barcodes/Print QR codes – If you are printing barcodes, select the format for the 
barcode. If you select Print Code39 codes, you must have a barcode font package installed to 
properly display the barcodes.

To print a picklist, select this information:

Print (include) closed ops – To include closed operation information, select this check box. 
Operations can be manually closed, or they can be closed when Run Complete is selected on the 
labor ticket.

Print part locations – To include a list of warehouse locations where the materials on the work 
order are stored, select this check box. When you select this check box, the Print Only Locations 
w/ Quantity and Use Work Order Warehouses check boxes become available. Select the Print 
only locations w/quantity check box to include only those locations with on-hand inventory for 
the part. Select the Use work order warehouses check box to print only those part locations 
associated with the warehouses specified on the work order.

Print traceability info – To print part trace information, select this check box.

Print alternate parts – To print a list of alternate parts available for each material, select this 
check box.

Print picklist ops info – This check box is available only if you sequence the picklist by Location 
ID. To include information about the operation resource, select this check box. Below each 
material line, the resource ID, resource type, start quantity, end quantity, run hours, start date, 
finish date, drawing ID and revision associated with the material is displayed. 

Print picklist material barcodes - To print barcodes for the materials included in the work order, 
select this check box.

Print picklist ops barcodes – To print barcodes for the operations in the work order, select this 
check box. 

Print Code39 barcodes/Print QR codes – If you are printing barcodes, select the format for the 
barcode. If you select Print Code39 codes, you must have a barcode font package installed to 
properly display the barcodes.

7 Click the arrow and select the type of output for the report. You can select:

Print – To send the report to your printer, select the Print option.

View – To view the report using report viewer, select the View option.

File – To send the report to text file, select the File option. Your report is prepared as a RTF file 
and a dialog box appears prompting you to enter the location and file name for the file to be 
saved.

E-mail – To prepare the report and attach it to an e-mail, select the E-mail option. The report is 
prepared as a RTF file and it is attached to a Microsoft Outlook e-mail. See your Microsoft Outlook 
user documentation. Click Send when you are ready to send the message. 

To e-mail a PDF instead of an RTF file, select the PDF Format check box.

8 If you selected Print for the report output, you can include documents associated with the work 
order. Select from these check boxes:

Print associated documents – To print all of the documents attached to the work order, select 
this option.



Printing Travellers & Picklists

8 – 6 | Infor VISUAL Inventory User’s Guide 

Sequence attachments – If you are printing more than one traveller and you would like to collate 
the output by work order, and you select this option, the system outputs the traveller, then the 
picklist, then the co-product, then the associated documents. This option is available only if you 
have selected the Print Associated Documents check box.

9 If you are outputting a range of work orders by date, specify whether to reprint travellers that have 
already been printed. Select from these check boxes:

Print Previously Printed Work Orders – To print work order travellers that have already been 
printed, select this check box. 

Print Unprinted Work Orders – To print work order travellers that have not yet been printed, 
select this check box. 

10 These options are available only if you select Traveller Print as the output format: 

Auto Release all details of each Work Order – Select this option button to release all operations 
and material requirements attached to a work order or leg header card. If the work order has legs 
and you select a specific sub ID, then only the resources and materials attached to the sub ID are 
released. 

Change Status of Subordinate Materials and Operations – If you select the Auto release all 
details of each work order check box, all subordinate legs are released. For example, if you are 
printing a traveller for a work order header card, selecting this check box also releases any leg 
header cards in the work order along with the materials and resources attached to the legs. Clear 
this check box if you do not want to release subordinate legs when you release a work order 
header. 

Exclude closed/cancelled subordinate legs – If you select the Auto release all details of each 
work order check box and the change status of subordinate materials and operation check box, 
select the Exclude closed/cancelled subordinate legs check box to retain the current status of any 
closed or cancelled legs. If you clear this check box, then the closed or cancelled legs are re-
released. 

11 Select File, Print/View, or click the Print toolbar button to output the report. 

If printing both travellers and picklists, they are output in two separate jobs.

You are asked if the travellers/picklists printed correctly. Answering yes commits the release of  
firmed work orders ready for release. Answering no prompts the print setup dialog to display 
again, allowing you to reprint the traveller/picklist. 

Working with Saved Work Order Traveller Print Settings
After you select print settings for travellers and picklists, you can save your settings. When you save 
print settings, all settings on the main window are saved. You can save multiple print setting 
configurations. Your saved print setting configurations are available only to you. Other users cannot 
use your print setting configurations.
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Saving Work Order Traveller Print Settings
To save your settings:

1 In the Work Order Traveller window, select the print settings.

2 Select File, Save Print Option As.

3 In the Name field, specify the name for this print option.

4 To use these print settings as your default settings, select the Default check box. When you next 
open the Work Order Traveller, your default settings are loaded.

5 Click Save. 

Loading Saved Work Order Traveller Print Settings
To load saved print settings into the Work Order Traveller window, specify the print settings to load in 
the Option Name field. The settings are loaded. Click Print to generate the travellers or picklists.

Editing Saved Work Order Traveller Print Settings
To edit an existing print settings profile:

1 In the Option Name field, specify the name of the profile.

2 Make edits as necessary.

3 Select File, Save Print Option.

Resetting Print Settings
To reset Work Order Traveller window print settings, select File, Clear Print Option. The Work Order 
Traveller window is restored to its default settings. 

Controlling Work Orders Printed
There are several options for selecting which work orders have travellers or picklists printed:
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Printing Single Work Orders
By specifying a Site ID, Base ID, Lot ID, Split ID, and Sub ID, you can print a new traveller and/or 
picklist for a work order, regardless of its status. You can select a single leg to print, or All. This allows 
individual legs to be started before the main leg, or in parallel with it.

To print a single work order, you must fill in all five fields.

Printing by Release Date Range
You can specify an open or closed range for release dates by indicating an earliest and/or latest 
release date in the Earliest Release Date and Latest Release Date fields. 

If you leave the Earliest Release Date field blank, all firm and released work orders, up to and 
including any specified Latest Release Date are included. Likewise, if you leave the Latest Release 
Date field blank, all work orders with release dates on or after the specified earliest date are included. 
If you leave both fields blank, all work orders, without regard to release date, are included.

Release Date Range in combination with the other options listed below determine which work orders 
are actually printed.

Printing Firmed Work Orders Only
If you select the Firmed option button only work orders with a Firmed status are printed. Otherwise, 
all Firm and Released work orders are printed. 

Printing Automatic Releases
If you select Auto Release all Details of each Work Orders, all work orders in the specified release 
date range that currently have a status of Firm are automatically released before printing the traveller. 
This also applies to a single selected work order or work order leg with a status of Firm.

For automatically released work orders, the Auto Release all Details of Each Work Order option also 
releases all operations and materials, and all legs of the work order or single leg, at the time it is 
released. If you do not select this option, only currently firmed and released operations and 
requirements are printed.

This feature allows the production manager to combine work order release and paperwork generation 
into a single operation.



Printing Travellers & Picklists

Infor VISUAL Inventory User’s Guide | 8 – 9

Printing Unprinted Released Work Orders
If you select Print Unprinted Work Orders, work order travellers are printed if the work order has not 
previously been printed. 

Selecting Traveller Content Options

Printing Operation Barcodes
If you are using Barcode Labor Entry, this option allows printing of a barcode that encodes the work 
order Base ID, Lot ID, Split ID, Sub ID, and Operation Number. You need the Code 39 barcode font 
on the system that is printing the traveller.

Printing Customer Order Info
If a customer order is linked to the work order, this option prints customer order information in the 
traveller’s header section. This includes Order ID, Order Date, Ship Via, Customer PO Number, 
Phone, FAX, Customer Part ID, Customer Name and Address, Ship To Address, and the Drawing/
Revision from the order line.

Printing Operation Write-ins
Operation Write-ins provide for up to four data entry areas on each operation printed, to be filled in by 
operators, supervisors, or other production personnel. Specify the labels for these fields in the 
Operation Write-in fields in the upper right of the dialog box. Defaults are stored in the Traveller 
section in Preferences Maintenance. The dialog box always appears with these defaults, which you 
can override. When you print them, the four write-ins appear horizontally for each operation on their 
own line. 

Printing Part Locations
This option shows all valid part locations for each part requirement. The requirement is indicated if it 
is for an auto-issue part.



Printing Travellers & Picklists

8 – 10 | Infor VISUAL Inventory User’s Guide 

Printing Traceability Information
If you are using Part Trace Maintenance, this option allows you to print part traceability information for 
parts associated with this work order.

Selecting Picklist Content Options
In addition to the options listed for the traveller above, you can select the following information for 
picklists:

Printing Material Barcodes
If you are using Barcode Material Entry, this option allows printing of a barcode that encodes work 
order Part ID with each material requirement on the picklist. You need the Code 39 barcode font on 
the system that is printing the traveller.

Printing Part Locations 
Similar to the option for the traveller format, this option prints all valid part locations, or auto-issue, for 
each material requirement.

All specified picklists are printed as one print job. If you want to print all legs, all materials for all legs 
are printed as one list.

Viewing Traveller Contents
All specified travellers are printed as one print job. Pages break for each leg and each work order to 
allow separate distribution.

A traveller has the following basic sections:

Work Order/leg Information - Printed at the start of each work order or leg, includes Work Order 
Base ID-Sub ID/Lot ID, Release and Want Dates, Drawing/Revision, and Quantity.

Customer Order Information - If selected, prints at the beginning of each work order.

Operation Information - For each operation, includes Resource ID, Specifications, Start/End 
Quantities, Setup and Run Hours, and Scheduled Start and Finish Date. Operation write-ins and 
barcodes print here, if selected.

Material Requirements - For each material requirement on each operation, Part ID, Unit of Measure, 
Quantity Required, Quantity Due, and a write-in area to indicate any issued material are printed 
beneath the operation.
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Viewing the Picklist Report
The picklist format has the following basic sections:

Work Order Information - Printed at the beginning of each work order, includes Work Order Base ID/
Lot ID, Release and Want Dates, Drawing/Revision, and Quantity.

Material Requirements - For each material requirement on the specified leg or legs of the work 
order, Part ID, Sub ID of leg, Operation Sequence Number of Operation, Piece Number within 
operation, Unit of Measure, Quantity Required, Quantity Due, and a write-in field for any issued after 
this report is printed.

Material barcodes and part locations also appear here.

You can print material requirements in part location sequence or in Sub ID, Operation Number, Piece 
Number sequence.
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Printing Work Order Travellers with the Reporting 
Service
You can use the Reporting Service to print work order travellers and picklists on the days and time 
you specify. 

After you install the service, use the Set as Scheduled dialog in the Work Order Traveller window to 
specify when to print work order travellers and picklists. You can use the service to print travellers and 
picklists once per day. 

Print job schedules are saved by user. Each user can schedule one print job per allowable site. The 
system administrator can control a user’s access to the Set as Scheduled dialog in Security 
Maintenance. 

When you set up a schedule, you must select only one site in the Site ID field. To print travellers for 
multiple sites using the service, you must set up a separate schedule for each site.

When you set up information in the Set as Schedule dialog, you set it up at the site level. If you use 
the service, your print job can only include travellers and picklists for a single site. When you use the 
service, you cannot combine multiple sites in a single print job. 

After the service is installed and the service schedule is set up, the database is examined based on 
the polling interval you specify to see if a travellers and picklists need to be printed. When a print job 
is found, the service opens the Work Order Traveller window and prints the travellers and picklists 
based on the settings you specify in the Set as Scheduled dialog. 

You can install the service once per database.

If you set up the Reporting Service, you can still print travellers and picklists manually. 

Installing the Reporting Service
To install the service:

1 In your VISUAL executables directory, locate VRPTSVC.EXE.

2 Perform one of these steps:

• If you do not use single sign-on, right-click VRPTSVC.EXE and select Run as Administrator.
The Sign In dialog is displayed.

• If you do use single sign-on, run a command prompt as the System Administrator. In the
Command Prompt line, specify <service path>/VRPTSVC.EXE -SYSADM. Replace <Service
path> with the path where VRPTSVC.EXE is installed. The Sign In dialog is displayed.

3 Specify this information:

User ID – Specify the user ID that the service uses to sign into the VISUAL database. This can be 
any valid VISUAL user ID who has permission to access the Work Order Traveller window 
(VMTRVRPT.exe).

Password – Specify the password associated with the user ID.

Database – Specify the database on which to run the service. 
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4 Click Sign In. The name and description of the service is displayed. 

5 Specify this information:

Log File Directory – Specify where to store the log file for the service. 

Polling Interval – Specify how frequently the service should check to see if travellers and picklists 
should be printed. Specify the interval in seconds. The maximum value is 900 seconds. If you 
specify a value greater than 900, your value is replaced with 900.

Log Level – Specify the level of information to write to the log file. Click one of these options:

None – To write the time the service started, click this option. This option is recommended for 
normal production environments.

Error – To write the time the service started and any error messages, click this option.

Info – To write to the time the service started, error messages, and additional information 
about the service, click this option. The use of this option is recommended only if you are 
troubleshooting issues with the service. When you use this option, the size of the log file 
grows quickly. 

The log file's name is VRPTSVC.log. The size of the log file is limited to 1 MB. When the log file 
approaches 1 MB, the log is renamed to VMRPTSVC_[Current date time].log, and a new 
VRPTSVC.log is created.

6 Click Install Service.

Specifying Printers to Use with the Service
When you set up the service schedule in the Work Order Traveller window, you select the printer to 
use from a drop-down list. Use the Available Printers dialog to specify the printers to include in the 
drop-down list.

To add a printer:

1 In the Infor VISUAL Report Generation Service dialog, click Printers.

2 Click Add. 

3 Select the printer to add. If necessary, click the Setup button to specify the printer settings to use. 
The settings available depend upon your printer. 

4 Click Ok.

5 Click Save. 

Scheduling the Service
After you install the Reporting Service, specify when the Reporting Service should be prompted to 
print travellers and picklists. Also specify the information to print. 
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Schedules are save by user. Each user can have as many print schedules as they need. When you 
set up a schedule, you must select only one site in the Site ID field. To print travellers for multiple sites 
using the service, you must set up a separate schedule for each site. 

To schedule the Reporting Service:

1 Select Eng/Mfg, Work Order Travellers.

2 In the Site ID field, specify the site for which to print travellers or picklists. You must select one site 
only. If you select multiple sites, the Set as Scheduled menu option is not active. 

3 In the Work Order Traveller window, specify the settings to use for the print job. For information 
about the settings, see "Printing Travellers & Picklists" on page 8–3 in this guide.

4 Specify when the service is active. Specify this information:

Start Date – Specify the date that the service should start checking for updates. Leave this field 
blank or specify today’s date if you do not want to delay the start of the service.

End Date – Specify the last date that the service should check for updates. Leave this field blank 
if you do not want to set up an expiration date for the service.

Enabled – To use the service with the selected schedule, select this check box. To stop using the 
service, clear this check box. 

5 In the Run Type section, weekly is selected. You cannot change this selection. This selection 
indicates that the service should check for print jobs only on the days and times you specify.

6 In the Days of Week section, specify the days of the week to run the service. 

7 Use the Run At section to specify the time of day that the service should check for updates. The 
time you specify apply to all days that you run the service. 

Note: The service may not run exactly at the time you specify. The service is prompted to check 
for print jobs at the time you specify, but the polling interval specified for the service may pass 
before the travellers or picklists are printed. 

8 In the Printing section, specify this information:

Printer – Specify the printer to use with this scheduled print job. To add a printer to the list, use  
VRPTSVC.exe. See "Specifying Printers to Use with the Service" on page 8–13 in this guide.

Copies – Specify the number of copies to print. If you specify 0, the default number of copies 
defined on the printer’s driver is used. 

9 Click Save. 

If you have multiple sites, repeat this procedure for each site for which you want to print travellers and 
picklists with the Reporting Service. 

Deactivating the Reporting Service Schedule
You can deactivate your scheduled print jobs. For example, if you are going on vacation and do not 
want your print jobs to be run while you are out of the office, you can deactivate your print jobs.
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If you set up print job schedules for more than one site, then you must deactivate each schedule 
separately.

To deactivate a scheduled print job:

1 Select Eng/Mfg, Work Order Traveller.

2 In the Site ID field, specify the site for which you are deactivating the service. 

3 Select File, Save as Scheduled. 

4 Clear the Enabled check box.

5 Click Save. 

Monitoring Reporting Service Print Jobs
If you have set up the VISUAL Reporting Service (VRPTSVC.EXE) to automatically run print jobs 
based on a schedule, use the Report Service Configurations dialog to monitor print jobs. You can 
review current Report Service print jobs, activate and deactivate them, and delete them.

Reviewing Reporting Service Print Job Configurations
To review the print job configurations:

1 Select Admin, Application Global Maintenance. 

2 Select Maintain, Report Service Configurations.

3 Review this information:

Report Type – The type of report that the service runs is displayed. For example, if a user has set 
up a print job for work order travellers, then Work Order Traveller is displayed.

Site ID – If applicable, the ID of the site where the report is run. Certain reports must be run one 
site at a time.

User ID – The ID of the user who scheduled the reporting service to run the report is displayed.

Enabled – If the reporting service configuration is currently active, this check box is selected. If 
the configuration is current inactive, this check box is cleared.

Last Run – The date and time that the service ran the configuration is displayed. 

Printer – The printer where the service sent the print job is displayed.

4 To reread configuration information from the database, click Refresh.

Deactivating Reporting Service Print Job Configurations
To deactivate a reporting service print job configuration:
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1 Select Admin, Application Global Maintenance. 

2 Select Maintain, Report Service Configurations.

3 Clear the Enabled check box.

4 Click Save.

If you are deactivating more than one print job, you must click save after each time you clear the 
Enabled check box. 

Deleting Reporting Service Print Job Configurations
To delete a reporting service print job configuration:

1 Select Admin, Application Global Maintenance. 

2 Select Maintain, Report Service Configurations.

3 Select the configuration to delete.

4 Click Delete. An X is displayed in the row header, indicating that the row will be deleted.

5 To complete the deletion, click Save. To cancel the deletion and retain the configuration in your 
database, click Delete again. The X is removed from the row header. 

Removing the Reporting Service
If you no longer want to use the service to print travellers and picklists, remove the service. After the 
service is removed, users can only print travellers and picklists manually.

To remove the reporting service:

1 In your VISUAL executables directory, locate VRPTSVC.EXE.

2 Right-click VRPTSVC.EXE and select Run as Administrator. The Sign In dialog is displayed.

3 Specify this information:

User ID – Specify the user ID that the service uses to sign into the VISUAL database. This can be 
any valid VISUAL user ID.

Password – Specify the password associated with the user ID.

Database – Specify the database on which to run the service. 

4 Click Sign In.

5 Click Remove Service. 



Barcode Labor Transactions

Infor VISUAL Inventory User’s Guide | 9 – 1

Chapter 9: Barcode Labor Transactions

This chapter includes:

Topic Page

What is Barcode Labor Ticket Entry? ............................................................................................. 9–2
Using Wedge Barcode Labor Ticket Entry ...................................................................................... 9–3
Performing Wedge Barcode Tasks ................................................................................................9–11
What is BTS?................................................................................................................................ 9–18
Installing and Setting Up BTS....................................................................................................... 9–22
Using BTS..................................................................................................................................... 9–31
Printing BTS Reports .................................................................................................................... 9–43
Processing Selected Rows ........................................................................................................... 9–45
Using the Archiving Utility ............................................................................................................. 9–46
Using BTS..................................................................................................................................... 9–47
Using ALTS ................................................................................................................................... 9–62
Printing Barcodes ......................................................................................................................... 9–67



What is Barcode Labor Ticket Entry?

9 – 2 | Infor VISUAL Inventory User’s Guide 

What is Barcode Labor Ticket Entry?
The Labor Ticket Entry application (non-Barcode) is designed for entering batches of previously 
completed paper labor tickets. However, there may be times when you may prefer to have the 
operators themselves enter labor ticket information on a more timely basis. There are two major 
advantages to this:

• At any point in time, the work order and shop status shown in VISUAL very accurately reflects the
true situation.

• The administrative task of ticket entry is distributed among all operators, who otherwise would still
need to complete paper tickets. Therefore, a re-keying step is eliminated, along with the
possibility of any errors.

Barcode Labor Ticket Entry allows operators to enter their own labor tickets.

• Wedge Barcode Labor Ticket Entry - This application works with a barcode keyboard wedge,
which is a device that plugs into the keyboard line of a standard PC, allowing you to use
barcoding without any other special equipment.

Both types of labor barcode entry provide subsets of the total Labor Ticket Entry function. You must 
perform certain tasks, such as deleting a ticket or over-reporting time, using the standard Labor Ticket 
Entry application. The labor barcode modules are not designed for time and attendance but for labor 
reporting purposes.

This chapter covers both labor barcode entry applications.

Understanding Barcode Labor Transactions
There are three types of labor tickets: setup, run, and indirect. Use manual Labor Ticket Entry to enter 
these tickets after they are completed. Barcode Labor Ticket Entry allows you to enter tickets in two 
parts, start and finish. This is done by using a temporary labor ticket called an in-process ticket. An in-
process ticket represents a started transaction that has not been completed. It is represented by a 
labor ticket with identical clock in and clock out times and a null (empty) elapsed time. This indicates a 
ticket that started at the specified time and will be completed at a later time. When an employee has 
an in-process ticket, the employee is “clocked-in.”

Barcode Labor Ticket Entry uses these tickets to create an unbroken string of setup, run, and indirect 
transactions. In other words, the clock in time of a ticket is equal to the clock out time of the previous 
ticket. Note that the application needs to assign time to either an indirect or job at all times while the 
employee is considered clocked in. If the application has not been ‘told’ where to apply this time (by 
wanding a ‘specific indirect’ or starting a job), then it accumulates the time to a ‘default indirect ID’ as 
specified in the Administrator Setup section of the barcode application.

Caution:  Never manually delete an in process labor ticket that you created using Barcode 
Labor Ticket Entry. Instead, edit the transaction and save it with an Hours Worked 
value of zero. Do not attempt to create an in-process (open) ticket manually, create 
the ticket via barcode only. If necessary, you can then change the clock in time by 
using ‘Retrieve In Process’ in labor ticket entry.
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Using Wedge Barcode Labor Ticket Entry
Wedge Barcode Labor Ticket Entry is NOT available from the Main window. You can start Wedge 
Barcode Labor Ticket Entry from Windows Explorer.

To start Barcode Labor Ticket Entry:

Double-click Vmbclabr.exe located in the directory where your executables are installed.

The Barcode Labor Ticket Entry window appears.

Two on screen features guide you through the ticket entry process. A large, left-pointing arrow 
appears to the right of the input that is expected. A message line on the bottom left of the window tells 
you what action needs to be completed. The current time appears in the upper right corner of the 
Barcode Labor Ticket Entry window.

Clicking on the Clear button at any point before the transaction is complete aborts all entries and 
clears the window. The window clears automatically if you do not input information for five minutes.

If you experience trouble scanning barcodes, the most common solution is to change the barcode 
font type on the QRP to CODE39TWO and/or change formatting from bold to not bold, or the reverse. 

Wedge barcoding is a labor tracking system much like ALTS but requires the user to have direct 
access to a computer. The Wedge barcoding system is designed to accept data input only from a 
keyboard or Wedge type barcode scanner. Wedge is so called because the hardware for the system 
“wedges” between the keyboard and the computer. When you type, the keyboard sends the 
characters to the computer as usual; when you scan a barcode the scanner converts the barcode to 
keyboard code and sends them to your computer as if you had typed them. If you are using a 
software wedge and a communication port connection for your scanner, the computer interprets the 
incoming data and reroutes it to the keyboard buffer as if you had typed it.

The Wedge barcoding system uses a Graphical User Interface (instead of text based like ALTS and 
BTS) and does not use a Telnet server.

The Wedge barcoding system is not compatible with Telnet compliant scanners.

Setting Up Administrator Preferences
Administrator Setup contains options controlling the operation of Barcode Labor Ticket Entry. You 
can only access Administrator Setup when you are logged in as SYSADM. Options are stored in 
Preferences Maintenance under the Barcode Labor Entry section on the barcode client.

1 In the VISUAL executable directory, double-click Vmbclabr.exe. 

2 Select File, Administrator Setup.

3 In the table, a list of the indirect IDs in your system is displayed. You can add or delete indirect IDs 
directly in the Preferences/Setup dialog. See "Editing Indirect IDs" on page 9–6 in this guide. 

4 In the Multiple Jobs section, specify whether an employee can clock in to more than one job at the 
same time. Click one of these options: 

Do not allow – Click this option if employees can clock in to only one job at a time. 
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Prorate Hours Spent on Work - For each overlapping ticket for the same employee, this 
option divides elapsed time by the total number of simultaneous tickets and adjusts the 
elapsed hours accordingly. For example, If two jobs (run simultaneously) begin at 1:00 and 
end at 3:00, the hours worked will be 1.0 for each job (2 hours / 2 jobs).

Prorate Cost of Work - The multiplier of overlapping tickets is adjusted to a value less than 
one, based on the amount of overlapping time. Using the example above but under this 
proration method, hours worked are 2.0 hours for each ticket and the multiplier for each is .5 
(calculated as 1 divided by the number of jobs = ½ or .5). You can view this multiplier in the 
‘Multiplier 2’ field of manual Labor Ticket Entry. Only if you look at the Detail or Summary 
Labor Report, will the hours calculated  include the multiplier, showing hours worked as 1 
hour for each job (2 hours * .5 = 1 hour).

The option you choose partially depends on if you want tickets to accurately reflect the real 
elapsed time. If you do, choose Prorate Cost of Work. Both options will result in the same labor 
costs but not burden costs. Prorate by Cost assigns burden without regard for other jobs in 
process; it does not prorate burden. Prorate by Hours assigns burden based on the prorated 
hours.

For example, assume Job A and Job B have a resource burden costing $20 an hour and the 
employee running the jobs is paid $10 an hour. Job A and B are run simultaneously for one hour. 
Prorate by Cost assigns $5 for labor (($10/hour * 1 hr.) / 2 jobs) for each job and $20 for burden 
on each job ($20/hour * 1 hour), totaling $10 for labor and $40 for burden during that one hour. 
Prorate by Hours calculates $5 for labor (($10/hour * 1 hr.) / 2 jobs) and $10 for burden (($20/hour 
* 1 hour) / 2 jobs) on each job, totaling $10 labor and $20 for burden for the one hour.

Typically, a machine-intensive shop will prorate by cost to assign full burden to each machine. 
Labor-intensive, assembly-oriented shops typically use prorate by hours. Efficiency ratings (under 
production schedule reports) will be meaningful using this method.

5 In the Operation Reporting section, specify whether employees can work on operations out of 
order. Click one of these options:

Allow out of sequence – Click this option to allow employees to work on the operations in a work 
order in any order.

Do not allow out of sequence – Click this option to require employees to work on the operations 
in a work order in order.

Prompt when out of sequence – Click this option to display a message when employees begin 
on operation out of sequence.

6 Specify these settings:

Duration Threshold - Specify in hours the longest transaction allowed. The maximum value is 
24. When an employee tries to complete an in-process transaction with a longer elapsed time 
than this threshold, the transaction is not allowed and a message is displayed. You must complete 
the transaction using manual Labor Ticket Entry. When you complete the transaction in labor 
Ticket Entry, automatic breaks are not accounted for and must be entered manually.

Default Indirect ID - Specify the ID to use for all indirect time that is not specifically logged using 
the Indirect action.

Allow Comments on Indirects – Select this check box to allow employees to specify comments 
when they enter indirect labor tickets. 
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Announce Transaction Accepted - Select this check box to display a message that states 
whether the transaction succeeded or failed. 

Ask for Confirmation Before Save - Select this check box to prompt the employee to confirm the 
transaction before saving it. 

Automatically Compute Quantity Complete - Select this check box to compute quantity 
complete based on elapsed time. To use this feature, the resource for the job must have a run 
type of pieces per hour. 

If the Quantity Complete by Hours check box has been selected on the operation to which you are 
reporting labor, then the Automatically Compute Quantity Complete setting in the Administrator 
Setup dialog is ignored. The Quantity Complete by Hours check box can be selected on the 
operation itself, on the work order header, or in Site Maintenance. 

See "Setting Preferences in Site Maintenance and the Manufacturing Window" on page 9–7 in 
this guide. 

If you allow employees to clock into multiple jobs at the same time, then it is presumed that the 
entire clocked in time applies to all jobs that the employee has clocked in to. For example, 
presume that an employee has clocked in to three jobs at the same time and worked for three 
hours. When the employee stops the jobs, an elapsed time of 3 hours is displayed on all three 
labor tickets. 

To calculate elapsed time by dividing the total time worked by the number of jobs, specify this 
information in Preferences Maintenance:

Section - BarcodeLaborEntry

Setting - CalcQtyCompleteOnTotalHours

Value - N

If you use this preference setting, then the amount of time clocked in is divided by the number of 
jobs. For example, presume that an employee has clocked in to three jobs at the same time and 
worked for three hours. When the employee stops the jobs, an elapsed time of 1 hour is displayed 
on all three labor tickets. 

Preferences Maintenance is available on the Admin menu in the main VISUAL application.

This preference setting applies if you set up the automatic calculation of quantity complete in the 
Administrator Setup dialog of Wedge Barcode, in Site Maintenance, or in the Manufacturing 
Window. 

Auto Stop Indirect on Initial Start Job - Select this check box to automatically close the open 
indirect labor transaction when an employee starts a job. If you select this check box, specify how 
to determine the department and cost category to use on the indirect transaction in the Assume 
work order department and cost category field. If you are licensed to use A&D functions, also 
specify the project department and cost category to use in the Assume project department and 
cost category field. For each field, select one of these options: 

Employee – Select this option to use employee’s default department and cost category.

Prompt (Emp) – Select this option to prompt the user for a valid employee department and 
cost category.

Resource – Select this option to use the resource’s default department and cost category.
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Prompt (Res) – Select this option to prompt the user for a valid resource department and cost 
category.

Edit Quantity Complete vs. Standard - To allow employees to enter a quantity greater than the 
quantity required by the work order, select this check box. In the Allowable percentage over 
standard field, specify the percentage to use to calculate the allowable quantity. Employees 
cannot enter quantities greater than the work order quantities plus their allowable percentages..

Employee ID Must Be Scanned/Wanded In - Check this box to require an employee ID be 
scanned/wanded into the system, as opposed to entering the ID via the keyboard. This setting is 
an effective security measure to prevent other employees from clocking in as (or for) someone 
else.

Prompt for indirect department and cost category - To prompt users to specify a department 
and cost category on indirect jobs, select this check box. 

Operation seq no must be scanned/wanded in - If you select this check box, employees must  
enter an operation sequence number by scanning a barcode or wanding in. If you clear this check 
box, employees can use the keyboard to enter operation numbers (Base ID, Lot ID, Split ID, Sub 
ID, Operation Sequence). 

Operator is allowed to change Resource ID - If you check this box, employees can change the 
Resource ID for a labor transaction to any other valid Resource ID. While in effect, after the 
operation sequence number is validated, the focus is set to the Resource ID. Employees can 
either accept the default Resource ID or enter a different Resource ID.If the employee chooses a 
different resource ID, it must be an active resource. Resources designated as obsolete are not 
eligible. If you clear this check box, then the resource defined on the operation is used and cannot 
be changed. 

Set Local Time from Server – Select this check box to set local time based on the local time of 
your server.

Use default employee site id for Indirect transactions – Select this option to use the 
employee’s default site ID for all indirect transactions. Clear this check box if employees can use 
a site other than their default site for indirect transactions.

Show operation quantity completed – Select this check box to display the quantity that has 
already been completed for the operation.

Show operation quantity deviated – Select this check box to display the total unacceptable 
quantity that has already been reported for the operation.

Show operation quantity remaining – Select this check box to display the quantity remaining for 
the operation. 

7 Click Ok to save the preferences.

Editing Indirect IDs
You can insert and delete indirect IDs in the Preferences/Setup dialog box. To ensure that barcodes 
are printed correctly, enter all IDs in uppercase.

To create an indirect ID, click Insert, then add the information for the new indirect ID.
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To delete an indirect ID, select the ID then click the Delete button.

Click Ok to save the changes.

Setting Preferences in Site Maintenance and the 
Manufacturing Window
Use the settings available in Site Maintenance and the Manufacturing Window to set up these labor 
reporting functions:

Function Set up

Report labor by percentage complete 
instead of quantity complete. 
Replace the Op Qty Completed field with Op 
Prcnt Complete field, Op Qty Remaining field 
with Op Prcnt Remaining field, and Quantity 
Completed field with Percent Completed field.

Select the Percent Complete check box

Enable automatic calculation of quantity 
complete based on hours. 
Automatically calculate quantity or percentage 
complete based on the number of hours 
reported on the labor ticket. 
This feature functions in the same way as the 
quantity complete function available in the 
administrator set up of Wedge Barcode Labor 
Entry.

Select the Quantity Complete by Hours check 
box.

Deactivate automatic closing of operations. 
Automatically stop calculating the quantity or 
percentage at a threshold that you specify. 
This feature is useful if you engineer to order 
and actual time spent on operations frequently 
exceeds the estimates. When you specify a 
threshold, the automatic calculation stops when 
the threshold is reached. The operation 
remains open, and the remaining time remains 
on your schedule. 
To close the operation, users must specify Y in 
the Run Complete field when they stop the job. 
You can also change the status of the 
Operation to closed in the Manufacturing 
Window. 

Select the Quantity Complete by Hours check 
box.
Specify a value in the Max Percent Completed 
field. 
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The settings that you specify at the site level are used for all masters and operations in the site. If you 
do not specify settings at the site level, then you can specify settings on the header card on masters. 
Settings that you specify on the header card are applied to all operations in the master, including 
operations in legs. If you do not specify settings at the site level or header card level, you can specify 
settings on individual operations.

1 Decide the level at which you want to set up percentage of completion functions:

• To specify the settings at the site level, select Admin, Site Maintenance. Click the Defaults
tab.

• To specify the settings at the header level, select Eng/Mfg, Manufacturing Window and
open the header card of the work order, engineering master, or quote master. 

• To specify the settings at the operation level, select Eng/Mfg, Manufacturing Window and
open the operation. 

2 Specify this information:

Percent complete – Select this check box to replace the Op Qty Completed field with Op Prcnt 
Complete field, Op Qty Remaining field with Op Prcnt Remaining field, and Quantity Completed 
field with Percent Completed field.

Quantity Complete by Hours –To automatically calculate quantity complete or percentage of 
completion based on the hours reported on the labor ticket, select this check box.

If you report labor based on quantity complete, then this calculation is made to determine the 
quantity completed during the labor ticket:

(hours reported on ticket/total estimated hours for operation) * operation quantity

If you report labor based on percentage complete, then this calculation is made to determine the 
percentage:

(hours reported on ticket/estimated hours for operation) * 100

The operation is automatically closed when the quantity or percentage complete equals or 
exceeds the operation quantity. 

Max Percent Completed – If you selected the Quantity Complete by Hours check box, use this 
field to specify the maximum percentage that can be calculated automatically. When the 
percentage complete meets the threshold that you specify, automatic calculation of quantity 
complete is stopped. The operation remains on your schedule until the operation is manually 
closed. This formula is used to calculate the number of hours for the operation that remain on 
your schedule:

((100 - value specified in Max Percent Completed field)/100) * total hours required for the 
operation

To complete the labor on an operations, users must manually close the operation. To close the 
operation, users can specify that the run is complete on the labor ticket. You can also change the 
status of the operation to Closed in the Manufacturing Window. 

3 Click Save. 
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Printing Barcodes
You can print all the barcodes you need for Barcode Labor Ticket Entry using VISUAL. However, 
before you can do this you need to install a special Code 39 barcode font, which is available through 
Infor Global Solutions.

Printing Employee IDs
You can print Employee IDs using the Print command in Employee Maintenance. You can print a 
single employee or a range of employees. To print an Employee ID barcode, check the Print 
Barcodes check box and select a barcode type before printing. 

Code39 – This type of barcode, also known as Code 3 of 9, contains variable length, discrete 
symbology. You must have a Code 39 barcode font installed to view the barcode. If you do not have 
the Code 39 font installed, then the alphanumeric ID is displayed instead with a prefix and suffix. This 
pattern is used: *%ID%*. 

QR Code – This is a two-dimensional or matrix barcode. QR stands for quick response.

Printing Work Order Information
For set up and run transactions, you can print the work order traveller to include a single barcode that 
encodes Base ID, Lot ID, Split ID, Sub ID, and Operation Sequence Number.

To print work order travellers, select Work Order Traveller from the Eng/Mfg menu of the Main 
window.

Make sure you have selected Print Operation Barcodes from the Options box.

Printing the Barcode Legend
You can avoid using the keyboard or mouse in the barcode labor ticket process by printing unique 
barcodes for necessary information, including transaction type, setup/run completed, Yes/No, etc. 
This is the barcode legend.

To print this barcode legend:

1 Select Print Bar Code Legend from the File menu.

2 Click Ok to print the legend.

Click the Print Setup button to select the printer.

You can modify the barcode legend using Quest. The QRP file is VMBCLGND.QRP.
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Entering Employee IDs
Entering your employee ID starts the labor ticket transaction. You can enter your employee ID by 
barcode or through the keyboard.

When you enter a valid employee ID, the current status of your transactions is displayed:

You Are Clocked In - If an in-process ticket exists for an indirect job.

Setup In Process

 - If an in-process ticket exists for a setup.

Run In Process 

- If an in-process ticket exists for a run.

You Are Clocked In (n Transactions Active)

 - If multiple jobs are allowed; n is the total number of in-process tickets.

You Are On Break

 – If a break transaction is in-process.

If you get an “Unable to find shift information” message when entering an employee ID, you must 
enter additional shift information. Complete all information in Shift Definition and Shift Codes under 
Employee Maintenance. The employee must be eligible to work on the day he is wanding, have start/
stop shift times defined under “shift codes”, and be checked as “Active” and have a valid department 
ID. 
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Performing Wedge Barcode Tasks

Clocking In
Clocking In indicates you are starting the workday, but you are not working directly on a job. Clocking 
In creates a default indirect labor ticket starting at the clock in time.

1 Wand or enter your Employee ID.

When you enter or wand in your employee ID, your default site is inserted in the Site ID field.

2 Select the Clock In option by:

• wanding the Clock In barcode
• pressing the 1 key on the keyboard
• clicking the Clock In button.

A dialog box may appear, asking you to confirm the action.

3 Click or wand on Yes to confirm the action.

You are clocked in at the current time.

If you are immediately starting a job when you begin work, your first transaction can be a start job 
(instead of a clock-in) as this will automatically clock you in. A ‘clock-out’, however, must be done at 
the end of the shift. Simply doing a “stop job” will not stop the tracking of the employee’s time.

You may get a message ‘You have been clocked in for more than 12 hours’. This means the 
employee has an open (in-process) ticket older than the hours specified in “Duration Threshold” 
under Administrator Setup of the barcode application. The setting is designed to catch a situation 
where an employee has forgotten to clock out of his previous shift. The supervisor should pull up the 
ticket in Labor Ticket Entry and close it manually using the proper clock out time. Keep in mind a 
manually closed ticket will not calculate breaks nor will it use end of shift grace periods.

Starting a Setup
Starting a setup indicates you are starting direct labor for setup on a work order/operation. When you 
start a setup, any of your in-process tickets (if in single job mode) are completed and a new in-
process setup ticket is created, using the current time as the clock in.

1 Wand or enter your Employee ID.

2 Select the Start Setup option by:

• wanding the Start Setup code
• pressing the 2 key on the keyboard
• clicking on the Start Setup button.

3 Wand the work order traveller for the job you are setting up. 
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A dialog box may appear, asking you to confirm the action.

4 Click or wand on Yes to confirm the action.

The Start Set Up time is recorded.

Starting a Job
Starting a job indicates you are starting direct labor for the run portion of a specified work order/
operation. When starting a run, any default indirect labor tickets are completed and a new in-process 
run ticket is created. In multiple job mode, a specifically wanded indirect labor ticket is carried through 
even when you start a job. 

1 Wand or enter your Employee ID.

2 Select the Start Run option by:

• wanding the Start Run code
• pressing the 3 key on the keyboard
• clicking on the Start Run button.

3 Wand the work order traveller for the job you are starting.

If you are licensed to use multiple sites, the employee must be assigned to the site on the work 
order to successfully wand the traveller.

A dialog box appears, asking you to confirm the action.

4 Click or wand on Yes to confirm the action.

The Start Run time is recorded.

Starting an Indirect Task
Selecting Indirect indicates you are starting an indirect task. If in single job mode, this completes any 
of your in-process tickets and creates a new in-process indirect ticket. No matter what the job mode 
setting (single or multiple job), only one indirect task can be in-process at any given time.

1 Wand or enter your Employee ID.

2 If you are running a job in single job mode, you are informed a run is in-process. Select the 
Indirect option by:

• wanding the Indirect code
• pressing the 4 key on the keyboard
• clicking on the Indirect button.

If you are NOT running a job, proceed to step 7.

3 Enter the quantity you completed for the current job, then press the TAB key.

4 Enter the quantity deviated for the current job, then press the TAB key.
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If you entered a deviated quantity, enter the Deviation Reason ID and press the TAB key.

Note: If the Require Deviation Reason for Deviated Quantities option is selected in Site 
Maintenance, you are required to enter a reason code before continuing.

5 If the setup/run for the current operation is complete, enter Y, then press the TAB key.

If the setup/run for the current operation is NOT complete, enter N, then press the TAB key.

6 Enter any comments for the current job, then press the TAB key.

7 Enter or wand an Indirect ID for the indirect task.

A dialog box appears, asking you to confirm the action.

8 Click or wand on Yes to confirm the action.

Note: If you have trouble scanning indirect Labor IDs, check Employee Maintenance to be sure 
that indirect Labor IDs appear in UPPERCASE alphanumeric characters only. Code39 barcode 
fonts cannot be read if indirect codes contain lowercase characters or special characters 
including &, =, _ (underscore), and @.

Stopping a Job
When you stop a job in single job mode (or multiple job mode but with only one job in process), your 
in-process labor ticket is completed and a new in-process default indirect labor ticket is created. If in 
multiple job mode with multiple jobs in-process, stopping a job stops only one specified job at a time.

1 Wand or enter your Employee ID.

2 Select the Stop Job option by:

• wanding the Stop Job code
• pressing the 5 key on the keyboard
• clicking on the Stop Job button.

If you are in more than one job, an additional screen displays, allowing you to select which job you 
are stopping.

3 Depending on how the system administrator set up the system, this information could be 
displayed:

Op Qty Completed/Op Prcnt Compl – The quantity that has already been completed for the 
operation. If the operation is set up to report completion based on quantities, then Op Qty 
Completed is used as the label for this field. If the operation is set up to report completion based 
on percentage, the Op Prcnt Compl is used as the label. 

If quantity or percentage of completion is calculated automatically and a maximum completion 
percentage has been specified, then this value is not updated after the maximum completion 
percentage has been reached. For example, if the operation has a maximum completion 
percentage of 80%, then this field is no longer updated after 80% of the estimated labor hours 
have been completed. Additional hours can be reported, but the percent of quantity remaining 
value is not changed.
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Op Qty Deviated – The total unacceptable quantity that has already been reported for the 
operation.

Op Qty Remaining/Op Prcnt Remaining – The quantity that has not yet been completed on the 
operation. 

If the operation is set up to report completion based on quantities, then Op Qty Remaining is used 
as the label for this field. If the operation is set up to report completion based on percentage, the 
Op Prcnt Remaining is used as the label. 

If quantity or percentage of completion is calculated automatically and a maximum completion 
percentage has been specified, then this value is not updated after the maximum completion 
percentage has been reached. Additional hours can be reported, but the percent of quantity 
remaining value is not changed.

4 If you are manually reporting completion information, enter information about the quantity that you 
completed. If the operation requires you to report quantities, then this field is labeled Quantity 
Completed. Specify the quantity that you completed on the labor ticket. If the operation requires 
you to report percentages, then this field is labeled Percent Completed. Specify the percentage 
that you competed during the labor ticket. For example, if 30% had previously been completed 
and you completed an additional 10%, then specify 10 in this field. 

If you are automatically calculating completion information, then the quantity or percent complete 
is calculated when you complete the transaction. 

5 Enter the quantity deviated for the current job, then press the TAB key.

If you entered a deviated quantity, enter the Deviation Reason ID and press the TAB key.

Note: If the Require Deviation Reason for Deviated Quantities option is selected in Site 
Maintenance, you are required to enter a reason code before continuing.

6 If the setup/run for the current job is complete, enter Y, then press the TAB key.

If the setup/run for the current job is NOT complete, enter N, then press the TAB key.

7 Enter any comments for the current job, then press the TAB key.

A dialog box appears, asking you to confirm the action.

8 Click or wand on Yes to confirm the action.

Completing Labor on Operations with Max Percent Complete Thresholds
If a maximum percent complete threshold has been specified for an operation, then you must perform 
one of these tasks to indicate that labor is complete and the operation is closed:

• Specify Y in the Run Complete field. The operation completion meter will not reach 100%, but
the operation is still closed.

• Use the Manufacturing Window to change the status of the operation to Closed. The
operation completion meter will not equal 100%. 
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Stopping an Indirect Task
1 Wand or enter your Employee ID.

If in single job mode, a specifically-wanded indirect task can be stopped by starting a new run or 
setup, another indirect, or clocking out.

If in multiple job mode, you must stop the indirect task by stopping the current one, starting a 
different indirect task (automatically stopping the previous indirect), or clocking out.

2 Select the indirect option by either:

• wanding the Start/Stop Indirect code
• pressing the 4 key on the keyboard
• clicking on the Indirect button.

If you are stopping an indirect task, you are done with the transaction at this point (aside from a 
confirmation message, etc.). If you are starting an indirect, you will need to supply the indirect ID 
in one of two ways:

• wand the Indirect ID 
• enter the Indirect ID

Clocking In/Out for Breaks
Select or wand the Break button to record unpaid, manual breaks (breaks can be defined as manual 
or automatic), which are usually meal times. This action does not create or complete any labor tickets. 
Rather, it sets the break time for the current in-process ticket. The Break button records the start and 
end of breaks. The time difference is recorded in the break time of the current ticket, then the break 
time is deducted from the total elapsed time. Do not use the Break button to record automatic breaks 
– the breaks will be accounted for automatically by the time changing to the appropriate indirect ID. 
This computation occurs when the employee clocks out.

1 Wand or enter your Employee ID.

If you are starting a break, clocked in, run in process, or setup in process are displayed.

If you are clocking back in from a break, You are on break is displayed.

2 Select the Break option by either:

• wanding the Break code
• pressing the 6 key on the keyboard
• clicking on the Break button. A dialog box appears, asking you to confirm the action.

3 Click or wand on Yes to confirm the action.

Clocking Out
Select Clock Out at the end of the work day. Clocking out completes any of your in-process tickets. 



Performing Wedge Barcode Tasks

9 – 16 | Infor VISUAL Inventory User’s Guide 

1 Wand or enter your Employee ID.

You are informed if a run is in-process.

2 Select the Clock Out option by either:

• wanding the Clock Out barcode
• pressing the 7 key on the keyboard
• clicking on the Clock Out button.

If you are not in a job, proceed to step 7. If you are in multiple jobs, you will be told to do a ‘stop 
job’ instead. 

3 Enter the quantity you completed for the current job, then press the TAB key.

4 Enter the quantity deviated for the current job, then press the TAB key.

If you entered a deviated quantity, enter the Deviation Reason ID and press the TAB key.

5 If the setup/run for the current operation is complete, enter Y, then press the TAB key.

If the setup/run for the current operation is NOT complete, enter N, then press the TAB key.

6 Enter any comments for the current job, then press the TAB key.

7 Click or wand on Yes to confirm the action.

Another dialog box appears, asking you to accept the transaction.

8 Click Ok to complete the transaction.

Displaying Work Order Information
Barcode Labor Ticket Entry is usually the primary application for operators, so it includes the ability to 
display picture/objects and specifications associated with work orders and operations.

Scan the work order/operation information from the traveller while the Barcode Labor Ticket Entry 
window is clear (no employee ID entered).

Do NOT enter an employee ID; this starts a transaction. The information for the work order/
operation appears in the window.

Viewing Work Order Picture/Objects
If there is a picture or object associated with the work order, it appears at the upper right of the 
window, just below the time. Select the various options from the Picture/Object menu to control the 
display.

If you select Scale from the Picture/Object menu, the picture appears to scale, with as much of the 
upper left corner showing as possible.

If you select Size to Fit from the Picture/Object menu, the picture is reduced or enlarged to fit in the 
display frame, changing the aspect ratio if necessary to fill the frame.
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If you select Size to Best Fit from the Picture/Object menu, the picture is reduced or enlarged to fit in 
the display frame, while preserving the aspect ratio.

If the item is an object, what appears in the window depends on the type of object. For example, a 
drawing typically appears as a smaller version of itself. For a Microsoft Word object, however, the 
Word icon is displayed. Double clicking on the object activates any application associated with the 
object. You can also activate an object by selecting Show Work Order Picture/Object from the Picture 
Object menu. 

Viewing Operation Picture/Objects
If a picture or object is associated with the individual operation you have specified, it appears at the 
mid-right of the window, below the position of the work order object. The picture/object behaves 
identically to the work order picture/object.

Viewing Operation Specifications
If there is a specification for the specified operation, an icon representing a document appears at the 
lower right of the window. There are three ways to view a specification:

• Double-click the icon.
• Select Show Operation Specifications from the Picture/Objects menu.
• Click the Specification button. 

The Specifications dialog box appears.

Click the Close button to close the dialog box.
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What is BTS?
We have all been to the grocery store and seen the clerk scanning our groceries and then presenting 
us with a bill. That is only part of what barcoding entails—inventory tracking in real time. Using Infor 
Global Solutions Associate’s BTS (Barcode Transaction System), you can track your inventory and 
labor transactions in real time. This means that, as you go about your daily business, BTS is checking 
your data against the appropriate business rules in VISUAL (preventing unnecessary errors), and 
current data is processing at all times.

Using barcodes you will also alleviate any mistakes that your employees might make when they have 
to manually enter work order numbers, purchase order numbers, and times into your computer 
system.

BTS consists of two systems, ALTS (Automated Labor Tracking System), AMTS (Automated Material 
Tracking System), and Wedge barcoding and offers users of VISUAL the ability to use many different 
types of barcode readers to track labor and material transactions in real time.

BTS features:

• Graphical User Interface (GUI) for label design and printing
• Simple DOS based reader application for use on many different Barcode reader platforms
• ODBC Compliant connections to any and all databases
• Compatibility with a vast array of barcode scanners, including radio frequency scanners, fixed

scanners, and Wedge type scanners
• The use of standard industry compliant labels and thermal label printers
• Completely customizable user interface for a variety of reader formats

How Does BTS Work?
When you scan a barcode, your Telnet server connection sends the information to BTS. BTS then 
places the scanned information into a holding table within your database. The appropriate transaction 
processor copies the transaction information from the holding table to the appropriate tables in your 
database. The exception to this rule is the Wedge barcode program, that places the scanned 
information directly into the appropriate tables in your database.

While BTS can use Wedge type scanners Wedge cannot use Telnet compliant scanners.
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The following flowchart shows an example of a typical BTS setup.

There are many other methods of setting up BTS, for example, you can also use the Telnet server as 
a transaction processor computer.

Note: You can also use Wedge type barcode scanners with ALTS, these do not use the Wedge 
barcoding software but work the same as any other Telnet compliant scanner.

What is ALTS (Automated Labor Transaction System)?
ALTS is the labor tracking portion of BTS and allows you to perform the following labor transactions:

• Clock In
• Setup Start
• Run Start
• Indirect Labor
• Job Stoppage
• Break
• Clock Out
• Employee Status

Infor Global Solutions has designed ALTS to accept data input from a wide variety of Telnet compliant 
scanners including radio frequency (RF) scanners, pen or wand type scanners, and stationary 
scanners
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What is AMTS (Automated Material Tracking System)?
AMTS is the material tracking portion of BTS and allows you to manage your materials through the 
use of barcode hardware. AMTS allows you to perform the following material transactions:

• Purchase Receipt Entry
• Shipping
• Material Movement within Facilities
• Issue of Raw materials to Work Orders
• Receipt of Finished Goods to Inventory
• Physical Inventory and Cycle Counting

Infor Global Solutions has designed ALTS to accept data input from a wide variety of Telnet compliant 
scanners including radio frequency (RF) scanners, pen or wand type scanners, and stationary 
scanners that BTS also supports:

Basic Inventory Transactions – Use basic transactions to track basic material movements within 
your facility. This module allows you to track inventory from the point it enters your facility, through 
processing, and on to the shipping dock.

Physical Inventory/Cycle Counting – AMTS allows the user to scan data they would normally have 
to manually enter from inventory tags and/or sheets.

Lot/Serial Traceability – You can trace any lot/serial traceable item within VISUAL using VISUAL/
AMTS.

Dimensional Inventory – Use AMTS to enter the dimensions of the parts you track dimensionally.

Barcode Label printing – Design standard and custom labels using Loftware’s Label Printing 
System and print them with almost any thermal label printer.

What is the Label Print Utility?
Using the Label Print utility, you can design and define labels within specific categories, allowing you 
to produce labels based on their usage and data requirements.

Note: You must be a licensed user of Loftware Labelling in order to use the label print utility.

The label categories are: 

• Raw Materials and/or Received Materials Labels
• Parts Labels 
• Traceability Labels
• Finished Goods Labels 
• Shipping Labels
• Warehouse/Location Labels

These categories help you segment printing duties into their respective areas. For example, shipping 
labels can be printed in your shipping department.
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Before You Begin
Before you begin using BTS, you should become familiar with Microsoft Windows terminology and 
procedures. See your Windows documentation if you are not familiar with the version of Windows you 
are running.

System Requirements
You must meet the following minimum requirements to use BTS:

• From ALTS and AMTS you will need a communications server or workstation running Windows
NT and an ODBC connection to your VISUAL database and a network protocol that supports
Telnet communications.

If you are planning on using only Wedge barcode inputs, you need to have computers or 
workstations with individual ODBC connections to your VISUAL database.

• If you want to print reports that includes barcodes, you will need an appropriate printer and
barcode fonts loaded on the computer from which you will be printing.

• If you want to print barcode labels, you will need a Thermal Barcode printer and a label design
program such as Loftware Label Manager from Loftware, Inc.

• Scanners of various types as appropriate for you business.
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Installing and Setting Up BTS
All of the necessary executable files and drivers for BTS are automatically installed when VISUAL is 
installed. In order for BTS to work, you must enter the appropriate License Keys for the modules you 
want to use.

There are several steps involved in setting up your Barcode Tracking System:

• Make sure you have the latest versions of the BTS files
• Preparing your VISUAL database for BTS
• Setting up a Telnet server
• Entering the appropriate license keys
• Setting up appropriate ODBC DSN database connections
• Setting up transaction processors
• Editing the appropriate settings in your Vmbts.ini file. If you will be using only the Wedge

barcoding system, you will not be using a Vmbts.ini file.
• Installing and setting up your label design software. If you do not plan on printing labels, you do

not need a label design program.

Entering License Keys
To enter or change a license key in:

1 With VISUAL running, select Enter New License Key… from the Admin menu of the main 
window.

2 In the Product section, select the appropriate option button.

3 Enter the appropriate license key in the License Key box.

4 Click OK.

The Enter License Key dialog box saves the License Key you entered and closes.

Note: You must repeat these steps for each license key you want to enter.

Preparing Your Database for BTS
To prepare your database for BTS:

1 Select Employee Maintenance from the Admin menu.

The Employee Maintenance window appears.

2 From the Edit menu, select Indirect Codes.

The Indirect Codes dialog box appears.

3 Click Insert.
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The cursor appears in a blank line in the Indirect ID column.

4 Enter the appropriate information for this Indirect ID.

Note: Some barcode fonts do not support the use of characters like * ! $ % or spaces.

5 Click Save.

6 When you have finished entering Indirect ID codes, click Close.

7 From the Edit menu, select Shift Definitions.

8 Enter the Shift ID and Description in the appropriate boxes.

9 Enter the following in the Allowed Clock In/Out Grace Periods section:

Minutes before start of shift - Enter the number of minutes grace period you want to allow 
before the start of the shift.

Minutes after Start of shift - Enter the number of minutes grace period you want to allow after 
the start of the shift.

Minutes before end of shift - Enter the number of minutes grace period you want to allow before 
the end of the shift.

Minutes after end of shift - Enter the number of minutes grace period you want to allow after the 
end of the shift.

Between job lag time - Enter the number of minutes grace period you want to allow between 
jobs.

Minutes before/after breaks - Enter the number of minutes grace period you want to allow 
before and after breaks.

10 Enter the Indirect ID you want to which you want to charge breaks and meals.

11 Click Save.

12 Close the Employee Maintenance window.

13 On the machine on which you will be printing barcodes, install the Code 39 Fonts. See your 
system documentation.

For the reports you intend to print with barcodes, change the barcode font size to between 16 and 
40 points.

14 For the parts for which you want to use barcoding, use the Manufacturing’s Edit Part Trace Profile 
window to make sure that each Part ID has a numbering setting of Automatic or User.

Setting Up ODBC DSN Database Connections
If you are using the AMTS or ALTS barcoding systems, you must set up an ODBC (Open Database 
Connectivity) DSN (Database Server Name) so that the appropriate barcoding databases can 
connect to your VISUAL database.

You must add a DSN for each VISUAL database to which you want to connect. For example, if you 
use a demonstration or training database, you must also set up a DSN to connect to those databases.
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Note: The ODBC DSN must reside on the same machine as the AMTS and ALTS executable 
programs reside. If you are using BTS on several computers with different settings, each computer 
must have its own ODBC DSN settings.

The following is an example of adding a DSN. Your DSN settings will be different depending on your 
settings and the type of database you use:

1 Open the Windows ODBC Data Source Administration window.

See your operating system documentation.

2 On the User DSN tab, select the Data Source type you want to use for this connection and click 
Add.

3 Select the appropriate ODBC driver and click Finish.

Note: You must select the appropriate driver for the type of database you are using in VISUAL. 

4 In the Data Source Name box, enter a name for this data source.

Note: Because of potential ODBC problems, use a different name than your actual database 
name.

If you want to check what your Data Source Name is, use Windows Notepad to open your
Vmbts.ini file (usually located in the Vmfg sub-directory of your Program Files directory.)

The “DatabaseAlias=Data Source Name” is located in the [BTSDefaultSettings] section.

5 If you want to enter a description for this data source name, click in the Description box and enter 
the description you want.

6 Click in the Server Name box and enter the appropriate name for your SQL server name.

Note: If you are using SQL Server, the server name must match the server path name that is 
specified in your Sql.ini file in the [win32client.ws32] section. If you are using a different type of 
database for VISUAL, refer to the appropriate instructions for the database you are using.

7 Click OK.

The ODBC Driver Set Up dialog box closes.

8 Click OK.

The ODBC Data Source Administrator dialog box closes.

Setting Up ALTS Administrator Preferences
Because Administrator Setup contains options controlling the operation of ALTS, you can only access 
Administrator Setup when you are logged in as SYSADM. ALTS stores the options you select here in 
Preferences Maintenance.

To select ALTS options:

1 With Vmbtslbr.exe running, select Admin Setup from the File menu.

A list of the current indirect IDs is displayed in the table.
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Make sure of that all of the Indirect IDs are less than eight alphanumeric characters in length and 
that they are all capital letters.

2 In the Duration Threshold field, specify in hours the longest transaction allowed. The maximum 
value is 24. You should enter a duration threshold greater than the normal shift length but not 
greater than 24 hours. When an employee tries to complete an in-process transaction with a 
longer elapsed time than this threshold, the transaction is not allowed. You must complete the 
transaction using manual Labor Ticket Entry. When you complete the transaction in labor Ticket 
Entry, automatic breaks are not accounted for and must be entered manually. 

3 In the Default Indirect ID field, specify the indirect labor ID to use to record indirect labor. 

Make sure you enter the correct Indirect Labor ID for the account into which you want ALTS to put 
all indirect labor time. The default indirect labor account is the account into which  BTS puts ALL 
between job time. This is also the account into which BTS puts the user’s time when they have 
not clocked into a specific direct or indirect labor account (job).

4 In the Multiple Jobs section, specify whether employees can clock in to more than one job at the 
same time. 

Click one of these options:

Do Not Allow - If you do not want an employee to have multiple simultaneous labor transactions, 
select the Do not allow option button.

If you select the Do not allow option, ALTS requires a user to perform a “Stop” function before 
“Starting” another.

Prorate Hours Spent on Work - If you want to allow simultaneous labor transactions and you 
want to divide the total hours by the number of simultaneous tickets, select the Prorate Hours 
Spent on Work option button.

For example, if an employee clocks in to two jobs at the same time and clocks out of those two 
jobs two hours later, the hours for each job are calculated:

2 hours / 2 jobs = 1 hour each job.

If you are a labor-intensive, assembly-oriented shop, you may find it useful to use prorate by 
hours because efficiency ratings will be meaningful using this method.

Note: “Prorate Hours Spent on Work” does not accurately take into account Burden Costs 
because it assigns burden based on the prorated hours only.

Prorate Cost of Work - If you want to allow simultaneous labor transactions and you want to 
accurately take into account burden costs, select the Prorate Cost of Work option button.

For example, if Job A and Job B have a $20 per hour resource burden and the employee running 
the jobs is paid $10 an hour. The employee runs both jobs together for one hour.

“Prorate by Cost” assigns $5 for labor for each job using the following formula:

($10/hour x 1 hr) / 2 jobs = $5

and assigns $20 for burden for each job using the following formula:

$20/hour x 1 hour = $40

totaling $10 for labor and $40 for burden for one hour.

In contrast, “Prorate by Hours” calculates $5 for labor for each job using the following formula:
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($10/hour * 1 hr.) / 2 jobs = $5

and assigns $10 for burden for each job using the following formula:

($20/hour * 1 hour) / 2 jobs = $10

totaling $10 for labor and $20 for burden for one hour.

Typically, a machine-intensive shop will prorate by cost to assign full burden to each machine.

5 In the Operation Reporting section, select the type of operation reporting you want to use. Click 
one of these options: 

Allow Out of Sequence - If the sequence of your operations is not critical, select the Allow Out 
of Sequence option button.

Do Not Allow Out of Sequence - If the sequence of your operations is critical, select the Do Not 
Allow Out of Sequence option button.

Prompt When Out of Sequence - If you want the transaction processor to prompt employees to 
make decisions as out of sequence operations occur, select the Prompt When Out of Sequence 
option button.

6 If you want ALTS to automatically compute the completed quantity based on the time, select the 
Automatically Compute Quantity Complete check box.

Note: The resource for the job must be set to “pieces per hour.”

If the Quantity Complete by Hours check box has been selected on the operation to which you are 
reporting labor, then the Automatically Compute Quantity Complete setting is ignored. The 
Quantity Complete by Hours check box can be selected on the operation itself, on the work order 
header, or in Site Maintenance. 

7 To allow employees to enter a quantity greater than the quantity required by the work order, select 
the Edit Quantity Complete vs. Standard check box. In the Allowable percentage over standard 
field, specify the percentage to use to calculate the allowable quantity. Employees cannot enter 
quantities greater than the work order quantities plus their allowable percentages.

8 Click OK.

The Preferences/Setup dialog box closes.

Inserting Indirect Labor IDs
To insert a new Indirect Labor ID:

1 Click Insert.

A new line appears highlighted.

A code of M automatically appears for each new Indirect Labor ID you enter.

2 Click in the Indirect ID column and enter the Indirect Labor ID you want to use.

3 Press the TAB key and enter the appropriate general ledger account you want to use for this 
indirect labor.
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Indirect IDs must be less than eight alphanumeric characters in length and all capital letters.

Deleting Indirect Labor IDs
To delete an Indirect Labor ID:

1 Click in the row header for the Indirect Labor ID you want to delete.

The row appears highlighted.

2 Click Delete.

An X appears in the row header indicating you have marked the Indirect ID for deletion.

If you want to remove the selection of the Indirect ID before you have clicked OK, click Delete 
again. The X no longer appears, indicating that the Indirect ID is NOT marked for deletion.

3 When you have finished changing your administrative settings, click OK.

 ALTS will not actually make the deletion until you click OK.

Setting Preferences in Site Maintenance and the Manufacturing 
Window
Use the settings available in Site Maintenance and the Manufacturing Window to set up these labor 
reporting functions:

Function Set up

Report labor by percentage complete 
instead of quantity complete. 
Replace the Quantity Complete prompt with 
Percent Complete. 

Select the Percent Complete check box

Enable automatic calculation of quantity 
complete based on hours. 
Automatically calculate quantity or percentage 
complete based on the number of hours 
reported on the labor ticket. 
This feature functions in the same way as the 
quantity complete function available in the 
administrator set up of ALTS.

Select the Quantity Complete by Hours check 
box.
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The settings that you specify at the site level are used for all masters and operations in the site. If you 
do not specify settings at the site level, then you can specify settings on the header card on masters. 
Settings that you specify on the header card are applied to all operations in the master, including 
operations in legs. If you do not specify settings at the site level or header card level, you can specify 
settings on individual operations.

1 Decide the level at which you want to set up percentage of completion functions:

• To specify the settings at the site level, select Admin, Site Maintenance. Click the Defaults
tab. 

• To specify the settings at the header level, select Eng/Mfg, Manufacturing Window and
open the header card of the work order, engineering master, or quote master.

• To specify the settings at the operation level, select Eng/Mfg, Manufacturing Window and
open the operation. 

2 Specify this information:

Percent complete – Select this check box to replace the Quantity Complete prompt with a 
Percent Complete prompt. 

Quantity Complete by Hours –To automatically calculate quantity complete or percentage of 
completion based on the hours reported on the labor ticket, select this check box.

If you report labor based on quantity complete, then this calculation is made to determine the 
quantity completed during the labor ticket:

(hours reported on ticket/total estimated hours for operation) * operation quantity

If you report labor based on percentage complete, then this calculation is made to determine the 
percentage:

(hours reported on ticket/estimated hours for operation) * 100

The operation is automatically closed when the quantity or percentage complete equals or 
exceeds the operation quantity. 

Deactivate automatic closing of operations. 
Automatically stop calculating the quantity or 
percentage at a threshold that you specify. 
This feature is useful if you engineer to order 
and actual time spent on operations frequently 
exceeds the estimates. When you specify a 
threshold, the automatic calculation stops when 
the threshold is reached. The operation 
remains open, and the remaining time remains 
on your schedule. 
To close the operation, users must specify that 
the run is completed when they stop the job. 
You can also change the status of the 
Operation to closed in the Manufacturing 
Window. 

Select the Quantity Complete by Hours check 
box.
Specify a value in the Max Percent Completed 
field. 

Function Set up



Installing and Setting Up BTS

Infor VISUAL Inventory User’s Guide | 9 – 29

Max Percent Completed – If you selected the Quantity Complete by Hours check box, use this 
field to specify the maximum percentage that can be calculated automatically. When the 
percentage complete meets the threshold that you specify, automatic calculation of quantity 
complete is stopped. The operation remains on your schedule until the operation is manually 
closed. This formula is used to calculate the number of hours for the operation that remain on 
your schedule:

((100 - value specified in Max Percent Completed field)/100) * total hours required for the 
operation

To complete the labor on an operation, users must manually close the operation. To close the 
operation, users can specify that the run is complete on the labor ticket. You can also change the 
status of the operation to Closed in the Manufacturing Window. 

3 Click Save. 

Setting Up Loftware’s Label Design Software
Follow the instructions for installing Loftware’s Label Design software. After you have successfully 
installed your label design software, use the following instructions to help you set up BTS to use the 
Thermal Barcode Print Utility:

1 From the Admin menu, select Label Printer Setup Utility.

The Barcode Label/Printer Setup Utility program appears.

2 Click the Loftware Setup tab.

3 Click the Loftware button and navigate to where you want to keep your Loftware label files.

4 Click the Spool button and navigate to your thermal printer server.

5 Click the Loftware Printer Ini button and navigate to where your Loftware Printer.ini file is 
located.

6 Click the Save icon on the toolbar.

7 When you have finished setting up BTS, select Exit from the File menu.

The Vmbtslp.exe program closes.

Creating a TAB File on Save
In order for Vmbtslp.exe to access the field names you have used in your label designs, it must have 
access to the corresponding .tab file. A .tab file is a text file indicating what you have called your label 
data fields.

To create .tab files:

1 With the Loftware Label manager running, select Preferences from the Options menu.

The Preferences dialog box opens.
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2 Open the design options by clicking on the plus sign to the left of Design Options. 

The list expands and the Loftware Label Manager design options appear.

3 Select the Create Tab File on Save option.

A check mark appears in the check box to show you have selected the Create Tab File on Save 
option.

4 Click OK.

The Preferences dialog box closes. In order for your changes to take effect, you must exit and 
restart the Loftware Label Manager.
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Using BTS

BTS Transaction Processors
Many of the features of BTS are common to AMTS and ALTS; regardless of which transaction 
processor you are using, the steps for performing the following tasks are the same.

When you scan a barcode, BTS places the data you scan into a temporary transaction table until the 
appropriate transaction processor processes the data and places it into your database.

You must run transaction processors on the computer you have set up as your barcode server. You 
can run transaction processors in conjunction with VISUAL.

Running all of the transaction processors at the same time you are scanning enables you to process 
data in real time. Data you scan now will almost immediately (depending on your processor settings) 
become available to VISUAL.

BTS assigns transaction numbers independent of VISUAL. For example, labor ticket do not have the 
same Transaction ID as that assigned by BTS.

Using BTS Transaction Processors
Because AMTS transaction processors all do very much the same jobs, they are similar in structure 
and usage. Once you have mastered the first processor, you will find it easier to learn the remaining 
processors.

Once you have made all of the appropriate settings for your particular manufacturing setup, BTS 
works “behind the scenes” to import the information you scan into your VISUAL database.

The AMTS system consists of:

Vmbtsivt.exe - Use the Vmbtsivt.exe processor to work with your material movements, issues, and 
work order transactions.

Vmbtsphy.exe - Use the Vmbtsphy.exe processor to work with your physical inventory count 
transactions.

Vmbtsrcv.exe - Use the Vmbtsrcv.exe processor to work with your purchase receipt transactions.

Vmbtsshp.exe - Use the Vmbtsshp.exe processor to work with your customer shipment transactions.

The ALTS system consists of:

Vmbtslbr.exe - Use the Vmbtslbr.exe processor to work with your labor ticket transactions.

Because BTS transaction processors are not available from within VISUAL, you must start the 
transaction processor you want to use by using one of the following methods:

• Double-click shortcut icons on your Windows Desktop or Start menu.
• Using Windows Explorer or My Computer, double-click the appropriate file name.
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All transaction processors consist of the following elements:

Menu Bar - The menu bar consist of four menus from which you can select various options.

Toolbar - The toolbar consists of small icons which you can click to select various functions.

Pending Transaction Table - The Pending Transactions table contains a list of all of your pending 
transactions related to the processor you are viewing. For example, if you have your Purchase 
Receipt processor open, only your pending purchase receipt transactions appear in the Pending 
Transactions table.

Completed Transaction Tables - The Completed Transactions table contains a list of all of your 
completed transactions related to the processor you are viewing. You can set how many days of 
transactions appear in the Completed Transactions table.

Using the Menu Bar
The menu bar consist of the following four menus from which you can select all of the transaction 
processor’s options.

File Menu
The File menu consists of the following options:

Note: The File menu changes depending on which transaction processor you have open.

Process Selected Row - If you have selected a pending transaction and want to process that row, 
select the Process Selected Row option.

The transaction processor immediately processes the row you selected even if the Process Timer is 
not running.

Refresh - If you want to refresh the processor tables, select the refresh option.

The processor processes the appropriate pending transactions which move from the pending table to 
the completed table.

Admin Setup - (Admin Setup only appears in the Vmbtslab.exe Transaction processor.) Use Admin 
Setup to set up the preferences for your labor transactions.

Archive - Use the Archive option to help clean your transaction holding tables.

Print - If you want to print a list of your barcode transactions, select the Print option.

The Print BTS Transactions dialog box appears. See "Printing BTS Reports" on page 8-46.

Print Options - (Print Options is only available in the Vmbtsshp.exe Transaction processor.) Use 
Print Options to select some of your barcode printing options.

Date Options - Use Date Options to set the number of days of transactions you want to appear in the 
Completed Transactions table.

Exit - To close the transaction processor you are running, select Exit.
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View menu
The View menu contains the Main Toolbar option. The Transaction Processor window automatically 
selects the Main Toolbar option. If you do not want the main toolbar to appear, select Main Toolbar 
from the View menu.

Timer Options Menu
The Timer Options menu consists of the following options:

Set Timer Period - Use the Set Timer Period option to change the time between which the 
transaction processor checks for new transactions.

Refresh on Timer - (The Transaction Processor window automatically selects the Refresh on Timer 
option.) If you do not want the processor to refresh the Pending and Completed tables each time the 
processor checks for new transactions, select the Refresh on Timer option.

Start Timer - Use the Start Timer option to start the processor timer.

Help Menu
The Help menu consists of the following:

Help Topics… F1 - If you want to open the main help file at the appropriate section, select Help 
Topics from the Help menu. You can also press the F1 key.

About Help… F2 - If you want some help on using the BTS help system, select About Help from the 
Help menu. You can also press the F2 key.

About - If you want to view the VISUAL splash screen, select About… from the Help menu.

All of the current version numbers for the modules for which you are licensed appear on the splash 
screen.

Using the Toolbar
The toolbar consists of small icons which you can click to select various functions.

To use a toolbar icon, click the appropriate icon for the option you want to use.

 – If you have selected a pending transaction and want to process that row, select the Process 
Selected Row icon on the toolbar.

The transaction processor immediately processes the row you selected even if the Process Timer is 
not running.
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 – If you want to refresh the processor tables, select the refresh icon on the toolbar.

The processor processes the appropriate pending transactions which move from the pending table to 
the completed table.

 – If you want to print a list of your barcode transactions, select the Print icon.

 – Use the Start Timer icon to start the processor timer.

 – When the timer is running the icon appears as a Stop icon. To stop the timer, click the Stop 
icon.

BTS Transaction Processors
Each of the BTS transaction processors are similar in structure and use, the differences between the 
processor windows are in the information that the Pending and Completed tables contain.

The information contained in each of the Pending and Completed tables is as follows:

Inventory Transaction Processor (Vmbtsivt.exe)

Pending Transaction Table
The Pending Transaction table contains the following columns:

ID - The ID of the transaction appears in the ID column.

The Inventory transaction processor automatically numbers each transaction with a unique identifier.

Trans Type - The type of the transaction appears in the Trans Type column.

Transaction types are M (Inventory Material Movement), I (Issue to a Work Order), W (Receipt from 
Work Order), F (Issue Return), A (Inventory Adjust In), and H (Inventory Adjust Out).

Trans Date - The date on which the transaction occurred appears in the Trans Date column.

Qty - The quantity of the parts or material you are issuing or transferring appears in the Qty column.

User ID - The ID of the user who scanned the transaction appears in the User ID column.

Part ID - The ID of the part you transferred or issued appears in the Part ID column.

Base ID - If the transaction involves a work order, the Base ID of the work order appears in the Base 
ID column.

Lot ID - If the transaction involves a work order, the Lot ID of the work order appears in the Lot ID 
column.



Using BTS

Infor VISUAL Inventory User’s Guide | 9 – 35

Split ID - If the transaction involves a work order, the Split ID of the work order appears in the Split ID 
column.

Sub ID - If the transaction involves a work order, the Sub ID of the work order appears in the Sub ID 
column.

Operation Seq # - If the transaction involved an operation on a work order, the sequence number of 
the operation appears in the Operation Seq # column.

Req Piece # - If the transaction involved a material on a work order, the requirement piece number of 
the material appears in the Req Piece # column.

From Warehouse - The warehouse from which you are transferring or issuing the parts appears in 
the From Warehouse column.

From Location - The location in the warehouse from which you are transferring or issuing the parts 
appears in the From Location column.

To Warehouse - The warehouse to which you are receiving the inventory transaction appears in the 
To Warehouse column.

To Location - The location in the warehouse to which you are receiving the inventory transaction 
appears in the To Location column.

Site ID - The site in which the transaction was created is inserted.

Trace ID - If the inventory transaction involves a traced part, the lot number, serial number, or other 
label for the tracing group appears in the Trace ID column.

N Property 1 - If you are using part tracing profiles and you have set up any alphanumeric and 
numeric properties for your tracing labels, the appropriate information appears in the N Property and 
A Property columns.

Completed Transaction Table
The Completed Transaction table contains the same columns as the Pending Transactions table, with 
the addition of one column titled Trans ID. The Inventory transaction processor automatically assigns 
a Transaction ID for each transaction it successfully processes.

Physical Inventory Count Transaction Processor (Vmbtsphy.exe)
The Pending Transaction table contains the following columns:

ID - The ID of the transaction appears in the ID column.

The Physical Inventory transaction processor automatically numbers each transaction with a unique 
identifier.

Trans Type - The type of the transaction appears in the Trans Type column. P is used for physical 
inventory counts. 

Part ID - The identification number of the part appears in the Part ID column.
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Trans Date - The date on which the transaction occurred appears in the Trans Date column.

Physical Count ID - The identification number of the physical count appears in the Physical Count ID 
column.

Tag # - The tag number of the part that was counted during the physical inventory appears in the Tag 
# column.

Qty - The quantity of the part you counted appears in the Quantity column.

Site ID - The site in which the transaction was created is inserted. 

User ID - The identification number of the user appears in the User ID column.

Trace ID - If the transaction involves a traced part, the lot number, serial number, or other label for the 
tracing group appears in the Trace ID column.

A Property 1 - If you are using part tracing profiles and you have set up any alphanumeric and 
numeric properties for your tracing labels, the appropriate information appears in the A Property and 
N Property columns.

Completed Transaction Table
The Completed Transaction table contains the same columns as the Pending Transactions table.

The Physical Inventory transaction processor automatically assigns a Transaction ID for each 
transaction it successfully processes, however, the Transaction ID does not appear in the Completed 
table.

Purchase Receipts Transaction Processor (Vmbtsrcv.exe)
The Pending Transaction table contains the following columns:

ID - The ID of the transaction appears in the ID column. The Physical Inventory transaction processor 
automatically numbers each transaction with a unique identifier.

Trans Type - The type of the transaction appears in the Trans Type column.

Transaction types are R (Purchase Receipt) and 2 (Purchase Return).

Trans Date - The date on which the transaction occurred appears in the Trans Date column.

PO ID - The identification number for the purchase order you are receiving appears in the Purchase 
Order ID column.

PO Line # - The number for the line on the purchase order you are receiving appears in the Line 
Number column.

Part ID - The identification number of the part appears in the Part ID column.

Qty. - The quantity of the part or material you are receiving appears in the Quantity column.

To Warehouse - The identification number for the warehouse to which you are receiving appears in 
the To Warehouse column.
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To Location - The identification number for the location within the warehouse to which you are 
receiving appears in the To Location column.

Base ID - If the transaction involves a work order, the Base ID of the work order appears in the Base 
ID column.

Lot ID - If the transaction involves a work order, the Lot ID of the work order appears in the Lot ID 
column.

Split ID - If the transaction involves a work order, the Split ID of the work order appears in the Split ID 
column.

Sub ID - If the transaction involves a work order, the Sub ID of the work order appears in the Sub ID 
column.

Operation Seq # - If the transaction involves a work order, the sequence number of the operation 
appears in the Operation Seq # column.

CO ID - If this receipt is linked to a customer’s purchase order, your customer’s order identification 
number appears in the CO ID column.

Site ID - The site in which the transaction was created is inserted.

CO Line # - If this receipt is linked to a customer’s purchase order, the line number of the purchase 
order to which this receipt is linked appears in the CO Line # column.

User ID - The identification number of the user appears in the User ID column.

Trace ID - If the transaction involves a traced part, the lot number, serial number, or other label for the 
tracing group appears in the Trace ID column.

A Property 1 - If you are using part tracing profiles and you have set up any alphanumeric and 
numeric properties for your tracing labels, the appropriate information appears in the A Property and 
N Property columns.

Completed Transaction Table
The Completed Transaction table contains the same columns as the Pending Transactions table, with 
the addition of one column titled Trans ID.

The Inventory transaction processor automatically assigns a Transaction ID for each transaction it 
successfully processes.

Sorting Information in the Line Item Table
You can sort the information in the line item table by Ln #, Part ID, Part Description, or Vendor Part 
ID. Click the triangle next to the column name by which you would like to sort. The system sorts the 
table by the column you choose.

Toggle between ascending and descending order by clicking the triangle. If the triangle points up, 
then the system sorts the column in ascending order. If the triangle points down, then the system 
sorts the column in descending order. 
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Shipping Transaction Processor (Vmbtsshp.exe)
The Pending Transaction table contains the following columns:

ID - The ID of the transaction appears in the ID column. The Physical Inventory transaction processor 
automatically numbers each transaction with a unique identifier.

Trans Type - The type of the transaction appears in the Trans Type column.

Transaction types are S (Shipment of a Customer Order) and L (Packlist Shipment).

Trans Date - The date on which the transaction occurred appears in the Trans Date column.

CO ID - If this shipment is linked to a customer’s purchase order, your customer’s order identification 
number appears in the CO ID column.

CO Line # - If this shipment is linked to a customer’s purchase order, the line number of the purchase 
order to which this receipt is linked appears in the CO Line # column.

Del. Sched Line # - If the shipment has a delivery schedule, the scheduled shipment line number 
appears in the Del. Sched Line # column.

Part ID - The identification number of the part appears in the Part ID column.

Qty. - The quantity of the part or material you are shipping appears in the Qty column.

From Warehouse - The ID of the warehouse from which you are shipping the goods appears in the 
From Warehouse column.

From Location - The ID of the location in the warehouse from which you are shipping the goods 
appears in the From Location column.

Trace ID - If the transaction involves a traced part, the lot number, serial number, or other label for the 
tracing group appears in the Trace ID column.

Base ID - If the transaction involves a work order, the Base ID of the work order appears in the Base 
ID column.

Site ID - The site in which the transaction was created is inserted.

Lot ID - If the transaction involves a work order, the Lot ID of the work order appears in the Lot ID 
column.

Split ID - If the transaction involves a work order, the Split ID of the work order appears in the Split ID 
column.

Sub ID - If the transaction involves a work order, the Sub ID of the work order appears in the Sub ID 
column.

Operation Seq # - If the transaction involves a work order, the sequence number of the operation 
appears in the Operation Seq # column.

PO ID - If this receipt is linked to a customer’s purchase order, your customer’s order identification 
number appears in the PO ID column.

PO Line # - If this receipt is linked to a customer’s purchase order, the line number of the purchase 
order to which this receipt is linked appears in the PO Line # column.

User ID - The identification number of the user appears in the User ID column.
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Trace ID - If the transaction involves a traced part, the lot number, serial number, or other label for the 
tracing group appears in the Trace ID column.

A Property 1 - If you are using part tracing profiles and you have set up any alphanumeric and 
numeric properties for your tracing labels, the appropriate information appears in the A Property and 
N Property columns.

Completed Transaction Table
The Completed Transaction table contains the same columns as the Pending Transactions table, with 
the addition of one column titled Trans ID.

The Inventory transaction processor automatically assigns a Transaction ID for each transaction it 
successfully processes.

Setting Shipment Print Options
You can configure print options so that Thermal Labels, Part Packlists, and bills of lading print 
automatically after the AMTS transaction processor processes a transaction and assigns it a status of 
Completed.

To assign shipment print options:

1 Open the Vmbtsshp.exe transaction processor.

2 Select Print Options from the File menu.

3 Select the options to use.

If you want to automatically print thermal labels for all of your customer shipment transactions, 
select the Auto Print Thermal labels check box.

If you want to automatically print Part Packlists for all customer shipment transactions, select the 
Auto Print Packlist check box. 

If you want to automatically print Bills of Lading for all customer shipment transactions, select the 
Auto Print BOL check box.

4 Click Save.

Running the ALTS Labor Ticket Transaction Processor 
(Vmbtslab.exe)
The Pending Transaction table contains the following columns:

ID - The ID of the transaction appears in the ID column. The Labor Ticket transaction processor 
automatically numbers each transaction with a unique identifier.

Trans Type - The type of labor transaction appears in the Trans Type column. The types are:
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C – Clock In

T – Start WO set up

U – Start job

D – Start Indirect

J – Stop Job

B – Break

O – Clock Out

8 – Stop Indirect

Trans Date - The date on which the transaction occurred appears in the Trans Date column.

Qty. - The quantity of the part or material involved in the transaction appears in the Qty column.

Bad Qty. - If there are any bad parts involved in the labor transaction, that quantity appears in the 
Bad Qty column.

Setup Completed? - If the labor transaction finished the setup, a Y appears in the Setup Completed? 
column.

Indirect ID - If the transaction is an indirect labor transaction, the indirect labor ID appears in the 
Indirect ID column.

Base ID - If the transaction involves a work order, the Base ID of the work order appears in the Base 
ID column.

Lot ID - If the transaction involves a work order, the Lot ID of the work order appears in the Lot ID 
column.

Split ID - If the transaction involves a work order, the Split ID of the work order appears in the Split ID 
column.

Sub ID - If the transaction involves a work order, the Sub ID of the work order appears in the Sub ID 
column.

Operation Seq # - If the transaction involves a work order, the sequence number of the operation 
appears in the Operation Seq # column.

User ID - The identification number of the user appears in the User ID column.

Site ID - The site in which the transaction was created is inserted.

Trace ID - If the transaction involves a traced part, the lot number, serial number, or other label for the 
tracing group appears in the Trace ID column.

A Property 1 - If you are using part tracing profiles and you have set up any alphanumeric and 
numeric properties for your tracing labels, the appropriate information appears in the A Property and 
N Property columns.

Completed Transaction Table
The Completed Transaction table contains the same columns as the Pending Transactions table.
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The Labor transaction processor automatically assigns a Transaction ID for each transaction it 
successfully processes, however, the Transaction ID does not appear in the Completed table.

Setting Timer Options
BTS transaction processors (the individual pieces that process your data) operate on timers that you 
can set to a specific amount of time in-between checks for new transactions.

To set timer options:

1 From the Timer Options menu, select Set Timer Period.

2 In the Time box, enter the period of time in milliseconds that you want to allow to lapse before the 
processor checks for new transactions.

There are one thousand milliseconds in one second. For example, if you enter 1,000, the 
transaction processor checks for new data every one second.

3 If you are going to run BTS with one or more of the transaction processor timers off and you want 
to automatically turn the timer on when you open that particular processor, select the Open 
Processor with Timer On check box.

4 If you want BTS to create a debug log file for processed transactions, select the Make Debug Log 
check box. 

5 Click OK.

The Timer Options dialog box closes.

Populating Pending Transactions on the Timer
If you want to start automatically checking your barcode data transactions, set the timer to check for 
pending transactions and start the timer:

1 From the Timer Options menu, select Refresh on Timer.

A check appears next to the menu selection to show you have selected the Refresh on Timer 
option.

The appropriate transaction processor automatically checks for new data transaction at each time 
interval and refreshes the appropriate processor window.

2 After you have set your timer options and are ready to begin the scanning process, you can start 
the timer by clicking the Start Timer button on the toolbar, or selecting Start Timer from the Timer 
Options menu.

Caution:  Because of the time it takes to actually process a transaction and the actual amount 
of transactions that take place in your business, you may want to consider a timer 
period no less than three seconds (30000 milliseconds).
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The Start Timer button changes to a Stop Timer button and the current time appears to the right 
and above the Pending Transactions table.

Stopping the Timer
If you want to examine a pending or confirmed transaction, you can stop the timer.

To stop the timer, click the Stop Timer button on the toolbar, or select Stop Timer from the Timer 
Options menu.

The current time no longer appears, indicating that you have stopped the timer.

Setting Date Options
In the shipping and receiving processors (Vmbtsshp and Vmbtsrcv) you can specify the number of 
days of completed transactions you want to appear in the processor windows.

1 From the File menu of either application, select Date Options.

2 Enter the number of days of completed transactions you want to appear.

Any completed transactions falling outside this number of days do not appear in the Completed 
Transactions section.

Note: If you want to view information for these transactions, you must do so from the Purchase 
Receipt Entry or Shipping Entry windows.

3 Click OK.
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Printing BTS Reports
Printing barcode transaction reports which contain lists of your barcoded transactions, can be a very 
useful. Using the BTS Transaction report tool, you can include all types transaction types and 
statuses in your reports. You can also constrain the range of each report by specifying which 
transaction types and statuses within a given time period you want to appear in your report.

Note: If the session timer is on, you cannot print reports. For more information on stopping the timer, 
refer to the appropriate section earlier in this chapter.

If you are licensed to use multiple sites, you can include more than one site on the report.

1 From any of the BTS transaction processor windows, click the Print button on the main toolbar, or 
select Print from the File menu.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable. 

3 Click the Start Date calendar icon and select the date from which you want to run this report.

Note: You can also click in a Date box and manually enter a Start Date or Thru Date. BTS uses a 
long date format. For example, you must enter the 18th June 2001 as 06/18/2002 or 06182002.

4 Select one of the following report types:

Summary - If you want a summary version of your report, select the Summary option button. The 
Print BTS Transactions dialog box automatically selects the summary report option.

Detail - If you want a highly detailed version of your report, select the Detail option button.

5 Select the Transaction Statuses you want to include in your report.

You can select:

Pending - Select the Pending check box if you want your report to include pending transactions. 
A pending transaction is a transaction that you have scanned but BTS has not processed.

Completed - Select the Completed check box if you want your report to include completed 
transactions. A completed transaction is a transaction that you have scanned and BTS has 
processed. 

Errors - Select the Error check box if you want your report to include errors.

6 Select the types of information you want in your report:

If you want to include all of your material transactions in the report, click the All AMTS Types 
button.

You can also select any combination of the following material transactions to include in your 
report:

Click Shipping if you want to include shipping transactions in the report.

Click Receiving if you want to include receiving transactions in the report.

Click Issue to WO if you want to include work order issue transactions in the report.

Click Receive from WO if you want to include work order receipt transactions in the report.

Click Material Movement if you want to include material movement transactions in the report.
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Click Physical Count if you want to include physical inventory count transactions in the report.

If you want to include all  of your labor transactions in the report, click the All ALTS Types button.

You can also select any combination of the following labor transactions to include in your report:

Click Clock In if you want to include Clock In transaction types in the report.

Click Start Setup if you want to include Start Setup transactions in the report. 

Click Start Run if you want to include Start Run transactions in the report.

Click Indirect if you want to include Indirect transactions in the report. 

Click Stop Job if you want to include Stop Job transactions in the report. 

Click Break if you want to include Break transactions in the report. 

Click Clock Out if you want to include Clock Out transactions in the report. 

7 Select an output for the report.

You can select:

Print - If you want to print your report, select Print from the drop-down list. When you click OK, a 
print dialog box appears. Select any appropriate printer settings and click OK.

View - If you want to view the report, select View from the drop-down list. When you click OK, the 
report appears in a separate window. If the report is acceptable and your want to print it, click the 
Print icon on the toolbar.

File - If you want to send this report to a file, select File from the drop-down list. When you click 
OK, the Print to File dialog box appears. Enter the file name and path where you want BTS to 
save your report and click OK.

E-mail - If you want to send a copy of this report by e-mail, select E-mail from the drop-down list. 
When you generate the report the system attaches the file to a Microsoft Outlook e-mail. See your 
Microsoft Outlook user documentation.

BTS sends transaction activity reports as attached RTF (Rich Text Format) files.

8 Click OK.

BTS prepares and displays the report you are running.

9 When you have finished viewing your report, close the report window by clicking the Close 
Window icon in the top right corner of the open window.

10 Click Close.

The Print BTS Transactions dialog box closes.
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Processing Selected Rows
From time to time you may find it necessary or helpful to process individual pending transactions.

If you are using BTS for the first time, you may find it helpful to process individual transactions from 
time to time to help develop an understanding of the transaction processors and their intricacies. 

In addition, you can use this feature as a debugging tool; after scanning a label or a barcode on a 
report, you can observe the transaction in the Pending Transactions table and verify that the data in 
the table is the data you scanned. When an error occurs, you can instantly identify it and take the 
appropriate steps to rectify the discrepancy.

To process an individual pending transaction:

1 Click the row header for the row you want to process.

The row appears highlighted.

2 Click the Process Selected Row button on the toolbar, or select Process Selected Rows from 
the File menu.

BTS processes the transaction and moves the transaction line to the Completed transactions 
section.
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Using the Archiving Utility
To archive or delete records from your transaction holding tables:

1 Select Archive from the File menu.

Because the BTS Archive Utility runs independently from any transaction processor, you can start 
the utility from any processor window.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the sites to archive. If 
you are licensed to use a single site, this field is unavailable.

3 In the Action section, select what you want the Archive Utility to do with your records.

If you want to mark the records in the holding table as archived records, select Archive Records.

If you want to delete the records from your holding table, select Delete Records.

4 In the Transaction section, select the statuses you want to archive. You can select:

Errors - If you want to archive all of the records with a status of Error (E), select the Errors check 
box.

Archived - If you want to archive all of the records with a status of Archived (A), select the 
Archived check box.

Completed - If you want to archive all of the records with a status of Completed (C), select the 
Completed check box.

5 In the Transaction Type section select what type of transactions you want to archive.

If you want to select all of your AMTS or ALTS transactions, click the All AMTS Types or All 
ALTS Types button.

If you want to select individual transaction types, click the first type you want and continue to 
select types while holding the CTRL key. Each transaction type you select appears highlighted.

6 In the Transaction Dates section select the dates between which you want to archive records.

Click the From calendar button and select the date from which you want to archive records. If you 
want to select all records after a certain date, do not enter a To date.

Click the To calendar date button and select the date up to which you want to archive records. If 
you want to archive records up to but not after a certain date, do not enter a From date.

7 Click OK.

If you have selected to archive records, the BTS Archive Utility changes all of the effected 
record’s transaction statuses to A (Archived).

If you have selected to delete records, the BTS Archive Utility removes all of the effected records 
from the holding table.

Caution:  Deleting information permanently removes the information from your database. You 
CANNOT recover deleted information. Make sure that you no longer need the 
information before you delete it.
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Using BTS
Using a barcode scanner depends upon which brand of scanner you have. Alll scanners interface 
with BTS in much the same way. Once you have learned how to scan barcodes for one function, all 
other scanning functions will basically be the same.

Following is a list of material related functions on which you can use barcodes to input data:

• Purchase order receipt
• Shipping Customer Orders
• Transferring materials:

Location to location

Issue to work order

Receive from work order

• Physical Inventory Count
• Edit Packlist

These codes are used on your scanner screen. Scanner screens vary widely and depend on the 
brand and model of scanner you have.

• A. PO Receipt
• B. Location to Location
• C. Issue to a WO
• D. Recv from a WO
• E. Ship to a CO
• F. Phys Inv/CC
• G. Edit Packlist
• H. Close Packlist
• I. Issue Return
• J. Adjust In
• K. Adjust Out
• L. Rtn to Vendor by PO
• M. Rtn to Vendor by Rcvr
• 1. Clock In 
• 2. Start Setup
• 3. Start Run
• 4. Indirect
• 5. Stop Job
• 6. Break
• 7. Clock Out
• 8. Employee Status
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You can validate that BTS has processed the transaction by running the appropriate transaction 
processor and looking for the scanned record in the Completed Transactions table (or the Pending 
Transaction table if the processor timer is not running.)

You can also check for the correct inventory transaction in the appropriate window.

Receiving Purchase Orders
Use BTS Receiving to scan the barcodes related to the products you receive at your receiving dock. 
The data you scan is available as if you entered the transactions using the Purchase Receipts Entry 
window.

Caution:  When you are scanning barcodes, make sure you scan the barcode that the module 
is requesting.
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Purchase Order Receipt Flowchart

Assuming that all of the relevant paperwork has been printed with barcodes and the parts you are 
receiving have had the appropriate barcode labels attached, the following flow charts show a 
graphical representation of the various steps that the Purchase Order Receipt module could go 
through during receipt of a purchase order.

BTS steps the user through the scanning process depending on how the purchase order was set up. 
For example, if the purchase order was linked to a work order or customer order, BTS prompts the 
user to scan the appropriate barcode before scanning the quantity.
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Transferring, Moving, and Issuing Materials Using BTS
You can perform the following material movements using BTS:

• Location to Location transfers. Location to location transfers can include:

Any Warehouse/Location to Any Warehouse/Location 

Primary Warehouse/Location to Any Warehouse/Location 

Any Warehouse/Location to Auto-Issue Warehouse/Location

Any Warehouse/Location to Inspection Warehouse/Location

• Issues to Work Orders
• Receipts from Work Orders

You can validate that BTS has processed the transaction by running the appropriate transaction 
processor and looking for the scanned record in the Completed Transactions table (or the Pending 
Transaction table if the processor timer is not running.)

You can also check for the correct inventory transaction in the appropriate window.

Assuming that all of the relevant paperwork has been printed with barcodes, and the parts you are 
transferring have had the appropriate barcode labels attached, the following flow charts shows a 
graphical representation of the various steps through which the various material transfer modules 
could go when you are using barcode scanners.

Use the Prevent Negative Backdating check box to determine how to examine current inventory when 
a backdated inventory transaction is generated in Inventory Transaction Entry, Shipping Entry, 
Receiving Entry, or IBT Shipping Entry. If you select this check box, then the quantity you had on 
hand on the date of the transaction is used to determine inventory levels. If you did not have sufficient 
quantity on the date of the transaction, then the transaction cannot be completed. For example, say 
you enter an adjust out inventory transaction on January 5 for 10 units, but you specify January 3 as 
the transaction date. If you only had 8 units in your inventory on January 3, then you are prevented 
from completing the backdated transaction if you select the Prevent Negative Backdating check box.

Completing Backdated Transactions
When you backdate a transaction that causes materials to be removed from your inventory, such as 
an adjust out, a purchase return, or a shipment, your ability to complete the transaction depends upon 
the Prevent Negative Backdating setting specified for the site in Site Maintenance.

If the check box is selected, then the quantity you had on hand on each date from the date of the 
transaction to the current date is used to determine inventory levels. If you did not have sufficient 
quantity on any one of the days between the date of the transaction and the current the date, then the 
transaction cannot be completed. For example, say you enter a shipment on January 5 for 10 units, 
but you specify January 3 as the transaction date. If you only had 8 units in your warehouse location 
on January 4, then you are prevented from completing the shipment.

If the check box is cleared, then the quantity you have on hand on the date you enter the transaction 
is used to determine inventory levels. For example, say you enter a shipment on January 5 for 10 
units, but you specify January 3 as the transaction date. If you have 10 units on hand in the 
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warehouse location on January 5, then you can complete the transaction, even if you did not have 10 
units on hand on January 3 or January 4. When you clear the Prevent Negative Backdating check 
box, you can generate negative inventory balances for past dates, even though you do not allow 
negative inventory balances for current dates.

If you clear the Prevent Negative Backdating check box, then the quantity you have on hand on the 
date you enter the transaction is used to determine inventory levels. For example, say you enter an 
adjust out inventory transaction on January 5 for 10 units, but you specify January 3 as the 
transaction date. If you have 10 units on hand on January 5, then you can complete the transaction, 
even if you did not have 10 units on hand on January 3. When you clear the Prevent Negative 
Backdating check box, you can generate negative inventory balances for past dates, even though 
you do not allow negative inventory balances for current dates.

Transferring Materials From Location to Location
If you want to move materials from any valid warehouse/location to any other valid warehouse/
location, use the Location to Location barcoding module. If you are licensed to use multiple sites, the 
warehouses must belong to the same site. The data you scan is available as if you entered the 
transactions using the Inventory Transaction window.

Note: If you do NOT want the Location to Location barcoding module to request a location scan for a 
default Primary, Auto-issue, or Inspection location, you must change the appropriate Vmbts.ini 
setting.
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Location to Location Flowchart
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Existing Trace ID Flowchart
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Use Max Lot Quantity Flowchart

Issuing Materials to a Work Order
If you want to issue materials from a warehouse location to a work order, use the Issue to a Work 
Order barcoding module. The data you scan is available as if you entered the transactions using the 
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Issue Materials to Work Order Flowchart

Receiving Materials From a Work Order
If you want to receive materials from a work order, use the Receipt From a Work Order barcoding 
module. The data you scan is available as if you entered the transactions using the Inventory 
Transaction window.
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Receive Materials From a Work Order Flowchart

Shipping Customer Orders Using BTS
Use the BTS Shipping program to scan the barcodes relating to outgoing shipments at your loading 
dock. The data is available in your database as if you entered the transactions using the Shipping 
Entry window.

Assuming that all of the relevant paperwork has been printed with barcodes and the parts you are 
shipping have had the appropriate barcode labels attached, the following flow chart shows a graphical 
representation of the various steps through which the Ship Customer Order module could go during 
shipping a customer order process.
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Ship a Customer Order Flowchart

The actual steps that the processor takes, depends on how the purchase order was set up. For 
example, if the customer order is linked to a work order or purchase order, BTS prompts the user to 
scan the appropriate ID barcode before scanning the quantity.
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Using the Physical Inventory and Counts transaction processor, you can use barcodes to help you do 
physical inventory counts and cycle counts.
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Assuming that all of the relevant tags and sheets have been printed with barcodes and the parts you 
are counting have had the appropriate barcode labels attached, the following flow chart shows a 
graphical representation of the various steps that the Physical Count module could go through during 
the physical inventory and cycle count:
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Using the Edit Packlist transaction processor, you can use barcodes to help you ship parts you have 
set up with a trace profile.
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Assuming that all of the relevant paperwork has been printed with barcodes and the parts you are 
shipping have had the appropriate barcode labels attached, the following flow chart shows a graphical 
representation of the various steps through which the Edit Packlist module step during shipping:
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Trace Number Related Flowcharts
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Proceed to Preassigned Trace Numbers Required Flowchart
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Using   ALTS
Using a barcode scanner depends on which brand of scanner you have. However, all scanners 
interface with BTS in much the same way. Once you have learned how to scan barcodes for one 
function, all other scanning functions will basically be the same.

Using your barcode scanners for labor transactions, you can efficiently track, in real time, exactly how 
much labor is being applied by whom to where.

You can use barcodes to input data for the following labor related functions:

• Clock Ins
• Setup Starts
• Run Starts
• Indirect Transactions
• Job Stoppages
• Breaks
• Clock Outs

The following example gives you an idea of what appears on your scanner screen. Scanner screens 
vary widely and what you will see on your scanner screen depends on the brand and model of 
scanner you have.

You can validate that BTS has processed the transaction by running the appropriate transaction 
processor and looking for the scanned record in the Completed Transactions table (or the Pending 
Transaction table if the processor timer is not running.)

You can also check for the correct labor transaction in the appropriate window.

Clocking In
Using the Clock In transaction processor, you can use barcodes to help your employees clock in.

Caution:  When you are scanning barcodes, make sure you scan the barcode that the module 
is requesting.

A. PO Receipt 1. Clock In
B. Location to Location 2. Start Setup
C. Issue to a WO 3. Start Run
D. Recv from a WO 4. Indirect
E. Ship to a CO 5. Stop Job
F. Phys Inv/CC 6. Break
G. Edit Packlist 7. Clock Out

8. Employee Status
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Follow the steps below to clock into the labor transaction system:

Starting Setups
Using the Start Setup transaction processor, you can use barcodes to track the times when 
employees start job setups.

Follow the steps below to start a labor transaction for the setup of a job:

Starting Runs
Using the Start Run transaction processor, you can use barcodes to track the times when employees 
start job runs.

From the main menu, 
select "1" (Clock In)

Scan User ID

Process and Return to 
the main menu

From the main menu, 
select "2" (Start Setup)

Scan User ID

Scan Work Order information
(Base ID/Lot ID/Split ID/Sub ID/Op 
#/Seq #)

Process and Return to the 
main menu
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Follow the steps below to start a labor transaction for the running of a job:

Tracking Indirect Labor
Using the Indirect transaction processor, you can use barcodes to track an employee’s indirect labor.

Follow the steps below to start a labor transaction for indirect labor:

Stopping Jobs
Using the Stop transaction processor, you can use barcodes to stop the tracking of labor for a job 
setup or run, or indirect labor.

From the main menu, 
select "3" (Start Run)

Scan User ID

Scan Work Order information
(Base ID/Lot ID/Split ID/Sub ID/ Op 
#/Seq #)

Process and Return to the 
main menu

From the main menu, 
select "4" (Indirect)

Scan User ID

Scan Indirect Labor ID

Process and  Return 
to the main menu
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Follow the steps below to stop a labor transaction:

Tracking Breaks
Using the Break transaction processor, you can use barcodes to track the break times taken by 
employees.

Follow the steps below to track time taken on breaks:

From the main menu, 
select "5" (Stop Job)

Scan User ID

Scan Work Order information
(Base ID/Lot ID/Split ID/Sub ID/
Op #/Seq #)

Scan Completed Quantity or 
percentage

Scan Deviated Quantity

Scan Deviated Reason

Is the  Setup or Run 
Completed?
Scan Answer (Yes or No)

Process and Return to 
the main menu

From the main menu, select 
"6" (Break)

Scan User ID

Process and Return 
to the main menu
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Clocking Out
Using the Clock Out transaction processor, you can use barcodes to track the times when employees 
clock out of the labor transaction system.

Follow the steps below to clock out of the labor transaction system:

Viewing Current Employee Status
Using the Employee Status transaction processor, you can use barcodes to check your current Clock 
In status.

Follow the steps below to check your Clock In status:

From the main menu, select 
"7" (Clock Out)

Scan User ID

Process and Return 
to the main menu

From the main menu, select 
"8" (Employee status)

Scan User ID

Press ENTER key

Process and Return 
to the main menu
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Printing Barcodes
There are two types of barcodes you can print from within VISUAL:

• Barcodes that you print on reports.

You can print all of the relevant reports within VISUAL, that apply to barcodes, with or without the 
appropriate barcodes. This means you only need to print barcodes on the reports you intend 
using with your barcode scanning system.

• Thermal label barcodes.

For each of the reports to which thermal labels apply, a button appears. When you click the 
Thermal Label button the Print Thermal Labels dialog box appears allowing you to print the 
thermal labels that apply to the report you are processing.

There are three basic steps to printing barcode thermal labels:

1 Design your labels.

Using label design software like Loftware’s Label Printing System, design your labels according to 
your label needs and the type of thermal label printers you use. During the design process you 
will decide what information you want on your labels and the barcode layout on the actual label.

2 Link your data.

Use the BTS Labels/Printers Setup utility to link the data fields in your labels to the appropriate 
fields in your VISUAL database.

3 Print your barcodes.

Using the appropriate VISUAL window, print your report barcodes and matching thermal labels.

For more information on printing barcodes, see the section later in this chapter.

Designing Your Labels
Because BTS does not incorporate any label design features, you must design your label layouts and 
data fields in a third party program such as Loftware’s Barcode Label Printing System (LLM-WIN32).

Design your labels according to the instruction of the software you are using.

Note: Make sure that you have selected to create TAB files when you save a label file. See your label 
software documentation.

Defining Label Formats
Before you can use any of your label designs to print barcode labels you must define your label data 
connections; you need to tell your labels from where in your VISUAL database to get their data.

If you are licensed to use multiple sites, specify label formats on a site-by-site basis.

To define label data connections:
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1 Open the Vmbtslp.exe Labels/Printers Setup utility.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site for which you 
are setting up label formats. If you are licensed to use a single site, this field is unavailable.

3 Click in the Label ID box and enter a name you want to use for this label data connection.

If you are creating a label data connection that is similar to one you already have, click the Label 
ID button and select the appropriate Label ID.

You can then make the changes you want and save the new connection under a different Label 
ID.

4 Click the Label Type arrow and select a label type for this data connection.

Depending on the label type you select, the VISUAL database tables to which you have access 
appear in the Available Data Tables drop-down list box. For example, if you select Warehouse for 
a label type, only Location L and Warehouse W appear in the Available Data Tables drop-down 
list box because they are the only appropriate tables for Warehouse label types.

The following database tables are available for each label type:

Label Type VISUAL 
Database Tables Label Type VISUAL Database Tables

ORDERING 

CUSTOMER_OR
DER_LINE 
CUSTOMER_OR
DER PART 

RECEIVING 

PART 
PURC_ORDER_LINE 
PURCHASE_ORDER 
RECEIVER RECEIVER 
LINE 

PART 
PART 
PART_LOCATIO
N 

SHIPPING 

CUST_ADDRESS 
CUST_ORDER_LINE 
CUSTOMER 
CUSTOMER_ORDER 
PART PART_SHIPPER 
PART_SHIPPER_LINE 

PART_SHIPPING 

CUSTOMER_AD
DRESS 
CUSTOMER 
PART 
PART_SHIPPIN
G TRACE 

SHP 
TRACEABLE 

CUST_ADDRESS 
CUST_ORDER_LINE 
CUSTOMER 
CUSTOMER_ORDER 
PART PART_SHIPPER 
PART_SHIPPER_LINE 
TRACE 
TRACE_INV_TRANS 

PHYSICAL 

PART 
PHYS_COUNT 
TAG 
PHYSICAL_COU
NT 

TRACEABLE PART TRACE 
TRACE_INV_TRANS 
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5 Click in the Description box and enter a description for this Label ID. You can also click the 
Description button to select a description from the table.

6 Click the Available Data Tables arrow and select the data table from which you want the label 
data to come.

7 There are three methods to select a data field from the Available Data Fields list:

In the Data Fields Available list, click the data field you want to use. Click the right arrow and the 
name of the field appears in the left Selected Data Fields list.

Double-click the field you want to use and it automatically appears in the left Selected Data Fields 
list.

Select the field you want to use and drag it to the left Selected Data Fields list.

Continue selecting the fields you want to use in your label.

8 After you have selected the database fields you want to include in your label, click the Label File 
button and select the label with which you want to associate the data fields you have selected.

9 Click the Label Fields button.

The Label fields from the label you selected appear in the Label Fields Available list on the right of 
the window.

10 For each data name in the left Selected Data Fields list, select a corresponding data field from the 
right Label Fields Available list.

PO_LINKED 

PART 
PURC_ORDER_
LINE 
PURCHASE_OR
DER 
REQUIREMENT 

WAREHOUSE LOCATION WAREHOUSE 

PURCHASING 

PART 
PURC_ORDER_
LINE 
PURCHASE_OR
DER 

WO_LINKED_CO 

CUSTOMER_ORDER_LIN
E CUST_ORDER 
DEMAND SUPPLY LINK 
PART WORK ORDER 

RCV 
TRACEABLE 

PART 
PURC_ORDER_
LINE 
PURCHASE_OR
DER RECEIVER 
RECEIVER LINE 
TRACE 
TRACE_INV_TR
ANS 

WORKORDER 

OPERATION 
PART_MATLPART 
PART_WOPART 
REQUIREMENT 
WORK_ORDER 

Label Type VISUAL 
Database Tables Label Type VISUAL Database Tables
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The first field you select appears next to the top data field and each subsequent field you select 
appears as you select it.

Use the double-sided arrows next to the columns to link the database field to the label field.

Note: You must arrange the label fields so that they appear next to the data fields with which you 
want them associated.

11 After you have linked all of the data fields you need for your label, click the Save icon on the 
toolbar.

Printing Barcodes
There are two types of barcodes you can print from within VISUAL:

Printing Barcodes on VISUAL Reports
All of the reports within VISUAL on which you can print barcodes have a Print Barcodes check box. If 
you want to include barcodes in a report, select the Print Barcodes check box and select the type of 
barcode.

Code39 – This barcode type, also known as Code 3 of 9, contains variable length, discrete 
symbology. You must have a Code 39 barcode font installed to view the barcode. If you do not have 
the Code 39 font installed, then the alphanumeric ID is displayed instead with a prefix and suffix. This 
pattern is used: *%ID%*. 

QR Code – This is a two-dimensional or matrix barcode. QR stands for quick response.

Because of the many reports available in VISUAL the report you print may look different to the 
example below.
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Printing Thermal Label Profiles
Printing a report containing all or some of your label profiles can be a very useful tool when you are 
originally designing your company’s thermal labels.

To print your label profiles:

1 Open the Labels Printer Setup utility.

2 Click the Print icon on the toolbar, or from the File menu, select Print.

3 If you want to print a report limited to a label type, click the Label Type arrow and select the 
appropriate label type from the list.

4 If you want to limit your report to specific labels or a group of labels:

If you want to limit your report to a specific group of labels, click the Starting Label ID button and 
select the label with which you want to start the report. Click the Ending Label ID and select the 
label with which you want to end your report.

If you want to print a report containing all of your labels after a specific Label ID, click the Starting 
Label ID button and select the label with which you want to begin this report.

If you want to print a report containing all of your labels before a specific Label ID, click the 
Ending Label ID button and select the Label ID with which you want to end this report.

5 If you want to include an example barcode of the label’s type, ID, and data and label fields, select 
the Print Barcode check box and select a barcode type.

Code39 – This barcode type, also known as Code 3 of 9, contains variable length, discrete 
symbology. You must have a Code 39 barcode font installed to view the barcode. If you do not 
have the Code 39 font installed, then the alphanumeric ID is displayed instead with a prefix and 
suffix. This pattern is used: *%ID%*. 

QR Code – This is a two-dimensional or matrix barcode. QR stands for quick response.

6 Click the arrow and select the output you want to use for this report.

You can select:

Print - If you want the print utility to send your report directly to your printer, select Print.

View - If you want to view your report on screen, select View.

You can print your report from the View dialog box.

File - If you want the print utility to save your report as a file, select File.

E-mail - If you want the print utility to send your report (in Rich Text Format) through electronic 
mail, select E-mail.

When you generate the report the system attaches the file to a Microsoft Outlook e-mail. See your 
Microsoft Outlook user documentation.

7 Click OK.
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What are ECNs?
Engineering Change Notification (ECN) is the process and methodology you use to control changes 
to your product designs and manufacturing processes. Infor Global Solutions has developed ECN’s 
capabilities to help you establish and maintain methods for managing your engineering changes 
within the VISUAL system.

Depending on the industry, your company may call the ECN process by a different name. For 
example, Engineering Change Request (ECR), Engineering Change Order (ECO), and Engineering 
Change Notice (ECN). Some companies use all three terms as a means of designating the sequential 
steps involved in the overall process: starting with the request, going to the order, and ending with the 
notification. Some companies separate their document changes from their product changes, referring 
to the document changes as Document Change Requests (DCR). Depending on your business 
processes, engineering change management may include one or all of these valid terms. ECN 
combines each of these engineering changes into a single, comprehensive process whereby ECN 
status determines the current stage whether it be request, order, or notification. ECN uses 
Authorization, Implementation, Approval, and Distribution Teams to assign the ECN (as a task) to 
various users throughout the engineering change management process.

ECN enables you to manage engineering changes to your documents, parts, and bills of 
manufacture. While the engineering change process usually varies from company to company, there 
are some elements that are common to all companies. All ECNs contain a problem statement or 
subject for the change, who needs to authorize it, a description of what work needs to be done, and 
who needs to be notified of the completed changes.

ECN accomplishes this task by including:

• Automatic notifications of needed signoffs for tasks via ECN Task Maintenance
• Notification to production and engineering of pending changes
• Electronic notification of completed ECNs to a distribution list
• Prevention of specific transactions to work already in progress
• Control of ECNs on manufacturing legs
• Ability to assign multiple ECNs to a single document, part, or bill of manufacture
• Ability to assign multiple documents, parts, and bills of manufacture, to a single ECN
• Electronic signatures
• Electronic record security
• ECN status conditions
• Effectivity conditions
• Management of change history
• Engineering change history for documents, parts, and bills of manufacture
• Audit history of engineering change notices

Understanding Toolbar Buttons
The Engineering Change Notice Entry window uses many of the standard toolbar icons with the 
addition of the following icons:
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 – Subject Comment - Click the Subject Comment icon to enter notes on the Subject tab.

 – Notes Comment - Click the Notes Comment icon to enter comments and notes on the Notes 
tab.

 – ECN Tree - To view an ECN’s dependencies in a tree structure, click the ECN Tree icon on the 
toolbar.

 – Line Item Specifications - With a line selected, you can enter and view the specifications 
for the line in a larger dialog box by clicking the Line Item Specifications icon on the toolbar. When 
line item specifications exist no diagonal line is shown on the icon.

 – Start - With a line selected, you can start the associated program by clicking the Start icon on 
the toolbar.

 – Where Used - When you are working with Parts and Engineering Masters, you can view a list 
of where the item on the line you select is used by clicking the Where Used icon on the toolbar.

 – Subordinate Parts - When you are working with Parts, Engineering Masters, and Work 
Orders, you can view a list of all subordinate parts involved with the line you select by clicking the 
Subordinate Parts icon on the toolbar.

 – Work in Process -When you are working with Parts and Engineering Masters, you can view 
work in process details by clicking the Work in Process icon on the toolbar.

 – Line Detail - When you are working with Work Orders and Engineering Masters, you can view 
the actual details of the changes made to the master you have specified in the ECN by clicking the 
Line Details icon on the toolbar.

 – Apply Changes - When you are working with Engineering Masters, you can apply the changes 
you have made in the master specified in the ECN to the corresponding work orders of the same ID 
by clicking the Apply Changes icon on the toolbar.

Note: You cannot apply changes to Closed or Cancelled work orders.

ECNs in a Multi-site Environment
If you are licensed to use multiple sites, ECNs behave in this manner:

Documents – For site-level documents, specify the site in the Site ID field that owns the document to 
create an ECN. For tenant-level documents, specify a site that is allowed to use the document in the 
Site ID field to create an ECN. 
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Engineering Change – Since engineering changes are maintained at the site level, any ECN you 
enter for an engineering change affects the engineering change in the selected site only.

Engineering Master – Since engineering masters are maintained at the site level, any ECN you enter 
for an engineering master affects the engineering master in the selected site only.

Parts – Depending on the part information you change to comply with an ECN, an ECN you enter for 
a part in one site may affect the part record in other sites. If your ECN specifies a change to 
information maintained at the tenant level, then all site records for that part will also be changed.

Work Order – Since work orders are maintained at the site level, any ECN you enter for a work order 
affects the work order in the selected site only.
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Setting Up ECNs
Before you begin creating ECNs, specify default ECN settings and create the common codes to use 
in ECNs. 

Specifying Default ECN Settings
If you are licensed to use multiple sites, you must establish ECN default settings on a site-by-site 
basis. If you are licensed to use a single site, you must establish ECN default settings on an 
enterprise-wide basis.

The settings you specify on the ECN tab in Site Maintenance determine the behaviors of ECNs in 
your system.

To specify default ECN settings:

1 Select Admin, Site Maintenance.

2 If you are licensed to use multiple sites, click the Entity ID arrow and select the parent entity of 
the site. If you are licensed to use a single site, this field is unavailable. 

3 If you are licensed to use multiple sites, click the Site ID arrow and select the site for which you 
are setting up default ECN information. If you are licensed to use a single site, this field is 
unavailable.

4 Click the ECN tab.

5 Specify the settings to use with ECNs. Select from these check boxes:

Modify ECNs with an on-hold status – To allow users to modify ECNs with an on-hold status, 
select this check box. To prohibit users from modifying ECNs with an on-hold status, clear this 
check box. If you clear the check box, ECNs cannot be modified until their statuses change from 
on-hold. 

Password required for secured fields - To require your users to enter a password when they 
enter data in certain fields, select the Password required for secured fields check box. If you 
select this check box, users must specify their password when entering subject or notes 
comments in ECN entry. Users must also specify their password when changing the status of an 
assigned task. This functionality provides you with electronic signature capability.

If you do not require passwords to be entered, clear this check box.

Generate all tasks simultaneously - To generate tasks for members of all of your ECN teams at 
the same time when you change the ECN’s status from Undefined, select the Generate all tasks 
simultaneously check box. If you do not select this check box tasks are generated only for the 
first non-completed team. For example, Implementation team members will not receive tasks until 
Authorization team members have signed off on their tasks.

Lock new engineering change notifications - If you want to automatically lock all new ECNs, 
select the Lock new engineering change notifications check box.
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Allow application of ECN to unreported ops/reqs to in-process work orders – Select this 
check box to apply ECNs to work orders that are already in process, provided that labor has not 
already been reported or material issued to the operations and requirements affected by the ECN. 
For example: you have an engineering master with operations A, B, and C. You enter an ECN that 
affects operation B. 

In one work order based on the engineering master, a labor ticket has already been entered 
against operation B. In this case, the ECN would not be applied to the work order. In another work 
order based on the engineering master, labor had been reported to operation A but not to 
operation B. In this case, the ECN would be applied. 

If the ECN update has any impact on a requirement or operation that has actual labor or material 
issues, the system will not update the work order. For example, if an ECN changes a quantity per 
on a leg header card, the system will not update the work order if labor or materials have been 
applied under the leg.

If you select this check box, the system will not apply ECNs to split work orders or work orders 
with active demand supply links.

Clear the check box if you do not want the system to apply ECNs to any in-process work order.

6 In the Maintenance section of the ECN tab, click the appropriate button and set up these codes:

Types - In the Types list, set up specific codes for the types of ECNs your company uses. ECN 
types are specific classifications to your company. Some common ECN types include Drawing 
Revision, Design Change, New Tooling, and Tooling Change.

Reasons - In the Reason list, set up the codes you want to use for the reasons you will be issuing 
ECNs in your company. Some common ECN reasons include Design Defect, Field Failure, 
Manufacturability, and Regulatory/Standards Requirements.

Dispositions - In the Disposition list, set up codes for the dispositions you want in processing 
ECNs in your company. Some common ECN disposition codes include New, Obsolete, Scrap, 
Use as Is, and Return to Vendor.

Rejection Codes - In the Rejection Codes list, set up the codes you want to use for why a 
particular ECN may be rejected.

7 If you use Infor Quality Management, specify the connection settings to use. Click the General 
tab, and then select the Enable check box in the Infor Quality Management Interface section. 
Specify this information:

Always Use/Query Use – After an ECN is ready to be implemented, you click the Start button in 
ECN Entry. These options determine the result of clicking the Start button. If you click Always 
Use, then IQM is always launched when you click the Start button in ECN Entry. If you click Query 
Use, then you are prompted to choose to open the appropriate IQM maintenance window or to 
open the appropriate VISUAL maintenance window. For example, if the ECN is for a document, 
you can choose to open IQM Document Maintenance or VISUAL Document Maintenance.

Application Path – Specify the default URL for IQM. This is the URL you access to log into IQM.

Configuration – Specify the IQM configuration to log into. 
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Use VE User – To pass the currently logged in VISUAL user ID to the IQM log in window, select 
this check box. If the user is already logged into IQM, then IQM can be accessed directly from 
VISUAL. The user does not have to log into IQM again. If the user is not currently logged into 
IQM, then the user ID is passed to the IQM log in window. The user must supply a password. To 
require users to always log into IQM, clear this check box.

8 Click the Save button.

Setting up Lists
Before you can select an item from a list, you must open the appropriate list and add the items to the 
list. You may find it helpful to prepare your ECN code lists and set up all of your lists prior to entering 
any ECNs.

By way of example, this manual shows setting up the ECN Types list: the process to set up your 
Disposition Code, ECN Reason, and Rejection Codes lists is the same.

While you set up ECN types in Site Maintenance, the types you set up are available for all sites. ECN 
code lists are stored at the tenant level.

To set up your ECN Types list:

1 In the Site Maintenance window on the ECN tab, click the Types button.

2 Click the Insert button.

A new row at the bottom of the list appears highlighted and the cursor appears in the Code 
column.

3 Enter the code you want to use.

4 Click the TAB key and enter a description for this code.

5 Click the Save button.

Any previously unsaved information is saved.

Deleting Items in Lists
To delete a line item from a list:

1 Open the appropriate list.

2 Click the row header fro the line item you want to delete.

The row appears highlighted.

3 Click the Delete button.

An X appears in the row header indicating you have marked the line item for deletion.

4 Click the Save button.

The line item is removed from your database.
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Setting up Groups
To facilitate the creation of ECN teams, you can create ECN groups, which you can use to assign 
entire sets of users to a team or teams.

You may find it useful to create groups by department or functional responsibility. Or, if you usually 
have the same people sign off on the various stages of your ECNs, you may find it useful to create a 
group of users for the sole purpose of designating them as the default Authorization, Implementation, 
Approval, or Distribution Team. You can modify ECN Groups as required for individual ECNs.

If you are licensed to use multiple sites, you must set up groups on a site-by-site basis. When you 
create a user group in a particular site, only those users who have been assigned to the site can be 
included in the user group. 

If you are licensed to use a single site, you can assign any user to any group.

To set up ECN Groups:

1 Select Security, Profile/User/Group Security.

2 In the Security by section, select Group. When you select the Group option, the system displays 
the Group tab and deactivates the other tabs.

3 In the Group ID field, specify a group ID. In the field to the right of the group ID field, specify a 
description of the group.

4 Click the Language ID arrow and select the language that the group uses.

5 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you are 
creating this group. If you are licensed to use a single site, this field is unavailable.

6 If this group is a default team for your ECNs, specify which task for which this group is responsible 
in the ECN Default Team section. You can override the default and select a different team when 
you enter the ECN. A group can be assigned to more than one default ECN approval group.

7 Select the Group Signoff check box if any one member of the group can sign off for the entire 
group. When you generate tasks for the group, each member of the group receives the task. 
When one member completes the task, the system marks the task for all group members 
complete. 

If you select the Group Signoff check box, only one member of the group has to complete the task 
assigned to the group. For example, say ECN123 is assigned to the ECN Implementation Team, 
which is made up of User1, User2, User3, and User4. When you select the Group Signoff check 
box, only one of the users in the group needs to complete the task related to ECN123. When one 
user in the group marks the task Complete, the system marks the task complete for the other 
users.

Clear the check box if each member of the group has to complete assigned tasks, or if you want 
to enable the Signoff function for only certain group members. When you clear the check box, the 
system activates the User Signoff check box.

8 Add members to the group. Click the Insert Row button, then double-click the User ID browse 
button. If you are licensed to use multiple sites, the User ID browse table shows only the users 
who have been assigned to the selected site. If you are licensed to use a single site, you can 
select any user.

9 Specify the following for the users:
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Leader – If the user is a the group’s leader, select the Leader check box. Each group can have 
only one leader. The leader can view the team members’ tasks in Tasks Maintenance.

User Signoff – If you have cleared the Group Signoff check box, the system activates the User 
Signoff check box. When you select the User Signoff check box for more than one user, one of 
the selected users can complete the assigned task on behalf of the other selected users. For 
example, say ECN123 is assigned to the ECN Implementation Team, which is made up of User1, 
User2, User3, and User4. You have selected User Signoff for User 1, User2, and User3. If User2 
completes the task, the system marks User1’s and User3’s task complete. User4’s task, however, 
remains open until User4 marks the task complete. The group does not complete the task until 
User4 and one of User1, User2, and User3 marks the task as complete. 

10 Click Save.
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Entering ECN Information
The Engineering Change Notice Entry window contains four sections:

Basic Information - The Basic Information section contains your ECN set up information and tells the 
user who created the ECN and to whom the creator assigned the management of this ECN.

Additional Information - The tabbed section at the right portion of the ECN window contains 
additional comments and cost analysis information. It also contains a History tab that shows a 
chronological history of everything that any user does to this ECN.

Teams/Completion Status - The Teams/Completion section contains the users and teams that the 
creator assigned to perform the status tasks.

ECN Table - The line item table at the bottom of the ECN Entry window contains the individual tasks 
you want performed in order to complete the ECN.

Entering Basic Information into ECNs
To enter an ECN:

1 From the main window, click the Eng/Mfg menu and select the ECN Entry option.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you are 
creating the ECN. If you are licensed to use a single site, this field is unavailable.

3 If you want to manually number this ECN, enter a unique ID in the ECN ID box.

If you want the next available ECN ID automatically entered, leave the ECN ID box empty.

4 The current user’s identification is automatically entered in the Creator box. If you want to change 
the creator for this ECN, click the Creator button and select the User ID you want to use as a 
creator for this ECN.

5 Click the Assigned To button and select the user to which you want to assign this ECN.

6 The current date is automatically entered in the Request Date box, if you want to change this 
date, click the Calendar button and select the date you want to use.

7 Click the Calendar button for the Desired Finish Date and select the date you want to use as a 
finish date for this ECN.

8 In the Teams/Completion Status section click the appropriate buttons and enter the following:

Authorization - Click the Authorization button and select the user or group you want to use for 
your ECN authorization.

Implementation - Click the Implementation button and select the user or group you want to use 
for your ECN implementation.

Approval - Click the Approval button and select the user or group you want to use for your ECN 
approval.

Distribution - Click the Distribution button and select the user or group you want to use for your 
ECN distribution.
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Update After - If the Update After check box is not already selected (you can specify a default 
Update After preference), select the point from the four ECN stages at which revision update 
should occur.

Note: If you have assigned any groups as Default groups, those groups automatically appear in 
the Teams/Completion section.

9 Enter the appropriate tasks for this ECN. See the “Entering ECN Tasks” section later in this 
chapter.

10 Enter any additional information about this ECN on the appropriate tab. 

11 When you have finished setting up your ECN, click the Save icon on the toolbar.

If you have not entered an ID for this ECN, the next available ID is automatically assigned.

Entering Information on ECN Tabs
The tabbed section contains several tabs where you can enter additional information regarding this 
ECN.

The following tabs appear:

Subject - The Subject tab contains any comments you have entered regarding the reason for this 
ECN. Many companies refer to this area as the ECN Request or ECN Problem Statement—use this 
are to describe the topic or reason for this ECN.

For ease of reading, you may want to have your users limit their input to brief descriptions of the ECN 
and enter more elaborate descriptions in the Notes tab.

Notes - The Notes tab contains any general comments you have entered. You can use the 
information in this tab for sorting, filtering and reporting ECNs. Because not all ECNs have the same 
impact on your company, you may want to establish procedures and practices within your 
organization for determining the order on which you will work your ECNs. The information in the 
General tab may be helpful to you in determining the relative importance of one ECN to other ECNs.

General - The General tab contains information you have entered about the origin, type, priority, and 
completion date of the current ECN.

History - The History tab contains a chronological list of all of the changes anyone has made to the 
current ECN.

Cost Analysis - The Cost Analysis tab contains information boxes related to the costs for the current 
ECN.

These costs may be estimated costs, actual costs, or both. You may want to use this tab to enter the 
cost estimates so that the individuals responsible for authorizing the ECN can base their decision on 
these expected costs. You may also want to use this tab to enter in the actual costs of the ECN 
implementation after the ECN is complete as a way of providing an audit to the ECN.
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Entering Information on the Subject and Notes Tabs
To enter comments and notes on the Subject and Notes tab:

1 Click the appropriate Subject or Note icon on the toolbar.

The Subject icon is blue and the Notes icon is green.

The Comment dialog box appears with the current users name in the Users Name box and the 
current date.

2 Enter the Subject or Note comment you want.

Subject notes only appear in the Subject tab and Note comments only appears in the Notes tab.

3 If you have selected the Passwords required for secure fields option in the Accounting Entity 
Maintenance window, you are prompted for a password with a dialog box. Enter your User 
Password before you save and exit the dialog.

4 Click the Save button.

Your comments are automatically saved with the user’s name and current date and the comment 
dialog box closes.

The user/date/time stamp appears with the comment you entered in the text box on the Subject or 
Note tab. Because this data provides a history to the ECN comments, you cannot edit anything 
that appears in the Comment or Notes tabs.

5 You may add additional comments at any time. Each additional comment you add to the text box, 
appears above any previous comments you have entered.

Entering Information on the General Tab
To enter information on the General tab:

1 Click the General tab.

2 Click the Origin button and select the originator for this ECN.

The User option is automatically selected for the origin. If the ECN originates from within your 
company and you want to enter an originator, click the Origin button and select a user from the 
list that appears.

Note: If you have many users, you can use a search feature to narrow the number of users that 
appear in the list. For example, if you want only user names beginning with W to appear in the list, 
click the Search button and enter W%. Click the Search button again and only user names 
beginning with W appear.

By selecting the Customer or Vendor option buttons, the list that appears when you click the 
Origin button is limited to either your Customers or your Vendors.

3 If you want to assign a type for this ECN, click the Type button and select the type of ECN you are 
entering.

4 If you want to assign the reason that caused you to enter this ECN, click the Reason button and 
select the reason for this ECN.
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5 A priority of 50 is automatically assigned for all new ECNs. If you want to change the priority of 
this ECN, click in the Priority box and enter the priority you want. You can specify a priority from 1 
to 100.

This priority value is reported in ECN Task Maintenance. You may want to use this priority value to 
assist you in determining which ECNs require your attention first. You may also want to use the 
ECN Priority in conjunction with the ECN Type and ECN Reason in determining which ECNs on 
which you will first work.

6 If you want to lock all of the lines specified in this ECN, select the Locked check box.

If you select the Locked check box, transactions related to the Line IDs are prevented from 
occurring. For example, if you have locked an ECN at the header level, you will not be able to 
issue material, receive parts, ship parts, or order parts for any of the line items on the ECN.

7 Click the Save icon on the toolbar.

The information is saved to your database.

Entering Information on the Cost Analysis Tab
The Cost Analysis tab provide you an area where you can enter your costs, actuals, or estimates for 
the current ECN. Remember, your costs are for informational purposes only and have no bearing on 
any cost calculations.

To enter information on the Cost Analysis tab:

1 Click the Cost Analysis tab.

2 Click in the Total Rework Cost box and enter the dollar amount you want to use for the rework for 
this ECN.

3 Click in the Total Scrap Cost box and enter the dollar amount you want to use for the scrap for 
this ECN.

4 Click in the Total ECN Cost box and enter the dollar amount you want to use for the ECN cost 
estimate.

5 If you want to enter any comments regarding your cost estimates, click in the Comments section 
and enter your comments.

Note: You may want to enter comments as to the reasons for your estimates in the Comments 
section.

6 Click the Save icon on the toolbar.

Entering and Editing ECN Tasks
To enter or edit an ECN task.

1 With the appropriate ECN open, click the Insert Row button on the toolbar.
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The next available row in the table appears selected and the cursor appears in the Type column. 
The line is automatically numbered and the status is set as Open.

2 Click the arrow and select the type of ECN change to which this line refers. You can select 
Document, Eng Change, Eng Master, Part, or Work Order. If you are licensed to use projects, 
you can also select Product.

3 Double-click ID and select the item you are changing.

Only the appropriate IDs for the Type you select appear in the ID list. For example, if you select a 
type of Part, only a list of parts is displayed in the ID list. If you are licensed to use multiple sites, 
the browse table is constrained by the site ID in the ECN header.

If the Document ID you selected has a file location associated with it, that location is displayed in 
the File Location column.

If the record you are changing does not yet exist, you can create a placeholder

4 If you want to change the status of this task, click the arrow in the Status column and select the 
status you want to use.

5 Double-click Disposition and select the reason for this item. Dispositions Codes indicate what 
activity must occur for this item as part of the processing of the ECN.

6 If you want to include a specification for this task, click in the Line Item Specification column and 
enter the information you want.

If you enter a specification for an item, a check appears in the Specs check box.

7 If you want to lock this task, select the Locked check box.

8 If this task has any subordinate task, a check appears in the Subordinates check box.

9 When you have finished entering tasks for this ECN, click the Save icon on the toolbar.
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Completing ECN Tasks
After tasks have been generated for your ECNs, the users you have assigned as team members can 
complete the tasks in Task Maintenance. Task Maintenance also lists any purchase requisition or 
workflow-related tasks assigned to the user.

See "Tasks" on page 5–19 in the Concepts and Common Features guide.
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Applying Changes to Quality Management Records
If you are integrated to Infor Quality Management, update the corresponding quality management 
records to keep your quality database in sync with your VISUAL database.

Before you begin this procedure, you must enable IQM in Site Maintenance.

To update your quality management system:

1 In the ECN record, select a line item.

2 Click the Start button. Perform one of these actions:

• If you specified Query Use on the Site Maintenance General tab for this site, then a dialog box
is displayed. To open the related maintenance window in the quality management system,
click Yes. To open the maintenance window in VISUAL, click No.

• If you specified Always Use on the Site Maintenance General tab for this site, then the quality
management system is opened. 

The maintenance form that is opened depends upon the item specified on the ECN line. This 
table shows which quality management form is associated with each ECN item type.

3 When you are finished implementing the ECN in both the quality management system and in 
VISUAL, select the External Tasks Complete check box. This completes the ECN. After an ECN 
is complete, you cannot edit it.

ECN Type Quality Management Form

Document Document Maintenance

Part Product Maintenance

Engineering Master Process Maintenance

Work Order Process Maintenance

Project Not applicable. Projects are not maintained in the quality 
management system.

Change Notice Not applicable. Change notices are not maintenance in the 
quality management system.
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Applying Engineering Changes to Work Orders
After you specify an ECN for an engineering master, you can apply the changes to work orders 
associated with the engineering master.

The system applies the changes depending upon the Allow application of ECN to unreported reqs to 
in-process work orders setting in Site Maintenance. If you selected this check box, then the system 
applies ECNs to work orders that are already in process, provided that labor has not already been 
reported or material issued to the operations and requirements affected by the ECN. The system will 
also apply ECNs to work orders associated with the engineering master that are not already in 
process. The system will not apply ECNs to split work orders or work orders with active demand links.

If the ECN update has any impact on a requirement or operation that has actual labor or material 
issues, the system will not update the work order. For example, if an ECN changes a quantity per on 
a leg header card, the system will not update the work order if labor or materials have been applied 
under the leg.

If the check box is cleared in Site Maintenance, then the system applies ECNs to work orders that are 
not in process only.

To apply changes:

1 Select the ECN line that you would like to apply to work orders. The ECN line must apply to either 
a Work Order or Engineering Master.

2 Click the Apply Changes button on the tool bar, or select Edit, Apply Changes to Work Orders.

3 The Apply change detail to work orders dialog box lists the work orders associated with the 
engineering master or work order you selected. The system places a check box in the Skip 
column if an associated work order cannot be changed. You can choose to skip additional work 
orders by selecting the Skip check box. 

4 Click Apply. The system updates the work orders that are not designated as Skip. 
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Using the Leg/Master Updater
If you have created a leg in a master from another master, you can use the Leg Updater to update the 
leg if you change the original master. Similarly, you can apply changes you make to a leg to the 
original master.

Before you can use the master updater to update masters from legs, you must designate masters as 
eligible for updating. To designate an engineering master as eligible for updating from legs:

1 In the Manufacturing Window, open the engineering master.

2 Open the header card.

3 Click the Engineering tab.

4 Select the Allow Update from Leg check box.

5 Click Save.

If the engineering master has legs, then you need to designate each leg as eligible for updating. Open 
the leg header card, click the Engineering tab, and select the Allow Update from Master check box.

Before you can use the leg updater to update legs from masters, you must designate legs as eligible 
for updating. To designate a leg as eligible for updating from an engineering master:

1 In the Manufacturing Window, open the work order, quote master, or engineering master.

2 Open the header card of the leg.

3 Click the Engineering tab.

4 Select the Allow Update from Master check box.

5 Click Save.

Updating Engineering Masters from Legs
You can update an Engineering master from a leg on any type of master: work order, engineering 
master, or quote master. 

If you are licensed to use multiple sites, you can perform these updates within the same site only. You 
cannot apply a change made to a leg in one site to a master in a second site.

To update an engineering master from the leg of another master:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site where you are 
updating masters or legs. If you are licensed to use a single site, this field is unavailable.

2 Select Edit, Update Master from Leg.

3 If you selected an ECN line that references a master, the system inserts the Part ID, Type, Base 
ID, Lot ID, Split ID, and Sub ID you selected. Click the browse buttons to change the information.

4 If you have more than one engineering master for the part ID, click the Eng ID arrow to select the 
engineering ID to update. The system displays only the IDs of engineering masters that are 
eligible for updating.
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5 Click Save. 

6 The system asks if you want to print a pre-update engineering report. The pre-update engineering 
report displays the original information from the engineering master before any changes are 
applied. Click Yes to view the report or No to proceed with the update without viewing the report. 
If you click yes, specify the output options and click Ok.

7 After the system updates the master, it asks if you want to print an after-update engineering 
report. You can use the report to view the changes the update process made. Click Yes to view 
the report. Click No if you do not want to review the report.

8 The system asks if you want to update any legs that use the master that you updated. Click Yes 
to open the Update Legs from Master dialog box. Refer to the following procedure for more 
information. Click No if you do not want to update master that use the engineering master.

Updating Legs from Engineering Masters
You can update a leg on any type of master: work order, engineering master, or quote master. You 
cannot update a leg if any one of the following conditions is true:

• Quote masters linked to quotes that have been printed. 
• Any master with an active ECN, unless you are on the implementation team.
• Any master with a status of Closed or Canceled.
• Any work order with transactions against any part of the leg. 
• Any master where the Allow Update from Master check box is not selected on the Engineering

tab.

If you are licensed to use multiple sites, you can perform these updates within the same site only. You 
cannot apply a change made to a master in one site to a leg in a second site.

To update a leg from an engineering master:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you are 
updating masters. If you are licensed to use a single site, this field is unavailable.

2 Select Edit, Update Legs from Master.

3 If you selected an ECN line that references a master, the system inserts the Part ID and Source 
Eng ID. Click the Source Eng ID arrow to select another engineering master. You can select a 
different part by clicking the Part ID browse button and selecting a part, then selecting the Source 
Eng ID. 

4 Use the filters to limit the masters the system displays in the table. Choose from the following 
options:

Type – Select the type of master to view. Select from Work orders, Eng Masters, and Quote 
Masters. You can select more than one option.

Status – Select the status of the work order. Select from Firm, Released, Unreleased, Closed, or 
Canceled. You can select more than one option. While you can view Closed or Canceled masters 
in the table, you cannot update them. 
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Include updatable legs only – Select this check box to view only legs that are eligible to be 
updated. For more information, refer to “Designating Legs and Engineering Masters as Eligible for 
Updating” on page 3-97 in this guide. Clear the check box to view any master where the part ID is 
used for a leg.

Exclude legs already updated to part engineering ID – Select this check box to exclude any 
legs that have already been updated by the selected engineering master. Click the arrow to 
specify the master.

Exclude legs updated after – Select this check box to exclude any legs that have been updated 
after the date you specify. Click the calendar button to select the date to use.

The system inserts the masters that meet your filter criteria in the table. The table contains the 
following information:

Update Leg – Click the check box if you want the system to update the leg when you click the 
save button. Clear the check box if you do not want to update the leg. Click the Mark All button to 
select all masters eligible for updating. Click the Unmark All button to clear all Update Leg check 
boxes.

Work Order/Master Leg – The system inserts the ID of the master or leg where the part is used.

Message – The system inserts “Leg does not allow updates” if the leg is not eligible to be 
updated. The system displays this message if the Allow Update from Master check box has been 
cleared on a leg card, if the master is Closed or Canceled, or if the work order has any 
transactions against the leg to be updated. If the master has an active ECN, the system displays 
the “Leg does not allow updates” message if you are not on the implementation team. If you are 
on the implementation team, the system displays a caution message.

The system inserts “Update Allowed” if the leg can be updated.

Work Order Status – The system inserts the current status of the master.

Leg Status – The system inserts the current status of the leg.

Quantity Per – The system inserts the quantity of part required per end product produced as 
specified on the master or leg header card. You can change this value. Click in the Quantity Per 
field and specify a new value.

Scrap % – The system inserts the percentage of part lost as scrap during the production process 
as specified on the master or leg header card. You can change this value. Click in the Scrap % 
field and specify a new value.

Fixed Quantity – The system inserts the fixed quantity of the part consumed as specified on the 
master or leg header card. Fixed quantity is a one time quantity of the required material that is 
used regardless of the work order quantity. You can change this value. Click in the Fixed Quantity 
field and specify a new value.

Unit of Measure – The system inserts the unit of measure of the part.

Dimensions – The system inserts the dimensions as specified on the master or leg header card. 
You can change this value. Click in the Dimensions field and specify a new value.

Last Update From Ref – If the leg has been updated before, the system inserts reference 
information from the most recent previous update.

Last Update Part Eng ID – If the leg has been updated before, the system inserts the part 
engineering ID used in the most recent previous update.
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Last Update Date – If the leg has been updated before, the system inserts the most recent 
update date.

Last Update User ID – If the leg has been updated before, the system inserts the ID of the user 
who last updated the master.

5 Click Save. 

6 The system asks if you want to print a pre-update engineering report. The pre-update engineering 
report displays the original information from the masters before any changes are applied. Click 
Yes to view the report or No to proceed with the update without viewing the report. If you select 
yes, specify the output options and click Ok. Print a copy of the report so you can compare it to 
the after-update engineering report.

7 After the system updates the masters, it asks if you want to print an after-update engineering 
report. You can compare this report to the pre-update engineering report to view the changes the 
update process made. Click Yes to view the report. Click No if you do not want to review the 
report.

Printing a Where Used on Leg Report
You can view where an engineering master is used as a leg on another master by printing the Where 
Used on Leg Report. To print the report:

1 From the Update Legs From Master dialog box, click the Print button.

2 The system inserts the part ID and the filters you selected in the Update Legs from Master dialog 
box in the Where Used on Leg Report dialog box. You can change any of the filters in the Type 
and Status sections. You can also change your selections in the Include updatable legs only, 
Exclude legs already updated to part eng ID, and Exclude legs updated after check box.

3 In the Order By section, select the sort order for the report. You can sort the report By Type, By 
Status, or By Workorder/Master.

4 Select the output for the report.

5 Click Ok. 

The report displays the Part ID you selected for the report along with the part’s description and 
stock unit of measure. It lists the master Type, Work Order/Master Leg ID, the Allow Updates flag, 
Leg Status, Last Update Date, Last Update By, and Last Update from Reference for each master 
where the part is used.

Viewing Update Information
You can view information about when a leg was last updated from a master or when a master was 
last updated from a leg. To view information about when a leg was last updated from a master:

In the Update Legs from Master dialog box, select a Part ID and the appropriate filters. The system 
inserts the following information:
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Last Update From Ref – The system inserts the base ID of the engineering master that updated the 
leg.

Last Update Part Eng ID – The system inserts the engineering ID of the master that updated the leg.

Last Update Date – The system inserts the date that the leg was last updated.

Last Update User ID – The system inserts the ID of the user who performed the update.

You can also view this information on the Engineering tab of the Leg Header card.

To view information about engineering masters that have been updated by legs, select the 
engineering master’s header card and click the Engineering tab.

The system displays the following information:

Last Update From Ref – The system inserts the ID of the leg that updated the engineering master.

Last Updated – The system inserts the date that the master was updated.

Last Updated By – The system inserts the ID of the user who performed the update.
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Viewing ECN History
After you have entered a large number of ECNs into your database, you may find it helpful to use the 
ECN History window to search for a particular item’s ECN history.

1 Select Eng/Mfg, ECN History.

2 In the Line Type section, click the type of item whose ECNs you want to view. 

3 Click the ID button and select the item whose ECN history you want to view.

4 To filter the ECN History list by status, use the Status section. For example, if you only select 
Completed, only those ECNs that you have completed appear in the table.

5 To open an ECN record, select the row and then click the Run button. 

Printing ECN History
1 Select Eng/Mfg, ECN History.

2 Select File, Print.

3 In the Line Type section, click the type of ECN line item. When you select an item, the labels on 
the Start ID and End ID fields are updated. 

4 Specify this information:

Site ID(s) – If you are licensed to use multiple sites, select the sites whose ECNs you want to 
view in the report. If you are licensed to use a single site, this field is unavailable.

Start ID and End ID – To view ECNs for a range of IDs, include a range of ECNs in the report, 
specify a start ID and end ID. To view a single ECNs for a single ID, specify the ID in both the start 
ID and end ID field. To view all IDs, leave the Start ID and End ID fields blank. The browse table 
lists IDs associated with the sites that you selected. If you are browsing for Document IDs, the 
browse table also lists tenant-level documents that the selected sites are allowed to use. See 
“Setting Allowable Sites for Tenant Documents” on page 6-10 of the System-wide guide.

5 Specify filters for the report:

Status section – In the Status section, specify the statuses of the ECNs to include in the report.

Desired Finish Date section – To filter the ECNs by Desired Finish Date, specify information in 
the Start and End fields in the Desired Finish Date section. To view ECNs with a specific desired 
finish date, specify the date in both the Start and End desired finish date fields. To include ECNs 
with a desired finish date in a particular date range, specify the start and end date of the range. If 
you do not want to filter by Desired Finish Date, leave the fields blank. 

Completed On section – To filter the ECNs by Completed On Date, specify information in the 
Start and End fields in the Completed On section. To view ECNs that were completed on a 
specific date, specify the date in both the Start and End desired finish date fields. To include 
ECNs that were completed during a particular date range, specify the start and end date of the 
range. If you do not want to filter by Completed On Date, leave the fields blank. 
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Type – To view ECNs of a particular type, select the types in the Type field. You can select more 
than one type. 

Reason – To view ECNs with a particular Reason code, select the reasons in the Reason field. 
You can select more than one reason. 

6 In the Order By section, specify how to sort the ECNs in the report. To sort the information in the 
report in descending order, select the Descending check box. 

7 Select the output format for the report:

Print – Select this option to output the file to a printer. The file is sent to the selected default 
printer.

View – Select this option to view the output on your screen. 

File – Select this option to save the report to a text file. You can then edit the file using any text 
editor.

E-mail – Select this option to attach the report to an email. To attach the report as a PDF, select 
the PDF Format check box. To send the report as a Rich Text Format (.RTF) file, clear the PDF 
Format check box. 

8 Click Print.
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Adding ECN Details
If you are working on a master that is referenced by an engineering change notice, you must be a 
member of the Implementation team in order to change anything on the master. If you have selected 
Prompt for ECN Comments, on the Options menu, and an implementation team member changes 
any information on a master, a brief log of the change is entered and that team member is prompted 
to enter an ECN Detail.

Note: After a user has entered an ECN Detail, only a member of the appropriate implementation team 
can make changes to the Specification information.

To add ECN Details:

1 When you make changes to Engineering Masters, Quote Masters, or Work Orders and save 
those changes, the system opens the Change Comments dialog box.

2 Enter the comments you want for the change you have made.

3 Click the OK button.

The Change Comments dialog box closes and your comments are saved to your database.

Viewing ECN Details
From time to time you may find it useful to view a full list of all the changes that have been made to 
your masters.

To view ECN Details:

1 Open the engineering master, quote master or work order to which the ECN you are interested in 
refers.

2 Click the ECN Detail icon on the toolbar.

The ECN Detail dialog box appears populated with all of your ECN Changes.

3 If you want to make any changes to the Comments of an ECN Detail, click the appropriate line in 
the Comments column and make the changes you want.

4 Click the Save button on the toolbar.
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What is Common Sense Throughput?
Common Sense Throughput is a strategy for using information from VISUAL to increase your 
company’s profit.

Throughput is not theoretical. It is defined as revenue less materials and outside services.

The throughput value of something you make, if you have no order from a customer for it, is zero. In 
fact, it may be a liability; you have spent money to produce it and may not sell it.

The throughput value of something you have sold is defined as its price less the cost of materials and 
outside services that went into it. Profit is throughput less operating expense.

When throughput increases, and operating expenses are unchanged, all of the throughput increase 
becomes profit.

At a company for which:

• Annual sales are $1,000,000, material and outside service costs are $300,000 or 30% of sales,
and operating expenses are $600,000

• Throughput is $700,000
• Gross profit is $100,000 or 10% of sales

When you increase sales by 10% or $100,000 without increasing Operating Expense:

• Throughput increases by $70,000 (10%)
• Profit increases 70%, or $70,000

Increase throughput without increasing labor and overhead?

It is possible, by making better use of the capacity you already have. A study of American 
Manufacturers showed that most resources are never more than 50% utilized. This gross under-
utilization of resources is due to poor planning of resources and/or material.

A 10% increase in throughput would raise utilization from 50% to 55%.

Throughput Definitions
Operating Expense - All of the money that a company spends to be in business. This represents all 
costs that you cannot track to a specific piece with 100% certainty.

Throughput = Selling Price - Raw Materials - Purchased Parts - Services

Company Profit = Total Throughput - Operating Expense

What Limits Throughput?
Bottlenecks limit Throughput. Bottlenecks are anything that hinders or halts your company’s 
production. Common bottlenecks in manufacturing are shortages of:

• machines
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• personnel
• materials
• purchased parts

Using Common Sense Throughput
The Common Sense Throughput procedure is simple. Two staff members in your company should 
meet for 15 minutes each day with the CEO to discuss:

• Where was the bottleneck yesterday and how was this resource used?
• What was the production plan for this resource?
• What was its actual use?
• Why was it different?
• What resource is the bottleneck today?

• What is the production plan for this resource?
• Can the production plan be improved?
• Can the capacity be expanded?
• How much of the output at this resource is for customer orders, as opposed to non-customer

driven production?
• What resources are expected to be bottlenecks over the next three weeks?

• Is there more than one?
• Are the bottlenecks expected to wander?
• How do we achieve the greatest utilization?
• Are there any expected problems with the bottlenecks over the next three weeks?

• How can we increase sales of jobs and products that will generate more throughput?
• What past jobs have generated high throughput per bottleneck hour?
• What current jobs will generate high throughput per bottleneck hour?
• How do we sell more such jobs?

Starting the Throughput Window
To start the Throughput Window, select Scheduling, Throughput Window.

The Throughput Window contains the Site ID field, and eight buttons, one for each Throughput 
option. If you are licensed to use multiple sites, you must run each Throughput option by site. If you 
are licensed to use a single site, the Site ID field is unavailable, and you must run each Throughput 
option on an enterprise-wide basis.
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Setting Up Soft Allocations
Every time you run soft allocations, supply (work orders and inventory) is matched up with demand 
(customer orders) to determine throughput. Through the creation of soft allocations, material and 
service cost data can be retrieved to subtract from selling price data for each customer order line 
item.

Soft allocations, informal allocations matched to supply and demand, are calculated on a schedule-
by-schedule basis.

You can execute soft allocations manually at any time. From the Throughput Window select File, 
Create Soft Allocations.

If you are licensed to use multiple sites, this procedure sets up soft allocations for all of your sites.

To set up and schedule soft allocations:

1 From the Throughput Window, select File, Soft Allocation Setup.

2 Select the week days and specify the times when you want Soft Allocations executed. The 
Throughput Window needs to be running when the scheduled time occurs.

3 Select the Round Late Time If After check box and in the associated time field specify the cut-off 
time when the work order finish dates will be defined as being finished on the following day. For 
example, a work order is finished at 10:10:00 PM on Day 1, but the round late time if after is set to 
10:00:00 PM. That work order will display as finished on Day 2.

4 Select the Work Order Cost Method. You can choose either:

Part Selling Price - Select this option to use the selling price from Part Maintenance.

Projected/Unit Cost - Select this option to use the projected cost of the work order. If the 
projected cost is zero or the costing method is Standard, then the part's costs from Part 
Maintenance is used.

5 Specify the percentage of Opportunity Lost Yield in the Customer Service Management section. 
The yield percentage specified relates to the opportunity lost reported in the Customer Service 
Impact data.

6 If you want to allocate linked orders first, select the Allocate Linked Orders First check box.

If you want to allocate unavailable inventory, select the Allocate Unavailable Inventory check 
box.

If you want to allocate on-hold inventory, select the Allocate On-Hold Inventory check box.

7 Specify the periods for Monthly Buckets, Weekly Buckets, and Daily Buckets. The buckets 
define how many months, weeks, and days to display in the graph.

8 If you want to view the status meter while soft allocations are calculated, select the Show Status 
Meter While Calculating check box.

9 If you want to display four auditing table windows during soft allocation generation, select the 
Show Audit Windows During Allocation Generation check box. When selected the four audit 
windows list demand, inventory supply, work order and purchase supply, and soft allocations. You 
can select site and schedule information from the Site and Schedule drop-down buttons within the 
audit windows.
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10 Click Create.

11 Click Save to save any changes to the Soft Allocations Setup dialog.
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Using the Exceptions Report
Review the Throughput Allocation Exceptions Report for a listing of exceptions encountered during 
soft allocation creation. The report shows unallocated supply and demand.

To view the Throughput Allocation Exceptions Report:

1 From the Throughput Window, select File, Exceptions Report.

2 Select the schedules in the Schedules area.

3 Select the print destination for the report.

Select Print to output the report to a printer

Select View to output the report to your screen for viewing.

Select File to output the report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report via e-mail. Select the PDF Format check box to send the report 
as a PDF. Clear the check box to send the report as an RTF file. When you generate the report 
the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft Outlook user 
documentation.

4 Click Print.
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Using the Throughput Window Options
In the Throughput window, you have the option of viewing either actual and expected raw sales 
values or actual and expected throughput values. It is simple to change the appearance of the 
window to show sales values.

Use the standard Throughput configuration to gauge your enterprise’s profit; use the Sales 
configuration to gauge levels of incoming cash, both actual and expected.

To show sales values, select Options, Show Sales Values until a check mark is displayed next to 
the menu option. To show throughput values, select Options, Show Sales Values until the check 
mark is removed from the menu option. 

This table shows the options that are available depending on whether you view sales values or 
throughput values:

To use the Financial Calendar, select Use Financial Calendar from the Options menu.

A check mark is placed next to the option and the Financial Calendar is used to determine the time 
buckets used in the throughput calculations.

Sales Values Throughput Values
Actual Sales Actual Throughput
Expected Sales Expected Throughput
Actual Sales by Resource Actual Throughput by Resource
Expected Sales by Resource Expected Throughput by Resource
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Using Customer Service Impact Inquiry
The Customer Service Impact window is where all manufacturers should begin their Common Sense 
Throughput journey. Use the Customer Service Impact window to see how much money and time 
your current promise-and-expedite scheduling scheme is costing you as a result of schedule 
lateness.

After seeing the effects of late order fulfillment, you can use the other Throughput windows to improve 
your existing order fulfillment scheme, increase throughput, and even forecast productivity.

To use the Customer Service Impact Inquiry window:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use for 
customer service impact analysis. If you are licensed to use a single site, this field is unavailable.

2 Click Customer Service Impact.

3 In the Start Date field, specify a starting date for the inquiry. Unless you specify otherwise, the 
default is the current system date.

4 To add specific customers to the inquiry, select the Use Selected Customers check box.

If you are including only a subset of selected customers, click Edit List and select the customers 
that you want to include in the inquiry.

For each customer that you want to include, double-click the appropriate line or select the Include 
check box. When you are finished, click Ok.

5 From the Schedules section, select the schedules to include in the inquiry. The production 
schedule is selected by default. You can select more than one schedule. If you select multiple 
schedules, you can use delta graphs to compare differences between them. See "Viewing & 
Interpreting Customer Service Impact Delta Graph Information" on page 11–11 in this guide

6 In the Measurement section, select how to measure customer service impact:

Value - This is measured by the sales value of the shipment expected to be late as part of a daily, 
weekly, or monthly grouping that includes the customer’s requested ship date. The sales value is 
the allocated quantity multiplied by the unit price, less discounts and commissions.

Days - The expected completion date, throughput date, is subtracted from the customer’s 
requested ship date as part of a daily, weekly, or monthly grouping that includes the customer’s 
requested ship date.

Value-Days - This is measured as the product of days late and dollars late as part of a daily, 
weekly, or monthly grouping that includes the customer’s requested ship date.

Opp Lost - This is the amount of money you would make if you invested the lost money (dollars 
late) in a money market fund at a certain percentage rate.

7 Use the Unallocated Orders section to specify the unallocated orders to include in the graph. To 
include only allocated orders, clear all check boxes. To include unallocated orders, select one or 
more of these check boxes:

Include WOs - Select this check box to include all allocated customer orders and unallocated 
work orders.

Include COs - Select this check box to include all allocated customer order lines and unallocated 
customer orders lines. 
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WOs only - Select this check box to include only unallocated work orders. Allocated and 
unallocated customer order lines are not included.

COs only - Select this check box to include only unallocated customer order lines. Allocated 
customer order lines are not included.

8 To include early orders in the graph in addition to orders that are late or on time, select the 
Include Early Orders check box. To include only orders that are late or on time, clear the Include 
Early Orders check box. If you clear the Include Early Orders check box, orders with a days late 
value of 0 or greater are included.

9 In the Group By section, specify the date to use to group the orders. Click Throughput Date to 
use the date that the order is expected to be complete. Click Want Date to use the want date of 
the order. 

10 Select the graph option.

Monthly - The customer service impact is shown for this Schedule ID by month.

Weekly - The customer service impact is shown for this Schedule ID by week.

Daily - The customer service impact is shown for this Schedule ID by day.

11 Click the graph style drop-down button to select the graph style.

12 Click the Refresh toolbar button, or press the F5 key, to update the data display with your 
preferences.

13 To display the data as a graph, click the Graph toolbar button. To display the data as a table, click 
the Table toolbar button.

Viewing Customer Service Impact Graph Details
On the Customer Service Impact graph, you can either right-click or left-click a graph point to view 
details.

Note: Hold down the SHIFT key while clicking on a bar to view a detail dialog containing information 
for all graph points.

You can view this information:

Customer ID – The ID of the customer.

Customer Name – The name of the customer.

Customer Order – The ID of the customer order.

Unshipped Quantity – The number of items that have not been shipped.

Want Date – The date on which the customer wants to receive the order.

Supply ID – The ID of the order being fulfilled.

Allocated Quantity – The allocated quantity of the part ordered by the customer.

Finish Date – The date by which you have scheduled the order to be completed.

Throughput Date – The expected throughput date of the order.
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Part ID – If applicable, the ID of the part for which the customer placed the order.

Part Description – A description of the Part ID on the customer order.

Unit Price – The price per unit of the part in the customer order.

Value Late – The value of the work order or customer order that was not realized by the throughput 
date. 

Days Late – The number of days late this customer order currently is. The Want Date is subtracted 
from the Work Order Schedule Finish date to arrive at this value.

Value-Days Late – The number of days multiplied by the Dollars Late value of the customer order.

Opportunity Lost – The amount lost if you had delivered the shipment on time and then invested the 
billable amount in a x% yield money market account. The amount of money you would have earned if 
you had invested the amount in the Value Late column in a money market account. To calculate the 
value, it is presumed that you invested the money on the Want Date of the customer order. This value 
is influenced by the number of days late and the value you specify in the Yield % field in the Soft 
Allocations Setup dialog. The default is 5%.

Navigating in the Customer Service Impact Detail Dialog
While viewing Customer Service Impact detail information, you can launch the order in the Customer 
Order Entry window, the resulting work order in the Manufacturing window and the Scheduling 
window, the related purchase order in the Purchase Order Entry window, and the related part in the 
Material Planning Window.

Your methods for displaying these windows are:

• Double-click an ID.
• Right-click a line item and select a menu item.
• Select a line item, and then select a menu item from the Edit menu.

Note: A window selected via a menu item only displays when there is an associated record to display. 
For example, if the line item that you select has a customer order and no purchase order, then no 
Purchase Order Entry window displays when you select Purchase Order Entry from the menu.

This table lists the IDs from which you can launch associated windows within the Customer Service 
Impact Detail window.

ID Type Window Notes

Customer Order ID Customer Order Entry

Part ID Material Planning Window

Purchase Order ID Purchase Order Entry

Work Order ID
Manufacturing Window
Scheduling Window

The window displayed when you 
double-click this ID, depends on 
the which option is check marked 
in the Edit menu.
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Displaying Utilization, Contention, and Material Constraint 
Inquiry Windows
To display an inquiry window from the Customer Service Impact Detail Dialog:

1 Either right-click a line item and select a menu item, or select a line item, and then select a menu 
item from the Edit menu.

2 Select your inquiry: Utilization, Contention, or Material Constraint. Each Inquiry Detail window is 
discussed later in this chapter.

Note: When invoked from another application, the selected Inquiry window has an asterisk (*) in its 
title bar, signifying that you have called this window from another application and are using that 
application’s settings for a particular subset of orders.

Viewing & Interpreting Customer Service Impact Delta 
Graph Information
You can view the differences in the lateness of schedules by constructing a customer service impact 
delta graph. For example, you may want to compare a bottleneck-riddled schedule to a schedule with 
enhanced resource capacity that you’ve derived from the first with the intent of it being a “solution” to 
the original schedule. When you view the schedules, one against the other using a delta graph, the 
differences between the schedules are obvious.

The process of specifying customer service impact preferences is the same for this procedure. You 
must select at least two schedules—the first the base schedule, the other the “solution,” or the 
schedule from which you can evaluate the impact of any new scheduling parameters.

1 From the Customer Service Impact window, select the appropriate Schedule IDs.

2 Specify any other settings as necessary and click the Refresh toolbar button, or press the F5 key, 
to update the data display with your preferences.

Each Schedule ID is represented with a different color in the data displayed.

To view the selected schedules in a delta graph format, press the CTRL key and click a data point 
of the baseline schedule. Other schedules are compared against the schedule that you first 
selected.

Printing Customer Service Impact Reports
To print customer service impact reports:

1 From the Customer Service Impact dialog File menu, or the Customer Service Impact Details 
dialog File menu, select Print.

2 Select the print destination for the report.

Select Print to output the report to a printer
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Select File to output the report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report via e-mail. Select the PDF Format check box to send the report 
as a PDF. Clear the check box to send the report as an RTF file. When you generate the report 
the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft Outlook user 
documentation.

Select View to output the report to your screen for viewing.

3 Click Print.
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Using Contention Inquiry
Contention Inquiry identifies bottleneck resources and determines at which resource it is most difficult 
to schedule work.

To generate a contention inquiry:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use for the 
contention inquiry. If you are licensed to use a single site, this field is unavailable.

2 Click Contention in the Throughput Window.

3 Specify the starting and ending dates in the appropriate calendar boxes. The End Date field is 
only available if you select “All” resources.

4 Specify the resources to evaluate:

• To view all resources in the site, select “All” in the Resource field and “Full View” in the Shop
View.

• To view all resources in a shop view, select the view in the Shop View field and select “All” in
the Resource field.

• To view a single resource, select the resource in the Resource field. If you selected a shop
view, the list of resources is limited to the resources in the shop view. 

5 Specify how to measure contentions:

Occurrences - Select this to display contention by the number of times it occurs. If you select “All” 
resources, then you can specify the number of resources to display in the Show Top field. Valid 
numbers are between 2 and 3800. The Show Top field is not available when a specific resource is 
selected.

Severity - Select this to display contention by its severity. If you select “All” resources, then you 
can specify the number of resources to display in the Show Top field. Valid numbers are between 
2 and 3800. The Show Top field is not available when a specific resource is selected.

6 Select the appropriate option if the inquiry is for one resource:

Monthly - To view information by month, select this option.

Weekly - To view information by week, select this option. 

Daily - To view information by day, select this option.

7 Select a schedule in the Selected Schedules area. If you select “All” resources, then you can view 
contention against only one schedule. If you select one resource then you may select multiple 
schedules. When you select multiple schedules, you can use delta graphs to compare differences 
between them. See “Viewing & Interpreting Contention Delta Graph Information” on page  11-14.

8 Use the check boxes to specify how to evaluate load on the resources:

• To ignore that load exists during backward scheduling, select the Ignore Load Exists During
Backward Scheduling check box.

• To ignore that load exists for on time work orders, select the Ignore Load Exists for On Time
Work Orders check box.

• To use the first day of severity for the selected schedule, select the Use first incident only
check box. This reduces the number of days of severity.
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• To view planned orders in the contention inquiry, select the Include Planned Orders check
box.

9 Click the graph style drop-down button to select the graph style.

10 Click the Refresh toolbar button, or press the F5 key, to update the data display with your 
preferences.

11 To display the data as a graph, click the Graph toolbar button. To display the data as a table, click 
the Table toolbar button.

Viewing Contention Inquiry Details
On the Contention Inquiry graph, click an item on the graph (such as a bar on a bar graph).

The Contention Inquiry Detail window appears and displays this information:

Work Order/Operation - The work order and operation number using this resource.

Customer Order - The ID of the customer order.

Attempt Number - The attempt number which the work order was attempted to be scheduled into this 
resource.

Direction - The scheduling direction (forward or backward).

Result Detail - The detail of the inquiry audit.

Part ID - The ID of the part, if any, in the customer order.

Part Description - A description of the part, if any, in the customer order.

Severity - For successfully backward scheduled work order, “severity” refers to the delta between 
end date of first “load exists” occurrence for an operation and the scheduled finish date of that 
operation, measured in resource working hours.

Attempt Start - The attempt was in a backward direction and its start date is within the range.

Attempt End - The attempt was in a forward direction and its end date is with in the range.

Operation Start - The start date on the listed operation.

Operation End - The end date of the listed operation.

For a forward scheduled work order, “severity” refers to the delta between start date of first “load 
exists” occurrence for an operation and the scheduled start date of that operation, measured in 
resource working hours.

Viewing & Interpreting Contention Delta Graph Information
You can view the differences in the contention between schedules by constructing a contention delta 
graph. When you view the schedules, one against the other using a delta graph, the differences 
between the schedules are obvious.
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The process of specifying contention preferences is the same for this procedure. You must select at 
least two schedules—the first the base schedule, the other the “solution,” or the schedule from which 
you can evaluate the contention of any new scheduling parameters.

1 From the Contention window, select the appropriate Schedule IDs.

2 Specify any other settings as necessary and click the Refresh toolbar button, or press the F5 key, 
to update the data display with your preferences.

Each Schedule ID is represented with a different color in the data displayed.

To view the selected schedules in a delta graph format, press the CTRL key and click a data point 
of the baseline schedule. Other schedules are compared against the schedule that you first 
selected.

Printing Contention Inquiry Reports
To print contention reports:

1 From the Contention Inquiry dialog File menu, or the Contention Inquiry Details dialog File menu, 
select Print.

2 Select the print destination for the report.

Select Print to output the report to a printer

Select File to output the report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report via e-mail. Select the PDF Format check box to send the report 
as a PDF. Clear the check box to send the report as an RTF file. When you generate the report 
the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft Outlook user 
documentation. 

Select View to output the report to your screen for viewing.

3 Click Print.

4 Click Ok.
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Using Material Constraint Inquiry
Material Constraint Inquiry identifies bottleneck raw materials and bottleneck purchased parts. It 
determines which material causes the most changes to the schedule.

To generate a material constraint inquiry:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use for the 
material constraint inquiry. If you are licensed to use a single site, this field is unavailable.

2 Click Material Constraint in the Throughput Window.

3 Specify the starting and ending dates in the appropriate fields. The End Date field is only available 
if you select “All” resources.

4 Click the Part ID drop-down button and select a Part ID whose material constraint you want to 
view.

5 Specify how to measure constraints:

Occurrences - Select this to display material constraint by the number of times that if occurs. If 
you select “All” parts, then you can also specify how many of the parts to display in the Show Top 
field. Valid numbers are between 2 and 3800. The Show Top field is not available when one 
specific part is selected.

Severity - Select this to display material constraint by its severity. If you select “All” parts, then you 
can specify the number of parts to display in the Show Top field. Valid numbers are between 2 and 
3800. The Show Top field is not available when one specific part is selected.

6 Select the appropriate option if the inquiry is for one part:

Monthly - To view information by month, select this option.

Weekly - To view information by week, select this option. 

Daily - To view information by day, select this option.

7 Select a schedule in the Selected Schedules area. If you select "All" parts, then you can view 
material constraints against only one schedule. If you select one part you can select multiple 
schedules. When you have selected multiple schedules, you can use delta graphs to compare 
differences between them. See “Viewing & Interpreting Material Constraint Delta Graph 
Information” on page  11-17.

8 Use the check boxes to specify how to evaluate load:

• To ignore material constraint during backward scheduling, select the Ignore Material
Constraint During Backward Scheduling check box.

• To ignore material constraint for on time work orders, select the Ignore Material Constraint
for On Time Work Orders check box.

• To view planned orders in the material constraint inquiry, select the Include Planned Orders
check box.

9 Click the graph style drop-down button to select the graph style.

10 Click the Refresh toolbar button, or press the F5 key, to update the data display with your 
preferences.



Using Material Constraint Inquiry

Infor VISUAL Inventory User’s Guide | 11 – 17

11 To display the data as a graph, click the Graph toolbar button. To display the data as a table, click 
the Table toolbar button.

Viewing Material Constraint Inquiry Details
On the Material Constraint Inquiry data, click a data point. The Material Constraint Inquiry Detail 
dialog displays this information:

Work Order/Operation - Work order ID and operation number.

Customer Order - The ID of the customer order.

Attempt Number - The attempt number which the work order was attempted to be scheduled into this 
resource.

Direction - Scheduling direction (forward or backward).

Result Detail - The result of the scheduling attempt.

Resource ID - The ID of the operation.

Resource Description - The description of the operation.

Severity - For successfully backward scheduled work order, “severity” refers to the delta between 
end date of first “load exists” occurrence for an operation and the scheduled finish date of that 
operation, measured in resource working hours.

Attempt Start - The attempt was in a backward direction and its start date is within the range.

Attempt End - The attempt was in a forward direction and its end date is within the range.

Operation Start - The start date of the listed operation.

Operation End - The end date of the listed operation.

For a forward scheduled work order, “severity” refers to the delta between start date of first “load 
exists” occurrence for an operation and the scheduled start date of that operation, measured in 
resource working hours.

Viewing & Interpreting Material Constraint Delta Graph 
Information
You can view the differences in the material constraint between schedules by constructing a material 
constraint delta graph. When you view the schedules, one against the other using a delta graph, the 
differences between the schedules are obvious.

The process of specifying contention preferences is the same for this procedure. You must select at 
least two schedules—the first the base schedule, the other the “solution,” or the schedule from which 
you can evaluate the contention of any new scheduling parameters.

1 From the Contention window, select the appropriate Schedule IDs.
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2 Specify any other settings as necessary and click the Refresh toolbar button, or press the F5 key, 
to update the data display with your preferences.

Each Schedule ID is represented with a different color in the data displayed.

To view the selected schedules in a delta graph format, press the CTRL key and click a data point 
of the baseline schedule. Other schedules are compared against the schedule that you first 
selected.

Printing Material Constraint Reports
To print material constraint reports:

1 From the Material Constraint Inquiry dialog File menu, or the Material Constraint Inquiry Details 
dialog File menu, select Print.

2 Select the print destination for the report.

Select Print to output the report to a printer.

Select File to output the report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report via e-mail. Select the PDF Format check box to send the report 
as a PDF. Clear the check box to send the report as an RTF file. When you generate the report 
the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft Outlook user 
documentation.

Select View to output the report to your screen for viewing.

3 Click Print.

4 Click Ok.
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Using Utilization Inquiry
Use Utilization Inquiry to identify bottleneck resources and determine the resource that has the least 
capacity.

To make a utilization inquiry:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use for the 
utilization inquiry. If you are licensed to use a single site, this field is unavailable.

2 Click Utilization in the Throughput Window.

3 Specify a starting and ending date in the appropriate fields. The End Date field is only available if 
you select “All” resources.

4 Specify the resources to evaluate:

• To view all resources in the site, select “All” in the Resource field and “Full View” in the Shop
View.

• To view all resources in a shop view, select the view in the Shop View field and select “All” in
the Resource field.

• To view a single resource, select the resource in the Resource field. If you selected a shop
view, the list of resources is limited to the resources in the shop view.

5 If you selected all resources, specify the number of resources to include in the graph:

• To include the most utilized resources, select the Top option button. In the adjoining field,
specify a value. This number acts as the range for the inquiry. For example, if you specify 10,
the top 10 most utilized resources are searched for. You can click All to include all resources
in the inquiry.

• If you want to include the least utilized resources, select the Least option. In the adjoining
field, specify a value. This number acts as the range for the inquiry. For example, if you
specify 10, the top 10 least utilized resources are searched for. You can click All to include all
resources in the inquiry.

6 Use the check boxes to specify how to evaluate load:

• To include unused resources in your utilization inquiry, select the Include Unused Resources
check box.

• To view planned orders in the utilization inquiry, select the Include Planned Orders check
box.

7 Select the appropriate option if the inquiry is for one resource:

Monthly - To view information by month, select this option.

Weekly - To view information by week, select this option. 

Daily - To view information by day, select this option.

8 Select a schedule in the Selected Schedules area. If you select "All" resources, then you can view 
utilization against only one schedule. If you select one resource, then you can select multiple 
schedules.

9 Click the graph style drop-down button to select the graph style.
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10 Click the Refresh toolbar button, or press the F5 key, to update the data display with your 
preferences.

11 To display the data as a graph, click the Graph toolbar button. To display the data as a table, click 
the Table toolbar button.

Viewing Utilization Inquiry Detail Dialog
On the Utilization Inquiry data, click a data point.

The Utilization Inquiry Detail dialog displays this information:

Date/Week Day - The date and day of week for which the throughput information for this resource 
appears.

Load Hours - Sum of setup and run for all operations using the resource date.

Capacity - The number hours of the resource on this date.

Load Capacity Ratio - Load/Capacity expressed as a percentage.

Viewing & Interpreting Utilization Inquiry Delta Graph 
Information
You can view the differences in the lateness of schedules by constructing a utilization inquiry delta 
graph. For example, you may want to compare the use of resources when implementing one 
schedule versus another. When you view the schedules use of resources using a delta graph, the 
differences are obvious.

The process of specifying utilization preferences is the same for this procedure. You must select at 
least two schedules — the first the base schedule, the other the comparison schedule from which you 
can evaluate the impact of any new scheduling parameters.

1 From the Utilization Inquiry window, select the appropriate Schedule IDs.

2 Specify any other settings as necessary and click the Refresh toolbar button, or press the F5 key, 
to update the data display with your preferences.

Each Schedule ID is represented with a different color in the data displayed.

To view the selected schedules in a delta graph format, press the CTRL key and click a data point 
of the baseline schedule. Other schedules are compared against the schedule that you first 
selected.

Printing Utilization Inquiry Reports
To print utilization inquiry reports:
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1 From the Utilization Inquiry dialog File menu, or the Utilization Inquiry Details dialog File menu, 
select Print.

2 Select the print destination for the report.

Select Print to output the report to a printer.

Select File to output the report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report via e-mail. Select the PDF Format check box to send the report 
as a PDF. Clear the check box to send the report as an RTF file. When you generate the report 
the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft Outlook user 
documentation.

Select View to output the report to your screen for viewing.

3 Click Print.

4 Click Ok.
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Using Actual Throughput
Actual Throughput is a measurement of past performance. Actual invoiced amounts from shipments 
and actual material and outside service costs from work orders are used to compute it.

To make an actual throughput inquiry:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use for actual 
throughput analysis. If you are licensed to use a single site, this field is unavailable.

2 Click Actual Throughput in the Throughput Window.

3 Specify the ending date in the EndDate field.

4 Select a Graph Period option.

Monthly - To view information by month, select this option.

Weekly - To view information by week, select this option. 

Daily - To view information by day, select this option.

5 Click the graph style drop-down button to select the graph style.

6 Click the Refresh toolbar button, or press the F5 key, to update the data display with your 
preferences.

7 To display the data as a graph, click the Graph toolbar button. To display the data as a table, click 
the Table toolbar button.

Viewing Actual Throughput Details
On the Actual Throughput graph, click a data point.

The Graph Detail dialog displays this information:

Customer Order/Customer Name - The Customer Order ID and the customer’s name and ID.

Packlist ID - The shipping Packlist ID and line number.

Part ID/Part Description - The Part ID and description in the order.

Date Shipped - The date the order was shipped.

Shipped Qty - The amount shipped.

Sales Amount - Allocated quantity multiplied by the unit price, less discounts and commissions.

Material Cost - The cost from the work order or inventory multiplied by quantity allocated.

Service Cost - The cost from the work order or inventory multiplied by quantity allocated.

Throughput Amount - Sales amount less material cost and service cost.
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Printing Actual Throughput Reports
To print actual throughput reports:

1 From the Actual Throughput dialog File menu, or the Actual Throughput Inquiry Details dialog File 
menu, select Print.

2 Select the print destination for the report.

Select Print to output the report to a printer

Select File to output the report as a text file. You can then edit the report using a text editing 
application.

Select View to output the report to your screen for viewing.

Select E-mail to send the report via e-mail. Select the PDF Format check box to send the report 
as a PDF. Clear the check box to send the report as an RTF file. When you generate the report 
the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft Outlook user 
documentation.

3 Click Print.

4 Click Ok.
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Using Expected Throughput Inquiry 
Expected Throughput inquiry is a way of recognizing what throughput will be in the future. It is driven 
by Soft Allocations to customer orders and scheduled work order finish dates.

To make an expected throughput inquiry:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use for the 
expected throughput inquiry. If you are licensed to use a single site, this field is unavailable.

2 Click Expected Throughput in the Throughput Window.

3 Specify the base date in the Base Date field.

4 Select a Graph Period Option.

Monthly - To view information by month, select this option.

Weekly - To view information by week, select this option. 

Daily - To view information by day, select this option.

5 If you selected Weekly as a Graph Option, select the last day of the week from the Last Day of 
Week drop-down list.

6 Select a Schedule ID for the inquiry. You can select multiple schedules.

7 Click the graph style drop-down button to select the graph style.

8 Click the Refresh toolbar button, or press the F5 key, to update the data display with your 
preferences.

9 To display the data as a graph, click the Graph toolbar button. To display the data as a table, click 
the Table toolbar button.

Viewing Expected Throughput Inquiry Details
On the Expected Throughput graph, click a data point.

The Graph Detail dialog displays this information:

Customer Order - The Customer Order ID.

Customer Name - The name of the customer.

Part ID - The Part ID from the customer order line.

Part Description - A description of the part.

Line No - The line number from the customer order.

Want Date - The date the customer wants the order.

Quantity - The total quantity shipped on the customer order line.

Work Order Schd Fin Date - The work order scheduled finish date.

Work Order ID - The Work Order ID.
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Throughput Amount - The sales amount less material cost and service cost.

Sales Amount - The allocated quantity multiplied by the unit price, less discounts and commissions.

Material Cost - The cost from work order or inventory multiplied by quantity allocated.

Service Cost - The cost from the work order or inventory, multiplied by quantity allocated.

Viewing & Interpreting Expected Throughput Inquiry Delta 
Graph Information
You can graphically view the differences in expected throughput amounts between two or more 
schedules. The differences between the schedules are then obvious.

The process of specifying expected throughput information and setting preferences is the same for 
delta graphs. However, you must select at least two schedules - one to be the base, the other the 
variable against which you can check the impact of the new scheduling parameters.

From an Expected Throughput graph with multiple schedules loaded, hold down the CTRL key and 
left-mouse click the schedule you want to use as the base.

Printing Expected Throughput Inquiry Reports
To print expected throughput reports:

1 From the Expected Throughput dialog File menu, or the Expected Throughput Inquiry Details 
dialog File menu, select Print.

2 Select the print destination for the report.

Select Print to output the report to a printer.

Select File to output the report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report via e-mail. Select the PDF Format check box to send the report 
as a PDF. Clear the check box to send the report as an RTF file. When you generate the report 
the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft Outlook user 
documentation.

Select View to output the report to your screen for viewing.

3 Click Print.

4 Click Ok.
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Using Actual Throughput by Resource Inquiry
Use Actual Throughput by Resource Inquiry after you have recognized a bottleneck. Actual 
Throughput by Resource Inquiry recognizes the orders in the past that have generated maximum 
throughput for time spent at bottleneck resources.

To make an actual throughput by resource inquiry:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use for the 
actual throughput by resource inquiry. If you are licensed to use a single site, this field is 
unavailable.

2 Click Actual Throughput by Resource in the Throughput Window.

3 Click the Resource ID drop-down button and select resource whose actual throughput by 
resource you want to view.

4 Specify a starting and ending date in the appropriate fields.

The Actual Throughput by Resource Inquiry table displays this information:

Customer ID/Customer Name - The customer’s name and ID.

Work Order ID - The ID of the work order.

Customer Order ID - The Customer Order ID.

Packlist ID - The Packlist ID and line number from the shipper.

Ship Date - The shipped date from the shipper.

Part ID - The part ID on the customer order line.

Part Description - The part description for the part on the customer order line.

Shipped Qty - The total amount shipped from the customer order line.

Work Order Quantity - The work order quantity.

Sales Amount - The allocated quantity multiplied by the unit price, less discounts and 
commissions.

Material Cost - Material cost per unit.

Service Cost - Service cost per unit.

Throughput Amount - Sales amount less Material Cost and Service Cost.

Resource ID - The ID of the resource.

Hours at Resource - The total amount of time reported at the resource for the work order that 
was the source of the material and service cost data distributed to the shipment.

Throughput per Hour - Throughput amount multiplied by Hours at Resource.

Printing Actual Throughput by Resource Inquiry Reports
To print actual throughput by resource reports:
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1 Select File, Print in the Actual Throughput by Resource Inquiry window.

2 Select the print destination for the report.

Select Print to output the report to a printer.

Select File to output the report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report via e-mail. Select the PDF Format check box to send the report 
as a PDF. Clear the check box to send the report as an RTF file. When you generate the report 
the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft Outlook user 
documentation.

Select View to output the report to your screen for viewing.

3 Click Print.

4 Click Ok.
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Using Expected Throughput by Resource Inquiry
Use Expected Throughput by Resource Inquiry after you have identified the bottleneck resource. 
Expected Throughput by Resource Inquiry determines the orders in the future that should generate 
maximum throughput for time spent at a bottleneck resource.

To make an expected throughput by resource inquiry:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use for the 
expected throughput by resource inquiry. If you are licensed to use a single site, this field is 
unavailable.

2 Click Expected Throughput by Resource in the Throughput Window.

3 Click the Resource ID drop-down button and select resource whose expected throughput by 
resource you want to view.

The Expected Throughput by Resource Inquiry table displays this information:

Customer ID - The ID of the customer.

Order ID - The order ID.

Customer Name - The customer’s name.

Unshipped Qty - The quantity of the order that has not yet shipped.

Desired Ship Date - The date that you intend to ship the order.

Supply ID - The ID of the supply order that has been allocated to the demand through soft 
allocations.

Allocated Qty - The quantity of the supply order that is allocated to the demand order. 

Part ID - The Part ID from the customer order line.

Part Description - The part description from the customer order line.

Finish Date - The date by which you have scheduled the order to be completed.

Throughput Date - The expected throughput date of the order.

Value Late - The value of the customer order that was not realized by the throughput date. 

Material Cost - Material cost per unit.

Service Cost - Service Cost per unit.

Throughput Amount - Sales amount less Material Cost and Service Cost.

Hours at Resource - The total amount of time reported at the named resource for the work order 
that was the source of the material and service cost date distributed to the shipment.

Throughput Per Hour - Throughput amount divided by the Hours at Resource. 

Printing Expected Throughput by Resource Inquiry Reports
To print expected throughput by resource reports:
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1 Select File, Print in the Expected Throughput by Resource Inquiry window.

2 Select the print destination for the report.

Select Print to output the report to a printer.

Select File to output the report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report via e-mail. Select the PDF Format check box to send the report 
as a PDF. Clear the check box to send the report as an RTF file. When you generate the report 
the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft Outlook user 
documentation.

Select View to output the report to your screen for viewing.

3 Click Print.

4 Click Ok.
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What are Scheduling Reports?
Use Scheduling reports to keep track of your enterprise’s scheduling activities. From production 
reports to delay reports, scheduling reports, when used regularly as part of a concerted throughput 
scheduling effort, can help you get a better handle on just how well your company is performing in key 
production areas.

Scheduling Reports are available from the Scheduling menu. As a shortcut, use the personal menu 
toolbar to open scheduling report windows.

Sales reports consist of:

• Production Schedule Reports
• Utilization Percentages Reports
• Resource Delay Reports
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Printing Production Schedule Reports
The Production Schedule reports help the production manager and supervisor manage and analyze 
the shop. All six reports are available from the Print Production Schedule Reports window.

To access the Print Production Schedule Reports window:

Select Production Schedule Report from the Scheduling menu.

The window has seven buttons, one for each report available from the window.

Printing Shop Resource Dispatch Reports
The Shop Resource Dispatch Report prints firmed and released operations scheduled for each shop 
resource. The list for each resource is printed on a separate set of pages to allow independent 
distribution.

For each operation, the following information is displayed: Scheduled Start, Scheduled Finish, Base 
ID-Sub-ID/Lot ID (Operation Sequence Number), Part ID/Description, Setup Time, Run Time, End 
Quantity, Currently Completed Quantity, and a scheduling message.

If the schedule finish date for the operation’s work order is greater than its want date, the operation is 
marked early. If the scheduled finish date is after the want date, it is marked late. However, if the want 
date is previous to the current date, the operation is marked Late! (with exclamation point) to indicate 
that the want date has already passed, rather than it being scheduled as late. If the work order has 
not been scheduled into the production schedule, it marks the operation N/S (Not Scheduled).

If you are licensed to use multiple sites, you must the report on a site-by-site basis. You cannot 
include more than one site on the report.

1 From the Print Production Schedule Reports window, click the Shop Resource Dispatch Report 
button.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site for the report. If 
you are licensed to use a single site, this field is unavailable. 

3 Click the Schedule ID arrow and select the schedule to print.

4 Enter the range of shop resources to print. 

5 Click the Start ID button or Description button to select the resource with which you want to start 
the report. Click the End ID button or Description to select the resource with which you want to 
end the report. Leave both fields blank to print a report for all resources.

The Dispatch Report is always sequenced by Resource ID and Operation Start Date. You can 
choose the range of resources to print.

6 To print a report by shop view, click the Shop View button and select a shop view.

Shop views are logical groupings of operation resources. You may want to print a report of the 
shop view that contains, for example, all assembly operations - base, middle, and final. Rather 
than selecting a range of operations to ensure that you include all assembly operations, simply 
select the assembly view.
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Choosing a shop view before a Resource ID of range of IDs renders the above Resource browse 
buttons unavailable. When the report is printed, all resources within the shop view you selected 
are displayed in the report.

7 Select the appropriate resource types to include.

You can select any combination of type of resource to print: Work Center, Individual/Team, 
Contractor, and Group by selecting the check boxes for the appropriate types.

8 Select and set the appropriate work order schedule filter.

You can choose to print only operations for work orders whose Scheduled Finish Date is earlier or 
later than the Want Date by a specified number of days. This is especially useful for focusing on 
late orders.

To use these options, select either the check box and enter the number of days late and/or early. 
If you select both, all orders are considered earlier and later than the days you specify.

9 Select the status of the operations you want to print.

You can print the dispatch report for Firmed operations, Released operations, or both, by 
checking the appropriate boxes in the Status section.

10 Enter a horizon for the report.

The horizon zone for the dispatch and foreman’s report is defined as today’s date plus a specified 
number of days, or horizon days. For example, if today’s date is 4/17 and the horizon days is 
defined as 10 days, then the horizon date range is 4/17 through 4/27.

When the reports are generated using a horizon days value, it uses all operation start and finish 
dates scheduled for the selected resources to determine the inclusion in the report output based 
on how the dates compare to the horizon date range.

The following algorithm is used to determine which operations to include.

If the operation start date is between today’s date and the horizon date, then include the operation 
in the report.

If the start date is before today’s date and the finish date is equal to or after today’s date, then 
include the operation in the report.

If any time of the scheduled operation passes through the horizon date range, then include the 
operation in the report.

11 Select the Include Projected Throughput check box if you want projected throughput amounts 
taken into account when firmed and released operations are calculated for each shop operation.

A column is added to the end of the report in which the Throughput amounts appear for each work 
order. If the work order is late, the amount is negative.

For more information, refer to “Throughput Window” on page 11-1 in this guide.

12 Select the Print Barcodes check box and appropriate barcode type, if you want to include a 
barcode in the report for each Work Order Operation ID.

Code39 – This barcode type, also known as Code 3 of 9, contains variable length, discrete 
symbology. You must have a Code 39 barcode font installed to view the barcode. If you do not 
have the Code 39 font installed, then the alphanumeric ID is displayed instead with a prefix and 
suffix. This pattern is used: *%ID%*. 
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QR Code – This is a two-dimensional or matrix barcode. QR stands for quick response.

13 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file.

Select E-mail to send the report in a Rich Text Format (.RTF) through electronic mail. When you 
generate the report the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft 
Outlook user documentation.

14 Click Ok.

If you selected Print as the output, a standard Windows dialog box appears.

15 Make the appropriate selections then click Ok.

The report is printed.

Printing Work Order Schedule Status Reports
The Work Order Status report shows schedule status for a selected group of work orders. For each 
work order, the following information appears: Part/Description, Customer (if any), Want Date, 
Scheduled Finish Date (if scheduled), Quantity required, Status (R for Released, F for Firmed), and a 
scheduling message.

Early - If the schedule finish date for the work order is greater than its want date, the work order is 
marked as Early.

Late - If the scheduled finish date is after the want date, it is marked as Late.

Late! - If the want date is previous to the current date, the work order is marked as Late! (with 
exclamation point) to indicate that the want date has already passed, rather than it being scheduled to 
be late.

N/S - If the work order has not been scheduled into the production schedule, it is marked N/S (Not 
Scheduled).

If you are licensed to use multiple sites, you can include more than one site in the report.

1 From the Print Production Schedule Reports window, click the Work Order Schedule Status 
Report button.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 Enter the range of work orders to print.

4 Select the status of the work orders you want to print.

You can print report for Firmed work orders, Released work orders, or both, by checking the 
appropriate boxes in the Status section.

5 Select and set the appropriate work order schedule filter.
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You can choose to print only work orders with a Scheduled Finish Date earlier or later than the 
Want Date by a specified number of days. To use these options, check either box and enter the 
number of days late and/or early. If you select both, all work orders earlier and later than the days 
you specify are considered.

6 Select the sequence for the report.

You can sequence the report by Want Date, Scheduled Finish Date, or Days Late.

7 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

8 Click the Ok button.

If you selected Print as the output, a standard Windows dialog box appears.

9 Make the appropriate selections then click Ok.

The report is printed.

Printing Foreman’s Reports
The Foreman’s Report is a more detailed version of the Dispatch Report. For each operation, the 
following information appears:

• Schedule Start and Finish Dates
• Setup and Run Times
• Resource ID of the previous and next shop resource
• Quantity Available (from previous operation) and End Quantity required for this operation
• Completed Quantity for this operation, and Completed Percentage (Completed Quantity/End

Quantity)
• Early - If the schedule finish date for the work order is greater than its want date, the work order is

marked as Early.

Late - If the scheduled finish date is after the want date, it is marked as Late.

Late! - If the want date is previous to the current date, the work order is marked as Late! (with 
exclamation point) to indicate that the want date has already passed, rather than it being 
scheduled to be late.

N/S - If the work order has not been scheduled into the production schedule, it is marked as N/S 
(Not Scheduled).

If you are licensed to use multiple sites, you can include more than one site in the report.

1 From the Print Production Schedule Reports window, click the Foreman’s Dispatch Report 
button.
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2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 Enter the range of shop resources to print. Click the Start ID button or Description button to 
select the resource with which you want to start the report. Click the End ID button or Description 
to select the resource with which you want to end the report. Leave both fields blank to print a 
report for all resources.

The Dispatch Report is always sequenced by Resource ID and Operation Start Date. You can 
choose the range of resources to print.

4 If you would rather print a report by shop view, click the Shop View button and select a shop view. 
Shop views are logical groupings of operation resources. You may want to print a report of the 
shop view that contains, for example, all assembly operations - base, middle, and final. Rather 
than selecting a range of operations to ensure that you include all assembly operations, simply 
select the assembly view.

Choosing a shop view before a Resource ID of range of IDs renders the above Resource browse 
buttons unavailable. When the report is printed, all resources within the shop view you selected 
that have not been filtered out according to your filtering preferences appear.

5 Select the appropriate resource types.

You can select any combination of type of resource to print: Work Center, Individual/Team, and 
Contractor, by checking the boxes for the appropriate types.

6 Select the status of the operations you want to print.

You can print the dispatch report for Firmed operations, Released operations, or both, by 
checking the appropriate boxes in the Status section.

7 Enter a horizon for the report. The horizon zone for the dispatch and foreman’s report is defined 
as today’s date plus a specified number of days, or horizon days. For example, if today’s date is 
4/17 and the horizon days is defined as 10 days, then the horizon date range is 4/17 through 4/27.

When the reports are generated using a horizon days value, all operation start and finish dates 
scheduled for the selected resources are used to determine the inclusion in the report output 
based on how the dates compare to the horizon date range.

The following algorithm is used to determine which operations to include.

If the operation start date is between today’s date and the horizon date, then include the operation 
in the report.

If the start date is before today’s date and the finish date is equal to or after today’s date, then 
include the operation in the report.

If any time of the scheduled operation passes through the horizon date range, then include the 
operation in the report.

8 Select the Print Barcodes check box and select a barcode type, if you want to include a barcode 
in the report for each Work Order Operation ID. 

Code39 – This barcode type, also known as Code 3 of 9, contains variable length, discrete 
symbology. You must have a Code 39 barcode font installed to view the barcode. If you do not 
have the Code 39 font installed, then the alphanumeric ID is displayed instead with a prefix and 
suffix. This pattern is used: *%ID%*. 
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QR Code – This is a two-dimensional or matrix barcode. QR stands for quick response.

9 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

10 Click Ok.

If you selected Print as the output, a standard Windows dialog box appears.

11 Make the appropriate selections then click Ok.

The report is printed.

Printing the Shop Calendar
The Shop Calendar shows the hours of available capacity currently planned for a shop resource for 
each day of the specified year. This capacity is determined by examining the weekly schedule, 
resource capacity for each shift, and exception days.

Capacities are printed in a standard calendar format, one month to a page, for an entire year. The 
capacity is shown in the middle of the box for the calendar day.

If you are licensed to use multiple sites, you must print this report on a site-by-site basis. You cannot 
include more than one site in the report.

1 From the Print Production Schedule Reports window, click the Shop Capacity Calendar button.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use for the 
report. If you are licensed to use a single site, this field is unavailable.

3 From the list box, select the schedule you want to print.

You can print a calendar for any valid Schedule ID.

4 Select the appropriate Resource ID from the drop down menu.

This is the Resource ID for which you want to print the calendar.

5 Enter the year for which you want to print the calendar.

This field defaults to the current year.

6 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.
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Select E-mail to send the report in a Rich Text Format (.RTF) through electronic mail. When you 
generate the report the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft 
Outlook user documentation.

7 Click the Ok button.

If you selected Print as the output, a standard Windows dialog box appears.

8 Make the appropriate selections then click Ok.

The report is printed.

Printing Resource/Employee Efficiency/Utilization Reports
The Resource/Employee Efficiency/Utilization report examines estimated vs. actual hours of effort 
and available capacity to calculate efficiencies and utilizations for employees and resources. See the 
Sequencing section for details.

If you are licensed to use multiple sites, you can include more than one site in the report.

1 From the Print Production Schedule Reports window, click the Resource/Employee Efficiency/
Utilization button.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 Enter the range of shop resources to print.

4 Enter the starting and ending dates.

5 Select the appropriate resource types.

You can select one or both types of resource to print: Work Center or Individual/Team.

6 Click the Include Projected Throughput Amounts check box if you want your printed reports to 
include projected Throughput amounts. For more information, refer to “Throughput Window” on 
page 11-1 in this guide.

7 Select the appropriate detail/summary options.

Detail by Resource - For each selected resource, all labor tickets in the date range appear in 
date order. For each labor ticket, the following information appears:

• Work Order ID and Operation
• Part and Description
• Labor Ticket Date
• Employee ID
• Actual Hours Worked (from labor ticket)
• Estimated Hours (from work order operation)
• Efficiency % = 100 x Estimated Hours / Actual Hours
• Labor Ticket Type: S for Setup, R for Run (shown in Est Util column)
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Summary by Work Order - You can select a Resource ID range for this option. For each 
resource, all labor tickets for a work order are summarized into a single line. For each site, and 
work order, the following information appears:

• Work Order ID
• Part ID and Description
• Actual Hours (from all labor tickets)
• Estimated Hours (from operations)
• Efficiency % =100 x Estimated Hours / Actual Hours
• The following summary information is shown for each resource:
• Total Hours of Capacity for Resource in date range
• Total Actual Hours
• Total Estimated Hours
• Total Efficiency % = 100 x Total Estimated Hours / Total Actual Hours
• Actual Utilization % = 100 x Total of Actual Hours / Capacity
• Estimated Utilization % = 100 x Total of Estimated Hours / Capacity

Summary by Resource - Only the summary information for Detail by Resource appears. You can 
select a Resource ID range for this option.

In summary for each resource, the following information appears:

• Total hours of Capacity for the resource in the specified date range
• Total Actual Hours
• Total Estimated Hours
• Total Efficiency % = 100 x Total Estimated Hours / Total Actual Hours
• Actual Utilization % = 100 x Total of Actual Hours / Capacity
• Estimated Utilization % = 100 x Total of Estimated Hours / Capacity

Detail by Employee - You can select an Employee ID range for this option. For each selected 
employee, all labor tickets in the date range appear in date order. For labor ticket, the following 
information appears:

• Work Order ID and Operation
• Part and Description
• Labor Ticket Date
• Resource ID
• Actual Hours Worked (from labor ticket)
• Estimated Hours (from work order operation)
• Efficiency % = 100 x Estimated Hours / Actual Hours
• Labor Ticket Type: S for Setup, R for Run (shown in Est Util column)

Summary by Employee - Only the summary information for Detail by Employee appears. You 
can select an Employee ID range for this option.

• The following information appears:
• Total Actual Hours
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• Total Estimated Hours
• Total Efficiency % = 100 x Total Estimated Hours / Total Actual Hours

8 Select the Include Projected Throughput check box if you want projected throughput amounts 
taken into account when firmed and released operations are calculated for each shop operation. 
A column is added to the end of the report in which the Throughput amounts appear for each work 
order. If the work order is late, the amount is negative.

9 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report in a Rich Text Format (.RTF) through electronic mail. When you 
generate the report the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft 
Outlook user documentation.

10 Click the Ok button.

If you selected Print as the output, a standard Windows dialog box appears.

11 Make the appropriate selections then click Ok.

The report is printed.

Printing Shipping Performance Reports
The shipping performance report displays historical statistics on the meeting of desired ship dates 
and quantities when making actual shipments. Multiple sequences are available. Customer orders 
are listed, and the packlists for each order are listed. For each packlist line, the following appears:

• Desired Ship Date
• Actual Ship Date
• Days Late (Early) (Actual Ship Date - Desired Ship Date)
• Shipped Quantity
• Line Quantity

For each Order and for each sort sequence, the following statistics appear:

• Average Days Late or Early
• Total Quantity Shipped
• Total Percent Shipped So Far

If you are licensed to use multiple sites, you can include more than one site in the report.

To print the Shipping Performance report:

1 From the Print Production Schedule Reports window, click the Shipping Performance Report 
button.
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2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable. 

3 Enter the range of shipping dates for packlists to include in the report.

4 Select the sequence for the report.

You can sequence the report by Ship Date, Order ID, Customer ID, Customer Name, Part ID, 
Work Order ID, or Product Code.

5 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report in a Rich Text Format (.RTF) through electronic mail. When you 
generate the report the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft 
Outlook user documentation.

6 Click the Ok button.

If you selected Print as the output, a standard Windows dialog box appears.

7 Make the appropriate selections then click Ok.

The report is printed.

Printing Shop Floor Status Reports
The Shop Floor Status report displays the work order status associated with resource details in the 
shop floor. It displays the information of Work Order, Part, estimated in quantity, estimated out 
quantity, actual quantity in, actual quantity out, scrap quantity, yield percentage, and available 
quantity.

If you are licensed to use multiple sites, you can include more than one site in the report.

To print the Shipping Performance report:

1 From the Print Production Schedule Reports window, click the Shop Floor Status Report button.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 Enter the range of work orders to include in the report.

4 Select the sequence for the report.

You can sequence the report by Work Order ID or Part ID.

5 Select the status of the work orders you want to print.

You can select Unreleased, Firmed, Released, or Closed.
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6 Select the Print Barcodes check box and select a barcode type, if you want to include a barcode 
in the report for each Work Order ID, Sub ID, and Operation Sequence #.

Code39 – This barcode type, also known as Code 3 of 9, contains variable length, discrete 
symbology. You must have a Code 39 barcode font installed to view the barcode. If you do not 
have the Code 39 font installed, then the alphanumeric ID is displayed instead with a prefix and 
suffix. This pattern is used: *%ID%*. 

QR Code – This is a two-dimensional or matrix barcode. QR stands for quick response.

7 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report in a Rich Text Format (.RTF) through electronic mail. When you 
generate the report the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft 
Outlook user documentation.

8 Click the Ok button.

If you selected Print as the output, a standard Windows dialog box appears.

9 Make the appropriate selections then click Ok.

The report is printed.
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Printing Utilization Reports
Utilization reports show a percentage value for scheduled load versus actual capacity for shop 
resources over a fourteen day period. 

If you are licensed to use multiple sites, you must print this report on a site-by-site basis. You cannot 
include more than one site in the report.

To print this report:

1 Select Utilization Percentages from the Scheduling menu.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use for the 
report. If you are licensed to use a single site, this field is unavailable.

3 In the Starting Date field, enter the starting date for the report.

4 Select the appropriate output type from the output combo box.

Select Print to print the report to your printer.

Select View to view the report on your monitor.

Select File to print the report to a file.

5 From the Schedule combo box, select the schedule you want to print.

6 In the Resource Selection group box, enter the starting and ending IDs for the report; in the Shop 
View field, enter the appropriate shop view for the report.

7 If you do NOT want to include shop resources that are contractors, click the Exclude Contractor 
Shop Resources check box.

8 In the Show As group box, select the appropriate radio button for displaying report information.

Percentage of Utilization - Select this radio button to view the percentage of capacity being used 
for each resource in the report.

Percentage of Unscheduled Time - Select this radio button to view the percentage of idle time 
for each resource in the report. This is the inverse of the Percentage of Utilization selection.

9 In the Sort Order group box, select the appropriate radio button for displaying report information.

Most to Least Utilized - Select this radio button to view report results starting with the resource 
with the highest percentage of utilization (or lowest percentage of unscheduled time) to the 
resource with the lowest percentage of utilization (or highest percentage of unscheduled time).

Least to Most Utilized - Select this radio button to view report results starting with the resource 
with the lowest percentage of utilization (or highest percentage of unscheduled time) to the 
resource with the highest percentage of utilization (or lowest percentage of unscheduled time).

10 Select Print/View from the File menu.

The report is printed or the results are displayed on your monitor.
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Printing Delay Reports
Delay reports shows the total amount of delay in days from scheduled operations for shop resources 
over a variable period.

If you are licensed to use multiple sites, you can generate this report on a site-by-site basis only. You 
cannot include more than one site in the report.

1 Select Resource Delay from the Scheduling menu.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site to include in the 
report. If you are licensed to use a single site, this field is unavailable.

3 In the Starting Date field, enter the starting date for the report.

4 Select the appropriate output type from the output combo box.

Select Print to print the report to your printer.

Select View to view the report on your monitor.

Select File to print the report to a file.

Select E-Mail to send the report through electronic mail. 

5 From the Schedule combo box, select the schedule you want to print.

6 In the Delay By group box, select the appropriate check boxes:

Resource - Select this check box if the delay is being caused by a resource.

Material - Select this check box if the delay is being caused by a material.

You can select both of these check boxes, but you must select at least one.

7 In the Sort Order group box, select the appropriate radio button for displaying report information.

Most to Least Delayed- Select this radio button to view report results starting with the most 
delayed resource to the least delayed resource.

Least to Most Delayed- Select this radio button to view report results starting with the least 
delayed resource to the most delayed resource.

8 In the Print Options group box, select either Summary or Detail as the report type. If you select 
Detail, enter the horizon in days in the Horizon field.

9 In the Resource Selection group box, enter the starting and ending resource IDs for the report; in 
the Shop View field, enter the appropriate shop view for the report.

10 Select Print/View from the File menu.

The report is printed or the results are displayed on your monitor.
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What are Engineering and Manufacturing Reports?
Use Engineering and Manufacturing reports to keep track of the production activities of your 
enterprise. From bill of material reports to gross profit reports, engineering and manufacturing reports, 
when used regularly and analyzed for trends and comparisons, can help you get a better handle on 
just how well your company is performing from a production standpoint.

Engineering and Manufacturing Reports are all available from the Eng/Mfg menu.

Engineering and Manufacturing reports consist of:

• Bill of Material Report
• Costed Bill of Material Report
• Engineering Report
• Gross Profit Reports
• Production Schedule Reports
• Work in Process Report
• Work Order/Master Cost Report
• Work Order Requirement Report
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Printing Bill of Material Reports
This report provides an indented bill of materials for a range of engineering masters or work orders. 

For each master or work order, the following data is reported for each material requirement:

• BOM Level (0 is top level of part, 1 is main leg requirement, 2 is leg or fabricated part required by
main leg, etc.)

• Part ID
• Quantity Required per Unit
• Fixed Quantity Required
• Scrap %
• Dimensions

If you are licensed to use multiple sites, you can include more than one site in the report.

To print a Bill of Material Report:

1 Select Bill of Material Report from the Eng/Mfg menu.

2 Select the Bill of Material type.

You can print this report for engineering masters, or for work orders.

3 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

4 Enter the range of Part/Base IDs to print. 

If you selected Engineering Master above, you can click the Starting and Ending buttons to view 
a list of parts from which you can choose to set the range of the report.

If you selected Work Order above, you can click the Starting and Ending buttons to view a list of 
work orders from which you can choose to set the range of the report.

5 Select the Explode Top Level Parts Only check box to print a BOM for top-level parts only. 

Select the Explode One Level Only check box to print a BOM for one level of parts only.

Otherwise, a BOM prints for all fabricated parts.

6 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report in a Rich Text Format (.RTF) through electronic mail. When you 
generate the report the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft 
Outlook user documentation.

7 Select Print/View from the File menu.

If you selected Print as the output, a standard Windows dialog box appears.

8 Make the appropriate selections and then click Ok.
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The report is printed.
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Printing Costed Bill of Material Reports
The Costed Bill of Material report is similar to the Bill of Material report, but only prints BOMs for 
engineering masters, and provides additional cost information. 

For each part, the following data is reported for each material requirement on its engineering master:

• Part ID and Description
• Quantity Required
• Unit Cost
• Total Cost = Unit Cost x Quantity Required
• BOM Level

Additionally, the lot size and total production hour for the part are shown, along with totals for Unit 
Cost and Total Cost.

If you are licensed to use multiple sites, you can include more than one site in the report.

To print a Costed Bill of Material Report:

1 Select Costed Bill of Material Report from the Eng/Mfg menu.

The Edit menu contains four other functions: Reset Material Costs, Reset Operation Costs, 
Reset Service Costs, and Implode Costs. Reset Material Costs and Implode Costs are identical 
to the functions in Part Maintenance. Reset Operation Costs is identical to the function in Shop 
Resource Maintenance. Reset Service Costs is the same as the Reset Operation Costs function 
in Service Maintenance.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the site(s) to include 
in the report. If you are licensed to use a single site, this field is unavailable.

3 Enter the range of Part/Base IDs to print. 

4 Click the Explode Top Level Parts Only check box to print a BOM for top-level parts only. 

Otherwise, a BOM prints for all fabricated parts.

5 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report in a Rich Text Format (.RTF) through electronic mail. When you 
generate the report the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft 
Outlook user documentation.Select Print/View from the File menu.

If you selected Print as the output, a standard Windows dialog box appears.

6 Make the appropriate selections then click Ok.

The report is printed.
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Resetting Material Requirement Costs
When you reset material requirement costs from the Costed Bill of Material Report window, costs in 
engineering masters, quote masters, and work orders are updated based on the costs that are 
specified in Part Maintenance. 

Note: Because resetting material requirement costs has the potential to affect many work orders, use 
caution in making the decision to reset material requirement costs.

If you are licensed to use multiple sites, material requirement costs can be reset on a site-by-site 
basis only. You must select one Site ID before resetting material requirement costs. The material 
requirement costs are reset for only for that site’s masters and work orders.

To reset material requirement costs:

1 Select Eng/Mfg, Costed Bill of Material Report.

2 In the Site ID field, select the site where you are updating costs. You must select only one site. If 
you are licensed to use a single site, this field is not available.

3 Select Edit, Reset Material Requirement Costs.

4 Complete one of these tasks: 

• To reset costs for all parts in the site that you selected in step 2, click All Parts.
• To select the parts whose costs you are resetting, click Selected Parts. Click the Insert Row

button, then click the Part ID browse button to select the parts. 

The Current Part Only option is not available.

5 Specify the types of masters to update. Select one or more of these options:

• Engineering Master Material requirements
• Work Order Material Requirements
• Quote Master Material Requirements

6 To reset material costs based on the status of each material requirement, select the According to 
Material Requirement Status check box and select the statuses to use:

• Unreleased
• Firmed
• Released
• Closed
• Cancelled
• All

This selection applies to work orders only.

7 To reset material costs based on Work Order or Master creation date, select the According to W/
O or Master Creation Date check box. Use the calendar buttons to select the After or Before 
dates to use.

8 Click OK. As your material costs are updated, the Reset Materials Cost dialog box shows the 
current part being updated. When processing is finished, a dialog box is displayed listing the 
number of material requirements updated.
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9 Click OK. 

Resetting Resource Operation Costs
When you reset resource operation costs from the Costed Bill of Material Report window, costs in 
engineering masters, quote masters, and work orders are updated based on the costs that are 
specified in Shop Resource Maintenance. 

Note: Because resetting operation costs has the potential to affect many work orders, use caution in 
making the decision to reset costs.

If you are licensed to use multiple sites, operation costs can be reset on a site-by-site basis only. You 
must select one Site ID before resetting operation costs. The operation costs are reset for only for 
that site’s masters and work orders.

To reset operation costs:

1 Select Eng/Mfg, Costed Bill of Material Report.

2 In the Site ID field, select the site where you are updating costs. You must select only one site. If 
you are licensed to use a single site, this field is not available.

3 Select Edit, Reset Operation Costs.

4 Complete one of these tasks: 

• To reset costs for all resources in the site that you selected in step 2, click All resources.
• To select the resources whose costs you are resetting, click Selected resources. Click the

Insert Row button, then click the Resource ID browse button to select the resources. 

The Current resource only option is not available.

5 Specify the types of masters to update. Select one or more of these options:

• Engineering Master operations
• Work Order operations
• Quote Master operations

6 To reset costs based on the status of each operation, select the According to Operation Status 
check box and select the statuses to use:

• Unreleased
• Firmed
• Released
• Closed
• Cancelled
• All

This selection applies to work orders only.

7 To reset costs based on Work Order or Master creation date, select the According to W/O or 
Master Creation Date check box. Use the calendar buttons to select the After or Before dates to 
use.
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8 To reset costs based on operation type, click the Type drop-down arrow and select an operation 
type. 

9 Click OK. As your operation costs are updated, the Reset Operation Cost dialog box shows the 
current resource being updated. When processing is finished, a dialog box is displayed listing the 
number of operations that were updated.

10 Click OK. 

Resetting Service Operation Costs
When you reset service operation costs from the Costed Bill of Material Report window, costs in 
engineering masters, quote masters, and work orders are updated based on the costs that are 
specified in Outside Service Maintenance. 

Note: Because resetting operation costs has the potential to affect many work orders, use caution in 
making the decision to reset costs.

If you are licensed to use multiple sites, operation costs can be reset on a site-by-site basis only. You 
must select one Site ID before resetting operation costs. The operation costs are reset for only for 
that site’s masters and work orders.

To reset operation costs:

1 Select Eng/Mfg, Costed Bill of Material Report.

2 In the Site ID field, select the site where you are updating costs. You must select only one site. If 
you are licensed to use a single site, this field is not available.

3 Select Edit, Reset Operation Costs.

4 Complete one of these tasks: 

• To reset costs for all resources in the site that you selected in step 2, click All services.
• To select the resources whose costs you are resetting, click Selected services. Click the

Insert Row button, then click the Service ID browse button to select the resources. 

The Current service only option is not available.

5 Specify the types of masters to update. Select one or more of these options:

• Engineering Master operations
• Work Order operations
• Quote Master operations

6 To reset costs based on the status of each operation, select the According to Operation Status 
check box and select the statuses to use:

• Unreleased
• Firmed
• Released
• Closed
• Cancelled
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• All

This selection applies to work orders only.

7 To reset costs based on Work Order or Master creation date, select the According to W/O or 
Master Creation Date check box. Use the calendar buttons to select the After or Before dates to 
use.

8 Click OK. As your operation costs are updated, the Reset Operation Cost dialog box shows the 
current resource being updated. When processing is finished, a dialog box is displayed listing the 
number of operations that were updated.

9 Click OK. 

Imploding Costs
You can use Implode Costs to automatically calculate the standard unit costs (those listed in the 
Costs section of Part Maintenance) for fabricated parts. This is done by referencing the engineering 
master for the part, and summing costs for all required materials, labor, and outside services.

The Costing Between Levels section of Accounting Entity Maintenance controls how costs are “rolled 
up” when there are multiple levels of fabricated parts. This is only relevant when an engineering 
master has another fabricated part as a material requirement. If you select Fold to Material Cost, the 
material, labor, burden, and service costs for the required part is added, and that value contributes 
only to the material cost for the parent part. If you select Keep Separate Costs, each of the four cost 
categories individually contribute to those categories for the parent part.

A top level part is a fabricated part that is not used as a required material of any other fabricated part. 
Often, these are the parts that are sold as products.

The Multi Level option controls how Implode Costs follow chains of fabricated parts. If selected, 
implode costs is performed recursively for each fabricated part required in the engineering master, 
until only purchased parts are found. During this process, the estimated unit costs in the material 
requirements for these fabricated parts are also updated. If not selected, then the costs associated 
with the material requirements are used directly, as is. The Permanently Save option controls if the 
recursive implosion is permanently saved in each part master.

If you are licensed to use multiple sites, Implode Costs can only be used at the site level.

Note: Carefully consider any changes to standard costs when using a standard cost system. Most 
standard cost accounting systems operate under a principle where standards for existing parts are 
set and frozen for a given period, often an entire fiscal year. Implode Costs has the capability of 
changing the standards for ALL parts in your database.

To automatically calculate standard costs:

1 Select Eng/Mfg, Costed Bill of Material Report.

2 In the Site ID field, select the site where you are updating costs. You must select only one site. If 
you are licensed to use a single site, this field is not available.

3 Select Edit, Implode Costs.

4 Select the parts to implode. You can select:
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Current Part only – This option is not available.

Selected Parts – When you click this option, the Selected Parts browse button becomes active. 
Click this button to select fabricated parts from a table. You can select a single part or multiple 
parts. If you are licensed to use multiple sites, only the parts found in the site you selected in the 
Part Maintenance window are displayed. 

All top-level parts – Click this option to implode costs for all top level parts. If you are licensed to 
use multiple sites, only the top-level parts in the site you selected in the Part Maintenance window 
are imploded.

5 To save the results of the implosion at each part level, select the Permanently Save All Levels 
check box.

6 To implode costs through multi-levels from the selected part down, select the Multi Level check 
box.

7 Click OK.

Note: If you do not select Permanently Save All Levels, the implosion results show only in the 
Costing section of the current screen. Permanently Save All Levels is selected and cannot be 
changed when you select All Top Level Parts.

The Implode Cost dialog box shows a progress meter.

If any parts were not correctly imploded, a dialog box displays a list of the parts that were not 
correctly imploded. 
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Printing Engineering Reports
The Engineering Report provides a complete printout of an engineering master, work order, or quote.

If you ar licensed to use multiple sites, you can include more than one site in the report.

1 Select Engineering Report from the Eng/Mfg menu.

The window shows all engineering masters, work orders, and quotes. This window is similar to 
the Search window in the Manufacturing Window. To perform a search, select Search from the 
File menu.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the site(s) to include 
in the report. If you are licensed to use a single site, this field is unavailable.

3 If you want to print the short form of the report, click the Short Form check box.

The long form shows essentially all information defined in the Manufacturing Window for the 
header, each operation, and each material requirement.

The short form shows Quantity, Setup Hours, and Run Time for each operation, Quantity for each 
material, Drawing IDs, and Revs.

4 If you want to exclude customer information from the list table, click the No Customer check box.

5 Select the sequence for the report.

You can sequence the table window list by Work Order ID, Customer ID, Create Date, Want Date, 
or Release Date. Additionally, you can check the Descending check box to reverse the order of 
the listing.

The masters and orders you select print in this sequence. 

6 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-Mail to send the report through electronic mail in a Rich text Format (.RTF).

7 If you want to run the report for a selected line or lines, make the selections, then select Print/
View Selections from the File menu or click the Print button.

To print all lines, choose Print/View All Lines from the File menu. This option is useful when you 
have used a search to limit the number of lines in the list.

A standard Windows dialog box appears.

8 Make the appropriate selections then click Ok.

The report is printed.
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Printing Gross Profit Reports
This report lists orders shipped in a specified financial period or date range, and shows the following 
information for each selected packlist shipped:

Sales Amount

Labor, Material, Burden, Service, and Total Costs

Gross Profit =Sales Amount – Total Cost

Gross Profit % =100 x Gross Profit / Sales Amount

Costs and profits are summarized by order and by sequence group (ex: Customer, Product Code, 
etc.)

If you are licensed to use multiple sites, you can include more than one site in the report.

To print the Gross Profit report:

1 Select Gross Profit Report from the Eng/Mfg menu.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 Enter the starting ship date in the Starting Ship Date field.

4 Enter the ending ship date in the Ending Ship Date field.

5 Click the Report Currency arrow and select the currency for the report. If you are printing a report 
for a single site, the entity currency associated with the site is inserted. If you are printing a report 
for multiple sites, the drop-down list shows the tracking currencies shared by the selected sites. If 
no shared tracking currencies are found, “Not Available” is inserted. You cannot generate the 
report if a shared currency is not found. Clear site selections until a shared currency is found.

6 Select the appropriate report sequence in the Selection Criteria area of the window.

The Starting/Ending field names change according to the sequence you select.

7 Enter the range to print.

8 Click the Summary check box to print summary reports.

Only the totals by order and sequence group print.

9 Select the appropriate Show options.

Open Orders / Closed Orders – You can choose to print only open orders (firm or released) or 
only closed orders by checking the appropriate box. If you select both, all open and closed orders 
print.

Estimates – Cost estimates for Material, Labor, Burden, and Service print along with the actuals 
discussed above.

10 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.
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Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report in a Rich Text Format (.RTF) through electronic mail. When you 
generate the report the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft 
Outlook user documentation.Select Print/View from the File menu.

If you selected Print as the output, a standard Windows dialog box appears.

11 Make the appropriate selections then click Ok.

The report is printed.
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Printing Production Schedule Reports
The Production Schedule reports help the production manager and supervisor manage and analyze 
the shop. All six reports are available from the Print Production Schedule Reports window.

To access the Print Production Schedule Reports window:

Select Production Schedule Report from the Eng/Mfg menu.

The window has seven buttons, one for each report available from the window.

Printing Dispatch Reports
The Dispatch Report prints firmed and released operations scheduled for each shop resource. The 
list for each resource is printed on a separate set of pages to allow independent distribution.

For each operation, the following information is displayed: Scheduled Start, Scheduled Finish, Base 
ID-Sub-ID/Lot ID (Operation Sequence Number), Part ID/Description, Setup Time, Run Time, End 
Quantity, Currently Completed Quantity, and a scheduling message.

If the schedule finish date for the operation’s work order is greater than its want date, the operation is 
marked as early. If the scheduled finish date is after the want date, it is marked as late. However, if 
the want date is previous to the current date, the operation is marked as Late! (with exclamation 
point) to indicate that the want date has already passed, rather than it being scheduled to be late. If 
the work order has not been scheduled into the production schedule, the operation is marked as N/S 
(Not Scheduled).

If you are licensed to use multiple sites, you must print the report on a site-by-site basis. You cannot 
include more than one site in the report.

1 From the Print Production Schedule Reports window, click the Shop Resource Dispatch Report 
button.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use in the 
report. If you are licensed to use a single site, this field is unavailable.

3 Click the Schedule ID arrow and select the schedule to use.

4 Enter the range of shop resources to print. Click the Start ID button or Description button to 
select the resource with which you want to start the report. Click the End ID button or Description 
to select the resource with which you want to end the report. Leave both fields blank to print a 
report for all resources.

The Dispatch Report is always sequenced by Resource ID and Operation Start Date. You can 
choose the range of resources to print.

5 If you would rather print a report by shop view, click the Shop View button and select a shop view. 
Shop views are logical groupings of operation resources. You may want to print a report of the 
shop view that contains, for example, all assembly operations—base, middle, and final. Rather 
than selecting a range of operations to ensure that you include all assembly operations, simply 
select the assembly view. 
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Choosing a shop view before a Resource ID of range of IDs renders the above Resource browse 
buttons unavailable. When the report is printed, all resources within the shop view you selected 
that have not been filtered out according to your filtering preferences appear.

6 Select the appropriate resource types to include.

You can select any combination of type of resource to print: Work Center, Individual/Team, 
Contractor, and Group by checking the boxes for the appropriate types.

7 Select and set the appropriate work order schedule filter.

You can choose to print only operations for work orders whose Scheduled Finish Date is earlier or 
later than the Want Date by a specified number of days. This is especially useful for focusing on 
late orders.

To use these options, select either check box and enter the number of days late and/or early. If 
you select both, all orders are considered earlier and later than the days you specify.

8 Select the status of the operations you want to print.

You can print the dispatch report for Firmed operations, Released operations, or both, by 
checking the appropriate boxes in the Status section.

9 Enter a horizon for the report. The horizon zone for the dispatch and foreman’s report is defined 
as today’s date plus a specified number of days, or horizon days. For example, if today’s date is 
4/17 and the horizon days is defined as 10 days, then the horizon date range is 4/17 through 4/27.

When the reports are generated using a horizon days value, it uses all operation start and finish 
dates scheduled for the selected resources to determine the inclusion in the report output based 
on how the dates compare to the horizon date range.

The following algorithm is used to determine which operations to include.

If the operation start date is between today’s date and the horizon date, then include the operation 
in the report.

If the start date is before today’s date and the finish date is equal to or after today’s date, then 
include the operation in the report.

If any time of the scheduled operation passes through the horizon date range, then include the 
operation in the report.

10 Select the Include Projected Throughput check box if you want projected throughput amounts 
taken into account when firmed and released operations are calculated for each shop operation. 

A column is added to the end of the report in which the Throughput amounts appear for each work 
order. If the work order is late, the amount is negative.

11 Select the Print Barcodes check box select a barcode type, if you want to include a barcode in 
the report for each Work Order Operation ID. 

Code39 – This barcode type, also known as Code 3 of 9, contains variable length, discrete 
symbology. You must have a Code 39 barcode font installed to view the barcode. If you do not 
have the Code 39 font installed, then the alphanumeric ID is displayed instead with a prefix and 
suffix. This pattern is used: *%ID%*. 

QR Code – This is a two-dimensional or matrix barcode. QR stands for quick response.

12 Select the output for the report.
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Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. 

Select E-mail to send the report in a Rich Text Format (.RTF) through electronic mail. When you 
generate the report the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft 
Outlook user documentation.Click Ok.

If you selected Print as the output, a standard Windows dialog box appears.

13 Make the appropriate selections then click Ok.

The report is printed.

Printing Work Order Schedule Status Reports
The Work Order Status report shows schedule status for a selected group of work orders. For each 
work order, the following information appears: Part/Description, Customer (if any), Want Date, 
Scheduled Finish Date (if scheduled), Quantity required, Status (R for Released, F for Firmed), and a 
scheduling message.

If the schedule finish date for the work order is greater than its want date, the work order is marked as 
Early. If the scheduled finish date is after the want date, it is marked as Late. However, if the want 
date is previous to the current date, the work order is marked as Late! (with exclamation point) to 
indicate that the want date has already passed, rather than it being scheduled to be late. If the work 
order has not been scheduled into the production schedule, it is marked as N/S (Not Scheduled).

If you are licensed to use multiple sites, you can include more than one site in the report.

1 From the Print Production Schedule Reports window, click the Work Order Schedule Status 
Report button.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 Enter the range of work orders to print.

4 Select the status of the work orders you want to print.

You can print report for Firmed work orders, Released work orders, or both, by checking the 
appropriate boxes in the Status section.

5 Select and set the appropriate work order schedule filter.

You can choose to print only work orders with a Scheduled Finish Date earlier or later than the 
Want Date by a specified number of days. To use these options, check either box and enter the 
number of days late and/or early. If you select both, all work orders earlier and later than the days 
you specify are considered.

6 Select the sequence for the report.

You can sequence the report by Want Date, Scheduled Finish Date, or Days Late.

7 Select the output for the report.
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Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-Mail to send the report through electronic mail in a Rich text Format (.RTF).

8 Click Ok.

If you selected Print as the output, a standard Windows dialog box appears.

9 Make the appropriate selections then click Ok.

The report is printed.

Printing Foreman’s Reports
The Foreman’s Report is a more detailed version of the Dispatch Report. For each operation, the 
following information appears:

• Schedule Start and Finish Dates
• Setup and Run Times
• Resource ID of the previous and next shop resource
• Quantity Available (from previous operation) and End Quantity required for this operation
• Completed Quantity for this operation, and Completed Percentage (Completed Quantity/End

Quantity)
• Early, Late, Late!, or N/S scheduling message, as described previously.

If you are licensed to use multiple sites, you can include more than one site in the report.

1 From the Print Production Schedule Reports window, click the Foreman’s Dispatch Report 
button.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 Enter the range of shop resources to print. Click the Start ID button or Description button to 
select the resource with which you want to start the report. Click the End ID button or Description 
to select the resource with which you want to end the report. Leave both fields blank to print a 
report for all resources.

The Dispatch Report is always sequenced by Resource ID and Operation Start Date. You can 
choose the range of resources to print.

4 If you would rather print a report by shop view, click the Shop View button and select a shop view. 
Shop views are logical groupings of operation resources. You may want to print a report of the 
shop view that contains, for example, all assembly operations - base, middle, and final. Rather 
than selecting a range of operations to ensure that you include all assembly operations, simply 
select the assembly view.
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Choosing a shop view before a Resource ID of range of IDs renders the above Resource browse 
buttons unavailable. When the report is printed, all resources within the shop view you selected 
that have not been filtered out according to your filtering preferences appear.

5 Select the appropriate resource types.

You can select any combination of type of resource to print: Work Center, Individual/Team, and 
Contractor, by checking the boxes for the appropriate types.

6 Select the status of the operations you want to print.

You can print the dispatch report for Firmed operations, Released operations, or both, by 
checking the appropriate boxes in the Status section.

7 Enter a horizon for the report. The horizon zone for the dispatch and foreman’s report is defined 
as today’s date plus a specified number of days, or horizon days. For example, if today’s date is 
4/17 and the horizon days is defined as 10 days, then the horizon date range is 4/17 through 4/27.

When the reports are generated using a horizon days value, all operation start and finish dates 
scheduled for the selected resources are used to determine the inclusion in the report output 
based on how the dates compare to the horizon date range.

The following algorithm is used to determine which operations to include.

If the operation start date is between today’s date and the horizon date, then include the operation 
in the report.

If the start date is before today’s date and the finish date is equal to or after today’s date, then 
include the operation in the report.

If any time of the scheduled operation passes through the horizon date range, then include the 
operation in the report.

8 Select the Print Barcodes check box and select a barcode type, if you want to include a barcode 
in the report for each Work Order Operation ID. 

Code39 – This barcode type, also known as Code 3 of 9, contains variable length, discrete 
symbology. You must have a Code 39 barcode font installed to view the barcode. If you do not 
have the Code 39 font installed, then the alphanumeric ID is displayed instead with a prefix and 
suffix. This pattern is used: *%ID%*. 

QR Code – This is a two-dimensional or matrix barcode. QR stands for quick response.

9 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-Mail to send the report through electronic mail in a Rich text Format (.RTF).

10 Click Ok.

If you selected Print as the output, a standard Windows dialog box appears.

11 Make the appropriate selections then click Ok.

The report is printed.
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Printing the Shop Calendar
The Shop Calendar shows the hours of available capacity currently planned for a shop resource for 
each day of the specified year. This capacity is determined by examining the weekly schedule, 
resource capacity for each shift, and exception days.

Capacities are printed in a standard calendar format, one month to a page, for an entire year. The 
capacity is shown in the middle of the box for the calendar day.

If you are licensed to use multiple sites, you can print the shop calendar on a site-by-site basis only. 
You cannot include multiple sites in the shop calendar.

1 From the Print Production Schedule Reports window, click the Shop Capacity Calendar button.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site to include in the 
report. If you are licensed to use a single site, this field is unavailable.

3 From the list box, select the schedule you want to print. 

You can print a calendar for any valid Schedule ID. 

4 Select the appropriate Resource ID from the drop down menu.

This is the Resource ID for which you want to print the calendar.

5 Enter the year for which you want to print the calendar. 

This field defaults to the current year.

6 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-Mail to send the report through electronic mail in a Rich text Format (.RTF).

7 Click the Ok button.

If you selected Print as the output, a standard Windows dialog box appears.

8 Make the appropriate selections then click Ok.

The report is printed.

Printing Resource/Employee Efficiency/Utilization Reports
The Efficiency/Utilization report examines estimated vs. actual hours of effort and available capacity 
to calculate efficiencies and utilizations for employees and resources. See the Sequencing section for 
details.

If you are licensed to use multiple sites, you can include more than one site in the report.

1 From the Print Production Schedule Reports window, click the Resource/Employee Efficiency/
Utilization button.



Printing Production Schedule Reports

13 – 20 | Infor VISUAL Inventory User’s Guide 

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 Enter the range of shop resources to print.

4 Enter the starting and ending dates.

5 Select the appropriate resource types.

You can select one or both types of resource to print: Work Center or Individual/Team.

6 Click the Include Projected Throughput Amounts check box if you want your printed reports to 
include projected Throughput amounts. For more information, refer to the “Throughput Window” 
chapter in this guide.

7 Select the appropriate detail/summary options.

• Detail by Resource – For each selected resource, all labor tickets in the date range appear in
date order. For each labor ticket, the following information appears:

• Work Order ID and Operation
• Part and Description
• Labor Ticket Date
• Employee ID
• Actual Hours Worked (from labor ticket)
• Estimated Hours (from work order operation)
• Efficiency % = 100 x Estimated Hours / Actual Hours
• Labor Ticket Type: S for Setup, R for Run (shown in Est Util column)

Summary by Work Order – You can select a Resource ID range for this option. For each 
resource, all labor tickets for a work order are summarized into a single line. For each work order, 
the following information appears:

• Work Order ID
• Part ID and Description
• Actual Hours (from all labor tickets)
• Estimated Hours (from operations)
• Efficiency % = 100 x Estimated Hours / Actual Hours
• The following summary information is shown for each resource:
• Total Hours of Capacity for Resource in date range
• Total Actual Hours
• Total Estimated Hours
• Total Efficiency % = 100 x Total Estimated Hours / Total Actual Hours
• Actual Utilization % = 100 x Total of Actual Hours / Capacity
• Estimated Utilization % = 100 x Total of Estimated Hours / Capacity

Summary by Resource – Only the summary information for Detail by Resource appears. You 
can select a Resource ID range for this option.

In summary for each resource, the following information appears:

• Total hours of Capacity for the resource in the specified date range
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• Total Actual Hours
• Total Estimated Hours
• Total Efficiency % = 100 x Total Estimated Hours / Total Actual Hours
• Actual Utilization % = 100 x Total of Actual Hours / Capacity
• Estimated Utilization % = 100 x Total of Estimated Hours / Capacity

Detail by Employee – You can select an Employee ID range for this option. For each selected 
employee, all labor tickets in the date range appear in date order. For labor ticket, the following 
information appears:

• Work Order ID and Operation
• Part and Description
• Labor Ticket Date
• Resource ID
• Actual Hours Worked (from labor ticket)
• Estimated Hours (from work order operation)
• Efficiency % = 100 x Estimated Hours / Actual Hours
• Labor Ticket Type: S for Setup, R for Run (shown in Est Util column)

Summary by Employee – Only the summary information for Detail by Employee appears. You 
can select an Employee ID range for this option.

The following information appears:

• Total Actual Hours
• Total Estimated Hours
• Total Efficiency % = 100 x Total Estimated Hours / Total Actual Hours

8 Select the Include Projected Throughput check box if you want projected throughput amounts 
taken into account when firmed and released operations are calculated for each shop operation. 
A column is added to the end of the report in which the Throughput amounts appear for each work 
order. If the work order is late, the amount is negative.

9 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report in a Rich Text Format (.RTF) through electronic mail. When you 
generate the report the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft 
Outlook user documentation.Click the Ok button.

If you selected Print as the output, a standard Windows dialog box appears.

10 Make the appropriate selections then click Ok.
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Printing Shipping Performance Reports
The shipping performance report displays historical statistics on the meeting of desired ship dates 
and quantities when making actual shipments. Multiple sequences are available. Customer orders 
are listed, and the packlists for each order are listed. For each packlist line, the following appears:

• Desired Ship Date
• Actual Ship Date
• Days Late (Early) (Actual Ship Date – Desired Ship Date)
• Shipped Quantity
• Line Quantity

For each Order and for each sort sequence, the following statistics appear:

• Average Days Late or Early
• Total Quantity Shipped
• Total Percent Shipped So Far

If you are licensed to use multiple sites, you can include more than one site in the report.

To print the Shipping Performance report:

1 From the Print Production Schedule Reports window, click the Shipping Performance Report 
button.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 Enter the range of shipping dates for packlists to include in the report.

4 Select the sequence for the report.

You can sequence the report by Ship Date, Order ID, Customer ID, Customer Name, Part ID, 
Work Order ID, or Product Code.

5 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report in a Rich Text Format (.RTF) through electronic mail. When you 
generate the report the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft 
Outlook user documentation. Click the Ok button.

If you selected Print as the output, a standard Windows dialog box appears.

6 Make the appropriate selections then click Ok.

The report is printed.
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Printing Shop Floor Status Reports
The Shop Floor Status report displays the work order status associated with resource details in the 
shop floor. It displays the information of Work Order, Part, estimated in quantity, estimated out 
quantity, actual quantity in, actual quantity out, scrap quantity, yield percentage, and available 
quantity.

If you are licensed to use multiple sites, you can include more than one site in the report.

To print the Shop Floor Status report:

1 From the Print Production Schedule Reports window, click the Shop Floor Status Report button.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 Enter the range of work orders to include in the report.

4 Select the sequence for the report.

You can sequence the report by Work Order ID or Part ID.

5 Select the status of the work orders you want to print.

You can select Unreleased, Firmed, Released, or Closed.

6 Select the Print Barcodes check box and select a barcode type, if you want to include a barcode 
in the report for each Work Order ID, Sub ID, and Operation Sequence #. 

Code39 – This barcode type, also known as Code 3 of 9, contains variable length, discrete 
symbology. You must have a Code 39 barcode font installed to view the barcode. If you do not 
have the Code 39 font installed, then the alphanumeric ID is displayed instead with a prefix and 
suffix. This pattern is used: *%ID%*. 

QR Code – This is a two-dimensional or matrix barcode. QR stands for quick response.

7 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report in a Rich Text Format (.RTF) through electronic mail. When you 
generate the report the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft 
Outlook user documentation.Click Ok.

If you selected Print as the output, a standard Windows dialog box appears.

8 Make the appropriate selections then click Ok.

The report is printed.
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Printing Current Value Reports
These reports print the current value of your work in process, and also analyze actual vs. estimated 
material and labor usage. All three reports are available from the Work In Process Reports window.

To access the Work In Process Reports window:

Select Work In Process Report from the Eng/Mfg menu.

Printing Work in Process Reports
The Work in Process report prints actual cost information for work in process based on currently 
accumulated costs for firm and released work orders, or for WIP that has been posted to the general 
ledger using the Costing Utilities.

If you are licensed to use multiple sites, you can include more than one site in the report.

1 From the Work In Process Reports window, click the Print current work in process value for 
open orders button.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 Enter the range of Base IDs to include in the report.

4 In the Report Currency field, click the arrow and specify the currency to use for the report. If you 
are printing a report for multiple sites, the drop-down list displays tracking currencies shared by 
the selected sites. If no shared currencies are found, you can print the report in native currency, or 
clear site selections until a common currency is identified.

5 Select the appropriate Selection radio button.

Use Work Order Status – This option prints all accumulated cost data (either standard or actual)/
Projected cost for all work in process (workorder status of Released or Firm).

For each firmed and released work order, the following data appears:

• Work Order ID
• Part ID and Description
• Quantity
• Release Date
• Want Date
• Material Cost
• Labor Cost
• Burden Cost
• Service Cost
• Total Value = Material + Labor + Burden + Service
• Grand totals are printed for all work in process.
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Use Posted Value – This option prints accumulated cost data (either standard or actual) for all 
work in process (workorder status of Released or Firm) that has been journalized using Costing 
Utilities.

For each firmed and released work order, the following data appears:

• Work Order ID
• Part ID and Description
• Work Order Status
• Want Date
• Value Accumulated in WIP
• Value Received into Finished Goods
• WIP Value (Into WIP - From WIP)
• Grand totals are printed for Into WIP, From WIP, and WIP Value.

6 Select the WIP Costing method.

This option is available when the Use Work Order Status option is active. You can select either 
Actual unit cost or Projected unit cost. 

7 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report in a Rich Text Format (.RTF) through electronic mail. When you 
generate the report the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft 
Outlook user documentation. Click the Ok button.

If you selected Print as the output, a standard Windows dialog box appears.

8 Make the appropriate selections then click Ok.

The report is printed.

Printing Comparative Material Reports
This report compares estimated quantity required and cost for work orders with the actual materials 
issued. For each work order, all material requirements are listed in Part ID order.

For each requirement, the following information appears:

Part ID

Sub ID, Operation Sequence Number, Piece Number

Standard Quantity Required

Actual Quantity Issued

Standard Cost = Standard Quantity Required x Standard Unit Cost
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Actual Cost = Actual Quantity Issued x Inventory Value

Variance = Standard Cost – Actual Cost

Costs are grouped and totaled by Part ID and Work Order ID. Totals are also shown for the entire 
report.

If you are licensed to use multiple sites, you can include more than one site in the report.

1 From the Work In Process Reports window, click the Print comparative material usage for work 
orders button.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 In the Report Currency field, click the arrow and specify the currency to use for the report. If you 
are printing a report for multiple sites, the drop-down list displays tracking currencies shared by 
the selected sites. If no shared currencies are found, you can print the report in native currency, or 
clear site selections until a common currency is identified.

4 Select an option in the Selection section.

You can print this report for all open work orders (status of Firm or Released), or all closed work 
orders.

5 Enter the range of Base IDs to include in the report.

For closed work orders, you can specify a close date range of work orders to print. This allows 
you to analyze the results of all work orders closed in a given time period, such as the preceding 
week or month.

6 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-Mail to send the report through electronic mail in a Rich text Format (.RTF).

7 Click the Ok button.

If you selected Print as the output, a standard Windows dialog box appears.

8 Make the appropriate selections then click Ok.

The report is printed.

Printing Comparative Labor Reports
This report compares estimated labor required for work orders with the actual labor reported. For 
each work order, all operations are listed by Sub ID and Sequence Number. 

For each operation, the following information appears:

Sub ID, Operation Sequence Number
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Description

End Quantity (Quantity Required from operation)

Actual Run Quantity (as reported from Labor Tickets)

Standard Cost

Actual Cost

Variance = Standard Cost – Actual Cost

Costs are grouped and totaled by Work Order ID, and displays totals for the entire report.

If you are licensed to use multiple sites, you can include more than one site in the report.

1 From the Work In Process Reports window, click the Print comparative labor reported for work 
orders button.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 In the Report Currency field, click the arrow and specify the currency to use for the report. If you 
are printing a report for multiple sites, the drop-down list displays tracking currencies shared by 
the selected sites. If no shared currencies are found, you can print the report in native currency, or 
clear site selections until a common currency is identified.

4 Select the appropriate Selection radio button.

You can print this report for all open work orders (status of Firm or Released), or all closed work 
orders.

5 Enter the range of Base IDs to include in the report.

For closed work orders, you can specify a close date range of work orders to print. This allows 
you to analyze the results of all work orders closed in a given time period, such as the preceding 
week or month.

6 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to send the report in a Rich Text Format (.RTF) through electronic mail. When you 
generate the report the system attaches the file to a Microsoft Outlook e-mail. See your Microsoft 
Outlook user documentation.Click the Ok button.

If you selected Print as the output, a standard Windows dialog box appears.

7 Make the appropriate selections then click Ok.

The report is printed.
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Printing Inventory Balances Reports
The Inventory Balances report prints actual inventory balances for a part or group of parts, by date, 
part location, or type.

If you are licensed to use multiple sites, you can include more than one site in the report.

1 From the Work In Process Reports window, click the Print inventory balances - by unit button.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable.

3 Choose a Starting and Ending Date for the report by either manually entering the appropriate start 
and end date or using the calendar button to choose a date range.

4 Click the Starting Part ID button to choose the first part in the report

Click the Ending Part ID button to choose the last part in the report.

Leave both fields blank to print a report for all parts in the database.

5 Select a Part type:

Fabricated – Select the Fabricated check box to include all Fabricated parts in the output

Purchased – Select the Purchased check box to include all Purchased parts in the output.

You must select one, but you can select both if necessary.

6 Select an inventory location:

Warehouse – Select the Warehouse option button if you want to view part balances by 
warehouse.

Shop Resource – Select the Shop Resource option button if you want to view current part 
balances by work order resource.

The Shop Resources button becomes available.

7 Click the Shop Resources button to select a shop resource for the report. You can select more 
than one selection. If you do choose more than one, <Multiple Selection> appears in the Shop 
Resources field.

8 Select the output for the report:

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-mail to output your report as an .rtf attachment in the body of an electronic message. 

9 Click the Ok button.

If you selected Print as the output, a standard Windows dialog box appears.

10 Make the appropriate selections then click the Ok button.

The report is printed.
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Printing Work Order/Master Cost Reports
The Work Order/Master Cost report shows estimated costs for engineering and quote masters, and 
estimated, and projected costs for work orders. Costs are totaled for all operations, all materials, and 
the whole work order or master.

If you are licensed to use multiple sites, you can include more than one site in the report.

To print the Work Order/Master Cost report:

1 Select Work Order/Master Cost Report from the Eng/Mfg menu.

2 Select the appropriate type for the report.

You can print estimated costs for Engineering Masters and Quote Masters. You can print 
estimated, actual, and projected costs with detailed breakdowns for Work Orders.

3 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable. 

4 Enter the range of Base IDs to print.

5 In the Report Currency field, click the arrow and specify the currency to use for the report. If you 
are printing a report for multiple sites, the drop-down list displays tracking currencies shared by 
the selected sites. If no shared currencies are found, you can print the report in native currency, or 
clear site selections until a common currency is identified.

6 Select the appropriate status check boxes.

If printing costs for work orders, you can select any combination of status values to print by 
checking the boxes in the Status section. If you leave the boxes unchecked, work orders of all 
status values are printed.

7 Select the appropriate Info sequence radio button:

Estimates Only – Material, Labor, Burden, Service, and Total estimated cost are shown for each 
operation and material requirement of the work orders or masters selected.

Actuals Only – Material, Labor, Burden, Service, and Total actual cost appear for each work 
order selected. Actuals are accumulated using standard or actual costing, depending upon the 
costing method you are using.

Projected Only – Material, Labor, Burden, Service, and Total projected cost appear for each work 
order selected. Projected cost is an estimate of total cost based on the actuals for the work 
completed and standard estimates for work remaining.

Comparative Totals – For each material requirement and operation, the following is shown:

• Quantity
• Estimated Cost = Estimated Material + Labor + Burden + Service
• Actual Cost = Actual Material + Labor + Burden + Service
• Variance = Estimated – Actual
• Projected = Projected Material + Labor + Burden + Service

Comparative Totals with Breakdown - Same as Comparative Totals, but Material, Labor, 
Burden, and Service costs are broken out into separate sections before being totaled. 
Additionally, setup time and run time are split out for operations.
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Detail Transactions - Individual labor, inventory, and service transaction costs are broken out by 
Material, Labor, Burden, and Service costs for each selected work order. This is the most detailed 
cost report available, as it shows the source transaction for each cost incurred.

8 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-Mail to send the report through electronic mail in a Rich text Format (.RTF).

9 Select Print/View from the File menu.

If you selected Print as the output, a standard Windows dialog box appears.

10 Make the appropriate selections then click Ok.

The report is printed.
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Printing Work Order Requirement Reports
This report summarizes unpurchased or unissued material required by a work order, and is especially 
useful for managing non-inventory materials.

If you are licensed to use multiple sites, you can include more than one site in the report.

1 Select the Work Order Requirements Report from the Eng/Mfg menu.

2 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable. 

3 Select the range of work order to print.

4 Select the appropriate date range.

This allows you to specify the range of work order Want Dates or material Required Dates to print, 
depending upon your selection of Sequence.

5 In the Report Currency field, click the arrow and specify the currency to use for the report. If you 
are printing a report for multiple sites, the drop-down list displays tracking currencies shared by 
the selected sites. If no shared currencies are found, you can print the report in native currency, or 
clear site selections until a common currency is identified.

6 Select the appropriate Info radio button.

If you select Unissued Material Required, all requirements where the current issued quantity is 
less than the quantity required print.

If you select Unpurchased Material Required, all requirements that do not have linked purchase 
orders print. This is useful for managing non-inventory part purchases, or any purchases that are 
directly to a job.

7 Select the appropriate sequence for the report.

You can sequence the report by the Want Date of work orders, or by the Required Date of 
material requirements on the work orders.

8 Check the Include Material with Part IDs to print inventory materials.

If you do not check this box, only non-inventory materials are reported (those without Part IDs). 
This allows you to manage those materials that are special to a particular job, because you can 
use the Material Planning Window for all materials with Part IDs.

9 Select the output for the report.

Select Print to output the report to a printer.

Select View to output the report to your screen for viewing.

Select File to output your report as a text file. You can then edit the report using a text editing 
application.

Select E-Mail to send the report through electronic mail in a Rich text Format (.RTF).

10 Select Print/View from the File menu.
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What is Equipment Maintenance?
Use the Equipment Maintenance window to collect and maintain customer equipment data. The 
Equipment Maintenance window allows you to establish maintenance profiles for pieces of equipment 
that you’ve sold and now plan to service as part of a maintenance agreement. You have the option of 
specifying whether equipment maintenance is internal (on site) or external.

Starting Equipment Maintenance
Select EqMnt, Equipment Maintenance.
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Entering and Maintaining Equipment Information
Before using the Equipment Maintenance window, set up basic information regarding equipment and 
services.

From the Maintenance menu, you can enter and maintain equipment information of the following 
types:

• Equipment Type
• Equipment Model
• Service Area Maintenance
• Service Branch Maintenance
• Maintenance Type
• Coverage Hours Maintenance
• Part Price List Maintenance
• Labor Price List Maintenance
• Labor Calendar Maintenance
• Auto Numbering

Entering, Maintaining, and Deleting Equipment Types
Use the Equipment Types dialog box to enter and maintain equipment types.

1 Select Maintenance, Equipment Type Maintenance.

2 Click Insert.

3 Specify this information:

Type – Specify the type ID. Enter any alphanumeric combination as a unique identifier of the type.

Description – Specify a description of the type. Be detailed in your descriptions. For example, 
use this field to supply a cryptic alphanumeric equipment type such as 44RR with an description 
that greatly clarifies actual equipment characteristics and use.

4 Click Save.

5 To modify information, place the mouse pointer in the appropriate column in the appropriate line 
and manually edit the information. When complete, click the Save button.

6 To delete an equipment type, highlight the appropriate line and click the Delete button.

An X is placed at the beginning of the line.

Click the Save button to delete the line.

7 Click the Close button to return to the Equipment Maintenance window.
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Entering, Maintaining, and Deleting Equipment Models
Use the Equipment Models dialog box to enter and maintain equipment models.

1 Select Maintenance, Equipment Model Maintenance.

2 Click Insert.

3 Specify this information:

Model – The model of the equipment. Enter any alphanumeric combination as a unique identifier 
of the model.

Type – The type of equipment model this is. Double-click the column header to view a list of 
equipment types. If you have not previously entered equipment types, no types appear in the line 
item table. Because Equipment Types are necessary in the entry of new models, pause in this 
procedure and enter Equipment Types now. See the previous section for more information.

Description – A description of the model. Use this field to explain actual equipment model 
characteristics and use.

4 Click Save.

5 To modify information, place the mouse pointer in the appropriate column in the appropriate line 
and manually edit the information. When complete, click Save.

6 To delete an equipment model, highlight the appropriate line and click Delete.

An X is placed at the beginning of the line.

Click Save to delete the line.

7 Click Close to return to the Equipment Maintenance window.

Entering, Maintaining, and Deleting Service Areas
 Use the Service Areas dialog box to enter and maintain service area information.

1 Select Maintenance, Service Area Maintenance.

2 Click Insert.

3 Specify this information:

Area – The new area you want to define. Enter any alphanumeric combination as a unique 
identifier of the area.

Description – A description of the area. Use this field to enter any general information about the 
area. Be detailed in your descriptions.

4 Click Save.

5 To modify information, place the mouse pointer in the appropriate column in the appropriate line 
and manually edit the information. When complete, click Save.

6 To delete a service, highlight the appropriate line and click Delete.

An X is placed at the beginning of the line.
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Click Save to delete the line.

7 Click Close to return to the Equipment Maintenance window.

Entering, Maintaining, and Deleting Service Branches
Use the Service Branches dialog box to enter and maintain service branch information.

1 Select Maintenance, Service Branch Maintenance.

2 Click Insert.

3 Specify this information:

Branch – An ID for the branch you want to add. Enter any alphanumeric combination as a unique 
identifier of the branch.

Area – The area in which the service branch is found. Double-lick the <Area> column header to 
view a list of valid service areas. If you have not previously entered any service areas, none 
appear in the line item table. Because Service Areas are necessary in the entry of new branches, 
pause in this procedure and enter at least one Service Area now. See the previous section for 
more information.

Description – A description of the service branch. Be detailed in your descriptions.

4 Click Save.

5 To modify information, place the mouse pointer in the appropriate column in the appropriate line 
and manually edit the information. When finished, click Save.

6 To delete a service branch, highlight the appropriate line and click Delete.

An X is placed at the beginning of the line.

Click Save to delete the line.

7 Click Close to return to the Equipment Maintenance window.

Entering, Maintaining, and Deleting Maintenance Types
Use the Maintenance Engineering IDs dialog box to enter and maintain Maintenance Types 
information.

1 Select Maintenance, Maintenance Type.

2 Click Insert.

3 Specify this information:

Type – An ID for the type you want to add. Enter any 3 character alphanumeric combination as a 
unique identifier.

Description – A description of the ID. Be detailed in your descriptions.

4 Click Save.
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5 To modify information, place the mouse pointer in the appropriate column in the appropriate line 
and manually edit the information. When finished, click Save.

6 To delete a maintenance type, highlight the appropriate line and click Delete.

An X is placed at the beginning of the line.

Click Save to delete the line.

7 Click Close to return to the Equipment Maintenance window.

Entering, Maintaining, and Deleting Coverage Hours
Use the Coverage Time Maintenance dialog box to enter and maintain coverage times information.

1 Select Maintenance, Coverage Hours Maintenance.

2 Click Insert.

3 Specify this information:

Start Time – The start time of the maintenance coverage shift. AM is assigned unless you specify 
PM.

End Time – The end time of the maintenance coverage shift. AM is assigned unless you specify 
PM.

Coverage Description – A description of the coverage type. Be detailed in your descriptions. For 
example, enter text that helps to clarify what a maintenance engineer may do during this type of 
maintenance coverage shift.

4 Click Save.

5 To modify information, place the mouse pointer in the appropriate column in the appropriate line 
and manually edit the information. When finished, click Save.

6 To delete a maintenance coverage range, highlight the appropriate line and click Delete.

An X is placed at the beginning of the line.

Click Save to complete the deletion.

7 Click Close to return to the Equipment Maintenance window.

Establishing Part Price Lists
You can establish prices for part used in equipment maintenance. A Part Price ID can have multiple 
parts. Use Part Price IDs to group together parts with similar prices and discounts. For example, an 
ID could consist of five parts, all of which have a price of 3.00-4.00 and a discount of 3-5%. Of course, 
a Part Price ID can also be made up of parts with disparate prices and discounts. There are no 
restrictions on the parts you can include in a Part Price List ID as long as they are valid VISUAL parts.

1 Select Maintenance, Part Price List Maintenance.
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2 Click Insert.

3 Double-click the Part ID column header to view the part table and select a part. All parts currently 
existing in your VISUAL database appear in this table.

The part’s description is inserted into the Description field.

4 Enter a price for the part. You can enter a maximum of 10 numeric characters in the field.

5 If you plan to offer a discount on the part, enter a discount for the part in the Discount field. After 
tabbing out of the field, a % is placed after the discount value.

6 Enter as many lines as necessary. If you want to copy an existing ID to another ID, click Copy.

Enter a unique ID or select one from the list box.

Click Save. The new ID is added if you specified a new ID or modifies the ID if you specified an 
existing ID.

7 When you are finished adding, modifying, or deleting Part Price ID information, click Save. Click 
Close to return to the Equipment Maintenance window.

Establishing Labor Price Lists
You can establish a list of labor prices associated with resources used to perform maintenance on 
equipment. A Labor Price List ID can have multiple resources. Use Labor Price IDs to group together 
labor resources with similar operating costs. For example, a Labor Price ID could consist of five 
resources - all perhaps part of a shop group, all of which have a normal hourly rate of $5.00 and an 
overtime cost of $10.00. Of course, a Labor Price ID can also be made up of resources with disparate 
hourly and overtime rates. There are no restrictions on the resources you can include in a Labor Price 
List ID as long as they are valid VISUAL resources.

1 Select Maintenance, Labor Price List Maintenance.

If you are only editing an existing profile, select the profile from the Labor Price ID list box.

2 For new labor profiles, enter a unique ID in the Labor Price ID data field. You can enter up to 10 
alphanumeric characters in the field.

3 Click Insert. You must enter an ID before you can select a Resource ID. 

4 Double-click the Resource ID column header to view the resource table and select a resource. All 
resources currently in your VISUAL database appear in this table.

The resource’s description is auto-filled in the Description field.

5 In the Normal/HR column, enter the normal hourly rate for the resource. You can enter a 
maximum of 10 numeric characters in the field.

6 In the Overtime 1/HR column, enter the overtime rate if overtime is one hour. An entry in this field 
is not required.

7 In the Overtime 2/HR column, enter the overtime rate if overtime is two hours. An entry in this field 
is not required.

8 Enter as many lines as necessary. If you want to copy an existing ID to another ID, click Copy.
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Enter a unique ID or select one from the list box.

Click Save. The new ID is added if you specified a new ID or modifies the ID if you specified an 
existing ID.

9 When you are finished adding, modifying, or deleting Labor Price ID information, click Save. Click 
Close to return to the Equipment Maintenance window.

Establishing Labor Calendars
Labor calendars allow you to assign hours of operation to resources used in equipment maintenance.

1 Select Maintenance, Labor Calendar Maintenance.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site whose labor 
calendar you are setting up. If you are licensed to use a single site, this field is unavailable.

3 Click the Resource ID arrow and select the Resource ID for which you want to establish a billing 
calendar.

4 In the table, specify this information:

Start Time – The starting time of the resource.

Normal Hours – The normal duration (hours) of operation for the resource.

Overtime1 – The duration (hours) of the first overtime shift.

Overtime2 – The duration (hours) of the second overtime shift.

5 Click Save.
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Entering Customer Equipment Information
To set up customer equipment information:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

2 Click the Customer ID button to select the customer for whom you are entering equipment 
information.

3 Click the Equipment ID button to select an existing piece of equipment or enter a unique ID for 
this piece of equipment in the data field.

4 Select an Equipment Type or Model by clicking the appropriate button.

If you select an equipment type, you may not be able to select a model. Equipment models 
require equipment types as part of their definition, so selecting a certain type does not necessarily 
mean that a model exists with the same type in its profile. Either base this piece of customer 
equipment on a type or a specific model. If you select a type with no corresponding model, you 
cannot choose a model without changing the type.

5 Click the Equipment tab and specify this information:

Mfg Date – Click the calendar button and select the date of manufacture for the equipment.

Part ID – If applicable, click the Part ID button and select a Part ID. When generating unplanned 
maintenance calls for this piece of equipment in Unplanned Maintenance, all work orders are 
created with this Part ID as the material in the work order header card.

List Rels – For new Equipment IDs, enter a unique engineering release number and select a date 
for the release. The value you enter for this Equipment ID is for this Equipment ID only. Every 
piece of equipment has a unique series of engineering release numbers.

For existing Equipment IDs, click the List Rels button to select from a list of all engineering 
releases.

Release Date – The current date is inserted. 

Serial Number – Enter a serial number for the equipment. Serial numbers can be a maximum of 
19 alphanumeric characters in length.

Area – Click the Area button to select the area for equipment maintenance. In order to view areas 
in this table, you must have previously entered Areas using the Maintenance menu option Service 
Area Maintenance. See earlier in this chapter for more information.

Branch – Click the Branch button to select the branch for equipment maintenance. In order to 
view branches in this table, you must have previously entered branches using the Maintenance 
menu option Service Branch Maintenance. See earlier in this chapter for more information.

If you already selected an Area, only those Branches with the selected Area in their profile 
appear.

Work Order – Click the Work Order button to select a work order for the piece of equipment. If 
you already selected a Part ID, you can only choose a work order with the same Part ID. You 
must clear the Part ID field if you want to view all work orders in the database. Although this is 
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treated as the equipment’s default Work Order ID, you can specify unique Work Order IDs when 
processing calls in Unplanned Maintenance. In short, you are not bound by this ID. Use it to 
communicate to engineering personnel an approximate work order model for the equipment.

Description – If necessary, enter any descriptive information in the multi-line text field.

Location – Click the appropriate option for the maintenance location.

External - Maintenance on the equipment is performed externally, or away from the site.

Internal - Maintenance on the equipment is performed internally, or on-site.

Description – If necessary, enter any descriptive information in the multi-line text field.

6 Click the Maintenance tab.

7 Specify this information:

Engineer ID – Click the Engineer ID button to select a resource for the Equipment ID. Only valid 
VISUAL resources are accepted. 

For external maintenance, this option in unavailable; for internal maintenance, this field is 
required.

Machine ID – Click the Machine ID button to select a resource for the Equipment ID. 

Maint ID – Enter a Maintenance ID or click the Maint ID button to select an ID. In order to view 
Maintenance IDs, you must have previously entered them using the Maintenance menu option, 
Maintenance Type. Only valid types are accepted. See earlier in the chapter for more information.

Class – Select a class from the Class list box.

Labor Only - Maintenance requires labor only.

None - Maintenance requires no labor.

Parts & Labor - Maintenance requires parts and labor.

Parts Only - Maintenance requires parts only.

Contract No – Enter a contract number. Contract numbers can be a maximum of 15 
alphanumeric characters in length.

Price Lists section – If applicable, from the Price Lists section, select the appropriate labor and/
or part Price List ID.

You must enter part and labor price lists using the Maintenance menu options Part Price List 
Maintenance and Labor Price List Maintenance. If you have not established any part or labor 
price lists, none appear. See earlier in the chapter for more information.

Click the Labor button or Parts button as appropriate.

Free of Charge section – Specify if parts, labor, or mileage are to be free of charge. If they are, 
select the appropriate check box.

Dates – Enter a date range for maintenance coverage.

Enter the starting date in the left data field, and the ending date in the right data field. For 
example, enter a week—a period of seven days—to start. Later, when you specify a period of 
coverage, you can apply this seven days as a base unit to longer periods of time.



Entering Customer Equipment Information

Infor VISUAL Inventory User’s Guide | 14 – 11

Coverage – Click the Coverage button to select a type of coverage. You must click the button to 
select a type. In order to view types, however, you must have previously entered them using the 
Maintenance menu option, Coverage Hours Maintenance. See earlier in this chapter for more 
information.

Period – Enter the period, in months, of coverage.

8 Click the Profiles tab.

Equipment Maintenance uses engineering masters as templates for creating work orders. You 
can attach multiple maintenance profiles to a piece of equipment. A maintenance profile consists 
of an ID, an engineering master, a frequency type, and a frequency number.

A typical profile may be:

For equipment AXBC, Profile 4 says do EM 4, weekly, every 2 weeks.

When you create the work order later, jobs are created based on the given profile.rts.

The Profiles tab displays profiles for the Equipment ID. Enter profiles in Planned Maintenance.

If a piece of equipment has a Part ID, you cannot select a Profile ID unless an engineering master 
exists for the Part ID. The Equipment Maintenance window stores and maintains its own 
engineering masters. VE Engineering Masters do not apply when establishing profiles. See the 
scheduling section later in this chapter for more information.

If any profiles exist for a piece of equipment, they appear in the line item table.

9 Click the Contact tab and specify the contact; someone within the customer organization with 
whom you would communicate the details of an equipment maintenance operation. By default, 
the primary contact information for the customer is displayed. You can specify a different contact. 
You can select a contact with an ID or enter a standalone contact for this transaction only.

• To select a contact with a registered Contact ID, use one of these methods:

Select an alternate contact - Click the Contact browse button and select a contact from the 
browse table showing contacts assigned to the customer. Select the Use Selected Contact 
toolbar button.

Select a contact from all contacts - Click the Contact browse button and then click the 
Associate existing contact toolbar button. Select a contact from the Contacts dialog and 
click Ok. In the Contacts for Customer dialog select the contact and then click the Use 
Selected Contact toolbar button.

Specify a new contact in the Contacts for Customer dialog - Click the Contact browse 
button. Click the Add New Contact button and specify contact information in the General tab 
and Address tab fields. Click the Save toolbar button.

You can also assign contacts to customers in the Contact Maintenance window.

• To specify a standalone contact, specify the contact information in the fields on the Contact
tab. If contact information is already displayed in the tab, you can edit the existing information
to create a standalone contact. When you edit the information, the Contact ID field is cleared.
The edits that you make in the Contact tab do not update contact information in your Contact
table. Standalone contact information is saved with the transaction only and is not added to
your Contacts table. If you anticipate using this standalone contact again, Infor recommends
creating a contact with a Contact ID. 
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Specify this information:

Contact ID/Name – Enter the contact’s full name and review the ID number. A contact without 
an ID number does not display in Contact Maintenance.

Position – Enter the contact’s position. For example, CEO.

Salutation – Enter the salutation to use for this vendor contact. This field has a drop-down 
menu populated with some of the most popular salutations.

Phone/Ext – Enter the telephone number, with area code and extension, for the contact. This 
may be a direct line to the contact, or a generic company line.

Fax – Enter the area code and Fax number.

Mobile – Enter the contact’s area code and mobile phone number.

E-Mail – Enter the appropriate vendor E-mail address.

Note: Standalone contacts are not added to the Email Documents list for the vendor. Only contacts 
with IDs can be added to the Email Documents list. 

If you do not want to assign a contact to this order, click the Use No contact toolbar button.

10 Click the Save toolbar button.

Deleting Equipment IDs
To delete an equipment ID:

1 If you are licensed to use multiple sites, click the Site ID arrow to select the site in which you 
created the equipment. If you are licensed to use a single site, this field is unavailable.

2 Click the Equipment ID browse button and  select the Equipment ID to delete. 

3 Click the Delete button. You are prompted to confirm the action. 

4 Click Yes to delete the Equipment ID and all dependent rows or No to return to the Equipment 
Maintenance window.
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Activities
Activities are available in the Equipment Maintenance window. Use activities to manually create 
reminders about follow-up items or to record information about interactions you have with customers. 

To add a new activity, select Edit, Activity Entry. See "Creating Activities" on page 5–5 in the 
Concepts and Common Features guide.

To view existing activities, select View, Activities. To view all activities related to equipment, select 
View, Activities from a blank Equipment Maintenance window. To view all activities related to a 
particular equipment ID, select the ID in the Equipment Maintenance window before selecting View, 
Activities. See "Activity Maintenance" on page 5–10 in the Concepts and Common Features guide.
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What is the Planned Maintenance Manager?
The Planned Maintenance Manager lets you create planned maintenance details for equipment 
you’ve previously set up using Equipment Maintenance. Use the Planned Maintenance Manager to 
create maintenance profiles, and attach equipment to these profiles, after which you can generate 
planned maintenance schedules that are converted to common manufacturing work orders. When 
you have finished maintenance work on the equipment and the work order closes, you can generate 
billing details for the equipment, if the equipment is external and the work order is for a piece of 
customer equipment.

Starting the Planned Maintenance Manager
To start the Planned Maintenance Manager:

From the EqMnt menu, select Planned Maintenance.

The Planned Maintenance Manager window is primarily a display tool for scheduled maintenance 
jobs and does not feature the tabs and header fields of the Equipment Maintenance window. The 
option buttons at the top of the window allow you to filter what you can view and the toolbar contains 
shortcut buttons you can use to quickly execute scheduling runs and create work orders. Before 
trying to schedule any planned maintenance jobs, take a look at the three options available from the 
Maintenance menu. They let you enter planned maintenance and equipment profiles, the use of 
which allows you to create numerous different equipment maintenance scheduling scenarios. See the 
next section for more information.

Setting Up the Planned Maintenance Manager

Entering, Maintaining, and Deleting Engineering IDs
Use the Maintenance Engineering IDs dialog box to enter and maintain Engineering ID information. 
These EMs are available for planned maintenance to use in equipment profiles.

1 From the Maintenance menu, select Engineering IDs.

2 To enter a new Engineering ID, click the Insert button.

3 Enter information in the following fields:

Eng ID - The Engineering ID you want to add. Enter any 3 character alphanumeric combination 
as a unique identifier.

Description - A description of the ID. Be detailed in your descriptions.

4 Click the Save button to commit the information.

5 To modify information, place the mouse pointer in the appropriate column in the appropriate line 
and manually edit the information. When finished, click the Save button.



What is the Planned Maintenance Manager?

Infor VISUAL Inventory User’s Guide | 15 – 3

6 To delete an Engineering ID, highlight the appropriate line and click the Delete button.

An X is placed at the beginning of the line.

Click the Save button to delete the line.

7 Click the Close button to return to the Service Branch Maintenance window.
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Entering Maintenance Profiles
Because you may have a wide range of equipment, you need to be able to maintain multiple 
maintenance profiles and have the option of assigning more than one profile to the same Engineering 
ID. Some equipment may require yearly maintenance, while other pieces may require weekly checks. 
For pieces of equipment requiring varying levels of service, maintain several profiles and create 
service schedules with the profile of your choice.

1 From the Maintenance menu, select Maintenance Profiles.

Existing profiles appear in the line item table.

2 In the Profile ID field, enter a unique ID for the profile. To edit an existing profile, enter the ID or 
double-click the profile in the line item table.

For new Profile IDs, the New Profile check box is selected.

3 In the Description data field, enter any descriptive text for the profile. Notes to colleagues or 
words explaining the particular profile make good entries. 

4 Click the Eng ID button to select an Engineering ID to associate to the profile. Enter Engineer IDs 
in the Planned Maintenance Manager window. See the previous section for more information. The 
profile will not save unless it has an Engineering ID.

5 Select a frequency type for the profile.

Daily - Select this option button if you want maintenance scheduled on a daily basis, up to seven 
days, when using this maintenance profile. 

Weekly - Select this option button if you want maintenance scheduled on a weekly basis, up to 
four weeks, when using this maintenance profile. 

Monthly - Select this option button if you want maintenance scheduled on a monthly basis, up to 
12 months, when using this maintenance profile. 

Yearly - Select this option button if you want maintenance scheduled on a yearly basis, when 
using this maintenance profile.

6 Enter a frequency. For example, if you want the profile to have a frequency value of six days, 
select the Days option button and then enter six.

7 Click the Save button to save the maintenance profile. It appears in the line table. To edit any of 
these settings, double-click the profile, modify as necessary and then save.

8 To delete a profile, select the profile in the line item table and click the Delete button.

Entering Equipment Profiles
Now that you’ve entered maintenance profiles, you can attach them to pieces of equipment. 
Equipment profiles provide a means of specifying maintenance specifics, such as the day of the week 
you want to perform the maintenance on, and any date exceptions. Exceptions allow you insert days 
of inactivity into an equipment profile. Saved equipment profiles appear in the Equipment 
Maintenance window in the Profiles tab.
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1 From the Maintenance menu, select Equipment Profiles.

2 From the Profile ID lost box, select a Profile ID. You have to create maintenance profiles before 
anything appears in the list box. Instructions for creating maintenance profiles precede this 
section

The read-only fields and the line table are auto-filled with profile information.

3 Click the Insert button to add a new line to the table.

4 Double-click the <Equip ID> column header to view the EQUIPMENT table and select a piece of 
equipment.

5 Enter a day for the profile. This is the day of the week on which you want the maintenance to 
begin. Using the above Frequency (two weeks for example), maintenance for this piece of 
equipment is scheduled every two weeks - or every other Monday, for instance.

6 If applicable, enter a ship date for the profile.

If you associated a part/engineering master to the Equipment ID in Equipment Maintenance, the 
Part ID/engineering master appears in the Engineering Master column. If there is no engineering 
master associated to it, “No Part ID on Equipment” appears. To view an engineering master in the 
Manufacturing Window, select a line and click the Eng Master button.

7 Click the Save button to save the new line.

8 To make exceptions to the profile line, highlight a line and click the Exceptions button.

The Exceptions dialog box appears. The Equipment ID and Profile ID appear in read-only fields at 
the top of the dialog box.

9 Click the Insert button to add a new exception. 

10 Enter the month in which the exception will take place. Then, within the month, enter the dates for 
which there will be an exception.

11 Click the Save button to save the exception.

When you return to the Add Equipment Profiles dialog box, you’ll find that the Exception check 
box in the line table has been selected. 
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Creating Maintenance Schedules
After you’ve entered equipment and equipment profiles into your database, you can generate a 
maintenance schedule that reflects current equipment/profile relationships.

1 From the File Menu, select Create Schedule or click the Create Schedule button.

Scheduled lines appear in the table. Click the Clear Sched button if you want to clear the display. 
Use the features in the top part of the window as a filter to control what you want to include in the 
schedule.

2 Enter a date range for the schedule. If you want dates to be ignored, leave the fields blank. Click 
the calendar icons or manually enter dates.

3 Use the browse buttons to select the information to include in the schedule. You can include 
Equipment, Type, Model, Resource, Site, Customer, Area, Branch, and Eng ID.

4 To exclude from the schedule with information displaying in the data fields, select the Exclude 
check boxes to the right. This feature is useful if you want to run different scheduling scenarios 
without deleting and modifying filter preferences. The check boxes, however, are only available if 
the corresponding data fields are active as well.

5 Click the Schedule button to begin the scheduling process.

A dialog box appears in which you can see the progress of the scheduling run.

After the scheduling run is complete, another dialog box appears summarizing the number of new 
job records created and the range for the jobs.

Scheduling results appear in the line item table, one line per job.

The line item table contains the following columns:

Site ID – The site where the job was scheduled.

Job Date - The date on which the maintenance job is scheduled to occur. For a piece of 
equipment with a profile for which you have set a daily frequency preference, using an occurrence 
rate of every six days, with a coverage range of 3/3/2003 - 5/31/2003, a series like this is 
scheduled:

3/9/2003, 3/15/2003, 3/21/2003, 3/27/2003, 4/2/2003, 4/8/2003, 4/14/2003, 4/20/2003, 4/26/
2003, 5/2/2003, 5/8/2003, 5/14/2003, 5/20/2003, 5/26/2003.

Job ID – The Job ID of the maintenance job.

Customer - The ID of the customer for whom you are performing the equipment maintenance.

Equipment – The ID of the equipment you are maintaining.

Model - The model, if any, of the Equipment ID. You specify this during new equipment entry. See 
earlier in the chapter for more information.

Type - The type, if any, of the Equipment ID. You specify this during new equipment entry. See 
earlier in the chapter for more information.

Service Area – The service area, if any, of the Equipment ID. You specify this during new 
equipment entry. See earlier in the chapter for more information.
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Branch – The branch, if any, of the Equipment ID. You specify this during new equipment entry. 
See earlier in the chapter for more information.

Engineer - The Engineer for the equipment. You specify this during new equipment entry. See 
earlier in the chapter for more information.

WO Base ID - The Base ID of the work order.

Eng ID – The engineering ID associated with this maintenance record.

Def Status - The status of the work order.

WO Create Date - The date on which the work order is created.

Internal - Either a Y or an N displays in the column. If a maintenance job is internal, a Y appears; 
if it is external, an N appears. You specify job location during new equipment entry. See earlier in 
the chapter for more information.

Sales Order – If a sales order was created in conjunction with this maintenance record, the ID of 
the sales order is inserted.

Line No – The line number of the sales order for this maintenance record.

Last Invoice – The date of the last invoice for this maintenance record.

6 Use the options at the top of the window to filter the information in the table. In the Planned 
Maintenance Status area, select one of these options:

Planned – Select this option to view maintenance jobs that have not yet been scheduled.

WO Created – Select this option to view maintenance jobs with scheduled work orders.

WO Closed – Select this option to view maintenance jobs with closed work orders.

CO Created – Select this option to view maintenance jobs with customer orders.

Billed – Select this option to view maintenance jobs that have been billed.

All – Select this option to view all maintenance jobs.

To specify the type of job to view in the table, select one of these options:

Internal - Select this option button to view only Internal jobs.

External - Select this option button to view only External jobs.

Both - Select this option button to view both Internal and External jobs. This is the default.

Viewing & Editing Maintenance Schedule Equipment/Job 
Records
After scheduling maintenance jobs, the jobs appear in the line item table, one job per line. You can 
view and edit these records to suit your scheduling preferences and requirements.

To do this:

1 If necessary, scroll down the table and locate the job line you want to view or edit and double-click 
the line.
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The six read-only fields at the top of the window display basic maintenance job information. The 
fields at the bottom of the window are editable.

2 If you want to change or add a job Maintenance Engineering ID, click the Eng ID button and 
choose a Maintenance Engineering ID from the list. 

3 If you want to change the resource, click the Resource ID button and select an operation 
resource from a list of valid operation resources. 

4 To change the job date, click the calendar icon and select a date or manually enter a date.

5 To change the default work order status, click the appropriate radio button. 

Released - This job is assigned a default status of released. Released work orders are ready for 
the floor. Work may begin on them at any time.

Firmed - This job is assigned a default status of firmed. Firmed work orders are not ready for the 
floor. Work may not begin on them until their status moves to Released.

Default - This job is assigned the default status of all work orders, which is either, Released or 
Firmed, depending on the preference set at the time. See the next section for more information on 
setting a work order creation default status.

6 Click the Save button to commit the settings.

The dialog box closes and you can see the new settings in the appropriate columns in the line 
item table.

Setting a Work Order Default Status
Choose a default status for new work orders and an external and internal rank. 

1 Select Work Order Defaults from the Edit menu.

2 Select the appropriate option button.

Firm - Work orders are created with a status of firmed. Firmed work orders are not ready for the 
floor. Work may not begin on them until their status moves to Released.

Released - Work orders are created with a status of released. Released work orders are ready for 
the shop floor; work may begin on them at any time. See the “Material Planning Window” chapter 
in the Inventory guide.

3 Enter an Internal and External Rank.

Use ranks to assign importance to external and internal work orders. The Concurrent Scheduler 
uses these rankings as priorities when scheduling released work orders. To change the priority of 
individual work orders, use the Concurrent Scheduler.

4 Click the Save button to commit settings.
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Setting a Customer Order Default Status
Choose a default status for new customer orders that are created.

1 From the Edit menu, select Customer Order Defaults.

2 Select the appropriate option button.

Firm - Customer orders are created with a status of firmed. Firmed customer orders are not ready 
for the floor. Work may not begin on them until their status moves to Released.

Release - Customer orders are created with a status of released. Released work orders are ready 
for the floor; work may begin on them at any time. 

3 Click the Save button to commit settings.
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What is Unplanned Maintenance?
Use the Unplanned Maintenance window to track the maintenance of internal and external equipment 
outside of regularly-scheduled tasks. The Unplanned Maintenance module serves as a “call center” 
for the manufacturer’s Service or Customer Service departments.

Starting Unplanned Maintenance
Unplanned Maintenance is available from the Equipment Maintenance menu.

To start Unplanned Maintenance:

From the main menu, select Unplanned Maintenance from the Equipment Maintenance menu.

The Unplanned Maintenance window is divided into a header section and a tabbed section. Begin by 
specifying a site, then entering general unplanned maintenance information. See the next section for 
more information.
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Entering and Maintaining Unplanned Maintenance 
Information
Before you can begin using the Unplanned Maintenance window, you must enter some basic 
information for equipment and services.

From the Maintain menu, you can enter and maintain information for the following:

• Fault Types
• Fault Codes
• Remedy Types
• Remedy Codes
• Urgency Codes
• Escalation Codes
• Engineer Assignments
• Standard Repairs

Entering, Maintaining, and Deleting Fault Types
Use the Fault Types dialog box to enter and maintain fault type information. A fault is a failing in a 
piece of equipment requiring maintenance. Fault Types consist of a Type and a Description.

1 From the Maintain menu, select Fault Types.

2 To enter a new type, click the Insert button.

3 Enter information in the following fields:

Type – The type of fault. You can enter a maximum of 15 alphanumeric characters.

Description – A description of the fault. Be detailed in your descriptions. For example, enter text 
that helps to clarify what a maintenance engineer may need to do to repair this kind of fault. You 
can enter a maximum of 40 alphanumeric characters.

4 Click the Save button to commit the information.

5 To modify information, place the mouse pointer in the appropriate column in the appropriate line 
and manually edit the information. When finished, click the Save button.

6 To delete a fault type, highlight the appropriate line and click the Delete button. 

An X is placed at the beginning of the line.

Click the Save button to complete the deletion.

7 Click the Close button to return to the Unplanned Maintenance window.
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Entering, Maintaining, and Deleting Fault Codes
Use the Fault Codes dialog box to enter and maintain fault code information. A fault is a failing in a 
piece of equipment requiring maintenance. Fault Codes consist of a Code, a Fault Type, and a 
Description.

1 From the Maintain menu, select Fault Codes.

2 To enter a new type, click the Insert button.

3 Enter information in the following fields:

Code – A code for the fault. You can enter a maximum of 15 alphanumeric characters.

Fault Type – The type of fault. Double-click the column header to select a type. In order to select 
a type, you must have entered fault types in the database. See the previous section for more 
information.

Description – A description of the fault code. Be detailed in your descriptions. For example, enter 
text that helps to clarify what a maintenance engineer may need to do to repair this kind of fault. 
You can enter a maximum of 40 alphanumeric characters.

4 Click the Save button to commit the information.

5 To modify information, place the mouse pointer in the appropriate column in the appropriate line 
and manually edit the information. When finished, click the Save button.

6 To delete a fault code, highlight the appropriate line and click the Delete button.

An X is placed at the beginning of the line.

Click the Save button to complete the deletion.

7 Click the Close button to return to the Unplanned Maintenance window.

Entering, Maintaining, and Deleting Remedy Types
Use the Remedy Types dialog box to enter and maintain remedy type information. Remedy Types 
consist of a Code and a Description.

1 From the Maintain menu, select Remedy Types.

2 To enter a new type, click the Insert button.

3 Enter information in the following fields:

Code – An identifier for the remedy type. You can enter a maximum of 15 alphanumeric 
characters.

Description – A description of the remedy type. Be detailed in your descriptions. For example, 
enter text that helps to clarify what the remedy actually is. You can enter a maximum of 40 
alphanumeric characters.

4 Click the Save button to commit the information.

5 To modify information, place the mouse pointer in the appropriate column in the appropriate line 
and manually edit the information. When finished, click the Save button.
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6 To delete a remedy type, highlight the appropriate line and click the Delete button. 

An X is placed at the beginning of the line.

Click the Save button to complete the deletion.

7 Click the Close button to return to the Unplanned Maintenance window.

Entering, Maintaining, and Deleting Remedy Codes
Use the Remedy Codes dialog box to enter and maintain remedy code information. Remedy Codes 
consist of a Code, a Remedy Type, and a Description.

1 From the Maintenance menu, select Remedy Codes.

2 To enter a new type, click the Insert button.

3 Enter information in the following fields:

Code – A code (ID) for the remedy. You can enter a maximum of 15 alphanumeric characters.

Remedy Type – The type of remedy. Double-click the column header to select a type. In order to 
select a remedy type, you must have entered remedy types in the database. See the previous 
section for more information on entering remedy types.

Description – A description of the remedy code. Be detailed in your descriptions. For example, 
enter text that helps to clarify what the remedy actually is. You can enter a maximum of 40 
alphanumeric characters.

4 Click the Save button to commit the information.

5 To modify information, place the mouse pointer in the appropriate column in the appropriate line 
and manually edit the information. When finished, click the Save button.

6 To delete a remedy code, highlight the appropriate line and click the Delete button.

An X is placed at the beginning of the line.

Click the Save button to complete the deletion.

7 Click the Close button to return to the Unplanned Maintenance window.

Entering, Maintaining, and Deleting Urgency Codes
Use the Urgency Codes dialog box to enter and maintain urgency code information. Urgency Codes 
consist of a Code and a Description.

1 From the Maintain menu, select Urgency Codes.

2 To enter a new code, click the Insert button.

3 Enter information in the following fields:

Code – An identifier for the urgency code. You can enter a maximum of 15 alphanumeric 
characters.
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Description – A description of the urgency code. Be detailed in your descriptions. For example, 
enter text that helps clarify how urgent the maintenance is. You can enter a maximum of 40 
alphanumeric characters.

4 Click the Save button to commit the information.

5 To modify information, place the mouse pointer in the appropriate column in the appropriate line 
and manually edit the information. When finished, click the Save button.

6 To delete an urgency code, highlight the appropriate line and click the Delete button. 

An X is placed at the beginning of the line.

Click the Save button to complete the deletion.

7 Click the Close button to return to the Unplanned Maintenance window.

Entering, Maintaining, and Deleting Escalation Codes
Use the Escalation Codes dialog box to enter and maintain escalation code information. Escalation 
Codes consist of a Code and a Description.

1 From the Maintain menu, select Escalation Codes.

2 To enter a new code, click the Insert button.

3 Enter information in the following fields:

Code – An identifier for the escalation code. You can enter a maximum of 15 alphanumeric 
characters.

Description – A description of the escalation code. Be detailed in your descriptions. For example, 
enter text that helps to clarify what the escalation indicates. You can enter a maximum of 40 
alphanumeric characters.

4 Click the Save button to commit the information.

5 To modify information, place the mouse pointer in the appropriate column in the appropriate line 
and manually edit the information. When finished, click the Save button.

6 To delete an escalation code, highlight the appropriate line and click the Delete button.

An X is placed at the beginning of the line.

Click the Save button to complete the deletion.

7 Click the Close button to return to the Unplanned Maintenance window.

Standard Repair Maintenance
Standard repairs are repairs that you perform routinely. Enter standard repair types into your 
database so you do not have to reenter the same information each time the need for the repair arises.

1 From the Maintain menu, select Standard Repairs.
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2 Click the Insert button to add a new row to the table.

3 Enter information in the following fields:

Eng ID – Double-click the column header to select an Engineer ID for the repair. All standard 
repairs are assigned an Engineer ID of 0. 

Part ID – The Part ID of the standard repair. You cannot select a Part ID other than the one that 
appears when you select an Engineer ID.

Equip Type – Double-click the column header to select an Equipment Type for the repair. Enter 
equipment types in Equipment Maintenance. Because equipment models contain equipment 
types as part of their profile, you can skip this step if you know which model you want to assign to 
the standard repair. For more information, refer to the “Equipment Maintenance” chapter in this 
guide.

Equip Model – Double-click the column header to select an Equipment Model for the repair. You 
can select an equipment type and model with one step by selecting an equipment model. Model 
IDs contain an equipment type. Enter equipment models in Equipment Maintenance. For more 
information, refer to the “Equipment Maintenance” chapter in this guide.

Fault Type – Double-click the column header to select a fault type for the standard repair. See 
earlier in this chapter for more information on entering Fault Types. Because fault codes contain 
fault types as part of their profile, you can skip this step if you know which fault code you want to 
assign to the standard repair.

Fault Code – Double-click the column header to select a fault code for the standard repair. See 
earlier in this chapter for more information on entering Fault Codes. Any fault code selection 
overrides the fault type, if the fault type is different than the fault type in the fault code. See earlier 
in this chapter for more information on entering Fault Codes.

4 Click the Save button to commit the information and save the standard repair type.

5 Click the Close button to return to the Unplanned Maintenance window.

Assign Engineer Maintenance
Use the Assign Engineers dialog box to assign different facets of equipment maintenance to an 
individual resource. When you receive a call, you can select a resource based on the area/branch, 
model/type, fault code/fault type assignments.

1 From the Maintain menu, select Assign Engineers.

2 Click the Resource ID button to select a resource.

3 From the Type list box, select a type. Possible selections are Branch, Fault, and Model.

If you select Branch, columns Area, Branch, and Assigned appear in the line item table.

If you select Fault, columns Fault Type, Fault Code, and Assigned appear in the line item table.

If you select Model, columns Type, Model, and Assigned appear in the line item table.
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4 Enter information in the following fields:

Auto-Numbering Maintenance
You can specify auto-numbering preferences for call numbers, work orders, and sales orders. Use 
auto-numbering if you want IDs automatically assigned as transactions involving call numbers, work 
orders, and sales orders are completed. Without auto-numbering preferences specified, you must 
assign IDs to the above three types. 

If you are licensed to use multiple sites, you can specify auto-numbering profiles for each of your 
sites.

To set call number auto-numbering preferences, from the Edit menu select Auto Numbering, Call 
Number.

To set work order auto-numbering preferences, from the Edit menu, select Auto Numbering, UPM 
Work Order ID.

To set sales order auto-numbering preferences, from the Edit menu, select Auto Numbering, UPM 
Sales Order ID.

The auto-numbering dialog box appears.

See the “Concepts and Common Features” chapter.

Establishing Work Order Defaults
Enter work order defaults for status, rank, and specify an internal and external engineering master for  
use when new work orders are processed.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site for which you 
are setting up defaults. You must select a site to define the default internal and external work 
orders for the site. If you are licensed to use a single site, this field is unavailable.

Type Columns What to Specify

Branch Area, Branch, and 
Assigned 

Use Type Branch to assign areas and branches to 
specific resources. Select an Area, Branch and 
select the Assigned check box to assign an 
engineer to the resource. 

Fault Fault Type, Fault 
Code, and Assigned 

Use Type Fault to assign equipment types and 
models to specific resources. Select a Fault Type, 
Fault Code, and select the Assigned check box to 
assign an engineer to the resource 

Model Type, Model, and 
Assigned 

Use Type Model to assign equipment types and 
models to specific resources. Select a Type, Model, 
and select the Assigned check box to assign an 
engineer to the resource. 
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2 From the Options menu, select Preferences.

3 Specify the following information in the Work Order Defaults section:

Internal – Click the button to select an engineering master to use for all internal (taking place 
within the shop, or on-site) maintenance jobs. You are required to specify a default Engineering ID 
before you can begin processing any work orders.

If you are licensed to use multiple sites, the browse table shows engineering masters created in 
the site you selected in step 1.

External – Click the button to select an engineering master to use for all external (taking place 
outside the shop, or off-site) maintenance jobs. You are required to specify a default Engineering 
ID before you can begin processing any work orders.

If you are licensed to use multiple sites, the browse table shows engineering masters created in 
the site you selected in step 1.

Default Status – Select a default status for work orders. Choose one option:

Release – Release(d) work orders are work orders on which you are ready to begin working. 
They have been ‘released” to the shop floor.

Firm – Firm work orders are work orders existing more for planning purposes. Though they 
are real work orders, until they are released, the Concurrent Scheduler does not schedule 
them as it does released work orders. Scheduler and planners use this designation as a work 
order place holder.

Internal Rank – Select a default priority for the purpose of scheduling work orders for internal 
equipment unplanned maintenance.

External Rank – Select a default priority for the purpose of scheduling work orders for external 
equipment unplanned maintenance.

4 In the Customer Order Default status area, select one of the following options:

Release – Release(d) customer orders are orders on which you are ready to begin work. 

Firm – Firm customer orders are orders existing more for planning purposes. Though they are 
“real” customer orders and exist in the database, the Concurrent Scheduler does not schedule 
them as it does released work orders. Scheduler and planners use the Firm designation as a kind 
of place holder.

5 Click the Ok button to commit information.

Note: Until you specify a default internal and external engineering master, you cannot process 
work orders in the Unplanned Maintenance Window. The message, “Default Engineering Master 
is Invalid” is returned.
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Searching for Unplanned Maintenance Calls
The Unplanned Maintenance Window features full search capabilities. Customer service 
representatives will find the search feature particularly convenient, as they can fully search a 
potentially huge database to retrieve a specific subset of calls. For example, if you know that a call 
has a specific escalation code—one typically not used—and you want to view a list of calls with that 
particular escalation code, you can conduct a search to include only those calls with that escalation 
code. You will use the feature more as the volume of data increases in your database.

1 To search your database for calls, click the Search button on the main toolbar or select Search 
Calls from the Edit menu. 

2 See the chart on the next pages for more information on searching.

The Call ID search table contains the following columns:

Call ID – The ID of the UPM call.

Equip ID – The ID of the piece of equipment for which the UPM call has been entered.

Work Order Base ID – The ID of the work order for this UPM call. The naming of the work orders 
in the UPM window follows standard VISUAL protocol. After you have created a work order, you 
can view it in the Manufacturing Window, where you can manipulate it accordingly.

To search 
by... Enter... If nothing happens... What else you can do

Equipment 

Click the Equipment 
button and select the 
piece of Equipment, 
then click the Search 
button.

Specify a more defined 
search set and click the 
Search button again. 

If any work orders 
appear, click the View 
WO button to view a 
work order in the 
Manufacturing Window. 

Type 

Click the Type button 
and select the Type, 
then click the Search 
button. 

Specify a more defined 
search set and click the 
Search button again. 

If any work orders 
appear, click the View 
WO button to view a 
work order in the 
Manufacturing Window. 

Model 

Click the Model button 
and select the Model, 
then click the Search 
button. 

Specify a more defined 
search set and click the 
Search button again. 

If any work orders 
appear, click the View 
WO button to view a 
work order in the 
Manufacturing Window. 

Status 

Click the Status arrow 
and select the Status, 
then click the Search 
button.

Status is an automatic 
selection. You cannot 
clear this field. 

If any work orders 
appear, click the View 
WO button to view a 
work order in the 
Manufacturing Window. 
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Customer ID – The ID of the customer for whom the UPM call has been entered. Customer/
Equipment associations are obtained from the Equipment Maintenance window, where you have 
already assigned a customer to a piece of equipment.

Status – The status of the UPM call. Cancelled/Void if the UPM call has been cancelled or 
voided; Closed, if the UPM call is closed, work is complete; CO Created if a customer order has 
bee completed for the UPM call; Entered is the UPM call has been entered into the database. 
This is the default. Invoiced if the UPM call has been invoiced and you are ready to receive a 
payment or voucher on it; WO Created if a work order has been successfully created for the UPM 
call. 

Call Date – The date on which you entered the call.

Fault Type 

Click the Fault Type 
Button and select the 
Fault Type, then click 
the Search button.

Specify a more defined 
search set and click the 
Search button again. 

If any work orders 
appear, click the View 
WO button to view a 
work order in the 
Manufacturing Window. 

Fault  

Code Click the Fault 
Code Button and select 
the Fault Code, then 
click the Search button.

Specify a more defined 
search set and click the 
Search button again. 

If any work orders 
appear, click the View 
WO button to view a 
work order in the 
Manufacturing Window. 

Area 

Click the Area Button 
and select the Area, 
then click the Search 
button.

Specify a more defined 
search set and click the 
Search button again. 

If any work orders 
appear, click the View 
WO button to view a 
work order in the 
Manufacturing Window. 

Branch 

Click the Branch Button 
and select the Branch, 
then click the Search 
button.

Specify a more defined 
search set and click the 
Search button again. 

If any work orders 
appear, click the View 
WO button to view a 
work order in the 
Manufacturing Window. 

Urgency 

Click the Urgency 
Button and select the 
Urgency Cod, then click 
the Search button.

Specify a more defined 
search set and click the 
Search button again. 

If any work orders 
appear, click the View 
WO button to view a 
work order in the 
Manufacturing Window. 

Escalation 

Click the Escalation 
Button and select the 
Escalation cod, then 
click the Search button.

Specify a more defined 
search set and click the 
Search button again. 

 If any work orders 
appear, click the View 
WO button to view a 
work order in the 
Manufacturing Window. 

To search 
by... Enter... If nothing happens... What else you can do
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3 From the View By section, select the appropriate option button to view the results of your search 
by Call ID, Equipment ID, WO base ID, Status, or Call Date.

4 Click the Clear button to clear the output table window and conduct a new search.
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Entering Unplanned Maintenance Calls
After entering UPM information to the database, you can now generate and process maintenance 
calls for customers. You must assign a unique identification number to each unplanned maintenance 
call. If you established auto-numbering preferences for call numbers, the next number is generated.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site in which you are 
entering the call. If you are licensed to use a single site, this field is unavailable.

2 If you want to modify or view an existing call, click the Call ID button.

For new calls, enter a unique ID in the data field.

The Call Date defaults to the current system date and is not editable.

3 Click the Equipment button to select the piece of equipment for which you are generating the call. 
You cannot enter a new Equipment ID in this field. Enter equipment information using the 
Equipment Maintenance window, the companion window to the Unplanned Maintenance window.

After selecting a piece of equipment, many of the data fields throughout the Unplanned 
Maintenance Window are auto-filled, including Customer ID. For the most part, you cannot edit 
equipment information in the Unplanned Maintenance window. To edit equipment information, use 
the Equipment Maintenance window.

4 Specify the following information in the Call Status section:

Status – The status of the call. It’s a good idea to accept the default of Entered. If you create a 
work order or customer order for the UPM call, the status changes automatically. Or, you can 
select,

Cancelled/Void if the UPM call has been cancelled or voided; Closed, if the UPM call is closed 
and work is complete; CO Created if a customer order has been created for the UPM call; 
Entered if the UPM call has been entered into the database. This is the default. Invoiced if the 
UPM call has been invoiced and you are ready to receive a payment or voucher on it; WO 
Created if a work order has been successfully created for the UPM call.

Closed Date – The date on which the UPM call closed, if it is in fact closed. Click the calendar 
button to change the Closed date if necessary.

Urgency – Click the Urgency button to select an urgency code for the UPM call.

Escalation – Click the Escalation button to select an escalation code for the UPM call.

5 Enter necessary fault information in the Fault Data section. If you know the code you want to 
assign, select a Fault Code first and the Fault Type defaults to the fault type defined in the code.

Fault Type – Click the Fault Type button to select a fault type for the UPM call. You must select 
at least a fault type for each UPM call. If you select a fault code for which a call(s) exists with 
same fault type/code, you are presented with a dialog box, asking if you want to view a list of 
those calls. Click Yes or No as appropriate.

Fault Code – Click the Fault Code button to select a fault code for the UPM call. Because fault 
codes consist of a Code ID and a Fault Type, if you’ve already selected a fault type, the fault 
codes you can select from are limited to those codes in which the selected fault type is a 
component.
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6 If applicable, enter necessary remedy information in the Remedy Data section. If you know the 
code you want to assign, select a Remedy Code first and the Remedy Type defaults to the 
remedy type defined in the code.

Remedy Type – Click the Remedy Type button to select a remedy type for the UPM call. You 
must select at least a remedy type for each UPM call. If you select a remedy code for which a 
call(s) exists with same remedy type/code, you are presented with a dialog box, asking if you 
want to view a list of those calls. Click Yes or No as appropriate.

Remedy Code – Click the Remedy Code button to select a remedy code for the UPM call. 
Because remedy codes consist of a Code ID and a Remedy Type. If you’ve already selected a 
remedy type, the remedy codes you can select from are limited to those codes in which the 
selected remedy type is a component.

7 View and verify equipment details in the Equipment Details tab. The Equipment Details tab has 
the default position in the Unplanned Maintenance window. After selecting a piece of equipment, 
many of the fields in the Equipment Details tab are auto-filled with the equipment’s default 
information.

Customer ID – The customer associated to the piece of equipment from Equipment 
Maintenance. Each equipment profile must have a Customer ID. 

Part ID – The part master associated with the equipment from the Equipment Maintenance 
window. When you process a work order for a UPM call, if the piece of equipment has a Part ID 
associated to it, the work order is created with a header card for this material. There may not be a 
value in this read-only data field; only if you’ve associated a Part ID to a piece of equipment will 
an ID appear. Because it is not a required field in Equipment Maintenance, this field may be 
empty.

Mfg WO – The Work Order ID you have associated to the piece of equipment from Equipment 
Maintenance. Because it is not a required field in Equipment Maintenance, this field may be 
empty.

Serial Number – If there is one, the serial number for the equipment from Equipment 
Maintenance.

Mfg Date – The date of manufacture of the equipment from Equipment Maintenance.

Type – The equipment type from Equipment Maintenance.

Model – The equipment model from Equipment Maintenance.

Area – The area where maintenance in performed on the equipment. 

Branch – The branch where maintenance in performed on the equipment. 

Internal – The Internal option button is selected if the equipment is an internal piece of 
equipment.

External – The External option button is selected if the equipment is an external piece of 
equipment.

If there is a picture of the equipment, click the Picture button on the main toolbar. 

8 Click the Equipment Maintenance tab to view and verify more equipment information.

Maintenance ID – The Maintenance ID of the equipment from Equipment Maintenance.

Machine ID – The Machine ID of the equipment from Equipment Maintenance.
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Class – The equipment class from Equipment Maintenance: Labor Only, None, Parts and 
Labor, and Parts Only.

Contract No – The Contract number from Equipment Maintenance.

Date From/To – The starting ending date of coverage on the equipment. This is from Equipment 
Maintenance.

Hours From/To – The starting and ending hours during the days within the coverage period. This 
is from Equipment Maintenance.

Period (Months) – The period of coverage on the equipment. This is from Equipment 
Maintenance.

9 Click the Work Order Details tab and specify engineering information before you create the work 
order for the UPM call.

10 If you want to create a new work order for the current call, enter a unique ID in the WO Base ID 
data field. If you want to select an existing work order (doing so allows you to view the order in the 
Manufacturing Window by clicking the WO Base ID button again, after the WO Base ID appears), 
click the WO Base ID button and select the work order from the service calls table. Only work 
orders created using the Unplanned Maintenance window appear in the service calls table.

If you enter a unique ID, you are asked if you want to create the new work order after you tab out 
of the field, regardless of there being enough work order detail to save the work order. If you are 
using auto-numbering, let the next available number be selected for you.

If you choose to create the work order without having entered all of the required information, you 
are prompted to choose more work order settings. Continue to enter at least the required 
information. At any time, you can process a work order by clicking the Process WO button on the 
main toolbar. If required fields are still empty, you are prompted for the information that is missing.

The default engineering masters used to generate work orders are displayed at the bottom of the 
tab. You can specify the default engineering masters in the Preferences dialog box, or you can 
click the browse buttons and specify the default engineering masters directly on the W/O Details 
tab.

11 Enter a task time in hours for the work order. Task time is an estimation of how long it will take you 
to complete the task. This is a required field; only number values are valid.

12 Enter a travel time in hours for the UPM call. Travel time is how long it takes you to arrive at an 
external location to complete a UPM call. This is not a required field.

13 If different than the displaying date, select a new Requested Date by clicking the calendar icon or 
manually entering a date. 

A requested date is the date on which the service call work order was requested. The requested 
date defaults to your current system date. This is a required field. After processing the work order, 
you cannot edit this field.

If different than the displaying date, select a new Confirmed Date by clicking the calendar icon or 
manually entering a date. A confirmed date is the date on which the service call work order was 
confirmed. The confirmed date defaults to your current system date. This is a required field. After 
processing the work order, you cannot edit this field.

14 Select an Engineer ID for the work order by clicking the Engineer ID button. 
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If the equipment has a default Engineer ID, this field is auto-filled when you select an Equipment 
ID. To select a different Engineer ID, click the Engineer ID button.

The equipment Type, Model, Area, and Branch appear in the fields at the top of the dialog box. 
Click any of the buttons to view a searchable table of all current Types, Models, Area, and 
Branches. Fault Type and Fault Code do not appear unless you have already selected a type and 
code for the current work order. You can click the Fault Type and Fault Code button to view a 
searchable table of all current fault types and fault codes.

15 If no Engineer IDs appear in the table, click the Search button to view all eligible IDs.

Highlight a line and click Ok or double-click the line. The dialog box closes and you are returned 
to the Unplanned Maintenance window.

16 If the repair is standard, click the Std Repair button. 

A UPM Standard Repair searchable table appears. Select the appropriate standard repair. Before 
you can select a standard repair, you must enter standard repair types.

17 If you want to view all occurrences of the Engineer ID in an existing schedule, select a Schedule 
ID from the list box and click the View Schedule button.

The system displays a table containing all work orders in the selected schedule that use the 
Resource ID.

If you want to view a work order in the Manufacturing Window, from the Info menu select View 
Selected Work Order or press the SHIFT+F9 keys.

18 You can now process the work order even though you may choose to enter more information.

If so, read the following sections for more on specifying information not necessary to the work 
order, but useful in the interest of maintaining a complete and well-ordered database.

19 Click the Save button on the main toolbar to process the work order and save the UPM call.

You can also click the Process Workorder button to process the work order. Continue reading for 
more on specifying address, contact and billing information.

20 Click the Address tab.

The default address of the customer for whom you are entering this UPM call displays in the field. 
This address is from Customer Maintenance.

Click the Address button on the main toolbar to select a different customer address.

The Addresses–(Current Customer) dialog box appears.

21 Either double-click an address or highlight a line and click the Ok button. Click the Use Default 
button to revert to the customer’s default address.

The customer address appears in the Address tab.

22 Click the Contact tab and specify the contact for this unplanned maintenance entry. By default, 
the primary contact information for the customer is displayed. You can specify a different contact. 
You can select a contact with an ID or enter a standalone contact for this transaction only.

• To select a contact with a registered Contact ID, use one of these methods:
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Select an alternate contact - Click the Contact browse button and select a contact from the 
browse table showing contacts assigned to the customer. Select the Use Selected Contact 
toolbar button.

Select a contact from all contacts - Click the Contact browse button and then click the 
Associate existing contact toolbar button. Select a contact from the Contacts dialog and 
click Ok. In the Contacts for Customer dialog select the contact and then click the Use 
Selected Contact toolbar button.

Specify a new contact in the Contacts for Customer dialog - Click the Contact browse 
button. Click the Add New Contact button and specify contact information in the General tab 
and Address tab fields. Click the Save toolbar button.

You can also assign contacts to customers in the Contact Maintenance window.

• To specify a standalone contact, specify the contact information in the fields on the Contact
tab. If contact information is already displayed in the tab, you can edit the existing information
to create a standalone contact. When you edit the information, the Contact ID field is cleared.
The edits that you make in the Contact tab do not update contact information in your Contact
table. Standalone contact information is saved with the transaction only and is not added to
your Contacts table. If you anticipate using this standalone contact again, Infor recommends
creating a contact with a Contact ID. 

Specify this information:

Contact ID/Name – Enter the contact’s full name and review the ID number. A contact without 
an ID number does not display in Contact Maintenance. A contact is someone within the 
customer organization with whom you would communicate the details of a maintenance 
operation.

Position – Enter the contact’s position. For example, CEO.

Salutation – Enter the salutation to use for this vendor contact. This field has a drop-down 
menu populated with some of the most popular salutations.

Phone/Ext – Enter the telephone number, with area code and extension, for the contact. This 
may be a direct line to the contact, or a generic company line.

Fax – Enter the area code and Fax number.

Mobile – Enter the contact’s area code and mobile phone number.

E-Mail – Enter the appropriate vendor E-mail address.

Note: Standalone contacts are not added to the Email Documents list for the vendor. Only contacts 
with IDs can be added to the Email Documents list. 

If you do not want to assign a contact to this order, click the Use No contact toolbar button.

23 Click the Billing tab to enter customer order and invoice information for a work order. For every 
work order, you have the option of creating a customer order and an invoice. After (or before) 
processing a work order, enter a Customer Order ID and an Invoice ID. When the order has been 
created, use the Billing function of the Unplanned Maintenance window to generate a customer 
order and/or an invoice.
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Processing Unplanned Maintenance Information to 
Create Work Orders
After entering required UPM call information, you can create a work order for the unplanned 
maintenance call. The work orders you create in the Unplanned Maintenance window are valid work 
orders you can view in the Manufacturing Window, and then modify as necessary.

When you are ready to create the new work order, click the Process WO button on the main toolbar.

Also, you can click the Save button on the main toolbar to process the work order and then saves the 
UPM call to the database in the UNP_MNT_CALLS table.

After UPM call information has been processed, a message is displayed to inform you that the task 
was successful.

After the work order has been processed, the status changes to WO Created.



Printing Unplanned Maintenance Reports

Infor VISUAL Inventory User’s Guide | 16 – 19

Printing Unplanned Maintenance Reports
You can print call reports and work order travellers using the Unplanned Maintenance window.

Printing Individual Calls
You can print a report of calls, one at a time.

1 From the File menu, select Print Call Detail or click the Print button on the main toolbar.

2 If you know the ID of the call you want to print, enter the Call ID in the Call ID data field.

If you want to search for the Call ID, click the Call ID button to view a table containing all Call IDs 
in the database.

3 Select how you want to output the report:

Print – Select Print if you want the report printed. After clicking Ok, you can specify print 
preferences and begin printing.

View – Select View if you want to view the report. After clicking the Ok button, the Centura Report 
Builder opens and the report displays.

File – Select File if you want to save the report to file. After clicking Ok, you are allowed to name 
the file; the file is then saved in the directory where your executables are installed.

E-mail – Select E-mail if you want to send the report through electronic mail. Select the PDF 
Format check box to email the report as a PDF. Clear the check box to send the report in Rich 
Text Format (.RTF). When you generate the report the system attaches the file to a Microsoft 
Outlook e-mail. For more information on addressing and sending the e-mail, refer to your 
Microsoft Outlook user documentation.

4 Click the Print Setup button to specify which printer you want used when printing Unplanned 
Maintenance reports.

5 Click the Ok button to begin the printing process.

6 Click the Cancel button to return to the Unplanned Maintenance window.

Printing Work Order Travellers 
From the Unplanned Maintenance Window, you can print Work Order Travellers for the work orders 
you’re creating for UPM calls. For more information, refer to the “Work Order Travellers” chapter in 
this guide.
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Printing Call Lists
Use the Call Lists report to view information about calls from a period of time you specify. You can 
print a report by date range, urgency code, or escalation code.

1 From the File menu, select Print Call List.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the sites to include in 
the report. If you are licensed to use a single site, this field is unavailable. 

3 Specify a date range for the report by clicking the calendar buttons or manually entering a date 
range.

4 Select a Report by option button. Choices include customer, engineer, area, equipment, call, 
date, and site. The report is sequenced according to this setting. 

5 Narrow the scope of the report more by choosing the appropriate Select Only options. You can 
select specific components of existing calls, and a call report can be compiled that exclusively 
includes only calls with, for example, a specific urgency code, escalation code, or any of the other 
possible selections.

Equip ID – Click the Equip ID button to select a piece of equipment. The report is compiled with 
calls for this piece of equipment only. 

Type – Click the Type button to select a type of equipment. The report is compiled with calls with 
this type of equipment only.

Model – Click the Model button to select a model. When you select a model, the Type field is 
auto-filled as well. The report compiles with calls with this model and type of equipment only.

Fault Type – Click the Fault Type button to select a fault type.The report compiles with calls with 
this fault type only.

Fault Code – Click the Fault Code button to select a fault code. The report compiles with calls 
with this fault code only.

Status – From the list box, select a status. The report compiles with calls with this status only.

Urgency – Click the Urgency button to select an urgency code. The report compiles with calls 
with this urgency code only.

Escalation – Click the Escalation button to select an escalation code. The report compiles with 
calls with this escalation code only.

Engineer – Click the Engineer button to select an engineer (resource). The report compiles with 
calls with this engineer (resource) only.

6 Select how you want to output the report:

Print – Select Print if you want the report printed. After clicking Ok, you can specify print 
preferences and begin printing.

View – Select View if you want to view the report. After clicking the Ok button, the Centura Report 
Builder opens and the report is displayed.

File – Select File if you want to save the report to file. After clicking Ok, you can name the file; 
then the file saves in the directory where your executables are installed.
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E-mail – Select E-mail if you want to send the report through electronic mail in a Rich Text Format 
(.RTF). When you generate the report the system attaches the file to a Microsoft Outlook e-mail. 
For more information on addressing and sending the e-mail, refer to your Microsoft Outlook user 
documentation.

7 Click the Print Setup button to specify which printer you used when printing Unplanned 
Maintenance reports.

8 Click the Ok button to begin the printing process.

9 Click the Cancel button to return to the Unplanned Maintenance window.
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What is Drum-Buffer-Rope and Easy Lean?
Drum-Buffer-Rope (DBR) is a production planning technique inspired by the Theory of Constraints 
(TOC) business management philosophy developed by Dr. Eli Goldratt, author of The Goal. It 
enables companies to dependably deliver on time and improve flow through the shop floor while 
safely minimizing lead-time and work-in-process. This planning process maximizes the use of a 
Capacity Constrained Resource (CCR) and uses time buffers to create schedules that deliver 
products on time to the degree possible with available resources and materials.

Buffer Management (BM) is the execution technique companion to DBR. This technique results in 
minimal expediting as it alerts the user to flow blockages that otherwise would threaten the ability to 
maximize the utilization of the CCR or otherwise put the due date in jeopardy. 

VISUAL DBR™ programs deliver both DBR and BM capabilities that become an embedded, holistic 
part of the system. 

Easy Lean is also designed to produce just enough supply to meet demand. In an Easy Lean 
environment, none of the resources are capacity constrained. No CCR exists.

Operating in a DBR or Easy Lean Environment
When you are licensed to use DBR, the DBR scheduler creates work orders and planned purchase 
orders for you. If you use DBR, you should not create work orders manually. You should let the DBR 
scheduler create work order when it finds demand.

Similarly, you do not have to enter purchase orders manually. The DBR scheduler creates planned 
purchase orders if it finds demand for purchased parts. You can use the Material Planning Window to 
release these planned orders, and then process the purchase order as you would any other purchase 
order.

If you are licensed to use DBR, you should NOT use the Concurrent Scheduler. You should only use 
the DBR scheduler.

Key Concepts
The capacity constrained resource, buffers, and part replenishment levels all interact to make sure 
you are delivering products to customers on time.

Capacity Constrained Resource (CCR)
A capacity constrained resource is a resource that you plan to use as close to 100% as possible. 
Though a few companies may have more than one CCR, typically there is only one. To protect the 
CCR, create buffers.
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Time Buffers

CCR Buffer
A CCR buffer is a generous allowance of time for work to reach the CCR after you have issued 
material to a work order.

The time to actually perform the work that must be done prior to the CCR operation is usually quite 
small when compared to the CCR buffer time. The purpose of the CCR buffer is to protect the CCR 
from being starved for work.

Shipping Buffer
For a work order that uses the CCR, the shipping buffer is a generous allowance of the time to 
perform the operations subsequent to the CCR, after you have completed the work at the CCR.

The time to actually perform the work that must be done subsequent to the CCR operation is usually 
quite small when compared to the shipping buffer time.

For work orders that do not use the CCR, the shipping buffer represents a generous allowance of 
time for all work to be done once you have issued material to a work order. Because you produce 
these work orders free of the constraint resource, these work orders are sometimes called "Free 
Orders." The time for you to actually perform all of the work that must be done on "Free orders" is 
usually quite small when compared to the shipping buffer time.

The purpose of the shipping buffer is to protect you against missing the due dates to your customers.

Assembly Buffer
For multilevel work orders, where one or more legs do not go through the CCR but are assembled 
with another leg that does go through the CCR (at a point downstream from the CCR operation), the 
assembly buffer is a generous allowance of time for work to reach the point where it joins up with a 
CCR leg once you have issued the material to the non-CCR leg.

The purpose of the assembly buffer is to protect the shipping buffer from being consumed by 
"Murphy" events along the non-CCR legs. Material release dates are calculated for non-CCR leg 
materials by subtracting both the shipping buffer time and the assembly buffer time from the 
customer's due date.

Rods
When a work order has two or more CCR operations that you must perform sequentially, it is 
necessary to provide protection to the CCR for each of the affected operations. The Rod is a 
generous allowance of time for you to perform work between the two CCR operations.
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Leadtime Buffer
For stocked materials that you purchase, the leadtime buffer is a generous allowance of time to 
comfortably obtain more materials (including time to place the purchase order). The leadtime buffer is 
one manufacturing cycle.

Minimum Lead-time
For stocked materials that are purchased the minimum leadtime buffer is the shortest time in which 
you could obtain more.

User-defined Buffers
For made-to-order parts (not stocked), user-defined buffers provide extra buffer protection to either a 
particular operation or to a particular leg. You can specify these buffers on engineering masters or on 
individual work orders.

Stocked Part Replenishment Levels
For stocked materials, whether you purchase them or make them, when your on hand quantity plus 
your on order quantity reaches a level less than your replenishment level quantity, it is time to place a 
replenishment order. This replenishment level is a buffer for the stocked part. 

Buffer Zones
Buffer zones indicate that a certain percentage of the buffer has been consumed. You can use this 
information to analyze whether your buffers are too small or too large.

These zones are used: Green, Yellow, and Red. For time buffers, the Black zone is also used. The 
Black zone indicates that all of the red zone has been consumed. When you enter the Black zone, 
you have used all of the buffer time.
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Setting Up
Before you begin using DBR and Easy Lean features, set up default settings. 

Use Site Maintenance to specify DBR settings for each site. You can grant permission to the 
scheduler to delete work orders if demand no longer exists, allocate supply to later demand, and 
choose to plan independently planned warehouses separately. You can also set the percentage to 
use to analyze which of your resources are constrained.

If you are licensed to use multiple sites, specify these settings for each of your sites.

To specify DBR site settings:

1 Select Admin, Site Maintenance.

2 Specify this information:

Entity ID – Specify the ID of the parent entity for the site.

Site ID – Specify the ID of the site.

3 Click the Scheduling tab. In addition to the standard scheduling information, specify this 
information for DBR:

Allow DBR to Delete Work Orders – After you run the DBR scheduler, existing work orders may 
have no demand associated with them. Use this check box to determine what to do with these 
work orders. To delete the work orders, select this check box. To change the status of the work 
orders to Unreleased, clear this check box. You can then manually delete the unreleased work 
orders. 

Allocate Supply to Later Demand – If work orders have unallocated supply, use this check box 
to determine how to use the unallocated supply. To use unallocated supply for future demand 
only, select this check box. Any unallocated supply is used to supply demand with a due date later 
than the work order due date. If you select this check box, you cannot use unallocated supply to 
meet demand with a due date earlier than the work order due date. 

To use unallocated supply for demand with due dates earlier than the supply work order dates, 
clear this check box. If you clear this check box, the work order due date and quantity is adjusted 
to meet the earlier demand. Work orders are adjusted only if they have not been printed and they 
have not been started. For demand with due dates later than the existing work order due dates, 
new work orders are created to meet the demand.

Plan by Warehouse – Select this check box to plan independently planned warehouses 
separately from your universally planned warehouses. When you select this check box, 
production schedules and material requirements for each independently planned warehouse are 
determined individually. Designate warehouses as independently planned in Warehouse 
Maintenance. If you select this option, use Part Maintenance to set up planning parameters for 
parts in each independently planned warehouse.

Clear this check box to plan all warehouses in aggregate, regardless if a warehouse is designated 
as independently planned.

Identify Resource with % Planned Load as CCR – Specify the percentage of load to use to 
identify a resource as a capacity constrained resource. This value is used when you identify 
CCRs in Buffer Management. Resources with planned loads equal to or exceeding the 
percentage you specify are identified as CCRs.
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4 Click the Save button.

Setting Up Independently Planned Warehouses
If you selected the Plan by Warehouse check box in Site Maintenance, then individual warehouses 
can be planned independently during DBR scheduling. If a warehouse is independently planned, 
supply from the warehouse can only be used to meet demand on the warehouse inventory. Demand 
on the warehouse inventory can only be met by supply in the warehouse. You must specify which of 
your warehouses are independently planned. 

All warehouses not designated as independently planned are universally planned warehouses. When 
demand is made on a particular universal warehouse, supply from other universal warehouses can be 
used to meet the demand. 

To set up an independently planned warehouse:

1 Select Inventory, Warehouse Maintenance.

2 Specify this information:

Site ID – If you are licensed to use multiple sites, specify the site where this warehouse resides. If 
you are licensed to use a single site, this field is unavailable.

Warehouse ID – Specify the ID of the warehouse to designate as independently planned.

Independently Planned – Select this check box.

3 Complete the warehouse record. See “Warehouse Maintenance” on page 4-1 in the Inventory 
guide.

4 Click the Save button.
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Parts in a DBR/Easy Lean Environment
If you are licensed to use DBR, use Part Maintenance to set up planning information for your parts. 

Set up most of this information on the DBR tab. The options available to you on the DBR tab vary 
depending on whether or not the part is stocked. A stocked part is a part that you typically have on 
hand in your inventory. To designate a stocked part, select the Stocked check box in the part header. 
Stocked parts can be spare parts. If you do not typically keep a supply of the part in your inventory, 
clear the Stocked check box. A non-stocked part can still be stored in your inventory, and you do 
need to specify warehouse locations for a non-stocked part. Non-stocked parts are typically 
purchased specifically for a particular work order.

The buffers that apply to parts depend on whether they are stocked or not stocked. A stocked part 
uses replenishment buffers that you can use to manage the number of units in your inventory. 
Stocked parts also use lead-time buffers that indicate how long it takes to acquire the part. A non-
stocked part uses time buffers only. On the part record, you can specify the lead-time buffer for the 
non-stocked part. On engineering masters and work orders, you can specify an additional user-
defined buffer for your non-stocked parts. 

If you plan by independently planned warehouse and have selected the Plan by Warehouse check 
box in Site Maintenance, you can set up part information in Part Maintenance for each of your 
independently planned warehouses.

Setting Up Stocked Parts
Refer to the Part Maintenance chapter in the Inventory guide for information on how to create a new 
part. To set up planning information for stocked parts:

1 Select Inventory, Part Maintenance.

2 Click the Part ID browse button and select a stocked part. 

3 Click the DBR tab.

4 Specify this information:

Planner User ID – Specify the person responsible for material planning for this Part ID. 
Depending on your settings in Warehouse Maintenance, a planner may be responsible for 
transferring this part to other warehouses in Inventory Transaction Entry. You can also sort certain 
material reports by planner ID. 

Buyer User ID – If this part is a purchased part, specify the person responsible for buying this 
Part ID. For purchased parts, buyers are responsible for acquiring the part. You can use buyer IDs 
on purchase requisitions and purchase orders.

Demand Horizon (in days) – Specify the default demand horizon. The scheduler uses the 
demand horizon you specify to search for demand orders. For example, if you specify 60 in this 
field, the scheduler looks for demand for the part from the current date to 60 days in the future.

Min/Max Order Qty – Specify the minimum and maximum suggested order quantity when placing 
a planned order. When the DBR scheduler creates a planned order for this part, the quantity 
ordered is not less than the minimum quantity or more than the maximum quantity. For example, 
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if you had demand for 50 of this part and the maximum order quantity is 25, the DBR scheduler 
plans two orders of 25 to meet the demand. If you had demand for 3 of this part and the minimum 
order is 5, then the DBR scheduler plans an order for a quantity of 5. 

Multiples Of – If you order this part in certain multiples, specify the multiple in this field. For 
example, if you specify 6 in this field, you order this part in multiples of 6, such as 12, 18, and so 
on. If you had demand for 8 of this part, the DBR scheduler would plan an order for a quantity of 
12.

ADU Horizon (in days) – If you plan part replenishment using average daily usage, specify the 
horizon to use in this field. When the system determines your average daily usage, the number 
you specify here is the number of days the system uses to assess demand. For example, if you 
specify 60 in this field, the system analyzes usage for the previous 60 days when it calculates 
average daily usage.

Leadtime Buffer (in hours) – Specify the default amount of time required to supply this part. For 
a fabricated part, this value is the time it takes to complete one manufacturing cycle. For a 
purchased part, this value is the time it takes to acquire the part from a vendor.To specify one day, 
enter 24.

Minimum Leadtime (in hours) – Specify the minimum lead-time in hours to use when you are 
purchasing this part in an expedited mode. To specify one day, enter 24.

Replenishment Level – To manually specify the replenishment level for this part, specify a value 
in this field. The value you specify in this field triggers new orders for this part. The value you 
specify should provide enough supply for one leadtime buffer cycle. For example, if you specified 
48 in the Leadtime Buffer field, then you would specify the number of parts needed to meet two 
days worth of demand.

When the quantity on hand plus the quantity on order for this part falls below the figure you 
specify in this field, a new order is generated when you run the DBR scheduler. For purchased 
parts, a new planned order is created. For fabricated parts, a new replenishment work order is 
generated.

The replenishment level can be calculated for you. To calculate this value based on actual usage 
over the leadtime buffer, use the Replenishment Buffer Analysis dialog box. To calculate this 
value based on average daily usage and the part’s usage characteristics, use the Demand-driven 
Replenishment Buffer Analysis dialog box. See "Determining Replenishment Levels for Stocked 
Parts" on page 17–9 in this guide.

If your replenishment levels fluctuate over time, use the Replenishment Level Effective Dates 
dialog box. See "Setting Up Replenishment Level Effective Dates" on page 17–28 in this guide.

Emergency Stock % – Specify the percentage of the replenishment level that triggers a high-
priority order to be generated. For example, if your replenishment level is 5 and you specified 60 
percent in this field, a high-priority work order would be generated by the DBR scheduler if you 
had 3 parts in inventory. If the supply order is a purchase order, choose a vendor with a short lead 
time to supply emergency orders.

When the quantity of a part is below the emergency stock percentage, the part is in the Red Zone 
of its inventory buffer.

Yellow Zone Stock % – Specify the percentage of the replenishment level that triggers the DBR 
scheduler to recognize demand. For example, if your replenishment level is 5 and you specified 
80 percent in this field, a work order would be generated if you had 4 parts in inventory. 
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On-hand Alert Emergency % – Specify the percentage of the replenishment level that triggers 
an alert. 

5 Click the Save button.

Determining Replenishment Levels for Stocked Parts
You can determine replenishment levels for stocked parts based on the inventory issue history for the 
part (actual usage). To examine actual usage over a particular number of lead-time buffers, use the 
Replenishment Buffer Analysis dialog box. To examine average daily usage over a particular period 
of time, use the Demand-driven Buffer Analysis dialog box.

In the Replenishment Buffer Analysis dialog, you analyze the usage of a part during the leadtime 
buffer specified for the part. You can examine usage during a single leadtime buffer or multiple 
leadtime buffers. The average number of parts issued during the lead-time buffer is used as the 
replenishment level.

In the Demand-driven Buffer Analysis dialog, you analyze the average daily usage of the part over a 
period of time you specify. If you use this tool, set up a buffer profile to categorize the part’s usage 
patterns; for example, the volatility of supply and demand. The average daily usage is used with the 
buffer profile to calculate the replenishment level, the part’s red zone, and the part’s green zone.

In addition to these dialog boxes, you can also use the Part Replenishment Level Effective Dates 
dialog box to specify effective dates for replenishment levels. If supply or demand for a part fluctuates 
seasonally, you can use this dialog box to manually specify replenishment levels and the time periods 
the replenishment levels should be used.

Setting Up Buffer Profiles
Use Buffer Profiles to group parts with similar buffer characteristics together. For example, you could 
create a buffer profile for purchased parts with high demand variability and a medium amount of lead 
time. Or, you could create a buffer profile for fabricated parts with low demand variability and a high 
amount of lead time. The parts you assign to the buffer profile share the characteristics of the profile. 
The parts are not necessarily related to each other on a bill of a material, nor or they necessarily in 
the same product or commodity family. The parts you assign to a buffer profile share similar demand 
and supply patterns.

After you set up buffer profiles and assign them to parts, you can use the parameters you set up in the 
buffer profile in conjunction with the actual demand and supply for the parts to establish new 
replenishment levels for the parts. 

Buffer profiles are primarily used with parts that are planned based on average daily usage.

If you are licensed to use multiple sites, you can assign a buffer profile to a part at the tenant level. 
When you assign a buffer profile at the tenant level, the profile applies to the part in all entities and 
sites. You can also assign a buffer profile at the site level. If you plan by independently planned 
warehouses, you can assign a buffer profile at the warehouse level.

To create a buffer profile:
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1 Select Inventory, Part Maintenance.

2 Select Maintain, Buffer Profiles.

3 Specify this information:

Profile ID – Specify the ID to use to identify this buffer profile.

Description – Specify a description of the buffer profile.

Item Type – Specify the type of parts in this buffer profile. Select either Fabricated or Purchased.

Variability Category – Specify the variability in demand of parts in this profile. Select one of these 
options: High, Medium, or Low.

Lead-time Category – Specify the category for the amount of lead time parts in this profile 
require. Select one of these options: Long, Medium, or Short.

After you specify the Item Type, Variability Category, and Lead-time Category, the Profile Code 
and Profile Code Description are inserted. The Profile Code is the first letter of the selected Item 
Type, Variability Category, and Lead-time Category.

Use significant minimum order quantity for green zone – Use this check box to specify 
whether or not a part’s minimum order quantity should replace the part’s calculated green zone if 
the calculated green zone is less than the minimum order quantity. To replace the calculated 
green zone with the minimum order quantity when the minimum order quantity exceeds the 
calculated green zone, select this check box. The minimum order quantity will be used as the 
green zone. To use the calculated green zone even if it is less than the minimum order quantity for 
the part, clear this check box. 

Lead-time Green Impact % – Specify the lead-time green impact percentage to use for parts with 
this buffer profile. When you select a lead-time category, a recommended percentage range is 
displayed next to the field. When you generate replenishment levels and buffers using demand-
driven stocked part analysis, the lead-time green impact percentage is multiplied by the yellow 
zone to determine the size of the green zone.

Lead-time Red Impact % – Specify the lead-time red impact percentage to use for parts with this 
buffer profile. When you select a lead-time category, a recommended percentage range is 
displayed next to the field. When you generate replenishment levels and buffers using demand-
driven stocked part analysis, the lead-time red impact percentage is multiplied by the yellow zone 
to determine the size of the red zone base.

Variability Red Safety % – Specify the variability red safety percentage to use for parts with this 
buffer profile. When you select a variability category, a recommended percentage range is 
displayed next to the field. When you generate replenishment levels and buffers using demand-
driven stocked part analysis, the variability red safety percentage is multiplied by the red zone 
base to determine the size of the red zone safety.

On Hand Alert Red % – Specify the on hand alert red percentage to use for parts with this profile. 
When you generate replenishment levels and buffers using demand-driven stocked part analysis, 
the on hand alert red percentage is multiplied by the top of red to create the alert sub-zone.

4 Click Ok.
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Using Buffer Profiles to Assign Buffer and Horizon Information
Use the Buffer Profile Parts dialog box to assign buffer and horizon information to multiple parts at the 
same time. You can assign this information:

• Buffer Profile ID
• Lead-time Buffer
• Demand Horizon

Assigning a Buffer Profile ID to Multiple Parts
To assign a buffer profile ID to multiple parts:

1 Select Inventory, Part Maintenance.

2 Select Maintain, Buffer Profile IDs.

3 Click View Profile Parts.

4 In the Assign to Parts section, select Assign Buffer Profile.

5 Specify the parts to display in the table. Specify this information:

Site ID – Specify the site whose parts you want to display in the table.

Warehouse ID – This field is available only if the site you selected plans by independently 
planned warehouses. Specify the warehouse whose parts you want to display in the table. To 
display the parts in your universally planned warehouses, select Universal. If the site you selected 
does not plan by independently planned warehouses, then this field is unavailable.

Show Parts with Profile – To display only parts with no buffer profile ID assigned, clear this 
check box. to display all parts, clear this check box.

Fabricated/Purchase/All – Select the type of parts to display in the table. Click Fabricated to 
display fabricated parts only. Click Purchase to display purchased parts only. Click All to display 
parts of both types.

6 Select the information about the parts to view in the table. Specify these settings:

Show Changes Only – This check box is a available if you have edited any of the lines and have 
not yet saved your changes. To display only the lines you have edited, select this check box. To 
display all lines, clear this check box. 

Show Current Values – Selecting or clearing this check box has no impact on the information 
displayed in the table.

Show Zone Details – To display information about the red, yellow, and green zones, select this 
check box. When you select this check box, the current and new green zone size, the current and 
new top of red zone, the current and new red zone base, the current and new size of red safety, 
the current and new top of yellow, and the current and new yellow zone size are displayed.

Show Status Details – To display information about buffer statuses based on your current supply 
and demand, select this check box. When you select this check box, the quantity on hand, 
quantity in demand over horizon, quantity on order over horizon, current available buffer status, 
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current and new low red status, current and new low yellow status, current and new low alert 
status, current and new on-hand alert status level, and current on-hand alert red percentage are 
displayed.

7 Depending on your selections in the Display Options section, this information is displayed:

Part ID – The ID of the part is displayed.

Description – The description of the part is displayed.

Commodity Code – The commodity code specified for the part is displayed.

Product Code – The product code specified for this part is displayed.

Fab – If the part is a fabricated part, this check box is selected.

Pur – If the part is a purchased part, this check box is selected.

Current Demand Horizon – The current demand horizon specified for the part is displayed. 

Current Demand Horizon End Date – The end date of the range used to examine demand is 
displayed. This date is determined by adding the demand horizon to the current date. The 
demand horizon does not consider the work schedule. For example, if the current date is 6/15/
2013 and the demand horizon is 10, then the Demand Horizon End Date is 6/24/2013, or 10 days 
from 6/15/2013, inclusive.

ADU Horizon (in Days) – The average daily usage horizon specified for the part is displayed.

Current Leadtime Buffer (in days) – The lead time buffer you specified for the part in Part 
Maintenance is divided by 24 to determine the lead time buffer in days. 

Minimum Leadtime – The minimum leadtime specified for the part is displayed.

Current Replenishment Level = Top of Green – The current replenishment level specified for 
the part is displayed. This value is equal to the top of green value. The top of green should equal 
the sum of the green zone, the yellow zone, and the red zone.

Current Emergency Stock % – The current emergency stock percentage specified on the part 
record is displayed.

New Emergency Stock % – The new emergency stock percentage based on the profile you 
applied is displayed.

Current Yellow Stock % – The current yellow stock percentage specified on the part record is 
displayed.

New Yellow Stock % – The new yellow stock percentage based on the profile you applied is 
displayed.

Minimum Order Qty – The minimum order quantity specified for the part on the part record is 
displayed.

Multiple Order Qty – The multiple in which you purchase or manufacture this part is displayed. 
This information is specified on the part record.

Maximum Order Qty – The maximum order quantity specified for the part on the part record is 
displayed.

Curr. Green Zone Size – The current green zone is displayed. The current green zone is 
calculate by multiplying the green impact percentage by the current yellow zone.
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New Green Zone Size – The new green zone is calculated based on the profile you applied.

Curr. Top of Red = Red Zone Size – The current top of red, which is the same as the red zone 
size, is displayed. This formula is used to calculate the top of red size: current replenishment level 
- (current replenishment level * (100 – emergency stock percent)/100).

New Top of Red = Red Zone Size – The new top of red is calculated based on the profile you 
applied.

Curr Size of Red Zone Base – The current red zone base is displayed. This value is calculated 
by multiplying the red impact percentage by the current yellow zone.

New Size of Red Zone Base – The new red zone size is calculated based on the profile you 
applied.

Current Size of Red Safety – The current red safety size is displayed. This formula is used to 
calculate the current size of red safety: current top of red / (1 + (100 / variability red safety 
percent)).

New Size of Red Safety – The new size of red is calculated based on the profile you applied.

Current Top of Yellow – The current top of yellow is displayed. This formula is used to calculate 
the current top of yellow: current replenishment level – (current replenishment level * (100 – 
yellow stock percent) / 100).

New Top of Yellow – The new top of yellow is calculated based on the profile you applied.

Current Yellow Zone Size – The current yellow zone size is displayed. This formula is used to 
calculate the current yellow zone size: top of yellow – top of red.

New Yellow Zone Size – The new yellow zone size is calculated based on the profile you 
applied.

Current On-hand Buffer Status – The current on-hand buffer status is displayed. This formula is 
used to calculate the current on-hand buffer status: ((Replenishment level – on-hand quantity) / 
Replenishment level) * 100.

Quantity On Hand – The number of units currently in stock is displayed.

Quantity In Demand Over Horizon – The number of units of this part in demand during the 
demand horizon.

Quantity On Order Over Horizon – The number of units of this part on order during the demand 
horizon.

Current Avail. Buffer Status – The current available buffer status is displayed. This formula is 
used to calculate the current available buffer status: (replenishment level - (qty on-hand + qty on-
order - qty in-demand)) / replenishment level * 100.

Demand Horizon (in Days) – The demand horizon specified for this part is displayed.

Quantity On Hand – The number of units currently in stock is displayed.

Quantity In Demand Over Leadtime – The number of units of this part in demand during the 
demand horizon.

Quantity On Order Over Leadtime – The number of units of this part on order during the demand 
horizon.
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Current Avail. Buffer Status – The current available buffer status is displayed. This formula is 
used to calculate the current available buffer status: (replenishment level - (qty on-hand + qty on-
order - qty in-demand)) / replenishment level * 100.

Current Low Red Status – The current lowest buffer status value that is in the red zone is 
displayed. 

New Low Red Status – The new lowest buffer status value that is in the red zone is displayed. 

Current Low Yellow Status – The lowest buffer status value that is in the yellow zone is 
displayed. 

New Low Yellow Status – The new lowest buffer status value that is in the yellow zone is 
displayed.

Current Low Alert Status – The lowest buffer status value that triggers an alert is displayed. 

New Low Alert Status – The new lowest buffer status value that triggers an alert is displayed.

Current On-hand Alert Level – The current on-hand alert level is displayed. This formula is used 
to calculate the current on-hand alert level: top of red * on-hand alert red percent / 100

New On-hand Alert Level – The new on-hand alert level is calculated based on the profile you 
applied.

Current On-hand Alert Level – The current on-hand alert level specified on the part record is 
displayed.

8 Select the rows for the parts to which you are applying the new buffer profile ID.

9 Click Set selected parts profile ID. The new profile is applied, and new replenishment level, 
buffer levels, and alert levels are calculated.

10 Click Save to apply the new buffer profile ID, replenishment level, buffer levels, and alert levels to 
the selected parts. 

Assigning a New Leadtime Buffer to Buffer Profile Parts
You can assign new leadtime buffers to parts assigned to a particular buffer profile. You can use the 
lead-time buffer field in the header to apply the same lead-time buffer to all selected parts, or you can 
manually specify a new buffer for each part in the line table. To assign a new leadtime buffer:

1 Select Inventory, Part Maintenance.

2 Select Maintain, Buffer Profile IDs.

3 Click View Profile Parts.

4 In the Assign to Parts area, select Assign Leadtime Buffer.

5 Specify the parts to display in the table. Specify this information:

Profile ID – Select the buffer profile whose parts you are assigning a new leadtime buffer. After 
you select a profile ID, information about the profile is inserted in the header.

Site ID – Specify the site whose parts you want to display in the table.
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Warehouse ID – This field is available only if the site you selected plans by independently 
planned warehouses. Specify the warehouse whose parts you want to display in the table. To 
display the parts in your universally planned warehouses, select Universal. If the site you 
selected does not plan by independently planned warehouses, then this field is unavailable.

Fabricated/Purchase/All – Select the type of parts to display in the table. Click Fabricated to 
display fabricated parts only. Click Purchase to display purchased parts only. Click All to display 
parts of both types.

6 Select the information about the parts to view in the table. Specify these settings:

Show Changes Only – This check box is a available if you have edited any of the lines and have 
not yet saved your changes. To display only the lines you have edited, select this check box. To 
display all lines, clear this check box. 

Show Current Values – Selecting or clearing this check box has no impact on the information 
displayed in the table.

Show Zone Details – To display information about the red, yellow, and green zones, select this 
check box. When you select this check box, the current green zone size, top of red zone, red 
zone base, size of red safety, top of yellow, and yellow zone size are displayed.

Show Status Details – To display information about buffer statuses based on your current supply 
and demand, select this check box. When you select this check box, the quantity on hand, 
quantity in demand over horizon, quantity on order over horizon, current available buffer status, 
current low red status, current yellow status, current low alert status, current on-hand alert status 
level, and current on-hand alert red percentage are displayed.

7 Depending on your selections in the Display Options section, this information is displayed:

Part ID – The ID of the part is displayed.

Description – The description of the part is displayed.

Commodity Code – The commodity code specified for the part is displayed.

Product Code – The product code specified for this part is displayed.

Fab – If the part is a fabricated part, this check box is selected.

Pur – If the part is a purchased part, this check box is selected.

Current Demand Horizon – The current demand horizon specified for the part is displayed. 

Current Demand Horizon End Date – The end date of the range used to examine demand is 
displayed. This date is determined by adding the demand horizon to the current date. The 
demand horizon does not consider the work schedule. For example, if the current date is 6/15/
2013 and the demand horizon is 10, then the Demand Horizon End Date is 6/24/2013, or 10 days 
from 6/15/2013, inclusive.

ADU Horizon (in Days) – The average daily usage horizon specified for the part is displayed.

Current Leadtime Buffer (in days) – The lead time buffer you specified for the part in Part 
Maintenance is divided by 24 to determine the lead time buffer in days. 

Current Covered ADU – The average daily usage based on the current average daily usage 
horizon is displayed.

Minimum Leadtime – The minimum leadtime specified for the part is displayed.
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Current Replenishment Level = Top of Green – The current replenishment level specified for 
the part is displayed. This value is equal to the top of green value. The top of green should equal 
the sum of the green zone, the yellow zone, and the red zone.

Current Emergency Stock % – The current emergency stock percentage specified on the part 
record is displayed.

Current Yellow Stock % – The current yellow stock percentage specified on the part record is 
displayed.

Minimum Order Qty – The minimum order quantity specified for the part on the part record is 
displayed.

Multiple Order Qty – The multiple in which you purchase or manufacture this part is displayed. 
This information is specified on the part record.

Maximum Order Qty – The maximum order quantity specified for the part on the part record is 
displayed.

Curr. Green Zone Size – The current green zone is displayed. The current green zone is 
calculate by multiplying the green impact percentage by the current yellow zone.

Curr. Top of Red = Red Zone Size – The current top of red, which is the same as the red zone 
size, is displayed. This formula is used to calculate the top of red size: current replenishment level 
- (current replenishment level * (100 – emergency stock percent)/100).

Curr Size of Red Zone Base – The current red zone base is displayed. This value is calculated 
by multiplying the red impact percentage by the current yellow zone.

Current Size of Red Safety – The current red safety size is displayed. This formula is used to 
calculate the current size of red safety: current top of red / (1 + (100 / variability red safety 
percent)).

Current Top of Yellow – The current top of yellow is displayed. This formula is used to calculate 
the current top of yellow: current replenishment level – (current replenishment level * (100 – 
yellow stock percent) / 100).

Current Yellow Zone Size – The current yellow zone size is displayed. This formula is used to 
calculate the current yellow zone size: top of yellow – top of red.

Current On-hand Buffer Status – The current on-hand buffer status is displayed. This formula is 
used to calculate the current on-hand buffer status: ((Replenishment level – on-hand quantity) / 
Replenishment level) * 100.

Quantity On Hand – The number of units currently in stock is displayed.

Quantity In Demand Over Horizon – The number of units of this part in demand during the 
demand horizon.

Quantity On Order Over Horizon – The number of units of this part on order during the demand 
horizon.

Current Avail. Buffer Status – The current available buffer status is displayed. This formula is 
used to calculate the current available buffer status: (replenishment level - (qty on-hand + qty on-
order - qty in-demand)) / replenishment level * 100.

Demand Horizon (in Days) – The demand horizon specified for this part is displayed.

Quantity On Hand – The number of units currently in stock is displayed.
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Quantity In Demand Over Leadtime – The number of units of this part in demand during the 
demand horizon.

Quantity On Order Over Leadtime – The number of units of this part on order during the demand 
horizon.

Current Avail. Buffer Status – The current available buffer status is displayed. This formula is 
used to calculate the current available buffer status: (replenishment level - (qty on-hand + qty on-
order - qty in-demand)) / replenishment level * 100.

Current Low Red Status – The current lowest buffer status value that is in the red zone is 
displayed. 

Current Low Yellow Status – The lowest buffer status value that is in the yellow zone is 
displayed. 

Current Low Alert Status – The lowest buffer status value that triggers an alert is displayed. 

Current On-hand Alert Level – The current on-hand alert level is displayed. This formula is used 

Current On-hand Alert Level – The current on-hand alert level specified on the part record is 
displayed.

8 Specify the new lead-time buffer. Perform one of these steps:

• To specify a single buffer to apply to multiple parts in the table, specify the new lead-time
buffer In the New Lead-time Buffer field in the header. Specify the buffer value in days. Select
the parts in the table to which to apply the new buffer, and then click Set selected parts lead-
time buffer. 

• To specify a new buffer on a part-by-part basis, specify the new buffer in the New Lead-time
Buffer (in days) column in the table. 

After you specify a new buffer, the New Covered Average Daily Usage is calculated. If you applied 
the new buffer using the New Lead-time Buffer field in the header, then Set from header is 
inserted in the New Lead-time Buffer Based On column. If you applied new buffers on a part-by-
part basis, then Manual Row Entry is inserted in the New Lead-time Buffer Based On column.

9 Click Save to apply the new lead-time buffer to the parts.

Assigning a New Demand Horizon to Buffer Profile Parts
You can assign new demand horizons to parts assigned to a particular buffer profile. You can use the 
demand horizon field in the header to apply the same demand horizon to all selected parts, or you 
can manually specify a new demand horizon for each part in the line table. To assign a new demand 
horizon:

1 Select Inventory, Part Maintenance.

2 Select Maintain, Buffer Profile IDs.

3 Click View Profile Parts.

4 In the Assign to Parts area, select Assign Demand Horizon.

5 Specify the parts to display in the table. Specify this information:
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Profile ID – Select the buffer profile whose parts you are assigning a new demand horizon. After 
you select a profile ID, information about the profile is inserted in the header.

Site ID – Specify the site whose parts you want to display in the table.

Warehouse ID – This field is available only if the site you selected plans by independently 
planned warehouses. Specify the warehouse whose parts you want to display in the table. To 
display the parts in your universally planned warehouses, select Universal. If the site you 
selected does not plan by independently planned warehouses, then this field is unavailable.

Fabricated/Purchase/All – Select the type of parts to display in the table. Click Fabricated to 
display fabricated parts only. Click Purchase to display purchased parts only. Click All to display 
parts of both types.

6 Select the information about the parts to view in the table. Specify these settings:

Show Changes Only – This check box is a available if you have edited any of the lines and have 
not yet saved your changes. To display only the lines you have edited, select this check box. To 
display all lines, clear this check box. 

Show Current Values – Selecting or clearing this check box has no impact on the information 
displayed in the table.

Show Zone Details – To display information about the red, yellow, and green zones, select this 
check box. When you select this check box, the current green zone size, top of red zone, red 
zone base, size of red safety, top of yellow, and yellow zone size are displayed.

Show Status Details – To display information about buffer statuses based on your current supply 
and demand, select this check box. When you select this check box, the quantity on hand, 
quantity in demand over horizon, quantity on order over horizon, current available buffer status, 
current low red status, current yellow status, current low alert status, current on-hand alert status 
level, and current on-hand alert red percentage are displayed.

7 Depending on your selections in the Display Options section, this information is displayed:

Part ID – The ID of the part is displayed.

Description – The description of the part is displayed.

Commodity Code – The commodity code specified for the part is displayed.

Product Code – The product code specified for this part is displayed.

Fab – If the part is a fabricated part, this check box is selected.

Pur – If the part is a purchased part, this check box is selected.

Current Demand Horizon – The current demand horizon specified for the part is displayed. 

Current Demand Horizon End Date – The end date of the range used to examine demand is 
displayed. This date is determined by adding the demand horizon to the current date. The 
demand horizon does not consider the work schedule. For example, if the current date is 6/15/
2013 and the demand horizon is 10, then the Demand Horizon End Date is 6/24/2013, or 10 days 
from 6/15/2013, inclusive.

ADU Horizon (in Days) – The average daily usage horizon specified for the part is displayed.

Current Leadtime Buffer (in days) – The lead time buffer you specified for the part in Part 
Maintenance is divided by 24 to determine the lead time buffer in days. 
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Current Covered ADU – The average daily usage based on the current average daily usage 
horizon is displayed.

Minimum Leadtime – The minimum leadtime specified for the part is displayed.

Current Replenishment Level = Top of Green – The current replenishment level specified for 
the part is displayed. This value is equal to the top of green value. The top of green should equal 
the sum of the green zone, the yellow zone, and the red zone.

Current Emergency Stock % – The current emergency stock percentage specified on the part 
record is displayed.

Current Yellow Stock % – The current yellow stock percentage specified on the part record is 
displayed.

Minimum Order Qty – The minimum order quantity specified for the part on the part record is 
displayed.

Multiple Order Qty – The multiple in which you purchase or manufacture this part is displayed. 
This information is specified on the part record.

Maximum Order Qty – The maximum order quantity specified for the part on the part record is 
displayed.

Curr. Green Zone Size – The current green zone is displayed. The current green zone is 
calculate by multiplying the green impact percentage by the current yellow zone.

Curr. Top of Red = Red Zone Size – The current top of red, which is the same as the red zone 
size, is displayed. This formula is used to calculate the top of red size: current replenishment level 
- (current replenishment level * (100 – emergency stock percent)/100).

Curr Size of Red Zone Base – The current red zone base is displayed. This value is calculated 
by multiplying the red impact percentage by the current yellow zone.

Current Size of Red Safety – The current red safety size is displayed. This formula is used to 
calculate the current size of red safety: current top of red / (1 + (100 / variability red safety 
percent)).

Current Top of Yellow – The current top of yellow is displayed. This formula is used to calculate 
the current top of yellow: current replenishment level – (current replenishment level * (100 – 
yellow stock percent) / 100).

Current Yellow Zone Size – The current yellow zone size is displayed. This formula is used to 
calculate the current yellow zone size: top of yellow – top of red.

Current On-hand Buffer Status – The current on-hand buffer status is displayed. This formula is 
used to calculate the current on-hand buffer status: ((Replenishment level – on-hand quantity) / 
Replenishment level) * 100.

Quantity On Hand – The number of units currently in stock is displayed.

Quantity In Demand Over Horizon – The number of units of this part in demand during the 
demand horizon.

Quantity On Order Over Horizon – The number of units of this part on order during the demand 
horizon.
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Current Avail. Buffer Status – The current available buffer status is displayed. This formula is 
used to calculate the current available buffer status: (replenishment level - (qty on-hand + qty on-
order - qty in-demand)) / replenishment level * 100.

Demand Horizon (in Days) – The demand horizon specified for this part is displayed.

Quantity On Hand – The number of units currently in stock is displayed.

Quantity In Demand Over Leadtime – The number of units of this part in demand during the 
demand horizon.

Quantity On Order Over Leadtime – The number of units of this part on order during the demand 
horizon.

Current Avail. Buffer Status – The current available buffer status is displayed. This formula is 
used to calculate the current available buffer status: (replenishment level - (qty on-hand + qty on-
order - qty in-demand)) / replenishment level * 100.

Current Low Red Status – The current lowest buffer status value that is in the red zone is 
displayed. 

Current Low Yellow Status – The lowest buffer status value that is in the yellow zone is 
displayed. 

Current Low Alert Status – The lowest buffer status value that triggers an alert is displayed. 

Current On-hand Alert Level – The current on-hand alert level is displayed. This formula is used 

Current On-hand Alert Level – The current on-hand alert level specified on the part record is 
displayed.

8 Specify the new demand horizon. Perform one of these steps:

• To specify a single demand horizon to apply to multiple parts in the table, specify the new
demand horizon In the New Demand Horizon field in the header. Specify the demand horizon
in days. Select the parts in the table to which to apply the new demand horizon, and then click
Set selected parts demand horizon. 

• To specify a new demand horizon on a part-by-part basis, specify the new demand horizon in
the New Demand Horizon column in the table. 

After you specify a new demand horizon, the New Demand Horizon End Date is calculated. If you 
applied the new demand horizon using the New Demand Horizon field in the header, then Set 
from header is inserted in the New Demand Horizon Based On column. If you applied new 
demand horizons on a part-by-part basis, then Manual Row Entry is inserted in the New Demand 
Horizon Based On column.

9 Click Save to apply the new demand horizon to the parts.

Recalculating Replenishment Levels Based on Demand During the 
Lead-time Buffer
Use the Replenishment Buffer Analysis dialog to calculate new replenishment levels based on 
demand during a specified number of lead-time buffers.
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The lead-time buffer is the amount of time it takes to restock the product. For fabricated parts, this is 
the amount of time it takes to fabricate a part. For purchased parts, this is the amount of time it takes 
to receive the part from a vendor.

In Replenishment Buffer Analysis, actual demand for the part during the lead-time buffer is used to 
calculate a new recommended replenishment level. You can specify the number of lead-time cycles 
to use in the demand calculation. For example, if your lead-time buffer is 24 hours, you can choose to 
examine demand over any multiple of the lead-time, such as 48, 72, and so on. The number of issue 
inventory transactions for the part is retrieved, and the average number of issue transactions per 
lead-time buffer period is calculated. This average is used as the recommended replenishment level.

You can increase the recommended buffer by specifying an additional quantity to include in the 
buffer. You can add either a percentage of the recommended replenishment level or a specify 
number of units.

In addition, you can review the number of times your inventory quantity fell into the yellow level or into 
the emergency level. You can use this information to determine whether a larger replenishment level 
is required.

To recalculate replenishment levels based on demand during the lead-time buffer:

1 Select Inventory, Part Maintenance.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site that contains 
the parts to use in the replenishment analysis and recalculation. If you are licensed to use a single 
site, this field is unavailable.

3 Select Maintain, Replenishment Buffer Analysis.

4 Specify the information to display in the table. Specify these options:

Warehouse ID – If the site you selected plans by independently planned warehouses, specify the 
warehouse whose parts you want to view. Specify Universal to view parts in your universally 
planned warehouses. If the site you selected does not plan by independently planned 
warehouses, this field is unavailable.

Show Current Replenishment Levels – To display the current replenishment level for the parts, 
select this check box. To hide the current replenishment level for the parts, clear this check box. 
When you select this check box, this information is displayed for each part in the table:

Current Replenishment Level Minus Average Issues – After you specify a demand period (see 
next step), this field is calculated by subtracting the average number of issues per buffer during 
the demand period from the current replenishment level.

Current Replenishment Emergency Level – The current replenishment emergency level is 
displayed. This is calculated by multiplying the current replenishment level by the emergency 
stock percentage.

Current Replenishment Yellow Level – The current yellow level is displayed. This is calculated 
by multiplying the current replenishment level by the yellow stock percentage.

Current Replenishment % Buffers with Emergency Intrusions – The percentage of buffers 
during the demand period where the stocked quantity fell below the current replenishment 
emergency level. 
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Current Replenishment % Buffers with No Yellow Intrusions – The percentage of buffers 
during the demand period where the stocked quantity did not enter the yellow zone. This is the 
percentage of buffers where the stocked quantity was in the green zone.

Show Changes Only – This check box is a available if you have edited any of the lines and have 
not yet saved your changes. To display only the lines you have edited, select this check box. To 
display all lines, clear this check box.

Fabricated/Purchase/All – Specify the type of part to display in the table. Click Fabricated to 
display fabricated parts only. Click Purchase to display purchased parts only. Click All to display 
part of both types.

5 Specify the time period to use to examine demand. In the Issue Selection Options section, specify 
this information:

Number of Lead-time Buffers – Specify the number of lead-time buffers to examine. 

End Date – Specify the last date of the demand period.

6 After you specify these values, the number of lead-time buffers you specified is multiplied by the 
lead-time buffer duration. This amount of time is subtracted from the End Date to calculate the 
first date used to find demand. In the table, these columns are updated:

Start Date – The first date of the demand period is inserted.

Issued Qty Since Start Date – The number of units issued during the demand period is 
displayed.

Avg. Issues Per Lead-time Buffer – The number of units issued during the demand period is 
divided by the number of lead-time buffers specified on the header. This is the average number of 
material issues per each lead-time buffer.

Curr. Repl. Level Minus Avg. Issues – This column is displayed if you have selected the Show 
Current Replenishment Levels check box. The average number of issues is subtracted from the 
current replenishment buffer. A low number indicates that you are replenishing your stock of this 
part appropriately. 

7 To specify a new replenishment level, perform one of these steps:

• To manually specify a new replenishment level, specify the new quantity in the New
Replenishment Level column.

• To calculate a new replenishment level, first specify the number of units to add to the Average
Issues Per Lead-time quantity. You can add units based on a percentage of the Average
Issues Per Lead-time quantity or add a particular number of units to the Average Issues Per
Lead-time Quantity. To specify a percentage, click the % option, then specify the percentage
in the New Repl. = Calc. Repl. Plus field. To specify a number of units, click the Qty option,
then specify the number of units in the field. Click Recalc selected parts.

8 After you specify a new replenishment level, these values are calculated based on the new 
replenishment level:

• New Replenishment Level Minus Average Issues
• New Replenishment Emergency Level
• New Replenishment Yellow Level
• New Replenishment % Buffers with Emergency Intrusions
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• New Replenishment % Buffers with No Yellow Intrusions

9 Use the Exceptions Processing section to filter the table to display only parts with exceptions. 
Specify these settings:

Curr. Repl. w/ Emergency Level Intrusions – Select this check box to display only parts with 
emergency level intrusions based on the current replenishment level. Any part with an emergency 
level intrusion greater than 0% is displayed. Clear this check box to display part both with and 
without emergency level intrusions.

Curr. Repl. w/No Yellow Level Intrusions – Select this check box to display only parts with no 
yellow level intrusions based on the current replenishment level. Only parts with 100% in the Curr 
Repl % w/No Yellow Level Intrusions are displayed. Clear this check box to display parts both with 
and without yellow level intrusions.

New Repl. w/Emergency Level Intrusions – Select this check box to display only parts with 
emergency level intrusions based on the new replenishment level. Any part with an emergency 
level intrusion greater than 0% is displayed. Clear this check box to display part both with and 
without emergency level intrusions.

New Repl. w/No Yellow Level Intrusions – Select this check box to display only parts with no 
yellow level intrusions based on the new replenishment level. Only parts with 100% in the Curr 
Repl % w/No Yellow Level Intrusions are displayed. Clear this check box to display parts both with 
and without yellow level intrusions.

10 Click the Save button. 

11 Click Close. You are prompted to print the Replenishment Level Changes Report. Click Yes to 
print the report. 

12 You are prompted to permanently change the replenishment level fields for the part. Click Yes to 
update the part record with the new replenishment level. Click No to exit the dialog without 
updating your parts.To exit the dialog without editing your parts, click Close.

Generating the Replenishment Level Changes Report
The Replenishment Level Changes Report displays a list of the changes you made to the 
replenishment levels in the Replenishment Buffer Analysis dialog box.

From the Replenishment Buffer Analysis dialog, click Print. Or, click Yes when prompted to print the 
report when you exit the Replenishment Buffer Analysis dialog box after saving changes to your 
replenishment levels.

The report is generated. This information is included in the report: part ID, part Description, method 
used to recalculate the replenishment level, the lead-time buffer, product code, new and previous 
replenishment level, new and previous emergency level, new and previous yellow level.

Recalculating Replenishment Levels Based on Demand and 
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Average Daily Usage
Use the Demand-driven Buffer Analysis dialog to recalculate replenishment levels based on demand 
for the part. You can generate new replenishment levels based on actual usage of the part, or 
manually specify new data to use to calculate replenishment levels.

Demand-driven stocked part analysis examines actual usage of a part during the average daily usage 
horizon. Any part issued in conjunction with a customer order or a work order is identified as demand. 
The total demand is divided by the average daily usage horizon to determine the average daily usage. 
The average daily usage is then used to calculate a new replenishment level and new emergency 
stock and yellow stock percentages.

You can override the system-calculated average daily usage and replenishment level (top of green). If 
you specify your own values for these fields, the emergency stock and yellow stock percentages are 
calculated for you.

To calculate replenishment levels and buffer zones:

1 Select Inventory, Part Maintenance.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site that contains the 
parts to use in the replenishment analysis and recalculation. If you are licensed to use a single 
site, this field is unavailable.

3 Select Maintain, Demand-driven Stocked Part Analysis.

4 To determine the information displayed in the table, specify this information:

Warehouse ID – If you are planning by independent warehouse, specify the warehouse to use in 
the analysis. To analyze your universally planned warehouses, specify Universal.

Show Current Replenishment Levels – To show the current replenishment levels for the parts 
as specified on the DBR tab, select this check box. If you do not want to view replenishment 
levels from the DBR tab, clear this check box.

Show Changes Only – This check box is a available if you have edited any of the lines and have 
not yet saved your changes. To display only the lines you have edited, select this check box. To 
display all lines, clear this check box. 

End Date – Specify the end date to use when identifying demand. The end date is used in 
conjunction with the Average Daily Usage Horizon to calculate the range of days to use to find 
demand. 

Exception Processing – Specify the settings to use for exception processing. Select from these 
options:

Current Replenishment On-hand Alerts – To display parts that currently have on-hand 
replenishment alerts, select this check box. To display parts both with and without alerts, clear this 
check box.

Projected Replenishment On-hand Alerts – To display parts that are projected to have 
replenishment alerts, select this check box. To display parts both with and without projected 
alerts, clear this check box. 
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New Replenishment Oh-hand Alerts – This check box is available only if you have edited any of 
the lines in the table and have not yet saved your changes. To display parts that would currently 
have on-hand replenishment alerts based on your new replenishment settings, select this check 
box. To display part both with and without alerts, clear this check box.

New Projected Replenishment On-hand Alerts – This check box is available only if you have 
edited any of the lines in the table and have not yet saved your changes. To display parts that are 
projected to have on-hand alerts based on the new replenishment levels, select this check box. 
To display parts both with and without projected alerts, clear this check box.

Fabricated/Purchased/All – Under the table, select the type of part to display in the table. Click 
Fabricated to view fabricated parts only. Click Purchased to view purchased parts only. Click All to 
view both fabricated and purchased parts.

5 This information is displayed in the table:

Part ID – The ID of the part is displayed.

Description – The description of the part is displayed.

Commodity Code – The commodity code specified for the part is displayed.

Product Code – The product code specified for this part is displayed.

Fab – If the part is a fabricated part, this check box is selected.

Pur – If the part is a purchased part, this check box is selected.

ADU Horizon (in Days) – The average daily usage horizon specified for the part is displayed.

Start Date – The first date used to find demand is inserted. The start date is calculated by 
subtracting the ADU Horizon from the end date. The ADU Horizon is expressed in working days. 
When the start date is calculated, any non-work days, such as weekends that have no shifts 
scheduled, are ignored.

Lead Time Buffer (in days) – The lead time buffer you specified for the part in Part Maintenance 
is divided by 24 to determine the lead time buffer in days. 

Current Replenishment Level = Top of Green – The current replenishment level specified for 
the part is displayed. This value is equal to the top of green value. The top of green should equal 
the sum of the green zone, the yellow zone, and the red zone.

Total Usage Since Start Date – The total number of parts issued since the start date is 
displayed. Parts can be issued to work orders or in conjunction with customer orders.

Average Daily Usage – To calculate this value, the total usage is divided by the ADU Horizon 
value.

Minimum Order Qty – The minimum quantity you can order for this part is displayed.

Buffer Profile ID – The buffer profile ID specified for this part is displayed. 

MOQ Green – If this check box is selected, then the significant minimum order quantity specified 
for the part in the Buffer Profile is used to calculate the green zone quantity. If this check box is 
cleared, then no minimum order quantities affect the green zone. If the part is not assigned to a 
buffer profile, then this check box is selected. 
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Green Impact % – The green impact percentage specified in the buffer profile is displayed. If this 
part is not assigned to a buffer profile, then a value of 50 is entered. This value is used to 
calculate the green zone. The green impact percentage is multiplied by the size of the yellow 
zone to calculate the green zone.

Red Impact % – The red impact percentage specified in the buffer profile is displayed. If this part 
is not assigned to a buffer profile, then a value of 50 is entered. This value is used to calculate the 
red zone base. The red impact percentage is multiplied by the size of the yellow zone to calculate 
the red zone base.

Var. Red Safety % – The variability red safety percentage specified in the buffer profile is 
displayed. If this part is not assigned to a buffer profile, then a value of 50 is entered. This value is 
used to calculate the red safety sub-zone. The red impact percentage is multiplied by the size of 
the red zone base to calculate the red safety sub-zone.

Curr. Green Zone Size – The current green zone is displayed. The current green zone is 
calculate by multiplying the green impact percentage by the current yellow zone.

Curr. Top of Red = Red Zone Size – The current top of red, which is the same as the red zone 
size, is displayed. This formula is used to calculate the top of red size: current replenishment level 
- (current replenishment level * (100 – emergency stock percent)/100).

Curr Size of Red Zone Base – The current red zone base is displayed. This value is calculated 
by multiplying the red impact percentage by the current yellow zone.

Current Size of Red Safety – The current red safety size is displayed. This formula is used to 
calculate the current size of red safety: current top of red / (1 + (100 / variability red safety 
percent)).

Current Top of Yellow – The current top of yellow is displayed. This formula is used to calculate 
the current top of yellow: current replenishment level – (current replenishment level * (100 – 
yellow stock percent) / 100).

Current Yellow Zone Size – The current yellow zone size is displayed. This formula is used to 
calculate the current yellow zone size: top of yellow – top of red.

Current On-hand Buffer Status – The current on-hand buffer status is displayed. This formula is 
used to calculate the current on-hand buffer status: ((Replenishment level – on-hand quantity) / 
Replenishment level) * 100.

Demand Horizon (in Days) – The demand horizon specified for this part is displayed.

Quantity On Hand – The number of units currently in stock is displayed.

Quantity In Demand Over Leadtime – The number of units of this part in demand during the 
demand horizon.

Quantity On Order Over Leadtime – The number of units of this part on order during the demand 
horizon.

Current Avail. Buffer Status – The current available buffer status is displayed. This formula is 
used to calculate the current available buffer status: (replenishment level - (qty on-hand + qty on-
order - qty in-demand)) / replenishment level * 100.

Demand Horizon End Date – The end date of the range used to examine demand is displayed. 
This date is determined by adding the demand horizon to the date specified in the End Date field 
in Usage Selection Options section. Unlike the average daily usage horizon, the demand horizon 
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does not consider the work schedule. For example, if the end date in the Usage Selection field is 
6/15/2013 and the demand horizon is 10, then the Demand Horizon End Date is 6/24/2013, or 10 
days from 6/15/2013, inclusive.

Current Low Red Status – The lowest buffer status value that is in the red zone is displayed. 

Current Low Yellow Status – The lowest buffer status value that is in the yellow zone is 
displayed. 

Current Low Alert Status – The lowest buffer status value that triggers an alert is displayed. 

Current Emergency Stock % – The current emergency stock percentage specified on the part 
record is displayed.

Current Yellow Stock % – The current yellow stock percentage specified on the part record is 
displayed.

6 Calculate the new replenishment level and buffers. To calculate the new level, perform one of 
these steps:

• To calculate the new replenishment level and buffers based on actual demand, select the part
lines and click Recalc Selected Parts. The new replenishment level and associated buffers
are calculated. To indicated that the new replenishment level and buffers are based on actual
demand, Issue History is displayed in the New Replenishment Level Based On column.

• To manually specify a new replenishment level, specify the new level in the New Level = Top
of Green field. To indicate that the new replenishment level and buffers are based on a
manually specified replenishment level, Manual Replenish is displayed in the New
Replenishment Level Based On column.

• To calculate a new replenishment level based on a manually specified average daily usage,
specify the new average daily usage in the New Daily Usage field. To indicate that the new
replenishment level and buffers are based on a manually specified average daily usage,
Manual Daily USage is displayed in the new Replenishment Based On column.

7 After the new replenishment level is calculated or manually specified, new buffer information is 
calculated for the part. The formulas used for the new buffers are the same as the formulas used 
for the existing buffers, except that the new replenishment level is used in the calculations 
instead. These information is calculated:

• New Replenishment Level = Top of Green (If you generated the replenishment level based on
actual demand or based on a manually specified average daily usage, the new replenishment
level is inserted.)

• New Daily Usage (If you generated the replenishment level based on actual demand or based
on a manually specified replenishment level, the new replenishment level is inserted.)

• New Green Zone Size
• New Top of Red = Red Zone
• New Size of Red Zone Base
• New Size of Red Safety
• New Top of Yellow
• New Yellow Zone Size
• New On-hand Buffer Status
• New Avail. Buffer Status
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• New Low Red Status
• New Low Yellow Status
• New Low Alert Status
• New Emergency Stock %
• New Yellow Stock %.

8 To use the new replenishment level and buffer zones, click the Save button. On the DBR tab for 
the parts you updated, the new Replenishment Level, Emergency Stock %, Yellow Stock %, and 
On-hand Emergency % are inserted. To retain your current replenishment level and buffer 
settings, close the dialog without clicking Save.

Setting Up Replenishment Level Effective Dates
This procedure applies to stocked parts only.

Demand can fluctuate throughout the year. For example, you may see increased demand during 
certain seasons. To accommodate these fluctuations, you may use different replenishment levels 
during certain times of year. You can set up these replenishment levels in the Replenishment Level 
Effective Dates dialog box. The replenishment levels you set up in this dialog box override the 
replenishment level you specify in the DBR tab. If no replenishment level has been specified for the 
current date, then the replenishment level you specify in the DBR tab is used.

If you plan by independently planned warehouses, you can set up replenishment levels for each of 
your independently planned warehouses. You can also set up replenishment levels for your 
universally planned warehouses.

If you do not plan by independently planned warehouses, then the replenishment levels you set up in 
the Replenishment Level Effective Dates dialog box apply to all of your warehouses.

To set up replenishment levels by effective date:

1 Select Inventory, Part Maintenance.

2 Click the Part ID browse button and select a stocked part. 

3 If you plan by independently planned warehouses, perform these steps:

a Click the DBR tab.

b In the Warehouse ID field, select the independently planned warehouse for which you are 
setting up replenishment levels. Select Universal if you are setting up replenishment levels 
for your universally planned warehouses.

4 Select Maintain, Replenishment Level Effective Dates.

5 Click Insert.

6 Specify this information:

Begin Date – Specify the date that the replenishment level takes effect. Beginning on this date, 
the replenishment level you specify in this dialog overrides the replenishment level specified on 
the DBR tab.

End Date – Specify the date that the replenishment level override expires.
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Replenishment Level – Specify the replenishment level for this part. When the number of units in 
inventory falls below this amount, a new supply order is generated. For fabricated parts, a new 
work order is generated. For purchased parts, a new planned purchase order is generated.

Is Recurring – If this replenishment level override applies during these dates every year, select 
the Is Recurring check box. If you select this check box, then the replenishment level you specify 
applies during the date range every year. The year in the Begin Date and End Date is ignored.

7 Click Save.

Setting Up Made-to-Order Parts
Refer to the Part Maintenance chapter in the Inventory guide for information on how to create a new 
part.

A made-to-order or non-stocked part is a part that you make or acquire only when you have demand 
for it. For example, you would manufacture a made-to-order fabricated part only if a customer had 
placed an order for it. You would only purchase a non-stocked part only if you had a demand for it 
from a work order.

To set up planning information for made-to-order or non-stocked parts:

1 Select Inventory, Part Maintenance.

2 Click the Part ID browse button and select a non-stocked part. A part is not stocked if the Stocked 
check box is cleared in the header. 

3 Click the DBR tab.

4 Specify this information:

Planner User ID – Specify the person responsible for material planning for this Part ID. 
Depending on your settings in Warehouse Maintenance, a planner may be responsible for 
transferring this part to other warehouses in Inventory Transaction Entry. You can also sort certain 
material reports by planner ID. 

Buyer User ID – If this part is a purchased part, specify the person responsible for buying this 
Part ID. For purchased parts, buyers are responsible for acquiring the part. You can use buyer IDs 
on purchase requisitions and purchase orders.

Safety Stock Qty – Specify the quantity of this part to keep on hand to handle unexpected 
fluctuations in demand.

Demand Horizon (in days) – Specify the default demand horizon. The scheduler uses the 
demand horizon you specify to search for demand orders. For example, if you specify 60 in this 
field, the scheduler looks for demand for the part from the current date to 60 days in the future.

Min/Max Order Qty – Specify the minimum and maximum suggested order quantity when placing 
a planned order. When the DBR scheduler creates a planned order for this part, the quantity 
ordered is not less than the minimum quantity or more than the maximum quantity. For example, 
if you had demand for 50 of this part and the maximum order quantity is 25, the DBR scheduler 
plans two orders of 25 to meet the demand. If you had demand for 3 of this part and the minimum 
order is 5, then the DBR scheduler plans an order for a quantity of 5. 
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Multiples Of – If you order this part in certain multiples, specify the multiple in this field. For 
example, if you specify 6 in this field, you order this part in multiples of 6, such as 12, 18, and so 
on. If you had demand for 8 of this part, the DBR scheduler would plan an order for a quantity of 
12.

Leadtime Buffer (in hours) – Specify the default amount of time required to supply this part. To 
specify one day, enter 24.

Demand Fence 1 and 2 – Specify the number of days in a real demand period.

5 Click the Save button.

Setting Up User Defined Buffers for Made-to-Order Parts
You can specify additional buffer time for resources on made-to-order parts only. You can specify this 
additional time on resources and legs on your engineering masters or on individual work orders. 
When you add a user-defined buffer to a resource or leg, the buffer time is added to the shipping 
buffer. This provides extra protection to the resource or leg and allows materials to be issued to the 
resource or leg earlier.

To specify a user-defined buffer an a non-stocked part:

1 Select Eng/Mfg, Manufacturing Window.

2 Open the engineering master or work order to which you are applying a user-defined buffer.

3 Specify the user defined buffer:

• To specify a user-defined buffer for an operation, open the operation card. Click the Other
tab, and then specify the length of the buffer in hours in the Buffer Size (Hrs) field.

• To specify a user-defined buffer for a leg, open the leg header card. Click the Specifications
tab, and then specify the length of the buffer in hours in the Buffer Size (Hrs) field.

4 If you have not previously applied a buffer to the operation or leg, you are asked if you would like 
to update the buffer. Click Yes. 

5 Click the Save button. 

When you apply a user-defined buffer to an operation, the buffer time is added to the shipping buffer 
for materials preceding the operation where the buffer is applied. For example, if you applied a user-
defined buffer of 40 hours to operation 50, the user-defined buffer is applied to material requirements 
for operations 10 through 40. 

When you apply a user-defined buffer to a leg, the buffer time is added to the material requirements 
used on the leg. 

Multiple user-defined buffers can apply to materials. For example, if a user-defined buffer of 40 hours 
was applied to operation 50, and a leg with a user defined buffer of 30 is added to operation 10, then 
both user-defined buffers are applied to the material requirements on the leg.

This example demonstrates how user-defined buffers are applied. These buffers are used:

Shipping buffer - 80 hours

User-defined buffer applied to operation 50 - 40 hours
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User-defined buffer applied to leg on operation 10 - 30 hours

User-defined buffer applied to leg on operation 60 - 20 hours

In this example, the material requirements for operations 10 and 20 have a total buffer of 120 hours, 
or the shipping buffer plus the user-defined buffer on operation 50.

The material requirement for operation 60 has a total buffer of 80, which is the shipping buffer.

The leg used on operation 10 has a total buffer of 150 hours, or the shipping buffer plus the user-
defined buffer on the leg plus the buffer on operation 50.

The leg used on operation 60 has a total buffer of 100, or the shipping buffer plus the user-defined 
buffer on the leg.

You can view information about the user-defined buffers applied to your work orders in DBR 
Maintenance.
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Setting Up Buffers for Outside Services
If you use outside services in your manufacturing processes, you can set up a buffer to allow for the 
time it takes for the vendor to perform the service. To set up a buffer for an outside service.

1 Select Manufacturing, Shop Resource Maintenance.

2 Select a resource with the type Contractor, or create a new shop resource with the type 
Contractor.

3 Click the Other tab.

4 In the Drum-Buffer-Rope section, specify the service buffer in hours. 

5 Click the Save button.

When you use this shop resource in conjunction with a particular outside service, the buffer you 
specified is added to the covering buffer that feeds the operation.
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Setting Up Free Work Order Buffers
Use free work order buffers to establish the shipping buffer to use for work orders that do not use the 
capacity constrained resource. In Easy Lean operations, this is the only work order buffer you set up. 
In DBR operations, you set up the free work order buffers in addition to the CCR buffers.

Free work orders only use the shipping buffer. Other buffers are not used.

You must set up the free work order buffer before you can run the DBR scheduler. 

To set up the free work order buffer:

1 Select Scheduling, DBR Maintenance.

2 In the Site ID field, specify the site whose free work order buffers you are setting up. This field is 
available only if you are licensed to use multiple sites. If you are licensed to use a single site, this 
field is unavailable.

3 In the upper table, specify this information for the free work order:

Shipping Buffer – Specify the size of the shipping buffer in hours. For the free work order, the 
shipping buffer is a generous estimate of the time between the release of raw materials to the 
work order to order completion.

Shipping Buf % Check – Specify how much of the shipping buffer to use when checking the 
validity of the production schedule. When you build a production schedule, this is the percentage 
of the shipping buffer that should remain after the CCR operation is complete. If less than the 
percentage you specify is remaining, then the work order may not be completed on time.

Emerg Zone – Specify the percentage that represents the top of the red zone. Specify this value 
as a percentage of the total buffer consumed. For example, if your shipping buffer is 40, and your 
red zone is 0 to 8 hours, specify 80 in this field.

Yellow Zone – Specify the percentage that represents the top of the yellow zone. Specify this 
value as a percentage of the total buffer consumed. For example, if your shipping buffer is 40, and 
the top of your yellow zone is 24 hours, then specify 40 in this field.

Emerg Stock % – Specify the default emergency stock percentage for stocked parts. You can 
override this value in Part Maintenance. The emergency stock percentage is multiplied by the 
replenishment level to determine the red zone for the part. If the quantity of the part falls into the 
red zone, then you must expedite the purchase or manufacture of additional parts.

Collect Data for Intrusions – Specify which zone intrusions to track. You can review these 
intrusions in Buffer Maintenance. Select one of these options:

A – Select this option to track intrusions into all zones.

Y – Select this option to track intrusions into the yellow and red zones.

E – Select this option to track intrusions into the red zone only.

4 Click the Save button.
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Finding Capacity-constrained Resources
Typically, manufacturing lines only have one or two resources that are true capacity-constrained 
resources (CCRs). DBR’s planned load tools assist you in determining which of your resources are 
your CCRs. CCRs are used in a DBR environment only. An Easy Lean environment does not have 
CCRs.

Setting Up Shop Resources for Monitoring
Before you can monitor planned load to identify the CCR, you must set up your resource records to 
track planned load. You do not have to track planned load on every resource. If only a few resources 
are candidates for being the CCR, you can track planned load on these candidates only.

To set up a resource for tracking:

1 Select Eng/Mfg, Shop Resource Maintenance.

2 Click the Shop Resource ID browse button and select the resource to track.

3 Click the Other tab.

4 In the Drum-Buffer-Rope section, select the Monitor Planned Load check box.

5 Click the Save button.

Identifying the CCR
To determine which of your resources are CCRs, you must calculate your resource planned load.

To find your resource planned load:

1 Select Scheduling, DBR Scheduler.

2 Select the production schedule. If you are licensed to use multiple sites, select the production 
schedule for the appropriate site.

3 Select File, DBR Schedule.

4 In the Options section, select Create DBR Product Schedule Only. 

5 Click Ok.

6 After the scheduler runs, select File, Planned Load.

7 Specify this information:

Resource ID – To view planned load information for a particular resource, select the resource. 
Only the resources whose load you are monitoring are displayed. To view planned load 
information for all resources whose load you are monitoring, select *All*.

Calculation Date – The current date is inserted. You cannot edit this field. This date is used in 
conjunction with the value you specify in the Load Horizon field to determine the date range to 
use to search for demand.
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Load Horizon – Specify the number of days from the Calculation Date to look for demand. The 
value you specify here determines the end date of the demand horizon.

Create a Horizon Every – To specify a subset of the load horizon, specify the subset in this field. 
For example, if you specified 30 in the Load Horizon field, but wanted to view demand information 
for every two days, specify 2 in this field.

Show Intermediate Horizons – To display a line for every horizon subset as defined in the 
Create a Horizon Every field, select this check box. To display a single line for the horizon 
duration specified in the Load Horizon field, clear this check box.

Apply Calendar Exceptions – To take into account any calendar exceptions, select this check 
box. To ignore calendar exceptions and use the standard shop schedule in the load analysis, 
clear this check box.

8 Click Generate. The load for horizon you specified is calculated. 

Analyzing Planned Load Information
Because the object of using Drum-Buffer-Rope is to create a schedule based on your capacity-
constrained resources, it is important that you declare as CCRs ONLY those resources that are true 
constraints.

It is up to your management team to declare the resources that should be treated as CCRs. In order 
to help your management team arrive at that decision, DBR has a utility that shows planned load for 
each resource.

You can use the information in the Planned Load dialog box to identify the CCR. A resource that has 
the most total hours of planned load per unit in the future is a CCR candidate. A resource that has the 
highest percentage of its load ready to be worked on right now is another CCR candidate, as it 
reflects the fact that a lot of work is currently “stuck” in front of that resource.

The Planned Load information provided can show planned load as a single total per resource over the 
entire demand horizon or can be broken down into subtotals based on a time period you choose. 
When you break the demand horizon down into subtotals, you can pinpoint when a resource may 
become a CCR in the future. 

The Resource Planned Load table contains the following ten columns:

Resource ID – The Resource ID column contains the names of your resources.

Horizon – The Horizon column contains the number of days horizon for the planned load you 
generated.

Load per Unit – The Load per Unit column contains the planned load in hours per unit figures that the 
program calculates based on the current state of your work orders at your resources.

Load with Material per Unit – The Load Available per Unit column contains the amount of the load in 
hours that has all of its material available on which you can work. For example, the full quantity 
needed to be done at that operation is available for you to work on now.

% Load with Material per Unit – The % Load Available per Unit column contains the amount of the 
load (in percentage) per unit that is available for you to schedule.
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# of Resource Units – The quantity of each of your resource units appears in the # of Resource Units 
column.

Planned Load – The Planned Load column contains the hours of planned load for the resource.

Planned Load with Material – The Planned Load Available column contains the total number of hour 
with material available.

Hour of Capacity – The total number of hours of capacity available for this resource.

% Load per Capacity – What percent of resource capacity consumed by the load.

% Load with Material per Capacity – The percentage of the load available because the material has 
been reported complete at the previous operation.

Could Finish – The date on which the specified resource could finish the entire planned load appears 
in the Could Finish column. This calculation assumes that all necessary materials are available.

Available Could Finish – The Available Could Finish date is the date on which the planned load 
could be scheduled to finish on the specified resource. For the available could finish date, the only 
constraints the scheduler takes into account are those of the shop calendar.

Setting Up Buffers for the CCR
After you have decided which resources to declare as CCRs, you must set up appropriate buffers. 
When you are making decisions regarding appropriate buffer sizes, you must consider the following:

• The placement of the CCR within your manufacturing routing: is the CCR at the beginning,
middle, or end of our production process.

• Make your buffers generous in size (compared to the time to do the work) so that you can protect
your delivery dates from unforeseen events and your CCR from starvation. However, you should
not make buffer sizes so large that your delivery dates are delayed. The buffer sizes dictate the
lead times you quote to your customers and the amount of work-in-process you have.

To set up buffers for your resources:

1 Select Scheduling, DBR Maintenance. 

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

3 Click the Insert toolbar button.

4 Specify this information:

CCR ID – Double-click the CCR ID button, and select the resource that is the CCR. 

Rank – Specify the rank of this CCR. If you have multiple CCRs, the DBR scheduler processes 
the CCRs in order of rank, starting with the lowest ranked CCR. For example, a CCR with a rank 
of 1 would be processed before a CCR with a rank of 2.

Active – If this resource is an active CCR, select this check box. If this resource is not currently 
the CCR, clear the check box. If you clear the check box, you cannot create a schedule for the 
resource.

Is a Group – If the selected resource is a resource group, this check box is selected.
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Shipping Buffer – Specify the default shipping buffer in hours for this CCR. The shipping buffer is 
the amount of time it takes to complete a work order after the materials pass through the CCR. 
The consumption of the shipping buffer begins after the CCR operation is complete and ends 
when the work order header is closed. The shipping buffer is used to protect your delivery date.

CCR Buffer – Specify the default CCR buffer in hours. The CCR buffer is the amount of time it 
takes to complete all operations preceding the CCR in a work order. This is the amount of time 
between the issue of materials to the work order and the start of the CCR operation. Enter the 
number of hours you want to use for a CCR buffer for orders that pass through this resource. The 
CCR buffer help to ensure that the CCR is used at full capacity.

Assembly Buffer – Specify the default assembly buffer in hours. The assembly buffer is used 
when parts that have passed through the CCR are combined with parts that have not passed 
through the CCR. The assembly buffer is the amount of time between the issue of raw materials 
to the point where CCR parts are combined with non-CCR parts. The assembly buffer is used in 
conjunction with the shipping buffer to allow parts that do not use the CCR sufficient time to pass 
through the work order. 

Rod – Specify the default rod value in hours. A rod is used when a CCR is used more than once 
on a work order. parts move through a CCR more than once. The rod is the minimum amount of 
time that passes between the CCR operations. 

Shipping buffer % check – Specify how much of the shipping buffer to use when checking the 
validity of the production schedule. When you build a production schedule, this is the percentage 
of the shipping buffer that should remain after the CCR operation is complete. If less than the 
percentage you specify is remaining, then the work order may not be completed on time.

Emergency Zone % – Specify the percentage that represents the top of the red zone. Specify this 
value as a percentage of the total buffer consumed. For example, if your shipping buffer is 40, and 
your red zone is 0 to 8 hours, specify 80 in this field.

Yellow Zone – Specify the percentage that represents the top of the yellow zone. Specify this 
value as a percentage of the total buffer consumed. For example, if your shipping buffer is 40, and 
the top of your yellow zone is 24 hours, then specify 40 in this field.

Emerg. Stock % – This serves as a default emergency stock percentage for parts for which you 
do not enter a part specific Emergency Stock %.

MTS CCR Buffer – Specify the default CCR buffer for made-to-stock orders. 

Collect Data for Intrusions – Specify which zone intrusions to track. Select one of these options:

A – Select this option to track intrusions into all zones.

Y – Select this option to track intrusions into the yellow and red zones.

E – Select this option to track intrusions into the red zone only.

5 Click the Save button.
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Generating Buffers
After you set up the free work order buffers and the CCR buffers, apply them to your existing supply 
orders. To apply buffers:

1 Select Scheduling, DBR Maintenance.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site whose buffers 
you are generating. If you are licensed to use a single site, this field is unavailable.

3 Select Edit, Generate All Buffers. 
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DBR Scheduling
The DBR Scheduler is designed to help you produce only the materials needed during a short time 
frame. 

Details of the Scheduling Process
This process is used to schedule work orders and generate planned orders:

The preferences you specified in the DBR schedule dialog are read.

The scheduler prevents other users from trying to generate a schedule at the same time you are 
generating a schedule.

The DBR settings are loaded. DBR settings include the buffers set up for the free work order and the 
CCR, if applicable. 

Existing demand and supply links, including any links created by the Concurrent Scheduler, are 
deleted, with these exceptions:

• Links that have inventory demand and a work order or co-product as supply are not deleted if the
work order is firmed or released. These are assumed to be for safety stock replenishment

• Links that have a work order requirement as demand and a P/O or P/O delivery schedule as
supply and have a received quantity against the link are not deleted. It is assumed that these are
in inspection or have been issued.

• If nested MTO orders are being created and nested MTO links are not being deleted, then links
that have a work order requirement as demand and have a work order or co-product as supply
are only deleted if:
• The supply work order is cancelled, closed or unreleased, or
• The demand work order, that contains the requirement, is cancelled, closed or unreleased, or
• The demand requirement is cancelled, closed or unreleased

If the current schedule is the site's production schedule then delete any planned orders belonging to 
the site.

Work orders belonging to the site are loaded. This information is loaded: schedule independent 
information from main work orders, co-products, sub-assemblies, operations, requirements and 
requirement demand/supply links. 

If a CCR has been defined, the CCR's resource information is loaded, including the resource's 
calendar and capacity information.

The site’s stocked parts are loaded into memory, including quantity information, buffer/lead-time 
information, the primary warehouse, min/max/multiple order information and other part setting 
information. If the site is being planned by warehouse, then the part information comes from the part 
warehouse for independently planned warehouses.

Any audit records from a previous scheduling run are deleted. 

The site’s "schedule" work orders are loaded, including schedule dependent information from main 
work orders, sub-assemblies, operations and requirements.
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The selected schedule is loaded.

The current scheduling information for the schedule is loaded, unless you are creating a DBR 
Planning Schedule. If you are creating a DBR Planning Schedule, then the previous schedule is left 
as-is. If the schedule is loaded, then:

• The schedule is determined based on the date specified in the Schedule As Of Date field.
• The existing schedule is deleted from the database.

The DBR Planning Schedule process is performed:

• Supply is loaded:
• Supply from MTO work orders and co-products are loaded.
• Supply from MTS work orders and co-products are loaded.
• Supply from purchase orders and those IBTs from a consigned warehouse are loaded. Supply

is loaded in the order of the supply date.
• If the supply is for a stocked part, then the purchase order replenish quantity is updated. The

new quantity is added to the stocked part’s 1/3 horizon quantity.
• Demand from customer order lines, work order requirements (if nested-MTO is selected) and

those IBTs supplying a consigned warehouse are loaded. 
• Demand is loaded in the order of the customer order lines, work order, or IBT required date. 
• Any demand beyond the scheduling horizon is ignored.
• If the demand has any supply links, then they are loaded and linked to the demand.
• If the demand is for a stocked part and the demand is required within 1/3 of the part's demand

horizon, then the quantity is added to the stocked part's 1/3 horizon quantity.
• Netting is performed to assign supply to demand. If the plan by independent warehouse option is

selected then the netting is done for each independent warehouse separately and for the
aggregate of universal warehouses. If the option is not selected, then the netting is done for all
warehouses as an aggregate.

• Excess supply is processed. Only non-replenishment work orders are considered for excess
supply. MTO orders are deleted or unreleased if they are not supplying any demand, with these
exceptions: 
• If the Allow Excess Supply check box has been selected on the work order header, the work

order is not changed. Any excess supply is allowed. 
• If the work order has transactional history or is printed, the work order is changed to

unreleased if your preference settings allow the unrelease of work orders. If your preference
settings do not allow the unrelease of work orders that have history, are released, or are
printed, then the work orders are not modified. 

• If the work order is released and the unrelease of released orders is not allowed, then the
work order is not modified. 

• "Min/max/multiples of" order constraints are applied to the work order supply quantity. If this
results in the surplus quantity not being able to be reduced, then the work order is not
modified.

• If the work order has no transactional history, is not printed, or is not released, then: 
• If no quantity is required by demand, then either delete or unreleased the work order, 

according to the "delete work order" preference.
• Otherwise, reduce the work order desired quantity to the quantity required by demand.
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If only the DBR Planning Schedule (DPS) pass is being performed, then processing is done. If you 
cleared the DBR Planning Schedule Only check box, then the scheduling of the work orders begins. 
Work orders are scheduled using this processing:

Each firmed and released work order remaining after the DPS process is scheduled. If the previous 
schedule is being preserved, then only new work orders are scheduled.

If the work order is a nested Make-to-Order (MTO), then the work order is not scheduled at this point.  
These are scheduled later after the level zero (non-nested) MTO orders are scheduled and their 
requirement required dates are known and can be used to determine the nested (lower level) MTO 
work order want dates.

• Each work order is scheduled in the backward direction using infinite capacity. This determines
when work would start on work orders if you had infinite capacity on your resources.

• If you have a CCR, the capacity constraints on each CCR are determined and resolved. Each
CCR is processed from the CCR that has load that ends the latest in time to the CCR that has
load that ends the earliest.

• After backward scheduling and the capacity constraints on the CCRs are determined and
resolved, any operation scheduled to start before the Schedule As Of Date are adjusted to start
on or after the Schedule as of Date. Each CCR is process from the CCR that has load that starts
the earliest to the CCR that has load that starts the latest.

• If you preserved the previous schedule, the new schedule is merged with the previous schedule. 

After all non-nested MTO work order are scheduled, nested MTO work orders are created and 
scheduled. 

After nested MTO work orders are scheduled, Make-to-Stock (MTS) work orders are scheduled. 

If there is a defined CCR, then these steps are performed.

The schedule’s feasibility is checked using the default CCR buffer. 

The DBR Planning schedule is checked for validity.

Material releases are scheduled and the material release schedule is checked for feasibility. 

Nested MTO work order want dates are checked and updated. 

If you selected the Run Save Setups option, setups are saved if problem work orders exist.

The final schedule is saved. 

Setting Scheduler Preferences
Use DBR Scheduler Preferences to specify the settings to use when you run a schedule. 

If you are licensed to use a single site, you can set up tenant-level and schedule-level preference 
settings. When you create a new schedule, the tenant-level settings are used for the default settings 
for the schedule. You can edit the schedule-level preferences to override the tenant-level settings. If 
you do not create tenant-level or schedule-level preference settings, then the system default settings 
are used. 
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If you are licensed to use multiple sites, you can set up tenant-level, site-level, and schedule-level 
preference settings. When you create a new schedule in a site, the site-level settings are used for the 
default settings for the schedule. If site-level settings are not available, then the tenant-level settings 
are used. You can edit the schedule-level preferences to override the tenant- or site-level settings. If 
you do not create tenant-level, site-level, or schedule-level preferences, then the system default 
settings are used. 

In the DBR Scheduler window, users must have system administrator privileges to change scheduler 
preferences. Other users can view the preferences but cannot make changes. 

The SYSADM user can edit DBR schedule preferences in Preferences Maintenance. 

To specify DBR schedule preferences:

1 Select Scheduling, DBR Scheduler.

2 Perform one of these steps:

• To specify tenant-level preferences, do not select a schedule. Select Options,
Preferences.... In the Title bar, Preferences - **Tenant** is displayed.

• To specify site-level preferences, select a schedule for the site. Select Options,
Preferences.... In the Title bar, Preferences - plus the name of the site you selected is
displayed.

• To specify schedule-level preferences, select the schedule. Select Options, Schedule
Preferences.... In the Title bar, Preferences - plus the ID of the site and the schedule are
displayed.

3 Click the Options tab.

4 Specify these settings:

Schedule Horizon – Specify the maximum number of days into the future you want the DBR 
Scheduler to search for available capacity and demand.

Fit Tolerance – Specify a percentage that represents the amount of capacity that must be 
available relative to the size of the operation in order for the operation to be successfully 
scheduled in finite scheduling mode. For example a value of 90 indicates that an 8 hour operation 
can successfully fit into a 7.2 hour open slot. (8 hours x 90% = 7.2 hours)

Max Days to Save Setup – If you are saving resource setups, specify the number of days after 
the original setup you want the scheduler to save the resource setup before it uses that resource 
for another operation. 

Generate Audit Records – To generate audit records, select the Generate Audit Records check 
box. Audit records show each attempt the scheduler made to schedule work orders. 

Do Not Switch Op's w/mat'l w/problem op's – Specify how to handle operations on the CCR 
that lack material. To switch these operations with other operations with material on the CCR 
resource, clear this check box. To prevent operations from being switched, select this check box.

Suppress C/O Allocation Links Creation – To prevent the scheduler from creating links 
between work orders and customer order lines, select this Suppress C/O Allocation Links 
Creation check box. To allow the scheduler to create links between work orders and customer 
order lines, clear this check box. 

At the beginning of a run, the scheduler deletes any links it created in previous runs but does NOT 
delete those set by the user.
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Save Incidental Setups – To save similar resource setups the scheduler encounters between 
one operation and the next, select the Save Incidental Setups check box.

Link Non-stocked P/O's to Matl Req's – To create links between work orders with material 
requirements that can be satisfied by non-stocked material purchase orders, select the Link Non-
stocked P/O's to Matl Req's check box. To prevent non-stocked purchase orders from being 
linked to material requirement, clear this check box.

Mark Unreleased Work Orders for Reuse – To mark all work orders that are set to unreleased 
during the scheduling process so that those work orders can be reused on the next scheduling 
run, select the Mark Unreleased Work Orders for Reuse check box. To prevent unreleased work 
orders from being used in a subsequent scheduling run, clear this check box.

When Schedule as of is today – If the schedule as of date is today’s date, specify the time of day 
to use as the default start of the schedule. Click Default “at time” to midnight to start the schedule 
at midnight. Click Default “at time” to current time to use the time the scheduler is run as the start 
time of the schedule. 

5 To specify the information recorded in the DBR scheduler log file, click the Log tab.

6 Use the check boxes to specify the information to record in the log file. This table shows the check 
boxes that you can select and a description of the information that is written to the file:

7 Click the OK button.

Allowing Excess Supply on Work Orders
During processing, the DBR scheduler adjusts work orders that have excess supply if you have given 
the scheduler permission to do so. You can prompt the DBR scheduler to ignore selected work orders 
during this process, even if the work orders have excess supply. The work orders you designate will 
not have their quantities reduced, will not be canceled, and will not be unreleased. They may have 
their quantities increased to meet demand. 

To allow excess supply on work orders:

Check box Description

Loaded Root Work 
Orders

Select the check box to include the work order ID, warehouse ID, 
quantity required, and allocated quantities in the log file. Clear the 
check box to include only the number of work orders that were 
processed.

Part Netting Select the check box to record information about the supply that 
the scheduler assigned to demand.

Work Orders Schedule 
Backward Infinite

Select the check box to add a list of work orders that are schedule 
backwards with infinite capacity to the log.

Material Release 
Schedule Feasibility

Select the check box to add details of the material feasibility pass 
to the log. 

Work Order Created, 
Deleted, or Modified

Select the check box to add a list of work orders that were created, 
deleted, or changed to the log. 
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1 Select Eng/Mfg, Manufacturing Window.

2 Open the work order.

3 On the header card, select Allow Excess Supply.

4 Click the Save button.

Adding Schedules
To add a new schedule to the Schedule table:

1 Click the Insert Row button.

2 Specify this information:

Schedule ID – Specify the ID of the new schedule.

Site ID – If you are licensed to use multiple sites, specify the site where you are adding this 
schedule. If you are licensed to use a single site, this field is unavailable.

Delay for Material – To prompt the scheduler to check the availability of material and delay the 
work order if materials are not expected in time, select this check box. To schedule work orders 
even if the material is not available, clear this check box. The setting you specify is the default 
setting. You can override this setting when you generate the schedule.

3 Click the Save button.

The schedule uses the default shifts you specified in Site Maintenance. You can specify different shift 
information using the Weekly Calendars function.

Defining Weekly Calendars
Use the Weekly Calendars function to override the default schedule. You can apply the weekly 
calendar to all sites, all schedules in a site, to a particular schedule in the site, or to a particular 
resource used by the site. 

To define a weekly calendar:

1 Select File, Weekly Calendars.

2 In the header, specify to what this schedule applies. Specify this information:

Site ID – To apply the weekly calendar to all sites, select **All**. Otherwise, select the site to 
which this calendar applies.

Schedule ID – If you selected **All** in the site ID field, then **All** is the only option available to 
you. If you selected a specific site in the Site ID field, select **All** to apply the calendar to all 
schedules. Otherwise, select the schedule to which this calendar applies.

Resource ID – If you selected **All** in the Site ID field, then **All** is the only option available to 
you. If you selected a specific site in the Site ID field, select **All** to apply the calendar to all 
resources. To apply the calendar to a particular resource, select the resource from the list. If you 
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selected **All** in the schedule ID field, then the calendar applies to the resource in all schedules. 
If you selected a specific schedule in the schedule ID field, then the calendar applies to the 
resource in the selected schedule only.

3 For each work day, specify this information:

1st Shift Start – Specify the time of day the first shift starts.

Shift 1 – Specify the duration of the first shift.

Shift 2 – Specify the duration of the second shift.

Shift 3 – Specify the duration of the third shift.

4 Click the Save button.

Designating the Production Schedule
You must use Site Maintenance to designate which schedule is the production schedule for the site. 
To designate a production schedule:

1 Select Admin, Site Maintenance.

2 Specify this information:

Entity ID – If you are licensed to use multiple sites, click the arrow and select the parent entity of 
the site for which you are designating a production schedule. If you are licensed to use a single 
site, this field is unavailable.

Site ID – If you are licensed to use multiple sites, click the arrow and select the site for which you 
are designating a production schedule.

3 Click the Scheduling tab.

4 Click Define Production Schedule.

5 Specify the ID of the schedule to use as the production schedule. Select an existing schedule, or 
specify a new ID and description. 

6 Click Ok.

Calendar Exceptions
Use the calendar exceptions option to set calendar exceptions for all schedules, all resources, or for 
specific schedules and resources.

A calendar exception is a holiday, planned shutdown, or other interruption of capacity that does not 
occur on a weekly schedule. If the exception you are defining occurs weekly, define it in the weekly 
calendar. 

To specify calendar exceptions:

1 Select File, Calendar Exceptions. 
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2 In the header, specify to what this exception applies. Specify this information:

Site ID – To apply the exception to all sites, select **All**. Otherwise, select the site to which this 
exception applies.

Schedule ID – If you selected **All** in the site ID field, then **All** is the only option available to 
you. If you selected a specific site in the Site ID field, select **All** to apply the exception to all 
schedules. Otherwise, select the schedule to which this exception applies.

Resource ID – If you selected **All** in the Site ID field, then **All** is the only option available to 
you. If you selected a specific site in the Site ID field, select **All** to apply the exception to all 
resources. To apply the exception to a particular resource, select the resource from the list. If you 
selected **All** in the schedule ID field, then the exception applies to the resource in all 
schedules. If you selected a specific schedule in the schedule ID field, then the exception applies 
to the resource in the selected schedule only.

3 To define the exception, click the Insert button.

4 Specify this information:

Start Date – Specify the date that this exception starts. 

End Date – Specify the date that this exception ends.

1st Shift Start Time – Specify the time that the first shift starts.

Shift 1 Duration – Specify the duration of the exception for the first shift.

Shift 2 Duration – Specify the duration of the exception for the second shift.

Shift 3 Duration – Specify the duration the exception for the third shift.

5 If you selected a particular resource, specify this information:

Shift 1 Capacity – Specify the amount of capacity the resource has during the first shift.

Shift 2 Capacity – Specify the amount of capacity the resource has during the second shift.

Shift 3 Capacity – Specify the amount of capacity the resource has during the third shift.

6 Click the Save button. 

Sites and the DBR Scheduler
 These conditions apply when you run the DBR scheduler in sites: 

• Within a site, you can run the DBR scheduler for one schedule at a time. If a second user
attempts to run the scheduler in a site where the scheduler is already running, a message is
displayed. For example, if you are running the DBR scheduler for your production schedule in Site
A, a second VISUAL user cannot run the DBR scheduler for your “what if” schedule in Site A.
Similarly, users cannot run the scheduler in a site if the scheduling service is already running the
scheduler for the same site. 

• The DBR scheduler can be run simultaneously in different sites. For example, if you are running
the DBR scheduler for Site A, a second user can run the scheduler for Site B at the same time. 

• If you are licensed to use a single site, then the scheduler can be run for one schedule at a time. 
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Creating DBR Schedules Manually
After you have identified your capacity-constrained resources and set up buffers for those resources, 
you can run the DBR scheduler to schedule work orders on the CCR and create planned purchase 
orders for purchased materials.

To create a DBR schedule:

1 Open the DBR Schedule window.

2 Select the schedule to run.

Note: To run the DBR Scheduler for all of the active Schedules on your list, click the DBR 
Schedule All Active toolbar button. You will be able to select all of the same settings except the 
"Delay Orders When No Material" and "Preserve Previous Schedule" options.

3 Click the Schedule DBR Schedule button.

4 Specify this information:

Schedule As Of – To change the date the schedule starts, specify the date in this field. The 
current date is inserted by default. 

At Time – Specify the start time for the schedule. The current time is inserted by default. 

Preserve previous schedule – If you have previously run a schedule for this CCR and you want 
to save the details of that schedule, select the Preserve previous schedule check box. Any new 
scheduled items are merged with the preserved schedule.

Create DBR Production Schedule Only – To create the DBR production schedule only, select 
this check box. When you select this option, existing supply is matched with existing demand. No 
new work orders or planned purchase orders are created. Use this option to identify the CCR. To 
generate new work orders and planned purchase orders to meet demand, clear this check box.

Do Not Switch Op's w/mat'l w/problem op's – To prevent the scheduler from swapping problem 
operations (missing material) it encounters for different operations that use the same CCR (with 
material) from a different work order, select the Do Not Switch Op's w/mat'l w/problem op's 
check box. To allow the scheduler to swap problem operations, clear this check box.

Suppress C/O Allocation Links Creation – To prevent the scheduler from allocating supply from 
work orders to demand from customer order lines, select this check box. To allow the scheduler to 
allocate supply from work order to demand from customer order lines, clear this check box.

At the beginning of a run, the scheduler deletes any links it created in previous runs but does NOT 
delete those set by the user.

Delay Orders When No Material – To delay work orders until the material requirements are 
available, select this check box. To schedule work orders even if the material requirements are 
not available, clear this check box. 

Mark Unreleased Work Orders for Reuse – To mark all work orders that are set to unreleased 
during the scheduling process so that those work orders can be reused on the next scheduling 
run, select the Mark Unreleased Work Orders for Reuse check box. To prevent unreleased work 
orders from being used in a subsequent scheduling run, clear this check box.
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Save Incidental Setups – To save similar resource setups it encounters between one operation 
and the next, select this check box. When you select this check box, the set up time for a 
resource can be used for more than one operation. To allow for set up time for each operation, 
clear this check box.

Run Save Setup – To schedule "like" operations (those with the same operation type) on the 
same resource, back to back, so that the resource/machine only needs to be setup for the first 
operation, select the Run Save Setup check box. For example, presume you have five "like" 
operations to schedule on the same CCR, and each has two hours of setup time. If you select this 
check box, the machine is set up only once, and then all five operations are run through the 
machine. This saves eight hours of set up time. If the operations were not run back to back, the 
machine would need to be set up for each of the five operations, taking 10 hours of set up time.

Max Days to Save Setup – If you are saving resource setups, specify the number of days after 
the original setup you want the scheduler to look out in the schedule to find a "like" operation that 
can be scheduled back to back with a given operation. 

Generate Exceptions – To generate part exceptions at the end of the scheduling run, select this 
check box. After the scheduler is run, any part exceptions are displayed. If you do not want to 
generate exceptions, clear this check box. You can manually generate the part exceptions in the 
DBR Scheduler window by clicking File, Part Exceptions.

Suppress All Processing Messages – To run the scheduler without stopping for error 
messages, select this check box. To generate error messages during the scheduling process, 
clear this check box. Issues with scheduling are stored in the VMDBRSCH.log file. 

5 Click OK.

A progress dialog box appears.

When this CCR schedule is complete, the progress dialog box closes and the appropriate 
information appears in the schedule table.

If you have not previously generated buffers for the CCR that you select, a dialog box appears 
informing you to generate/update the appropriate buffers before continuing. Click Yes.

After you run the scheduler, this information is displayed in the schedule table:

Run Start Date – The date the schedule was last run is displayed.

Run End Date – The date the scheduler last completed a scheduling pass is displayed. 

Schedule As Of Date – The date that the schedule starts is displayed.

Problem W/Os – The number of work orders that were scheduled to be complete later than the 
want date is displayed. 

Work Orders – The total number of work orders scheduled is displayed. 

Operations – The total number of operations scheduled is displayed.

Requirements – The number of material requirements is displayed.
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Running the DBR Scheduler with the DBR Scheduling 
Service
You can use the DBR Scheduling Service to run the DBR Scheduler automatically on the days and 
times you specify. If you have multiple sites and would like to run the service for all sites, then you 
must install the service once for each site. 

To specify when to run the service, use the Set as Scheduled dialog in the DBR Scheduler. You can 
use the service to run the DBR scheduler up to six times a day. You also specify the standard settings 
to use to run the schedule, such as whether to preserve the previous schedule and whether to delay 
work orders when material requirements are not available. 

You can set up one run schedule for each schedule ID in the DBR Scheduler window. Any user that 
has access to the Set as Scheduled dialog in the DBR Scheduler window can edit the run schedule 
for a schedule ID. The system administrator can control which users have access to the Set as 
Scheduled dialog. 

After the service is installed and the service schedule is set up, the database is examined based on 
the polling interval you specify to see if a schedule needs to be run. When the service finds a 
schedule that needs to be run, the service opens the DBR Scheduler and runs the schedule based on 
the settings you specify in the Set as Scheduled dialog. 

If you set up the DBR Scheduling Service, you can still run the DBR Scheduler manually. 

Installing the Scheduling Service
The DBR Scheduling Service is installed by site. If you have multiple sites, install the service for each 
site whose DBR schedules you would like to run with the service.

The computer where you install a service must have these components installed: 

• VSRVANY.EXE – VSRVANY.EXE is a VISUAL tool that allows the service executables to be run
as a service. VSRVANY.EXE must be installed in the same directory as the service executables.
VSRVANY.EXE is installed with the VISUAL installer. 

• SC.EXE – SC.EXE is a Microsoft Windows tool used to make modifications to services and to
remove services. SC.EXE is commonly installed with Microsoft Windows. Run a Microsoft
Windows search to verify that SC.EXE is installed. SC.EXE does not have to be in the same
directory as the services executables; you can leave SC.EXE in the directory where Microsoft
installed it. 

• Gupta Runtimes – You must also have the Gupta runtimes for your version of VISUAL installed
on the computer where you run the service.

To install the service:

1 In your VISUAL executables directory, locate VMDBRSVC.EXE.

2 Perform one of these steps:

• If you do not use single sign-on, right-click VMDBRSVC.EXE and select Run as
Administrator. The Sign In dialog is displayed.
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• If you do use single sign-on, run a command prompt as the System Administrator. In the
Command Prompt line, specify <service path>/VMDBRSVC.EXE -SYSADM. Replace
<Service path> with the path where VMDBRSVC.EXE is installed. 

3 Specify this information:

User ID – Specify the user ID that the service uses to sign into the VISUAL database. This can be 
any valid VISUAL user ID who has access to the site for which you are setting up the service. This 
user must also have security permissions to access the DBR Scheduler (VMDBRSCH.exe)

Password – Specify the password associated with the user ID.

Database – Specify the database on which to run the service. 

4 Click Sign In. The name and description of the service is displayed. 

5 Specify this information:

Site ID – Specify the ID of the site whose DBR schedules you want to run with the service.

Log File Directory – Specify where to store the log file for the service. 

Polling Interval – Specify how frequently the service should check to see if the DBR scheduler 
should be run for the site. Specify the interval in seconds. The maximum value is 900 seconds. If 
you specify a value greater than 900, your value is replaced with 900. 

Log Level – Specify the level of information to write to the log file. Click one of these options:

None – To write the time the service started, click this option. This option is recommended for 
normal production environments.

Error – To write the time the service started and any error messages, click this option.

Info – To write to the time the service started, error messages, and additional information 
about the service, click this option. The use of this option is recommended only if you are 
troubleshooting issues with the service. When you use this option, the size of the log file 
grows quickly. 

The log file's name is VMDBRSVC_[Your Site Name].log. The size of the log file is limited to 1 
MB. When the log file approaches 1 MB, the log is renamed to VMDBRSVC_[Your Site 
Name]_[Current date time].log, and a new VMDBRSVC_[Your Site Name].log is created.

6 Click Install Service.

7 To install the service for another site, repeat steps 5 and 6. Repeat these steps for each site 
whose schedules you would like to run with the service. 

Scheduling the Service
After you install the DBR Scheduling Service, specify when the DBR Scheduling Service should be 
prompted to run schedules with the DBR Scheduler.

When you use the service, each of your schedules can be run at a different time. Repeat this 
procedure for each schedule you would like to run with the service. To run a schedule with the 
service, the service must be installed for the site specified for the schedule. 
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To schedule the Scheduling Service:

1 Select Scheduling, DBR Scheduler.

2 In the table, select the schedule that you will run with the Scheduling Service. Make sure you 
select a schedule from a site for which you have set up the Scheduling Service.

3 Select File, Set as Scheduled. The ID of the schedule you selected is displayed. 

4 Specify this information:

Preserve previous schedule – If you have previously run a schedule for the CCR and you want 
to save the details of that schedule, select the Preserve previous schedule check box. Any new 
scheduled items are merged with the preserved schedule.

Create DBR Production Schedule Only – To create the DBR production schedule only, select 
this check box. When you select this option, existing supply is matched with existing demand. No 
new work orders or planned purchase orders are created. Use this option to identify the CCR. To 
generate new work orders and planned purchase orders to meet demand, clear this check box.

Do Not Switch Op's w/mat'l w/problem op's – To prevent the scheduler from swapping problem 
operations (missing material) it encounters for different operations that use the same CCR (with 
material) from a different work order, select the Do Not Switch Op's w/mat'l w/problem op's 
check box. To allow the scheduler to swap problem operations, clear this check box.

Suppress C/O Allocation Links Creation – To prevent the scheduler from allocating supply from 
work orders to demand from customer order lines, select this check box. To allow the scheduler to 
allocate supply from work order to demand from customer order lines, clear this check box.

At the beginning of a run, the scheduler deletes any links it created in previous runs but does NOT 
delete those set by the user.

Delay Orders When No Material – To delay work orders until the material requirements are 
available, select this check box. To schedule work orders even if the material requirements are 
not available, clear this check box. 

Mark Unreleased Work Orders for Reuse – To mark all work orders that are set to unreleased 
during the scheduling process so that those work orders can be reused on the next scheduling 
run, select the Mark Unreleased Work Orders for Reuse check box. To prevent unreleased work 
orders from being used in a subsequent scheduling run, clear this check box.

Save Incidental Setups – To save similar resource setups it encounters between one operation 
and the next, select this check box. When you select this check box, the set up time for a 
resource can be used for more than one operation. To allow for set up time for each operation, 
clear this check box.

Run Save Setup – To schedule "like" operations (those with the same operation type) on the 
same resource, back to back, so that the resource/machine only needs to be setup for the first 
operation, select the Run Save Setup check box. For example, presume you have five "like" 
operations to schedule on the same CCR, and each has two hours of setup time. If you select this 
check box, the machine is set up only once, and then all five operations are run through the 
machine. This saves eight hours of set up time. If the operations were not run back to back, the 
machine would need to be set up for each of the five operations, taking 10 hours of set up time.

Max Days to Save Setup – If you are saving resource setups, specify the number of days after 
the original setup you want the scheduler to look out in the schedule to find a "like" operation that 
can be scheduled back to back with a given operation. 
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Generate Exceptions – To generate part exceptions at the end of the scheduling run, select this 
check box. After the scheduler is run, any part exceptions are displayed. If you do not want to 
generate exceptions, clear this check box. You can manually generate the part exceptions in the 
DBR Scheduler window by clicking File, Part Exceptions.

Suppress All Processing Messages – This check box is selected by default. You cannot clear 
the check box. If an error is encountered, the scheduler continues to run. Issues with scheduling 
are stored in the VMDBRSCH.log file. 

5 Specify when the service is active. Specify this information:

Start Date – Specify the date that the service should running the DBR scheduler. Leave this field 
blank or specify today’s date if you do not want to delay the start of the service.

End Date – Specify the last date that the service should run the DBR scheduler. Leave this field 
blank if you do not want to set up an expiration date for the service.

Enabled – To use the service with the selected schedule, select this check box. To stop using the 
service, clear this check box. 

6 In the Run Type section, weekly is selected. You cannot change this selection. This selection 
indicates that the service should check for updates only on the days and times you specify.

7 In the Days of Week section, specify the days of the week to run the service. 

Use the Run At section to specify the times of day that the service should run the scheduler. The 
times you specify apply to all days that you run the service. You can run the service up to 6 times 
a day.

Depending on the polling interval that was specified when the service was installed, the DBR 
scheduler might not be run exactly at the time you specify. At the times that you specified, the 
DBR scheduler is flagged as needing to be run. The DBR scheduler is started when the DBR 
Scheduling Service polls the database and finds that the DBR scheduler needs to be run. When 
you specify a time, the DBR scheduler could be run at any time between the time you specify and 
the time you specify plus the polling interval. For example, if you specify 7:00:00 as the start time 
and the polling interval is 600 seconds, then the DBR scheduler is started sometime between 
7:00:00 and 7:10:00.

8 Click Save. 

Deactivating the Service
To deactivate the service for a particular schedule ID:

1 Select Scheduling, DBR Scheduler.

2 In the table, select the schedule that you are running with the DBR Scheduling Service. 

3 Select File, Set as Scheduled. The ID of the schedule you selected is displayed. 

4 Clear the Enabled check box.

5 Click Save. 
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Removing the Scheduling Service
To remove the service for a site:

1 In your VISUAL executables directory, locate VMDBRSVC.EXE.

2 Right-click VMDBRSVC.EXE and select Run as Administrator. The Sign In dialog is displayed.

3 Specify this information:

User ID – Specify the user ID that the service uses to sign into the VISUAL database. This can be 
any valid VISUAL user ID.

Password – Specify the password associated with the user ID.

Database – Specify the database on which to run the service. 

4 Click Sign In.

5 In the Site ID field, specify the ID of the site where you no longer want to run the scheduling 
service.

6 Click Remove Service. None of the site's schedules will be run with the Scheduling Service. You 
must generate the site's schedules manually in the DBR Scheduler window. 
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Viewing Information in the DBR Scheduler Window
After you run the DBR scheduler, use the tools available in the DBR scheduler window to view 
information about the schedule and work orders.

Viewing Part Exceptions
A part exception occurs when the supply of the part does not meet the demand of the part. These 
conditions can cause stock-out and over-stock conditions to arise:

• When parts exist as both co-products and standard products
• When you class parts as both finished goods (spare parts) and components parts used in

assemblies
• When you change the date or quantity requirements for parts after work orders have work in

progress already for those parts
• When you change the quantity on hand for those parts through transactional adjustments
• When you manually change dates and quantities on existing released work orders
• When you manually link customer order lines to work orders producing quantities greater than the

customer demand
• When more than one work order is required to satisfy a higher level demand due to maximum

order levels
• When work orders supply more than one higher level demand which may be due on different days

After the scheduling process is complete, part exceptions are identified based on the above criteria. 
You are prompted to view the part exceptions. Click Yes to view the exceptions. The window is 
populated with the parts with stock-out or over-stock situations, and Suggested Release Near 
exceptions. The part exceptions generated after the scheduler is run are stored in the database.

If you choose not to view part exceptions after you run the scheduler, you can generate exceptions 
based on the current state of the database. When generating exceptions from the DBR Part 
Exceptions window, the exceptions are not saved to the database.

Exceptions are generated based on the netting of the total supply versus the total demand during 
your scheduling and demand horizons.

To view part exceptions:

1 Perform one of these steps:

• Run the scheduler, and then click Yes when prompted to view the part exceptions.
• Select the schedule to view, and then select File, Part Exceptions. Click the Search button to

view the exceptions stored in the database as a result of the scheduling process. Click
Generate Exceptions to generate exceptions based on the current state of the database.

All part exceptions are displayed in the table.

2 To filter the information in the table, use the fields in the Part Exceptions dialog box header. You 
can use these filters:

Part ID – Specify the ID of the part to view in the table. You can use wildcards in your search.
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Planner User ID – Specify the ID of the planner. When you specify a planner, the parts the 
planner is responsible for are displayed. You can use wildcards in your search.

Buyer User ID – Specify the ID of the buyer. When you specify a buyer, the parts the buyer is 
responsible for are displayed. You can use wildcards in your search.

Product Code – Specify the product code of the parts to view in the table.

Commodity Code – Specify the commodity code of the parts to view in the table.

Fabricated – Specify the type of part to view in the table. Specify Fabricated to view fabricated 
parts only. Specify Not Fabricated to view parts that are not fabricated only. Specify Don’t Care to 
view both fabricated and non-fabricate parts.

Purchased – Specify how you supply the parts in the table. Specify Purchase to view the parts 
you purchase. Specify Not Purchased to view the parts you do not purchase. Specify Don’t Care 
to view both purchased and non-purchased parts in the table.

Stocked – Specify the stock status of the parts in the table. Specify Stocked to view stocked parts 
only. Specify Not Stocked to view parts you do not stock only. Specify Don’t Care to view both 
stocked parts and parts you do not stock.

Stock Out – Specify the stock out quantity. Stock out occurs when demand is greater than 
quantity. The stock out quantity is the quantity of part you must acquire to meet demand. You can 
use these expressions before the number you specify:

< – The quantity is less than the number you specify.

<= – The quantity is less than or equal to the number you specify.

> – The quantity is greater than the number you specify.

>= – The quantity is greater than or equal to the number you specify.

= – The quantity must equal the number you specify.

Over Stock – Specify the overstock quantity. An overstock occurs when you have more supply 
than the demand requires. You can use the same expressions in the Over Stock field that you can 
use in the Stock Out field.

Issue Late – Specify the number of days late. You can use the same expressions in this field that 
you can use in the Stock Out field.

Release Late – Specify the number of days late. You can use the same expressions in this field 
that you can use in the Stock Out field.

Order Projected Late – Specify the number of days late. You can use the same expressions in 
this field that you can use in the Stock Out field.

Suggested Release Near – To view parts whose suggested release is near only, select this 
check box. To view all parts, clear this check box.

Exclude parts with over stock less than min/multiple quantity – Certain parts have a minimum 
order quantity or are required to be acquired in certain multiples. A minimum order quantity or a 
multiple quantity can cause a part to be overstocked. Select this check box to omit parts that are 
overstocked due to a minimum order quantity or multiple order quantity. Clear this check box to 
view all parts.
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Part May Have Any Attributes (or)/Part Must Have All Attributes (and) – Specify how to apply 
the filters. To search for parts that have any one of attributes you specify, click Part May Have Any 
Attributes (or). To search for parts that have all of the attributes you specify, click Part Must Have 
All Attributes (and).

User Generated Exceptions – If you accessed this dialog from the File menu and generated 
excepts, select this check box to view only the exceptions you generated. Clear the check box to 
view both generated exceptions and exceptions stored in the database. If you accessed this 
dialog from the prompt after you ran the scheduler, this check box in unavailable.

3 Click the Search button to apply your filters.

Viewing Additional Material Planning Information for Parts
To view additional material planning information for parts appearing in the DBR Part Exceptions 
window, double-click the part. The Material Planning window is opened and populated with the part 
you selected.

Printing Part Exception Reports
You can generate a report for all part exceptions in the table or for only selected part exceptions in the 
table. To generate a report:

1 To include only selected parts in the report, select the parts in the table. 

2 Click the Print button.

3 Specify the parts to include in the report:

Displayed – To include all parts in the table, click this option. 

Selected – To include only the parts you selected in the table, click this option.

4 Select the report output you want to use. You can select Print, View, File, or E-mail.

5 Click the OK button.

Your report is created and it is formatted for the output you selected.

Viewing Work Order Audit Details for a Schedule
Use the Work Order Audit dialog box to view information about the actions the scheduler took to 
schedule work order operations. This information is generated only if you selected the Generate audit 
records check box in Preferences.

To view work order audit information:

1 In the DBR Scheduler window, select the schedule to use.
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2 Select File, Show Work Order Audit.

3 By default, the work orders for the schedule you selected in the DBR scheduler are displayed. To 
view work order scheduled with a different schedule in the same site, specify the schedule in the 
Schedule ID field. To view work orders on all schedules in the site, select **All**.

4 View this information:

Schedule Rank – The work order’s rank is inserted. Work order with a higher rank are given 
preference in the schedule.

Work Order ID – The ID of the work order is inserted.

W/O Pass No – The number of passes the scheduler took to successfully schedule the work 
order.

Pass ID – The action taken by the scheduling pass is inserted. These codes are used:

A – Assign supply/demand.

C – Resolve capacity constraints.

F – Check feasibility.

I – Infinite backward schedule.

L – Load from database

M – Merge schedules.

R – Generate material release schedule.

S – Make-to-stock.

T – Push before today forward.

U – Save setups.

V – Check DBR planning schedule viability.

Result – The result of the scheduling pass is inserted. These codes are used:

A – Added load.

C – Resolved a capacity constraint.

D – Loaded from database.

E – Moved to alternate resource.

F – Failed.

H – Moved since material is available.

I – Infinite backward schedule result.

L – Resolved a load conflict.

M – Resolved a material constraint.

N – Moved since material not at the CCR. 

O – Resolved a conflict with a make-on-time order.

S – Scheduled a make-to-stock item.
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V – Moved to schedule a make-to-stock item.

T – Moved forward from before today. 

U – Saved setup. 

V – Moved to schedule a make-to-stock item. 

Y – Delayed due to a validity check.

Start Date – The date that work started on the work order is inserted.

Finish Date – The date that the work order was completed is inserted.

Release Date – The date that the work order’s status was changed to Released is inserted.

Want Date – The desired due date of the work order is inserted.

5 To view detailed information about a work order, select the work order line and then click the 
Show Detail... button.

6 Each operation scheduled on the CCR is displayed. View this information:

Work Order ID – The ID of the work order that contains the operations in the table.

Part ID – The finished good made at the completion of the work order.

Scheduled Rank Out Of – The operation’s rank is inserted. Operations with a higher rank are 
given preference in the schedule. The total number of operations scheduled is inserted after Out 
Of.

Pass Count – The number of attempts the scheduler made before the work order was 
successfully scheduled is inserted.

7 In the table, the operations schedule on the CCR are displayed. To highlight the operations with a 
critical material supply problem, select the Show Critical Material check box. For example, if a 
work order requires three materials, the first with lead time of 10 days, the second with a leadtime 
of 6 days, and the third with a leadtime of 25 days, the material with the longest leadtime—in this 
case 25 days—is highlighted in red to alert you that there may be a potential problem with the 
material that may result in the work order being late. After identifying such critical instances in a 
work order, you can take steps to rectify the situation. 

8 View this information:

Attempt No – The number of attempt the schedule made to schedule the operation is inserted.

Sub ID – The work order sub ID is inserted.

Seq No – The sequence of the operation within the work order is inserted.

Resource ID – The ID of the resource used in the operation is inserted.

W/O Pass No – The number of passes the scheduler took to successfully schedule the work 
order.

Pass ID – The action taken by the scheduler is inserted. 

Result – The result of the scheduler pass is inserted.

Result Detail – A description of the result is inserted.

Start Date – The date the operation is scheduled to start is inserted.
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Finish Date – The date the operation is scheduled to be complete is inserted.

Supply ID – If this operation is linked to supply, the supply ID is inserted.

Early/Late – The number of days early this operation was completed or the number of days late 
this operation was completed.

9 Below the table, information about the work order is inserted. View this information:

Desired Release Date – The date the work order is requested to be released is inserted.

Desired Want Date – The date the work order is requested to be complete is inserted.

Desired Quantity – The quantity of finished good to be produced by the work order is inserted.

Sched Start Date – The date the work order is scheduled to start is inserted.

Sched Finish Date – The date the work order is scheduled to finish is inserted.

Received Quantity – The quantity of finished good complete is inserted.

10 To print the work order audit information, click the Print button.

Viewing the Customer Order Shipment Schedule
After you run the DBR scheduler, you can view the status of your customer orders and information 
about the work orders associated with them.

If you are licensed to use multiple sites, you can view this information on a site-by-site basis only. The 
schedule you select in the DBR scheduler window determines which site you are viewing.

To view customer order shipment information:

1 In the DBR Scheduler window, select the schedule to use.

2 Select File, Show Shipment Schedule.

3 By default, all customer orders in the site are displayed. To filter the table, specify this information:

Part ID – To view orders for a particular part, specify the Part ID in this field.

Order ID – To view a particular order, specify the Order ID in this field.

4 Specify the sort order for the table. Click one of these options:

Desired Ship Date – Click this option to sort the table by the desired ship date specified on the 
order.

Part ID – Click this option to sort the table by part ID.

Order ID – Click this option to sort the table by customer order ID.

5 View this information in the table:

Order ID – The customer order ID and line number is inserted. 

Part ID – The part the customer ordered is displayed.

Desired Ship Date – The desired ship date from the customer order or customer order line is 
displayed.
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Scheduled Finish Date – The date that the linked work order is scheduled to be complete.

Days Late – The number of days after the desired ship date that the work order is scheduled to 
be complete.

Order Qty – The quantity of part ordered is inserted.

Shipped Qty – The quantity of part shipped is inserted.

Allocated Qty – The quantity of the work order allocated to the customer order is inserted.

Fulfilled Qty – The quantity of the allocation that has been fulfilled is inserted.

Line Status – The status of the customer order line is inserted. These statuses are used:

A – Inherit. A line with this status inherits the status of the order header.

C – Closed

F – Firmed

O – On Hold

R – Released

X – Canceled

6 Click Close to exit the dialog box.

Displaying the Material Release Schedule
Use the Material Release Schedule dialog to view the current state of the material release schedule. 
The Material Release Schedule shows information for the current date only. 

To view the material release schedule:

1 In the DBR Scheduler window, select the schedule to use.

2 Select File, Material Release Schedule.

3 By default, all materials scheduled for release are displayed. To filter the table, specify this 
information:

Schedule ID – The schedule you selected in the DBR Scheduler window before you accessed 
this dialog box is displayed by default. You can select any other schedule created for the site.

Part ID – To view the material release schedule for a particular part, specify the part ID in this 
field. Specify the raw material in this field, not the finished part.

Work Order ID – To view the material release schedule for a particular work order, specify the 
work order ID in this field. The Base ID, Lot ID, and Split ID for the work order is inserted.

4 Specify the information to view in the table. Click one of these options:

Daily Summary – Click this option to view the total quantity of the materials required. If you select 
this option, only the Required Date, Part ID, Warehouse ID, Remaining Quantity Required, 
Projected On-hand Quantity, Replenishment Level, Emergency Level, and Yellow Level are 
shown.
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Daily Detail – Click this option to view each work order that requires material.

Required Date – Click this option to sort the table by the date each material is required to be 
issued to the work order for the work order to be completed on schedule.

Part ID – Click this option to sort the table by part ID.

Work Order ID – Click this option to sort the table by work order ID.

5 Click the Show button.

6 View this information in the table:

Required Date – The date the material is required to be issued to the work order. The date is 
displayed in red if the material is late.

Part ID – The ID of the part to be issued.

Work Order ID – The work order ID is inserted.

Oper Seq # – The ID of the operation requiring this material is inserted.

Piece # – The piece number of the material requirement is inserted.

Warehouse ID – The ID of the warehouse where the finished good is stored is inserted. 

Resource ID – The ID of the resource used in the operation is inserted.

Remaining Qty Req’d – The quantity of material that has not yet been issued to the work order 
operation is inserted.

Proj Qty On-hand – The projected available quantity of the part is inserted. This value takes 
supply orders into consideration.

Replenishment Level – The replenishment level specified for the part in Part Maintenance is 
displayed. If you plan by warehouse and an independent warehouse is displayed in the 
Warehouse ID column, then the replenishment level information is the warehouse-specific 
information. Otherwise, the replenishment level for your universally planned warehouses is 
displayed.

Emer. Level – The emergency stock level for the part is displayed. The emergency stock level is 
calculated by multiplying the replenishment level by emergency stock percentage. If you plan by 
warehouse and an independent warehouse is displayed in the Warehouse ID column, then the 
warehouse-specific emergency stock percentage and replenishment level is used to calculated 
the emergency level. Otherwise, the values specified for your universally planned warehouses 
are displayed. 

Yellow Level – The yellow stock level for the part is displayed. The yellow stock level is 
calculated by multiplying the replenishment level by yellow stock percentage. If you plan by 
warehouse and an independent warehouse is displayed in the Warehouse ID column, then the 
warehouse-specific yellow stock percentage and replenishment level is used to calculated the 
yellow level. Otherwise, the values specified for your universally planned warehouses are 
displayed. 

7 To view information about a work order, select a line with a work order and click W/O Status. For 
more information, refer to "Viewing Work Order Status Information" on page 17-72.

To open the Material Planning Window for a particular part, select a line with the part and click 
Planning.
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To view the supply order for a particular material requirement, select the line and click Supply. 

To export the information in the table to Excel, click To Excel....

To exit the dialog box, click Close.

Viewing Parts with Mixed Demand
A part has mixed demand if the part is sold to customers and is also a material requirement on a work 
order or engineering master. When demand for these parts is analyzed, errors can occur. Parts are 
displayed in this dialog if a part is used on an open customer order line and either an open work order 
or engineering master.

To view parts with mixed demand:

1 In the DBR Scheduler window, select the schedule to use.

2 Select File, Show Parts with Mixed Demand.

The parts with mixed demand are listed in the table. To view the part in the Material Planning 
Window, double-click the appropriate line. 

Viewing Work Order Changes
To view the work order changes made by the DBR Scheduler after a scheduling run, use the Work 
Order Changes dialog box.

The Work Order Changes dialog box is populated with all of the changes the DBR Scheduler made to 
your work orders, the part involved, and what changes were made. The information is written to the 
VMDBRWOC.CSV file stored in your program directory. The Work Order Changes dialog is 
populated from the file.

You can open the VMDBRWOC.CSV file by selecting the Open option on the File menu. The 
associated program is started and the VMDBRWOC.CSV file is opened. For example, if Microsoft® 
Office Excel is associated with .csv files, Excel is started and VMDBRWOC.CSV is opened.

You can view work order changes by schedule only.

To view work order changes in the Work Order Changes dialog box:

1 In the DBR Scheduler window, select the schedule to use. 

2 Select File, Work Order Changes....

3 View this information:

Event No – The sequence in which this event was written to the log file. The event number 
indicates the order in which this change to a work order was processed. 

Type – The type of change is inserted. These types are used:

Date – This indicates that the want date of the work order was changed. 

Deleted – This indicates that the work order was deleted. 
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New – This indicates that a new work order was created.

Quantity – This indicates that the quantity on the work order was changed.

Status – This indicates that the work order status was changed.

Work Order – The ID of the work order is inserted. To open the work order in the Manufacturing 
Window, double-click the cell.

Part ID – The ID of the part manufactured in the work order is inserted. To open the work order in 
the Material Planning Window, double-click in the cell.

Message – A description of the action took by the scheduler is inserted. 

4 To hide any of the columns in the table, use the Display menu.

5 Select File, Exit to close the dialog box.

Viewing Problem Work Orders
Use the Problem Work Orders tool to help you view your work orders that are expected to be late due 
to either lack of material or contention for CCR capacity during the planning process.

To view problem work orders:

1 In the DBR Scheduler window, select the schedule to use. 

2 Select File, Problem Work Orders.

3 By default, all problem work orders are displayed. To change the information displayed in the 
table, specify this information:

Schedule ID – To view problem work order for a different schedule, specify the schedule in this 
field. You can select any schedule in the same site as the schedule you selected before you 
accessed this dialog box.

Part ID – To view problem work orders for a particular part, specify the part in this field.

Show All Work Orders – To show all work orders, even those with no issues, select this check 
box. To show problem work orders only, clear this check box.

4 Specify the sort order for the table. Click one of these options: Desired Want Date, Scheduled 
Finish Date, Part ID, or Order ID.

5 For each work order, you can decide whether to reschedule the work order. To force the work 
order to be made on time, select the Make On Time check box. When you select this check box, 
the Reschedule check box is also selected. To prompt the scheduler to reschedule the work 
order, but not necessarily force the work order to be made on time, select the Reschedule check 
box only.

6 Click the Save button.
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Viewing Problem Operations
Use the Problem Operations to view operations on your CCRs that lack their material requirements.

To view problem work orders:

1 In the DBR Scheduler window, select the schedule to use. 

2 Select File, Problem Operations.

3 By default, all problem operations are displayed. To change the information displayed in the table, 
specify this information:

Schedule ID – To view problem work order for a different schedule, specify the schedule in this 
field. You can select any schedule in the same site as the schedule you selected before you 
accessed this dialog box.

CCR ID – To view the operations on a particular CCR, specify the CCR in this field. Select All to 
view all CCRs.

View All Operations – To view all operations on your CCRs, select this check box. To view 
problem operations only, select this check box.

4 View this information in the table:

Operation ID – The work order and operation ID is inserted.

CCR ID – The ID of the CCR is inserted.

Could Start Date – The date the operation could start is inserted.

Scheduled Start Date – The date the operation is scheduled to start is inserted.

Could Finish Date – The earliest date on which the operation could be completed is inserted.

Scheduled FInish Date – The date the operation is currently scheduled to finish is inserted.

Days Late – The number of days late is inserted.

Delay Reason – The reason for the delay is inserted.

Calc End Qty – The quantity of part at completion is inserted.

Completed Qty – The quantity of part completed is inserted.

5 Click the Close button to exit the window.

Viewing Problem Requirements
Use the Problem Requirements dialog box to view materials that are causing delays. 

To view problem requirements:

1 In the DBR Scheduler window, select the schedule to use. 

2 Select File, Problem Requirements.

3 By default, all problem requirements are displayed. To change the information displayed in the 
table, specify this information:
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Schedule ID – To view problem requirements for a different schedule, specify the schedule in this 
field. You can select any schedule in the same site as the schedule you selected before you 
accessed this dialog box.

Part ID – To view problems with a particular part, specify the part ID in this field. Specify the ID of 
the material requirement, not the ID of the finished good.

Show – In the Show section, specify which material requirements to show. To show only certain 
requirements, click the Selected requirements option. Then, use the check boxes to select the 
materials to view. Select the Problem Requirements check box to view parts that cannot be 
supplied in time. Select the Non-problem requirements check box to view parts that have 
adequate supply but are still causing a delay. 

4 Click All Requirements to view both requirements causing delay and requirements that can be 
delivered on time.

5 View this information in the table:

Requirement ID – The work order and piece number of the requirements is inserted.

Required Date – The date the material is required for the operation is inserted.

Due Date – The date the operation is due is inserted.

Days Late – The number of days that have elapse after the required date. This is either the 
number of days after the required date to the current date, or the number of days after the 
required date that the materials were issued to the work order.

Reason – The reason the material is late is inserted.

Calc Qty – The quantity of finished good at completion is inserted.

Issued Quantity – The quantity of the material requirement that has been issued to the operation.

Allocated Quantity – The quantity of material requirement allocated from a supply order.

Fulfilled Quantity – The quantity of finished good completed is inserted. 

6 To exit the dialog box, click the Close button.

Managing Work Orders Unreleased by the Scheduler
When you run the scheduler, the scheduler identifies work orders that are not used to meet demand 
and unreleases them. You can choose to reuse these work orders in subsequent scheduling runs. 
Manage your unreleased work orders in the Work Orders Unreleased by DBR dialog box.

To manage these work orders:

1 In the DBR Scheduler window, select the schedule to use. 

2 Select File, Work Orders Unreleased by DBR.

3 By default, all work orders unreleased by DBR are displayed. To filter the work orders displayed in 
the table, specify this information:

Part ID – To view unreleased work orders for a particular part, specify the ID of the part in this 
field.



Viewing Information in the DBR Scheduler Window

17 – 66 | Infor VISUAL Inventory User’s Guide 

Show All Unreleased Work Orders – To display all work orders with a status of unreleased, 
select this check box. When you select this check box, any unreleased work order is displayed, 
not only the work orders unreleased by DBR. To display only the work orders unreleased by DBR, 
clear this check box.

List “Reuse” Work Orders First – To display the work order that DBR marked for reuse first, 
select this check box. To display the work orders in the sort order specified regardless of the 
reuse status, clear this check box.

4 In the Sort section, specify how to sort the work orders. Click Desired Want Date, Part ID, or 
Order ID.

5 View this information in the table:

Work Order ID – The ID of the work order is inserted.

Part ID – The finished good made by the work order is inserted.

Unrel by DBR – If the scheduler unreleased this work order, then this check box is selected. If the 
work order was unreleased manually, then this check box is cleared.

Reuse – If the scheduler marked this work order for reuse, then this check box is selected. You 
can decide which work orders to reuse. See the next step.

Desired Want Date – The date that the work order is due to be complete is inserted.

Desired Qty – The quantity on the work order is inserted.

Received Qty – The quantity of the part received into inventory is inserted.

Allocated Qty – The quantity of the work order allocated to a demand order.

Fulfilled Qty – The portion of the allocated quantity that has been delivered to the demand order.

Last Piece(s) Sub ID/Seq # – The location of the earliest unfinished operation is inserted. 

6 To specify which work orders to reuse, perform any of these steps:

• To select a single work order for reuse, select the Reuse check box for the work order in the
table.

• To select all work orders for reuse, click the Reuse All button.
• To designate no work orders for reuse, click the Reuse None button.
• To restore the selections to the previously saved settings, click the Restore button. Use the

Restore button to undo all of your changes since your last save.

7 Click the Save button.

8 Click the Close button.

You can perform these additional actions:

To view a work order in the Manufacturing Window, highlight the work order line in the table and then 
click View W/O....

To view a part in the Planning Window, highlight the part line in the table and then click Planning....

To export the contents of the table to Microsoft Excel, click Export to Excel.
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Viewing DBR Generated Demand-Supply Links
When you run the DBR scheduler, the scheduler creates demand and supply links between your 
supply orders and your demand orders. Customer orders are included in demand, provided that you 
have not selected the Suppress C/O allocation links creation check box when you ran the scheduler.

To view the links that the DBR scheduler created:

1 In the DBR Scheduler window, select the schedule to use. 

2 Select File, Show DBR Created Links.

3 By default, all DBR created links are displayed in the table. To view links for a particular part, 
specify the ID in the Part ID field.

4 Specify how to sort the work orders in the table. Click one of these options:

DSL ID – Click this option to sort the table by Supply Seq No. This is the order in which the DBR 
scheduler built the links.

Demand ID – Click this option to sort the table by demand ID.

Supply ID – Click this option to sort the table by supply ID.

Part ID – Click this option to sort the table by part ID.

5 To change a DBR-created link to a user created link, select the line and click the Make User 
button. To undo this action, select the line and click Unmake User.

6 Click the Save button. Any links that you converted to user links are removed from the table.

Generating the Common Materials Report
Use the common materials report to identify materials used as requirements in more than one 
released order. 

If you are licensed to use multiple sites, you can run this report on a site-by-site basis. The site used 
for the report is the site associated with the schedule you select before you access the report dialog 
box.

To generate the report:

1 In the DBR Scheduler window, select the schedule to use.

2 Select File, Print Common Materials Report.

3 Select the information for the report. Specify this information:

Starting Part ID – Specify the first part alphanumerically to view in the report.

Ending Part ID – Specify the last part alphanumerically to view in the report.

4 To view a single part in the report, specify the same ID in both the Starting Part ID and Ending 
Part ID field. To view all parts, leave both fields blank.

5 Specify how to sort the information in the report. The part is first sorted by Part ID. Specify the 
secondary sort order for the report. Select Work Order ID to sort the report by work order. Select 



Viewing Information in the DBR Scheduler Window

17 – 68 | Infor VISUAL Inventory User’s Guide 

Do Not Use Before Date to sort the report by the do not use before date. The do not use before 
date is calculated differently depending on the buffer the common part feeds. These calculations 
are used:

CCR buffer – If the part feeds the CCR buffer, then the do not use before time is the CCR 
schedule minus the CCR buffer, which is equal to the release date.

Shipping buffer after a CCR operation – If the part feeds the shipping buffer after the CCR, then 
the do not use before time is the starting time of the CCR schedule or the due date minus the 
shipping buffer, which ever time is later.

Assembly buffer – If the part feeds the assembly buffer, then the do not use before time is equal 
to the release date, calculated as the due date minus the shipping buffer minus the assembly 
buffer.

Free W/O – If the work order is a free work order, then the time is the due date minus the shipping 
buffer.

6 Specify how to output the report. Specify one of these options:

Print – Specify this option to send the report to a printer.

View – Specify this option to view the report in the report viewer.

File – Specify this option to save the report as a file.

E-mail – Specify this option to generate the report and e-mail it. Select the PDF check box to e-
mail the report as a PDF. Clear the PDF check box to e-mail the report as a comma-separated 
file.

7 Click Ok to generate the report.
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Analyzing Buffer Information in the DBR Maintenance 
Window
After you set up buffers and run the DBR scheduler, you can view the buffers applied to your parts 
and work orders. 

Viewing Buffer Information
To view buffer information:

1 Select Scheduling, DBR Maintenance.

2 If you are licensed to use multiple sites, click the Site ID button and select the site to view. If you 
are licensed to use a single site, this field is unavailable.

3 The table at the top displays the free work order buffer and the resources for which you have set 
up buffer information. To view your active CCRs only, select the Show active CCRs only check 
box. To view active and inactive CCRs, clear the check box.

4 Specify the information to view in the table at the bottom. Specify these settings:

Show Buffers For – Specify the documents and parts to display in the table. Select one or more 
of these check boxes: Work Orders, Eng. Masters, Stocked Parts, and Purchase orders.

Show Time Buffers of Type – Specify the buffers to display in the table. Select one or more of 
these check boxes: Shipping, CCR, Assembly, Rods, Replenishment, User Def.

5 Click Refresh. The buffers you selected are displayed in the table. For each buffer, this 
information is displayed:

Work Order ID – The ID of the document or part is displayed. The types of documents displayed 
are work order, engineering masters, and purchase orders. For engineering masters, the letter M 
is displayed before the engineering master ID. For purchase orders, the letter P is displayed 
before the purchase order ID. A part ID is displayed if the line is for a stocked part buffer.

Seq No – For work orders and engineering masters, the sequence number of the operation is 
displayed. For purchase orders, the line number is displayed. 

Piece No – For work orders and engineering masters, the piece number of the material is 
displayed.

CCR ID – If the buffer shown in the line is related to the CCR, the ID of the CCR is displayed. 
Otherwise, the category of the buffer shown in the line is displayed. These buffer categories are 
used:

PURC_ORDER – This is displayed if the line shows the leadtime buffer for a purchase order.

STOCKED_PART – This is displayed if the line shows the replenishment level for a stocked part.

USER_DEFINED – This is displayed if the line shows a user-defined buffer.

Free W/O – This is displayed if the line shows the free work order shipping buffer.

Type – The type of buffer shown in the line is displayed. These types are used:
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Shipping – This is displayed if the line shows the shipping buffer for the CCR or Free W/O.

CCR – This is displayed if the line shows the CCR buffer. 

Assembly – This is displayed if the line shows the assembly buffer.

Rod – This is displayed if the line shows the rod buffer.

Replenish – This is displayed if the line shows a replenishment work order.

Assy+Ship – This is displayed if the line shows an assembly buffer added to the shipment 
buffer.

Stocked Part – This is displayed if the line shows the replenishment buffer for a stocked part.

Repl. P/O – This is displayed if the line shows a purchase order placed to replenish a stocked 
part.

P/O – This is displayed if the line shows a purchase order.

State – The state of the buffer is displayed. A buffer can be either active or closed. If the buffers 
displayed are for an engineering master, then Engineering Master is inserted in this column.

Factor – See Adjusting Buffer Sizes.

Service Time – If an outside service precedes this operation, the amount of time required for the 
service is displayed. The service time is calculated by adding the service buffer specified for the 
resource in Shop Resource Maintenance to the amount of time for the set up and run specified for 
the service.

Size – The size of the buffer is displayed. For time buffers, the amount of buffer time in hours is 
displayed. For the replenishment buffer, the replenishment level for the part as specified in Part 
Maintenance is displayed.

W/O DBR Type – For work orders, the type of work order is displayed. These types are used: 

S – The work order is a made-to-stock work order.

O – The work order is a made-to-order work order.

R – The work order is a replenishment work order.

W/O DBR Priority – For work order, the priority of the work order is displayed. These types are 
used:

Emergency (E) – If your stock level falls below the emergency stock percentage level, DBR 
assigns a priority of Emergency.

On-time (O) – This work order must be made on time. This work order should not be 
rescheduled on a later date to satisfy material availability. 

Normal (N) – This work order can be scheduled and manufactured normally.

Part ID – The part ID related to the order is displayed.

Warehouse ID – The warehouse ID related to the part is displayed. If you plan by independently 
planned warehouses and you are viewing replenishment buffers, the warehouse-specific 
replenishment buffer for the part is displayed. If you are planning by independently planned 
warehouses and no warehouse ID is displayed, then the replenishment level displayed is for your 
universally planned warehouses.
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Warehouse IDs are also displayed for work orders. This is the warehouse where the finished 
goods will be stored.

Changing Buffer Sizes
For individual work orders or engineering masters, the default buffer settings may not be adequate. 
You can change the buffer size for individual work order and engineering masters. You can use 
factors to change the time buffers on work orders and engineering masters. 

You can also adjust buffer sizes for your CCR and apply the new buffers to your work orders. 

Changing Buffer Sizes Using Factors
To increase a time buffer, you can multiply the time buffer by a factor you specify. To use factors, a 
time buffer must be applied to a work order or engineering master. You cannot adjust the size of a 
replenishment buffer using factors. 

You can change buffer sizes using factors in the DBR Maintenance window.

To adjust buffer factors:

1 Select Scheduling, DBR Maintenance.

2 If you are licensed to use multiple sites, click the Site ID arrow and specify the site to use. If you 
are licensed to use a single site, this field is unavailable.

3 Click Refresh.

4 To adjust a time buffer on a work order or engineering master, specify the factor to use in the 
appropriate line in the table at the bottom of the window. The current buffer is multiplied by the 
new buffer. 

5 Click the Save button. 

Applying CCR Buffer Changes to Work Orders
You can apply updates to any of a CCR’s buffers to work orders and engineering masters. Any CCR 
buffer can be changed.

To update work orders and engineering masters with new buffers:

1 In the table at the top, adjust buffer settings as necessary.

2 To apply the changes to all work orders and engineering masters, select Edit, Recalculate All 
Buffer Sizes. To apply the changes to particular work order or engineering masters, select the 
work orders and engineering masters in the table. Select Edit, Recalculate Selected Work 
Order Buffer Sizes. 

3 Click the Save button.
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Recalculating Part Replenishment Buffers
To recalculate part replenishment buffers, use the Replenishment Buffer Analysis dialog box or the 
Demand-driven Stocked Part Analysis dialog box. These dialog boxes are identical to the dialog 
boxes found in Part Maintenance. 

After you recalculate replenishment buffers, apply them to your parts and work orders. To apply the 
new replenishment level to particular parts, select the appropriate lines. Then, select Edit, 
Recalculate Selected Stocked Part Replenishment Level. To update all parts, select Edit, 
Recalculate All Buffer Sizes.

Deleting Buffer Settings
To delete a set of buffer settings:

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use. If you 
are licensed to use a single site, this field is unavailable.

2 Click the CCR ID button and select the CCR you want to delete.

3 Click the Delete button on the toolbar or, from the File menu, select Delete.

A confirmation dialog box appears requesting you to confirm the deletion.

4 Click Yes.

The DBR Maintenance program removes the CCR ID and its buffer information from your 
database.

If you do not want to delete this CCR ID at this time, click No.

Note: You cannot delete buffer settings if you have generated any buffers using these buffer 
settings.

Viewing Work Orders
To view a work order in the Manufacturing window, select the work order in the table. Select View, 
Selected Work Order.

Viewing Work Order Status Information
To view the buffer status of a line item in the table, select the line. Then, select View, Selected Work 
Order Status. While the menu item indicates that the dialog applies to work orders only, you can also 
view the buffer status of purchase orders and parts. If you do select a work order, information about 
the order’s operations and material release schedule is also displayed.

This information is displayed in the dialog:
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Work Order ID – The ID of the work order is displayed. For purchase orders, the ID of the purchase 
order is displayed.

Part ID – The ID of the finished part produced by the work order is displayed.

Qty – The quantity of part required on the work order is displayed.

Want Date – The due date of the work order is displayed.

Start Date – The date that work began on the work order is displayed.

Finish Date – The date that the work order was completed is displayed.

Material Release Schedule – The materials required for this work order are listed in the Material 
Release Schedule table. The date the material is due to be issued to the work order is displayed in 
addition to the quantity required and the quantity already issued. If the material issue is late, the date 
is in red.

Scheduled Operations – The CCR operations schedule to occur are listed in the Scheduled 
Operations table. The dates that the operation is due to start and end are inserted.

Buffer Status – The status of all buffers applied to the work order or purchase order are displayed. 
This information is displayed: 

Sub ID – The sub ID of the work order is displayed.

Op # – The operation number for the resource is displayed.

Piece # – The material requirement number is displayed.

CCR ID – The ID of the resource for the CCR is displayed. Otherwise, the category of buffer is 
displayed.

Type – The type of buffer is displayed.

Active/Closed – The current state of the buffer is displayed.

Size – The size of the buffer is displayed. If this is a time buffer, the size is displayed in hours. For 
replenishment buffers, the size is displayed in units.

Part ID – When applicable, the Part ID that is the subject of the buffer.

End Date – The date that the buffer elapses.

To view the last piece of the work order, click the Last Pieces... button. This is the earliest unfinished 
operation of the work order.

To view the status of any linked customer order, click the C/O Status button.

The Mat’l Supply feature is unavailable.

Viewing Buffer Statuses of Non-CCR Operations
Certain buffers, such as the shipping buffer, apply to non-CCR operations. You can view this 
information in the DBR Maintenance window and in the Shop Resource window.

To view the buffer status of your non-CCR operations:
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1 Perform one of these steps:

• Select Scheduling, DBR Maintenance. If you are licensed to use multiple sites, click the Site
ID button and specify the site to use. If you are licensed to use a single site, this field is
unavailable.

• Select Eng/Mfg, Shop Resource Maintenance. If you are licensed to use multiple sites, click
the Site ID button and specify the site to use. If you are licensed to use a single site, this field
is unavailable.

• Select Scheduling, Buffer Management. If you are licensed to use multiple sites click the
Site ID button and specify the site to use. If you are licensed to use a single site, this field is
unavailable.

2 Select View, Resource Operations Buffer Status.

3 In the Resource ID field, specify the non-CCR resource to view. The date that the buffer status 
was last calculated is displayed.

4 Specify the operations to view in the table. Select one or more of these check boxes:

Show Ops that have Qty Available – Select this check box to display only operations where 
work is ready to begin. Some portion of the work-in-process product has been processed through 
all preceding operations. Clear this check box to view all operations.

Exclude Material Checks – If you have selected the Show Ops that have Qty Available check 
box, use this check box to filter which operations to view. To view operations with quantity 
available but no material requirements issued to the operation, select this check box. To view 
operations with quantity available that have had material requirements issued, clear this check 
box.

5 The buffers applied to the resource you specified are displayed.

To print a copy of the buffer information, click the Print button.

To exit the dialog box, click Close.
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Managing Buffers
After you have identified your CCRs, set up their buffers, and created schedules, you can compare 
schedules and material release dates and begin to manage your buffers to better fit your 
manufacturing needs.

Part of managing your buffers is calculating the current buffer statuses (usage of your buffers) on a 
daily basis.

Calculating buffer statuses on a daily basis:

• Helps you find jobs whose completion dates are threatened early enough in the process so that
you can take appropriate measures.

• Provides a historical account of buffer penetration to assist adjusting buffer sizes to minimize lead
times to their shortest, safest levels.

Calculating Buffer Statuses
You should perform this procedure each day.To calculate your buffer statuses:

1 Select Scheduling, Buffer Management.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site whose buffers 
you are calculating. If you are licensed to use a single site, this field is unavailable.

3 Click Calc Buffer Status. 

Viewing Buffer Status Information
After you generate buffer statuses, use the filters to select which buffers to view in the table. To filter 
the buffer status table:

1 To filter the parts in the table, specify this information:

Part ID – To view the buffer statuses for a particular part, specify the part ID. 

Warehouse ID – If you plan by warehouse, specify the warehouse whose part buffers you want to 
view. Select a specific independently planned warehouse from the list to view the buffers for that 
warehouse. To view buffer information for your universally planned warehouses, specify 
Universal. To view buffer information for all of your warehouse, specify All Warehouses. 

Product Code – To view buffers for parts assigned to particular product code, specify the product 
code ID in this field.

Customer ID – To view buffer statuses for parts sold to a particular customer, specify the 
customer ID. 

2 In the Display section, specify which buffers to display in the table. You can select:
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Time Buffers – Select this option to view buffers specified in hours. When you select this option, 
the Show time buffers of type section becomes available. Use this section to specify which time 
buffers to display in the table.

W/O Replenishment Buffers – Select this option to view work order replenishment buffers. 

Purchase Order Buffers – Select this option to view purchase order buffers.

Stocked Material Buffers – Select this option to view the buffers for your stocked parts. You can 
view fabricated stocked parts, purchased stocked parts, or both.

Max Rows – Specify the maximum number of buffers to view in the table. 

3 In the Show Zones section, specify which buffer zones to view in the table. You can select Red, 
Yellow, and Green.

4 In the header, the number of intrusions and open items for the type of buffer you selected in the 
Display section is inserted in these fields: 

Buffer Intrusions – The total number of buffer intrusions is inserted. Buffer intrusions are 
recorded based on your Collect Data for Intrusions setting for the CCR in DBR Maintenance. 

Open Items – The total number of open items is inserted. An open item can be a work order or a 
purchase order is inserted. 

Emergency Zone Intrusions – The total number of emergency buffer zone intrusions is inserted.

5 In the table, view information about your buffers. The information displayed in the table changes 
based on the buffer type you selected in the Display section. 

Status – The percentage of the buffer consumed is inserted. For time buffers, the buffer status is 
the percentage of the time passed relative to the buffer length. A value over 100 percent indicates 
that the buffer time has elapsed and the order is taking longer to complete than anticipated. For 
stock buffers, the percentage is calculated by subtracting the on-hand inventory from the 
replenishment level, and then dividing by the replenishment level. This value is multiplied by 100.

Est. % Complete – An estimate of the percentage of the work order that is complete is inserted. 
This information is displayed for time buffers only.

CCR ID – The ID of the CCR is inserted. For time buffers, either the resource ID of your CCR or 
Free W/O is inserted. For work order replenishment buffers, STOCKED_PART is inserted. 

Work Order ID – The identification number for the work order is displayed in the Work Order ID 
column. This information is displayed for time buffers and work order replenishment buffers only.

Purchase Order ID – The ID and the line number of the purchase order is inserted. This 
information is displayed for purchase order buffers only.

Part ID – For time buffers and work order replenishment buffers, the ID of the part made by the 
work order is inserted. For purchase order buffers, the part ID on the purchase order line is 
inserted. For stocked material buffers, the stocked part ID is inserted.

Stocked – If the part is a stocked part, then this check box is selected. If the part is a made-to-
order part, then this check box is cleared.

Seq No. – The operation sequence number where the CCR is used. This information is displayed 
for time buffers only. The sequence number is inserted for resources defined as your CCR only.
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Piece No – The piece number of the material requirement is inserted. The piece number is 
displayed only if a buffer is associated with it.

Type – The type of buffer described on the line is inserted. 

Size (in hours) – The size of the buffer in hours is inserted. 

Warehouse ID – The ID of the warehouse where the part will be received is inserted.

Buffer Due Date – The date that this buffer is due to be completed is inserted.

Due/Req’d Date – For time buffers, the date the want date of the work order is inserted. For 
purchase order buffers, the desired received date is inserted. 

W/O Start Date – The date on which the work order is scheduled to start is displayed. This 
information is displayed for time buffers only. 

W/O Finish Date – The date on which the work order is scheduled to finish is displayed. This 
information is displayed for time buffers only.

Days Late – If the work order is overdue, the number of days it is late appears.

Emerg. Status – The emergency status percentage is inserted. This is calculated by subtracting 
the Emergency Zone percentage specified in DBR Maintenance from 100. When a buffer has the 
emergency status percentage or less remaining, it is in the red zone.

Yellow Status – The yellow status percentage is inserted. The top of the yellow status range is 
calculated by subtracting the Yellow Zone percentage specified in DBR Maintenance from 100. 
When the percentage of buffer remaining is between this calculation and the emergency status 
percentage, it is in the yellow zone.

Desired Qty – The quantity of material produced by the work order or ordered on a purchase 
order is displayed. 

Received/Issued Qty – The quantity of the work order or purchase order is displayed. 

Allocated Qty – The quantity of the work order allocated to a customer order line is displayed.

Fulfilled Qty – The amount of the allocated quantity you have received from the work order is 
displayed.

W/O DBR Type – The type of work order is inserted. These types are used:

R – The order is a made-to-stock order, which is the same as a replenishment order.

O – The order is made-to-order. 

W/O DBR Priority – The priority of the work order is inserted. These priorities are used:

Emergency (E) – If your stock level falls below the emergency stock percentage level (DBR 
tab of the Part Maintenance window), DBR assigns a priority of Emergency.

On-time (O) – This order should be made on time without pushing the order to a future date to 
satisfy material availability.

Normal (N) – This order is scheduled normally.

Problem Class – To assign a problem class to the item on this line, highlight the line and select 
Edit, Buffer Status Problem Class. Specify the Problem Class, and add comments if necessary. 
After you assign the problem class, the problem class code is inserted in this column. Define 
problem classes in DBR Maintenance. 
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Last Piece(s) Sub ID/Seq ID – The location of the earliest unfinished operation of each work 
order leg is inserted.

Emergency Stock Status – For stocked parts only, the emergency stock percentage for the part. 

Yellow Stock Status – For stocked parts only, the yellow stock percentage for the part.

Working with Problem Classes
Setting up problem classes and assigning them to your instances of buffer intrusions helps you to 
analyze your buffers and the effects they have on your production line.

If you are licensed to use multiple sites, you can set up problem classes on an enterprise-wide basis 
only.

Setting Up Problem Classes
To set up problem classes:

1 From the Drum-Buffer-Rope Maintenance program Edit menu, select Problem Classes.

2 Click Insert.

3 Enter the identification number for this Problem Class ID.

4 If you want to change the problem type, press the TAB key and select the Problem type you want 
to use from the drop-down list.

You can select:

Material – Examples of Material type problem classes are late delivery from suppliers, failed 
incoming quality tests, and spoilage.

Order – Examples of Order type problem classes are machine breakdowns, poor subordination, 
and employee sickness.

Both – Examples of Both type problem classes are customers changing product delivery to 
earlier dates and weather related problems.

5 In the Description column, specify a description of the problem class.

6 Click Save.

Assigning Problem Classes to Buffers
To assign a problem class to a buffer:

1 In the Buffer Management window, select the CCR ID that contains the buffer to which you want 
to assign a problem class.
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2 Select the row to which you want to assign a problem class.

3 Select Edit, Buffer Status Problem Class.

4 Click the Problem Class arrow and select the problem class you want to use from the list.

5 To to include a detailed description for this problem class, click in the User-defined problem 
description box and enter the description.

6 Click OK.

7 Select File, Save.

The problem class you assign does not appear until you refresh the information in the table.

Clearing the Buffer Table
To clear the buffer table, select File, Delete. If you are sure you want to clear the table, click the Yes 
button in the dialog box.

Viewing Buffer Statuses as a Graph
You can view buffer status information as a graph. After you choose which buffers to display in the 
table, select View, Buffer Status Graph. The information from the table is presented in graph form. 
You can see the green, yellow, and red zones for each buffer and the percentage of buffer consumed. 
For time buffers, you can also view the percentage complete.

Analyzing Buffer Status Information
When you monitor your buffer statuses on a regular basis, you can identify which buffers are 
constantly being over used or under used and make adjustments.

Generally, you should strive for buffer statuses between 33 and 66 percent. Regular figures under 33 
percent indicate that your buffers are oversized and should be reduced. Regular figures above 66 
percent indicate that your buffers are undersized and should be increased.

If only certain work orders have consumed too much of the buffers, you can adjust the buffers for 
those work orders only. Make these adjustments by using buffer factors. You can specify buffer 
factors in DBR Maintenance or in the Manufacturing Window. Use this option with care. It can be 
difficult to manage many different work order factors. 

Statuses appear in the following formats:

Red – Red numbers indicate that the amount of remaining buffer has fallen below the level of the 
Emergency Zone % you set in the Buffer Management window.
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Red buffer statuses indicate that further investigation is warranted. The last completed process 
for the work order is displayed in the Last Piece(s) Sub ID/Seq ID column. Use this operation or 
piece number as the starting point for your investigation. Work backward from this point to 
analyze where the excess buffer penetration occurred. 

Black – Black numbers indicate that the current buffer penetration is below your emergency zone 
level and demand exists for the part. Use the Last Piece(s) Sub ID/Seq ID information to identify 
where the issues are occurring. 

Using Buffer Management Tools
Use the buffer management tools to analyze your production. Having an accurate picture can greatly 
help you to make more appropriate decisions about what to do in cases of excessive buffer 
penetrations.

Viewing Problem Work Orders
Use the Problem Work Orders tool to help you view your work orders that are expected to be late due 
to either lack of material or contention for CCR capacity during the planning process.

To view problem work order information, select Info, Problem Work Orders.

This tool is also available in the DBR Scheduler window. See "Viewing Problem Work Orders" on 
page 17–63 in this guide. 

Viewing Problem Operations
Use the Problem Operations to view operations on your CCRs that lack their material requirements.

This tool is also available in the DBR Scheduler window. See "Viewing Problem Operations" on page 
17–64 in this guide.

Viewing Problem Requirements
Use the Problem Requirements dialog box to view materials that are causing delays. 

This tool is also available in the DBR Scheduler window. See "Viewing Problem Requirements" on 
page 17–64 in this guide.
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Viewing Shipment Schedules
Use the Shipment Schedules dialog box to view the status of your customer orders and information 
about the work orders associated with them.

This tool is also available in the DBR Scheduler window. See "Viewing the Customer Order Shipment 
Schedule" on page 17–59 in this guide.

Viewing the Material Release Schedule
Use the Material Release Schedule dialog to view the current state of the material release schedule. 
The Material Release Schedule shows information for the current date only.

This tool is also available in the DBR Scheduler window. See "Displaying the Material Release 
Schedule" on page 17–60 in this guide.

Viewing the Selected Work Order
To view open a work order in the Manufacturing Window, select the line. Then, select View, Selected 
Work Order.

Viewing the Selected Work Order Status
To view the buffer status of a line item in the table, select the line. Then, select View, Selected Work 
Order Status. While the menu item indicates that the dialog applies to work orders only, you can also 
view the buffer status of purchase orders and parts. If you do select a work order, information about 
the order’s operations and material release schedule is also displayed.

This tool is also available in DBR Maintenance. See "Viewing Work Order Status Information" on 
page 17–72 in this guide.

Viewing Selected Work Order Customer Order Status
Use this tool to view the status of the customer orders linked to the work order you selected in the 
table. To use this tool:

1 Select the work order in the table.

2 Select View, Selected Work Order Customer Order Status.

3 This information is shown in the header:
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Total Production – The total amount on the work order, the portion of the work order allocated to 
the customer order, the total received, and the total quantity of the allocation complete is 
displayed.

Total Order – The total amount order on the customer order and the total amount of the order that 
has shipped is displayed.

4 In the Show section, specify the information to display in the table. Click Original Booked 
Order(s) to view information about the original order. Click Backlog to view backlogged orders. 
Click Shipments to view information about the shipment.

5 In the table, view this information:

Order ID – The ID of the customer order is inserted.

Ln # – The line number linked to the work order is inserted.

Packlist ID – If you selected Shipments in the Show section, the ID of the packlist on which the 
order shipped is inserted.

Del Ln # – If you selected Shipments in the Show section, the delivery line number on which the 
order shipped is inserted.

Customer ID – The ID of the customer who placed the order is inserted.

Misc/Reference – Reference information included in the customer order line is inserted. If no 
reference information was provided, then a description of the part is inserted.

Part ID – The ID of the ordered part is inserted.

Description – The description of the part is inserted.

Customer Part ID – The ID that the customer uses to identify this part is inserted.

Order Qty – The quantity of part ordered is inserted.

Shipped Qty – The quantity of part shipped to the customer is inserted.

Status – The current status of the customer order line inserted.

Ship On – The desired ship date from the customer order or customer order line is inserted.

Promise Date – The promise ship date from the customer order or customer order line is 
inserted.

Viewing Selected Work Order Buffers
To view all buffers applied to a work order, use the Selected Work Order Buffers tool. To use this tool:

1 Select a work order line in the table.

2 Select View, Selected Work Order Buffers.

3 This information is displayed:

Status Calculated Date – The date that buffer statuses were last calculated is inserted.
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CCR ID – The ID of the CCR is inserted. For the capacity constrained resource, the ID of the 
resource is inserted. For stocked parts, STOCKED_PART is inserted. 

Sub ID – The work order sub ID is inserted.

Seq No – The operation sequence number where the buffer is applied is inserted.

Piece No – The piece number of the material requirement is inserted.

Buffer Status – The percentage of the buffer used is inserted.

Est. % Complete – The estimate of the percentage of the work order that is complete is inserted. 
This information is displayed for time buffers only.

Type – The type of buffer is inserted.

Active/Closed – The status of the buffer operation is inserted.

Size – The size of the buffer in hours is inserted.

Part ID – If the buffer applies to a particular part, the ID of the part is inserted. Generally, a part ID 
is inserted for stocked part buffers.

Showing the Material Planning Window for a Part
To open the Material Planning Window for the part on the line, select the line. Then, select View, 
Show Material Planning for Part.

Viewing Resource Operations Buffer Status
Certain buffers, such as the shipping buffer, apply to non-CCR operations. This tool is also available 
in the DBR Maintenance window and in the Shop Resource window.

This tool is also available in the DBR Scheduler window. See "Viewing Buffer Statuses of Non-CCR 
Operations" on page 17–73 in this guide.

Viewing MTO/MTS Buffer Information
Use the MTO/MTS Buffer Analysis tool to view a history of buffer intrusions for the current year. This 
tool can help you analyze buffer intrusion patterns.

To view this buffer information:

1 If you are licensed to use multiple sites, in the Buffer Management window click the Site ID button 
and select the site whose buffer intrusions you want to view. If you are licensed to use a single 
site, this field is unavailable. 

2 Select View, MTO/MTS Buffer Analysis.

3 Specify the time period to view in the table:
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Start Date – Specify the first date in the time period. You must specify a date in the current year. If 
you specify a date in a different year, the value is the field defaults to the first day of the current 
year.

End Date – Specify the last date in the time period.

4 In the Group Period section, click Weekly to view buffer intrusions on a weekly basis. Click 
Monthly to view buffer intrusions on a monthly basis. If you click Monthly, the start date is 
adjusted to the first date within the month.

5 In the Display Type section, click the buffer information to view. Click one of these options:

MTO Orders – To view buffer intrusions for your made-to-order orders, click this option.

MTS Orders – To view buffer intrusions for your made-to-stock orders, click this option.

Purchase Orders – To view lead-time buffer intrusions for purchases, click this option.

Fabricated Parts – To view buffer intrusions for all fabricated parts, click this option.

Purchase Parts – To view buffer intrusions for all purchased parts, click this option.

6 To populate the table, click Refresh.

7 View this information in the table:

CCR ID – The ID of the CCR is inserted.

Period Begin – The start date of the period is inserted. This date may not match the Start Date 
you specified in the header. The first date that buffer statuses were generated after the start date 
you specified is used in this field. 

Days in Period – The number of times that buffer statuses were generated during the period is 
inserted.

# Open Items – The total number of open orders is inserted.

# Emergency Zone Intrusions – The number of times that the CCR entered the emergency zone 
portion of a buffer is inserted.

# Emergency Zone Intrusions Per Open Item – The number of emergency zone intrusions is 
divided by the number of open items. 

# Yellow Zone Intrusions – The number of times that the CCR entered the yellow zone portion of 
a buffer is inserted.

# Yellow Zone Intrusions Per Open Item – The number of yellow zone intrusions is divided by 
the number of open items. 

# Buffer Intrusions – The total number of times the CCR entered a buffer zone is inserted.

# Buffer Intrusions Per Open Item – The number of buffer intrusions is divided by the number of 
open items.

At the bottom of the table, the sum of the number of days, open items, and buffer intrusion information 
is inserted. The average number or open items and average buffer intrusion information is also 
inserted. 
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Stocked Part Buffer Analysis
Use the Stocked Part Buffer Analysis tool to analyze emergency zone buffer intrusions over time. The 
tool shows the number of working days spent in the emergency zone each month.

To view this buffer information:

1 If you are licensed to use multiple sites, in the Buffer Management window click the Site ID button 
and select the site whose buffer intrusions you want to view. If you are licensed to use a single 
site, this field is unavailable. 

2 Select View, Stocked Part Buffer Analysis.

3 In the header, specify the information to show in the table. Specify this information:

Part ID – To view information for a particular stocked part, specify the ID in this field.

Warehouse ID – This field is available only if you plan by warehouses. Specify the buffer 
information to use. To use buffer information specified for a particular warehouse, select the 
warehouse ID in this field. To use buffer information specified for your universal warehouses, 
select Universal.

End Month – Specify a date in the final month to use in the analysis.

Months in Period – Specify the number of months to include in the analysis. For example, if 
specify a 6 in this field and 7/31/2013 in the End Month field, then the analysis will include 
information from 2/1/2013 to 7/31/2013.

Work Days in Period – After you specify the number of months in the period, the number of work 
days based on the production schedule is inserted.

4 View this information in the table:

Month Of – The first day of the month in the line is inserted.

Days in Emergency Zone – The number of days during the month that stock level of the part fell 
into the emergency zone.

Working Days – The number of working days during the month is inserted.

Days in Emerg. Zone/Working Days – The average number of work days during the month that 
the stock level of the part fell into the emergency zone.

Emergency Zone – The emergency zone is inserted. This is calculated by subtracting the 
emergency stock percentage from 100.

Yellow Zone – The yellow zone of the part is inserted. This is calculated by subtracting the yellow 
zone stock percentage from 100.

5 To display the information in the table as a graph, click the Graph button.

To export the information in the table to Microsoft Excel, click the Send to Excel button.
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Viewing Stocked Part On-hand Alerts Information
This dialog box shows supply problems with stocked parts. Parts are displayed in this table if their 
current stock level is less than or equal to their top of yellow zone quantity. The top of yellow zone 
quantity is the total of your top of red zone and the yellow zone. You can also display parts that are 
over-stocked. An over-stocked part is a part whose quantity exceeds the top of green zone. 

To view this information:

1 If you are licensed to use multiple sites, in the Buffer Management window click the Site ID button 
and select the site whose buffer intrusions you want to view. If you are licensed to use a single 
site, this field is unavailable. 

2 Select View, Stocked Part On-hand Alerts.

3 Specify the information to view in the analysis. Specify this information:

Warehouse ID – This field is displayed only if you plan by warehouse. To view information for a 
particular independently planned warehouse, specify the warehouse in this field. To view 
information for your universally planned warehouses, specify Universal. To view information for all 
warehouses, specify All Warehouses.

Part Type – Under the warehouse ID field, specify the type of part to view in the analysis. To view 
fabricated parts only, click Fabricated. To view purchased parts only, click Purchased. To view all 
parts, click All.

Include Overstock – To include parts that are overstocked, click this check box. An overstocked 
part has an on-hand quantity that exceeds the top of green level. To exclude overstocked parts 
and view only those parts with stock levels less than or equal to their top of yellow zone, clear this 
check box.

Include Green Zone – To include parts with on-hand buffer statuses in the green zone, select this 
check box. To exclude parts with on-hand buffer statuses in the green zone, clear this check box.

4 View this information in the table:

Part ID – The ID of the part is inserted.

On-hand Buffer Status – The current on-hand buffer status is inserted. This column takes into 
consideration only parts that are currently in your inventory. Parts on order are ignored. This 
formula is used to calculate the current on-hand buffer status: ((Replenishment level – on-hand 
quantity) / Replenishment level) * 100. The cell is shaded in red if the calculated buffer status falls 
into the on-hand red alert zone. If the buffer status is in the red zone but not in the red alert zone, 
then the part is considered to be in the yellow zone for this analysis. If you are viewing 
overstocked parts, a negative number indicates that the part is overstocked.

Fab – If this part is a fabricated part, then this check box is selected. If this part is not a fabricate 
part, then this check box is cleared.

Pur – if this part is a purchased part, then this check box is selected. If this part is not a purchased 
part, then this check box is cleared.

Quantity On-hand – The quantity of this part currently in your inventory is inserted.

Quantity On-order – The quantity of this part currently on order during the planning lead-time is 
inserted. The demand horizon is specified in Part Maintenance.



Managing Buffers

Infor VISUAL Inventory User’s Guide | 17 – 87

Quantity In-demand – The current demand for this part during the planning lead-time is inserted. 
The demand horizon is specified in Part Maintenance.

Avail. Buffer Status – The available buffer status is calculated and inserted in this field. This 
formula is used to calculate the current available buffer status: (replenishment level - (qty on-hand 
+ qty on-order - qty in-demand)) / replenishment level * 100. 

Planning Horizon End Date – The last date used to find supply and demand for this part. The 
planning lead-time value is added to the current date to calculate this value.

Low Red Zone – The buffer status that defines the bottom of the red zone is inserted. 

Low Yellow Zone – The buffer status that defines the bottom of the yellow zone is inserted. 

Low Alert Status – The buffer status that defines the bottom of the red alert zone is inserted.

Planning Lead-time – The number of days into the future that supply and demand is considered 
for this analysis.

To view the information in the table as a graph, click Graph.

To export the information in the table to Microsoft Excel, click Send to Excel.

Viewing Stocked Parts Projected Buffer Alerts
This dialog box shows potential supply problems with stocked parts. Parts are displayed in this table if 
their current stock level is less than or equal to the alert buffer status. This calculation is used to 
calculate the alert buffer status: (replenishment level - (replenishment level * yellow stock percent / 
100)) / replenishment level * 100.

In this analysis, the actual average daily usage for a part is used to calculate anticipated use during 
the planning lead-time period. 

To view this information:

1 If you are licensed to use multiple sites, in the Buffer Management window click the Site ID button 
and select the site whose buffer intrusions you want to view. If you are licensed to use a single 
site, this field is unavailable. 

2 Select View, Stocked Part Projected On-hand Alerts.

3 Specify the information to view in the analysis. Specify this information:

Warehouse ID – This field is displayed only if you plan by warehouse. To view information for a 
particular independently planned warehouse, specify the warehouse in this field. To view 
information for your universally planned warehouses, specify Universal. To view information for all 
warehouses, specify All Warehouses.

Part Type – Under the warehouse ID field, specify the type of part to view in the analysis. To view 
fabricated parts only, click Fabricated. To view purchased parts only, click Purchased. To view all 
parts, click All.
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Include Projected Overstock – To include parts that are projected to be overstocked, click this 
check box. An overstocked part has an on-hand quantity that exceeds the top of green level. To 
exclude projected overstocked parts and view only those parts with projected stock levels less 
than or equal to their top of yellow zone, clear this check box.

Include Projected Green Zone – To include parts with projected on-hand buffer statuses in the 
green zone, select this check box. To exclude parts with projected on-hand buffer statuses in the 
green zone, clear this check box. Parts in the green zone are not presenting supply issues.

4 View this information in the table:

Part ID – The ID of the part is inserted.

Avail. Buffer Status – The available buffer status is calculated and inserted in this field. This 
formula is used to calculate the current available buffer status: (replenishment level - (qty on-hand 
+ qty on-order - qty in-demand)) / replenishment level * 100. 

Status Comment – If a projected buffer issue exists, a description of the problem is inserted. 
These messages are used:

• Stock out in # days, where # is the number of days from the current date when stock out is 
projected to occur.

• Stock out w/demand in # days, where # is the number of days from the current date when 
stock out is projected to occur.

• % buffer status in # days, where % is the buffer status and # is the number of days from 
the current date when this buffer status is projected to occur.

Fab – If this part is a fabricated part, then this check box is selected. If this part is not a fabricate 
part, then this check box is cleared.

Pur – if this part is a purchased part, then this check box is selected. If this part is not a purchased 
part, then this check box is cleared.

Planning Lead-time – The number of days into the future that supply and demand is considered 
for this analysis.

Quantity On-hand – The quantity of this part currently in your inventory is inserted.

Quantity In-demand Over Lead Time – The current demand for this part during the planning 
lead-time is inserted. The demand horizon is specified in Part Maintenance.

Average Daily Usage – The average daily usage of this part is inserted. This value is calculated 
by identifying the quantity of this part issued during the average daily usage horizon, and then 
dividing the quantity by the average daily usage horizon. The average daily usage horizon is 
specified in Part Maintenance.

Avg. Daily Usage Over Lead-time – The average daily usage of this part is multiplied by the 
planning lead-time to calculate the anticipated average daily usage of this part. 

Quantity On-order – The quantity of this part currently on order during the planning lead-time is 
inserted. The demand horizon is specified in Part Maintenance.

Planning Horizon End Date – The last date used to find supply and demand for this part. The 
planning lead-time value is added to the current date to calculate this value.

Low Red Zone – The buffer status that defines the bottom of the red zone is inserted. 

Low Yellow Zone – The buffer status that defines the bottom of the yellow zone is inserted. 
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Low Alert Status – The buffer status that defines the bottom of the red alert zone is inserted.

To view the information in the table as a graph, click Graph.

To export the information in the table to Microsoft Excel, click Send to Excel.

Viewing Part Planning Information
To view the planning information for a part in either the Stocked Part On-hand Alerts dialog or the 
Stocked Part Projected On-hand Alerts dialog, double-click the part’s line in the dialog box. 

To determine the information to display in the table, specify these options:

Planning Horizon – The planning horizon value from the on-hand alerts dialog is inserted. You can 
specify a different end date. 

Net Available Quantity – To net this part based on available quantity, select this check box. 
Available quantity is the quantity on-hand minus any quantity allocated to a demand order. To net this 
part based on on-hand quantity, clear this check box.

Deduct Safety Stock – To deduct the safety stock quantity defined for the part from the available 
quantity, select this check box. To include the safety stock in the available quantity, clear this check 
box.

Include Planned Orders – To include planned orders generated by the DBR scheduler, select this 
check box. To omit planned orders, clear this check box.

Show Detail Quantity – To include detailed quantity information, select this check box. When you 
select this check box, these columns are displayed:

• Total Qty Required
• Qty Issued
• Qty Ordered
• Qty Received

To include summary quantity information only, clear this check box.

Show Unreleased – To include unreleased orders in the material netting calculation, select this 
check box. To omit unreleased orders in the material netting calculation, clear this check box.

Show Firmed – To include firmed orders in the material netting calculation, select this check box. To 
omit firmed orders in the material netting calculation, clear this check box.

Show On-hold – To include on-hold orders in the material netting calculation, select this check box. 
To omit on-hold orders in the material netting calculation, clear this check box.

View this information in the table:

Demand Warehouse – If a warehouse is associated with the demand order, the warehouse ID is 
inserted.

Date Required – The date that the demand is required to be met is inserted.

Total Qty Required – The total quantity of part required on the demand order is inserted.

Qty Issued – The total quantity of part that has been issued to meet the demand is inserted.
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Qty Required – The remaining quantity required by the demand. This is equal to the total quantity 
required minus the quantity issued.

Stat – The status of the demand order is inserted. These statuses are used:

R –The order is released.

F – The order is firmed.

U – The order is unreleased.

O – The order is on hold.

Peg To – The ID of the demand order is inserted. To open the demand order, double-click in the Peg 
To field.

Demand Dimensional Info – If the part is a dimensional part, the dimensions from the demand order 
are inserted.

Required WBS – If you are licensed to use Project/A&D, the WBS code associated with the demand 
order is inserted.

Projected Quantity – The projected quantity for the line is inserted. This is the projected on-hand 
quantity after a supply order has been received and the demand order has consumed its requirement 
from the supply order and any existing on-hand balance.

Supply Warehouse – If the supply order is associated with a particular warehouse, the warehouse ID 
is inserted.

Qty Ordered – The quantity of the supply order is inserted.

Qty Received – The quantity of the supply order received is inserted.

Net Due Qty – The remaining quantity of the supply order that is due to be received is inserted.

Due Date – The date that the supply order is due to be received is inserted.

Rls Date – The date the supply order was released is inserted.

Stat – The status of the supply order is inserted. These statuses are used: 

R –The order is released.

F – The order is firmed.

U – The order is unreleased.

O – The order is on hold.

Issue Late – If the supply should have already been issued, the number of days ago that the supply 
should have been issued is inserted. 

Ord Late – If the supply order is late, the number of days late is inserted.

Rls Late – If the release of the order is late, the number of days late is inserted.

Sugg Rls Late – If the suggested release date is in the past, the number of days late is inserted.

Ord Proj Early – If the supply order is scheduled to be complete earlier than its due date, the number 
of days early is inserted.

Ord Proj Late – If the supply order is scheduled to be complete later than its due date, the number of 
days late is inserted.
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Stock Out – If demand is greater than supply, the quantity of demand in excess of supply is inserted.

Over Stock – If supply is greater than demand, the quantity of supply in excess of demand is 
inserted.

Exception – If a material netting issue exists, a description of the issue is inserted.

Suggested Release – The suggested release date of the supply order is inserted.

Sched Start – The date that the supply order is scheduled to start is inserted.

Sched Finish – The date that the supply order is scheduled to be complete is inserted.

Supply Dimensional Info – If the part is a dimensional part, the dimensions from the supply order 
are inserted.

Due WBS – If you are licensed to use Project/A&D, the WBS code associated with the supply order is 
inserted.

Rls Near – If the order’s release date is in the near future, this check box is selected.

Sugg Rls Near – If the suggested release date is in the near future, this check box is selected.

To export the information in the window to Microsoft Excel, click Send to Excel.

Generating Buffer Management Reports
You can generate these reports from the Buffer Management window:

• Common Materials Report
• Stocked Material Buffer Status Report
• Shipping/Delivery Report 

Common Materials Report
This report is also available in the DBR Scheduler. See "Generating the Common Materials Report" 
on page 17–67 in this guide.

Generating the Stocked Material Buffer Status Report
Use this report to analyze information about your stocked parts. The information in this report 
matches the information displayed in the Buffer Management table when you select Stocked Parts in 
the Display section. Since you can print this report for different buffer status generation dates, you 
can use these reports to analyze how your stocked part buffers have been used over time.

To generate this report:
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1 If you are licensed to use multiple sites, in the Buffer Management window click the Site ID button 
and select the site to use in the report. If you are licensed to use a single site, this field is 
unavailable. 

2 Select File, Print Stocked Material Buffer Status Report.

3 Specify the information to include in the report. Specify this information: 

Buffer Status Generated On – Specify the buffer status date for this report. If you select a date 
on which you did not generate buffers, you will receive a warning message. 

Warehouse ID – This field is displayed only if you plan by warehouse. To include information for a 
particular independently planned warehouse, specify the warehouse in this field. To include 
information for your universally planned warehouses, specify Universal. To include information for 
all warehouses, specify All Warehouses.

Product Code – To include information for parts assigned to a particular product code, specify the 
product code in this field. To include information for parts assigned to any product code or no 
product code, leave this field blank.

Buyer – To include parts purchased by a particular buyer, specify the buyer ID in this field. To 
include parts assigned to any buyer or no buyer, leave this field blank.

Planner – To include parts managed by a particular planner, specify the planner ID in this field. To 
include parts assigned to any planner or no planner, leave this field blank.

Part Type – Use the options under the Planner field to specify the type of part to include in the 
report. Click Fabricated to view stocked fabricated parts only. Click Purchased to view stocked 
purchased parts only. Click Fab/Pur to view stocked fabricated parts that are also purchased. 
Click All stocked parts to view all stocked parts.

Buffer Status Threshold – To view only stocked parts whose buffer status is at or above a certain 
value, specify the value in this field. Leave this field blank to view stocked parts with any buffer 
status.

Include All Parts in Emergency Zone – To view stocked parts in the emergency zone regardless 
of the buffer status threshold, select this check box. Clear this check box to use the buffer status 
threshold only.

4 Specify the output format for this report. Select one of these options:

Print – Select this option to print the report.

View – Select this option to view the report on your screen.

File – Select this option to export the report to a comma-separated file.

E-mail – Select this option to e-mail the report. To e-mail the report as a PDF, select the PDF 
Format check box. To e-mail the report as a comma-separated file, clear this check box.

5 To generate the report, click Ok.
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Generating the Shipping/Delivery Report
The Shipping/Delivery report provides information on all firm and released customer order lines and 
the work orders linked to them.

A customer order lines with a status of Firmed or Released are included in the report. Order lines with 
a status of Inherit are also included if the header status of the order is Firmed or Released.

To generate this report:

1 If you are licensed to use multiple sites, in the Buffer Management window click the Site ID button 
and select the site to use in the report. If you are licensed to use a single site, this field is 
unavailable. 

2 Select File, Shipping/Delivery Report.

3 Specify the information to include in the report. Specify these settings:

Starting Due Date and Ending Due Date – To view customer orders due during a particular 
range of dates, specify the starting date of the range in the Starting Due Date field and the ending 
date of the range in the Ending Due Date field. To view all orders, leave both fields blank.

Starting Customer ID and Ending Customer ID – To view orders for a particular range of 
customers, specify the starting ID of the range in the Starting Customer ID field and the ending ID 
of the range in the Ending Customer ID field. To view all customers, leave both fields blank. To 
view a single customer, specify the same ID in the both fields.

Starting Part ID and Ending Part ID – To view orders for a particular range of parts, specify the 
starting ID of the range in the Starting Part ID field and the ending ID of the range in the Ending 
Part ID field. To view orders for all parts, leave both fields blank. To view orders for a single part, 
specify the same ID in the both fields.

Starting Work Order ID and Ending Work Order ID – To view customer orders associated with a 
particular range of work orders, specify the starting ID of the range in the Starting Work Order ID 
field and the ending ID of the range in the Ending Work Order ID field. To view customer orders 
associated with all work orders, leave both fields blank. To view customer orders associated with 
a single work order, specify the same ID in the both fields.

4 In the Include Supply From section, specify the sources of supply to use in the report. To view 
customer orders with linked work orders only, select the Work Orders check box. When you 
select this check box, the work order ID fields are unavailable. 

5 In the Sequence section, select how to sort the information in the report. You can select:

• Due Date
• Order ID
• Customer ID
• Customer Name
• Part ID
• Supply ID

6 In the Subsequence section, select the secondary sort order for the report. You can select:

• Order ID
• Customer ID
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• Customer Name
• Part ID
• Supply ID

7 Click the output arrow and select the output method for the report:

Print – To send the report to your printer, select the Print option.

View – To view the report using the report viewer, select the View option.

File – To send the report to text file, select the File option. Your report is prepared as a RTF file 
and a dialog box appears prompting you to enter the location and file name for the file to be 
saved.

E-mail – To prepare the report and attach it to an e-mail, select the E-mail option. The report is 
prepared as a RTF file and it is attached to a Microsoft Outlook e-mail. To attach a PDF (Portable 
Document Format) file to your e-mail instead of a RTF file, select the PDF Format check box in 
the Type section.

8 Click the Print button.
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Using the Buffer Management Dashboard
Use the Buffer Management Dashboard to view changes to your buffer statuses as they happen. 
While the Buffer Management window provides you with a daily snapshot of your buffer statuses that 
you can compare over time, the Buffer Management Dashboard displays changes to your buffer 
statuses as they occur.

Many events can trigger changes in buffer statuses. If you manually change a buffer size, the buffer 
status will also change. For buffers measured in hours or days, changes in want dates on demand 
orders and the passage of time cause changes in buffer status. For stocked part buffers, any event 
that causes a change in the on-hand quantity can change the stocked part buffer status.

These common business events cause a change in buffer status:

• Customer Order Header
• Changing the status of an order
• Changing the desired ship date of the order

• Customer Order Line
• Inserting or deleting a customer order line
• Changing the line status
• Changing the desired ship date on the line
• Changing the order quantity
• Changing the part ID

• Customer Order Delivery Schedule Line
• Inserting or deleting a delivery schedule line
• Changing the desired ship date on the delivery schedule line
• Changing the delivery schedule quantity

• Parts
• Adding or deleting a part
• Changing the quantity available for MRP
• Changing the quantity on order
• Changing the quantity on demand
• Changing the replenishment level
• Changing the part status

• Purchase Order Header
• Changing the status of the order
• Changing the desired receive date

• Purchase Order Line
• Inserting or deleting a purchase order line.
• Changing the status of a line
• Changing the desired receive date on a line
• Changing the order quantity

• Purchase Order Delivery Schedule Line
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• Inserting or deleting a delivery schedule line
• Changing the desired receive date on the delivery schedule line
• Changing the delivery schedule quantity

• Work Order Header
• Adding or deleting a work order
• Changing the work order header status
• Changing the desired want date
• Changing the part ID

• Work Order Operations
• Inserting or deleting an operation
• Changing the set up hours
• Changing the run hours
• Changing the status
• Changing the resource ID

• Work Order Material Requirements
• Adding or deleting a material requirement to a work order
• Changing the requirement’s status
• Changing the part ID of the requirement

Accessing the DBR Dashboard
Select Scheduling, DBR Dashboard. 

Setting Up the DBR Dashboard
Use the procedures in this section to customize the DBR Dashboard. You can specify how often the 
DBR Dashboard checks for events that affect buffers. After you decide which tools to view in the 
Dashboard, you can save the configuration. 

Specifying the Update Interval
To specify how often the DBR Dashboard updates buffer information:

1 Select Tools, Options.

2 To refresh the information in the dashboard automatically, select the Refresh Automatically 
check box. After you select the check box, specify how frequently to check for new information in 
the Refresh Every fields. To refresh the information manually, clear the Refresh Automatically 
check box.
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Regardless of the setting you choose, you can refresh the information in the dashboard at any 
time by clicking the Refresh button on the toolbar.

3 Click the Ok button.

Saving a Default Dashboard Configuration
After you decide which tools to view in the window, you can save the configuration as your default 
configuration for quick access later.

To save your default configuration:

1 Choose the tools to display in the window.

2 Click the Save button.

As you analyze your buffer information, you might close certain tools and open others. To restore the 
dashboard to your default settings, click the View drop-down button and re-select Default.

Viewing Information in the Dashboard
Use the DBR Dashboard tool to set up the basic information to view in the dashboard. The 
information you select in the dashboard applies to the tools you open.

Specify this information:

Site ID – Specify the site ID to view.

Max # Buffers – Specify the maximum number of buffers to include in the tools.

Show Zones – Specify the buffer zones to view in the tools. 

Apply to All – Select this check box to apply your buffer zone settings to all currently open tools. 
Clear this check box if you do not want to apply your buffer zone settings to currently open tools.

Using Tools
These tools are available:

Buffer Management – The Buffer Management Tool is identical to the Buffer Management window. 
For procedures, see "Managing Buffers" on page 17–75 in this guide.

When you use the Buffer Management Tool, you can set the Site ID using the Dashboard Toolbar or 
using the Site ID field in the Buffer Management Tool. It is recommended that you set the Site ID 
using the Dashboard Toolbar. The site for all other buffer tools is set using the Dashboard Toolbar, so 
setting the site directly in the Buffer Management Tool can result in a mismatch of data between the 
Buffer Management Tool and the other tools.
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Shipping Buffer Status – Use this tool to view the status of the shipping buffers attached to your 
work orders. 

CCR Buffer Status – Use this tool to view the buffer status of your CCRs.

Assembly Buffer Status – Use this tool to view the status of your assembly buffers.

Replenishment Work Orders Buffer Status – Use this tool to view the status of your replenishment 
work orders.

Purchase Order Buffer Status – Use this tool to view the status of your purchase order buffers.

Stocked Material Buffer Status – Use this tool to view the status of your stocked material buffers.

Resource Operations Buffer Status Graph – Use this tool to view the buffer status of non-CCR 
operations.

Planned Load Graph – Use this tool to view the load for resources you are tracking. When you select 
this tool, specify this information:

Resource ID – To view planned load information for a particular resource, select the resource. 
Only the resources whose load you are monitoring are displayed. To view planned load 
information for all resources whose load you are monitoring, select *All*.

Load Horizon – Specify the number of days from today’s date to look for demand. The value you 
specify here determines the end date of the demand horizon.

Create a Horizon Every – To specify a subset of the load horizon, specify the subset in this field. 
For example, if you specified 30 in the Load Horizon field, but wanted to view demand information 
for every two days, specify 2 in this field.

Show Intermediate Horizons – To display a line for every horizon subset as defined in the 
Create a Horizon Every field, select this check box. To display a single line for the horizon 
duration specified in the Load Horizon field, clear this check box.

Apply Calendar Exceptions – To take into account any calendar exceptions, select this check 
box. To ignore calendar exceptions and use the standard shop schedule in the load analysis, 
clear this check box.

Throughput – See Using the Throughput Tool.

Buffer Intrusions Percentage – See Using the Buffer Intrusions Tool.

Using the Throughput Tool
Use the Throughput Tool to help analyze the profitability of your business.

The throughput value of something you make, if you have no order from a customer for it, is zero. In 
fact, it may be a liability; you have spent money to produce it and may not sell it.

The throughput value of something you have sold is defined as its price less the cost of materials and 
outside services that went into it. Profit is throughput less operating expense.

To view throughput:

1 Select Tools, Throughput.
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2 Specify the information to display in the table. Specify this information:

Start Date and End Date – To view throughput information for a specific date range, specify the 
first date of the range in the Start Date field and the end date of the range in the End Date field. To 
view information for all dates, leave this field blank.

Part ID – To view throughput information for a particular part, click the browse button and select 
the ID. To add more parts, repeat this step. As you select parts, they are added to the drop-down 
menu. To save this list, use the Part View field. Specify a name for this particular set of parts in the 
Part View field. When you access the Throughput Tool again, specify the Part View to use in the 
Part View field.

Customer ID – To view throughput information for a particular customer, click the browse button 
and select the ID. To add more customers, repeat this step. As you select customers, they are 
added to the drop-down menu. To save this list, use the Customer View field. Specify a name for 
this particular set of customers in the Customer View field. When you access the Throughput Tool 
again, specify the Customer View to use in the Customer View field.

Table View – Use this field to store the table configuration. After you arrange the columns in the 
table, specify a name for the arrangement in the Table View field. When you access the 
Throughput Tool again, specify the Table View to display the table arrangement.

Group By – Specify how to group the throughput information in the table.

Show – Specify the type of throughput information to view. Select these check boxes:

Actual Throughput – Actual throughput uses shipment data and actual costs to determine 
throughput. The unit price, discount percent, and commission percent are obtained from the 
shipper line. If this information is not available on the shipper line, then it is obtained from the 
customer order line.

Estimated Throughput – Estimated throughput uses customer order line data and estimated 
costs from the linked supply order.

Remaining Throughput – Remaining throughput uses actual throughput data and expected 
throughput data to determine the remaining throughput. Actual throughput is used for any 
shipped quantity and estimated data is used and prorated according to the remaining quantity 
to ship.

Projected Throughput – Projected throughput uses actual throughput data and remaining 
throughput data to determine the projected throughput.Generally, the projected throughput is 
the sum of actual and remaining throughput.

3 In the Throughput based on section, select which documents to use to generate throughput 
information. Click one of these options: 

C/O Desired Ship Date – Click this option to use customer orders. When you select this option, 
customer orders with ship dates within the date range you specify are inserted into the 
appropriate time buckets. Customer orders with a status of on-hold or canceled are not 
considered. Since information on the customer order is considered to be an estimate, selecting 
this option makes the most sense if you are viewing estimated throughput. 

Shipment Date – Click this option to use shipments. When you select this option, shipments with 
dates within the date range you specify are inserted into the appropriate time buckets. Since the 
costs on the shipment are actual costs, selecting this option makes the most sense if you are 
viewing actual throughput. 
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Invoice Date – Click this option to use receivable invoices. When you select this option, 
receivable invoices with dates within the date range you specify are inserted into the appropriate 
time buckets. Since the costs on the receivable invoice are actual costs, selecting this option 
makes the most sense if you are viewing actual throughput.

Work Order Want Date – Click this option to use work orders. When you select this option, work 
orders with desired want dates within the date range you specify are inserted into the appropriate 
time buckets. Unreleased and canceled orders are not considered. Work orders can be used to 
determine actual, estimated, and remaining throughput. 

4 Click Go.

5 This information is displayed in the table:

Throughput per Unit/CCR Minutes Per Unit – For each unit, the amount of throughput 
generated for every minute on the CCR is inserted. The higher the value, the more the product 
contributes to your profit.

Throughput per Unit – The amount of throughput for each unit is inserted. If you do not have a 
CCR, use this field to assess a part’s profitability. The higher the value, the more the product 
contributes to your profit.

CCR Minutes per Unit (MPU) – For each unit, the amount of CCR time the unit consumes is 
inserted. 

Total CCR Minutes – The total amount of time the CCR is used is inserted. This amount of time 
is calculated by adding the set up hour and run hours spent on the CCR and multiplying the value 
by 60. 

Throughput/CCR Minutes – The amount of throughput generated for each minute spent on the 
CCR is inserted. You can use this value to rank the performance of the part. The higher the 
throughput value, the more profitable the part is. 

Throughput per Unit/Production Hours per Unit – If you do not use a CCR, use this value to 
assess the profitability of a product. For each unit, the amount of throughput generated for every 
hour the unit is in production is inserted. If you use a CCR, the Throughput/CCR Minutes value is 
a better measure of a product’s profitability.

Production Hours per Unit (HPU) – The number or product hours required to make one unit of 
the part is inserted. 

Total Production Hours – The total production time for the work order is inserted. For estimated 
values, this is the sum of the estimated set up hours and run hours for all operations. For actual 
values, the actual set up time and run time are used. 

Throughput/Production Hours – The total throughput for each hour of production is inserted. If 
you use a CCR, the Throughput/CCR Minutes value is a better measure of a product’s 
profitability.

Throughput (TP) – The total throughput. Throughput is calculated using this formula: Sales 
amount - material cost - service cost.

Material Cost – The total material cost from the work order is inserted.

Service Cost – The total service cost from the work order is inserted.

Gross Amount – The gross amount of the customer order is inserted. Gross amount is calculated 
using this formula: Unit Price * User Quantity.
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Discount Amount – The discount amount offered to the customer is inserted. Discount amount is 
calculated using this formula: gross amount * (trade discount pct / 100).

Commission Amount – The total commission paid to the sales representative is inserted. The 
commission amount is calculated using this formula: (gross amount - discount amount) * 
(commission pct / 100).

Sales Amount – The total sales amount is inserted. The sales amount is calculated using this 
formula: (gross amount - discount amount - commission amount) * sell rate.

Quantity – The quantity ordered in stock unit of measure is inserted.

User Quantity – The quantity ordered in the selling unit of measure is inserted.

# Docs – The number of documents included in the time bucket is inserted.

Viewing the Throughput Detail Table
To view the documents included in a particular time bucket, double-click the row. Throughput 
information for each document in the bucket is displayed. To view the information as a pie chart, 
select View, Pie Chart. To view the information as a bar chart, select View, Bar Chart. To view 
throughput information for the supply order linked to the document, double-click the line.

Generating the Throughput Report
You can generate a report based on the contents of the Throughput Tool. After you populate the 
throughput table, you can generate the report. 

To generate the throughput report:

1 From the Throughput Tool, click Print.

2 In the Print section, specify the information to include in the report. You can include actual, 
estimated, remaining, and projected throughput.

3 In the Options section, specify how to group the information. Select one of these options:

Summary – Select this option to print a summary report. The summary report includes the total 
throughput for each bucket in the throughput table.

Breakdown by Part ID – Select this option to view the report by part ID. The Breakdown by Part 
ID includes the total throughput for each part for the date range you specified in the Throughput 
Tool.

Breakdown by Customer ID – Select this option to view the report by customer ID. The 
Breakdown by Customer ID includes the total throughput for each customer for the date range 
you specified in the Throughput Tool.

Details – Select this option to view a detailed report. The detailed report lists each document 
contributing to throughput for each bucket in the throughput table.

Breakdown by Part ID with Details – Select this option to view each document that contributes 
to throughput for each part during the date range specified in the Throughput Tool. 
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Breakdown by Customer ID with Details – Select this option to view each document that 
contributes to throughput for each customer during the date range specified in the Throughput 
Tool.

4 Specify the output format for this report. Select one of these options:

Print – Select this option to print the report.

View – Select this option to view the report on your screen.

File – Select this option to export the report to a comma-separated file.

E-mail – Select this option to e-mail the report. To e-mail the report as a PDF, select the PDF 
Format check box. To e-mail the report as a comma-separated file, clear this check box.

5 To generate the report, click Ok.

Viewing Percent Buffer Intrusions Information
Use this tool to view the buffer intrusion percentages for buffers measured in time. To view this 
information:

1 Select Tools, Percent Buffer Intrusions.

2 To specify the information to view in the table, click Graph Options.

3 Specify this information:

Start Date and End Date – In the Start Date and End Date fields, specify the date range to use 
for the table.

Group Period – Specify the time buckets to use in the table. You can select Monthly, Weekly, or 
Daily.

Display Type – Specify the orders to view in the table. You can select MTO Orders, MTS Orders, 
Purchase Orders, Fabricated Parts, or Purchased Parts.

4 Click Ok.

5 View this information:

CCR ID – The type of buffer is inserted. If you use a CCR, the resource ID of your CCR is 
inserted.

Period Begin – The start date of the period described in the line. 

Days in Period – The number of days in the measurement period is inserted. This is the number 
of times that buffer statuses were generated in the period.

# Open Items – The number of open demand orders is inserted.

# Emergency Zone Intrusions – The number of times the buffer entered the emergency zone 
during the period is inserted.

% Emerg. Zone Intrusions – The percentage of open items that caused an emergency zone 
intrusion is inserted.
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# Yellow Zone Intrusions – The number of times the buffer entered the yellow zone during the 
period is inserted.

% Yellow Zone Intrusions – The percentage of open items that caused a yellow zone intrusion is 
inserted.

# Buffer Intrusions – The total number of buffer intrusions is inserted.

% Buffer Intrusions – The percentage of open items that caused a buffer intrusion is inserted.

At the bottom of the table, the sum of the buffer intrusions and the average buffer intrusions are 
inserted.

Using View Menu Information
These dialog boxes are available in the View Menu:

• Problem Work Orders
• Problem Operations
• Problem Requirements
• Shipment Schedule
• Material Release Schedule
• Selected Work Order
• Selected Work Order Status
• Selected Work Order Customer Order Status
• Selected Work Order Buffers
• Selected Work Order Last Piece
• Show Material Planning for Part
• Resource Operations Buffer Status
• MTO/MTS Buffer Status
• Stocked Part Buffer Status
• Active Jobs

All of these dialog boxes except for Active Jobs are available in the Buffer Maintenance. See "Using 
Buffer Management Tools" on page 17–80 in this guide.

Viewing Active Jobs
The Active Jobs dialog box shows open labor tickets created against your work orders. 

To view active jobs:

1 Select View, Active Jobs.

2 Specify this information:

Employee ID – To view the active jobs for a particular employee, specify the ID in this field.
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Resource ID – To view the active jobs on a particular resource, specify the ID in this field.

Work Order ID – To view the active jobs for a particular work order, specify the ID in this field.

3 View this information in the table:

Employee ID – The ID of the employee working on the active job is inserted.

Resource ID – The ID of the resource used for the job is inserted.

Work Order ID – The iD of the work order associated with the job is inserted.

Current Buffer Status – The buffer status of this operation is inserted.

Transaction ID – The ID of the transaction is inserted.

Printing Reports
The reports you can print in the DBR Dashboard are the same as the reports you can print in the Buf-
fer Management window. See "Generating Buffer Management Reports" on page 17–91 in this guide.
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What is the Data Import Utility?
The Data Import Utility allows you to integrate technical estimating, industry-specific configurators, 
and other CAD products with VISUAL. Principally, the Data Import Utility reads tab-delimited text files 
and creates full bills of material, which include work orders, engineering masters and quote masters. 
You can also build new parts or add parts to your database using the Data Import Utility.

Data Import Utility Features
• Allows for the creation of multilevel bills of material from external sources.
• Supports specs (master, operation, requirement and Sub-ID).
• Automatically recalculates quantities after a successful importation.
• Generates a log file of all imports, including successful insertions and encountered errors.
• Runs from other applications with command-line parameters, minimized and ready to close after

completion.
• Features an analyze function that allows you to look at the data parsed into tab tokens without

importing. This is largely helpful in testing and debugging import files.
• Automatically auto-numbers requirement piece numbers.
• Auto-numbers work orders.
• Validates primary and secondary keys.

Some Benefits of the Data Import Utility
• Is fairly easy to understand and operate. The Data Import Utility does not require a user having a

detailed knowledge of VISUAL database or SQL.
• Does not require ODBC.
• The data source is independent. As long as the data is in the correct order and valid, the Data

Import Utility imports the data.
• Automatically uses default costs from Part Maintenance and Resource Maintenance.
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Creating Masters 
The Data Import Utility creates a single or multilevel Engineering, Quote or Work Order master from a 
tab-delimited file.

The Data Import Utility processes a tab-delimited file that contains the data needed to create masters. 
The file contains several different record layouts for each part of the master or work order. The file 
can contain multiple masters.

Input File Rules for Creating Masters
• The first field in each line determines the type of data that follows.
• Fields with default values can be left out; however, you must still include the tab-delimiter.
• A part line must follow Master, Assembly, and Material lines if the Part ID does not exist.
• Character data should not be quoted.
• Field data cannot contain tab characters.
• A tab character must follow the last field and each line must end with CRLF.

Input File Record Types
MASTER - Master header information.

PART - Part master information.

OPERATION - Operation information.

OPERATION RESOURCE - Concurrent resources

REF-DESIG - Reference designators

MATERIAL - Material requirement information.

ASSEMBLY- Sub-Assembly or leg-header information (for multilevel masters).

BEGIN-SPEC - Indicates the next line(s) are specs for the last record type processed.

END-SPEC - Indicates the end of specs for the last record type processed.

Import Fields and Tokens
A field in a record is a single, complete piece of data. For example, even though a Part ID may consist 
of two words - as in “STRONTIUM COUPLING” - it is still one piece of data. Each field must be 
delimited, or separated, by a tab. Each record must end with a carriage-return and line feed.
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Tokens are placeholders or positions in the record that the Data Import Utility uses to analyze data. 
Tokens start with a value of zero. The zero token indicates the type of record, such as a master or an 
operation. The data that will be imported into your database start with token 1. 

Master Record Layout
This is the header record for a bill of material. The Data Import Utility examines the lines and tokens 
(these begin with value 0) of information in the text file before it begins the importation process to 
create the work order, engineering master, or quote master. You do not have to make entries into all 
of these fields.

This table shows the layout of the file. It shows the data that is expected in each token, the length and 
type of the data, and whether you are required to include the data in your import file. For 
NumberString data types, the first value indicates the number of digits that can be included to the left 
of the decimal point. The second value indicates the number of digits that can be included to the right 
of the decimal point. 

Token # Name Data type Required Notes

0 Record Type 
Indicator MASTER Y You must specify MASTER. 

1 Type String(1) Y

The type of data that you are 
importing. Specify one of 
these values:
M ( Engineering Master)
W (Work Order)
Q (Quote Master)

2 Base ID String(30) N

The Base ID of the master 
you are importing.
For type M, you do not have 
to supply an ID.
For type W, you must specify 
a Work Order ID or leave this 
field blank for the next seq#. 
For Type Q, you must specify 
a Quote ID or leave this field 
blank for the next seq#. 
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3 Lot ID String(3) N

The Lot ID of the master you 
are importing. 
For type M, specify an 
Engineering ID. The default 
is the next Engineering ID.
For type W, specify a Lot ID. 
The default value is 1.
For type Q, specify a Lot ID. 
The default value is 1. 

4 Part ID String(30) N

The Part ID for the Master. 
This must be a valid Part ID 
or the next import record 
must be a part record that 
adds this part. 

5 Desired Qty NumberString(12.8) N If you do not specify a value, 
then 1 is used.

6 Drawing ID String(30) N The ID of the drawing of the 
part.

7 Drawing Rev 
Number String(8) N The revision level of the 

drawing.

8 Product Code String(15) N If specified, the code must 
exist in the database. 

9 Commodity 
Code String(15) N If specified, the code must 

exist in the database. 

10 Engineered By String(40) N The individual who 
configured the product. 

11 Engineered 
Date String(10) N

The day, month, and year of 
engineering. This defaults to 
the current date if you do not 
enter a date. Use MM/DD/
YYYY format. 

12 Desired Want 
Date String(10) N

The date that production on 
the master should be 
complete. Use MM/DD/YYYY 
format.

13 Desired 
Release Date String(10) N

The date that you plan to 
release the master to 
production. Use MM/DD/
YYYY format.

Token # Name Data type Required Notes
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14 Status String(1) N

Specify one of these values:
U (Unreleased)
F (Firmed), also the default
R (Released)
The user must have 
permission to set the status 
code. If the user does not 
have permission to set a 
status of Firmed, the Data 
Import Utility creates the 
master with a Unreleased 
status. The Data Import 
Utility generates an error 
message or log entry when a 
user with insufficient 
privileges has tried 
unsuccessfully to change a 
master status.

15 Drawing File String(100) N
The full path name to the 
Drawing File and name of the 
Drawing File. 

16 Forward 
Schedule String(1) N Specify Y or N. The default is 

N. 

17 Copy Routing String(1) N

Specify Y or N. This setting is 
used when importing work 
orders or quotes. If you 
specify Y, then the operations 
from the part’s engineering 
master are copied. If you 
specify Y, you must specify a 
part ID in field 4. 
This function is designed to 
be used primarily with the 
APS Import Utility, and as 
such only copies the 
operation (not material 
requirement) for the main 
assembly - Sub ID 0.

Token # Name Data type Required Notes
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18 Copy Materials String(1) N

Specify Y or N. This setting is 
used when importing work 
orders or quotes. If you 
specify Y, then the materials 
from the part’s engineering 
master are copied. If you 
specify Y, you must specify a 
part ID in field 4.

19 Master UDF 1 String(80) N The value for User Defined 
Field 1

20 Master UDF 2 String(80) N The value for User Defined 
Field 2

21 Master UDF 3 String(80) N The value for User Defined 
Field 3

22 Master UDF 4 String(80) N The value for User Defined 
Field 4

23 Master UDF 5 String(80) N The value for User Defined 
Field 5

24 Master UDF 6 String(80) N The value for User Defined 
Field 6

25 Master UDF 7 String(80) N The value for User Defined 
Field 7

26 Master UDF 8 String(80) N The value for User Defined 
Field 8

27 Master UDF 9 String(80) N The value for User Defined 
Field 9

28 Master UDF 10 String(80) N The value for User Defined 
Field 10

29 Master UDF 
Layout ID String(15) N The ID of the user-defined 

field layout.

30 Split ID String(3) N If the work order has been 
split, the ID of the split. 

31 Warehouse ID String(15) N
The warehouse where the 
manufactured product is 
stored. 

Token # Name Data type Required Notes
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Part Master Record Layout
The Data Import Utility examines the following fields and tokens (these begin with value 0) of 
information in the text file before it begins the importation process to create a part master. You do not 
have to enter information into all of these fields.

This table shows the layout of the file. It shows the data that is expected in each token, the length and 
type of the data, and whether you are required to include the data in your import file:

Token # Name Data type Required Notes

0 Record Type 
Indicator PART Y You must specify PART.

1 Part ID String(30) Y Part ID

2 Description String(120) N A description of the part.

3 Stock UM String(15) Y The unit of measure used for 
stocking the part. 

4 Fabricated String(1) N Y if the part is fabricated. 
Default value is N

5 Purchased String(1) N Y if the part is purchased. 
Default value is N

6 Stocked String(1) N Y if the part is stocked. 
Default value is N

7 Detail Only String(1) N Y if this is a detail only part. 
Default value N

8 Drawing ID String(30) N The Drawing ID of the part.

9 Drawing Rev 
Number String(8) N The revision number of the 

drawing. 

10 Product Code String(15) N The code must exist in the 
database. 

11 Commodity 
Code String(15) N The code must exist in the 

database. 

12 Order Policy String(1) N

The order policy of the part. 
These values are used: 
N = Not Planned, default
D = Discrete
P = Period Supply
F = Fixed
E = EOQ
M = Master Scheduled
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Operation Record Layout
Operation records add operations to the previous MASTER record.

13 Primary 
Warehouse ID String(15) N The warehouse ID must exist 

in the database. 

14 Primary 
Location ID String(15) N The location ID must exist in 

the database. 

15 Drawing File String(100) N Full path to the drawing file, 
including the file name.

16 Part UDF 1 String(80) N The value for User Defined 
Field 1

17 Part UDF 2 String(80) N The value for User Defined 
Field 2

18 Part UDF 3 String(80) N The value for User Defined 
Field 3

19 Part UDF 4 String(80) N The value for User Defined 
Field 4

20 Part UDF 5 String(80) N The value for User Defined 
Field 5

21 Part UDF 6 String(80) N The value for User Defined 
Field 6

22 Part UDF 7 String(80) N The value for User Defined 
Field 7

23 Part UDF 8 String(80) N The value for User Defined 
Field 8

24 Part UDF 9 String(80) N The value for User Defined 
Field 9

25 Part UDF 10 String(80) N The value for User Defined 
Field 10

26 UDF Layout ID String(15) N The ID of the user-defined 
field layout. 

Token # Name Data type Required Notes
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This table shows the layout of the file. It shows the data that is expected in each token, the length and 
type of the data, and whether you are required to include the data in your import file. For 
NumberString data types, the first value indicates the number of digits that can be included to the left 
of the decimal point. The second value indicates the number of digits that can be included to the right 
of the decimal point:

Token # Name Data type Required Notes

0 Record Type 
Indicator OPERATION Y You must specify 

OPERATION.

1 Parent 
Assembly # String(3) N

The level of parent assembly 
record. The default value is 
0, which is also the top level.

2 Sequence 
Number NumberString(5) Y The sequence number of the 

operation.

3 Resource ID String(15) Y
The Resource ID of the 
operation. The resource must 
exist in your database.

4 Run Number 
String(12.8) N

The run speed of the 
operation. The Data Import 
Utility creates operations with 
a run default of 0. This is not 
a required field. The Data 
Import Utility uses this value 
along with run type and load 
size to calculate run time.

5 Run Type String(1) N

Run type code:
H = Hours/Piece. This is the 
default value.
P = Pieces/Hour
M = Minutes/Piece
N = Pieces/Minute
L = Loads/Hour
D = Hours/Load

6 Drawing ID String(30) N
The Drawing ID of the 
associated with the 
operation. 

7 Drawing Rev 
Number String(8) N The revision number of the 

drawing. 

8 Setup NumberString(5.3) N Setup time. Default is 0.

9 Load Size Qty NumberString(12.8) N The load size quantity of the 
operation. Default is 0.
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10 Move Hours NumberString(3.3) N The move hours of the 
operation. The default is 0.

11 Minimum Move 
Quantity NumberString(12.8) N

The minimum move quantity 
of the operation. The default 
is 0. 

12 Scrap/Yield 
Type String(1) N

The scrap/yield type code of 
the operation:
S = Scrap
Y = Yield

13 Scrap/Yield 
Percentage NumberString(3.2) N Percentage of scrap/yield.

14 Fixed scrap 
units NumberString(12.8) N The fixed scrap units of the 

operation.

15 Drawing File String(100) N The full file path to and name 
of the drawing file.

16 Service ID String(15) N The ID of the outside service 
provided by the vendor. 

17 Transit Days NumberString(3.3) N

This field applies to services. 
The amount of time it takes 
for the material to travel to 
the service vendor. The 
default is 0.

18 Run Cost Per 
Unit NumberString(14.8) N

This field applies to services. 
The cost per unit to perform 
the service. The default is 0.

19 Service Base 
Charge NumberString(15.8) N

This field applies to services. 
The base amount charged by 
the vendor. The default is 0. 

20 Service Min 
Charge NumberString(15.8) N

This field applies to services. 
the minimum amount that the 
vendor charges. The default 
is 0. 

21 Begin 
Traceability String(1) N

This indicates if traceability 
begins starting at an 
operation. Y indicates that 
traceability takes effect 
starting at this operation. The 
default is N. 

Token # Name Data type Required Notes
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22 Start Qty NumberString(12.8) N

Use this quantity if you want 
to enable the override 
quantities feature. See the 
note in the Qty Complete 
description. 

23 End Qty NumberString(12.8) N

Use this quantity if you want 
to enable the override 
quantities feature. See the 
note in the Qty Complete 
description

24 Qty Complete NumberString(12.8) N

The cumulative quantity 
completed for this operation. 
The default is 0.

Note: If the quantity 
completed meets or exceeds 
the end quantity (either 
specified or calculated) of the 
operation, this operation is 
considered complete. Be 
careful when using the Qty 
Complete field.

25 Operation UDF 
1 String(80) N The value for User Defined 

Field 1

26 Operation UDF 
2 String(80) N The value for User Defined 

Field 2

27 Operation 
UDF3 String(80) N The value for User Defined 

Field 3

28 Operation UDF 
4 String(80) N The value for User Defined 

Field 4

29 Operation UDF 
5 String(80) N The value for User Defined 

Field 5

30 Operation UDF 
6 String(80) N The value for User Defined 

Field 6

31 Operation UDF 
7 String(80) N The value for User Defined 

Field 7

32 Operation UDF 
8 String(80) N The value for User Defined 

Field 8

33 Operation UDF 
9 String(80) N The value for User Defined 

Field 9

Token # Name Data type Required Notes
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Operation Resource Record Layout
Operation resource records add concurrent resources to an operation. If used, these records must 
follow the OPERATION record for which the concurrent resource(s) are required.

34 Operation UDF 
10 String(80) N The value for User Defined 

Field 10

35 Operation UDF 
Layout ID String(15) N The ID of the UDF Layout

36 Capacity Usage 
Max NumberString(5) N

The maximum capacity 
usage for the resource in the 
operation.

37 Capacity Usage 
Min NumberString(5) N

The minimum capacity usage 
for the resource in the 
operation. 

38 Setup Cost Per 
Hr NumberString(14.8) Y The per hour cost to set up 

the resource in the operation.

39 Run Cost Per 
Hr NumberString(14.8) Y

The per hour cost to run the 
operation. This is not a 
required field. 

40 Burden Per Hr 
Setup NumberString(14.8) Y The burden per hour applied 

to setup of the operation.

41 Burden Per Hr 
Run NumberString(14.8) Y The burden per hour applied 

to setup of the operation. 

42 Burden Per Unit 
Run NumberString(14.8) Y The burden per unit 

produced.

43 Fixed Burden NumberString(15.8) Y The fixed burden for the 
operation. 

44 Burden Percent 
Setup NumberString(3.3) Y The burden rate for setting 

up the operation.

45 Burden Percent 
Run NumberString(3.3) Y The burden rate for running 

up the operation.

46 Operation Type String(15) N The operation type. 

Token # Name Data type Required Notes
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This table shows the layout of the file. It shows the data that is expected in each token, the length and 
type of the data, and whether you are required to include the data in your import file. For 
NumberString data types, the first value indicates the number of digits that can be included to the left 
of the decimal point. The second value indicates the number of digits that can be included to the right 
of the decimal point:

Token # Name Data type Required Notes

0 Record Type 
Indicator OPER_RES Y You must specify 

OPER_RES.

1 Parent 
Assembly # String(3) N

The level of parent assembly 
record. The default value is 
0, which is also the top level.

2 Sequence 
Number NumberString(5) Y The sequence number of the 

operation.

3 Resource ID String(15) Y
The Resource ID of the 
operation. This must be a 
valid Resource ID. 

4 Type String(1) N

The type of operation 
resource. 
B - Specifies that concurrent 
resources apply to both 
setup and run. This the 
default value.
S - Specifies that concurrent 
resources apply only to 
setups.
R - Specifies that concurrent 
resources apply only to runs.

5 Percent 
Duration String(3) N

The percent of the operation 
that the resource is 
concurrent. The default value 
is 100

6 Justification String(1) N

Where the overlap between 
operations begins:
S - The concurrent resource 
applies overlaps the start of 
the operation. This is the 
default.
E - The concurrent resource 
overlaps the end of the 
operation.
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Material Record Layout
The material record identifies the material requirements for an operation.

This table shows the layout of the file. It shows the data that is expected in each token, the length and 
type of the data, and whether you are required to include the data in your import file. For 
NumberString data types, the first value indicates the number of digits that can be included to the left 
of the decimal point. The second value indicates the number of digits that can be included to the right 
of the decimal point:

7 Schedule Type Number(2) N
Specify 0 for continuous 
scheduling. Specify 1 for 
discontinuous scheduling. 

8 Minimum 
Segment Size NumberString(12.2) N

If the schedule is 
discontinuous, the minimum 
run duration on one resource 
unit before a second unit can 
be scheduled. 

Token # Name Data type Required Notes

0 Record Type 
Indicator MATERIAL Y You must specify MATERIAL.

1
Parent 
Assembly # 
(Sub ID)

String(3) Y
The level of parent assembly. 
The default value is 0, which 
is also the top-level.

2 Sequence 
Number NumberString(5) Y

The sequence number of the 
operations that require this 
material.

3 Piece Number NumberString(5) N

The piece number of the 
material. The default is the 
next piece number, which the 
Data Import Utility 
increments by 10.

4 Part ID String(30) N The Part ID of the material. 
This must be a valid Part ID.

5 Quantity Per NumberString(12.8) N

The quantity of material 
required for each part 
produced by operations. If 
you do not specify a value, a 
default value of 1 is used. 

Token # Name Data type Required Notes
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6 Quantity Per 
Type String(1) N

The quantity per type code. 
Because of scrap and yield, 
the start quantity may be 
different than the end 
quantity. This field indicates 
to use start quantity or end 
quantity when calculating 
quantity per.
S (Start Qty), also the default
E (End Qty)

7 Usage UM String(15) N
The unit of measure of the 
material. This must be a valid 
unit of measure. 

8 Drawing ID String(30) N
The Drawing ID of the 
associated with the 
operation. 

9 Drawing Rev 
Number String(8) N The revision number of the 

drawing. 

10 Unit Material 
Cost NumberString(14.8) N

The unit cost of this material. 
The Data Import Utility uses 
the part cost from the existing 
part table, unless you specify 
a different value. If you 
specify a value, it overrides 
the default. 

11 Length NumberString(10.4) N
Only applies if the material is 
piece tracked and requires 
length.

12 Width NumberString(10.4) N
Only applies if the material is 
piece tracked and requires 
width.

13 Height NumberString(10.4) N
Only applies if the material is 
piece tracked and requires 
height.

14 Dimension UM String(15) N

The unit of measure of the 
material. This only applies to 
piece tracked parts and must 
be a valid unit of measure. 

15 Drawing File String(100) N The full file path to and name 
of the drawing file.

Token # Name Data type Required Notes
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16 Scrap Percent NumberString(3.2) N

The scrap percent of the 
material. The Data Import 
Utility creates material 
records with a default scrap 
percent value of 0. 

17 Fixed Quantity NumberString(12.8) N

The fixed quantity of the 
material. The Data Import 
Utility creates material 
records with a default fixed 
quantity value of 0. 

18 Dimensions String(80) N

This dimension formula must 
equal a valid numeric 
expression. This is not 
applicable for piece tracked 
parts.

19 Reference # String(10) N The reference number to an 
item number on a drawing. 

20 Issued Quantity 
# NumberString(12.8) N

The quantity of the 
requirement that has been 
issued to date. If the quantity 
issued meets or exceeds the 
material requirement, this 
material requirement is 
considered complete.

21 Material UDF 1 String(80) N The value for User Defined 
Field 1

22 Material UDF 2 String(80) N The value for User Defined 
Field 2

23 Material UDF 3 String(80) N The value for User Defined 
Field 3

24 Material UDF 4 String(80) N The value for User Defined 
Field 4

25 Material UDF 5 String(80) N The value for User Defined 
Field 5

26 Material UDF 6 String(80) N The value for User Defined 
Field 6

27 Material UDF 7 String(80) N The value for User Defined 
Field 7

Token # Name Data type Required Notes
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28 Material UDF 8 String(80) N The value for User Defined 
Field 8

29 Material UDF 9 String(80) N The value for User Defined 
Field 9

30 Material UDF 
10 String(80) N The value for User Defined 

Field 10

31 Material UDF 
Layout ID String(15) N The ID of the UDF Layout

32 Material Vendor 
ID String(15) N The ID of the vendor who 

sells the part.

33 Material Vendor 
Part ID String(30) N The ID that the vendor uses 

for the part. 

34 Material Mfg 
Name String(30) N The name of the 

manufacturer or the part.

35 Material Mfg 
Part ID String(30) N The ID that the manufacturer 

uses for the part.

36 Material Unit 
Labor Cost NumberString(14.8) N The cost of labor per unit.

37 Material Unit 
Burden Cost NumberString(14.8) N The burden per unit.

38 Material Unit 
Service Cost NumberString(14.8) N The service cost per unit.

39 Material Fixed 
Cost NumberString(15.8) N The fixed cost per unit. 

40 Material Burden 
Per Unit NumberString(9.6) N The material burden cost per 

unit. 

41 Material Burden 
Percent NumberString(3.2) N The percentage charged for 

burden. 

42 Material 
Warehouse ID String(15) N

The warehouse where the 
material requirement is 
stored.

43 Material 
Location ID String(15) N

The location in the 
warehouse where the 
material requirement is 
stored. 

Token # Name Data type Required Notes
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Reference Designator Record Layout
Use the Reference Designator record to add reference designators to a material card. To successfully 
import reference designator information, one of these conditions must be true:

• In the import file, the lines for the operation and material requirement associated with the
reference designator precede the line for the reference designator information, or

• The operation and material requirement already exist in your database. 

Note: The number of reference designators that you import is not validated. For example, if a material 
requirement has a quantity of five, then five separate reference designators are expected. After you 
import reference designators, open the associated material requirement card to validate the number. 
You can save more or fewer reference designators than expected.

For more information about reference designators, see "Specifying Reference Designators" on page 
3–66 in this guide.

This table shows the layout of the row in the file. It shows the data that is expected in each token, the 
length and type of the data, and whether you are required to include the data in your import file”

Token # Name Data Type Required Notes

0 Record Type 
Indicator REF-DESIG Y You must specify REF-

DESIG.

1 Sub ID String(3) N

The Sub ID where the 
material is used. If you leave 
this field blank, then the ID 
from the preceding Material 
row is used. 

2 Operation Seq 
No NumberString(5) N

The operation sequence 
number where the material is 
used. If you leave this field 
blank, then the ID from the 
preceding Material row is 
used. 

3 Piece No NumberString(5) N

The piece number of the 
material. If you leave this 
field blank, then the ID from 
the preceding Material row is 
used. 

4 Part ID String(30) N

The part ID of the material. 
This information is not 
imported into your database. 
It is used for messages. 

5 Ref Designator 
ID String(15) Y The ID of the reference 

designator.

6 X Coordinate String(15) N The x-coordinate of the 
designator
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Assembly Records
Assembly records add Sub-IDs (leg-headers) to the previous MASTER record. The OPERATION that 
requires the Sub-ID MUST be listed prior to the ASSEMBLY record.

This table shows the layout of the file. It shows the data that is expected in each token, the length and 
type of the data, and whether you are required to include the data in your import file. For 
NumberString data types, the first value indicates the number of digits that can be included to the left 
of the decimal point. The second value indicates the number of digits that can be included to the right 
of the decimal point:

7 Y Coordinate String(15) N The y-coordinate of the 
designator.

8 Description String(30) N A description of the 
designator. 

Token # Name Data type Required Notes

0 Record Type 
Indicator ASSEMBLY Y You must specify 

ASSEMBLY.

1 Parent 
Assembly String(3) Y

The level of parent assembly. 
This is the Sub ID of the 
parent record. The default 
value is 0, which is also the 
top-level.

2 Operation 
Number NumberString(5) N

The operation sequence 
number of the parent 
operation. 

3 Piece Number NumberString(5) N

The piece number of the 
material. This must be a valid 
Part ID. The default is the 
next piece number for the 
part assembly number.

4 Part ID String(30) N The Part ID of the material. 

5 Quantity Per NumberString(12.8) N

The quantity of material 
required for each part 
produced by operations. If 
you do not specify a value, a 
value of 1 is used. 

Token # Name Data Type Required Notes
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6 Quantity Per 
Type String(1) N

The quantity per type code. 
Because of scrap and yield, 
the start quantity may be 
different than the end 
quantity. This field indicates 
to use start quantity or end 
quantity when calculating 
quantity per. 
S (Start Qty), also the default 
E (End Qty) 

7 Usage UM String(15) N
The unit of measure of the 
material. This must be a valid 
unit of measure. 

8 Drawing ID String(30) N The Drawing ID of the 
assembly. 

9 Drawing Rev 
Number String(8) N The revision number of the 

drawing. 

10 Unit Material 
Cost NumberString(15.8) N

The unit cost of this material. 
The Data Import Utility uses 
the part cost from the existing 
part table, unless you specify 
a different value. If you 
specify a value, it overrides 
the default. 

11 Drawing File String(100) N The full file path to and name 
of the drawing file.

12 Sub ID String(3) N

The sequential number of 
this assembly. Specify the 
Sub-ID for this leg-header 
here. The Data Import Utility 
automatically increments to 
the next Sub ID. 

12 Length NumberString(10.4) N
Only applies if the material is 
piece tracked and requires 
length.

13 Width NumberString(10.4) N
Only applies if the material is 
piece tracked and requires 
width.

14 Height NumberString(10.4) N
Only applies if the material is 
piece tracked and requires 
height.

Token # Name Data type Required Notes
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15 Dimension UM String(15) N

The unit of measure of the 
material. This only applies to 
piece tracked parts and must 
be a valid unit of measure. 

16 Scrap Percent NumberString(3.2) N

The scrap percent of the 
material. The Data Import 
Utility creates material 
records with a default scrap 
percent value of 0. 

17 Fixed Quantity NumberString(12.8) N

The fixed quantity of the 
material. The Data Import 
Utility creates material 
records with a default fixed 
quantity value of 0. 

18 Dimensions String(80) N

This dimension formula must 
equal a valid numeric 
expression. This is not 
applicable for piece tracked 
parts. 

19 Reference # String(10) N The reference number to an 
item number on a drawing. 

20 Issued Quantity 
# NumberString(12.8) N

The quantity of the 
requirement that has been 
issued to date. If the quantity 
issued meets or exceeds the 
material requirement, this 
material requirement is 
considered complete.

21 Assembly UDF 
1 String(80) N The value for User Defined 

Field 1.

22 Assembly UDF 
2 String(80) N The value for User Defined 

Field 2.

23 Assembly UDF 
3 String(80) N The value for User Defined 

Field 3.

24 Assembly UDF 
4 String(80) N The value for User Defined 

Field 4.

25 Assembly UDF 
5 String(80) N The value for User Defined 

Field 5.

26 Assembly UDF 
6 String(80) N The value for User Defined 

Field 6.

Token # Name Data type Required Notes
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Specification Records
You can add specifications to MASTER, PART, OPERATION, MATERIAL, and ASSEMBLY records. 
The Data Import Utility uses any records that it finds after the BEGIN-SPEC and before the END-
SPEC as the specification to the previous Master, Part, Operation, Material, or Assembly record. 
BEGIN-SPEC and END-SPEC must be separate records; the text that comprises the actual 
specifications must be also be a separate record(s). Therefore, the minimum number of records that 
the Data Import Utility needs to create a record is 3 - one for the BEGIN-SPEC, one for the END-
SPEC, and at least one for the actual specification.

Note: If you do not specify a specification for a MATERIAL or ASSEMBLY record but do specify a 
valid Part ID for that MATERIAL or ASSEMBLY record, the Data Import Utility copies the specification 
from part Maintenance to the material requirement or leg specifications.

27 Assembly UDF 
7 String(80) N The value for User Defined 

Field 7.

28 Assembly UDF 
8 String(80) N The value for User Defined 

Field 8.

29 Assembly UDF 
9 String(80) N The value for User Defined 

Field 9.

30 Assembly UDF 
10 String(80) N The value for User Defined 

Field 10.

31 Assembly UDF 
Layout ID String(15) N The ID of the UDF Layout.

Token # Name Data type Required Notes
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Running the Data Import Utility in Background or 
Command Line Mode
You can run the Data Import Utility interactively or from a command line. When you run the Data 
Import Utility from a command line, you can call it from another program. If you include the proper 
command line options, the Data Import Utility runs minimized and closes automatically upon 
completion.

Command Line Options
-D - VISUAL Database name.

-U - VISUAL Database user name.

-P - VISUAL Database user password.

ENG_ID <filename> - This option, followed by the fully qualified tab-delimited filename, tells the Data 
Import Utility to create an Engineering/Quote Master(s) and/or Work Order(s) in VISUAL. This also 
creates parts for PART records.

CREATE_PART <filename> - This option, followed by the fully qualified tab-delimited filename, tells 
the Data Import Utility to create PART Master(s) in VISUAL. The input file should contain only PART 
lines; the Data Import Utility ignores all other line types.

SITE_ID <site ID> – Use this option to specify the site where you are creating the record. 

LOG_PATH <filepath> – Use this option to specify the location of the log file. Specify the path only; 
do not include the file name. 

For example:

Run c:\Infor\visual\vmdlsync.exe –D VMFG – U USERNAME – P PASSWORD ENG_ID 
c:\Infor\temp\file.txt SITE_ID MMC LOG_PATH c:\Infor\logs
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Starting the Data Import Utility Interactively
In the directory in which you executables are installed, locate and double-click Vmdlsync.exe.

Using the Data Import Utility to Create a Master Bill of 
Materials
1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use to create 

the bill of materials. If you are licensed to use a single site, this field is unavailable.

2 Select the Create VISUAL Eng/Master check box.

3 Make sure that your VISUAL database name—the database into which you are importing the 
data—,User ID, and Password are correct. 

4 When you are ready to import the text file into your VISUAL database, click the Run button on the 
main toolbar.

Using the Search dialog box that appears, locate and select the text file you want to import into 
your VISUAL database. Make it easier to locate theses files by keeping them in the directory 
where your executables are installed.

5 Click the Open button.

The Data Import Utility imports the specified text file, creates the master in your VISUAL 
database, and then recalculates quantities.

As it imports data, the blue progress meter and accompanying percent-done display inform you of 
what portion of the data you have successfully imported.

After successfully importing a master bill of materials, the number of masters created in your 
VISUAL database is displayed at the bottom of the window.

If all lines of an import file are unable to be processed, the import session is halted and an error 
message is displayed that lets you know where in the file—line number and field—an invalid value 
was found. With this information, you can fix the import file and try again to import it into your 
VISUAL database.

Using the Data Import Utility to Create a Part Master
1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use to create 

the part. If you are licensed to use a single site, this field is unavailable.

2 Select the Create VISUAL Part check box.

3 Make sure that your VISUAL database name, User ID and Password are correct. This is the 
VISUAL database into which you are importing the data.

4 When you are ready to import the text file into your VISUAL database, click the Run button.
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Using the Search dialog box that appears, locate and select the text file that you want to import 
into your VISUAL database. Keep these text files in your the directory where your executables are 
installed.

5 Click the Open button.

The Data Import Utility imports the specified text file, creates the part master in your VISUAL 
database.

Analyzing Data before Importation
The Analyze Data function helps debug import files. When you use this function, the Data Import 
Utility reads the tab-delimited import file and parses the data in each record and assigns a token 
(placeholder or array value) to each piece of data. The Data Import Utility aligns each piece of data 
with the associated field and displays the length of each data item. Tokens that show a 0 (zero) length 
indicate that the Data Import Utility found no data even though the record does contain a <tab> as a 
place holder to intentionally skip the field. Tokens that show a NULL value indicate that the record 
was not complete. This is an acceptable condition as long as all required fields are found. When the 
Data Import Utility analyzes data it does NOT import it; the Data Import Utility only interprets the data.

The analyze function does not validate data or populate default information.

1 If you are licensed to use multiple sites, click the Site ID arrow and select the site to use in the 
analysis. If you are licensed to use a single site, this field is unavailable.

2 From the Actions section, click the Analyze button.

3 Using the search dialog box that appears, locate the text file you want to import.

After you have located and opened it, the text file appears for your review. You cannot change this 
data. To modify it, open the text file in a text editor and make any necessary modifications.

Click the Print button to export the information to a PDF. 

4 Click the Ok button when you are finished viewing the input data.

Viewing Log Information after Importing Data
After you import data into your VISUAL database you can review details of the import session in the 
Vmdlsync.log file, the file the Data Import Utility creates as it imports the data. You can find this file in 
the directory where your executables are installed.
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